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Notice 

Every effort was made to ensure that the information in this manual was accurate 

at the time of release. However, information is subject to change without notice, 

and JDS Uniphase reserves the right to provide an addendum to this manual with 

information not available at the time that this manual was created. 

 

Copyright/Trademarks 

©  Copyright 2016 Viavi Solutions Inc. All rights reserved. No part of this guide 

may be reproduced or transmitted, electronically or otherwise, without written 

permission of the publisher. Viavi Solutions, the Viavi logo, CellAdvisor, 

RANAdvisor TrueSite, StrataSync, and EZ-Cal are trademarks of Viavi Solutions 

Inc. (“Viavi”). All trademarks and registered trademarks are the property of their 

respective companies. 

 

Google Maps and Google Earth are either trademarks or registered trademarks of 

Google in the United States and/or other countries. 

 

Bluetooth is a trademark or a registered trademark of Bluetooth Special Interest 

Group (SIG) Inc. in the United States and/or other countries. 

 

Android is a trademark or a registered trademark of Google in the United States 

and/or other countries. 

 

iOS is a trademark or a registered trademark of Apple Inc. in the United States 

and/or other countries. 

 

Windows and Windows 7 are either trademarks or registered trademarks of 

Microsoft Corporation in the United States and/or other countries. 

 

Copyright release 

Reproduction and distribution of this guide is authorized for US Government 

purposes only. 

 

Ordering information 

This document is a product of Viavi’s Technical Publications Department, issued 

as part of the JD780A Series. The catalog number for a published manual is 

JD780A362 - printed. The catalog number for an electronic manual on CD-ROM is 

JD780A361 - electronic. 

 

Open source disclaimer – IMPORTANT READ CAREFULLY 

The JD780A Series includes third party software licensed under the terms of 

separate open source software licenses. By using this software, you agree to 

comply with the terms and conditions of the applicable open source software 

licenses. Software originated by Viavi is not subject to third party licenses. Terms 

of the Viavi Software License different from applicable third party licenses are 

offered by Viavi alone. 

 

This product incorporates open source software entitled “zlib”. The zlib is the 



 

 

compression library written by Jean-loup Gailly and Mark Adler, who granted 

permission to use this software for any purpose, including commercial 

applications. 

 

This product includes open source software developed by the Apache Software 

Foundation (http://www.apache.org/). 

 

This product used free library for JPEG image compression written and distributed 

by Independent JPEG Group or IJG (http://www.ijg.org/). 

 

This product used free, open-source JavaScript library entitled “jQuery”. It is 

licensed under the MIT License (http://jquery.org/license/). 

 

See “Viewing OSS license” on page 42 for more information. 

 

Terms and conditions 

Specifications, terms, and conditions are subject to change without notice. The 

provision of hardware, services, and/or software is subject to Viavi’s standard 

terms and conditions, available at www.viavisolutions.com/en/terms-and-

conditions. 

 

EMC directive compliance 

This product was tested and conforms to the EMC Directive, 2004/108/EC and its 

amending directives for electromagnetic compatibility. Conformity with this 

directive is based upon compliance with the harmonized European standards: 

EN61326-1, CISPR11, EN61000-3-2, and EN61000-3-3. A copy of the Declaration 

of Conformity is provided upon your request. 

 

Low voltage directive compliance 

This product was tested and conforms to the Low Voltage Directive, 2006/95/EC 

and its amending directives. Conformity with this directive is based upon 

compliance with the harmonized European standard EN61010-1. A copy of the 

Declaration of Conformity is provided upon your request. 

 

WEEE and battery directive compliance 

Viavi has established processes in compliance with the Waste Electrical and 

Electronic Equipment (WEEE) Directive, 2002/96/EC, and the Battery Directive, 

2006/66/EC. 

 

This product, and the batteries used to power the product, should not be disposed 

of as unsorted municipal waste and should be collected separately and disposed 

of according to your national regulations. In the European Union, all equipment 

and batteries purchased from Viavi after 2005-08-13 can be returned for disposal 

at the end of its useful life. Viavi will ensure that all waste equipment and batteries 

returned are reused, recycled, or disposed of in an environmentally friendly 

manner, and in compliance with all applicable national and international waste 

legislation. 

 

It is the responsibility of the equipment owner to return equipment and batteries to 

http://www.ijg.org/
http://jquery.org/license/
http://www.viavisolutions.com/en/terms-and-conditions
http://www.viavisolutions.com/en/terms-and-conditions


 

Viavi for appropriate disposal. If the equipment or battery was imported by a 

reseller whose name or logo is marked on the equipment or battery, then the 

owner should return the equipment or battery directly to the reseller. 

Instructions for returning waste equipment and batteries to Viavi can be found in 

the Environmental section of Viavi’s web site at www.viavisolutions.com. If you 

have questions concerning disposal of your equipment or batteries, contact Viavi’s 

WEEE Program Management team. 
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Purpose and scope 

The purpose of this manual is to help you successfully operate the JD780A series (firmware version 

3.064 and later) and use its features and capabilities. This manual includes instructions that describe 

how to operate, set up, configure, and use the JD780A series, consisting of JD785A Base Station 

Analyzer, JD786A RF Analyzer, and JD788A Signal Analyzer. 

 

Assumptions 

This manual is intended for novice, intermediate, and experienced users who want to use the JD780A 

series effectively and efficiently. We are assuming that you have basic operation experience and are 

familiar with basic mobile communication concepts and terminology. 

 

Safety and compliance information 

Safety and compliance information for the instrument are provided upon your request. 

 

Safety consideration 

It is mandatory to permanently connect this product to the protective earth. 

 

When powering this instrument externally, always use an AC power cable that includes an earth 

(safety) ground connection, which is shipped with your instrument. 

 

 

WARNING 

Do not attempt to service this product yourself, as opening or removing covers may 
expose you to dangerous voltage and other hazards. Refer all servicing to qualified Viavi 
service personnel. 

 

 

CAUTION 

This equipment contains parts and assemblies sensitive to electrostatic discharge (ESD). 
Use ESD precautionary procedures when touching, removing, or inserting ESD sensitive 
parts and assemblies, or damage to components could result. 
 
An electrostatic-sensitive device can only withstand voltage spikes of 10 to 100 volts. Any 
discharge greater than this can damage or effectively destroy such a device while going 
unnoticed by a technician. Common plastics (synthetic insulating materials), clothing, and 
paper or cardboard are the most common source of static charges. 

 

 

CAUTION 

This instrument uses a Lithium Ion battery that, if not connected correctly, may lead to 
explosion. In case the battery needs to be exchanged, it must be the same kind as or 
compatible with the one shipped with your instrument. 
 
The battery must not be disposed of in a landfill site or as municipal waste, and should be 
disposed of according to your national regulations. 

 

Battery 

The battery pack that comes with the instrument is Lithium Ion and it may lead to explosion if not 

connected correctly. In case the battery needs to be replaced, it must be one of the same kinds or 

compatible ones. Disposal of the batteries must be done according to local safety and environmental 

regulations. 
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Safety guide 

 Do not expose the battery to high temperature such as fire, heat, direct sun, etc. 

 Do not connect the positive and negative terminals of the battery together with any metal 

objects such as wires, paper clips, etc. 

 Do not expose the battery to any type of liquid such as rain, water and salt water, etc. 

 Do not disassemble or modify the battery. 

 

Storage guide 

Lithium Ion batteries continue to slowly discharge (self-discharge) when stored or not in use for a while. 

In this case, you need to: 

 Remove the battery pack and store it separately from the product in a cool and dry location 

without direct sun light on the pack or its carton box. 

 Store the battery at temperatures between 10 °C and 30 °C (50 °F and 86 °F) to minimize the 

deactivation effect of the battery. 

 Storage at the temperatures above 30 °C or 86 °F reduces the battery storage life. 

 Charge at least once per 6 months to prevent leakage and deterioration in performance 

caused by self-discharging. 

 

Battery charge status indicator 

You can find the indicator for battery charge status on the battery pack. 

 

Table 1 Battery charge status 

Indicator Description 

 Voltage < 9.0 V, immediate charge required 

 Remaining Capacity Alarm, immediate charge required 

 1 to 19% Remaining, charge before storage 

 21 to 40% Remaining, charge before storage 

 41 to 60% Remaining, charge before storage 

 61 to 80% Remaining 

 81 to 100% Remaining 

 

Electrostatic discharge precautions (ESD) 

This instrument was manufactured in an ESD protected environment. Semiconductor devices used in 

this product are susceptible to damage by static discharge. Depending on the magnitude of the 

discharge, semiconductor devices may be damaged by direct contact or mere proximity of a static 

charge. This may cause performance degradation, early failure, or immediate destruction. Use the 

following guidelines to prevent ESD damage: 

 Before connecting a cable to this instrument terminal, short circuit the center of the cable with 

an outside metal shield. 
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 Before removing a connected cable or getting in contact with the center pin, wear a wrist strap 

with one MΩ resistor connected to the ground. 

 All equipment must be connected to the ground to avoid accumulation of static charges. 

 

Using 12 V DC automotive adapter 

When powering or charging this instrument with the 12 V DC Automotive Adapter, always verify that 

the supply is rated for a minimum of 60 Watts @12 V DC and that the socket is clear of any dirt or 

debris. If the adapter plug gets hot to touch during operation, discontinue the use immediately. 

 

Conventions 

This document uses typographical and symbols conventions as described in the following tables. 

 

Table 2 Text formatting and other typographical conventions 

Item Text formatting/symbols used Example(s) 

Buttons or hard keys that 
the user presses on a 
physical device 

Bold, all caps, default font Press the ON button. 
Press the MODE hard key. 
Press the MARKER hard key. 

Hot keys that the user 
presses on a physical 
device 

Bold, all caps, italics, default font Press the SYSTEM hot key. 
Press the MEASURE hot key. 

Soft keys or toggle keys 
that the user presses on a 
physical device to select 
corresponding menus 

Bold, default font Press the Span soft key. 
Press the Channel Power soft key. 

Soft key option separators Denoted by a vertical bar | that 
means “or”, only one option can be 
selected with a single press 

Press the Zone [1|2|3] soft key. 

File type Courier New In .tra file type. 

Required arguments (text 
variables in code) 

Denoted by slanted brackets < >. Enter <password> 

 

Table 3 Symbol conventions 

 

This symbol represents a general hazard. It may be associated with either a DANGER, 
WARNING, or CAUTION message. 

  

 

This symbol represents hazardous voltages. It may be associated with either a 
DANGER, WARNING, or CAUTION message. 

  

 

This symbol represents a risk of explosion. It may be associated with either a DANGER, 
WARNING, or CAUTION message. 

  

 

This symbol, located on the equipment, battery, or the packaging indicates that the 
equipment or battery must not be disposed of in a landfill site or as municipal waste, 
and should be disposed of according to your national regulations. 
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Table 4 Safety definitions 

DANGER Indicates a potentially hazardous situation that, if not avoided, will result in death or 
serious injury. It may be associated with either a general hazard, high voltage, or 
risk of explosion symbol. 

  

WARNING Indicates a potentially hazardous situation that, if not avoided, could result in death 
or serious injury. It may be associated with either a general hazard, high voltage, or 
risk of explosion symbol. 

  

CAUTION 

 

Indicates a potentially hazardous situation that, if not avoided, could result in minor 

or moderate injury and/or damage to equipment. It may be associated with either a 
general hazard, high voltage, or risk of explosion symbol. 
 
When applied to software actions, indicates a situation that, if not avoided, could 

result in loss of data or a disruption of software operation. 

 

Technical assistance 

If you require technical assistance, call 1-844-GO-VIAVI or send an email to TAC@viavisolutions.com. 

For the latest TAC information, go to http://www.viavisolutions.com/en/services-and-

support/support/technical-assistance. 

 

 

mailto:TAC@viavisolutions.com
http://www.viavisolutions.com/en/services-and-support/support/technical-assistance
http://www.viavisolutions.com/en/services-and-support/support/technical-assistance
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JD780A Series Overview 

This chapter provides a general description of the JD780A series. Topics discussed in this chapter 

include the following: 

 

 About the JD780A series ........................................................................................................... 25 

 Features and capabilities ........................................................................................................... 25 

 Options ...................................................................................................................................... 26 

 Specifications ............................................................................................................................. 26 
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About the JD780A series 

Viavi wireless RF and fiber test solutions for the 

field include base station analyzers, cable and 

antenna analyzers, and signaling analyzers for the 

installation and maintenance of modern wireless 

communication systems. RF and fiber test is 

critical for wireless operators facing challenges of 

signal quality and signaling interference, and 

maintaining quality high-bandwidth services. 

 

The JD780A series addresses spectrum analysis, 

interference analysis, and cable, antenna and 

modulation analysis, covering current wideband technologies such as WiMAX and LTE/LTE-Advanced. 

 

Base station analyzer JD785A 

The Base Station Analyzer contains all the features and capabilities required to perform field testing of 

cell sites of all wireless technologies, from 2G to 4G. 

 

RF analyzer JD786A 

The RF Analyzer provides multi-purpose solution for the analysis of RF systems covering all physical 

aspects of transmission, reception, and interference of RF systems up to 8 GHz. 

 

Signal analyzer JD788A 

The Signal Analyzer contains all the features and capabilities required to perform cell site field testing 

for all wireless technologies from 2G to 4G. 

 

Features and capabilities 

The JD780A series is the optimal test solution for installation and maintenance of cellular base stations 

and cell sites, running with external AC power or battery for the field. 

 

The user interface has been specifically designed with customized menus and simple calibration 

procedures, providing service providers with accurate and reliable measurement results. 

 

Applicable Systems 

 cdmaOne/cdma2000 

 EV-DO 

 WCDMA/HSPA+ 

 GSM/GPRS/EDGE 

 TD-SCDMA 

 WiMAX 

 LTE/LTE-Advanced (FDD/TDD) 
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Key Features 

Table 5 Key functions 

Functionality JD785A JD786A JD788A 

Spectrum Analyzer    

Cable and Antenna Analyzer    

RF Power Meter    

Optical Power Meter    

Fiber Inspection    

Signal Analyzers (optional)    

E1/T1 Analyzers (optional)    

Interference Analyzer (optional)    

Channel Scanner (optional)    

OTA Measurement (optional)    

EMF Analyzer (optional)    

 

Options 

This instrument is provided with various options/features that are available to be ordered. See 

“Appendix I – Ordering information” on page 599 for more information. 

 

Specifications 

AC power 

Input voltage is automatically selected within the instrument’s tolerable input line voltage from 100 to 

240 VAC. This instrument does not have a separate line protection fuse. 

 

Table 6 AC power requirements 

Item Specification 

AC Power 100 to 240 V AC, 50-60 Hz 

Power Consumption 37 W in operation; 49 W with battery charging 

 

Physical specifications 

Table 7 shows weight with standard configurations and the battery pack installed. 

 

Table 7 Physical specifications 

Parameter JD785A/JD786A JD788A 

Height 7.7” (195 mm) 7.7” (195 mm) 

Width 11.6” (295 mm) 11.6” (295 mm) 

Depth 3.2” (82 mm) 3.2” (82 mm) 
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Getting Started 

This chapter provides general guides of how to get started with your JD780A series instrument. Topics 

discussed in this chapter are as follows: 

 

 Unpacking the JD780A series ................................................................................................... 28 

 Exploring the JD780A series ..................................................................................................... 28 

 Installing battery pack ................................................................................................................ 32 

 Starting up the JD780A series ................................................................................................... 33 

 Managing files ............................................................................................................................ 33 

 Configuring system .................................................................................................................... 37 

 Upgrading firmware ................................................................................................................... 40 

 Managing licenses ..................................................................................................................... 41 

 Performing service diagnostic ................................................................................................... 42 

 Using system administration ...................................................................................................... 44 

 Running IP test .......................................................................................................................... 45 

 Activating StrataSync ................................................................................................................ 45 

 Setting communication .............................................................................................................. 48 

 Managing help manual .............................................................................................................. 53 
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Unpacking the JD780A series 

Unpack and inspect the shipping package thoroughly to ensure that nothing was damaged during the 

shipment. Also, check that your delivered package includes all of your ordered items in the shipment. If 

contents in the package are damaged or defective or if there are any missing items, keep the shipping 

list and materials for carrier’s inspection and contact your nearest Viavi's authorized sales and service 

office. 

 

A basic test set of JD780A series would include the following items in the package. For more options, 

see “Appendix I – Ordering information” on page 599. 

 

Table 8 Items included in a basic test set shipment 

Item Quantity 

JD780A series instrument (JD785A, JD786A, or JD788A) 1 

AC/DC power adapter and power cord 1 

1.5 meter cross LAN cable 1 

1.8 meter USB A-to-B cable 1 

> 1 GB USB memory 1 

Rechargeable Lithium Ion battery pack 1 

12 V DC automotive adapter 1 

Stylus pen 1 

User’s manual and application software CD 1 

 

Exploring the JD780A series 

 

Figure 1 JD785A front panel view 
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Front panel 

The JD780A series analyzers have the same front panel look as like Figure 1, except for the bumpers 

in different colors. 

 

Power on/off button 

Key Description 

 

POWER ON/OFF – You can turn your instrument on or off. Two LEDs indicate power 

source and status. See “Starting up the JD780A series” on page 33. 

 

Function hard keys 

You can use these hard keys to activate specified functions as labeled on each key. 

 

Key Description 

 
MODE – You can select an analyzer mode from all the standard and optional modes 

available to your instrument. 

 
FREQ/DIST – You can configure frequency or distance settings. 

 
AMP/SCALE – You can configure amplitude and scale settings. 

 
BW/AVG – You can configure bandwidth and average settings. 

 
TRACE/DISPLAY – You can set up trace and display parameters. 

 
MARKER – You can analyze measurements with markers. 

 
PEAK SEARCH – You can set up peak search parameters. 

 

Hot keys 

When the user input field on the screen is inactive, you can use these hot keys to activate specific 

functions instead of numbers. When you see the user input field activated or highlighted, press the 

ESC hard key to use these hot keys. 

 

Key Description 

 

MEASURE – You can select measurements available for your selected analyzer mode. 

 

MEASURE SETUP – You can set measurement parameters available for your selected 

measurement mode. 

 

SAVE/LOAD – You can save or load your current screen, result, setup, or limit into or 

from the internal memory or an external USB memory drive. 

 

SWEEP – You can configure sweep parameters. 

 

TRIGGER – You can select trigger options such as internal, external, and GPS. 

 

SYSTEM – You can configure your system settings or view your current system 

information. 
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PRESET – You can use this key to return to a known state and make measurements. 

 

HOLD – You can change the sweep mode: Continue or Single. 

 

LIMIT – You can set limit settings such as display line, multi segment line, Save Limits, 

recall limits, or test specification limits. 

 

BACKLIGHT – You can turn the key backlight feature on or off. 

 

HELP – You can have the online help screen if available. 

 

Soft keys 

You can use not only the touchscreen keys but also these physical soft keys placed along the right 

side of the display to start a specific function associated with each soft key, invoke other screen keys, 

or select a unit. The More screen menu indicates that there are more than seven screen menus for the 

level. The small arrowhead symbol in the screen menu indicates that there are screen menus under 

the screen menu. 

 

Data entry and other keys 

Key Description 

 

ROTARY KNOB WITH ENTER KEY – You can change a value with predefined 

increments or move marker position. Rotating this knob clockwise increases value or 
moves a marker to the right and rotating counter clockwise does vice versa. This knob 
works as the ENTER hard key as well. 

  

ARROW KEYS – You can increase or decrease value or move your selection up, down, 

to the left, or to the right. 

 

NUMERIC KEYS – You can manually enter a value for measurement parameters. 

 

DEL – You can delete data entry. After pressing the ENTER key or selecting a unit soft 

key, you cannot delete or remove data entered. 

 

ENTER – You can save and confirm data entry. 

 

ESC – You can cancel any input in the user input field or dismiss a pop-up window on the 

screen. 

 

PREV – You can go back to the previous menu without changing current setup. 

 

Top panel 

The JD785A and the JD786A analyzers have the same top view as Figure 2, except for the E1/T1 inlet. 

The JD786A has the GPIO inlet instead. 
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Figure 2 JD785A top panel view 

 

 

Reflection/RF Out (Cable and Antenna Analyzer) 

The Reflection/RF Out port of the Cable and Antenna Analyzer is a precise 50 Ω N-type female 

connector that is used as the output signal port for the Cable and Antenna Analyzer mode. 

 

 

CAUTION 

Do not apply or connect power exceeding +25 dBm to this Reflection/RF Out port. If such 
power is applied, it will degrade the product’s performance and can cause damage to the 
product in worst case. 

 

RF In (Cable and Antenna Analyzer) 

The RF In port is a precise 50 Ω N-type female connector that is used as the input signal port for 2-

port vector measurements in the Cable and Antenna Analyzer mode. 

 

 

CAUTION 

The maximum power allowed to the RF In port is +25 dBm. If the input power exceeds 
the limit, it may degrade the product performance or cause damage to the instrument in a 
worst case. Do not connect any power feed exceeding 1 W directly to this port. 

 

DC 18 V 

The input power to this port shall be 18 V DC. 

 

RF In (Spectrum Analyzer) 

The RF In port is a precise 50 Ω N-type female connector that is used as the input signal port for 

spectrum analysis, signal analysis, and RF power measurement. 

 

 

CAUTION 

The maximum power allowed to the RF In port is +25 dBm. If the input power exceeds 
the limit, it may degrade the product performance or cause damage to the instrument in a 
worst case. Do not connect any power feed exceeding 1 W directly to this port. 

 

Audio jack 

The audio jack is labeled with a headphones icon. Plugging in headphones or earphones turns the 

speaker off. 
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USB 

 CLIENT: This is a communication port that you can connect your instrument and your PC with 

application software JDViewer, JDRemote, or JDMapCreator. You must install driver software 

for the instrument on to the computer. See “Appendix H – Device driver installation” on page 

598 for more information. 

 HOST: You can use this port to plug in an external USB memory to extend storage capacity or 

to upgrade the instrument’s firmware. It supports most USB memory devices with 32-bit file 

system. You can also use this port to connect an external power sensor, Bluetooth USB 

adapter, or P5000i fiber microscope. See “Appendix G – Bluetooth connection” on page 595 

on how to set up and use the Bluetooth connection. 

 

LAN 

You can use this Ethernet communication port to connect your instrument and your PC using the 

application software JDViewer or Motorola WinLMF, if necessary. Two LEDs indicate data transfer 

activity and link status. 

 ACTIVITY: The yellow LED is illuminated during data transfer. 

 LINK: The green LED is illuminated when there is a valid communication connection. 

 

E1/T1 for JD785A 

You can use this E1/T1 input port to detect an error or alarm from E1/T1 signal and to transmit test 

pattern to E1/T1 transmission line connected through the provided RJ45 cable accessory. 

 

GPIO for JD786A and JD788A 

This General Purpose Input/Output (GPIO) port is factory use only. 

 

External In 

 GPS: You can plug in a GPS antenna to this SMA type female connector in order to get 

location information and highly accurate reference. 

 TRIGGER: You can use this SMA type female connector to receive PP2S clock or 10 ms 

synchronization signals from an external timing reference. 

 REF: You can use this SMA type female connector to receive 10 MHz, 13 MHz, or 15 MHz 

reference clock signals from an external frequency source. 

 

Installing battery pack 

You need to install the Lithium Ion battery pack provided with your instrument. Follow the instruction to 

install or remove the battery pack as needed. 

 

Procedure 

To install the battery pack: 

1. Loosen the latching screw of the battery cover by turning counter clockwise. 

2. Slide out the battery cover to open. 

3. Insert the battery pack with the connector terminal side up and push in until it stops. 



JD780A Series Analyzers 

 Getting Started 33 

4. Slide in the battery cover to close. 

5. Tighten the latching screw of the battery cover 
by turning clockwise. 

 
To remove the battery pack: 

1. Loosen the latching screw of the battery cover  
by turning counter clockwise. 

2. Slide out the battery cover. 

3. Hold the battery strap and pull it out. 

 

 

CAUTION 

The battery pack that came with your instrument is Lithium Ion and it may, if not 
connected correctly, lead to explosion. In case you need to replace the battery, you must 
use one of the same kinds or compatible ones. You must dispose a battery according to 
your local safety and environmental regulations. 

 

 

NOTE 

It is recommended that you turn off the instrument to replace the battery. However, if you 
do not want to interrupt the current test, you can leave the module turned on with the AC 
power adapter plugged in. 

 

Starting up the JD780A series 

Use the power button to turn your JD780A series on or off. When external power is supplied via the 

AC/DC adapter, the upper orange LED is illuminated. 

 

Procedure 

To turn on: 

1. Press and hold the      POWER button for a few seconds until the lower green LED indicator is 

illuminated. 

2. Release the button and wait for a few seconds while booting up. 
 
To turn off: 

1. Press and hold the      POWER button for a few seconds until the lower green LED indicator 

goes out. 

2. Release the button. 

 

Managing files 

The JD780A series lets you save and load screen, result, setup, limit, logging data, or Fail events 

depending on your selected measurement mode and option. 

 

 

NOTE 

If you see greyed-out menus as you change measurement modes, this indicates that the 
menu(s) are not available to be used. 

 

Using save 

You can save your current screen, result, setup, and limit into the internal memory or your external 

USB memory drive. 
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Procedure 

1. Press the SAVE/LOAD hot key. The Save/Load screen menu bar appears. 

2. Press the Save soft key. 

3. Select the save option, from the following choices: 

 

To save Select File type 

Current screen Save Screen > Screen .png 

Measurement result in a report 
format with comments 

Save Screen > Report .pdf 

Measurement result Save Result .tra 

.gom 

.grr 

.jdt 

Measurement result (.csv) Save Result as CSV Format .csv 

Setup and test configuration Save Setup .sta 

Limit setting Save Limit .jml 

Logging data Save Logging Data .grr 

.gsr 

.csv 

Automatically screen or results 
that falls outside the defined 
limit settings (Failed event) 

Save On Event .png 

.tra 

.csv 

The on-screen keyboard appears. 

 

 

NOTE 

- Save Setup saves a test configuration only and measurement limit setting. You must 

use Save Limit to save your limit settings. 

 

- In the Spectrum measurement of Spectrum Analyzer and Interference Analyzer 

modes, Save Setup saves the test configuration and measurement limit settings. 

 
- In the Cable and Antenna Analyzer mode, if the limit line is enabled and set, Save 

Result saves the trace together with the set limit line. 

 
- In the Spectrum measurement of Spectrum Analyzer and Interference Analyzer 

modes, if the limit line is enabled and set, Save Result saves the trace together with 

the set limit line. 

4. Type the name of the file in the File Name field with or without using a keyword. 

5. Optional. 

–  To create or edit keywords, touch the Edit Keywords button, select your desired keyword 
button in the upper screen, type a keyword, and then tap the Save button on the keyboard. 

See “Editing or adding a custom keyword” on page 606 for more information. 

–  To include a keyword in the file name, touch the Append Keywords button, select your 
desired keyword, and then tap the Keyboard button. See “Appending a keyword” on page 

607 for more information. 

–  To change the file location in the internal memory or to your USB memory drive, tap the 
Location button, select your desired file path using the touch screen or the rotary knob, 
and then press the Apply soft key. 
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–  To create a folder, press the Create Folder soft key, type a directory name, and then press 
the Apply soft key. 

6. Press the Save soft key. 

 

Saving fail events 

Depending on the measurement mode, you can let the instrument automatically save measurement 

screen or result that falls outside the defined limit settings or the Fail indicator is on. You can also set 

to save the first event and hold the measurement or to save all the events continuously. 

Procedure 

1. Press the SAVE/LOAD hot key. The Save/Load screen menu bar appears. 

2. Press the Save soft key. 

3. Press the Save On Event soft key. 

4. Press the Save Type soft key, and then select the save option: Screen, Result, or Result as 
CSV Format. 

5. Optional. Toggle the Save Then Stop soft key and select On in order to save the first event that 

falls outside the limit(s) and to hold the measurement. Otherwise, leave this feature off to save 
events continuously. 

6. Press the Start soft key to start saving. The on-screen keyboard appears. 

7. Type the name of the file in the File Name field with or without using a keyword. 

8. Optional. 

–  To create or edit keywords, touch the Edit Keywords button, select your desired keyword 
button in the upper screen, type a keyword, and then tap the Save button on the keyboard. 

See “Editing or adding a custom keyword” on page 606 for more information. 

–  To include a keyword in the file name, touch the Append Keywords button, select your 
desired keyword, and then tap the Keyboard button. See “Appending a keyword” on page 

607 for more information. 

–  To change the file location in the internal memory or to your USB memory drive, touch the 
Location button, select your desired file path using the touch screen or the rotary knob, 
and then press the Apply soft key. 

–  To create a folder, press the Create Folder soft key, type a directory name, and then press 
the Apply soft key. 

9. Press the Done soft key. 
The “Event Save” appears on the screen and the Start screen menu changes to Stop. 

10. Press the Stop soft key to end the event saving. 

 

Saving logging data 

You can save logging data in if your measurement mode supports this feature and has the activated 

Save Logging Data soft key. 

 

Procedure 

1. Press the SAVE/LOAD hot key. The Save/Load screen menu bar appears. 

2. Press the Save soft key. 

3. Press the Save Logging Data soft key. The on-screen keyboard appears. 

4. Type the name of the file in the File Name field with or without using a keyword. 
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5. Optional. 

–  To create or edit keywords, touch the Edit Keywords button, select your desired keyword 
button in the upper screen, type a keyword, and then tap the Save button on the keyboard. 

See “Editing or adding a custom keyword” on page 606 for more information. 

–  To include a keyword in the file name, touch the Append Keywords button, select your 
desired keyword, and then tap the Keyboard button. See “Appending a keyword” on page 

607 for more information. 

–  To create a folder, press the Create Folder soft key, type a directory name, and then press 
the Apply soft key. 

–  To change the file location in the internal memory or to your USB memory drive, touch the 
Location button, select your desired file path using the touch screen or the rotary knob, 
and then press the Apply soft key. 

 

 

NOTE 

In is recommended that you use an external USB memory drive to save logging data in 
the Auto Measure mode in order to have enough free space. 

6. Optional only in the Auto Measure mode. 
Toggle the Save Screen soft key and select All to save all the Auto Measure screens or Fail to 

save only the ones with the Fail on. 

7. Press the Save soft key to start logging. 

The “Recording” appears on the screen. 

8. Press the ESC hard key to stop logging data and complete saving. 

 

Using load 

You can load your saved screen, result, setup, and limit from the internal memory or your external 

USB memory drive. 

 

Procedure 

1. Press the SAVE/LOAD hot key. The Save/Load screen menu bar appears. 

2. Press the Load soft key. The Load screen menu bar appears. 

3. Select the load option, from the following choices: 

 

To load Select 

Saved screen or report Load Screen 

Measurement result Load Result 

Setup and test configuration Load Setup 

Limit setting Load Limit 

Logging data Load Logging Data 

Map file Load Map 

Scenario Load Scenario 

The file manager window appears. 

4. Select the name of the file to be loaded from the internal memory or from your USB drive. 
Information of your selected file appears in the File Information pane. 

5. Press the Load soft key. 



JD780A Series Analyzers 

 Getting Started 37 

Using file manager 

The File Manager lets you copy, cut, paste, and delete data files saved in the internal memory or in 

your USB memory drive. 

 

Procedure 

1. Press the SAVE/LOAD hot key. The Save/Load screen menu bar appears. 

2. Press the File Manager soft key. The file manager window appears. 

3. To copy, cut, and paste, complete the following steps: 

a. Select a file or folder by using the touch screen or the rotary knob. 

b. Select the Copy or Cut soft key. 

c. Select the location to which the file or folder to be pasted. 

d. Press the Paste soft key. 

4. To delete, complete the following steps: 

a. Select a file or folder by using the touch screen or the rotary knob. 

b. Press the Delete soft key. 

The confirmation dialog box appears. 
Once the file or folder is deleted, you cannot recover it. 

c. Select OK to delete. 

5. Press the Exit soft key or the ESC hard key to close the file manager window. 

 

Configuring system 

Setting frequency reference 

You can improve measurement accuracy by setting frequency reference. 

 

Procedure 

1. Press the SYSTEM hot key. 

2. Press the Freq Reference soft key. 

3. Select the frequency reference option: Internal, External 10 MHz, External 13 MHz, 
External 15 MHz, or GPS. 

 

Setting date and time 

You can set the instrument’ system clock to your region. 

 

Procedure 

1. Press the SYSTEM hot key. 

2. Select System Configuration > Date/Time. The current time zone information box appears. 

3. To change the standard time zone, complete the following steps: 

a. Press the Std Time Zone soft key. 

b. Select your time zone by using the rotary knob or arrow keys. You can also use the 
Top/Bottom or Page Up/Down soft keys. 
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c. Press the ENTER hard key to save your change. You can also press the rotary knob. 

4. To change the date format, complete the following steps: 

a. Press the Date Format soft key. 

b. Select YYMMDD, MMDDYY, or DDMMYY as needed. 

5. To set the date and time manually, complete the following steps: 

a. Select Year, Month, Day, Hour, or Minute soft key as needed. 

b. Enter a value by using numeric keys. 

c. Press the Enter soft key to save your change. 

6. Press the Apply screen key to save and exit. 

 

Setting language 

You can change the system language for the menus, messages, and information on screen. 

 

Procedure 

1. Press the SYSTEM hot key. 

2. Select System Configuration > Language. 

3. Select the language option from the choices available. 

 

Setting power on 

Procedure 

1. Press the SYSTEM hot key. 

2. Press the Power On soft key. 

3. Select the power-on option, from the following choices: 

–  Last: Boots up with the last state of the instrument before power-off or shut-down. 

–  Preset: Boots up with the default settings preset in the factory. 

–  User: Boots up with the user-defined setup. 

When the User is selected, the User Setup menu under System becomes activated. 

4. Optional. . If you have selected User in step 3, complete the following steps to specify a user 

setup file to be used: 

a. Press the User Setup soft key. 

b. Select the name of the user setup file. 

c. Press the Done soft key. 

 

 

NOTE 

The Preset is to revert to original factory settings. It is recommended that you use this 
option when you have experienced badly misadjusted settings. 

 

Changing display mode 

You can change the instrument’s display mode as needed. 
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Procedure 

1. Press the SYSTEM hot key. 

2. Select System Configuration > Display Mode. 

3. Select a display mode from the choices: Indoor, Outdoor, and Night. 

4. The instrument optimizes screen colors to each choice. 

 

Setting sleep time 

You can set the amount of time up to 255 minutes to let the instrument automatically turn the backlight 

off and enter into power saving mode after no actions or data entries. Default setting is zero, which 

indicates that the sleep mode is turned off and screen backlight is always on. 

 

Procedure 

1. Press the SYSTEM hot key. 

2. Select System Configuration > Sleep Time. 

3. Enter the amount of minutes by using the numeric keys. You can also use the rotary knob. 

4. Press the Enter soft key. 

 

Adjusting LCD brightness 

You can adjust display brightness from one to ten as needed. The larger number you set, the brighter 

the display becomes. 

 

Procedure 

1. Press the SYSTEM hot key. 

2. Select System Configuration > LCD Brightness. 

3. Enter a value by using the numeric keys. You can also use the rotary knob. 

4. Press the Enter soft key. 

 

Adjusting volume 

You can turn the sound on or off or adjust the volume from one to ten as needed. 

 

Procedure 

1. Press the SYSTEM hot key. 

2. Select the sound option, from the following choices: 

–  To turn the sound or alarm off, toggle the Sound soft key and select Off. 

–  To turn the sound or alarm on, toggle the Sound soft key and select On. 

–  To adjust the volume, complete the following steps: 

a. Press the Sound soft key. 

b. Enter a value by using the numeric keys. 

c. Press the Enter soft key. 
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Upgrading firmware 

It is recommended that you maintain your instrument up-to-date with its latest firmware in order to 

achieve the instrument’s optimal performance.  

 

Checking installed firmware version 

Procedure 

1. Press the SYSTEM hot key. 

2. Press the HW/FW Info soft key. 

3. Find the installed version number in the Firmware field. 

4. From a computer with Internet access, visit Viavi’s Software Updates website and check if your 
installed firmware is the latest one. Do the steps 5-6 if you want to update your firmware with 

using your USB memory drive. 

5. Download a latest firmware file from the website to the root directory of your USB memory drive. 
 

 

NOTE 

It is recommended that you format your memory drive to have enough space to download 
the file. 

6. Unzip the download file into the root directory of your USB memory stick. 
A firmware file (*.fw) and a firmware release note (*.pdf) are extracted. 

 

Installing new firmware 

To update your firmware, you can choose either way of using your USB memory drive or accessing the 

FTP server over the network. 

 

Upgrading from USB memory drive 

Procedure 

1. Power your instrument via the AC-DC adapter to prevent any severe damage to your instrument 
caused by a power-off in the middle of the upgrade, which may require a repair in the factory. 

2. Plug in the USB memory drive to the USB Host port of your instrument. 

3. Press the SYSTEM hot key. 

4. Select More (1/2) > Upgrade > USB. 

The file manager window appears. 

5. Highlight the firmware file (.fw) saved in the root directory of your USB drive. 

6. Press the Select soft key. 

The Update Firmware dialog box appears. 

7. Press the OK button to start to install the new firmware.  

The Upgrade Status bar appears. 
 

 

NOTE 

Firmware upgrade will be done within 30 minutes or so in most cases, but depending on 
the number of files to be reconfigured, it may take longer than that. 

8. After you have restarted the instrument, check the installed firmware version and DSP versions 
in the System settings. Refer to the firmware release note to find correct DSP version and 
compatible application software versions. 

 

http://www.jdsu.com/en-us/Test-and-Measurement/support/Software-Updates/Pages/sw-updates.aspx
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WARNING 

Do not remove the USB drive while upgrading the firmware. 

 

Upgrading from FTP server 

Procedure 

1. Power your instrument via the AC-DC adapter to prevent any severe damage to your instrument 
caused by a power-off in the middle of the upgrade, which may require a repair in the factory. 

2. Press the SYSTEM hot key. 

3. Select More (1/2) > Upgrade > FTP Server. 

The upgrade server dialog box appears. 
 

 

NOTE 

Older version of firmware does not have the FTP Server option. It is recommended that 
you update your firmware with the USB option first. 

4. Enter ftp2.jdsu.com in the server address field. 

5. Enter your proxy server address in the proxy server field, if necessary. 
Contact your system administrator for your proxy server information. 

6. Tap the Check button to check if the installed firmware version is the latest one. 

7. Do one of the following: 

–  If you view the latest firmware version information, tap the Install button to continue. 

–  If the message “Your firmware is up to date.” is displayed, tap the Cancel button. 
 

 

NOTE 

Firmware upgrade will be done within 30 minutes or so in most cases, but depending on 
the number of files to be reconfigured, it may take longer than that. 

8. After you have restarted the instrument, check the installed firmware version and DSP versions 
in the System settings. Refer to the firmware release note to find correct DSP version and 
compatible application software versions. 

 

Managing licenses 

The License Manager lets you view installed options, install additional ones, and load evaluation 

licenses. 

 

Checking installed or installable options 

Procedure 

1. Press the SYSTEM hot key. 

2. Select More (1/2) > License Manager. The License Manager menu bar appears. 

3. Select the menu, from the following choices: 

–  To view the installed options, select the Installed Options soft key. 

The list of options appears. The “(T)” indicates temporary licenses. 

4. To view the installable options, select the Installable Options soft key. 
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Installing purchased options 

Procedure 

1. Press the SYSTEM hot key. 

2. Select More (1/2) > License Manager. 

The License Manager menu bar appears. 

3. Select the Install an Option soft key. The Installable Options window appears. 

4. Highlight the name of the option from the list by using the rotary knob. 

5. Press the ENTER hard key. You can also press the rotary knob. 

The License Code bar appears. 

6. Type the number of the license to activate by using the numeric keys. 

7. Press the ENTER hard key. You can also select the Enter soft key. 

 

Loading temporary license 

The temporary license that you received from Viavi is intended for your evaluation only and it expires 

after its specified time limit. 

 

Procedure 

1. Press the SYSTEM hot key. 

2. Select More (1/2) > License Manager.  

The License Manager menu bar appears. 

3. Select the Load Temp License soft key. The file manager window appears. 

4. Select the name of the license file. 

5. Press the Load soft key. 

6. Optional. You can check the loaded license using the Installed Options menu. 

 

Viewing OSS license 

The JD780A series incorporates software that is covered by either the GNU General Public license or 

GNU Lesser General Public License. Check the OSS license notification for more details. 

 

Procedure 

To view OSS license notification and distribution: 

1. Press the SYSTEM hot key. 

2. Select More (1/2) > License Manager. 

The License Manager menu bar appears. 

3. Select the OSS License soft key. 

The Open Source Code Notification & Distribution screen appears. 

 

Performing service diagnostic 

The Service Diagnostic lets you view system log, perform self-test, revert the instrument settings to its 

factory settings, or perform touch alignment. 
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Viewing system log 

Procedure 

1. Press the SYSTEM hot key. 

2. Select More (1/2) > Svc Diagnostic > System Logging. 

3. Optional. Press the Save soft key to save the system log as a .log file type. 

 

Running self-test 

You can run a self-test on your instrument boards and modules. 

 

Procedure 

1. Press the SYSTEM hot key. 

2. Select More (1/2) > Svc Diagnostic > Self Test. 

The on-screen instruction appears. 

3. Connect a test cable between the Reflection/RF Out port for Cable and Antenna Analyzer and 

the RF In port for Spectrum Analyzer. 

4. Press the Start soft key. 

The test result window appears. 

5. Optional. Press the Save Screen soft key to save the self-test results. 

Performing factory reset 

The Factory Reset is used only when you want to purge all the user settings and data stored in the 

system and return to the instrument’s factory state. 

 

Procedure 

1. Press the SYSTEM hot key. 

2. Select More (1/2) > Svc Diagnostic > Factory Reset. 

The confirmation dialog box appears. 

3. Press the Yes soft key to continue. Otherwise, select No. 

 

 

NOTE 

It is recommended that you copy your setup or result data to an external USB memory 
drive so that you can restore them later. 

 

Re-aligning touch screen 

When you consistently experience of the instrument responding improperly to your touch on the 

screen, you may need to perform this touch-screen alignment. 

 

Procedure 

1. Press the SYSTEM hot key. 

2. Select More (1/2) > Svc Diagnostic > Touch Alignment.  

The white screen with a plus sign (+) in the upper-left corner appears. 

3. Touch the plus sign and repeat until the previous screen is back on. 
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Using system administration 

The Administration is used to disable editing limits, enable modifying online help, or change 

administration password. 

 

Logging in 

You need to log in first to access the administration menus. 
 

Procedure 

1. Press the SYSTEM hot key. 

2. Select More (1/2) > Administration. The password box appears. 

3. Enter <password> by using the numeric keys. 

Default password is “0000”. To change the password, see “Changing password” on page 44. 

4. Press the Apply soft key. 

 

Changing password 

Procedure 

1. Press the SYSTEM hot key. 

2. Select More (1/2) > Administration, and then enter your password. 

3. Press the Change Password soft key. The new password box appears. 

4. Enter a new password up to eight digits by using the numeric keys. 

5. Press the Apply soft key. The reconfirmation box appears. 

6. Enter the new password again by using the numeric keys. 

7. Press the Apply soft key to complete changing password. 

 

Locking limit key 

You can lock the LIMIT hot key and disable editing predefined limit settings to prevent any 

unintentional changes, which could result in incorrect measurements. 

 

Procedure 

1. Press the SYSTEM hot key. 

2. Select More (1/2) > Administration, and then enter your password. 

3. Toggle the Edit Limit soft key and select Disable to lock the LIMIT hot key or Enable to unlock 

the key. 

 

 

NOTE 
Disabling the Edit Limit limits the access to the LIMIT hot key only. The Limit features 

including displaying limit line(s) and Pass/Fail result function properly as predefined. 

 

Modifying online help 

The online help can be modified if needed. 
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Procedure 

1. Press the SYSTEM hot key. 

2. Select More (1/2) > Administration, and then enter your password. 

3. Toggle the Modify Help soft key and select Enable to allow modifying the online help or Disable 

to restrict any modification. 

 

Running IP test 

You can test an Internet Protocol (IP) configuration of the cell site’s backhaul. 

 

Procedure 

1. Press the SYSTEM hot key. 

2. Select More (1/2) > Utility > IP Test. 

3. Select the command option, from the following choices: 

–  To display the route and measure transit delays of packets, toggle the Commands soft key 
and select Traceroute. 

–  To display the reachability and measure the round-trip time, toggle the Commands soft key 
and select Ping. 

4. To set the destination IP address to be tested, complete the following steps: 

a. Press the Destination IP soft key. 

b. Press the First Octal soft key. 

c. Enter a value, and then press the Enter soft key. 

d. Press the Second Octal soft key and repeat step c. 

e. Press the Third Octal soft key and repeat step c. 

f. Press the Fourth Octal soft key and repeat step c. 

5. Press the Execute soft key and select Start to start testing. 

Test result is displayed on the screen as the test is progressing. 

6. Press the Execute soft key and select Stop to stop testing. 

7. Optional. Press the Save soft key to save the test result as a .txt file type. 

 

Activating StrataSync 

StrataSync is a cloud-based solution that provides asset, configuration, and test data management for 

Viavi instruments. StrataSync manages and tracks test instruments, collects and analyzes results from 

the entire network, and informs and trains the workforce. 

 

The JD780A series is compatible with the Viavi StrataSync cloud. This optional capability allows you to 

manage your instrument inventory ensuring you know where all your valuable equipment is and which 

engineer is using it. In addition, it allows you to keep your instruments current through the remote 

upgrade capability that ensures all instruments have the latest firmware. It also enables the centralized 

distribution of configuration settings to ensure all your engineers use the same instrument settings 

resulting in consistent measurements. 

 

Once testing is completed, the trace files can be uploaded onto StrataSync for secure storage and 
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sharing. This sharing capability allows engineers who have a problem they cannot resolve to request 

help from an expert who can analyze the trace file via StrataSync using applications such as JDViewer, 

JDFileViewer, JDPowerMeter, etc. from anywhere without having to be at the instrument, helping 

resolve problems even faster. 

 

Setting up Internet connection 

Your JD780A series instrument must have Internet access to be able to connect to the StrataSync. You 

can set up for wireline or wireless Ethernet network connection. You can also use your mobile device’s 

data network such as the Bluetooth tethering on an Android-based smartphone and the Personal 

Hotspot on an iOS-based smartphone. If you want to share your mobile’s data network, you need to 

connect your instrument to your mobile device. 

 

Procedure 

1. Connect one of the Parani-UD100 Bluetooth adapters to the USB port of your JD780A series. 

2. Turn on Bluetooth on your mobile device, and then activate its tethering or hotspot. 

–  On Android mobile devices: 

a Go to Settings > Connections > Bluetooth. 

b Check the box for Visible to all nearby Bluetooth devices to make your mobile 

device discoverable by your instrument. 

c Go to Settings > More networks > Tethering and portable hotspot. 

d Check the box for Bluetooth tethering to enable sharing your mobile device’s Internet 

connection with your instrument. 

–  On iOS mobile devices: 

a Go to Settings > Bluetooth. 

b Turn on Bluetooth. 

c Go to Settings > Personal Hotspot. 

d Turn on Personal Hotspot to make your mobile device discoverable by your 

instrument and enable sharing your mobile device’s Internet connection with your 
instrument. 

3. On your instrument, press the SYSTEM hot key. 

4. Select System Configuration > Remote Interface > Bluetooth > Connect. 

5. Press the Scan soft key to discover your mobile device. 

You will find your mobile device from the list on the screen. 

6. Highlight your mobile device name from the list, and then press the Select soft key. 

A dialog box appears. 

7. Tap the Connect button to pair and connect. 

8. On your mobile device, enter 0000 in the PIN field, and then tap the OK button or Pair. 

If the connection is successful, “(Paired & Connected)” appears next to the name of your mobile 
device on your instrument. If the connection is unsuccessful, repeat steps 6 and 7. 

9. Press the PREV hard key to return to the Bluetooth Information screen that displays the paired 

device and connected service including your CellAdvisor’s IP Address. 

 

NOTE 

If you want to use the Web-based remote control described on page 52 using this 
Bluetooth tethering, record the IP address assigned to your JD780A series to have 
access to the instrument on your smartphone’s Web browser. 

 

 

Establishing a connection to StrataSync 

Procedure 

1. Press the SYSTEM hot key. 
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2. Select More (1/2) > Utility > StrataSync. 
The StrataSync setting window appears as shown in Figure 91. 

3. Enter <server address> in the Server Address field for StrataSync. 
The server address at the time of this document production is “stratasync.viavisolutions.com”, 

which may change. 

 

NOTE 

Viavi provides you with the information required to access StrataSync at your 
purchase of StrataSync, including the Server Address, Account ID, and Port 

number. See “JD780A Series Common Options” on page 602 for more information 
on available options. 

4. Enter <account number> in the Account ID field. 

5. Enter <technician number> in the Technician ID field. 

6. To set the port number and proxy server address, complete the following steps: 

a. Tap the Detail Settings button. 

The input dialog box appears. 

b. Enter <port number> in the Port field. 

c. Enter <proxy server address> in the Proxy Server address, if necessary. 

Contact your system administrator for your proxy server information. 

d. Tap the Apply button to save and exit. 

7. Tap the Start Sync button. 

Once successfully synchronized, the text “Successfully synchronized with server” appears and 

the StrataSync icon changes accordingly. 

8. Tap the Apply button to exit. 

 

Figure 3 StrataSync setting window 

 

 

StrataSync status indicators 

The StrataSync indication icons provide you with the connection and activity status. 

 

Indicator Description 

   
Indicates that your instrument is idle to be connected and synchronized with the 
StrataSync server. 
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Indicates that your instrument is acquiring an authentication, synchronizing with the 
server, and sharing data. 

   
Indicates that your instrument is synchronized successfully. 

   
Indicates that your instrument failed to synchronize with the StrataSync server or 
encountered an error. 

 

Setting communication 

JD780A series provides several methods for you to connect your instrument with application software 

or other instruments and devices. 

 

Configuring Ethernet 

You can configure a network to connect your JD780A series to a computer installed with Viavi software 

applications such as JDViewer or JDRemote via Ethernet. JD780A series supports both IPv4 and IPv6 

protocols. 

 

Setting for IPv4 protocol 

Procedure 

1. Press the SYSTEM hot key. 

2. Select System Configuration > Ethernet Config > IPv4. 

The Ethernet Configuration box appears. 

3. Do one of the following: 

–  To enable automatic IP addressing, toggle the Mode soft key and select DHCP. 

–  To manually assign fixed IP addresses, complete the following steps: 

a. Toggle the Mode soft key and select Static. 

b. Press the IP Address soft key. 

c. Type in an address including dots in the user input field. 

d. Press the ENTER hard key or Enter soft key. 

e. Press the Subnet Mask soft key and repeat steps c-d. 

f. Press the Gateway soft key and repeat steps c-d. 

g. Press the DNS soft key and repeat steps c-d. 

4. Press the Apply soft key to complete the network configuration. 

The message “Applying Network Info…” appears. 

 

Setting for IPv6 protocol 

Procedure 

1. Press the SYSTEM hot key. 

2. Select System Configuration > Ethernet Config > IPv6. 

3. Do one of the following: 

–  To enable automatic IP addressing, toggle the Mode soft key and select Auto. 
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–  To manually assign fixed IP addresses, complete the following steps: 

a. Toggle the Mode soft key and select Static. 

The Ethernet Configuration box appears. 

b. Press the IP Address soft key. 

c. Type in an address including colons using the on-screen keyboard. 

d. Press the Apply soft key to complete the input. 

e. Press the Subnet Prefix Length soft key. 

f. Enter a length value using the numeric keys, and then press the Enter soft key. 

g. Press the Gateway soft key and repeat steps c-d. 

h. Press the DNS soft key and repeat steps c-d. 

4. Press the ESC hard key, and then make sure to press the Apply soft key in the IPv6 menu bar in 

order to apply and complete the network configuration. 
The message “Applying Network Info…” appears. 

 

Setting for JDViewer and JDRemote 

The App SW is set by default to make it easy to connect your instrument to JDViewer, JDRemote, 

JDMapCreator, and other applications. After using other remote interfaces such as SCPI, LMF, and 

USBTMC, it is recommended that you set the LAN and USB settings back to App SW. 

 

Procedure 

1. Press the SYSTEM hot key. 

2. Press the System Configuration soft key. 

3. Press the Remote Interface soft key and then do the following: 

–  Select the LAN soft key and then press the App SW soft key. 

–  Select the USB soft key and then press the App SW soft key. 

 

Setting USBTMC mode 

The USB Test & Measurement Class (USBTMC) is a standard for programmatic control of USB-based 

test instruments that defines protocols used to send and receive messages. If you want to use the 

USBTMC protocol to communicate with the instrument remotely, you can turn this TMC Mode on. 

 

Procedure 

1. Press the SYSTEM hot key. 

2. Select System Configuration > Remote Interface > USB. 

3. Press the USBTMC soft key. 

The confirmation dialog box appears. 

4. Press the USBTMC soft key again to confirm the mode change and reboot the instrument. 

 

 

NOTE 
After using the USBTMC mode, you may want to set this setting back to App SW if you 

use JDViewer mainly for remote controlling your JD780A series. 

 

Setting SCPI mode 

You can use SCPI commands to control your JD780A series remotely. 
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Procedure 

1. Press the SYSTEM hot key. 

2. Select System Configuration > Remote Interface > LAN. 

3. Press the SCPI soft key. 

 

 

NOTE 
After using the SCPI mode, you may want to set this setting back to App SW if you use 

JDViewer or JDRemote mainly. 

 

Configuring LMF setting 

The Local Maintenance Facility (LMF) setting is used in order to perform TX Calibration and TX Audit 

on Motorola's CDMA/EV-DO BTS in the RF Power Meter mode. See “Appendix F – Motorola 

CDMA/EV-DO LMF” on page 593 for more information. 

 

Enabling Bluetooth connection 

If your JD780A series has the Bluetooth Connectivity option installed with a license, you can use the 

Bluetooth mode to enable communicate between your instrument and your computer with application 

software such as JDRemote and JDViewer or to transfer files to a Bluetooth storage device. See 

“Appendix G – Bluetooth connection” on page 595 for more information. 

 

Enabling Wi-Fi connection 

Wi-Fi Connectivity is an optional feature that you can activate by installing a purchased license on your 

JD780A series. After plugging a USB Wi-Fi LAN card using Realtek NICs into the instrument, you can 

join a wireless network from the instrument so that you can have access to StrataSync or control the 

instrument from the Web-based remote control on a computer. 
 

Procedure 

1. Plug in your USB Wi-Fi LAN card to the USB Host port of the JD780A series. 
The Wi-Fi LAN card is detected and the white Wi-Fi indicator appears on the screen to indicate it. 

 

NOTE 

CellAdvisor JD780A series is compatible only with a USB LAN card that uses Realtek 
NICs (RTL8188eu, RTL8192cu, and RTL8812au). 

2. Press the SYSTEM hot key. 

3. Select System Configuration > Remote Interface > Wi-Fi. 

The Wi-Fi mode is turned on automatically. After searching nearby networks, the instrument 
displays a list of networks. 

4. To select a network to join, complete the following steps: 

a. To refresh the networks list, press the Scan soft key. 
The instrument displays all detected networks as Detected and previously connected ones 
as Saved. 

b. Highlight a network to join by using the arrow keys or rotary knob. 

c. Press the Select soft key. 
The Wi-Fi Connection Info window appears for entries. Figure 4 is an example. 

5. To enter a user identity and a password for the network, complete the following steps: 

a. Tap on the input box for Identity, if required. 

The on-screen keyboard appears. 



JD780A Series Analyzers 

 Getting Started 51 

b. Type your identity, and then press the Apply soft key. 

c. Tap on the input box for Password, if required. 

The on-screen keyboard appears. 

d. Type a correct password that must be at least eight characters long. 

e. Press the Apply soft key. 

f. To view the password exactly as entered, tap the checkbox for Show Password to enable 

it. 

6. To configure IP network settings, complete the following steps: 

a. Select the TCP/IP protocol option from the choices: IPv4 and IPv6. 

Sub-selection options change according to your selection. If the selected network supports 
IPv6, you can configure IP settings for it. 

b. Do one of the following: 

–  To enable automatic IP addressing, select DHCP for IPv4 or Auto for IPv6. 

It is recommended that you select DHCP unless otherwise you know static IP 

addresses. 

–  To manually assign fixed IP addresses, select Static, and then enter addresses as 

required for IPv4 or IPv6. If you do not have required information, contact your 

network administrator. 

–  To disable the IPv6 protocol, select Off. 

7. Press the Connect soft key. 

Once connected, the Wi-Fi indicator turns to green and the Wi-Fi Connection Info window is 
updated with information about the connected network including SSID, status, authentication 
type, encryption method, BSSID, and assigned IP address(es). If you have selected Auto for 
IPv6 in step 6, you will have Link-Local, Stateless, and Stateful instead of IP Address. If you see 

the green Wi-Fi indication with a red exclamation mark in the center, it means that an IP address 
has not been assigned. 

 

NOTE 

It is important to record the IP address(es) if you want to use the Web Remote on your 
computer. 

8. To disconnect the currently connected network, select the network and then press the 
Disconnect soft key. 

9. To forget the selected network and delete it permanently from the list, press the Remove soft key. 

 

Figure 4 Example of Wi-Fi connection information window 
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Enabling Web-based remote control 

If your JD780A series has the Wi-Fi Connectivity option installed with a license, you can enable this 

Web Remote feature to control your instrument from most of Web browsers including Windows 

Internet Explorer (IE) 6 and later, Firefox, Chrome, Safari, and Android native browser in an accessible 

network. You can also use this feature to allow other users to access your instrument remotely and 

share the live screen concurrently with up to 10 clients in the network. 

 

Procedure 

1. Press the SYSTEM hot key. 

2. To get the IP address assigned to your instrument, do one of the following: 

–  For wireline LAN connection: 

a. Select System Configuration > Ethernet Config > IPv4 or IPv6. 

b. Toggle the Mode soft key and select DHCP or Auto for automatic IP addressing. 

c. Press the Apply soft key. 

The Ethernet Configuration box is updated with assigned IP address(es). 

d. Record the IP address(es). For IPv6 Auto, you will see Link-Local, Stateless, and 
Stateful instead of IP Address. 

 

NOTE 

If your network does not support the automatic IP addressing, contact your network 
administrator to get a fixed IP address assigned to your instrument. 

–  For wireless LAN connection: 

a. Select System Configuration > Remote Interface > Wi-Fi. 

b. Select the currently connected network from the list, and then press the Select soft key. 

c. Record the IP address displayed at the bottom. 

–  For Bluetooth tethering on an Android-based smartphone or Personal Hotspot on an  

iOS-based smartphone: 

a. Select System Configuration > Remote Interface > Bluetooth. 

b. Record the IP address assigned to your instrument under Connected Service. 

3. Press the SYSTEM hot key again. 

4. Select System Configuration > Remote Interface. 

5. Toggle the Web Remote soft key and select On to enable it. 

6. Open a Web browser on your computer or mobile device and then enter the IP address you have 
obtained in step 2, depending on the TCP/IP protocol. Examples are the following: 

–  IPv4: 10.82.26.254 (put the entire the address including dots in the URL bar) 

–  IPv6: [fe80::21b:22ff:fea1:924a] (make sure to add the brackets “[” and “]” and put the 

entire address including colons in the URL bar) 

Your instrument’s live screen appears on the Web browser as shown like Figure 5 or Figure 6. 

 

NOTE 

The IPv6 protocol is supported on the operation system “Windows Vista” and later. 
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Figure 5 Example of Web remote on iPhone 

 

 

Figure 6 Example of Web remote on Chrome 

 

 

Managing help manual 

JD780A series contains the JD780A series help manual by default. The name of default help menual is 

“System_Help”. You can browse the manual instantly from any screen by pressing the HELP hot key. 

 

Adding other help manual 

You can add other help manuals to your instrument by importing other help manuals from a USB 

memory drive. 

 

Procedure 

1. Insert a USB memory drive that contains the help files (.html). 

2. Press the HELP hot key. 
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3. Select Help manager > Import Help Files. 

The list of help files appears on the import help files window. 

4. Select a folder you want to add. 

 

NOTE 
You cannot copy the “Internal” folder. 

5. Tap the Copy button to complete. 
The text “Copy Completed” appears. The folder or file is copied under the User_Help folder in 
the Select Help. See Figure 7. 

 

NOTE 

The maximum storage size for user help is 10M. If the file exceeds the remained storage 
space, the text “Not enough space left” appears. 

 

 

Viewing help manual 

You can select a help manual to view on your instrument. 

 

Procedure 

1. Press the HELP hot key. 

2. Select Help manager > Select Help. 

The list of help files appears on the select help window. 

3. Select a folder or a help file you want to view, and then tap the Select button. 

4. Press the Home soft key to view the selected help manual. 

The selected help manual appears. 

5. To copy a folder or help file in the User_Help folder, select a foler or a help file, and then tap 
Copy > Paste. 

6. To delete a folder or a help file, select a folder or a help file, and then tap Delete > Yes. 

 

NOTE 
You cannot delet the User_Help folder. 

 

 

Figure 7 Example of select help screen 
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Analyzing Measurement Results 

This chapter provides instructions on how to use JD780A series’ capabilities for measurement analysis. 

Topics discussed in this chapter are as follows: 

 

 Using marker ............................................................................................................................. 56 

 Using peak search ..................................................................................................................... 57 
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Using marker 

Marker  

Marker is used to get the information about a specific trace. Six markers can be set on the display and 

each marker can be used independently. The X and Y coordinates of the trace are displayed when the 

marker is placed on any position of the trace. The position displaying the marker’s X and Y coordinates 

may be slightly different for each measurement mode and refer to the description of each 

measurement. There are three different marker types available: Normal, Delta, and Delta pair. Marker 

position can be set manually by entering numeric values (frequency) when one of the marker types is 

selected. 

 Select Marker: Selects an active marker whose position can be changed with the rotary knob 

or the arrow keys. The assigned number of the active marker is displayed in the Select Marker 

menu box and the active marker number is also displayed right next to the active marker on 

the trace when the Marker View is set to On. 

 Marker View: Displays the selected marker on the screen or hides it. When the Marker View 

is turned off and then on again in the same measurement mode, markers appear at the 

previous positions. If a measurement mode is changed, markers are not restored to their 

previous positions. 

 Normal: This Normal marker type provides the reading of a marker position on the trace along 

with the marker number between one and six. 

 Delta: This Delta marker type is associated with a Normal marker. A Normal marker must be 

set before a Delta marker is set. When the Delta marker is set, the position set by the Delta 

marker becomes the reference position of the Normal marker and the marker’s X and Y values 

displays the difference compared with the Delta marker. 

 Delta Pair: This Delta Pair marker type is associated with a Normal marker. A Normal marker 

must be set before a Delta Pair marker is set. When the Delta Pair marker is set, the position 

set by the Delta Pair marker becomes the reference position of the Normal marker and the 

marker’s X and Y values displays the difference compared with the Delta Pair marker. The 

reference position will be varied in accordance with trace change. 

 Marker All Off: Turns all the markers the screen off. When the Marker View is selected for 

those markers, the instrument displays those markers back at the previous position. If a 

measurement mode is changed, current settings are not restored. 

 Marker : Sets the X coordinate of the active marker as selected. 

- MarkerCenter: Sets the frequency of the active marker to the center frequency of 

spectrum analyzer. 

- MarkerStart: Sets the frequency of the active marker to the start frequency of spectrum 

analyzer. 

- MarkerStop: Sets the frequency of the active marker to the stop frequency of spectrum 

analyzer. 

 Frequency Count: This Frequency Count is used when a highly accurate reading of the 

frequency is needed for the active marker on the signal. The measurement sweeps get 

significantly slower because the instrument runs the measurement of the signal peak with 1 Hz 

resolution in background. Toggle this key between On and Off to enable or disable the 

frequency count function for the selected marker. 

 Noise Marker: This Noise Marker is used to measure a noise adjacent to a signal by 

averaging several data points to calculate the readout for the Noise Marker as if making a 

measurement using a 1 Hz bandwidth. Toggle this key between On and Off to enable or 
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disable the noise marker function for the selected active marker. 

 

 

NOTE 

Frequency Count and Noise Marker functions are used only in the Spectrum Analyzer 
mode. 

 

Using peak search 

Peak search  

Each time the Peak Search soft key is pressed, the active marker is positioned at the highest peak of 

the trace. 

 Peak Search: Moves the active marker to the highest peak of the trace. 

 Next Peak: Moves the active marker to the second highest peak of the trace. 

 Next Peak Right: Moves the active marker to the highest peak to the right of its current 

position. 

 Next Peak Left: Moves the active marker to the highest peak to the left of its current position. 

 Min Search: Moves the active marker to the lowest peak of the trace. 

 Always Peak: When the Always Peak is set to On, the instrument moves the active marker 

automatically to the highest peak of the trace every time the trace is refreshed. 
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Using Spectrum Analyzer 

This chapter provides instructions for using the Spectrum Analyzer function. Topics discussed in this 

chapter are as follows: 

 

 Introduction ................................................................................................................................ 59 

 Display overview ........................................................................................................................ 59 

 Connecting a cable .................................................................................................................... 60 

 Selecting measurement mode ................................................................................................... 61 

 Conducting spectrum measurements ........................................................................................ 68 

 Conducting RF measurements .................................................................................................. 72 
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Introduction 

The advantage of using the Spectrum Analyzer is easy to verify the presence of unwanted signals 

such as spurious and harmonics, which are normally very hard to identify in time domain analysis.  

 

Performance assurance in wireless communication systems includes the observation of the out-of-

band signal characteristics in order to identify the presence of harmonic signals. Harmonic signals of a 

carrier may interfere with other signals far out of the transmission band, or harmonic signals from other 

transmitter may interfere with in band signals affecting the spectral integrity. 

 

In these days when wide variety of wireless communication services are provided in frequency bands 

assigned very closely to each other, it is critical to ensure that each communication service is carried 

out within their assigned frequency band minimizing interference with adjacent frequency bands. The 

Adjacent Channel Power Ratio (ACPR) characteristic of a power amplifier or other RF components is 

an important factor in evaluating the system performance. 

 

The JD780A series is the optimal solution to perform following measurements: 

 

 Spectrum Analysis 

- Spectrum 

 RF Analysis 

- Channel Power 

- Occupied Bandwidth 

- Spectrum Emission Mask 

- Adjacent Channel Power (ACP) 

- Multi-ACP 

- Spurious Emissions 

- AM/FM Audio Demodulation 

- Field Strength 

- Route Map 

- Dual Spectrum 

- PIM Detection (Single and Multiple Carriers) 

- Total Harmonic Distortion (THD) 

 

Display overview 

Figure 8 provides overview of each segment of the measurement screen. 
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Figure 8 Spectrum measurement screen 

 

 

Connecting a cable 

There are two ways that you can make a connection of your instrument and the base station to be 

tested: direct or indirect. 

 

Procedure 

To make a direct connection: 

1. Connect the Spectrum Analyzer RF In port of the JD780A series and the PA output port of BTS 

as shown in Figure 9. 
 
To make an indirect connection: 

1. Connect the Spectrum Analyzer RF In port of the JD780A series and the monitor (test) port of 

BTS as shown in Figure 10. 

 

Figure 9 Direct connection 

 
JD785A/JD786A 

 
JD788A 
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Figure 10 Indirect connection 

 
JD785A/JD786A 

 
JD788A 

 

 

CAUTION 
The maximum power for the Spectrum Analyzer RF In port is +25 dBm (0.316 W). If the 

input signal level to be measured is greater than +25 dBm, use a High Power 
Attenuator to prevent damage when you directly connect the signal to the instrument or 
connect the signal from the coupling port of a directional coupler. 

 

Selecting measurement mode 

Procedure 

1. Press the MODE hard key. 

2. Press the Spectrum Analyzer soft key. The Measure Off mode is selected by default. 

3. To select a measurement mode, press the MEASURE hot key and then select the measurement 
mode: 

–  Channel Power 

–  Occupied BW 

–  Spectrum Emission Mask 

–  Adjacent Channel Power 

–  Multi-ACP 

–  Spurious Emissions 

–  AM/FM Audio Demod 

–  Field Strength 

–  Route Map 

–  Dual Spectrum 

–  PIM Detection > Single Carrier or Multiple Carrier 

–  Total Harmonic Distortion 

 

Configuring test parameters 

Setting frequency 

You need to set the frequency range to be measured with either the center frequency/span or the 
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start/stop frequencies. You can also set the frequency with the channel number and span. 

 

Procedure 

To set the center frequency and span: 

1. Press the FREQ/DIST hard key. 

2. Toggle the Unit soft key and select Freq. 

3. Press the Center Frequency soft key. 

4. Enter a value by using the numeric keys. You can also use the rotary knob or the arrow keys. 

5. Select the unit: GHz, MHz, kHz, or Hz. 

6. Press the Span soft key, and then do one of the following: 

–  To set the span manually, select Span, enter a value, and then select the unit. 

–  To set the span automatically, select Full Span, Zero Span, or Last Span as needed. 

 

 

NOTE 
The Zero Span option is available only in the Spectrum mode. If you have selected Zero 
Span, select TRIGGER > Free Run, External, GPS, Video, or Display Position. 

 
To set the start and stop frequencies: 

1. Press the FREQ/DIST hard key. 

2. Toggle the Unit soft key and select Freq. 

3. Press the Start Frequency soft key. 

4. Enter a value by using the numeric keys. You can also use the rotary knob or the arrow keys. 

5. Select the unit: GHz, MHz, kHz, or Hz. 

6. Press the Stop Frequency soft key. 

7. Enter a value by using the numeric keys. You can also use the rotary knob or the arrow keys. 

8. Select the unit: GHz, MHz, kHz, or Hz. 
 
To set the channel number and span: 

1. Press the FREQ/DIST hard key. 

2. Toggle the Unit soft key and select Channel. 

3. To select the standard channel, complete the following steps: 

a. Press the Channel Std soft key. The standard channel window appears. 

See “Appendix C – Band, frequency & channel standard” on page 588 for more information. 

b. Select the band to be measured by using the rotary knob, the arrow keys, or the Page 
Up/Page Down soft keys. 

c. Press the Select soft key or the rotary knob to confirm the selection. 

4. Toggle the Link soft key to select the sweep direction and select Fwd for forward or Rev for 

reverse. 

5. To set the channel number, complete the following steps: 

a. Press the Channel Number soft key. 

b. Enter a value by using the numeric keys. 

c. Press the Enter soft key or ENTER hard key to complete the entry. 

The instrument automatically displays the corresponding center frequency value for the 
selected channel number. 

6. To set the span, complete the following steps: 

a. Press the Span soft key. 
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b. Select the span option, from the following choices: 

–  To set the span manually, select Span, enter a value, and then select the unit. 

–  To set the span automatically, select Full Span, Zero Span, or Last Span as needed. 

 

NOTE 
The Zero Span option is available only in the Spectrum mode. If you have selected Zero 
Span, select TRIGGER > Free Run, External, GPS, Video, or Display Position. 

 
Optional. To define the amount of frequency increment for the rotary knob: 

1. Press the Frequency Step soft key, if the Freq is selected. 

2. Enter a value by using the numeric keys. 

3. Press the unit: GHz, MHz, kHz, or Hz. 
 
 
Optional. To define the amount of channel increment for the rotary knob: 

1. Press the Channel Step soft key, if the Channel is selected. 

2. Enter a value by using the numeric keys. 

3. Press the Enter soft key. 

 

 

NOTE 

This setting is not used in the Spurious Emissions mode. 

 

Setting amplitude 

Reference level and attenuation 

You can set the reference and attenuation levels automatically or manually to optimize the display of 

the traces measured, as you desire. 

 

Procedure 

To automatically set the reference and attenuation level: 

1. Press the AMP/SCALE hard key. 

2. Press the Auto Scale soft key. 

Each time you press this key, both of the Y-axis scale and input attenuation level change to be 
optimized with some margin. 

 
To set the reference or attenuation level manually: 

1. Press the AMP/SCALE hard key. 

2. To set the maximum reference level on the Y-axis manually, complete the following steps: 

a. Press the Reference Level soft key. 

b. Enter a value by using the numeric keys or the rotary knob with 10 dB increments. 

c. Press the unit soft key or the ENTER hard key. 

3. To set the attenuation option, select one from the following choices: 

–  To set the input attenuator’s level automatically, select Attenuation > Auto. 

 

 

NOTE 
It is recommended that you set the Attenuation to Auto in most situations so that the 

level of the input attenuator can be set automatically according to your input signal level. 

–  To set the input attenuation manually up to 55 dB to optimize S/N, complete the following 
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steps: 

a. Select Attenuation > Manual. 

b. Press the Attenuation Value soft key to set the level. 

c. Enter a value between 0 and 55 in fives by using the numeric keys. 

d. Press the dB soft key or the ENTER hard key. 

–  To couple the input attenuator’s level with your reference level setting, select Attenuation > 
Couple. 

As you increase the reference setting, the attenuation level also increases acoordingly. 
 
Optional. To change the scale unit: 

1. Select More (1/2) > Units. 

2. Select the unit of the display scale: dBm, dBV, dBmV, dBµV, V, or W. 

The scale unit on the screen changes accordingly. 
 

 

NOTE 
For the Field Strength mode, the units change to dBµV/m, dBmV/m, dBV/m, Volt/m, 
Watt/m^2, and dBm/m^2. 

 

 

Pre-amplifier 

You can turn the internal pre-amplifier on to correct and compensate for the gain of the preamplifier so 

that amplitude readings show the value at the input connector. 

 

Procedure 

1. Press the AMP/SCALE hard key. 

2. Toggle the Preamp soft key and select On or Off as needed. 

 

 

NOTE 

You can turn the Preamp on when the input attenuation range is from 0 dB to 10 dB. If 
the attenuation value is manually set to greater than 10 dB, the instrument will 
automatically turn off the pre-amplifier to display low-level signal properly on the chart. 

 

External offset 

You can turn the External Offset on and manually set the external offset value. An offset consists of a 

cable loss and a user offset and the measurement result shows the value reflecting both offset values. 

When the external offset value is set at 40 dB in the Spectrum mode, the measurement result 

compensates 40 dB at both the Spectrum Analyzer and Signal Analyzer modes 

 

Procedure 

To set the external offset: 

1. Press the AMP/SCALE hard key. 

2. Toggle the External Offset soft key and select On. 

3. Enter a value by using the numeric keys. 

4. Press the dB soft key to complete the entry. 

 
To turn the external offset off: 

1. Press the AMP/SCALE hard key. 
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2. Toggle the External Offset soft key and select Off. 

 

 

NOTE 

This setting is not used in the Field Strength mode. 

 

Scale per division 

You can use the Scale/Div feature available for the spectrum measurement screen. It represents the 

value of one division on the horizontal scale. The default setting is 10 dB per division and the 

maximum value can be set up to 20 dB. 

 

Procedure 

To set the scale per division: 

1. Press the AMP/SCALE hard key. 

2. Select More (1/2) > Scale/Div. 

3. Enter a value between 1 and 20 by using the numeric keys. 

4. Press the dB soft key to complete the entry. 

 

Setting bandwidth 

You can manually set the Resolution Bandwidth (RBW), Video Bandwidth (VBW), and the proportional 

VBW based on the designated RBW. Selecting Auto changes the value to correspond to your 

frequency span setting for RBW and to the current RBW and VBW/RBW settings for VBW. 

 

Procedure 

To automatically set the RBW and VBW to your selected VBW/RBW ratio: 

1. Press the BW/AVG hard key. 

2. Press the VBW/RBW soft key to set the proportional VBW based on the designated RBW. 

Table 9 shows the ratio example for 30 kHz RBW. 

3. Select the ratio: 1, 0.3, 0.1, 0.03, 0.01, or 0.003. 

4. Toggle the RBW soft key and select Auto. 

5. Toggle the VBW soft key and select Auto. 

The RBW or VBW value on the screen changes accordingly based on the span. 

 
To manually set the RBW or VBW to your selected VBW/RBW ratio: 

1. Press the BW/AVG hard key. 

2. Press the RBW soft key. 

3. Enter a value between 1 Hz to 3 MHz in 1-3 sequence by using the numeric keys. 

4. Select the unit: MHz, kHz, or Hz. 
The RBW setting automatically changes to Manual. 

5. Press the VBW soft key. 

6. Enter a value by using the numeric keys. 

7. Select the unit: MHz, kHz, or Hz. 
The VBW setting automatically changes to Manual. 

The RBW or VBW value on the screen changes accordingly. 



JD780A Series Analyzers 

66 Using Spectrum Analyzer 

 

 

NOTE 

This setting is not used in the Spurious Emissions mode. 

 

Table 9 VBW/RBW ratio example 

RBW Ratio (VBW/RBW) VBW 

30 kHz 1:1 30 kHz 

 1:0.3 10 kHz 

 1:0.1 3 kHz 

 1:0.03 1 kHz 

 1:0.01 300 Hz 

 1:0.003 100 Hz 

 

Setting average 

You can set the number of measurements to be averaged for the trace presentation. A maximum of 

100 times of averaging can be set. When the averaging reaches to your setting, a new measurement 

value replaces the measurement value in sequence from the earliest. 

 

Procedure 

1. Press the BW/AVG hard key. 

2. Press the Average soft key. 

3. Enter a value between 1 and 100 as needed by using the numeric keys. 

4. Press the Enter soft key. 

 

Setting sweep 

The SWEEP hot key is used to set and control the sweep time, sweep mode, gated sweep settings, 

and gated sweep on or off. 

 

Sweep time 

You can set the sweep time automatically or manually. Manual setting allows you to set the sweep time 

beyond an automatic setting. 

 

Procedure 

1. Press the SWEEP hot key. 

2. Select the sweep time option, from the following choices: 

–  To automatically set, toggle the Sweep Time soft key and select Auto. 

–  To manually set, complete the following steps: 

a. Press the Sweep Time soft key. 

b. Enter a value by using the numeric keys. 

c. Select the unit: Sec, mSec, or µSec. 
The sweep time mode automatically changes to Manual. 
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NOTE 

This setting is not used in the Spurious Emissions mode. 

 

Sweep mode 

The default settings of the sweep mode are Continue and Normal to sweep continuously at a normal 

speed for most on-going measurements. If you want to hold the measurement or get a single sweep, 

you can change the sweep mode. 

 

Procedure 

To select the single sweep mode: 

1. Press the SWEEP hot key. 

2. Toggle the Sweep Mode soft key and select Single. You can also use the HOLD hot key. 

The letter HOLD in red appears and the sweeping is paused. 

3. Optional. Press the Sweep Once soft key to get a new measurement. 

4. Optional. To speed up sweeping, press the Sweep Mode soft key and then select Fast. 

 

 

NOTE 
Selecting Sweep Mode > Fast may reduce the measurement accuracy, but it is useful to 

identify the existence of interfering signals. 

 
To return to the continuous sweep mode: 

1. Toggle the Sweep Mode soft key and select Continue. You can also use the HOLD hot key. 

The letter HOLD in red disappears and the sweeping resumes. 

 

 

NOTE 

This setting is not used in the in the Field Strength mode, the AM/FM Audio Demodulation 
mode, and the Route Map mode. 

 

Gated sweep 

You can configure the gated sweep settings with an internal or external trigger source. If you select 

Gated Sweep Settings, you can view the signal in time domain. 

 

Procedure 

1. Press the SWEEP hot key. 

2. Press the Gated Sweep Settings soft key. 

3. Optional. Adjust sweep time to allow enough time for a cycle by completing the following steps: 

a. Press the Zero Span Time soft key. 

b. Enter a value by using the numeric keys. 

c. Select the unit: Sec, mSec, or µSec. 

4. Set the period, if using the internal trigger source, by doing one of the following: 

–  To select the preset period, complete the following steps: 

a. Toggle the Period soft key and select StdSignal. 

b. Press the StdSignal soft key, and then select the period: GSM (4.615 ms), WCDMA 
(10 ms), LTE (10 ms), EV-DO (5 ms), TD-SCDMA (5 ms), or WiMAX (10 ms). 

–  To manually set the period, complete the following steps: 
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a. Toggle the Period soft key and select Manual. 

b. Press the Period soft key to enter the amount of time. 

c. Enter a value by using the numeric keys. 

d. Select the unit: Sec, mSec, or µSec. 

5. Press the TRIGGER hot key, and then do one of the following: 

–  Select External for an external trigger source. 

–  Select Video or Display Position for the internal trigger source. 

6. Press the PREV hard key to continue setting the gated sweep. 

7. Set the gate delay by completing the following steps: 

a. Press the Gate Delay soft key. 

b. Enter a value by using the numeric keys. 

c. Select the unit: Sec, mSec, or µSec. 

8. Set the gate length by completing the following steps: 

a. Press the Gate Length soft key. 

b. Enter a value by using the numeric keys. 

c. Select the unit: Sec, mSec, or µSec. 

9. Press the PREV hard key to enable gated sweeping. 

10. Toggle the Gated Sweep soft key and select On. 

 

 

NOTE 

This setting is not used in the in the Spurious Emissions mode, the Field Strength mode, 
and the Route Map mode. 

 

Using RF source 

You can turn the RF Source feature on to provide different power levels as like using a CW signal 

generator. 

 

Procedure 

1. Press the MEASURE SETUP hot key. 

2. Press the RF Source soft key. 

3. Press the Frequency soft key to set the frequency of the CW signal to be injected. 

4. Enter a value, and then select the unit: GHz, MHz, kHz, or Hz. 

5. Press the Power Level soft key to set the output level of the CW signal to be injected. 

6. Enter a value, and then select the dBm soft key. 

7. Toggle the RF Source soft key and select On. 

 

Conducting spectrum measurements 

If you have configured test parameters as described in the “Configuring test parameters” on page 61, 

your measurement is displayed on the screen as like the following example, Figure 11. 
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Figure 11 Spectrum measurement with spectrum analyzer 

 
 

 

 

Setting trace 

You can display up to six traces on the measurement chart simultaneously. 

 

Procedure 

1. Press the TRACE/DISPLAY hard key. 

2. Press the Select Trace soft key, and then select the trace number: T1, T2, T3, T4, T5, or T6. 

The legend shape of the selected trace changes from square to round to indicate that the trace is 
the active one now. 

3. Do one of the following: 

To Select Trace Legend 

Clear current data and display with new 
measurements 

Clear Write W 
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Display the input signal’s maximum response only 
(unlimited or for a certain amount of time) 

Max Hold M 

Display the input signal’s minimum 
response only 

(unlimited or for a certain amount of time) 

Min Hold m 

Capture the selected trace and compare traces Capture C 

Load a saved trace More (1/2) > Load L 

Hide the selected trace Trace View > Off F 

Remove all the traces and initialize the trace 
settings 

More (1/2) > Trace 
Clear All 

 

 

 

NOTE 
For the Max Hold and Min Hold, your instrument compares newly acquired data with the 

active trace and displays larger maximum values or smaller minimum values on the 
screen. You can set it to Unlimited to hold and view maximum or minimum data or 

specify a certain amount of time up to 60 seconds by using numeric keys or the rotary 
knob. 

4. To select the detection option, press the More (1/2) > Detectors, and then do one of the 

following: 
 

To display Select 

Random noise better than the peak without missing signals Normal 

The highest value in each data point Peak 

The root mean squared average power across the spectrum RMS 

The lowest value in each data point Negative Peak 

The center value in each data point Sample 

5. Optional. Press the More (1/2) > Trace Info soft key, and then select the trace number to view 
the trace’s parameter setting information stored at the time of the measurement or None to hide 

the information display. 

6. Optional. If you have the two traces T1 and T2, you can perform trace math. To view the power 
difference between the traces, press the T1 – T2 -> T5 or T2 – T1 -> T6 soft key. 

The result is overlaid on the screen along with the second Y-axis. 

 

 

NOTE 

To be able to load a trace, the trace to be overlaid must be saved in the same 
measurement mode and frequency setting as the current measurement. 

 

Setting limit 

Procedure 

To use the display line: 

1. Press the LIMIT hot key. 

2. Press the Display Line soft key for a reference line. 

3. Enter a value, and then press the dBm unit soft key. 

4. Toggle the Display Line soft key between On and Off to display and dismiss the reference line. 

The straight line appears across the screen to be used as a visual reference only. 
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To display the multiple segment line: 

1. Press the LIMIT hot key. 

2. Press the Multi Segment Line soft key for Pass/Fail indication. 

3. Toggle the Limit soft key between Upper and Lower to select the one to be displayed. 

4. Set the number of segments for the selected upper or lower limit line. You can set up to 50 
segments. 

a. Press the # of Line soft key. 

b. Enter a value between 1 and 50 by using the numeric keys. 

c. Press the Enter soft key. 

5. Press the Autoset soft key to let the instrument set the limit for each segment and display the 

line. 

6. Optional. To move the limit line, complete the following steps: 

a. Select Limit Up/Down or Limit Left/Right. 

b. Turn the rotary knob to move the line as desired. You can also manually enter a value. 

7. Optional. To edit the segment properties, complete the following steps: 

a. Press the Edit Limit soft key. 

b. Press the Move soft key and then turn the rotary knob to select the segment to edit. 

c. Select the menu option, from the following choices: 

–  To hide the line for the selected segment, toggle the Line soft key and select Off. 

–  To add a new point, press the Add Point soft key. 

–  To delete the selected point, press the Delete Point soft key. 

–  To change the position, press the Frequency or Amplitude soft key, and then turn the 

rotary knob to change the value as desired. 

8. Optional. Go to SAVE/LOAD > Save, and then select Save Limit to save the limit settings. 

See “Using save” on page 33 for more information. 

 

Setting frequency offset 

If you want to check how much the actual frequency has been drifted from the input center frequency 

on your spectrum, you can set the center frequency as a frequency reference or an offset to view the 

drifted amount in frequency easily. 

 

Procedure 

1. Press the FREQ/DIST hard key. 

2. Press the Frequency Offset soft key. 

3. Enter a value using the numeric keys. You can also turn the rotary knob to change the value.  
For example, if you have set the center frequency as 89.1 MHz and want to set it as a frequency 
reference, you need to enter “-89.1” in the user input field to view the center frequency as “0”.   

4. Select the unit: GHz, MHz, kHz, or Hz. 

All frequency information on the display changes accordingly. 
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Conducting RF measurements 

Channel power 

The Channel Power measurement is a common test used in the wireless industry to measure the total 

transmitted power of a radio within a defined frequency channel. It acquires a number of points 

representing the input signal in the time domain, transforms this information into the frequency domain 

using Fast Fourier Transform (FFT), and then calculates the channel power. The effective resolution 

bandwidth of the frequency domain trace is proportional to the number of points acquired for the FFT. 

 

The channel power measurement identifies the total RF power, power spectral density, and Peak to 

Average Ratio (PAR) of the signal within the channel bandwidth. 

 

Setting measure setup 

After configuring test parameters, you can set the measure setup to continue your measurement. The 

measurement settings can be saved and recalled as a file. You can also use JDViewer, PC application 

software to configure a measure setup, save as a file, and load the file on to the instrument. 

 

Procedure 

1. Configure test parameters as described in the “Configuring test parameters” on page 61. 

2. Press the MEASURE SETUP hot key. 

3. Set the channel power measurement bandwidth to be measured: 

a. Press the Integrated BW soft key. 

b. Enter a bandwidth by using the numeric keys. You can also use the rotary knob. 

c. Select the unit: GHz, MHz, kHz, or Hz. 

4. Set the frequency range over which the instrument will sweep: 

a. Press the Span soft key. 

b. Enter a span frequency value by using the numeric keys. You can also use the rotary knob. 

c. Select the unit: GHz, MHz, kHz, or Hz. 

5. Set the number of measurements to be averaged: 

a. Press the Average soft key. 

b. Enter a value between 1 and 100. 

c. Press the Enter soft key. 

 

Setting limit 

Procedure 

1. Press the LIMIT hot key. 

2. Press the Channel Power soft key to set the limit parameters. 

3. Toggle the Test Limits soft key between On and Off to enable or disable the Pass/Fail 

indication. 

4. Set the upper threshold: 

a. Press the High Limit soft key. 

b. Enter a value for the upper limit. 
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c. Press the dBm unit soft key. 

5. Set the lower threshold: 

a. Press the Low Limit soft key. 

b. Enter a value for the lower limit. 

c. Press the dBm unit soft key. 

6. Optional. Go to SAVE/LOAD > Save, and then select the save option from the choices available 

for your measurement mode. See “Using save” on page 33 for more information. 

 

Measurement example 

Figure 12 Channel power measurement with spectrum analyzer 

 

 

Channel power measurement result shows channel power and spectrum density in a user specified 

channel bandwidth. The peak to average ratio (PAR) is shown at the bottom of the screen as well. The 

shaded area on the display indicates the channel bandwidth. 

 

Occupied bandwidth 

The Occupied Bandwidth measures the percentage of the transmitted power within a specified 

bandwidth. The percentage is typically 99%. 

 

Setting measure setup 

After configuring test parameters, you can set the measure setup to continue your measurement. The 

measurement settings can be saved and recalled as a file. You can also use JDViewer, PC application 

software to configure a measure setup, save as a file, and load the file on to the instrument. 

 

Procedure 

1. Configure test parameters as described in the “Configuring test parameters” on page 61. 

2. Press the MEASURE SETUP hot key. 

3. Set the percentage of power within the bandwidth to be measured: 
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a. Press the Occupied BW % Power soft key. 

b. Enter a value by using the numeric keys. You can also use the rotary knob. 

c. Press the Enter soft key. 

4. Set the frequency range over which the instrument will sweep: 

a. Press the Span soft key. 

b. Enter a span frequency value by using the numeric keys. You can also use the rotary knob. 

c. Select the unit: GHz, MHz, kHz, or Hz. 

5. Set the number of measurements to be averaged: 

a. Press the Average soft key. 

b. Enter a value between 1 and 100. 

c. Press the Enter soft key. 

 

Setting limit 

Procedure 

1. Press the LIMIT hot key. 

2. Press the Occupied BW soft key to set the limit parameters. 

3. Toggle the Test Limits soft key between On and Off to enable or disable the Pass/Fail indication. 

4. Set the upper threshold: 

a. Press the High Limit soft key. 

b. Enter a value for the upper limit. 

c. Select the unit: MHz, kHz, or Hz. 

5. Optional. Go to SAVE/LOAD > Save, and then select Save Limit to save the limit settings. 

See “Using save” on page 33 for more information. 

 

Measurement example 

The Occupied Bandwidth measurement shows both of power across the band and power bandwidth in 

a user specified percentage to determine the amount of spectrum used by a modulated signal. 

Occupied bandwidth is typically calculated as the bandwidth containing 99% of the transmitted power. 
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Figure 13 Occupied bandwidth measurement with spectrum analyzer 

 

 

Spectrum emission mask (SEM) 

The Spectrum Emission Mask (SEM) measurement is to identify and determine the power level of out-

of-band spurious emission outside the necessary channel bandwidth and modulated signal. It 

measures the power ratio between in-band and adjacent channels. The JD780A series indicates either 

Pass or Fail based on the specified limit of the signal. 

 

Setting measure setup 

After configuring test parameters, you can set the measure setup to continue your measurement. The 

measurement settings can be saved and recalled as a file. You can also use JDViewer, PC application 

software to configure a measure setup, save as a file, and load the file on to the instrument. 

 

Procedure 

1. Configure test parameters as described in the “Configuring test parameters” on page 61. 

2. Press the MEASURE SETUP hot key. 

3. Set the main channel bandwidth to be measured: 

a. Press the Main Channel BW soft key. 

b. Enter a value by using the numeric keys. You can also use the rotary knob. 

c. Select the unit: MHz, kHz, or Hz. 

4. Set the frequency range over which the instrument will sweep: 

a. Press the Span soft key. 

b. Enter a span frequency value by using the numeric keys. You can also use the rotary knob. 

c. Select the unit: GHz, MHz, kHz, or Hz. 

5. Set the number of measurements to be averaged: 

a. Press the Average soft key. 

b. Enter a value between 1 and 100. 

c. Press the Enter soft key. 
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6. To configure an offset, up to five, complete the following steps: 

a. Press the Offset/Limit soft key. 

The Offset/Limit screen menu bar appears. 

b. Press the Offset soft key, and then select the number for the active offset to configure. 

c. Toggle the Offset soft key and select On to display or Off to hide the active offset. 

d. Press the Offset Frequency soft key to set the center frequency of the offset. 

e. Enter a value by using the numeric keys. You can also use the rotary knob. 

f. Select the unit: MHz, kHz, or Hz. 

g. Press the Measurement Bandwidth soft key to set the bandwidth for the selected offset. 

h. Enter a value by using the numeric keys. You can also use the rotary knob. 

i. Select the unit: MHz, kHz, or Hz. 

j. Toggle the Reference soft key between Relative and Absolute and select Relative or 
Absolute depending on how to use the reference. 

7. To define the selected offset’s limits for Pass/Fail indication, complete the following steps: 

a. Press the Start Offset Limit soft key to set the threshold for the power difference between 

the main channel bandwidth and the selected offset bandwidth on the left. 

b. Enter a value by using the numeric keys. You can also use the rotary knob. 

c. Select the dB soft key. 

d. Press the Stop Offset Limit soft key to set the threshold for the power difference between 

the main channel bandwidth and the selected offset bandwidth on the right. 

e. Enter a value by using the numeric keys. You can also use the rotary knob. 

f. Select the dB soft key. 

 

Setting limit 

Procedure 

1. Press the LIMIT hot key. 

2. Press the Spectrum Emission Mask soft key. 

3. Toggle the Test Limits soft key between On and Off to enable or disable the Pass/Fail 

indication. 

4. Optional. Go to SAVE/LOAD > Save, and then select Save Limit to save the limit settings. 

See “Using save” on page 33 for more information. 
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Measurement example 

Figure 14 Spectrum emission mask measurement with spectrum analyzer 

 

 

Adjacent channel power (ACP) 

The Adjacent Channel Power (ACP) is the power contained in a specified frequency channel 

bandwidth relative to the total carrier power. It may also be expressed as a ratio of power spectral 

densities between the carrier and the specified offset frequency band. 

 

Setting measure setup 

After configuring test parameters, you can set the measure setup to continue your measurement. The 

measurement settings can be saved and recalled as a file. You can also use JDViewer, PC application 

software to configure a measure setup, save as a file, and load the file on to the instrument. 

 

Procedure 

1. Configure test parameters as described in the “Configuring test parameters” on page 61. 

2. Press the MEASURE SETUP hot key. 

3. Set the main channel bandwidth to be measured: 

a. Press the Main Channel BW soft key. 

b. Enter a value by using the numeric keys. You can also use the rotary knob. 

c. Select the unit: MHz, kHz, or Hz. 

4. Set the frequency range over which the instrument will sweep: 

a. Press the Span soft key. 

b. Enter a span frequency value by using the numeric keys. You can also use the rotary knob. 

c. Select the unit: GHz, MHz, kHz, or Hz. 

5. Set the number of measurements to be averaged: 

a. Press the Average soft key. 

b. Enter a value between 1 and 100. 

c. Press the Enter soft key. 
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6. To configure an offset, up to five, complete the following steps: 

a. Press the Offset/Limit soft key. 

The Offset/Limit screen menu bar appears. 

b. Press the Offset soft key, and then select the number for the active offset to configure. 

c. Toggle the Offset soft key and select On to display or Off to hide the active offset. 

d. Press the Offset Frequency soft key to set the center frequency of the offset. 

e. Enter a value by using the numeric keys. You can also use the rotary knob. 

f. Select the unit: MHz, kHz, or Hz. 

g. Press the Integration Bandwidth soft key to set the bandwidth for the selected offset. 

h. Enter a value by using the numeric keys. You can also use the rotary knob. 

i. Select the unit: MHz, kHz, or Hz. 

7. To define the selected offset’s limits for Pass/Fail indication, complete the following steps: 

a. Press the Lower soft key to set the threshold for the power difference between the main 

channel bandwidth and the selected offset bandwidth on the left. 

b. Enter a value by using the numeric keys. You can also use the rotary knob. 

c. Select the dBc soft key. 

d. Press the Upper soft key to set the threshold for the power difference between the main 

channel bandwidth and the selected offset bandwidth on the right. 

e. Enter a value by using the numeric keys. You can also use the rotary knob. 

f. Select the dBc soft key. 

 

Setting limit 

Procedure 

1. Press the LIMIT hot key. 

2. Press the ACP soft key. 

3. Toggle the Test Limits soft key between On and Off to enable or disable the Pass/Fail 

indication. 

4. Optional. Go to SAVE/LOAD > Save, and then select Save Limit to save the limit settings. 

See “Using save” on page 33 for more information. 
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Measurement example 

Figure 15 Adjacent channel power measurement with spectrum analyzer 

 

 

Multi-ACP 

The Multi-ACP measurement is used to do multi-channel ACP testing. It helps you to measure ACP in 

multi-channel transmitting base station environment. 

 

Setting measure setup 

After configuring test parameters as described in “Configuring test parameters” on page 61, you can 

set the measure setup to continue your measurement. The measurement settings can be saved and 

recalled as a file. You can also use JDViewer, PC application software to configure a measure setup, 

save as a file, and load the file on to the instrument. 

 

Procedure 

1. Press the MEASURE SETUP hot key. 

2. Toggle the Unit soft key and select Freq or Channel. 

–  For the frequency setting, complete the following steps: 

a. Press the Lowest Frequency soft key. 

b. Enter a value by using the numeric keys. You can also use the rotary knob. 

c. Select the unit: GHz, MHz, kHz, or Hz. 

d. Press the Highest Frequency soft key. 

e. Enter a value by using the numeric keys. You can also use the rotary knob. 

f. Select the unit: GHz, MHz, kHz, or Hz. 

–  For the channel setting, complete the following steps: 

a. Press the Channel Std soft key. The standard channel window appears. 

b. Select the band to be measured by using the rotary knob or the Page p/Page Down 

soft keys. 

c. Press the Select soft key or the rotary knob to confirm the selection. 
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d. Toggle the Link soft key to select the sweep direction and select Fwd or Rev as 

needed. 

e. Press the Lowest Channel soft key. 

f. Enter a value by using the numeric keys. 

g. Press the Enter soft key or ENTER hard key to complete the entry. 

The instrument automatically displays the corresponding center frequency value for the 
selected channel number. 

h. Press the Highest Channel soft key. 

i. Enter a value by using the numeric keys. 

j. Press the Enter soft key or ENTER hard key to complete the entry. 

The instrument automatically displays the corresponding center frequency value for the 
selected channel number. 

3. To set up ACP setting, press the ACP Settings soft key and then complete the following steps: 

a. Press the Main Channel BW soft key. 

b. Enter a value by using the numeric keys. You can also use the rotary knob. 

c. Select the unit: MHz, kHz, or Hz. 

d. Press the Span soft key to set the frequency range over which the instrument will sweep. 

e. Enter a span frequency value by using the numeric keys. You can also use the rotary knob. 

f. Select the unit: GHz, MHz, kHz, or Hz. 

g. Press the Average soft key to set the number of measurement to be averaged: 

h. Enter a value between 1 and 100. 

i. Press the Enter soft key. 

4. To configure an offset, up to five, complete the following steps: 

a. Press the Offset/Limit soft key. The Offset/Limit screen menu bar appears. 

b. Press the Offset soft key, and then select the number for the active offset to configure. 

c. Toggle the Offset soft key and select On to display or Off to hide the active offset. 

d. Press the Offset Frequency soft key to set the offset frequency. 

e. Enter a value by using the numeric keys. You can also use the rotary knob. 

f. Select the unit: MHz, kHz, or Hz. 

g. Press the Integration Bandwidth soft key. 

h. Enter a value by using the numeric keys. You can also use the rotary knob. 

i. Select the unit: MHz, kHz, or Hz. 

5. To define the selected offset’s limits for Pass/Fail indication, complete the following steps: 

a. Press the Lower soft key to set the threshold for the power difference between the main 

channel bandwidth and the selected offset bandwidth on the left. 

b. Enter a value by using the numeric keys. You can also use the rotary knob. 

c. Select the dBc soft key. 

d. Press the Upper soft key to set the threshold for the power difference between the main 

channel bandwidth and the selected offset bandwidth on the right. 

e. Enter a value by using the numeric keys. You can also use the rotary knob. 

f. Select the dBc soft key. 
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Setting limit 

Procedure 

1. Press the LIMIT hot key. 

2. Press the Multi-ACP soft key. 

3. Toggle the Test Limits soft key between On and Off to enable or disable the Pass/Fail indication. 

4. Optional. Go to SAVE/LOAD > Save, and then select Save Limit to save the limit settings. 

See “Using save” on page 33 for more information. 

 

Measurement example 

Figure 16 Multi-ACP measurement with spectrum analyzer 

 

 

Spurious emissions 

The Spurious Emissions measurement is to identify or determine the power level of in-band or out-of-

band spurious emissions within the necessary channel bandwidth and modulated signal. The JD780A 

series indicates either Pass or Fail based on the specified limit of the signal. 

 

Setting measure setup 

After configuring test parameters as described in the “Configuring test parameters” on page 61, you 

can set the measure setup to continue your measurement. The measurement settings can be saved 

and recalled as a file. You can also use JDViewer, PC application software to configure a measure 

setup, save as a file, and load the file on to the instrument. 

 

Procedure 

1. Press the MEASURE SETUP hot key. 

2. To set up the range table and parameters, press the Range Table soft key and then complete 

the following steps: 

a. Press the Range soft key, and then select the range number between 1 and 20 to add  

as a new or change the existing settings. 
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b. Do the following as desired: 

–  Select Start Frequency, and then specify the start frequency for the selected range. 

–  Select Stop Frequency, and then specify the stop frequency for the selected range. 

–  Select Start Limit, and then specify the lower limit for Pass/Fail indication. 

–  Select Stop Limit, and then specify the upper limit for Pass/Fail indication. 

–  Select More (1/2) > Attenuation, and then specify an value in the multiple of five. 

–  Select More (1/2) > RBW, and then specify a RBW value. 

–  Select More (1/2) > VBW, and then specify a VBW value. 

c. Press the PREV hard key. 

d. Toggle the Range soft key and select On to display the selected range in the result table or 
Off to hide it from the table. 

3. Toggle the Measure Type soft key between Examine and Full to select the measurement type. 

 

NOTE 
The Examine mode displays only the selected range while the Full mode lets the 

instrument automatically changes the selected range from one another. 

4. To set the number of measurements to be averaged, complete the following steps: 

a. Press the Average soft key. 

b. Enter a value between 1 and 100. 

c. Press the Enter soft key. 

5. To move the highlighted bar in the result table to other range, complete the following steps: 

a. Press the Range soft key in the Measure Setup menu bar. 

b. Enter a value between 1 and 20. 

c. Press the Enter soft key. 

 

Setting limit 

Procedure 

1. Press the LIMIT hot key. 

2. Press the Spurious Emissions soft key. 

3. Toggle the Test Limits soft key between On and Off to enable or disable the Pass/Fail indication. 

4. Optional. Go to SAVE/LOAD > Save, and then select Save Limit to save the limit settings. 

See “Using save” on page 33 for more information. 
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Measurement example 

Figure 17 Spurious emissions measurement with spectrum analyzer 

 

 

AM/FM audio demodulation 

The AM/FM Audio Demodulator operates using the power received from radio waves and it serves as 

an alternative to identify interfering signals easily. The instrument sounds demodulated signals that 

can be heard through the built-in speaker or plugged-in headphones. You can hear the sound and 

identify interfering signals easily. 

 

Setting measure setup 

After configuring test parameters as described in the “Configuring test parameters” on page 61, you 

can set the measure setup to continue your measurement. The measurement settings can be saved 

and recalled as a file. You can also use JDViewer, PC application software to configure a measure 

setup, save as a file, and load the file on to the instrument. 

 

Procedure 

1. Press the MEASURE SETUP hot key. 

2. Toggle the Audio Demod soft key between On and Off to turn the AM/FM audio demodulation 

on and off. 

3. Press the Demod at soft key, and then select the marker number for the frequency to be 

demodulated. 
 

 

NOTE 
You must set the marker(s) first by using the MARKER hard key as the AM/FM 

demodulator uses the marker position to demodulate. See “Using marker” on page 56 for 
more information. 

4. Press the Demod Mode soft key, and then select the demodulation mode: AM, FM and CW. 

5. Press the Dwell Time soft key, and then turn the rotary knob to set the demodulation interval 

between 1 and 20. 

6. Press the Volume soft key, and then turn the rotary knob to set the speaker volume. 

7. Toggle the Auto Gain soft key between On and Off to enable or disable the automatic gain 
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feature to adjust the interval gain of the demodulator. 

8. Optional. You can use the Save On Event soft key to let the instrument automatically save 
measurement screen or result that falls outside the defined limit settings or the Fail indicator is 
on. You can also set to save the first event and hold the measurement or to save all the events 
continuously. See “Using save” on page 33 for more information. 

 

Setting limit 

You can show or hide the display line on the screen that is used as a visual reference only. 

 

Procedure 

To view the display line: 

1. Press the LIMIT hot key. 

2. Press the Display Line soft key. 

3. Enter a value, and then press the dBm unit soft key. 

4. Toggle the Display Line On/Off soft key and select On. 

The straight line appears on the screen. 
 
To dismiss the display line: 

1. Press the LIMIT hot key. 

2. Toggle the Display Line On/Off soft key and select Off. 

 

You can use the multiple segment limit line to set up different limits for different frequency ranges for 

Pass/Fail indication. 

 

Procedure 

To display the multiple segment line: 

1. Press the LIMIT hot key. 

2. Press the Multi Segment Line soft key. 

3. Toggle the Limit soft key between Upper and Lower to select the one to be displayed. 

4. Set the number of segments for the selected upper or lower limit line. You can set up to 50 
segments. 

a. Press the # of Line soft key. 

b. Enter a value between 1 and 50 by using the numeric keys. 

c. Press the Enter soft key. 

5. Press the Autoset soft key to let the instrument set the limit for each segment and display the 

line. 

6. Optional. To move the limit line, complete the following steps: 

a. Select Limit Up/Down or Limit Left/Right. 

b. Turn the rotary knob to move the line as desired. You can also manually enter a value. 

7. Optional. To edit the segment properties, complete the following steps: 

a. Press the Edit Limit soft key. 

b. Press the Move soft key and then turn the rotary knob to select the segment to edit. 

c. Select the menu option, from the following choices: 

–  To hide the line for the selected segment, toggle the Line soft key and select Off. 
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–  To add a new point, press the Add Point soft key. 

–  To delete the selected point, press the Delete Point soft key. 

–  To change the position, press the Frequency or Amplitude soft key, and then turn the 

rotary knob to change the value as desired. 

8. Optional. Go to SAVE/LOAD > Save, and then select Save Limit to save the limit settings. 

See “Using save” on page 33 for more information. 

 

Measurement example 

Figure 18 AM/FM audio demodulation with spectrum analyzer 

 

 

Field strength meter 

The Field Strength Meter measures the field strength over the frequency range of a connected 

antenna, which is known with its specific bandwidth and gain characteristics. A standard or user-

defined antenna can be selected from the antenna list in the JD780A series. 

 

Setting measure setup 

Procedure 

1. Connect an antenna to be used with your instrument. 

2. Configure test parameters as described in the “Configuring test parameters” on page 61. 

3. Press the MEASURE SETUP hot key, and then do one of the following: 

–  To select the connected antenna from the list stored in the instrument: 

a. Press the Antenna List soft key to view the standard and custom antennas. 

The antenna list window appears. 

b. Select an antenna to be used for the field strength measurement by using the rotary 
knob, the arrow keys, or Page Up/Page Down soft keys. 

c. Press the Select soft key. 
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NOTE 

You can use the JDViewer to edit or define a custom antenna and add to this list. 

–  To edit the properties of the connected antenna: 

a. Press the Antenna Start Frequency soft key. 

b. Enter a value by using the numeric keys, and then select the unit: GHz, MHz, kHz, or 
Hz. You can also use the rotary knob. 

c. Press the Antenna Stop Frequency soft key. 

d. Enter a value by using the numeric keys, and then select the unit: GHz, MHz, kHz, or 
Hz. You can also use the rotary knob. 

e. Press the Gain soft key to enter the gain information for the antenna. 

f. Enter a value by using the numeric keys, and then select the Enter soft key. 

 

Setting limit 

You can show or hide the display line on the screen that is used as a visual reference only. 

 

Procedure 

To view the display line: 

1. Press the LIMIT hot key. 

2. Press the Display Line soft key. 

3. Enter a value, and then press the dBm unit soft key. 

4. Toggle the Display Line On/Off soft key and select On. 

The straight line appears on the screen. 
 
To dismiss the display line: 

1. Press the LIMIT hot key. 

2. Toggle the Display Line On/Off soft key and select Off. 

 

You can use the multiple segment limit line to set up different limits for different frequency ranges for 

Pass/Fail indication. 

 

Procedure 

To display the multiple segment line: 

1. Press the LIMIT hot key. 

2. Press the Multi Segment Line soft key. 

3. Toggle the Limit soft key between Upper and Lower to select the one to be displayed. 

4. Set the number of segments for the selected upper or lower limit line. You can set up to 50 
segments. 

a. Press the # of Line soft key. 

b. Enter a value between 1 and 50 by using the numeric keys. 

c. Press the Enter soft key. 

5. Press the Autoset soft key to set and display the limit line for each segment automatically.. 

6. Optional. To move the limit line, complete the following steps: 

a. Select Limit Up/Down or Limit Left/Right. 

b. Turn the rotary knob to move the line as desired. You can also manually enter a value. 
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7. Optional. To edit the segment properties, complete the following steps: 

a. Press the Edit Limit soft key. 

b. Press the Move soft key and then turn the rotary knob to select the segment to edit. 

c. Select the menu option, from the following choices: 

–  To hide the line for the selected segment, toggle the Line soft key and select Off. 

–  To add a new point, press the Add Point soft key. 

–  To delete the selected point, press the Delete Point soft key. 

–  To change the position, press the Frequency or Amplitude soft key, and then turn the 

rotary knob to change the value as desired. 

8. Optional. Go to SAVE/LOAD > Save, and then select Save Limit to save the limit settings. 

See “Using save” on page 33 for more information. 

 

Measurement example 

Figure 19 Field strength measurement with spectrum analyzer 

  

 

Route map 

The JD780A series provides the Route Map function that allows you to collect data of points in an 

indoor or outdoor environment and track the received signals and coverage of RF transmitters by 

plotting data real time directly on top of a loaded floor plan or a map.  

 

If you have obtained user experience data through Viavi’s ariesoGEO and generated raster data files 

from the application, you can load them onto your base map to help you troubleshoot problems easily 

and quickly. 

 

Setting measure setup 

Procedure 

1. If required, connect a GPS receiver to your JD780A series for outdoor mapping. 
Indoor mapping does not necessarily need a GPS antenna. 
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2. Configure test parameters as described in the “Configuring test parameters” on page 61. 

3. To load your map file, complete the following steps: 

a. Plug in your USB drive that has a floor map or .mcf file type created in JDMapCreator. . If 

the JDMapCreator application on your computer is connected to the instrument via USB or 
LAN, you can send a map file with a single layer to the instrument directly by using the 
Send to EQP menu in JDMapCreator. 

 

 

NOTE 

The JDMapCreator converts and resizes any scanned floor plan or layout to fit onto your 
instrument’s display. JDMapCreator 1.2.0 or later can save a multiple-layered map, 
providing x1, x2, and x4 views, as a sizable map file so that you can zoom in and out 

after loading it. 

b. Press SAVE/LOAD hot key, and then select Load > Load Map. See “Using load” on page 

36 for more information. 

4. Press the MEASURE SETUP hot key. 

5. Press the Plot Point soft key, and then select the plot point option from the following choices: 

–  To collect data/plot points automatically as you move around in a vehicle or outside, select 
GPS and then toggle the Screen Mode soft key between Map and Full. 

 

 

NOTE 
With the Map setting, you can view only the collected points that can be seen within the 

boundary of the loaded map. If a point is off the map, the instrument displays an arrow to 
indicate the direction of the current location on the map and the distance from the center 
to the location at the top of the screen. 
 
With the Full setting, you can view all the collected points of the route without the loaded 

map. 

–  To collect data/plot points manually without a GPS antenna, select Position. 

–  To collect data/plot points based on time, select Time. 

You do not need a GPS antenna as you would usually use this option indoor. 

6. Press the Plot Item soft key, and then select the measurement option: RSSI or ACP. 

7. Optional. If ACP is selected, set the Main Channel BW and Offset/Limit : 

a. Press the Main Channel BW soft key. 

b. Enter a value by using the numeric keys. You can also use the rotary knob. 

c. Select the unit: MHz, kHz, or Hz. 

d. Press the Offset/Limit soft key. 

e. Toggle the Offset soft key and select On to display or Off to hide the offset. 

f. Press the Integration Bandwidth soft key. 

g. Enter a value by using the numeric keys. You can also use the rotary knob. 

h. Select the unit: MHz, kHz, or Hz. 

i. Press the Offset Frequency soft key to set the offset frequency. 

j. Enter a value by using the numeric keys. You can also use the rotary knob. 

k. Select the unit: MHz, kHz, or Hz. 

l. Press the Offset Limit soft key to set the offset limit. 

m. Enter a value by using the numeric keys. You can also use the rotary knob. 

n. Select the dB soft key. 

8. Toggle the Plot soft key and select Start. 

9. Touch directly on the screen or press the ENTER hard key to collect data and plot points on the 
loaded map for the Position or Time setting. 
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NOTE 
For the Position setting, you can change the direction of the route with screen touch or 
the arrow keys and the distance with the rotary knob. For the Time setting, the instrument 

interpolates points in between two enters on a straight dotted line. You can change the 
direction of the route with the arrow keys and the distance with the rotary knob. 

10. Toggle the Plot soft key and select Stop to stop plotting. 

11. Press the SAVE/LOAD hot key to save the result. See “Using save” on page 33 for more 
information. 

 

NOTE 

The instrument does not automatically save the collected data. It is recommended that 
you save the result. Otherwise, you will lose all the collected data. 

 

 

Setting limit 

You can set the thresholds for the four different color indicators. 

 

Procedure 

1. Press the LIMIT hot key. 

2. Press the Excellent soft key to set its threshold. 

3. Enter a value, and then press the dBm soft key. You can also use the rotary knob. 

4. Press the Very Good soft key to set its threshold. 

5. Enter a value, and then press the dBm soft key. You can also use the rotary knob. 

6. Press the Good soft key to set its threshold. 

7. Enter a value, and then press the dBm soft key. You can also use the rotary knob. 

8. Press the Poor soft key to set its threshold. 

9. Enter a value, and then press the dBm soft key. You can also use the rotary knob. 

10. Optional. Go to SAVE/LOAD > Save, and then select Save Limit to save the limit settings. 

See “Using save” on page 33 for more information. 
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Measurement example 

Figure 20 Route map measurement screen with GPS 

  

 

Controlling a map 

If you have loaded a sizable map that was created in JDMapCreator 1.2.0 or later, you can use the 

Map Control feature that enables you to zoom into the map and view a specific area of interest in detail. 

 

Procedure 

1. Press the TRACE/DISPLAY hard key. 

2. Press the Map Control soft key. This key is active only when you have loaded a sizable map. 

3. Do one of the following: 

–  To zoom into an area of interest directly, complete the following steps: 

a. Toggle the Zoom to soft key and select Area. 

The black rectangle appears on the map. 

b. Press the Zoom In and Zoom Out soft keys, as you need, to decrease and increase 

the selected area. 

c. Move the rectangle by using the four arrow keys, as you need, to place it in a specific 
area of interest. 

d. Press the center of the rotary knob to zoom into the selected area. You can also press 
the Zoom to soft key again to zoom into the selected area. 

–  To zoom into the center or zoom out from the center, complete the following steps: 

a. Toggle the Zoom to soft key and select Center. 

b. Press the Zoom In and Zoom Out soft keys, as you need, to zoom in and zoom out. 

c. Move the zoomed-in area by using the four arrow keys, as you need. 

 

Loading and displaying raster data 

If you have a set of raster data files generated through the ariesoGEO application, you can load and 

overlay the data on your route map to help you check the signal quality and the strength of 

interferences while driving toward the area of interest. 
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Procedure 

1. Copy a set of raster data files into your USB memory drive, including the following: 

–  ASCII: .tab, .asc, and .clr files 

–  BIL: .tab,.hdr, .bil, and .clr files 

 

NOTE 
The .tab file type is a geospatial vector data format used in many geographic 

information systems. The color file (.clr) is an optional file, but the image will be 

displayed as a grayscale image without it. The size of the raster map must be  
1024 x 1024 or smaller. 

2. Plug in the USB memory drive to your instrument. 

3. Press the TRACE/DISPLAY hard key. 

4. Press the Load Raster Map soft key. 

The file explorer window appears. 

5. Navigate to the raster file (.tab) you want to open, and then press the Load soft key. 

The raster image appears on top of your base map as shown in Figure 21. 

 

NOTE 

If the area of the loaded raster data is not within the boundary of the base map, you will 
not see the raster image on the screen. 

6. To select the display option, complete the following steps: 

a. Press the Display Options soft key. 

b. Select the option you desire from the choices: On , Off, and Blink. 

7. To adjust the transparency level of the image, complete the following steps: 

a. Press the Transparency soft key. 

b. Enter a value between 0 for opaque and 100 for clear. 

c. Press the Enter soft key. 

 

Figure 21 Raster image overlaid on the base map 

  

 

Dual spectrum 

The Dual Spectrum feature lets you view two spectrum measurements, both the Uplink and Downlink 

spectrum, simultaneously eliminating the need to swap between two screens back and forth. 
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Setting measure setup 

Procedure 

1. Configure test parameters as described in the “Configuring test parameters” on page 61. 

2. Press the MEASURE SETUP hot key. 

3. Toggle the Active Window soft key between Top and Bottom to select the measurement 

window to configure or work on. 

 

Measurement example 

Figure 22 Dual spectrum measurement with spectrum analyzer 

 

 

PIM detection (single and multiple carriers) 

The Passive Intermodulation (PIM) Detection allows you to detect Uplink PIM across the full spectrum 

for any technology. When PIM is detected, the normal repair mode is to replace the offending cable 

and what you need to do is replacing the whole cable irrespective of the location of the fault. 

 

Setting measure setup 

Procedure 

1. Press the MEASURE SETUP hot key. 

2. Connect cables as instructed on the screen. 

3. Optional. To check any possibility of PIM existence in red color by calculation, complete the 
following steps: 

a. Press the Calculated PIM soft key. 

b. Press the Radio Band soft key for single carrier. 
There are Radio 1 Band and Radio 2 Band soft keys for multiple carriers. 

c. Highlight a desired band and then press the Select soft key. 

d. Press the Return soft key. 

4. To set the uplink frequency to be measured, do one of the following: 
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–  To set the center frequency and span, complete the following steps: 

a. Toggle the Unit soft key and select Freq. 

b. Press the Uplink Center Frequency soft key. 

c. Enter a value by using the numeric keys. You can also use the rotary knob. 

d. Select the unit: GHz, MHz, kHz, or Hz. 

e. Press the Uplink Span soft key. 

f. Enter a value by using the numeric keys. You can also use the rotary knob. 

g. Select the unit: GHz, MHz, kHz, or Hz. 

–  To set the channel number and span, complete the following steps: 

a. Toggle the Unit soft key and select Channel. 

b. Press the Channel Std soft key and select a desired band. 

c. Press the Channel Number soft key. 

d. Enter a value by using the numeric keys and then press the Enter soft key. 

The instrument automatically displays the corresponding center frequency value for the 
selected channel number. 

e. Press the Uplink Span soft key. 

f. Enter a value by using the numeric keys. You can also use the rotary knob. 

g. Select the unit: GHz, MHz, kHz, or Hz. 

5. Press the Continue soft key and follow the instructions on the screen. 

 

Measurement example 

Figure 23 PIM detection for single carrier 
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Figure 24 PIM detection for multiple carriers 

 

 

Total Harmonic Distortion (THD) 

The JD780A series can measure the Total Harmonic Distortion using spectrum analyzer. The Total 

Harmonic Distortion is defined as the ratio of RMS voltage of the harmonics to that of the fundamental 

component. This is accomplished by using a spectrum analyzer to obtain the level of each harmonic 

with peak detector. 

Figure 25 Total harmonic distortion screen 

 

 

Setting fundamental frequency 

You need to set the fundamental frequency to measure the total harmonic distortion. Once you set up, 

it will automatically collect the harmonic outputs (up to the tenth harmonics as shown in Figure 25) 

from the spectrum analyzer and calculate the corresponding THD value (%) and the distortion 

attenuation (dB). 
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Procedure 

1. Press the FREQ/DIST hard key. 

2. Press the Fundamental Frequency soft key. 

3. Enter a value by using the numeric keys. You can also use the rotary knob or the arrow keys. 

4. Select the unit: GHz, MHz, kHz, or Hz. 

The total harmonic distortion screen changes accordingly. 

 

Setting reference level 

You can set the reference level automatically or manually to optimize the display of the traces 

measured, as you desire. 

Procedure 

To automatically set the reference level: 

1. Press the AMP/SCALE hard key. 

2. Press the Auto Scale soft key. 

Each time you press this key, the Y-axis scale changes to be optimized with some margin. 

 
To set the reference or attenuation level manually: 

1. Press the AMP/SCALE hard key. 

2. To set the maximum reference value on the Y-axis manually, compete the following steps: 

a. Press the Reference Level soft key. 

b. Enter a value by using the numeric keys or the rotary knob with 10 dB increments. 

c. Select the unit: dBM or -dBM, or press the ENTER hard key. 

3. To set the attenuation option, select one from the following choices: 

–  To set the input attenuator's level automatically, select Attenuation > Auto. 

–  To set the input attenuation manually up to 55 dB to optimize S/N, complete the following 

steps: 

a. Select Attenuation > Manual. 

b. Press the Attenuation Value soft key to set the level. 

c. Enter a value in fives by using the numeric keys. 

d. Press the dB soft key or the ENTER hard key. 

–  To couple the input attenuator's level with your reference level setting, select Attenuation > 

Couple. 

 
Optional. To change the scale unit: 

1. Select More (1/2) > Units. 

2. Select the unit of the display scale: dBm, dBV, dBmV, dBμV, V, or W. 

The scale unit on the screen changes accordingly. 

 

Pre-amplifier 

You can turn the internal pre-amplifier on to correct and compensate for the gain of the preamp so that 

amplitude readings show the value at the input connector. 

Procedure 

1. Press the AMP/SCALE hard key. 

2. Toggle the Preamp soft key and select On or Off as needed. 
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NOTE 

You can turn the Preamp on when the input attenuation range is from 0 dB to 10 dB. If 
the attenuation value is manually set to greater than 10 dB, the instrument will 
automatically turn off the pre-amplifier to display low-level signal properly on the chart. 

 

External offset 

You can turn the External offset on and manually set the external offset value. 

Procedure 

To set the external offset: 

1. Press the AMP/SCALE hard key. 

2. Press the External Offset soft key and select On. 

Enter a value by using the numeric keys between -120 to 120. You can also use the rotary knob 
or the arrow keys. 

3. Press the dB soft key or the ENTER hard key. 

 
To turn the external offset off: 

1. Press the AMP/SCALE hard key. 

2. Press the External Offset soft key and select Off. 

 

Scale per division 

You can use the Scale/Div feature available for the total harmonic distortion screen. It represents the 

value of one division on the horizontal scale. The default setting is 10 dB per division and the 

maximum value can be set up to 20 dB. 

Procedure 

1. Press the AMP/SCALE hard key. 

2. Select More (1/2) > Scale/Div. 

Enter a value between 1 and 20 by using the numeric keys. You can also use the rotary knob or 
the arrow keys. 

3. Press the dB soft key or the ENTER hard key. 
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Using Interference Analyzer 

This chapter provides instructions for using the Interference Analyzer function (option 011). Topics 

discussed in this chapter are as follows: 

 

 Introduction ................................................................................................................................ 98 

 Display overview ........................................................................................................................ 98 

 Connecting a cable .................................................................................................................... 99 

 Selecting measurement mode ................................................................................................. 100 

 Configuring test parameters .................................................................................................... 100 

 Conducting spectrum measurements ...................................................................................... 107 

 Conducting interference measurements ................................................................................. 110 

 Setting limit for interference analyzer ...................................................................................... 124 
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Introduction 

Interference is becoming more prevalent in the wireless community with the increasing number of 

transmitters coming on the air. Wireless service providers have traditionally used spectrum analyzers 

to monitor service channels, frequencies, and adjacent spectrum and to locate sources of interference. 

A spectrum analyzer can only show you an interfering signal and you require determining the source of 

the interference. To solve interference problems, you must understand the RF environment, know 

adjacent operating transmitters, and identify any new or unlicensed emitters. 

 

Once a potential interfering signal is identified in the Spectrum Analyzer mode, you can monitor the 

signal further in the Interference Analyzer mode. JD780A series provides two different methodologies 

to identify and determine interference signals: Spectrogram and Received Signal Strength Indicator 

(RSSI). Locating the source of interference signal can be done with geographical information received 

from the built-in GPS receiver. 

 

The JD780A series is extremely effective for locating and identifying periodic or intermittent RF 

interference. Interference signals derive from several kinds of licensed or unlicensed transmitters that 

cause dropped calls and poor service quality.  

 

The JD780A series provides following measurements for interference analysis: 

 

 Spectrum 

 Spectrogram (Single/Dual) 

 RSSI (Received Signal Strength Indicator) 

 Interference Finder 

 Spectrum Replayer 

 Radar Chart 

 

Using a set of the AntennaAdvisor Handle that holds a broadband directional antenna is mandatory in 

the Rader Chart mode and its built-in compass, GPS antenna, gyro sensor, and low-noise amplifier 

(LNA) benefits you to determine the direction of the interference. 

 

Display overview 

Figure 26 provides descriptions for each segment of the measurement screen. 
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Figure 26 Interference measurement screen 

 

 

Connecting a cable 

Using an Omni or Yagi antenna 

Procedure 

1. Connect an Omni/directional RF antenna to the Spectrum Analyzer RF In port of the JD780A 

series. 

2. Connect a GPS antenna to the GPS port of the JD780A series. 

 

Figure 27 Interference measurement connection 

 
JD785A/JD786A 

 
JD788A 

 



JD780A Series Analyzers 

100 Using Interference Analyzer 

 

CAUTION 

If the input signal level to be measured is less than 0 dBm, set it to 0 dB attenuation or 
turn on the preamp to have better dynamic range for the testing. 

 

Using an AntennaAdvisor handle 

In the Interference Finder mode and the Radar Chart mode, you can perform interference hunting 

using the AntennaAdvisor Handle after attaching a broadband directional antenna to it. The handle is 

an optional device that has a built-in GPS antenna and LNA. 

 

Procedure 

1. Mount a broadband antenna to your AntennaAdvisor Handle according to the quick start guide of 
the AntennaAdvisor Handle. 

2. Connect the RF Type-N jack of the handle to the RF In port of the instrument. 

3. Connect the GPS SMA jack of the handle to the GPS port of the instrument. 

The GPS status indicator appears on the instrument screen. If GPS is locked, the indicator turns 
green. 

4. Connect the USB plug of the handle to the USB Host port of the JD780A series. 

The device icon      appears in the system status bar on the screen. 

 

Figure 28 Connection using AntennaAdvisor handle and log-periodic antenna 

 

 

Selecting measurement mode 

Procedure 

1. Press the MODE hard key. 

2. Press the Interference Analyzer soft key. The Spectrum mode is selected by default. 

3. To change the mode, press the MEASURE hot key and then select the measurement mode: 
Spectrogram, Dual Spectrogram, RSSI, Interference Finder, Spectrum Replayer, or Radar 
Chart. 
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NOTE 
If the Dual Spectrogram is selected, you can select the left or right measurement pane 
in MEASURE SETUP to configure measurement parameters for the selected 

spectrogram. 

 

Configuring test parameters 

Setting frequency  

You need to set the frequency range to be measured either with the center frequency and span or with 

the start and stop frequencies. You can also set the frequency with the channel number and span. 

 

Procedure 

To set the center frequency and span: 

1. Press the FREQ/DIST hard key. 

2. Toggle the Unit soft key and select Freq. 

3. Press the Center Frequency soft key. 

4. Enter a value by using the numeric keys. You can also use the rotary knob or the arrow keys. 

5. Select the unit: GHz, MHz, kHz, or Hz. 

6. Press the Span soft key, and then do one of the following: 

–  To set the span manually, select Span, enter a value, and then select the unit. 

–  To set the span automatically, select Full Span, Zero Span, or Last Span as needed. 

 

 

NOTE 
The Zero Span option is available only in the Spectrum mode. If you have selected Zero 
Span, select TRIGGER > Free Run, External, GPS, Video, or Display Position. 

 
To set the start and stop frequencies: 

1. Press the FREQ/DIST hard key. 

2. Toggle the Unit soft key and select Freq. 

3. Press the Start Frequency soft key. 

4. Enter a value by using the numeric keys. You can also use the rotary knob or the arrow keys. 

5. Select the unit: GHz, MHz, kHz, or Hz. 

6. Press the Stop Frequency soft key. 

7. Enter a value by using the numeric keys. You can also use the rotary knob or the arrow keys. 

8. Select the unit: GHz, MHz, kHz, or Hz. 
 
To set the channel number and span: 

1. Press the FREQ/DIST hard key. 

2. Toggle the Unit soft key and select Channel. 

3. To select the standard channel, complete the following steps: 

a. Press the Channel Std soft key. The standard channel window appears. 

See “Appendix C – Band, frequency & channel standard” on page 588 for more information. 

b. Select the band to be measured by using the rotary knob, the arrow keys, or the Page 
Up/Page Down soft keys. 

c. Press the Select soft key or the rotary knob to confirm the selection. 
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4. Toggle the Link soft key to select the sweep direction and select Fwd for forward or Rev for 

reverse. 

5. To set the channel number, complete the following steps: 

a. Press the Channel Number soft key. 

b. Enter a value by using the numeric keys. 

c. Press the Enter soft key or ENTER hard key to complete the entry. 

The instrument automatically displays the corresponding center frequency value for the 
selected channel number. 

6. To set the span, complete the following steps: 

a. Press the Span soft key. 

b. Select the span option, from the following choices: 

–  To set the span manually, select Span, enter a value, and then select the unit. 

–  To set the span automatically, select Full Span, Zero Span, or Last Span as needed. 

 

 

NOTE 
The Zero Span option is available only in the Spectrum mode. If you have selected Zero 
Span, select TRIGGER > Free Run, External, GPS, Video, or Display Position. 

 
Optional. To define the amount of frequency increment for the rotary knob: 

1. Press the Frequency Step soft key, if the Freq is selected. 

2. Enter a value by using the numeric keys. 

3. Press the unit: GHz, MHz, kHz, or Hz. 
 
Optional. To define the amount of channel increment for the rotary knob: 

1. Press the Channel Step soft key, if the Channel is selected. 

2. Enter a value by using the numeric keys. 

3. Press the Enter soft key. 

 

Setting amplitude 

Reference level and attenuation 

You can set the reference and attenuation levels automatically or manually to optimize the display of 

the traces measured, as you desire. 

 

Procedure 

To automatically set the reference and attenuation level: 

1. Press the AMP/SCALE hard key. 

2. Press the Auto Scale soft key. 

Each time you press this key, both of the Y-axis scale and input attenuation level change to be 
optimized with some margin. 

 
To set the reference or attenuation level manually: 

1. Press the AMP/SCALE hard key. 

2. To set the maximum reference value on the Y-axis manually, complete the following steps: 

a. Press the Reference Level soft key. 

b. Enter a value by using the numeric keys or the rotary knob with 10 dB increments. 

c. Press the dBm soft key or the ENTER hard key. 
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3. To set the attenuation option, select one from the following choices: 

–  To set the input attenuator’s level automatically, select Attenuation > Auto. 
 

 

NOTE 
It is recommended that you set the Attenuation to Auto in most situations so that the 

level of the input attenuator can be set automatically according to your input signal level. 

 

–  To set the input attenuation manually up to 55 dB to optimize S/N, complete the following 
steps: 

a. Select Attenuation > Manual. 

b. Press the Attenuation Value soft key to set the level. 

c. Enter a value between 0 and 55 in fives by using the numeric keys. 

d. Press the dB soft key or the ENTER hard key. 

–  To couple the input attenuator’s level with your reference level setting, select Attenuation > 
Couple. 

As you increase the reference setting, the attenuation level also increases acoordingly. 
 
Optional. To change the scale unit: 

1. Select More (1/2) > Units. 

2. Select the unit of the display scale: dBm, dBV, dBmV, dBµV, V, or W. 

The scale unit on the screen changes accordingly. 

 

Scale per division 

You can use the Scale/Div feature available for the spectrum measurement screen. It represents the 

value of one division on the horizontal scale. The default setting is 10 dB per division and the 

maximum value can be set up to 20 dB. 

 

Procedure 

To set the scale per division: 

1. Press the AMP/SCALE hard key. 

2. Select More (1/2) > Scale/Div. 

3. Enter a value between 1 and 20 by using the numeric keys. 

4. Press the dB soft key to complete the entry. 

 

Pre-amplifier 

You can turn the internal pre-amplifier on to correct and compensate for the gain of the preamp so that 

amplitude readings show the value at the input connector. 
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Procedure 

1. Press the AMP/SCALE hard key. 

2. Toggle the Preamp soft key and select On or Off as needed. 

 

 

NOTE 

You can turn the Preamp on when the input attenuation range is from 0 dB to 10 dB. If 
the attenuation value is manually set to greater than 10 dB, the instrument will 
automatically turn off the pre-amplifier to display low-level signal properly on the chart. 

 

External offset 

You can turn the External Offset on and manually set the external offset value. An offset consists of a 

cable loss and a user offset and the measurement result shows the value reflecting both offset values. 

When the external offset value is set at 40 dB in the Spectrum mode, the measurement result 

compensates 40 dB at both the Spectrum Analyzer and Signal Analyzer modes 

 

Procedure 

To set the external offset: 

1. Press the AMP/SCALE hard key. 

2. Toggle the External Offset soft key and select On. 

3. Enter a value by using the numeric keys. 

4. Press the unit soft key to complete the entry. 
 
To turn the external offset off: 

1. Press the AMP/SCALE hard key. 

2. Toggle the External Offset soft key and select Off. 

 

Setting bandwidth 

VBW based on the designated RBW. Selecting Auto changes the value to correspond to your 

frequency span setting for RBW and to the current RBW and VBW/RBW settings for VBW. 

 

Procedure 

To automatically set the RBW and VBW to your selected VBW/RBW ratio: 

1. Press the BW/AVG hard key. 

2. Press the VBW/RBW soft key to set the proportional VBW based on the designated RBW. 

Table 9 shows the ratio example for 30 kHz RBW. 

3. Select the ratio: 1, 0.3, 0.1, 0.03, 0.01, or 0.003. 

4. Toggle the RBW soft key and select Auto. 

5. Toggle the VBW soft key and select Auto. 

The RBW or VBW value on the screen changes accordingly based on the span. 

 
To manually set the RBW or VBW to your selected VBW/RBW ratio: 

1. Press the BW/AVG hard key. 

2. Press the RBW soft key. 
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3. Enter a value between 1 Hz to 3 MHz in 1-3 sequence by using the numeric keys. 

4. Select the unit: MHz, kHz, or Hz. 
The RBW setting automatically changes to Manual. 

5. Press the VBW soft key. 

6. Enter a value by using the numeric keys. 

7. Select the unit: MHz, kHz, or Hz. 
The VBW setting automatically changes to Manual. 

The RBW or VBW value on the screen changes accordingly. 

 

Table 10 VBW/RBW ratio example 

RBW Ratio (VBW/RBW) VBW 

30 kHz 1:1 30 kHz 

 1:0.3 10 kHz 

 1:0.1 3 kHz 

 1:0.03 1 kHz 

 1:0.01 300 Hz 

 1:0.003 100 Hz 

 

Setting average 

You can set the number of measurements to be averaged for the trace presentation. A maximum of 

100 times of averaging can be set. When the averaging reaches to your setting, a new measurement 

value replaces the measurement value in sequence from the earliest. 

 

Procedure 

1. Press the BW/AVG hard key. 

2. Press the Average soft key. 

3. Enter a value between 1 and 100 as needed by using the numeric keys. 

4. Press the Enter soft key. 

 

Setting sweep 

The SWEEP hot key is used to set and control the sweep time, sweep mode, gated sweep settings, 

and gated sweep on or off. This key is not available in the Dual Spectrum and Radar Chart modes. 

 

Sweep time 

You can set the sweep time automatically or manually. Manual setting allows you to set the sweep time 

beyond an automatic setting. 

 

Procedure 

1. Press the SWEEP hot key. 

2. Select the sweep time option, from the following choices: 
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–  To automatically set, toggle the Sweep Time soft key and select Auto. 

–  To manually set, complete the following steps: 

a. Press the Sweep Time soft key. 

b. Enter a value by using the numeric keys. 

c. Select the unit: Sec, mSec, or µSec. 
The sweep time mode automatically changes to Manual. 

 

Sweep mode 

The default settings of the sweep mode are Continue and Normal to sweep continuously at a normal 

speed for most on-going measurements. If you want to hold the measurement or get a single sweep, 

you can change the sweep mode. 

 

Procedure 

To select the single sweep mode: 

1. Press the SWEEP hot key. 

2. Toggle the Sweep Mode soft key and select Single. You can also use the HOLD hot key. 

The letter HOLD in red appears and the sweeping is paused. 

3. Optional. Press the Sweep Once soft key to get a new measurement. 
 
To return to the continuous sweep mode: 

1. Toggle the Sweep Mode soft key and select Continue. You can also use the HOLD hot key. 

The letter HOLD in red disappears and the sweeping resumes. 

 

 

NOTE 
Selecting Sweep Mode > Fast may reduce the measurement accuracy, but you can use 

this fast sweep mode to identify the existence of interfering signals. 

 

Gated sweep 

You can configure the gated sweep settings with an internal or external trigger source. If you select 

Gated Sweep Settings, you can view the signal in time domain. 

 

Procedure 

1. Press the SWEEP hot key. 

2. Press the Gated Sweep Settings soft key. 

3. Optional. Adjust sweep time to allow enough time for a cycle by completing the following steps: 

a. Press the Zero Span Time soft key. 

b. Enter a value by using the numeric keys. 

c. Select the unit: Sec, mSec, or µSec. 

4. Set the period, if using the internal trigger source, by doing one of the following: 

–  To select the preset period, complete the following steps: 

a. Toggle the Period soft key and select StdSignal. 

b. Press the StdSignal soft key, and then select the period: GSM (4.615 ms), WCDMA 
(10 ms), LTE (10 ms), EV-DO (5 ms), TD-SCDMA (5 ms), or WiMAX (10 ms). 

–  To manually set the period, complete the following steps: 
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a. Toggle the Period soft key and select Manual. 

b. Press the Period soft key to enter the amount of time. 

c. Enter a value by using the numeric keys. 

d. Select the unit: Sec, mSec, or µSec. 

5. Press the TRIGGER hot key, and then do one of the following: 

–  Select External for an external trigger source. 

–  Select Video or Display Position for the internal trigger source. 

6. Press the PREV hard key to continue setting the gated sweep. 

7. Set the gate delay by completing the following steps: 

a. Press the Gate Delay soft key. 

b. Enter a value by using the numeric keys. 

c. Select the unit: Sec, mSec, or µSec. 

8. Set the gate length by completing the following steps: 

a. Press the Gate Length soft key. 

b. Enter a value by using the numeric keys. 

c. Select the unit: Sec, mSec, or µSec. 

9. Press the PREV hard key to enable gated sweeping. 

10. Toggle the Gated Sweep soft key and select On. 

 

 

NOTE 

This setting is not used in the Spectrum Replayer mode. 

 

Conducting spectrum measurements 

The spectrum measurement with an audible indicator is especially useful for locating interferer sources 

with a directional antenna. 

 

Setting trace 

You can display up to six traces on the measurement chart simultaneously. 

 

Procedure 

1. Press the TRACE/DISPLAY hard key. 

2. Press the Select Trace soft key, and then select the trace number: T1, T2, T3, T4, T5, or T6. 

The legend shape of the selected trace changes from square to round to indicate that the trace is 
the active one now. 

3. Do one of the following: 
 

To Select Trace Legend 

Clear current data and display with new 
measurements 

Clear Write W 

Display the input signal’s maximum response only 
(unlimited or for a certain amount of time) 

Max Hold M 
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Display the input signal’s minimum response only 
(unlimited or for a certain amount of time) 

Min Hold m 

Capture the selected trace and compare traces Capture C 

Load a saved trace More (1/2) > Load L 

Hide the selected trace Trace View > Off F 

Remove all the traces and initialize the trace 
settings 

More (1/2) > Trace 
Clear All 

 

 

 

NOTE 
For the Max Hold and Min Hold, your instrument compares newly acquired data with the 

active trace and displays larger maximum values or smaller minimum values on the 
screen. You can set it to Unlimited to hold and view maximum or minimum data or 

specify a certain amount of time up to 60 seconds by using numeric keys or the rotary 
knob. 

4. To select the detection option, press the More (1/2) > Detectors, and then do one of the 

following: 
 

To display Select 

Random noise better than the peak without missing signals Normal 

The highest value in each data point Peak 

The root mean squared average power across the spectrum RMS 

The lowest value in each data point Negative Peak 

The center value in each data point Sample 

5. Optional. Press the More (1/2) > Trace Info soft key, and then select the trace number to view 
the trace’s parameter setting information stored at the time of the measurement or None to hide 

the information display. 

6. Optional. If you have the two traces T1 and T2, you can perform trace math. To view the power 
difference between the traces, press the T1 – T2 -> T5 or T2 – T1 -> T6 soft key. 

The result is overlaid on the screen along with the second Y-axis. 

 

 

NOTE 

To be able to load a trace, the trace to be overlaid must be saved in the same 
measurement mode and frequency setting as the current measurement. 

 

Sound indicator 

You can use the Sound Indicator to help you identify interfering signals by sounding an alarm. 

 

Procedure 

1. Configure test parameters as described in the “Configuring test parameters” on page 100. 

2. Press the MEASURE SETUP hot key. 

3. Press the Sound Indicator soft key. 

4. Toggle the Sound soft key between On and Off to enable and disable the alarm sound. 

5. Select the alarm reference option from the following choices: 

–  To set the active marker position as the alarm reference, toggle the Alarm Reference soft 
key and select Marker. 
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–  To set the limit as the alarm reference, complete the following steps: 

a. Toggle the Alarm Reference soft key and select Line. 

The Limit Line menu becomes activated to be set. 

b. Press the Limit Line soft key to define a threshold for the limit line. 

c. Enter a value by using the numeric keys. You can also use the rotary knob. 

d. Press the dBm soft key. 

6. Optional. To adjust the volume for alarm sound, press the Volume soft key and then turn the 

rotary knob clockwise or counter clockwise. 

7. Optional. You can save logging data automatically so that you can load the measurement data 

and replay in the Spectrum Replayer mode. See “Using save” on page 33 for more information. 

 

AM/FM audio demodulation 

You can use the AM/FM Audio Demodulation to identify if the interfering signal is n
th
 harmonics of 

AM/FM audio. The instrument sounds demodulated signals that you can hear through the speaker or 

headphones. 

 

Procedure 

1. Configure test parameters as described in the “Configuring test parameters” on page 100. 

2. Press the MEASURE SETUP hot key. 

3. Toggle the Audio Demod soft key between On and Off to turn the AM/FM audio demodulation 

on and off. 

4. Press the Demod at soft key, and then select the marker number for the frequency to be 

demodulated. 
 

 

NOTE 
You must set the marker(s) first by using the MARKER hard key as the AM/FM 

demodulator uses the marker position to demodulate. See “Using marker” on page 56 for 
more information. 

5. Press the Demod Mode soft key, and then select the demodulation mode: AM, FM and CW. 

6. Press the Dwell Time soft key, and then turn the rotary knob to set the demodulation interval 

between 1 and 20. 

7. Press the Volume soft key, and then turn the rotary knob to set the speaker volume. 

8. Toggle the Auto Gain soft key between On and Off to enable or disable the automatic gain 

feature to adjust the interval gain of the demodulator. 

9. Optional. Go to SAVE/LOAD > Save, and then select the save option from the choices available 

for your measurement mode. See “Using save” on page 33 for more information. 

 

Interference ID 

The Interference ID automatically classifies interfering signals over a designated spectrum and 

displays the list of possible signal types corresponding to the selected signal. 

 

Procedure 

1. Configure test parameters as described in the “Configuring test parameters” on page 100. 

2. Press the MEASURE SETUP hot key. 
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3. Toggle the Interference ID soft key between On and Off to turn the Interference ID on and off. 

4. To set the threshold level manually, complete the following steps: 

a. Press the Threshold soft key. 

b. Enter a value by using the numeric keys. 

c. Press the dBm soft key. 

5. Optional. Go to SAVE/LOAD > Save, and then select the save option from the choices available 

for your measurement mode. See “Using save” on page 33 for more information. 

 

 

NOTE 
You can use the LIMIT hot key to analyze your measurements with the display line, multi-
segment line, and channel limit. See “Setting limit for interference analyzer” on page 124 
for more information. 

 

Conducting interference measurements 

Spectrogram 

The Spectrogram is particularly useful when attempting to identify periodic or intermittent signals as it 

captures spectrum activity over time and uses various colors to differentiate spectrum power levels. 

When the directional antenna is used to receive the signal, you will see a change in the amplitude of 

the tracked signal as you change the direction of the antenna and see a change in the Spectrogram 

colors. The source of the signal is located in the direction that results in the highest signal strength. 

 

Setting measure setup 

Procedure 

1. Configure test parameters as described in the “Configuring test parameters” on page 100. 

2. Press the MEASURE SETUP hot key. 

3. To set the amount of time between each trace measurement: 

a. Press the Time Interval soft key. 

b. Enter a value by using the numeric keys. You can also use the rotary knob. 

c. Press the Sec soft key. 

4. To set the time cursor on a specific trace position, complete the following steps: 

a. Toggle the Time Cursor soft key and select On. 

b. Turn the rotary knob to move the time cursor. You can also enter a value and then press the 
Enter soft key. 

 

 

NOTE 

Enabling the time cursor puts the measurement on hold and you can make post-
processing analysis for each measurement over time using the time cursor. 

5. To start a new measurement, press the Reset/Restart soft key. 

6. Optional. Go to SAVE/LOAD > Save, and then select the save option from the choices available 

for your measurement mode. See “Using save” on page 33 for more information. 

 

Measurement example 

The spectrogram shows a vertical line on the chart when the marker is enabled on the screen. 
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Figure 29 Interference measurement in spectrogram 

 

 

 The horizontal line or X-axis of the spectrogram is frequency. 

 The vertical line or Y-axis is time. 

 The color identification (Spectrogram) indicates power level of the tracked signal. As the signal 

strength increases, the color on the spectrogram changes accordingly. 

 

Figure 30 Interference measurement in spectrogram with gated sweep on 

 

 

 

NOTE 
You can use the LIMIT hot key to analyze your measurements with the display line, multi-
segment line, and channel limit. See “Setting limit for interference analyzer” on page 124 
for more information. 
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Dual spectrogram 

The Dual Spectrogram mode is useful to compare two spectrograms displayed simultaneously on the 

screen. 

 

Setting measure setup 

Procedure 

1. Configure test parameters as described in the “Configuring test parameters” on page 100. 

2. Press the MEASURE SETUP hot key. 

3. Toggle the Active Window soft key and select Left or Right spectrogram to be set up. 

4. To set the amount of time between each trace measurement: 

a. Press the Time Interval soft key. 

b. Enter a value by using the numeric keys. You can also use the rotary knob. 

c. Press the Sec soft key. 

5. To set the time cursor on a specific trace position, complete the following steps: 

a. Toggle the Time Cursor soft key and select On. 

b. Turn the rotary knob to move the time cursor. You can also enter a value and then press the 
Enter soft key. 

 

 

NOTE 

Enabling the time cursor puts the measurement on hold and you can make post-
processing analysis for each measurement over time using the time cursor. 

6. To start a new measurement, press the Reset/Restart soft key. 

7. Optional. Go to SAVE/LOAD > Save, and then select the save option from the choices available 

for your measurement mode. See “Using save” on page 33 for more information. 

 

Measurement example 

Figure 31 Interference measurement in dual spectrogram view 
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RSSI 

The Received Signal Strength Indicator (RSSI) is a multi-signal tracking metric that is particularly 

useful for measuring power-level variations over time. The RSSI measurement lets you assign power 

limit line for audible alarms and increase alarm counters every time a signal exceeds a defined limit 

line. For long-term analysis, the spectrogram and RSSI measurements can be automatically saved 

into an external USB memory. Post-analysis can be performed with JDViewer application software. 

 

Setting measure setup 

Procedure 

1. Configure test parameters as described in the “Configuring test parameters” on page 100. 

2. Press the MEASURE SETUP hot key. 

3. To set up the alarm parameters, complete the following steps: 

a. Press the Alarm soft key. 

b. Press the Alarm at soft key and select the marker number: M1 to M6 . 

c. Press the Limit Line soft key to set a threshold for the alarm. 

d. Enter a value by using the numeric keys. You can also use the rotary knob. 

e. Press the dBm soft key. 

f. Toggle the Alarm soft key between On and Off to turn the alarm feature on or off. 

g. Optional. Press the Volume soft key and adjust the volume. 

4. To set up the AM/FM audio demodulation, complete the following steps: 

a. Press the AM/FM Audio Demod soft key. 

b. Toggle the Audio Demod soft key between On and Off to turn the AM/FM audio 

demodulation on or off. 

c. Press the Demod at soft key, and then select the marker number for the frequency to be 

demodulated. 
 

 

NOTE 

For the alarm and AM/FM audio demodulation, you must set the marker(s) first by using 
the MARKER hard key as these features use the marker position to sound alarm or 

demodulate. See “Using marker” on page 56 for more information. 

d. Press the Demod Mode soft key, and then select the demodulation mode: AM, FM and 
CW. 

e. Press the Dwell Time soft key, and then turn the rotary knob to set the demodulation 

interval between 1 and 20. 

f. Toggle the Auto Gain soft key between On and Off to enable or disable the automatic gain 

feature to adjust the interval gain of the demodulator. 

g. Optional. Press the Volume soft key and adjust the volume. 

5. To start a new measurement, press the Reset/Restart soft key. 

6. Optional. Go to SAVE/LOAD > Save, and then select the save option from the choices available 

for your measurement mode. See “Using save” on page 33 for more information. 
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Measurement example 

Figure 32 Interference measurement in RSSI 

 

 

 

NOTE 

You can use the LIMIT hot key to analyze your measurements with the display line, multi-
segment line, and channel limit. See “Setting limit for interference analyzer” on page 124 
for more information. 

 

Interference finder 

The Interference Finder is an automatic triangulation algorithm that uses GPS coordinates to locate 

possible interference sources based on three measurements. The interference finder calculates 

possible interference locations using its inscribed circle or circumscribed circle based on measured 

intersection points. You can plot up to seven measurement points and select three that are more 

representative for triangulation. JD780A series automatically logs measurement positions not to lose 

them while changing measurement modes. 

 

If you have obtained user experience data through Viavi’s ariesoGEO and generated raster data files 

from the application, you can load them onto your route map to help you troubleshoot problems easily 

and quickly. 

 

Loading a map 

After you have made connections as described in the “Connecting a cable” on page 99 and configured 

test parameters as described in the “Configuring test parameters” on page 101, you need to load a 

map of the area where you want to go out and do interference hunting. 
 

Procedure 

1. Plug in your USB drive that has a map file in .mcf file type created in JDMapCreator. If the 

JDMapCreator application on your computer is connected to the instrument via USB or LAN,  
you can send a map file with a single layer to the instrument directly by using the Send to EQP 

menu in JDMapCreator. 

 

NOTE 

The JDMapCreator converts and resizes any scanned floor plan or layout to fit onto your 
instrument’s display. JDMapCreator 1.2.0 or later can save a multiple-layered map, 
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providing x1, x2, and x4 views, as a sizable map file so that you can zoom in and out 

after loading it. 

2. Press SAVE/LOAD hot key, and then select Load > Load Map. 

3. Navigate to a map file you want to open. 
The File Information pane displays file properties including file name, map type, and address. If 
you see “Sizable Map” for Map Type, you can zoom in and out the base map after loading. 

4. Press the Load soft key. The loaded map appears. 

 

Initializing AntennaAdvisor 

If you have connected the AntennaAdvisor Handle, you must initialize it. 

 

Procedure 

1. Press the MEASURE SETUP hot key. 
A message appears at the bottom of the screen to alert you if you have not performed 
initialization of your connected the antenna handle set. 

2. To adjust the integration bandwidth based on the center frequency of the interfering signal that 
you have identified in the Spectrum view, complete the following steps: 

a. Press the Bandwidth soft key. 

b. Enter a value by using the numeric keys. You can also use the rotary knob. 

c. Select the unit option from the choices: GHz, MHz, kHz, and Hz. 

3. Initialize the antenna handle to calibrate the built-in compass by completing the following steps: 

a. Hold your antenna handle horizontally in its upright position. 

b. Point the antenna to the north, and then press the Initialize AntennaAdvisor soft key. 

 

Setting location 

As the Interference Finder uses triangulation to provide a circle of possible source of the interference, 

you must set three location points so that the straight lines started from the point can create three 

intersections. If you have the AntennaAdvisor Handle, it makes it easy to determine these points using 

its built-in compass and GPS antenna while measure power level of the received signal. 

 

Procedure 

1. Press the Location Setup soft key in the Measure Setup menu bar. 

2. Press the Location soft key to set three location points. 

3. Press the Point [1|2|3] soft key to set the first location point, and then do one of the following: 

–  To automatically get the selected point’s positioning information with GPS locked, press the 

Get GPS Position. The instrument displays the latitude and longitude information of the 

signal received by either the GPS antenna or AntennaAdvisor Handle. 

–  To manually define a position for the selected point, complete the following steps: 

a. Press the Latitude soft key, and then set the properties: North/South, Degree, 
Minute, and Second. 

b. Press the Longitude soft key, and then set the properties: East/West, Degree, 
Minute, and Second. 

4. To set an azimuth, do one of the following: 

–  Using the AntennaAdvisor Handle, complete the following steps: 

a. Press and hold the TRIGGER button on the handle and pan the antenna handle to scan 

through until you find the strongest RSSI value. 
RSSI, polarization, elevation and azimuth readings are continuously updated on the 
screen while pressing the physical button. 
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b. Release the TRIGGER button to stop scanning. 

–  Using a compass, complete the following steps: 

a. Press the Azimuth soft key. 

b. Pan your Yagi antenna to find a signal with highest RSSI value, and then measure an 
azimuth of the interfering signal. 

c. Enter the measured angle using the numeric keys, and then press the Enter soft key. 

–  Using your instrument without a compass, complete the following steps: 

a. Press the Azimuth soft key. 

b. Pan your Yagi antenna to find a signal with highest RSSI value. 

c. Turn the rotary knob to align the straight line on the base map with the direction of the 
interfering signal. The azimuth calculated by the instrument appears on the screen. 

 

NOTE 

The AntennaAdvisor Handle has a built-in low-noise amplifier (LNA) and you can turn it 
on and off using the physical On/Off button located on the rear side of the handle unit. 
For example, if the received signal is weak, you can turn on the switch to improve S/N. 

5. To save the defined position, press the Save Position soft key and then select one of the soft 

keys to which you want to save the position information. The instrument stores the saved location 
points in the internal memory so that you can load them by using the Load Position soft key. 

6. Press the Location soft key, and then repeat steps 3-5 to set the second location point. 

7. Press the Location soft key, and then repeat steps 3-5 to set the third location point. 

The circumscribed circle appears when the lines from three location points create three 
intersections or vertices. 

   
 

 

Setting display mode 

When the triangulation is done with three location points and azimuth for each point, you can view a 

circumscribed circle by default. You can change the display mode to inscribed circle or double circles 

to view a narrower area. The center of the green-shaded circle is determined to be where the source 

of the interfering signal resides. 
 

Procedure 

1. Press the Display Setup soft key in the Measure Setup menu bar. 

2. Press the Display Mode soft key, and then select the option from the following choices: 

–  Circum: It displays a circumscribed circle that meets the three vertices of the triangle. 

–  Inscribed: It displays an inscribed circle that meets the three sides of the triangle. 

–  Double: it displays both circumscribed and inscribed circles. 

Circumscribed 

 

Inscribed 

 

Double 
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3. Toggle the Screen Mode soft key to select Map or Full as needed. 

–  Map: This option displays what are inside the base map with the map image. 

–  Full: This option displays three location points and defined circle without the map image. 

 

Controlling a map 

If you have loaded a sizable map that was created in JDMapCreator 1.2.0 or later, you can use the 

Map Control feature that enables you to zoom into the green-shaded area on the map and view the 

location of the interference source in detail. 

 

Procedure 

1. Press the TRACE/DISPLAY hard key. 

2. Press the Map Control soft key. This key is active only when you have loaded a sizable map. 

3. Do one of the following: 

–  To zoom into an area of interest directly, complete the following steps: 

a. Toggle the Zoom to soft key and select Area. 

The black rectangle appears on the map. 

b. Press the Zoom In and Zoom Out soft keys, as you need, to decrease and increase 

the selected area. 

c. Move the rectangle by using the four arrow keys, as you need, to place it in a specific 
area of interest. 

d. Press the center of the rotary knob to zoom into the selected area. You can also press 
the Zoom to soft key again to zoom into the selected area. 

–  To zoom into the center or zoom out from the center, complete the following steps: 

a. Toggle the Zoom to soft key and select Center. 

b. Press the Zoom In and Zoom Out soft keys, as you need, to zoom in and zoom out. 

c. Move the zoomed-in area by using the four arrow keys, as you need. 

 

Measurement example 

Figure 33 Interference finder measurement in map view 
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Loading and displaying raster data 

If you have a set of raster data files generated through the ariesoGEO application, you can load and 

overlay the data on your base map to help you assume suspicious points of interference easily and 

pinpoint the source of the interference quickly. 

 

Procedure 

1. Copy a set of raster data files into your USB memory drive, including the following: 

–  ASCII: .tab, .asc, and .clr files 

–  BIL: .tab,.hdr, .bil, and .clr files 

 

NOTE 
The .tab file type is a geospatial vector data format used in many geographic 

information systems. The color file (.clr) is an optional file, but the image will be 

displayed as a grayscale image without it. The size of the raster map must be  
1024 x 1024 or smaller. 

2. Plug in the USB memory drive to your instrument. 

3. Press the TRACE/DISPLAY hard key. 

4. Press the Load Raster Map soft key. 

The file explorer window appears. 

5. Navigate to the raster file (.tab) you want to open, and then press the Load soft key. 

The raster image appears on top of your base map as shown in Figure 34. 

 

NOTE 

If the area of the loaded raster data is not within the boundary of the base map, you will 
not see the raster image on the screen. 

6. To select the display option, complete the following steps: 

a. Press the Display Options soft key. 

b. Select the option you desire from the choices: On, Off, and Blink. 

7. To adjust the transparency level of the image, complete the following steps: 

a. Press the Transparency soft key. 

b. Enter a value between 0 for opaque and 100 for clear. 

c. Press the Enter soft key. 

 

Figure 34 Raster image overlaid on the map in interference finder 
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Spectrum Replayer 

The Spectrum Replayer lets you retrieve and replay recorded spectrum analyzer traces in interference 

analysis mode. These traces can be played back in the spectrogram or RSSI. You can configure the 

limit line to create failure points when signals exceed it. The failure points are clearly displayed on the 

trace timeline for quick access during playback. 

 

Setting measure setup 

Procedure 

1. Press the MEASURE hot key. 

2. Press the Spectrum Replayer soft key. 

The file manager window appears. 

3. Select a file to be loaded, and then press the Load soft key. 

The Measure Setup screen menus appear. 

4. Toggle the Replay Direction soft key between FWD and REV to change play direction to forward 

or reverse. 

5. Press the Replay Speed soft key, and then select the speed option: x1, x2, x3, and x4. 

6. Press the Play soft key to start playing. 

7. Press the Pause soft key to pause or stop playing data. 

8. To move to a particular failure position directly and play from there, complete the following steps: 

a. Press the Jump to Fail Index soft key. 

b. Enter a value by using the numeric keys. 

c. Press the Enter soft key. 

9. Optional. Toggle the Time Cursor soft key between On and Off to display or hide the time cursor 

on the screen. This key becomes activated when you play logged data in the Spectrogram mode. 

 

 

NOTE 

If you connected a USB drive, do not remove it while playing. Doing so may freeze the 
USB port, which will require you to restart the instrument to get a USB drive recognized 
again. 

 

Setting display 

You can select the display option. 

 

Procedure 

1. Press the TRACE/DISPLAY hard key. 

2. Select the display option: Spectrum, Spectrogram, or RSSI. 

 

 

NOTE 
You can use the LIMIT hot key to analyze your measurements with the display line, multi-
segment line, and channel limit. See “Setting limit for interference analyzer” on page 124 
for more information. 

 

Radar Chart 

If you have identified an interfering signal on your spectrum view, you can move to the Radar Chart 

mode and measure RSSI power level through 360 degrees at a location received by the connected 
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broadband directional antenna so that you can determine the direction of the source of the interference. 

A set of the AntennaAdvisor Handle with the antenna is mandatory to perform measurements in this 

mode. 

 

If you have obtained user experience data through Viavi’s ariesoGEO and generated raster data files 

from the application, you can load them onto your base map to help you troubleshoot problems easily 

and quickly. 

 

Loading a map 

After you have connected your AntennaAdvisor Handle set to the JD780A series as described in the 

“Using an AntennaAdvisor handle” on page 100 and configured test parameters as described in the 

“Configuring test parameters” on page 101, you need to load a map of the area where you want to go 

out and do interference hunting activities. 

 

Procedure 

1. Plug in your USB drive that has a map file in .mcf file type created in JDMapCreator. If the 

JDMapCreator application on your computer is connected to the instrument via USB or LAN,  
you can send a map file with a single layer to the instrument directly by using the Send to EQP 

menu in JDMapCreator. 

 

NOTE 

The JDMapCreator converts and resizes any scanned floor plan or layout to fit onto your 
instrument’s display. JDMapCreator 1.2.0 or later can save a multiple-layered map, 
providing x1, x2, and x4 views, as a sizable map file so that you can zoom in and out 

after loading it. 

2. Press SAVE/LOAD hot key, and then select Load > Load Map. 

3. Navigate to a map file you want to open. 
The File Information pane displays file properties including file name, map type, and address. If 
you see “Sizable Map” for Map Type, you can zoom in and out the base map after loading. 

4. Press the Load soft key. 
The loaded map appears. Before pressing the Get GPS Position soft key, you should not 

interpret the center of the radar chart as your current geographical location on the map. 

 

Controlling a map 

If you have loaded a sizable map that was created in JDMapCreator 1.2.0 or later, you can use the 

Map Control feature that enables you to zoom into the map and view a specific area of interest in detail. 

 

Procedure 

1. Press the TRACE/DISPLAY hard key. 

2. Press the Map Control soft key. This key is active only when you have loaded a sizable map. 

3. Do one of the following: 

–  To zoom into an area of interest directly, complete the following steps: 

a. Toggle the Zoom to soft key and select Area. 

The black rectangle appears on the map. 

b. Press the Zoom In and Zoom Out soft keys, as you need, to decrease and increase 

the selected area. 

c. Move the rectangle by using the four arrow keys, as you need, to place it in a specific 
area of interest. 

d. Press the center of the rotary knob to zoom into the selected area. You can also press 
the Zoom to soft key again to zoom into the selected area. 

–  To zoom into the center or zoom out from the center, complete the following steps: 
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a. Toggle the Zoom to soft key and select Center. 

b. Press the Zoom In and Zoom Out soft keys, as you need, to zoom in and zoom out. 

c. Move the zoomed-in area by using the four arrow keys, as you need. 

 

Initializing AntennaAdvisor 

After you have connected the AntennaAdvisor Handle and loaded a map for the area of interest, you 

must initialize the AntennaAdvisor Handle to calibrate its built-in compass in order to obtain accurate 

azimuth information. 

 

Procedure 

1. Press the MEASURE SETUP hot key. 
A message appears at the bottom of the screen to alert you if you have not performed 
initialization of your connected the antenna handle set. 

2. To adjust the integration bandwidth based on the center frequency of the interfering signal that 
you have identified in the Spectrum view, complete the following steps: 

a. Press the Bandwidth soft key. 

b. Enter a value by using the numeric keys. You can also use the rotary knob. 

c. Select the unit option from the choices: GHz, MHz, kHz, and Hz. 

3. Initialize the antenna handle to calibrate the built-in compass by completing the following steps: 

a. Hold your antenna handle horizontally in its upright position. To avoid unnecessary impact 
of external magnetic field, position yourself at the location where the value of magnetic field 
strength displayed on the instrument is green. 

b. Point the antenna to the north, and then press the Initialize AntennaAdvisor soft key. 

The message disappears and the red line for the current antenna direction moves to the  
0-degree line and overlaps to let you know that the initialization is done successfully. 

 

 

NOTE 

If is recommended that you re-initialize the AntennaAdvisor Handle after measurements 
to re-calibrate the compass when you notice that the red line on the radar chart is not 
aligned with the north on the map even though you are pointing the antenna to the north. 

 

Obtaining RSSI data 

After you have connected your antenna handle set and done necessary setups, you can monitor the 

power level of the received signal, the amount of polarization, and elevation level real time. Using the 

Trigger button on the antenna handle set, you can plot the RSSI level through 360 degrees at your 

location. 

 

Procedure 

1. When you have the green GPS indicator, press the Get GPS Position soft key in the Measure 

Setup menu bar to set your current location with GPS locked as the center of the radar chart. 
The latitude and longitude information at the bottom of the display changes from ‘Unknown 
Position’ to the obtained position information. 

2. Optional. To save a position to recall for triangulation in the Interference Finder mode, press the 
Save Position soft key and then select one of the soft keys to which you want to save. 

3. Monitor the RSSI reading of the received signal. If the signal is weak, turn on the LNA switch on 
the antenna handle set to improve S/N. 

 

NOTE 

The AntennaAdvisor Handle has a built-in low-noise amplifier (LNA) and you can turn it 
on and off by toggling the physical On/Off switch located on the rear side of the handle 
unit. 
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4. Hold the antenna handle set horizontally and then make the following measurement: 

–  To obtain a RSSI value, complete the following steps: 

a. Press the TRIGGER button located on the antenna handle. 

Every time you press the physical button on the handle, a beep is sounded and a power 
level of the received signal is plotted as a blue dot on the radar chart. Depending on the 
strength of the measured value, you may hear different tones of beeping. 

b. With panning the antenna horizontally to vary the angle of the direction, repeat 
pressing the TRIGGER button to obtain at least five points if you want to do the 

localization.  

–  To obtain RSSI values continuously, complete the following steps: 

a. Press and hold the TRIGGER button located on the antenna handle to start a 

continuous measurement. 

b. Pan the antenna handle horizontally through the angle of 360 degrees you desire. 
A beep is sounded repeatedly to let you know that the measurement is continuing and 
measured values are plotted on the radar chart. See Figure 35 for an example. 

c. Release the TRIGGER button to stop the continuous measurement. 

 

NOTE 
The maximum number you can plot on the radar chart is 500 points both in the single 

and continuous measurements. If your measurement reached to 500 points, you need to 
reset the measurement by pressing the Localization soft key twice or performing the 
initialization of the AntennaAdvisor Handle. 
 
Concentric circles indicate different levels of RSSI. The outer circle, the higher power 
level is. You can use the AMP/SCALE hard to adjust the amplitude scale of the chart. 

5. To change the display mode, toggle the Screen Mode soft key and select Map or Full as 

needed. 

–  Map: It displays measured points inside the base map image. If you are in the area outside 

the base map and continue your measurement with the Trigger button, the instrument 

continue obtaining data even though the radar chart disappears from the screen. You can 

view obtained data when you change this display option to Full. 

–  Full: It displays measured points without the base map image. In case that you made 

measurements in the area outside the map image, selecting this option moves your 

measured data to the center of the display so that you can view the result. 

 

Localizing RSSI data 

The Localization feature lets you view averaged and smoothed measurement data with a bold green 

line on the radar chart that helps you determine the direction of the highest RSSI value. When you 

have five or more data points plotted on the radar chart, you can perform this localization. 

 

Procedure 

1. Press the Localization soft key in the Measure Setup menu bar. 

All the measured points turn to green color and you can view the bold green line that indicates 
the possible direction of the interference source. See Figure 36 for an example. 

2. To clear all the data plots on the radar chart, press the Localization soft key again. 
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Measurement example 

Figure 35 RSSI data plotted on the radar chart 

 

 

Figure 36 Localized RSSI data on the radar chart 

 

 

Loading and displaying raster data 

If you have a set of raster data files generated through the ariesoGEO application, you can load and 

overlay the data on your background map to help you view suspicious points of interference easily and 

pinpoint the source of the interference quickly. 

 

Procedure 

1. Copy a set of raster data files into your USB memory drive, including the following: 

–  ASCII: .tab, .asc, and .clr files 

–  BIL: .tab,.hdr, .bil, and .clr files 
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NOTE 
The .tab file type is a geospatial vector data format used in many geographic 

information systems. The color file (.clr) is an optional file, but the image will be 

displayed as a grayscale image without it. The size of the raster map must be  
1024 x 1024 or smaller. 

2. Plug in the USB memory drive to your instrument. 

3. Press the TRACE/DISPLAY hard key. 

4. Press the Load Raster Map soft key. 

The file explorer window appears. 

5. Navigate to the raster file (.tab) you want to open, and then press the Load soft key. 

The raster image appears on top of your base map. 

 

NOTE 

If the area of the loaded raster data is not within the boundary of the base map, you will 
not see the raster image on the screen. 

6. To select the display option, complete the following steps: 

a. Press the Display Options soft key. 

b. Select the option you desire from the choices: On, Off, and Blink. 

7. To adjust the transparency level of the image, complete the following steps: 

a. Press the Transparency soft key. 

b. Enter a value between 0 for opaque and 100 for clear. 

c. Press the Enter soft key. 

 

Setting limit for interference analyzer 

Procedure 

To use the display line: 

1. Press the LIMIT hot key. 

2. Press the Display Line soft key for a reference line. 

3. Enter a value, and then press the dBm unit soft key. 

4. Toggle the Display Line soft key between On and Off to display and dismiss the reference line. 

The straight line appears across the screen to be used as a visual reference only. 

 
To display the multiple segment line: 

1. Press the LIMIT hot key. 

2. Press the Multi Segment Line soft key for Pass/Fail indication. 

3. Toggle the Limit soft key between Upper and Lower to select the one to be displayed. 

4. Set the number of segments for the selected upper or lower limit line. You can set up to 50 
segments. 

a. Press the # of Line soft key. 

b. Enter a value between 1 and 50 by using the numeric keys. 

c. Press the Enter soft key. 

5. Press the Autoset soft key to let the instrument set the limit for each segment and display the 

line. 

6. Optional. To move the limit line, complete the following steps: 

a. Select Limit Up/Down or Limit Left/Right. 

b. Turn the rotary knob to move the line as desired. You can also manually enter a value. 

7. Optional. To edit the segment properties, complete the following steps: 
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a. Press the Edit Limit soft key. 

b. Press the Move soft key and then turn the rotary knob to select the segment to edit. 

c. Select the menu option, from the following choices: 

–  To hide the line for the selected segment, toggle the Line soft key and select Off. 

–  To add a new point, press the Add Point soft key. 

–  To delete the selected point, press the Delete Point soft key. 

–  To change the position, press the Frequency or Amplitude soft key, and then turn the 

rotary knob to change the value as desired. 
 
To define the channel limit: 

1. Press the LIMIT hot key. 

2. Press the Channel Limit soft key. 

3. To define the index table, complete the following steps: 

a. Toggle the Table soft key between On and Off to display and hide the channel index table 

on the screen. 

b. Press the Index soft key. 

c. Enter an index number to be set between 1 and 10 by using the numeric keys. 

d. Press the Enter soft key. 

e. Press the Start Frequency or Center Frequency soft key depending on your prior 

frequency setting. 

f. Enter a value by using the numeric keys. You can also use the rotary knob or the arrow 
keys. 

g. Select the unit: GHz, MHz, kHz, or Hz. 

h. Press the Stop Frequency or Span Width soft key depending on your prior frequency 

setting. 

i. Enter a value by using the numeric keys. You can also use the rotary knob or the arrow 
keys. 

j. Select the unit: GHz, MHz, kHz, or Hz. 

4. To set the limits for Pass/Fail indication, complete the following steps: 

a. Toggle the Limit soft key between On and Off to enable and disable the limit. 

b. Press the High Limit soft key. 

c. Enter a value by using the numeric keys. You can also use the rotary knob or the arrow 
keys. 

d. Press the dBm soft key. 

e. Press the Low Limit soft key. 

f. Enter a value by using the numeric keys. You can also use the rotary knob or the arrow 
keys. 

g. Press the dBm soft key. 

5. Optional. Go to SAVE/LOAD > Save, and then select Save Limit to save the limit settings. 

See “Using save” on page 33 for more information. 
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Using GSM/GPRS/EDGE Signal Analyzer 

This chapter provides instructions for using the GSM/GPRS/EDGE Signal Analyzer function (option 

022) with GSM//GPRS/EDGE OTA Analyzer function (option 042). Topics discussed in this chapter are 

as follows: 

 

 Introduction .............................................................................................................................. 127 

 Display overview ...................................................................................................................... 127 

 Connecting a cable .................................................................................................................. 128 

 Selecting measurement mode ................................................................................................. 130 

 Configuring test parameters .................................................................................................... 130 

 Conducting spectrum measurements ...................................................................................... 134 

 Conducting RF measurements ................................................................................................ 135 

 Conducting power vs. time measurements ............................................................................. 142 

 Conducting constellation measurements ................................................................................ 145 

 Performing auto measurements .............................................................................................. 147 

 Conducting GSM OTA measurements .................................................................................... 149 
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Introduction 

The Global System for Mobile Communications (GSM) is a digital cellular standard that uses Time 

Division Multiple Access (TDMA) multiplexing scheme and Gaussian Minimum Shift Keying (GMSK) 

modulation. The Enhanced Data Rates for GSM Evolution (EDGE) is an enhancement to GSM that 

promises to deliver multimedia and other broadband applications. It uses TDMA and 3π/8 8PSK 

(phase shift keying) modulation. 

 

This instrument performs measurements using the methods and limits as defined in the 3GPP TS 

51.021 Base Station System (BSS) equipment specification: Radio Aspects V8.9.0 (2003-06) and 

SGPP TS 45.005 Radio Transmission and Reception (version 12.5.0, release 12). The Pass/Fail 

indictor helps you to determine base station performance easily. 

 

This instrument provides the following measurement tools for GSM/GPRS/EDGE system: 

 

 Spectrum Analysis 

 RF Analysis 

- Channel Power 

- Occupied Bandwidth 

- Spectrum Emission Mask (SEM) 

- Output RF Spectrum 

- Spurious Emissions 

 Power vs. Time 

- Power vs. Time (Slot) 

- Power vs. Time (Frame) 

 Modulation Analysis 

- Constellation 

 Auto Measure 

 Over The Air (OTA) 

- Channel Scanner 

- Frequency Scanner 

- Multipath Profile 

- Modulation Analyzer 

 

Display overview 

Figure 37 provides descriptions for each segment of the measurement screen. 
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Figure 37 GSM signal analyzer measurement screen 

 

 

Connecting a cable 

Direct connection 

Procedure 

1. Connect the Spectrum Analyzer RF In port of the JD780A series and the power amplifier output 

port of BTS. 

 

Figure 38 Direct connection 

 
JD785A/JD786A 

 
JD788A 

 

Indirect connection 

Procedure 

1. Connect the Spectrum Analyzer RF In port of the JD780A series and the monitor (test) port of 

BTS. 
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Figure 39 Indirect connection 

 
JD785A/JD786A 

 
JD788A 

 

 

CAUTION 
The maximum power for the Spectrum Analyzer RF In port is +25 dBm (0.316 W). If the 
input signal level to be measured is greater than +25 dBm, use a High Power 
Attenuator to prevent damage when you directly connect the signal to the instrument or 
connect the signal from the coupling port of a directional coupler. 

 

Over the air (OTA) 

Procedure 

1. Connect an Omni/directional RF antenna to the Spectrum Analyzer RF In port of the JD780A 

series. 

2. Connect a GPS antenna to the GPS port of the JD780A series. 

 

Figure 40 OTA connection 

 
JD785A/JD786A 

 
JD788A 

 

 

CAUTION 

If the input signal level to be measured is less than 0 dBm, set 0 dB attenuation or turn on 
the preamp to have better dynamic range for the OTA testing. 
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Selecting measurement mode 

Procedure 

1. Press the MODE hard key. 

2. Press the Signal Analyzer soft key. 

3. Press the GSM soft key. The Spectrum mode is set by default. 

4. Press the MEASURE hot key, and then select the measurement mode option from the following 
choices: 

–  Spectrum 

–  RF Analysis > Channel Power, Occupied BW, Spectrum Emission Mask,  
Output RF Spectrum, or Spurious Emissions 

–  Power vs Time > Power vs Time (Slot) or Power vs Time (Frame) 

–  Constellation 

–  Auto Measure 

–  OTA > Channel Scanner, Frequency Scanner, Multipath Profile, or 
Modulation Analyzer 

 

Configuring test parameters 

Setting frequency 

You can set the frequency with either frequency or channel number. If a frequency to be set matches 

to the frequency corresponding to the selected channel standard, the instrument calculates its channel 

number and updates the screen with it automatically. 

 

Procedure 

To set the center frequency: 

1. Press the FREQ/DIST hard key. 

2. Toggle the Unit soft key and select Freq. 

3. Press the Center Frequency soft key. 

4. Enter a value by using the numeric keys. You can also use the rotary knob. 

5. Select the unit: GHz, MHz, kHz, or Hz. 

6. Optional. To define the amount of frequency increment for the rotary knob, complete the following 
steps: 

a. Press the Frequency Step soft key. 

b. Enter a value by using the numeric keys. You can also use the rotary knob. 

c. Press the unit: GHz, MHz, kHz, or Hz. 
 
To set the channel number: 

1. Press the FREQ/DIST hard key. 

2. Toggle the Unit soft key and select Channel. 

3. To select the standard channel, complete the following steps: 

a. Press the Channel Std soft key. The standard channel window appears. 

See “Appendix C – Band, frequency & channel standard” on page 588 for more information. 
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b. Select the band to be measured by using the rotary knob, the arrow keys, or the Page 
Up/Page Down soft keys. 

c. Press the Select soft key or the rotary knob to confirm the selection. 

4. Press the Channel Number soft key. 

5. Enter a value by using the numeric keys. You can also use the rotary knob. 

6. Press the Enter soft key. 

The instrument automatically displays the corresponding center frequency value for the selected 
channel number. 

7. Optional. To define the amount of channel increment for the rotary knob, complete the following 
steps: 

a. Press the Channel Step soft key. 

b. Enter a value by using the numeric keys. You can also use the rotary knob. 

c. Press the Enter soft key. 

 

 

NOTE 

This frequency setting is not used in the Spurious Emissions mode. 

 

Setting amplitude 

Reference level and attenuation 

You can set the reference and attenuation levels automatically or manually to optimize the display of 

the traces measured, as you desire. 

 

Procedure 

To automatically set the reference and attenuation level: 

1. Press the AMP/SCALE hard key. 

2. Press the Auto Scale soft key. 

Each time you press this key, both of the Y-axis scale and input attenuation level change to be 
optimized with some margin. 

 
To set the reference or attenuation level manually: 

1. Press the AMP/SCALE hard key. 

2. To set the maximum reference value on the Y-axis manually, complete the following steps: 

a. Press the Reference Level soft key. 

b. Enter a value by using the numeric keys or the rotary knob with 10 dB increments. 

c. Press the unit soft key or the ENTER hard key. 

3. To set the attenuation option, select one from the following choices: 

–  To set the input attenuator’s level automatically, select Attenuation > Auto. 

 

NOTE 
It is recommended that you set the Attenuation to Auto in most situations so that the 

level of the input attenuator can be set automatically according to your input signal level. 

–  To set the input attenuation manually up to 55 dB to optimize S/N, complete the following 
steps: 

a. Select Attenuation > Manual. 

b. Press the Attenuation Value soft key to set the level. 

c. Enter a value between 0 and 55 in fives by using the numeric keys. 
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d. Press the dB soft key or the ENTER hard key. 

–  To couple the input attenuator’s level with your reference level setting, select Attenuation > 
Couple. 

As you increase the reference setting, the attenuation level also increases acoordingly. 
 
Optional. To change the scale unit: 

1. Select More (1/2) > Units. 

2. Select the unit of the display scale: dBm, dBV, dBmV, dBµV, V, or W. 

The scale unit on the screen changes accordingly. 
 

 

NOTE 

This Units menu is available in the Spectrum and RF Analysis modes. 
 

 

Scale per division 

You can use the Scale/Div feature available for the spectrum and RF analysis. It represents the value 

of one division on the horizontal scale. The default setting is 10 dB per division and the maximum 

value can be set up to 20 dB. 

 

Procedure 

1. Press the AMP/SCALE hard key. 

2. Select More (1/2) > Scale/Div. 

3. Enter a value between 1 and 20 by using the numeric keys. 

4. Press the dB soft key to complete the entry. 

 

Pre-amplifier 

You can turn the internal pre-amplifier on to correct and compensate for the gain of the preamp so that 

amplitude readings show the value at the input connector. 

 

Procedure 

1. Press the AMP/SCALE hard key. 

2. Toggle the Preamp soft key and select On or Off as needed. 

 

 

NOTE 

You can turn the Preamp on when the input attenuation range is from 0 dB to 10 dB. If 
the attenuation value is manually set to greater than 10 dB, the instrument will 
automatically turn off the pre-amplifier to display low-level signal properly on the chart. 

 

External offset 

You can turn the External Offset on and manually set the external offset value. An offset consists of a 

cable loss and a user offset and the measurement result shows the value reflecting both offset values. 

When the external offset value is set at 40 dB in the Spectrum mode, the measurement result 

compensates 40 dB at both the Spectrum Analyzer and Signal Analyzer modes. 

 

Procedure 

To set the external offset: 
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1. Press the AMP/SCALE hard key. 

2. Toggle the External Offset soft key and select On. 

3. Enter a value by using the numeric keys. 

4. Press the dB soft key to complete the entry. 

 
To turn the external offset off: 

1. Press the AMP/SCALE hard key. 

2. Toggle the External Offset soft key and select Off. 

 

Setting average 

You can set the number of measurements to be averaged for the trace presentation. A maximum of 

100 times of averaging can be set. When the averaging reaches to your setting, a new measurement 

value replaces the measurement value in sequence from the earliest. 

 

Procedure 

1. Press the BW/AVG hard key. 

2. Press the Average soft key. 

3. Enter a value between 1 and 100 as needed by using the numeric keys. 

4. Press the Enter soft key. 

 

Setting sweep mode 

The default setting is Continue to sweep continuously for most on-going measurements. If you want to 

hold the measurement or get a single sweep, you can change the sweep mode. 

 

Procedure 

To select the single sweep mode: 

1. Press the SWEEP hot key. 

2. Toggle the Sweep Mode soft key and select Single. You can also use the HOLD hot key. 

The letter HOLD in red appears and the sweeping is paused. 

3. Optional. Press the Sweep Once soft key to get a new measurement. 
 
To return to the continuous sweep mode: 

1. Toggle the Sweep Mode soft key and select Continue. You can also use the HOLD hot key. 

The letter HOLD in red disappears and the sweeping resumes. 

 

Setting trigger source 

You can set the trigger source option for your measurements. 

Procedure 

1. Press the TRIGGER hot key. 

2. Select the trigger source option from the following choices: 
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To set the trigger level Select 

When using the RF burst (wideband) trigger RF Burst 

To free burst if there is a frequency burst signal Internal FB 

To training sequence code RF Burst & TS 

To external trigger reference External 

To the free trigger Free 

To the locked GPS GPS 
 

 

Conducting spectrum measurements 

If you have configured test parameters as described in the “Configuring test parameters” on page 130, 

your measurement result is displayed on the screen as like the following example, Figure 41. 

 

Figure 41 Spectrum measurement screen with GSM signal analyzer 

 

 

Setting measure setup 

Procedure 

1. Press the MEASURE SETUP hot key. 

2. Press the Time Slot soft key, and then select your desired time slot number from 0 to 7. 

3. Optional. To set the delay, complete the following steps: 

a. Press the Miscellaneous soft key. 

b. Press the Delay soft key to set the amount of delay in µs. 

c. Enter a value by using the numeric keys. You can also use the rotary knob. 

d. Press the µs soft key. 
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NOTE 

The Delay setting is used only when there is a time offset in the signals to be measured. 

 

Setting trace 

You can display up to six traces on the measurement chart simultaneously. 

 

Procedure 

1. Press the TRACE/DISPLAY hard key. 

2. Press the Select Trace soft key, and then select the trace number: T1, T2, T3, T4, T5, or T6. 

The legend shape of the selected trace changes from square to round to indicate that the trace is 
the active one now. 

3. Do one of the following: 
 

To Select Trace Legend 

Clear current data and display with new 
measurements 

Clear Write W 

Display the input signal’s maximum response only 
(unlimited or for a certain amount of time) 

Max Hold M 

Display the input signal’s minimum response only 
(unlimited or for a certain amount of time) 

Min Hold m 

Capture the selected trace and compare traces Capture C 

Load a saved trace More (1/2) > Load L 

Hide the selected trace Trace View > Off F 

Remove all the traces and initialize the trace 
settings 

More (1/2) > Trace 
Clear All 

 

 

 

NOTE 
For the Max Hold and Min Hold, your instrument compares newly acquired data with the 

active trace and displays larger maximum values or smaller minimum values on the 
screen. You can set it to Unlimited to hold and view maximum or minimum data or 

specify a certain amount of time up to 60 seconds by using numeric keys or rotary knob. 

4. Optional. Press the More (1/2) > Trace Info soft key, and then select the trace number to view 
the trace’s parameter setting information stored at the time of the measurement or None to hide 

the information display. 

5. Optional. If you have the two traces T1 and T2, you can perform trace math. To view the power 
difference between the traces, press the T1 – T2 -> T5 or T2 – T1 -> T6 soft key. 

The result is overlaid on the screen along with the second Y-axis. 

 

Conducting RF measurements 

Channel power 

The Channel Power measures in-channel power for GSM/GPRS and EDGE systems, which use 

dynamic power control to ensure that each link is maintained with minimum power. It gives two 

fundamental benefits of keeping overall system interference to a minimum level and of maximizing 

battery life in the case of mobile stations. It determines the power delivered to the antenna system on 

the RF channel under test. The instrument acquires a GSM/GPRS or EDGE signal in the time domain. 

The average power level above the threshold is then computed and displayed. 
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Setting measure setup 

After configuring test parameters as described in the “Configuring test parameters” on page 130, you 

can continue your measurement. 

 

Procedure 

1. Press the MEASURE SETUP hot key. 

2. Press the Time Slot soft key to assign a time slot with which performs measurements, and then 
select your desired time slot number from 0 to 7. 

3. Optional. To set the delay, complete the following steps: 

a. Press the Miscellaneous soft key. 

b. Press the Delay soft key to set the amount of delay in µs. 

c. Enter a value by using the numeric keys. You can also use the rotary knob. 

d. Press the µs soft key. 

 

 

NOTE 

The Delay setting is used only when there is a time offset in the signals to be measured. 

 

Measurement example 

Figure 42 Channel power measurement with GSM signal analyzer 

 

 

Channel power measurement result shows channel power and spectrum density in a user specified 

channel bandwidth. The peak to average ratio (PAR) is shown at the bottom of the screen as well. The 

shaded area on the display indicates the channel bandwidth. 

 

 

NOTE 
You can use the LIMIT hot key to analyze your measurements with the user-definable 
limit and Pass/Fail indication. See “Setting limit for RF tests” on page 141 for more 
information. 

 

Occupied bandwidth 

The Occupied Bandwidth measures the spectrum shape of the carrier. It is defined as the bandwidth, 
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which includes 99% of the transmitted power among total transmitted power. 

 

Setting measure setup 

After configuring test parameters as described in the “Configuring test parameters” on page 130, you 

can continue your measurement. 
 

Procedure 

1. Press the MEASURE SETUP hot key. 

2. Press the Time Slot soft key to assign a time slot with which performs measurements, and then 
select your desired time slot number from 0 to 7. 

3. Optional. To set the delay, complete the following steps: 

a. Press the Miscellaneous soft key. 

b. Press the Delay soft key to set the amount of delay in µs. 

c. Enter a value by using the numeric keys. You can also use the rotary knob. 

d. Press the µs soft key. 

 

 

NOTE 

The Delay setting is used only when there is a time offset in the signals to be measured. 

 

Measurement example 

The Occupied Bandwidth measurement shows both of power across the band and power bandwidth in 

a user specified percentage to determine the amount of spectrum used by a modulated signal. 

Occupied bandwidth is typically calculated as the bandwidth containing 99% of the transmitted power. 

 

Figure 43 Occupied bandwidth measurement with GSM signal analyzer 

 

 

 

NOTE 
You can use the LIMIT hot key to analyze your measurements with the user-definable 
limit and Pass/Fail indication. See “Setting limit for RF tests” on page 141 for more 
information. 
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Spectrum emission mask (SEM) 

The Spectrum Emission Mask (SEM) measurement is to identify and determine the power level of out-

of-band spurious emission outside the necessary channel bandwidth and modulated signal. It 

measures the power ratio between in-band and adjacent channels. The JD780A series indicates either 

Pass or Fail based on the specified limit of the signal. 

 

Setting measure setup 

After configuring test parameters as described in the “Configuring test parameters” on page 130, you 

can continue your measurement. 

 

Procedure 

1. Press the MEASURE SETUP hot key. 

2. Press the Time Slot soft key to assign a time slot with which performs measurements, and then 
select your desired time slot number from 0 to 7. 

3. Optional. To set the delay, complete the following steps: 

a. Press the Miscellaneous soft key. 

b. Press the Delay soft key to set the amount of delay in µs. 

c. Enter a value by using the numeric keys. You can also use the rotary knob. 

d. Press the µs soft key. 

 

 

NOTE 

The Delay setting is used only when there is a time offset in the signals to be measured. 

 

Measurement example 

Figure 44 SEM measurement with GSM signal analyzer 

 

 

 

NOTE 
You can use the LIMIT hot key to analyze your measurements with the user-definable 

limit and Pass/Fail indication. See “Setting limit for RF tests” on page 141 for more 
information. 
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Outpur RF spectrum 

The Output RF Spectrum measures power of the output RF modulation spectrum of the carrier at 

different frequency offsets from the carrier in different measurement bandwidths. It is used to 

determine if the output spectrum due to modulation and wideband noise for all supported RF channels 

meets the requirements as specified in 3GPP TS 45.005 and conforms to the specification. 

 

Setting measure setup 

After configuring test parameters as described in the “Configuring test parameters” on page 130, you 

can continue your measurement. 
 

Procedure 

1. Press the MEASURE SETUP hot key. 

2. Press the Time Slot soft key to assign a time slot with which performs measurements, and then 
select your desired time slot number from 0 to 7. 

3. Optional. To set the delay, complete the following steps: 

a. Press the Miscellaneous soft key. 

b. Press the Delay soft key to set the amount of delay in µs. 

c. Enter a value by using the numeric keys. You can also use the rotary knob. 

d. Press the µs soft key. 

 

 

NOTE 

The Delay setting is used only when there is a time offset in the signals to be measured. 

 

Measurement example 

Figure 45 Output RF spectrum measurement with GSM signal analyzer 

 

 

 

NOTE 

A set of limit values are applied according to the current channel power and automatically 
displayed in the result table. You can use the LIMIT hot key to enable or disable the 
Pass/Fail indication. See “Setting limit for RF tests” on page 141 for more information. 
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Spurious emissions 

Out-of-band emissions are unwanted emissions immediately outside the channel bandwidth resulting 

from the modulation process and non-linearity in the transmitter but excluding spurious emissions. The 

Spurious Emissions measurement is to identify and determine the power level of out-of-band spurious 

emission within the necessary channel bandwidth and modulated signal measured at the RF port of 

the Base Station. 

 

Setting measure setup 

After configuring test parameters as described in the “Configuring test parameters” on page 130, you 

can continue your measurement. 

 

Procedure 

1. Press the MEASURE SETUP hot key. 

2. To set up the range table and parameters, press the Range Table soft key and then complete 

the following steps: 

a. Press the Range soft key, and then select the range number between 1 and 20 to add  

as a new or change the existing settings. 

b. Do the following as desired: 

–  Select Start Frequency, and then specify the start frequency for the selected range. 

–  Select Stop Frequency, and then specify the stop frequency for the selected range. 

–  Select Start Limit, and then specify the lower limit for Pass/Fail indication. 

–  Select Stop Limit, and then specify the upper limit for Pass/Fail indication. 

–  Select More (1/2) > Attenuation, and then specify an value in the multiple of five. 

–  Select More (1/2) > RBW, and then specify a RBW value. 

–  Select More (1/2) > VBW, and then specify a VBW value. 

c. Press the PREV hard key. 

d. Toggle the Range soft key and select On to display the selected range in the result table or 
Off to hide it from the table. 

3. Toggle the Measure Type soft key between Examine and Full to select the measurement type. 

 

NOTE 
The Examine mode displays only the selected range while the Full mode lets the 

instrument automatically changes the selected range from one another. 

4. To set the number of measurements to be averaged, complete the following steps: 

a. Press the Average soft key. 

b. Enter a value between 1 and 100. 

c. Press the Enter soft key. 

5. To move the highlighted bar in the result table to other range, complete the following steps: 

a. Press the Range soft key in the Measure Setup menu bar. 

b. Enter a value between 1 and 20. 

c. Press the Enter soft key. 
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Measurement example 

Figure 46 Spurious emissions measurement with GSM signal analyzer 

 

 

 

NOTE 
You can use the LIMIT hot key to analyze your measurements with the user-definable 
limit and Pass/Fail indication. See “Setting limit for RF tests” on page 141 for more 
information. 

 

Setting limit for RF tests 

By default, test limits specified in the standard are set for you. You can change thresholds if you desire. 

 

Procedure 

1. Press the LIMIT hot key. 

2. Press the RF Test Limits soft key. 

3. Select the test item(s) and set the limit(s) depending on your selected measurement mode: 
 

To set the limit for Select Set 

Channel power Channel Power High Limit, Low Limit 

Occupied bandwidth Occupied BW High Limit 

Spectrum emission mask Spectrum Emission Mask (On/Off only) 

Output RF spectrum Output RF Spectrum (On/Off only) 

Spurious emissions Spurious Emissions (On/Off only) 

4. Optional. You can enable alarm sound that goes off if the measurement falls outside of the limit. 
Toggle the Beep soft key between On and Off to enable or disable the beep sound. 

5. Optional. Go to SAVE/LOAD > Save, and then select Save Limit to save the limit settings. 

See “Using save” on page 33 for more information. 
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Conducting power vs. time measurements 

The Power vs. Time measurement measures the mean transmission power during the useful part of 

GSM bursts and verifies that the power ramp fits within the defined mask. It also lets you view the rise, 

fall, and useful part of the GSM burst. 

 

This measurement provides masks for both of Base Transceiver Station (BTS) and Mobile Station 

(MS). The timing masks are referenced to the transition from the bit 13 to the bit 14 of the mid-amble 

training sequence. For GMSK measurements, the 0 dB reference is determined by measuring the 

mean transmitted power during the useful part of the burst. 

 

Power vs. time (slot) 

Setting measure setup 

After configuring test parameters as described in the “Configuring test parameters” on page 130, you 

can continue your measurement. The measurement settings can be saved and recalled as a file. 

 

Procedure 

1. Press the MEASURE SETUP hot key. 

2. Press the Time Slot soft key to assign a time slot with which performs measurements, and then 
select your desired time slot number from 0 to 7. 

3. Press the Detect Mode soft key, and then select the signal standard option: Auto, GSM, or 
EDGE. Auto is set by default. The instrument applies a mask automatically based on the selected 

mode. 

4. Optional. To set the delay, complete the following steps: 

a. Press the Miscellaneous soft key. 

b. Press the Delay soft key to set the amount of delay in µs. 

c. Enter a value by using the numeric keys. You can also use the rotary knob. 

d. Press the µs soft key. 

 

 

NOTE 

The Delay setting is used only when there is a time offset in the signals to be measured. 

 

Setting limit for burst power 

Procedure 

1. Press the LIMIT hot key. 

2. Press the PvsT Test Limits soft key. 

3. Press the Burst Power soft key to set the limit in the Power vs. Time (Slot) measurement. 

4. Toggle the Test Limits soft key between On and Off to enable or disable the Pass/Fail 

indication. 

5. Set the upper threshold: 

a. Press the High Limit soft key. 

b. Enter a value for the upper limit, and then press the dBm unit soft key. 

6. Set the lower threshold: 

a. Press the Low Limit soft key. 
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b. Enter a value for the lower limit, and then press the dBm unit soft key. 

7. Optional. You can enable alarm sound that goes off if the measurement falls outside of the limit. 
Toggle the Beep soft key between On and Off to enable or disable the beep sound. 

8. Optional. Go to SAVE/LOAD > Save, and then select Save Limit to save the limit settings. 

See “Using save” on page 33 for more information. 

 

Measurement example 

Figure 47 Power vs. time (slot) measurement with GSM/EDGE signal analyzer 

 

 

 

 

Power vs. time (frame) 

Setting measure setup  

After configuring test parameters as described in the “Configuring test parameters” on page 130, you 

can continue your measurement. The measurement settings can be saved and recalled as a file. 
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Procedure 

1. Press the MEASURE SETUP hot key. 

2. Press the Detect Mode soft key, and then select the signal standard option: Auto, GSM, or 
EDGE. Auto is set by default. The instrument applies a mask automatically based on the selected 

mode. 

3. Optional. To set the delay, complete the following steps: 

a. Press the Miscellaneous soft key. 

b. Press the Delay soft key to set the amount of delay in µs. 

c. Enter a value by using the numeric keys. You can also use the rotary knob. 

d. Press the µs soft key. 

 

 

NOTE 

The Delay setting is used only when there is a time offset in the signals to be measured. 

 

Setting limit for frame average power 

Procedure 

1. Press the LIMIT hot key. 

2. Press the PvsT Test Limits soft key. 

3. Press the Frame Avg Power soft key to set the limit in the Power vs. Time (Frame) 

measurement. 

4. Toggle the Test Limits soft key between On and Off to enable or disable the Pass/Fail 

indication. 

5. Set the upper threshold: 

a. Press the High Limit soft key. 

b. Enter a value for the upper limit. 

c. Press the dBm unit soft key. 

6. Set the lower threshold: 

a. Press the Low Limit soft key. 

b. Enter a value for the lower limit. 

c. Press the dBm unit soft key. 

7. Optional. You can enable alarm sound that goes off if the measurement falls outside of the limit. 
Toggle the Beep soft key between On and Off to enable or disable the beep sound. 

8. Optional. Go to SAVE/LOAD > Save, and then select Save Limit to save the limit settings. 

See “Using save” on page 33 for more information. 
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Measurement example 

Figure 48 Power vs. time (frame) measurement with GSM signal analyzer 

 

 

Conducting constellation measurements 

The Constellation is used to observe some aspects of modulation accuracy and can reveal certain 

fault mechanisms such as I/Q amplitude imbalance or quadrature imbalance. It displays constellation 

diagram by modulation types. 

 

Setting measure setup 

After configuring test parameters as described in the “Configuring test parameters” on page 130, you 

can continue your measurement. The measurement settings can be saved and recalled as a file. 

 

Procedure 

1. Press the MEASURE SETUP hot key. 

2. Press the Time Slot soft key to assign a time slot with which performs measurements, and then 
select your desired time slot number from 0 to 7. 

3. Press the Detect Mode soft key, and then select the signal standard option: Auto, GSM, or 
EDGE. Auto is set by default. The instrument applies a mask automatically based on the selected 

mode. 

4. Toggle the PSK Constellation soft key between On and Off to enable or disable the PSK 

constellation observation. 
 

 

NOTE 

The PSK constellation must be turned on to analyze EDGE signals. 

5. Optional. To set the delay, complete the following steps: 

a. Press the Miscellaneous soft key. 

b. Press the Delay soft key to set the amount of delay in µs. 

c. Enter a value by using the numeric keys. You can also use the rotary knob. 

d. Press the µs soft key. 
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NOTE 

The Delay setting is used only when there is a time offset in the signals to be measured. 

 

Setting limit for constellation 

Procedure 

1. Press the LIMIT hot key. 

2. Press the Modulation Test Limits soft key to set the limits in the Constellation measurement. 

3. Select the test item(s) and set the limit(s) depending on your selected measurement mode: 
 

To set the limit for Select Set 

Frequency error Frequency Error High Limit, Low Limit 

Phase error rms Phase Error RMS High Limit, Low Limit 

Phase error peak Phase Error Peak High Limit, Low Limit 

Error vector magnitude rms EVM RMS High Limit 

Error vector magnitude peak EVM Peak High Limit 

I/Q origin offset of the I and Q error 
(magnitude squared) offset from the origin 

IQ Origin Offset High Limit 

Carrier to interference (C/I) ratio C/I Low Limit 

4. Optional. You can enable alarm sound that goes off if the measurement falls outside of the limit. 
Toggle the Beep soft key between On and Off to enable or disable the beep sound. 

5. Optional. Go to SAVE/LOAD > Save, and then select Save Limit to save the limit settings. 

See “Using save” on page 33 for more information. 

 

Measurement example 

Figure 49 Constellation measurement with GSM signal analyzer 
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NOTE 

Measurement items such as IQ Origin Offset, C/I, EVM RMS/Peak and EVM 95
th
 

are applicable only to EDGE signal measurements. 

 

Performing auto measurements 

The Auto Measure function of the JD780A series allows a complete signal profiling covering RF 

characterization and modulation quality parameters of up to 10 different carriers, particularly useful on 

an overlay architecture where base stations are transmitting in different frequencies. 

 

The Auto Measure can be easily executed either by selecting a menu in the instrument or by running a 

programmed scenario in the PC-based application so that the instrument automatically configure and 

perform tests on every aspect of all the carriers. 

 

Setting limit for auto measure 

You can set test limits for test item(s) in the auto measurement. 

Procedure 

1. Press the LIMIT hot key. 

2. Press the RF Test Limits soft key, and then enable test limits as desired. 

3. Press the PvsT Test Limits soft key, and then enable test limits as desired. 

4. Press the Modulation Test Limits soft key, and then enable test limits as desired. 

5. Optional. You can enable alarm sound that goes off if the measurement falls outside of the limit. 
Toggle the Beep soft key between On and Off to enable or disable the beep sound. 

6. Optional. Go to SAVE/LOAD > Save, and then select Save Limit to save the limit settings. 

See “Using save” on page 33 for more information. 

 

Setting measure setup 

After configuring test parameters as described in the “Configuring test parameters” on page 130, you 
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can continue your measurement. The measurement settings can be saved and recalled as a file. You 

can also use JDViewer, PC application software to configure a measure setup, save as a file, and load 

the file on to the instrument. 

 

Procedure 

1. Press the MEASURE SETUP hot key. 

2. Toggle the Configuration soft key and select the configuration option: 

–  Current: to let the instrumnet use current frequency (single carrier) and determine pass or 

fail based on the instrument’s limit settings in Auto Measure. 

–  Scenario: to run a test with a programmed scenario in JDViewer. 

The Scenario menu becomes activated. 

3. To load a scenario, press the Scenario soft key, and then select a scenario file to load. 

4. Toggle the Test Time soft key and select the test time option: 

–  Now: to let the instrument run a test only once. 

–  Schedule: to let the instrument repeat tests as defined in the Set Timing. 

The Set Timing menu becomes activated. 

5. To define a schedule for an auto measurement, complete the following steps: 

a. Press the Set Timing soft key. 

b. Press the Start Time (HH:MM) soft key. 

c. Enter the time in the HH:MM format, and then press the Enter soft key. 

d. Press the Stop Time (HH:MM) soft key. 

e. Enter the time in the HH:MM format, and then press the Enter soft key. 

f. Press the Time Interval soft key. 

g. Enter the amount of time in minutes, and then press the Enter soft key. 

7. To select the type of the measurement data to be taken for the determination of the results,  
press the Data Type soft key and then select the data type option fro the following choices: 

–  Sample: The Auto Measure takes the last measurement data only. 

–  RMS: The Auto Measure takes data from all 20 measurements and averages them. 

–  Peak: The Auto Measure takes only the highest peak of all 20 measurements. 

–  Negative Peak: The Auto Measure takes only the lowest peak of all 20 measurements. 

6. To set external offset, complete the following steps: 

a. Toggle the External Offset soft key and select On. 

b. Enter a value by using the numeric keys, and then press the dB soft key. 

8. To save your settings and results, go to SAVE/LOAD > Save and then perform functions as you 

desire. See “Using save” on page 33 for more information. 

9. Press the Run Test soft key to start to run a test. 

The Auto Measure Results window appears at the end of the test. 

10. To stop running the test, press the Abort soft key. 

11. To change the view on the screen during the test, press the Display and then select the view 

option from the following choices: 

–  Screen: You can view each measurement screen as the test progresses. 

–  Results: You can view a measurement result table as the test progresses. 

–  Settings: You can view a measurement setting table as the test progresses. 
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Setting display 

After completion of the auto measurement, the screen menu changes to Trace/Display so that you can 

view the results in different forms. 

 

Procedure 

1. Toggle the Display soft key and select the display option: 

–  Result: to view the result table. The Display Result menu becomes activated. 

–  Settings: to view the measurement settings for the auto measurement. 

2. Toggle the Display Result soft key and select the display result option: 

–  Full: to view detailed measurement readings with the pass/fail indication. 

–  Quick: to view only the Pass/Fail results. 

3. To view the measurement results for a different carrier, press the View Carrier soft key and then 

select the carrier number to view. 

 

Conducting GSM OTA measurements 

This Over-The-Air (OTA) measurement has channel scanner, frequency scanner, multipath profile, and 

modulation analyzer screens. The GSM OTA has a function to display channel power and related 

information up to 128 GSM down link signals. This channel scanner can quickly identifies improper 

power levels that affect network performance. The transmitter performance can be made on a base 

station from the convenience of your vehicle without taking the base station out of service. It helps you 

to determine testing area's RF environmental condition with the multipath profile. 

 

Channel scanner 

Setting channel 

Procedure 

1. Press the FREQ/DIST hard key. 

2. To select the standard channel, complete the following steps: 

a. Press the Channel Std soft key. The standard channel window appears. 

See “Appendix C – Band, frequency & channel standard” on page 588 for more information. 

b. Select the band to be measured by using the rotary knob, the arrow keys, or the Page 
Up/Page Down soft keys. 

c. Press the Select soft key or the rotary knob to confirm the selection. 

3. To set the starting channel to be scanned, complete the following steps: 

a. Press the Channel Number soft key. 

b. Enter a value by using the numeric keys. You can also use the rotary knob. 

c. Press the Enter soft key. 

4. To set the amount of channel increment in scanning channels, complete the following steps: 

a. Press the Channel Step soft key. 

b. Enter a value by suing the numeric keys. You can also use the rotary knob. 

c. Press the Enter soft key. 

5. To set the number of channels to be displayed, complete the following steps: 
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a. Press the # of Channels soft key. 

b. Enter a value by using the numeric keys. You can also use the rotary knob. 

c. Press the Enter soft key. 

 

Setting zoom position 

You can set the starting channel for the Zoom In Window. 

 

Procedure 

1. Press the TRACE/DISPLAY hard key. 

2. Press the Zoom Position soft key. 

3. Enter a value by using the numeric keys. You can also use the rotary knob. 

4. Press the Enter soft key. 

 

Setting limit for OTA channel scanner 

Procedure 

1. Press the LIMIT hot key. 

1. Press the Limit Line soft key to set a threshold for the limit line and Pass/Fail indication. 

2. Enter a value, and then press the dBm unit soft key. 

3. Toggle the Limit Line soft key between On and Off to display or dismiss the limit line. 

4. Optional. You can enable alarm sound that goes off if the measurement falls outside of the limit. 
Toggle the Beep soft key between On and Off to enable or disable the beep sound. 

5. Optional. Go to SAVE/LOAD > Save, and then select the save option from the choices available 

for your measurement mode. See “Using save” on page 33 for more information. 
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Measurement example 

Figure 50 Channel scanner measurement with GSM OTA signal analyzer 

 

 

Frequency scanner 

Setting frequency 

Procedure 

1. Press the FREQ/DIST hard key. 

2. To set the starting frequency to be scanned, complete the following steps: 

a. Press the Start Frequency soft key. 

b. Enter a value by using the numeric keys. You can also use the rotary knob. 

c. Select the unit: GHz, MHz, kHz, or Hz. 

3. To set the amount of frequency increment in scanning frequencies, complete the following steps: 

a. Press the Frequency Step soft key. 

b. Enter a value by suing the numeric keys. You can also use the rotary knob. 

c. Select the unit: GHz, MHz, kHz, or Hz. 

4. To set the number of frequencies to be displayed, complete the following steps: 

a. Press the # of Frequencies soft key. 

b. Enter a value by using the numeric keys. You can also use the rotary knob. 

c. Press the Enter soft key. 

 

Setting zoom position 

You can set the starting channel for the Zoom Window. 

 

Procedure 

1. Press the TRACE/DISPLAY hard key. 

2. Press the Zoom Position soft key. 
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3. Enter a value by using the numeric keys. You can also use the rotary knob. 

4. Press the Enter soft key. 

 

Setting limit for OTA frequency scanner 

Procedure 

1. Press the LIMIT hot key. 

2. Press the Limit Line soft key to set a threshold for the limit line and Pass/Fail indication. 

3. Enter a value, and then press the dBm unit soft key. 

4. Toggle the Limit Line soft key between On and Off to display or dismiss the limit line. 

5. Optional. You can enable alarm sound that goes off if the measurement falls outside of the limit. 
Toggle the Beep soft key between On and Off to enable or disable the beep sound. 

6. Optional. Go to SAVE/LOAD > Save, and then select Save Limit to save the limit settings. 

See “Using save” on page 33 for more information. 

 

Measurement example 

Figure 51 Frequency scanner measurement with GSM OTA signal analyzer 

 

 

Multipath profile 

The Multipath Profile let you determine RF environmental conditions of testing area. The multipath 

profile is the result of portions of the original broadcast signal arriving at the receiving antenna out of 

phase. This can be caused by the signal being reflected off objects such as buildings, or being 

refracted through the atmosphere differently from the main signal. 

 

Setting measure setup 

After configuring test parameters as described in the “Configuring test parameters” on page 130, you 

can continue your measurement. The measurement settings can be saved and recalled as a file. 
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Procedure 

1. Press the MEASURE SETUP hot key. 

2. Press the Detect Mode soft key, and then select the signal standard option: Auto, GSM, or 
EDGE. Auto is set by default. The instrument applies a mask automatically based on the selected 

mode. 

3. Optional. To set the delay, complete the following steps: 

a. Press the Miscellaneous soft key. 

b. Press the Delay soft key to set the amount of delay in µs. 

c. Enter a value by using the numeric keys. You can also use the rotary knob. 

d. Press the µs soft key. 

4. Optional. Go to SAVE/LOAD > Save, and then select the save option from the choices available 

for your measurement mode. See “Using save” on page 33 for more information. 

 

 

NOTE 

The Delay setting is used only when there is a time offset in the signals to be measured. 

 

Measurement example 

Figure 52 Multipath profile measurement with GSM OTA signal analyzer 

 

 

Modulation analyzer 

Setting measure setup 

After configuring test parameters as described in the “Configuring test parameters” on page 130, you 

can continue your measurement. The measurement settings can be saved and recalled as a file. 

 

Procedure 

1. Press the MEASURE SETUP hot key. 

2. Press the Detect Mode soft key, and then select the signal standard option: Auto, GSM, or 
EDGE. Auto is set by default. The instrument applies a mask automatically based on the selected 

mode. 
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3. Optional. To set the delay, complete the following steps: 

a. Press the Miscellaneous soft key. 

b. Press the Delay soft key to set the amount of delay in µs. 

c. Enter a value by using the numeric keys. You can also use the rotary knob. 

d. Press the µs soft key. 

4. Optional. Go to SAVE/LOAD > Save, and then select the save option from the choices available 

for your measurement mode. See “Using save” on page 33 for more information. 

 

 

NOTE 

The Delay setting is used only when there is a time offset in the signals to be measured. 

 

Setting limit for modulation analyzer 

Procedure 

1. Press the LIMIT hot key. 

2. Select the test item(s) and set the limit(s): 
 

To set the limit for Select Set 

Frame average power Frame Average Power High Limit 
Low Limit 

Frequency error Frequency Error High Limit 
Low Limit 

Burst power Burst Power High Limit 
Low Limit 

ACLR ACLR (On/Off only) 

Multi-ACLR Multi-ACLR (On/Off only) 

Spurious emissions Spurious Emissions (On/Off only) 

3. Optional. You can enable alarm sound that goes off if the measurement falls outside of the limit. 
Toggle the Beep soft key between On and Off to enable or disable the beep sound. 

4. Optional. Go to SAVE/LOAD > Save, and then select Save Limit to save the limit settings. 

See “Using save” on page 33 for more information. 
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Measurement example 

Figure 53 Modulation analyzer measurement with GSM OTA signal analyzer 

 

 

 



 

 

  8 

 

Using WCDMA/HSPA+ Signal Analyzer 

This chapter provides instructions for using the WCDMA/HSPA+ Signal Analyzer function (option 023) 

with the WCDMA/HSPA+ OTA Analyzer function (option 043). Topics discussed in this chapter are as 

follows: 

 

 Introduction .............................................................................................................................. 157 

 Display overview ...................................................................................................................... 157 

 Connecting a cable .................................................................................................................. 158 

 Selecting measurement mode ................................................................................................. 160 

 Configuring test parameters .................................................................................................... 160 

 Conducting spectrum measurements ...................................................................................... 165 

 Conducting RF measurements ................................................................................................ 166 

 Conducting modulation measurements ................................................................................... 173 

 Performing auto measurements .............................................................................................. 185 

 Performing power statistics CCDF measurement ................................................................... 187 

 Conducting WCDMA/HSPA+ OTA measurements .................................................................. 188 
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Introduction 

This WCDMA/HSPA+ Signal Analyzer can be used to test a WCDMA transmitter including 

HSDPA/HSPA+ signals to check the base station’s compliance with following standards documentation. 

 

 3GPP TS 25.104 Base Station radio transmission and reception 

 3GPP TS 25.141 Base Station (BS) conformance test 

 3GPP TS 25.211 Physical channel and mapping of transport channels onto physical channels 

 3GPP TS 25.212 Multiplexing and channel coding 

 3GPP TS 25.213 Spreading and modulation 

 

The instrument automatically makes standard defined measurements using the measurement 

methods and limits as defined in the standards. Detailed measurement results allow you to analyze 

WCDMA and HSPA+ system performance. You may alter the measurement parameters for specialized 

analysis. Pass/Fail testing with standard defined or user defined upper and lower limits and the 

Pass/Fail indictor help you to determine base station performance easily. 

 

This instrument provides the following measurement tools for WCDMA/HSPA+ system: 

 

 Spectrum Analysis 

 RF Analysis 

- Channel Power 

- Occupied Bandwidth 

- Spectrum Emission Mask (SEM) 

- Adjacent Channel Leakage power Ratio (ACLR) 

- Multi-ACLR 

- Spurious Emissions 

 Modulation Analysis 

- Constellation 

- Code Domain Power 

- Relative Code Domain Error 

- Codogram 

- Received Code Strength Indicator (RCSI) 

- CDP Table 

 Auto Measure 

 Power Statistics CCDF 

 Over The Air (OTA) 

- Channel Scanner 

- Scramble Scanner 

- Multipath Profile 

- Code Domain Power 

- Route Map 

 

Display overview 

Figure 54 provides descriptions for each segment of the measurement screen. 
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Figure 54 WCDMA/HSPA+ signal analyzer measurement screen 

 

 

Connecting a cable 

Direct connection 

Procedure 

1. Connect the Spectrum Analyzer RF In port of the JD780A series and the power amplifier output 

port of BTS. 

 

Figure 55 Direct connection 

 
JD785A/JD786A 

 
JD788A 

 

Indirect connection 

Procedure 

1. Connect the Spectrum Analyzer RF In port of the JD780A series and the monitor (test) port of 

BTS. 
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Figure 56 Indirect connection 

 
JD785A/JD786A 

 
JD788A 

 

 

CAUTION 
The maximum power for the Spectrum Analyzer RF In port is +25 dBm (0.316 W). If the 
input signal level to be measured is greater than +25 dBm, use a High Power 
Attenuator to prevent damage when you directly connect the signal to the instrument or 
connect the signal from the coupling port of a directional coupler. 

 

Over the air (OTA) 

Procedure 

1. Connect an Omni/directional RF antenna to the Spectrum Analyzer RF In port of the JD780A 

series. 

2. Connect a GPS antenna to the GPS port of the JD780A series. 

 

Figure 57 OTA connection 

 
JD785A/JD786A 

 
JD788A 

 

 

CAUTION 

If the input signal level to be measured is less than 0 dBm, set 0 dB attenuation or turn on 
the preamp to have better dynamic range for the OTA testing. 
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Selecting measurement mode 

Procedure 

1. Press the MODE hard key. 

2. Press the Signal Analyzer soft key. 

3. Press the WCDMA soft key. The Spectrum mode is set by default. 

4. Press the MEASURE hot key, and then select the measurement mode option from the following 
choices: 

–  Spectrum 

–  RF Analysis > Channel Power, Occupied BW, Spectrum Emission Mask, ACLR,  
Multi-ACLR, or Spurious Emissions 

–  Modulation > Constellation, Code Domain Power, Relative Code Domain Error,  
Codogram, RCSI, or CDP Table 

–  Auto Measure 

–  Power Statistics CCDF 

–  OTA > Channel Scanner, Scramble Scanner, Multipath Profile, Code Domain Power, 
or Route Map 

 

Configuring test parameters 

Setting frequency 

You can set the frequency with either frequency or channel number. If a frequency to be set matches 

to the frequency corresponding to the selected channel standard, the instrument calculates its channel 

number and updates the screen with it automatically. 

 

Procedure 

To set the center frequency: 

1. Press the FREQ/DIST hard key. 

2. Toggle the Unit soft key and select Freq. 

3. Press the Center Frequency soft key. 

4. Enter a value by using the numeric keys. You can also use the rotary knob. 

5. Select the unit: GHz, MHz, kHz, or Hz. 

6. Optional. To define the amount of frequency increment for the rotary knob, complete the following 
steps: 

a. Press the Frequency Step soft key. 

b. Enter a value by using the numeric keys. You can also use the rotary knob. 

c. Press the unit: GHz, MHz, kHz, or Hz. 
 
To set the channel number: 

1. Press the FREQ/DIST hard key. 

2. Toggle the Unit soft key and select Channel. 

3. To select the standard channel, complete the following steps: 

a. Press the Channel Std soft key. The standard channel window appears. 

See “Appendix C – Band, frequency & channel standard” on page 588 for more information. 
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b. Select the band to be measured by using the rotary knob, the arrow keys, or the Page 
Up/Page Down soft keys. 

c. Press the Select soft key or the rotary knob to confirm the selection. 

4. Press the Channel Number soft key. 

5. Enter a value by using the numeric keys. You can also use the rotary knob. 

6. Press the Enter soft key. 

The instrument automatically displays the corresponding center frequency value for the selected 
channel number. 

7. Optional. To define the amount of channel increment for the rotary knob, complete the following 
steps: 

a. Press the Channel Step soft key. 

b. Enter a value by using the numeric keys. You can also use the rotary knob. 

c. Press the Enter soft key. 

 

 

NOTE 

This frequency setting is not used in the Multi-ACLR and Spurious Emissions modes. 

 

Setting amplitude 

Reference level and attenuation 

You can set the reference and attenuation levels automatically or manually to optimize the display of 

the traces measured, as you desire. 

 

Procedure 

To automatically set the reference and attenuation level: 

1. Press the AMP/SCALE hard key. 

2. Press the Auto Scale soft key. 

Each time you press this key, both of the Y-axis scale and input attenuation level change to be 
optimized with some margin. 

 
To set the reference or attenuation level manually: 

1. Press the AMP/SCALE hard key. 

2. To set the maximum reference value on the Y-axis manually, complete the following steps: 

a. Press the Reference Level soft key. 

b. Enter a value by using the numeric keys or the rotary knob with 10 dB increments. 

c. Press the unit soft key or the ENTER hard key. 

 

 

NOTE 
In the measurements such as Code Domain Power, Codogram, and RCSI, you may 
need to select the reference option between Relative and Absolute before setting the 

reference level. 

3. To set the attenuation option, select one from the following choices: 

–  To set the input attenuator’s level automatically, select Attenuation > Auto. 

 

 

NOTE 
It is recommended that you set the Attenuation to Auto in most situations so that the 

level of the input attenuator can be set automatically according to your input signal level. 

–  To set the input attenuation manually up to 55 dB to optimize S/N, complete the following 
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steps: 

a. Select Attenuation > Manual. 

b. Press the Attenuation Value soft key to set the level. 

c. Enter a value between 0 and 55 in fives by using the numeric keys. 

d. Press the dB soft key or the ENTER hard key. 

–  To couple the input attenuator’s level with your reference level setting, select Attenuation > 
Couple. 

As you increase the reference setting, the attenuation level also increases acoordingly. 
 
Optional. To change the scale unit: 

1. Select More (1/2) > Units. 

2. Select the unit of the display scale: dBm, dBV, dBmV, dBµV, V, or W. 

The scale unit on the screen changes accordingly. 

 

 

NOTE 

This Units menu is available in the Spectrum and RF Analysis modes. 
 

 

Scale per division 

You can use the Scale/Div feature available for the spectrum and RF analysis. It represents the value 

of one division on the horizontal scale. The default setting is 10 dB per division and the maximum 

value can be set up to 20 dB. 

 

Procedure 

To set the scale per division: 

1. Press the AMP/SCALE hard key. 

2. Select More (1/2) > Scale/Div. 

3. Enter a value between 1 and 20 by using the numeric keys. 

4. Press the dB soft key to complete the entry. 

 

Pre-amplifier 

You can turn the internal pre-amplifier on to correct and compensate for the gain of the preamp so that 

amplitude readings show the value at the input connector. 

 

Procedure 

1. Press the AMP/SCALE hard key. 

2. Toggle the Preamp soft key and select On or Off as needed. 

 

 

NOTE 

You can turn the Preamp on when the input attenuation range is from 0 dB to 10 dB. If 
the attenuation value is manually set to greater than 10 dB, the instrument will 
automatically turn off the pre-amplifier to display low-level signal properly on the chart. 

 

External offset 

You can turn the External Offset on and manually set the external offset value. An offset consists of a 

cable loss and a user offset and the measurement result shows the value reflecting both offset values. 
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When the external offset value is set at 40 dB in the Spectrum mode, the measurement result 

compensates 40 dB at both the Spectrum Analyzer and Signal Analyzer modes 

 

Procedure 

To set the external offset: 

1. Press the AMP/SCALE hard key. 

2. Toggle the External Offset soft key and select On. 

3. Enter a value by using the numeric keys. 

4. Press the dB soft key to complete the entry. 

 
To turn the external offset off: 

1. Press the AMP/SCALE hard key. 

2. Toggle the External Offset soft key and select Off. 

 

Setting average 

You can set the number of measurements to be averaged for the trace presentation. A maximum of 

100 times of averaging can be set. When the averaging reaches to your setting, a new measurement 

value replaces the measurement value in sequence from the earliest. 

 

Procedure 

1. Press the BW/AVG hard key. 

2. Press the Average soft key. 

3. Enter a value between 1 and 100 as needed by using the numeric keys. 

4. Press the Enter soft key. 

 

Setting sweep mode 

The default setting is Continue to sweep continuously for most on-going measurements. If you want to 

hold the measurement or get a single sweep, you can change the sweep mode. 

 

Procedure 

To select the single sweep mode: 

1. Press the SWEEP hot key. 

2. Toggle the Sweep Mode soft key and select Single. You can also use the HOLD hot key. 

The letter HOLD in red appears and the sweeping is paused. 

3. Optional. Press the Sweep Once soft key to get a new measurement. 
 
To return to the continuous sweep mode: 

1. Toggle the Sweep Mode soft key and select Continue. You can also use the HOLD hot key. 

The letter HOLD in red disappears and the sweeping resumes. 

 

Setting trigger source 

You can set the trigger source option for your measurements. 
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Procedure 

1. Press the TRIGGER hot key. 

2. Select the trigger source option from the following choices: Internal, External, or GPS. 

 

Setting external clock 

To enhance the reliability of modulation analysis measurements the JD780A series must be 

synchronized with a base station. When an external clock is not supplied, the instrument works with its 

built-in internal high-accuracy time base and some measurement results may exhibit inaccurate values. 

Therefore, it is highly recommended that you use the same reference clock as the signal source. You 

can use the TRIGGER hot key to set the external clock. 

 

Table 11 Standards of external clock operation 

Clock Type Reference Port Switching Standard 

External 
Reference 

Internal Internal 10 MHz  Default 

 External External Ref Clock Ext Ref (SMA) Manual switching 
(Input signal level >-3 dBm) 

 GPS GPS Clock GPS (SMA) Automatic switching 
(GPS signal received) 

Trigger Internal Internal Trigger  Default 

 External External Trigger Trigger (SMA) Manual switching 

 GPS GPS GPS (SMA) Manual switching 

 

Figure 58 Connection ports for external reference clock 

 

 

Procedure 

1. Connect an external reference or a GPS antenna to the JD780A series. 

2. Press the SYSTEM hot key. 

3. Press the Freq Reference soft key, and then select the reference option: Internal, External 10 
MHz, External 13 MHz, External 15 MHz, or GPS. 

 

 

NOTE 

When a GPS antenna is connected and locked, GPS coordinates (longitude and latitude) 
are displayed on the screen and frequency reference is automatically set to GPS in the 
System > Freq Reference. 
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Table 12 External reference indicators 

Type Indicator Description 

Internal  (green) The green INT icon indicates that the instrument uses the built-in 

internal time base. 

External  (green) The green EXT icon indicates that an external reference is connected 

and locked and that the instrument uses the same reference clock as 
the signal source. 

External  (red) The red EXT icon indicates that an external reference is connect but not 

locked. 

GPS (green) The green GPS antenna icon indicates that a GPS antenna is 
connected and locked. 

GPS (yellow) The yellow GPS antenna icon indicates that a GPS antenna is 
connected and locking is in progress. 

GPS (grey) The grey GPS antenna icon indicates that a GPS antenna is not 
connected, failed, or unable to be locked. 

 

Conducting spectrum measurements 

If you have configured test parameters as described in the “Configuring test parameters” on page 160, 

your measurement result is displayed on the screen as like the following example, Figure 59. 

 

Figure 59 Spectrum measurement screen with WCDMA signal analyzer 

 

 

Setting trace 

You can display up to six traces on the measurement chart simultaneously. 

 

Procedure 

1. Press the TRACE/DISPLAY hard key. 

2. Press the Select Trace soft key, and then select the trace number: T1, T2, T3, T4, T5, or T6. 

The legend shape of the selected trace changes from square to round to indicate that the trace is 
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the active one now. 

3. Do one of the following: 
 

To Select Trace Legend 

Clear current data and display with new 
measurements 

Clear Write W 

Display the input signal’s maximum response only 
(unlimited or for a certain amount of time) 

Max Hold M 

Display the input signal’s minimum response only 
(unlimited or for a certain amount of time) 

Min Hold m 

Capture the selected trace and compare traces Capture C 

Load a saved trace More (1/2) > Load L 

Hide the selected trace Trace View > Off F 

Remove all the traces and initialize the trace 
settings 

More (1/2) > Trace 
Clear All 

 

 

 

NOTE 
For the Max Hold and Min Hold, your instrument compares newly acquired data with the 

active trace and displays larger maximum values or smaller minimum values on the 
screen. You can set it to Unlimited to hold and view maximum or minimum data or 

specify a certain amount of time up to 60 seconds by using numeric keys or the rotary 
knob. 

4. To select the detection option, press the More (1/2) > Detectors, and then do one of the 

following: 
 

To display Select 

Random noise better than the peak without missing signals Normal 

The highest value in each data point Peak 

The root mean squared average power across the spectrum RMS 

The lowest value in each data point Negative Peak 

The center value in each data point Sample 

5. Optional. Press the More (1/2) > Trace Info soft key, and then select the trace number to view 
the trace’s parameter setting information stored at the time of the measurement or None to hide 

the information display. 

6. Optional. If you have the two traces T1 and T2, you can perform trace math. To view the power 
difference between the traces, press the T1 – T2 -> T5 or T2 – T1 -> T6 soft key. 

The result is overlaid on the screen along with the second Y-axis. 

 

Conducting RF measurements 

Channel power 

The Channel Power measurement is a common test used in the wireless industry to measure the total 

transmitted power of a radio within a defined frequency channel. This procedure measures the total 

power within the defined channel for WCDMA. This measurement is applied to design, characterize, 

evaluate, and verify transmitters and their components or devices for base stations and mobile stations. 

 

The channel power measurement identifies the channel power within a specified bandwidth (default is 
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5 MHz, as per the 3GPP WCDMA technical specifications) and the power spectral density (PSD) in 

dBm/Hz. 

 

After configuring test parameters as described in the “Configuring test parameters” on page 160, your 

measurement result is displayed on the screen as like the following example, Figure 60. 

 

Figure 60 Channel power measurement with WCDMA/HSPA+ signal analyzer 

 

 

 

NOTE 
You can use the LIMIT hot key to analyze your measurements with the user-definable 

limit and Pass/Fail indication. See “Setting limit for RF tests” on page 172 for more 
information. 

 

Occupied bandwidth 

The 3GPP specifications require the occupied bandwidth (OBW) of a transmitted WCDMA signal to be 

less than 5 MHz, where occupied bandwidth is defined as the bandwidth containing 99% of the total 

channel power. In this measurement, the total power of the displayed span is measured. Then the 

power is measured inward from the right and left extremes until 0.5% of the power is accounted for 

each of the upper and lower part of the span and the calculated difference is the occupied bandwidth. 

 

The spectrum shape of a WCDMA signal can give a useful qualitative insight into the transmitter’s 

operation. Any distortion to the spectrum shape might be an indication of degradation of the 

transmitter's performance. 

 

After configuring test parameters as described in the “Configuring test parameters” on page 160, your 

measurement result is displayed on the screen as like the following example, Figure 61. 
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Figure 61 Occupied bandwidth measurement with WCDMA/HSPA+ signal analyzer 

 

 

 

NOTE 

You can use the LIMIT hot key to analyze your measurements with the user-definable 
limit and Pass/Fail indication. See “Setting limit for RF tests” on page 172 for more 
information. 

 

Spectrum emission mask (SEM) 

The Spectrum Emission Mask (SEM) measurement required by 3GPP specifications encompasses 

different power limits and different measurement bandwidths (resolution bandwidths) at various 

frequency offsets. It may be expressed as a ratio of power spectral densities between the carrier and 

the specified offset frequency band. It provides useful figures-of-merit for the spectral re-growth and 

emissions produced by components and circuit blocks, without the rigor of performing a full SEM 

measurement. 

 

The SEM measures spurious signal levels in up to five pairs of offset or region frequencies and relates 

them to the carrier power. 

 

Setting measure setup 

After configuring test parameters as described in the “Configuring test parameters” on page 160, you 

can set the mask type according to the output power of the base station be tested. Your measurement 

result is displayed on the screen as like the following example, Figure 62. 

 

Procedure 

1. Press the MEASURE SETUP hot key. 

2. Press the Mask Type soft key. 

3. Select the mask type option: – 31 dBm, 31 – 39 dBm, 39 – 43 dBm, or 49 dBm –. 
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Figure 62 SEM measurement with WCDMA/HSPA+ signal analyzer 

 

 

 

NOTE 
You can use the LIMIT hot key to analyze your measurements with the user-definable 
limit and Pass/Fail indication. See “Setting limit for RF tests” on page 172 for more 
information. 

 

ACLR 

The Adjacent Channel Power Ratio (ACPR), designated by the 3GPP WCDMA specifications as the 

Adjacent Channel Leakage power Ratio (ACLR), is the power contained in a specified frequency 

channel bandwidth relative to the total carrier power. It may also be expressed as a ratio of power 

spectral densities between the carrier and the specified offset frequency band. 

 

After configuring test parameters as described in the “Configuring test parameters” on page 160, your 

measurement result is displayed on the screen as like the following example, Figure 63. 

 

Figure 63 ACLR measurement with WCDMA/HSPA+ signal analyzer 
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NOTE 
You can use the LIMIT hot key to analyze your measurements with the user-definable 
limit and Pass/Fail indication. See “Setting limit for RF tests” on page 172 for more 
information. 

 

Multi-ACLR 

The Multi-ACLR measurement is used to perform multi-channel ACLR measurements with as many 

channels as possible. It helps you to measure ACLR in multi-channel transmitting Base Station 

environment. 

 

Setting frequency for Multi-ACLR 

You can set the frequency with either frequency or channel number. 

 

Procedure 

1. Press the MEASURE SETUP hot key. 

2. To set the frequency, do one of the following: 

–  To set the center frequency, complete the following steps: 

a. Toggle the Unit soft key and select Freq. 

b. Press the Lowest Frequency soft key to set the starting center frequency. 

c. Enter a value by using the numeric keys. You can also use the rotary knob. 

d. Select the unit: GHz, MHz, kHz, or Hz. 

e. Press the Highest Frequency soft key to set the stopping center frequency. 

f. Enter a value by using the numeric keys. You can also use the rotary knob. 

g. Select the unit: GHz, MHz, kHz, or Hz. 

–  To set the channel number, complete the following steps: 

a. Toggle the Unit soft key and select Channel. 

b. To select the standard channel, press the Channel Std soft key and then select the 

band to be measured. 

c. Press the Lowest Channel soft key to set the starting channel. 

d. Enter a value by using the numeric keys. You can also use the rotary knob. 

e. Press the Enter soft key. 

f. Press the Highest Channel soft key to set the stopping channel. 

g. Enter a value by using the numeric keys. You can also use the rotary knob. 

h. Press the Enter soft key. 

 

After configuring test parameters, your measurement result is displayed on the screen as like the 

following example, Figure 64. 
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Figure 64 Multi-ACLR measurement with WCDMA/HSPA+ signal analyzer 

 

 

 

NOTE 

You can use the LIMIT hot key to analyze your measurements with the user-definable 
limit and Pass/Fail indication. See “Setting limit for RF tests” on page 172 for more 
information. 

 

Spurious emissions 

Out-of-band emissions are unwanted emissions immediately outside the channel bandwidth resulting 

from the modulation process and non-linearity in the transmitter but excluding spurious emissions. The 

Spurious Emissions measurement is to identify and determine the power level of out-of-band spurious 

emission within the necessary channel bandwidth and modulated signal measured at the RF port of 

the Base Station. 

 

Setting measure setup 

Procedure 

1. Press the MEASURE SETUP hot key. 

2. To set up the range table and parameters, press the Range Table soft key and then complete 

the following steps: 

a. Press the Range soft key, and then select the range number between 1 and 20 to add  

as a new or change the existing settings. 

b. Do the following as desired: 

–  Select Start Frequency, and then specify the start frequency for the selected range. 

–  Select Stop Frequency, and then specify the stop frequency for the selected range. 

–  Select Start Limit, and then specify the lower limit for Pass/Fail indication. 

–  Select Stop Limit, and then specify the upper limit for Pass/Fail indication. 

–  Select More (1/2) > Attenuation, and then specify an value in the multiple of five. 

–  Select More (1/2) > RBW, and then specify a RBW value. 

–  Select More (1/2) > VBW, and then specify a VBW value. 

c. Press the PREV hard key. 
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d. Toggle the Range soft key and select On to display the selected range in the result table or 

Off to hide it from the table. 

3. Toggle the Measure Type soft key between Examine and Full to select the measurement type. 

 

NOTE 
The Examine mode displays only the selected range while the Full mode lets the 

instrument automatically changes the selected range from one another. 

4. To set the number of measurements to be averaged, complete the following steps: 

a. Press the Average soft key. 

b. Enter a value between 1 and 100. 

c. Press the Enter soft key. 

5. To move the highlighted bar in the result table to other range, complete the following steps: 

a. Press the Range soft key in the Measure Setup menu bar. 

b. Enter a value between 1 and 20. 

c. Press the Enter soft key. 

 

After configuring test parameters as described in the “Configuring test parameters” on page 160, your 

measurement result is displayed on the screen as like the following example, Figure 65. 

 

Figure 65 Spurious emissions measurement with WCDMA/HSPA+ signal analyzer 

 
 

 

 

NOTE 
You can use the LIMIT hot key to analyze your measurements with the user-definable 
limit and Pass/Fail indication. See “Setting limit for RF tests” on page 172 for more 
information. 

 

Setting limit for RF tests 

By default, test limits specified in the standard are set for you. You can change thresholds if you desire. 
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Procedure 

1. Press the LIMIT hot key. 

2. Press the RF Test Limits soft key. 

3. Select the test item(s) and set the limit(s) depending on your selected measurement mode: 
 

To set the limit for Select Set 

Channel power Channel Power High Limit 
Low Limit 

Occupied bandwidth Occupied BW High Limit 

Spectrum emission mask Spectrum Emission Mask (On/Off only) 

ACLR ACLR (On/Off only) 

Multi-ACLR Multi-ACLR (On/Off only) 

Spurious emissions Spurious Emissions (On/Off only) 

4. Optional. You can enable alarm sound that goes off if the measurement falls outside of the limit. 
Toggle the Beep soft key between On and Off to enable or disable the beep sound. 

5. Optional. Go to SAVE/LOAD > Save, and then select Save Limit to save the limit settings. 

See “Using save” on page 33 for more information. 

 

Conducting modulation measurements 

Constellation 

The Constellation is used to observe some aspects of modulation accuracy and can reveal certain 

fault mechanisms such as I/Q amplitude imbalance or quadrature imbalance. It displays constellation 

diagram by modulation types. 

 

Setting measure setup 

After configuring test parameters as described in the “Configuring test parameters” on page 160, you 

can continue your measurement. The measurement settings can be saved and recalled as a file. 
 

Procedure 

1. Press the MEASURE SETUP hot key. 

2. To set the scramble code, complete the following steps: 

a. Toggle the Scramble soft key between Auto and Manual. 

b. Enter a value by using the numeric keys to set manually. 

c. Press the Enter soft key. 

3. Press the Detect Mode soft key, and then select the signal standard option: WCDMA, HSDPA, 
or HSPA+. HSDPA is set by default. 

4. To set the threshold, complete the following steps: 

a. Press the Threshold soft key. 

b. Enter a value by using the numeric keys. 

c. Press the Enter soft key. 

 



JD780A Series Analyzers 

174 Using WCDMA/HSPA+ Signal Analyzer 

Measurement example 

Figure 66 Constellation measurement with WCDMA/HSPA+ signal analyzer 

 
 

 

NOTE 
You can use the LIMIT hot key to analyze your measurements with the user-definable 
limit and Pass/Fail indication. See “Setting limit for modulation tests” on page 185 for 
more information. 

 

Code domain power 

The Code Domain Power (CDP) measures the distribution of power across the set of code channels, 

normalized to the total power. It helps to verify that each code channel is operating at its proper level 

and to identify problems throughout the transmitter design from coding to the RF section. System 

imperfections such as amplifier non-linearity will present themselves as an undesired distribution of 

power in the code domain. 

 

Setting measure setup 

After configuring test parameters as described in the “Configuring test parameters” on page 160, you 

can continue your measurement. The measurement settings can be saved and recalled as a file. You 

can also use JDViewer, PC application software to configure a measure setup, save as a file, and load 

the file on to the instrument. 

 

Procedure 

1. Press the MEASURE SETUP hot key. 

2. Optional. To set the scramble code, complete the following steps: 

a. Toggle the Scramble soft key between Auto and Manual. 

b. Enter a value by using the numeric keys to set manually. 

c. Press the Enter soft key. 

3. Optional. Press the Detect Mode soft key, and then select the signal standard option: WCDMA, 
HSDPA, or HSPA+. HSDPA is set by default. 

4. To set the S-CCPCH information of the system to be tested, complete the following steps: 

a. Press the S-CCPCH soft key. 
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b. Toggle the S-CCPCH soft key between On and Off to enable or disable the S-CCPCH. 

c. Press the Spread Factor soft key, and then select the spread factor option: 4, 8, 16, 32, 64, 
128, or 256. 

d. Press the Spread Code soft key to set the spread code. 

e. Enter a value by using the numeric keys. 

f. Press the Enter soft key. 

5. To set the PICH information of the system to be tested, complete the following steps: 

a. Press the PICH soft key. 

b. Toggle the PICH soft key between On and Off to enable or disable the PICH. 

c. Press the Spread Factor soft key, and then select the spread factor option: 4, 8, 16, 32, 64, 
128, or 256. 

d. Press the Spread Code soft key to set the spread code. 

e. Enter a value by using the numeric keys. 

f. Press the Enter soft key. 

6. Optional. To set the threshold, complete the following steps: 

a. Press the Threshold soft key. 

b. Enter a value by using the numeric keys. 

c. Press the Enter soft key. 

 

Measurement example 

Figure 67 Code domain power measurement with WCDMA/HSPA+ signal analyzer 

1) Full screen 
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2) Full screen with constellation 

 

3) Zoomed screen (Width 64) 

 

4) Zoomed screen with constellation (Width 64) 
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NOTE 
You can use the LIMIT hot key to analyze your measurements with the user-definable 
limit and Pass/Fail indication. See “Setting limit for modulation tests” on page 185 for 
more information. 

 

Setting display 

You can view .your measurement results in a different view option. 

 

Procedure 

1. Press the TRACE/DISPLAY hard key. 

2. Toggle the View soft key and select the display option: 

–  Zoom: to view the result in detail with zoom-in window. 

The Position and Width menus become activated. 

–  Full: to view the full measurement result. 

3. To define the zoom start position and width, complete the following steps: 

a. Press the Position soft key. 

b. Enter a value of the position by using the numeric keys. 

c. Press the Enter soft key. 

d. Press the Width soft key, and then select the Walsh code option: 32, 64, 128, or 256. 

4. Toggle the Constellation soft key between On and Off to enable or disable the constellation 

chart on the Code Domain Power screen. 

5. Toggle the Control Channel soft key and select the control channel mode option: 

–  Normal: to view the relative ratio of each control channel vs. total power. 

–  Delta: to view the relative ratio of each control channel vs. CPICH channel. 

 

Relative code domain power 

The Relative Code Domain Error (RCDE) measurement provides relative code domain error analysis 

that is particularly required by HSPA+. 

 

Setting measure setup 

After configuring test parameters as described in the “Configuring test parameters” on page 160, you 

can continue your measurement. The measurement settings can be saved and recalled as a file. You 

can also use JDViewer, PC application software to configure a measure setup, save as a file, and load 

the file on to the instrument. 

 

Procedure 

1. Press the MEASURE SETUP hot key. 

2. Optional. To set the scramble code, complete the following steps: 

a. Toggle the Scramble soft key between Auto and Manual. 

b. Enter a value by using the numeric keys to set manually. 

c. Press the Enter soft key. 

3. Optional. Press the Detect Mode soft key, and then select the signal standard option: WCDMA, 
HSDPA, or HSPA+. HSDPA is set by default. 
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NOTE 
It is recommended that you select HSPA+ for RCDE testing. 

4. To set the S-CCPCH information of the system to be tested, complete the following steps: 

a. Press the S-CCPCH soft key. 

b. Toggle the S-CCPCH soft key between On and Off to enable or disable the S-CCPCH. 

c. Press the Spread Factor soft key, and then select the spread factor option: 4, 8, 16, 32, 64, 
128, or 256. 

d. Press the Spread Code soft key to set the spread code. 

e. Enter a value by using the numeric keys. 

f. Press the Enter soft key. 

5. To set the PICH information of the system to be tested, complete the following steps: 

a. Press the PICH soft key. 

b. Toggle the PICH soft key between On and Off to enable or disable the PICH. 

c. Press the Spread Factor soft key, and then select the spread factor option: 4, 8, 16, 32, 64, 
128, or 256. 

d. Press the Spread Code soft key to set the spread code. 

e. Enter a value by using the numeric keys. 

f. Press the Enter soft key. 

6. Optional. To set the threshold, complete the following steps: 

a. Press the Threshold soft key. 

b. Enter a value by using the numeric keys. 

c. Press the Enter soft key. 

7. Optional. Go to SAVE/LOAD > Save, and then select the save option from the choices available 

for your measurement mode. See “Using save” on page 33 for more information. 

 

Measurement example 

Figure 68 Relative code domain error with WCDMA/HSPA+ signal analyzer 
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NOTE 
You can use the LIMIT hot key to analyze your measurements with the user-definable 
limit and Pass/Fail indication. See “Setting limit for modulation tests” on page 185 for 
more information. 

 

Setting display 

You can view .your measurement results in a different view option. 

 

Procedure 

1. Press the TRACE/DISPLAY hard key. 

2. Toggle the View soft key and select the display option: 

–  Zoom: to view the result in detail with zoom-in window. 

The Position and Width menus become activated. 

–  Full: to view the full measurement result. 

3. To define the zoom start position and width, complete the following steps: 

a. Press the Position soft key. 

b. Enter a value of the position by using the numeric keys. 

c. Press the Enter soft key. 

d. Press the Width soft key, and then select the Walsh code option: 32, 64, 128, or 256. 

4. Toggle the Constellation soft key between On and Off to enable or disable the constellation 

chart on the Code Domain Power screen. 

5. Toggle the Control Channel soft key and select the control channel mode option: 

–  Normal: to view the relative ratio of each control channel vs. total power. 

–  Delta: to view the relative ratio of each control channel vs. CPICH channel. 

 

Codogram 

The Codogram displays how the code level is changing over time and makes it easier for you to view 

traffic channels as they initiate and terminate and to track traffic channels call levels over time. The 

Codogram measurements can be saved into an external USB memory so that a post-analysis can be 

done with the application software JDViewer. 

 

Setting measure setup 

After configuring test parameters as described in the “Configuring test parameters” on page 160, you 

can continue your measurement. The measurement settings can be saved and recalled as a file. You 

can also use JDViewer, PC application software to configure a measure setup, save as a file, and load 

the file on to the instrument. 

 

Procedure 

1. Press the MEASURE SETUP hot key. 

2. Optional. To set the scramble code, complete the following steps: 

a. Toggle the Scramble soft key between Auto and Manual. 

b. Enter a value by using the numeric keys to set manually. 

c. Press the Enter soft key. 
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3. Optional. Press the Detect Mode soft key, and then select the signal standard option: WCDMA, 
HSDPA, or HSPA+. HSDPA is set by default. 

4. To set the S-CCPCH information of the system to be tested, complete the following steps: 

a. Press the S-CCPCH soft key. 

b. Toggle the S-CCPCH soft key between On and Off to enable or disable the S-CCPCH. 

c. Press the Spread Factor soft key, and then select the spread factor option: 4, 8, 16, 32, 64, 
128, or 256. 

d. Press the Spread Code soft key to set the spread code. 

e. Enter a value by using the numeric keys. 

f. Press the Enter soft key. 

5. To set the PICH information of the system to be tested, complete the following steps: 

a. Press the PICH soft key. 

b. Toggle the PICH soft key between On and Off to enable or disable the PICH. 

c. Press the Spread Factor soft key, and then select the spread factor option: 4, 8, 16, 32, 64, 
128, or 256. 

d. Press the Spread Code soft key to set the spread code. 

e. Enter a value by using the numeric keys. 

f. Press the Enter soft key. 

6. Optional. To set the threshold, complete the following steps: 

a. Press the Threshold soft key. 

b. Enter a value by using the numeric keys. 

c. Press the Enter soft key. 

7. To set the time interval, complete the following steps: 

a. Press the Time Interval soft key. 

b. Enter a value by using the numeric keys. 

c. Press the Enter soft key. 

8. To place the time cursor to analyze your measurements, complete the following steps: 

a. Toggle the Time Cursor soft key between On and Off to enable or disable the time cursor. 

b. Enter a value by using the numeric keys. 

c. Press the Enter soft key. 

 

 

NOTE 

When the time cursor is enabled, the measurement is put on hold and information about 
the time cursor is displayed. 

9. Optional. Go to SAVE/LOAD > Save, and then select the save option from the choices available 

for your measurement mode. See “Using save” on page 33 for more information. 
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Measurement example 

Figure 69 Codogram in full view with WCDMA/HSPA+ signal analyzer 

 

 

Setting display 

You can view .your measurement results in a different view option. 

 

Procedure 

1. Press the TRACE/DISPLAY hard key. 

2. Toggle the View soft key and select the display option: 

–  Zoom: to view the result in detail with zoom-in window. 

The Position and Width menus become activated. 

–  Full: to view the full measurement result. 

3. To define the zoom start position and width, complete the following steps: 

a. Press the Position soft key. 

b. Enter a value of the position by using the numeric keys. 

c. Press the Enter soft key. 

d. Press the Width soft key, and then select the Walsh code option: 32, 64, 128, or 256. 

 

RCSI 

The Received Code Strength indicator (RCSI) is used to track the code channels such as CPICH, P-

CCPCH, S-CCPCH, PICH, P-SCH, and S-SCH. It is particularly useful to observe signal fluctuations of 

the dedicated control channels over the time. The RCSI measurements can be saved into an external 

USB memory so that a post-analysis can be done with the application software JDViewer. 

 

Setting measure setup 

After configuring test parameters as described in the “Configuring test parameters” on page 160, you 

can continue your measurement. The measurement settings can be saved and recalled as a file. You 

can also use JDViewer, PC application software to configure a measure setup, save as a file, and load 

the file on to the instrument. 
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Procedure 

1. Press the MEASURE SETUP hot key. 

2. Optional. To set the scramble code, complete the following steps: 

a. Toggle the Scramble soft key between Auto and Manual. 

b. Enter a value by using the numeric keys to set manually. 

c. Press the Enter soft key. 

3. Optional. Press the Detect Mode soft key, and then select the signal standard option: WCDMA, 
HSDPA, or HSPA+. HSDPA is set by default. 

4. To set the S-CCPCH information of the system to be tested, complete the following steps: 

a. Press the S-CCPCH soft key. 

b. Toggle the S-CCPCH soft key between On and Off to enable or disable the S-CCPCH. 

Setting this on makes the S-CCPCH in the Alarm Code menu activated. 

c. Press the Spread Factor soft key, and then select the spread factor option: 4, 8, 16, 32, 64, 
128, or 256. 

d. Press the Spread Code soft key to set the spread code. 

e. Enter a value by using the numeric keys. 

f. Press the Enter soft key. 

5. To set the PICH information of the system to be tested, complete the following steps: 

a. Press the PICH soft key. 

b. Toggle the PICH soft key between On and Off to enable or disable the PICH. 

Setting this on makes the PICH in the Alarm Code menu activated. 

c. Press the Spread Factor soft key, and then select the spread factor option: 4, 8, 16, 32, 64, 
128, or 256. 

d. Press the Spread Code soft key to set the spread code. 

e. Enter a value by using the numeric keys. 

f. Press the Enter soft key. 

6. Optional. To set the threshold, complete the following steps: 

a. Press the Threshold soft key. 

b. Enter a value by using the numeric keys. 

c. Press the Enter soft key. 

7. Press the Alarm Code soft key, and then select the alarm code option: None, CPICH, P-
CCPCH, S-CCPCH, PICH, P-SCH, or S-SCH. 

 

 

NOTE 

The alarm codes S-CCPCH and PICH become activated in case that you have enabled 
the S-CCPCH and PICH respectively. 

8. To set the alarm mask, complete the following steps: 

a. Press the Set Mask soft key. 

b. Enter a value by using the numeric keys. 

c. Press the Enter soft key. 

9. Optional. Go to SAVE/LOAD > Save, and then select the save option from the choices available 

for your measurement mode. See “Using save” on page 33 for more information. 
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Measurement example 

Figure 70 RCSI measurement with WCDMA/HSPA+ signal analyzer 

 

 

Setting display 

You can view .your measurement results in a different view option. 

 

Procedure 

1. Press the TRACE/DISPLAY hard key. 

2. Toggle the View soft key and select the display option: 

–  Zoom: to view the result in detail with zoom-in window. 

The Position and Width menus become activated. 

–  Full: to view the full measurement result. 

3. To define the zoom start position and width, complete the following steps: 

a. Press the Position soft key. 

b. Enter a value of the position by using the numeric keys. 

c. Press the Enter soft key. 

d. Press the Width soft key, and then select the Walsh code option: 32, 64, 128, or 256. 

 

CDP Table 

The CDP Table is used to look at a numeric and textual description of all the active code channels in 

the signal. 

 

Setting measure setup 

After configuring test parameters as described in the “Configuring test parameters” on page 160, you 

can continue your measurement. The measurement settings can be saved and recalled as a file. You 

can also use JDViewer, PC application software to configure a measure setup, save as a file, and load 

the file on to the instrument. 
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Procedure 

1. Press the MEASURE SETUP hot key. 

2. Optional. To set the scramble code, complete the following steps: 

a. Toggle the Scramble soft key between Auto and Manual. 

b. Enter a value by using the numeric keys to set manually. 

c. Press the Enter soft key. 

3. Optional. Press the Detect Mode soft key, and then select the signal standard option: WCDMA, 
HSDPA, or HSPA+. HSDPA is set by default. 

4. To set the S-CCPCH information of the system to be tested, complete the following steps: 

a. Press the S-CCPCH soft key. 

b. Toggle the S-CCPCH soft key between On and Off to enable or disable the S-CCPCH. 

c. Press the Spread Factor soft key, and then select the spread factor option: 4, 8, 16, 32, 64, 
128, or 256. 

d. Press the Spread Code soft key to set the spread code. 

e. Enter a value by using the numeric keys, and then press the Enter soft key. 

5. To set the PICH information of the system to be tested, complete the following steps: 

a. Press the PICH soft key. 

b. Toggle the PICH soft key between On and Off to enable or disable the PICH. 

c. Press the Spread Factor soft key, and then select the spread factor option: 4, 8, 16, 32, 64, 
128, or 256. 

d. Press the Spread Code soft key to set the spread code. 

e. Enter a value by using the numeric keys, and then press the Enter soft key. 

6. Optional. To set the threshold, complete the following steps: 

a. Press the Threshold soft key. 

b. Enter a value by using the numeric keys, and then press the Enter soft key. 

 

Measurement example 

Figure 71 CDP Table measurement with WCDMA/HSPA+ signal analyzer 
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Setting display 

If the CDP table spans over to the next page(s), you can change pages up and down to view .your 

measurement results. 

 

Procedure 

1. Press the TRACE/DISPLAY hard key. 

2. Select Page Up or Page Down as needed. 

 

Setting limit for modulation tests 

Procedure 

1. Press the LIMIT hot key. 

2. Press the Modulation Test Limits soft key to set the limits. 

3. Select the test item(s) and set the limit(s) depending on your selected measurement mode: 
 

To set the limit for Select Set 

Frequency error Frequency Error High Limit 
Low Limit 

Error vector magnitude EVM High Limit 

Peak code domain error PCDE High Limit 

Carrier feed through Carrier Feed Through High Limit 

Correlated power in coded channel CPICH High Limit [Abs|Rel] 
Low Limit [Abs|Rel] 

Highest level among inactive channels Max Inactive High Limit 

Relative code domain error RCDE High Limit (QPSK) 
High Limit (16 QAM) 
High Limit (64 QAM) 

4. Optional. You can enable alarm sound that goes off if the measurement falls outside of the limit. 
Toggle the Beep soft key between On and Off to enable or disable the beep sound. 

5. Optional. Go to SAVE/LOAD > Save, and then select Save Limit to save the limit settings. 

See “Using save” on page 33 for more information. 

 

 

NOTE 

The Carrier Feed Through is a result of the RF carrier signal feeding through the I/Q 
modulator and riding on the output circuitry without being modulated. 

 

Performing auto measurements 

The Auto Measure function of the JD780A series allows a complete signal profiling covering RF 

characterization and modulation quality parameters of up to 10 different carriers, particularly useful on 

an overlay architecture where base stations are transmitting in different frequencies. 

 

The Auto Measure can be easily executed either by selecting a menu in the instrument or by running a 

programmed scenario in the PC-based application so that the instrument automatically configure and 

perform tests on every aspect of all the carriers. 
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Setting limit for auto measure 

You can set test limits for test item(s) in the auto measurement. 

Procedure 

1. Press the LIMIT hot key. 

2. Press the RF Test Limits soft key, and then enable test limits as desired. 

3. Press the Modulation Test Limits soft key, and then enable test limits as desired. 

4. Optional. You can enable alarm sound that goes off if the measurement falls outside of the limit. 
Toggle the Beep soft key between On and Off to enable or disable the beep sound. 

5. Optional. Go to SAVE/LOAD > Save, and then select Save Limit to save the limit settings. 

See “Using save” on page 33 for more information. 

 

Setting measure setup 

After configuring test parameters as described in the “Configuring test parameters” on page 160, you 

can continue your measurement. The measurement settings can be saved and recalled as a file. You 

can also use JDViewer, PC application software to configure a measure setup, save as a file, and load 

the file on to the instrument. 

 

Procedure 

1. Press the MEASURE SETUP hot key. 

2. Toggle the Configuration soft key and select the configuration option: 

–  Current: to let the instrumnet use current frequency (single carrier) and determine pass or 

fail based on the instrument’s limit settings in Auto Measure. 

–  Scenario: to run a test with a programmed scenario in JDViewer. 

The Scenario menu becomes activated. 

3. To load a scenario, press the Scenario soft key, and then select a scenario file to load. 

4. Toggle the Test Time soft key and select the test time option: 

–  Now: to let the instrument run a test only once. 

–  Schedule: to let the instrument repeat tests as defined in the Set Timing. 

The Set Timing menu becomes activated. 

5. To define a schedule for an auto measurement, complete the following steps: 

a. Press the Set Timing soft key. 

b. Press the Start Time (HH:MM) soft key. 

c. Enter the time in the HH:MM format, and then press the Enter soft key. 

d. Press the Stop Time (HH:MM) soft key. 

e. Enter the time in the HH:MM format, and then press the Enter soft key. 

f. Press the Time Interval soft key. 

g. Enter the amount of time in minutes, and then press the Enter soft key. 

6. To select the type of the measurement data to be taken for the determination of the results,  
press the Data Type soft key and then select the data type option from the following choices: 

–  Sample: The Auto Measure takes the last measurement data only. 

–  RMS: The Auto Measure takes data from all 20 measurements and averages them. 
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–  Peak: The Auto Measure takes only the highest peak of all 20 measurements. 

–  Negative Peak: The Auto Measure takes only the lowest peak of all 20 measurements. 

7. To set external offset, complete the following steps: 

a. Toggle the External Offset soft key and select On. 

b. Enter a value by using the numeric keys, and then press the dB soft key. 

8. To save your settings and results, go to SAVE/LOAD > Save and then perform functions as you 

desire. See “Using save” on page 33 for more information. 

9. Press the Run Test soft key to start to run a test. 

The Auto Measure Results window appears at the end of the test. 

10. To stop running the test, press the Abort soft key. 

11. To change the view on the screen during the test, press the Display and then select the view 

option from the following choices: 

–  Screen: You can view each measurement screen as the test progresses. 

–  Results: You can view a measurement result table as the test progresses. 

–  Settings: You can view a measurement setting table as the test progresses. 

 

Setting display 

After completion of the auto measurement, the screen menu changes to Trace/Display so that you can 

view the results in different forms. 

 

Procedure 

1. Toggle the Display soft key and select the display option: 

–  Result: to view the result table. 

The Display Result menu becomes activated. 

–  Settings: to view the measurement settings for the auto measurement. 

2. Toggle the Display Result soft key and select the display result option: 

–  Full: to view detailed measurement readings with the pass/fail indication. 

–  Quick: to view only the Pass/Fail results. 

3. To view the measurement results for a different carrier, press the View Carrier soft key and then 

select the carrier number to view. 

 

Performing power statistics CCDF measurement 

The Power Statistics Complementary Cumulative Distribution Function (CCDF) measurement 

characterizes the power statistics of the input signal. It provides PAR (Peak to Average power Ratio) 

versus different probabilities. 

 

Setting measure setup 

After configuring test parameters as described in the “Configuring test parameters” on page 160, you 

can continue your measurement. The measurement settings can be saved and recalled as a file. You 

can also use JDViewer, PC application software to configure a measure setup, save as a file, and load 

the file on to the instrument. 
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Procedure 

1. Press the MEASURE SETUP hot key. 

2. Press the CCDF Length soft key to set the length of the CCDF. 

3. Enter a value between 1 and 100 by using the numeric keys. You can also use the rotary knob. 

4. Press the Enter soft key. 

 

Measurement example 

Figure 72 CCDF measurement with WCDMA/HSPA+ signal analyzer 

 

 

Conducting WCDMA/HSPA+ OTA measurements 

This Over The Air (OTA) measurement has channel scanner, scramble scanner, multipath profile, code 

domain power, and route map screens. Scramble scanner displays six scrambling codes and powers 

to inform neighbor cells existence and its power. The multipath profile graph helps you to determine 

testing area's RF environmental condition. The code domain power shows not only modulation 

performance metric but also amplifier capacity and code utilization metric. The amplifier capacity (code 

utilization) measurement is an estimate of the amount of power amplifier capacity (code utilization) that 

is being used expressed in percent of maximum. 

 

Channel scanner 

Setting channel/frequency 

Procedure 

To set the channels to be scanned: 

1. Press the FREQ/DIST hard key. 

2. Toggle the Unit soft key and select Channel. 

3. Press the Index soft key, and then enter an index number by turning the rotary knob or using the 

numeric keys. 
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4. To select the standard channel, complete the following steps: 

a. Press the Channel Std soft key. The standard channel window appears. 

See “Appendix C – Band, frequency & channel standard” on page 588 for more information. 

b. Select the band to be measured by using the rotary knob, the arrow keys, or the Page 
Up/Page Down soft keys. 

c. Press the Select soft key or the rotary knob to confirm the selection. 

5. To set the channel number for the selected index, complete the following steps: 

a. Press the Channel Number soft key. 

b. Enter a value by using the numeric keys. You can also use the rotary knob. 

c. Press the Enter soft key. 

The instrument displays a corresponding center frequency for the channel number. 

6. To set the integration bandwidth for the selected index, complete the following steps: 

a. Press the Integration Bandwidth soft key. 

b. Enter a value by using the numeric keys. You can also use the rotary knob. 

c. Select the unit: GHz, MHz, kHz, or Hz. 

7. To add more channels to be scanned, repeat steps 3-6. 

8. Press the ESC hard key to dismiss the channel list window and view the scanning result. 
 
To set the frequencies to be scanned: 

1. Press the FREQ/DIST hard key. 

2. Toggle the Unit soft key and select Freq. 

3. Press the Index soft key, and then enter an index number by turning the rotary knob or using the 

numeric keys. 

4. To set the center frequency for the selected index, complete the following steps: 

a. Press the Center Frequency soft key. 

b. Enter a value by using the numeric keys. You can also use the rotary knob. 

c. Select the unit: GHz, MHz, kHz, or Hz. 

5. To set the integration bandwidth for the selected index, complete the following steps: 

a. Press the Integration Bandwidth soft key. 

b. Enter a value by using the numeric keys. You can also use the rotary knob. 

c. Select the unit: GHz, MHz, kHz, or Hz. 

6. To add more channels to be scanned, repeat steps 3-5. 

7. Press the ESC hard key to dismiss the channel list window and view the scanning result. 

 

Setting limit for OTA channel scanner 

Procedure 

1. Press the LIMIT hot key. 

2. Press the Limit Line soft key to set a threshold for the limit line and Pass/Fail indication. 

3. Enter a value, and then press the dBm unit soft key. 

4. Toggle the Limit Line soft key between On and Off to display or dismiss the limit line. 

5. Optional. You can enable alarm sound that goes off if the measurement falls outside of the limit. 
Toggle the Beep soft key between On and Off to enable or disable the beep sound. 
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6. Optional. Go to SAVE/LOAD > Save, and then select Save Limit to save the limit settings. 

See “Using save” on page 33 for more information. 

 

Measurement example 

Figure 73 Channel scanner measurement with WCDMA/HSPA+ OTA signal analyzer 

 

 

Scramble scanner 

The WCDMA/HSPA+ mobile receives signals from multiple base stations that all of these signals share 

the same spectrum and are present at the same time. Each base station has a unique scrambling code 

assigned to the particular base station and it differentiates its signal from other base stations in the area. 

 

Measurement example 

Figure 74 Scramble scanner measurement with WCDMA/HSPA+ OTA signal analyzer 
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Multipath profile 

The Multipath Profile enables you to determine RF environmental conditions of testing area. It 

indicates the amount of power of the dominant pilot signal that is dispersed outside the main 

correlation peak due to multipath echoes that are expressed in dB. This value should be very small 

ideally. 

 

The multipath profile is the result of portions of the original broadcast signal arriving at the receiving 

antenna out of phase. This can be caused by the signal being reflected off objects such as buildings, 

or being refracted through the atmosphere differently from the main signal. 

 

Measurement example 

Figure 75 Multipath profile measurement with WCDMA/HSPA+ OTA signal analyzer 

 

 

Code domain power 

Channels with high correlation factors are determined to be active channels and are indicated as such 

on the display. Once the channels are decoded, the analyzer determines the power of each channel 

relative to the total signal power. 

 

This measurement helps to verify that each code channel is operating at its proper level and helps to 

identify problems throughout the transmitter design from the coding to the RF section. System 

imperfections, such as the non-linearity of amplifiers, will present themselves as an undesired 

distribution of power in the code domain. 

 

Setting measure setup 

After configuring test parameters, you can set the measure setup to continue your measurement. The 

measurement settings can be saved and recalled as a file. You can also use JDViewer, PC application 

software to configure a measure setup, save as a file, and load the file on to the instrument. 

 

Procedure 

1. Press the MEASURE SETUP hot key. 
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2. To set the scramble code, complete the following steps: 

a. Toggle the Scramble soft key between Auto and Manual. 

b. Enter a value by using the numeric keys to set manually. 

c. Press the Enter soft key. 

3. Press the Detect Mode soft key, and then select the signal standard option: WCDMA, HSDPA, 
or HSPA+. HSDPA is set by default. 

4. To set the threshold, complete the following steps: 

a. Press the Threshold soft key. 

b. Enter a value by using the numeric keys. 

c. Press the Enter soft key. 

5. To set the S-CCPCH information of the system to be tested, complete the following steps: 

a. Press the S-CCPCH soft key. 

b. Toggle the S-CCPCH soft key between On and Off to enable or disable the S-CCPCH. 

c. Press the Spread Factor soft key, and then select the spread factor option: 4, 8, 16, 32, 64, 
128, or 256. 

d. Press the Spread Code soft key to set the spread code. 

e. Enter a value by using the numeric keys. 

f. Press the Enter soft key. 

6. To set the PICH information of the system to be tested, complete the following steps: 

a. Press the PICH soft key. 

b. Toggle the PICH soft key between On and Off to enable or disable the PICH. 

c. Press the Spread Factor soft key, and then select the spread factor option: 4, 8, 16, 32, 64, 
128, or 256. 

d. Press the Spread Code soft key to set the spread code. 

e. Enter a value by using the numeric keys. 

f. Press the Enter soft key. 

7. To set the maximum amplifier power, complete the following steps: 

a. Press the Max Amplifier Power soft key. 

b. Enter a value by using the numeric keys. 

c. Press the dBm soft key. 

8. To set the CPICH power, complete the following steps: 

a. Press the More (1/2) soft key. 

b. Press the CPICH soft key. 

c. Enter a value by using the numeric keys. 

d. Press the dBm soft key. 

9. To set the threshold for CPICH dominance, complete the following steps: 

a. Press the CPICH Dominance > soft key. 

b. Enter a value by using the numeric keys. 

c. Press the Enter soft key. 

 

 

NOTE 

Recommended value is 10. Color of the CPICH Dominance indicator on the screen 
bases on this setting. 

10. To set the threshold for multipath power, complete the following steps: 



JD780A Series Analyzers 

 Using WCDMA/HSPA+ Signal Analyzer 193 

a. Press the Multipath Power < soft key. 

b. Enter a value by using the numeric keys. 

c. Press the Enter soft key. 

 

 

NOTE 

Recommended value is one. Color of the multipath power indicator on the screen bases 
on this setting. 

11. Optional. Go to SAVE/LOAD > Save, and then select the save option from the choices available 

for your measurement mode. See “Using save” on page 33 for more information. 

 

Measurement example 

Figure 76 Code domain power measurement with WCDMA/HSPA+ OTA signal analyzer 

 

 

 

NOTE 
You can use the LIMIT hot key to analyze your measurements with the user-definable 
limit and Pass/Fail indication. 

 

Route map 

The JD780A series provides the Route Map function that allows you to collect data of points in an 

indoor or outdoor environment and track the received signals and coverage of RF transmitters by 

plotting data real time directly on top of a loaded floor plan or a map.  

 

If you have obtained user experience data through Viavi’s ariesoGEO and generated raster data files 

from the application, you can load them onto your route map to help you troubleshoot problems easily 

and quickly. 

 

Setting measure setup 

Procedure 

1. If required, connect a GPS receiver to your JD780A series for outdoor mapping. 
Indoor mapping does not necessarily need a GPS antenna. 
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2. Configure test parameters as described in the “Configuring test parameters” on page 160. 

3. To load your map file, complete the following steps: 

a. Plug in your USB drive that has a floor map or .mcf file type created in JDMapCreator. 

 

 

NOTE 

The JDMapCreator converts and resizes any scanned floor plan or layout to fit onto your 
instrument’s display.  

b. Press SAVE/LOAD hot key, and then select Load > Load Map. 

See “Using load” on page 36 for more information. 

4. Press the MEASURE SETUP hot key. 

5. Press the Plot Point soft key, and then select the plot point option from the following choices: 

–  To collect data/plot points automatically as you move around in a vehicle or outside, press 
the GPS soft key and then toggle the Screen Mode soft key between Map and Full. 

 

 

NOTE 
With the Map setting, you can view only the collected points that can be seen within the 

boundary of the loaded map. If a point is off the map, the instrument displays an arrow to 
indicate the direction of the current location on the map and the distance from the center 
to the location at the top of the screen. 
 
With the Full setting, you can view all the collected points of the route without the loaded 

map. 

–  To collect data/plot points manually without a GPS antenna in an indoor environment, press 
the Position soft key. 

6. Press the Plot Item soft key, and then select the measurement option: CPICH Power or Ec/Io. 

7. Toggle the Plot soft key and select Start. 

8. Touch directly on the screen or press the ENTER hard key to collect data and plot points on the 
loaded map for the Position setting. 

 

 

NOTE 
For the Position setting, you can change the direction of the route with the arrow keys 

and the distance with the rotary knob. 

9. Toggle the Plot soft key and select Stop to stop plotting. 

10. Press the SAVE/LOAD hot key to save the result. 
See “Using save” on page 33 for more information. 

 

 

NOTE 

The instrument does not automatically save the collected data. It is recommended that 
you save the result. Otherwise, you will lose all the collected data. 

 

 

Setting limit 

You can set the thresholds for the four different color indicators for CPICH power or Ec/Io. 

 

Procedure 

1. Press the LIMIT hot key. 

2. To set the limits for CPICH power if you have selected CPICH as for the plot item, complete the 
following steps: 

a. Press the CPICH Power soft key. 

b. Press the Excellent soft key to set its threshold. 
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c. Enter a value, and then press the dBm soft key. You can also use the rotary knob. 

d. Press the Very Good soft key to set its threshold. 

e. Enter a value, and then press the dBm soft key. You can also use the rotary knob. 

f. Press the Good soft key to set its threshold. 

g. Enter a value, and then press the dBm soft key. You can also use the rotary knob. 

h. Press the Fair soft key to set its threshold. 

i. Enter a value, and then press the dBm soft key. You can also use the rotary knob. 

j. Press the Poor soft key to set its threshold. 

k. Enter a value, and then press the dBm soft key. You can also use the rotary knob. 

3. To set the limits for Ec/Io if you have selected as for the plot item , complete the following steps: 

a. Press the Ec/Io soft key. 

b. Press the Good soft key to set its threshold. 

c. Enter a value, and then press the Enter soft key. You can also use the rotary knob. 

d. Press the Fair soft key to set its threshold. 

e. Enter a value, and then press the Enter soft key. You can also use the rotary knob. 

f. Press the Poor soft key to set its threshold. 

g. Enter a value, and then press the Enter soft key. You can also use the rotary knob. 

4. Optional. Go to SAVE/LOAD > Save, and then select Save Limit to save the limit settings. 

See “Using save” on page 33 for more information. 

 

Measurement example 

Figure 77 Route map measurement with WCDMA/HSPA+ OTA signal analyzer 

1) CPICH Power 
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2) CPICH Ec/Io 

 

 

Controlling a map 

If you have loaded a sizable map that was created in JDMapCreator 1.2.0 or later, you can use the 

Map Control feature that enables you to zoom into the map and view a specific area of interest in detail. 

 

Procedure 

1. Press the TRACE/DISPLAY hard key. 

2. Press the Map Control soft key. This key is active only when you have loaded a sizable map. 

3. Do one of the following: 

–  To zoom into an area of interest directly, complete the following steps: 

a. Toggle the Zoom to soft key and select Area. 

The black rectangle appears on the map. 

b. Press the Zoom In and Zoom Out soft keys, as you need, to decrease and increase 

the selected area. 

c. Move the rectangle by using the four arrow keys, as you need, to place it in a specific 
area of interest. 

d. Press the center of the rotary knob to zoom into the selected area. You can also press 
the Zoom to soft key again to zoom into the selected area. 

–  To zoom into the center or zoom out from the center, complete the following steps: 

a. Toggle the Zoom to soft key and select Center. 

b. Press the Zoom In and Zoom Out soft keys, as you need, to zoom in and zoom out. 

c. Move the zoomed-in area by using the four arrow keys, as you need. 

 

Loading and displaying raster data 

If you have a set of raster data files generated through the ariesoGEO application, you can load and 

overlay the data on your base map to help you check the signal quality and the strength of 

interferences while driving toward the area of interest. 

 

Procedure 

1. Copy a set of raster data files into your USB memory drive, including the following: 
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–  ASCII: .tab, .asc, and .clr files 

–  BIL: .tab,.hdr, .bil, and .clr files 

 

NOTE 
The .tab file type is a geospatial vector data format used in many geographic 

information systems. The color file (.clr) is an optional file, but the image will be 

displayed as a grayscale image without it. The size of the raster map must be  
1024 x 1024 or smaller. 

2. Plug in the USB memory drive to your instrument. 

3. Press the TRACE/DISPLAY hard key. 

4. Press the Load Raster Map soft key. 

The file explorer window appears. 

5. Navigate to the raster file (.tab) you want to open, and then press the Load soft key. 

The raster image appears on top of your base map as shown in Figure 78. 

 

NOTE 

If the area of the loaded raster data is not within the boundary of the base map, you will 
not see the raster image on the screen. 

6. To select the display option, complete the following steps: 

a. Press the Display Options soft key. 

b. Select the option you desire from the choices: On, Off, and Blink. 

7. To adjust the transparency level of the image, complete the following steps: 

a. Press the Transparency soft key. 

b. Enter a value between 0 for opaque and 100 for clear. 

c. Press the Enter soft key. 

 

Figure 78 Raster image overlaid on the route map in WCDMA/HSPA+ OTA signal analyzer 
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Using LTE - FDD Signal Analyzer 

This chapter provides instructions for using the LTE - FDD Signal Analyzer (option 028) and LTE-

Advanced FDD Analyzer (option 030) with the LTE - FDD OTA Analyzer (option 048), LTE-FDD 256 

QAM Demodulator (option 032), and the LTE-FDD RAN Performance Indicator (option 014). Topics 

discussed in this chapter are as follows: 

 

 Introduction .............................................................................................................................. 199 

 Display overview ...................................................................................................................... 200 

 Connecting a cable .................................................................................................................. 200 

 Selecting measurement mode ................................................................................................. 202 

 Configuring test parameters .................................................................................................... 202 

 Conducting spectrum measurements ...................................................................................... 207 

 Conducting RF measurements ................................................................................................ 209 

 Conducting power vs. time (frame) measurements ................................................................. 217 

 Conducting modulation measurements ................................................................................... 218 

 Performing auto measurements .............................................................................................. 238 

 Performing power statistics CCDF measurements ................................................................. 245 

 Performing carrier aggregation measurements ....................................................................... 246 

 Conducting LTE - FDD OTA measurements ............................................................................ 249 

 Performing RAN performance testing ..................................................................................... 263 
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Introduction 

The LTE (Long-Term Evolution) Signal Analyzer of the JD780A series performs power and spectrum 

measurements as well as modulation analysis to test the proper transmitter performance of FDD LTE 

systems. It performs conformance testing according to the following standards providing a simple 

Pass/Fail indication on each test. 

 

 3GPP TS 36.104. Evolved Universal Terrestrial Radio Access (E-UTRA); Base Station (BS) 

Radio Transmission and Reception 

 3GPP TS 36.141. Evolved Universal Terrestrial Radio Access (E-UTRA); Base Station (BS) 

Conformance Testing 

 3GPP TS 36.211. Evolved Universal Terrestrial Radio Access (E-UTRA); Physical Channels 

and Modulation 

 3GPP TS 36.212. Evolved Universal Terrestrial Radio Access (E-UTRA); Multiplexing and 

Channel Coding 

 3GPP TS 36.213 V8.2.0. Evolved Universal Terrestrial Radio Access (E-UTRA); Physical 

Layer Procedures 

 

This instrument provides the following measurement tools for FDD LTE system: 

 

 Spectrum Analysis 

 RF Analysis 

- Channel Power 

- Occupied Bandwidth 

- Spectrum Emission Mask 

- Adjacent Channel Leakage power Ratio (ACLR) 

- Multi-ACLR 

- Spurious Emissions 

 Power vs. Time (Frame) 

 Modulation Analysis 

- Constellation 

- Data Channel 

- Control Channel 

- Subframe 

- Frame 

- Time Alignment Error 

- Data Allocation Map 

 Auto Measure: 

- Conformance Test 

- Maintenance Test 

- Signal Performance Test 

- DAS Test 
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 Power Statistics CCDF 

 Carrier Aggregation 

 Over The Air (OTA) 

- Channel Scanner 

- ID Scanner 

- Multipath Profile 

- Control Channel 

- Datagram 

- Route Map 

 RAN Performance Indicator 

 

Display overview 

Figure 79 provides descriptions for each segment of the measurement screen. 

 

Figure 79 LTE - FDD signal analyzer measurement screen 

 

 

Connecting a cable 

Direct connection 

Procedure 

1. Connect the Spectrum Analyzer RF In port of the JD780A series and the Power amplifier output 

port of BTS. 
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Figure 80 Direct connection 

 
JD785A/JD786A 

 
JD788A 

 

Indirect connection 

Procedure 

1. Connect the Spectrum Analyzer RF In port of the JD780A series and the monitor (test) port of 

BTS. 

 

Figure 81 Indirect connection 

 
JD785A/JD786A 

 
JD788A 

 

 

CAUTION 
The maximum power for the Spectrum Analyzer RF In port is +25 dBm (0.316 W). If the 
input signal level to be measured is greater than +25 dBm, use a High Power 
Attenuator to prevent damage when you directly connect the signal to the instrument or 
connect the signal from the coupling port of a directional coupler. 

 

Over the air (OTA) 

Procedure 

1. Connect an Omni/directional RF antenna to the Spectrum Analyzer RF In port of the JD780A 

series. 

2. Connect a GPS antenna to the GPS port of the JD780A series. 
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Figure 82 OTA connection 

 
JD785A/JD786A 

 
JD788A 

 

 

CAUTION 

If the input signal level to be measured is less than 0 dBm, set 0 dB attenuation or turn on 
the preamp to have better dynamic range for the OTA testing. 

 

Selecting measurement mode 

Procedure 

1. Press the MODE hard key. 

2. Press the Signal Analyzer soft key. 

3. Press the LTE - FDD soft key. The Spectrum mode is set by default. 

4. Press the MEASURE hot key, and then select the measurement mode option from the following 
choices: 

–  Spectrum 

–  RF Analysis > Channel Power, Occupied BW, Spectrum Emission Mask, ACLR,  
Multi-ACLR, or Spurious Emissions 

–  Power vs Time (Frame) 

–  Modulation Analysis > Constellation, Data Channel, Control Channel, Subframe, Frame,  
Time Alignement Error, or Data Allocation Map 

–  Auto Measure > Conformance Test, Maintenance Test, Signal Perfomance, or DAS Test 

–  Power Statistics CCDF 

–  More (1/2) > Carrier Aggregation 

–  More (1/2) > OTA > Channel Scanner, ID Scanner, Multipath Profile, Control Channel, 
Datagram, or Route Map 

–  More (1/2) > RAN Performance Indicator 

 

 

NOTE 
The Carrier Aggregation soft key is activated if the license for the option 030 LTE-
Advanced FDD is installed and so does the RAN Performance Indicator for the option 

014 LTE-FDD RAN Performance Indicator. 
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Configuring test parameters 

Setting frequency 

You can set the frequency with either frequency or channel number. If a frequency to be set matches 

to the frequency corresponding to the selected channel standard, the instrument calculates its channel 

number and updates the screen with it automatically. 

 

Procedure 

To set the center frequency: 

1. Press the FREQ/DIST hard key. 

2. Toggle the Unit soft key and select Freq. 

3. Press the Center Frequency soft key. 

4. Enter a value by using the numeric keys. You can also use the rotary knob. 

5. Select the unit: GHz, MHz, kHz, or Hz. 

6. Optional. To define the amount of frequency increment for the rotary knob, complete the following 
steps: 

a. Press the Frequency Step soft key. 

b. Enter a value by using the numeric keys. You can also use the rotary knob. 

c. Press the unit: GHz, MHz, kHz, or Hz. 
 
To set the channel number: 

1. Press the FREQ/DIST hard key. 

2. Toggle the Unit soft key and select Channel. 

 

 

NOTE 
Selecting Channel sets the standard channel to Band Global automatically so that you 
can set the Channel Number without choosing a standard channel band from the list. 

3. Press the Channel Number soft key. 

4. Enter a value by using the numeric keys. You can also use the rotary knob. 

5. Press the Enter soft key. 

The instrument automatically displays the corresponding center frequency value for the selected 
channel number. 

6. Optional. To define the amount of channel increment for the rotary knob, complete the following 
steps: 

a. Press the Channel Step soft key. 

b. Enter a value by using the numeric keys. You can also use the rotary knob. 

c. Press the Enter soft key. 

 

 

NOTE 

This frequency setting is not used in the Multi-ACLR and Spurious Emissions modes. 

 

Setting amplitude 

Reference level and attenuation 

You can set the reference and attenuation levels automatically or manually to optimize the display of 

the traces measured, as you desire. 
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Procedure 

To automatically set the reference and attenuation level: 

1. Press the AMP/SCALE hard key. 

2. Press the Auto Scale soft key. 

Each time you press this key, both of the Y-axis scale and input attenuation level change to be 
optimized with some margin. 

 
To set the reference or attenuation level manually: 

1. Press the AMP/SCALE hard key. 

2. To set the maximum reference value on the Y-axis manually, complete the following steps: 

a. Press the Reference Level soft key. 

b. Enter a value by using the numeric keys or the rotary knob with 10 dB increments. 

c. Press the dBm soft key or the ENTER hard key. 

 

 

NOTE 
In the measurements such as Control Channel, Subframe, and Frame, you can select 
the reference option between Relative and Absolute instead. 

3. To set the attenuation option, select one from the following choices: 

–  To set the input attenuator’s level automatically, select Attenuation > Auto. 

 

 

NOTE 
It is recommended that you set the Attenuation to Auto in most situations so that the 

level of the input attenuator can be set automatically according to your input signal level. 

–  To set the input attenuation manually up to 55 dB to optimize S/N, complete the following 
steps: 

a. Select Attenuation > Manual. 

b. Press the Attenuation Value soft key to set the level. 

c. Enter a value between 0 and 55 in fives by using the numeric keys. 

d. Press the dB soft key or the ENTER hard key. 

–  To couple the input attenuator’s level with your reference level setting, select Attenuation > 
Couple. As you increase the reference setting, the attenuation level also increases 

acoordingly. 
 
Optional. To change the scale unit: 

1. Select More (1/2) > Units. 

2. Select the unit of the display scale: dBm, dBV, dBmV, dBµV, V, or W. 

The scale unit on the screen changes accordingly. 

 

 

NOTE 

This Units menu is available in the Spectrum and RF Analysis modes. 
 

 

Scale per division 

You can use the Scale/Div feature available for the spectrum and RF analysis. It represents the value 

of one division on the horizontal scale. The default setting is 10 dB per division and the maximum 

value can be set up to 20 dB. 

 

Procedure 

To set the scale per division: 
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1. Press the AMP/SCALE hard key. 

2. Select More (1/2) > Scale/Div. 

3. Enter a value between 1 and 20 by using the numeric keys. 

4. Press the dB soft key to complete the entry. 

 

Pre-amplifier 

You can turn the internal pre-amplifier on to correct and compensate for the gain of the preamp so that 

amplitude readings show the value at the input connector. 

 

Procedure 

1. Press the AMP/SCALE hard key. 

2. Toggle the Preamp soft key and select On or Off as needed. 

 

 

NOTE 

You can turn the Preamp on when the input attenuation range is from 0 dB to 10 dB. If 
the attenuation value is manually set to greater than 10 dB, the instrument will 
automatically turn off the pre-amplifier to display low-level signal properly on the chart. 

 

External offset 

You can turn the External Offset on and manually set the external offset value. An offset consists of a 

cable loss and a user offset and the measurement result shows the value reflecting both offset values. 

When the external offset value is set at 40 dB in the Spectrum mode, the measurement result 

compensates 40 dB at both the Spectrum Analyzer and Signal Analyzer modes 

 

Procedure 

To set the external offset: 

1. Press the AMP/SCALE hard key. 

2. Toggle the External Offset soft key and select On. 

3. Enter a value by using the numeric keys. 

4. Press the dB soft key to complete the entry. 

 
To turn the external offset off: 

1. Press the AMP/SCALE hard key. 

2. Toggle the External Offset soft key and select Off. 

 

Setting average 

You can set the number of measurements to be averaged for the trace presentation. A maximum of 

100 times of averaging can be set. When the averaging reaches to your setting, a new measurement 

value replaces the measurement value in sequence from the earliest. 

 

Procedure 

1. Press the BW/AVG hard key. 

2. Press the Average soft key. 
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3. Enter a value between 1 and 100 as needed by using the numeric keys. 

4. Press the Enter soft key. 

 

Setting sweep mode 

The default setting is Continue to sweep continuously for most on-going measurements. If you want to 

hold the measurement or get a single sweep, you can change the sweep mode. 

 

Procedure 

To select the single sweep mode: 

1. Press the SWEEP hot key. 

2. Toggle the Sweep Mode soft key and select Single. You can also use the HOLD hot key. 

The letter HOLD in red appears and the sweeping is paused. 

3. Optional. Press the Sweep Once soft key to get a new measurement. 
 
To return to the continuous sweep mode: 

1. Toggle the Sweep Mode soft key and select Continue. You can also use the HOLD hot key. 

The letter HOLD in red disappears and the sweeping resumes. 

 

Setting trigger source 

You can set the trigger source option for your measurements. 

Procedure 

1. Press the TRIGGER hot key. 

2. Select the trigger source option from the following choices: Internal, External, or GPS. 

 

Setting external clock 

To enhance the reliability of modulation analysis measurements the JD780A series must be 

synchronized with a base station. When an external clock is not supplied, the instrument works with its 

built-in internal high-accuracy time base and some measurement results may exhibit inaccurate values. 

Therefore, it is highly recommended that you use the same reference clock as the signal source. You 

can use the TRIGGER hot key to set the external clock. 

 

Figure 83 Connection ports for external reference clock 
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Procedure 

1. Connect an external reference or a GPS antenna to the JD780A series. 

2. Press the SYSTEM hot key. 

3. Press the Freq Reference soft key, and then select the reference option: Internal, External 10 
MHz, External 13 MHz, External 15 MHz, or GPS. 

 

Table 13 External reference indicators 

Type Indicator Description 

Internal  (green) The green INT icon indicates that the instrument uses the built-in 

internal time base. 

External  (green) The green EXT icon indicates that an external reference is connected 

and locked and that the instrument uses the same reference clock as 
the signal source. 

External  (red) The red EXT icon indicates that an external reference is connect but not 

locked. 

GPS (green) The green GPS antenna icon indicates that a GPS antenna is 
connected and locked. 

GPS (yellow) The yellow GPS antenna icon indicates that a GPS antenna is 
connected and locking is in progress. 

GPS (grey) The grey GPS antenna icon indicates that a GPS antenna is not 
connected, failed, or unable to be locked. 

 

Conducting spectrum measurements 

Setting measure setup 

After configuring test parameters as described in the “Configuring test parameters” on page 202, you 

can continue your measurement. 
 

Procedure 

1. Press the MEASURE SETUP hot key. 

2. Press the Bandwidth soft key. 

3. Select the nominal channel bandwidth to be measured, from the following choices: 

–  1.4 MHz, 3 MHz, 5 MHz, 10 MHz, 15 MHz, and 20 MHz 

 

Your measurement result is displayed on the screen as like the following example, Figure 84. 
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Figure 84 Spectrum measurement screen with LTE - FDD signal analyzer 

 

 

Setting trace 

You can display up to six traces on the measurement chart simultaneously. 

 

Procedure 

1. Press the TRACE/DISPLAY hard key. 

2. Press the Select Trace soft key, and then select the trace number: T1, T2, T3, T4, T5, or T6. 

The legend shape of the selected trace changes from square to round to indicate that the trace is 
the active one now. 

3. Do one of the following: 
 

To Select Trace Legend 

Clear current data and display with new 
measurements 

Clear Write W 

Display the input signal’s maximum response only 
(unlimited or for a certain amount of time) 

Max Hold M 

Display the input signal’s minimum response only 
(unlimited or for a certain amount of time) 

Min Hold m 

Capture the selected trace and compare traces Capture C 

Load a saved trace More (1/2) > Load L 

Hide the selected trace Trace View > Off F 

Remove all the traces and initialize the trace 
settings 

More (1/2) > Trace 
Clear All 

 

 

 

NOTE 
For the Max Hold and Min Hold, your instrument compares newly acquired data with the 

active trace and displays larger maximum values or smaller minimum values on the 
screen. You can set it to Unlimited to hold and view maximum or minimum data or 

specify a certain amount of time up to 60 seconds by using numeric keys or the rotary 
knob. 
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4. Optional. Press the More (1/2) > Trace Info soft key, and then select the trace number to view 
the trace’s parameter setting information stored at the time of the measurement or None to hide 

the information display. 

5. Optional. If you have the two traces T1 and T2, you can perform trace math. To view the power 
difference between the traces, press the T1 – T2 -> T5 or T2 – T1 -> T6 soft key. 

The result is overlaid on the screen along with the second Y-axis. 

 

Conducting RF measurements 

Channel power 

The Channel Power measurement is a common test used in the wireless industry to measure the total 

transmitted power of a radio within a defined frequency channel. It acquires a number of points 

representing the input signal in the time domain, transforms this information into the frequency domain 

using Fast Fourier Transform (FFT), and then calculates the channel power. The effective resolution 

bandwidth of the frequency domain trace is proportional to the number of points acquired for the FFT. 

 

The channel power measurement identifies the total RF power and power spectral density (PSD) of 

the signal in the LTE channel bandwidth. 

 

Setting measure setup 

After configuring test parameters as described in the “Configuring test parameters” on page 202, you 

can continue your measurement. 

 

Procedure 

1. Press the MEASURE SETUP hot key. 

2. Press the Bandwidth soft key. 

3. Select the nominal channel bandwidth to be measured, from the following choices: 

–  1.4 MHz, 3 MHz, 5 MHz, 10 MHz, 15 MHz, and 20 MHz 
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Measurement example 

Figure 85 Channel power measurement with LTE - FDD signal analyzer 

 

 

 

NOTE 
You can use the LIMIT hot key to analyze your measurements with the user-definable 
limit and Pass/Fail indication. See “Setting limit for RF tests” on page 216 for more 
information. 

 

Occupied bandwidth 

The Occupied Bandwidth measures the spectrum shape of the carrier. It is defined as the bandwidth, 

which includes 99% of the transmitted power among total transmitted power. 

 

Setting measure setup 

After configuring test parameters as described in the “Configuring test parameters” on page 202, you 

can continue your measurement. 

 

Procedure 

1. Press the MEASURE SETUP hot key. 

2. Press the Bandwidth soft key. 

3. Select the nominal channel bandwidth to be measured, from the following choices: 

–  1.4 MHz, 3 MHz, 5 MHz, 10 MHz, 15 MHz, and 20 MHz 
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Measurement example 

Figure 86 Occupied bandwidth measurement with LTE - FDD signal analyzer 

 

 

 

NOTE 
You can use the LIMIT hot key to analyze your measurements with the user-definable 
limit and Pass/Fail indication. See “Setting limit for RF tests” on page 216 for more 
information. 

 

Spectrum emission mask (SEM) 

The Spectrum Emission Mask (SEM) measurement required by 3GPP specifications encompasses 

different power limits and different measurement bandwidths (resolution bandwidths) at various 

frequency offsets. It may be expressed as a ratio of power spectral densities between the carrier and 

the specified offset frequency band. It provides useful figures-of-merit for the spectral re-growth and 

emissions produced by components and circuit blocks, without the rigor of performing a full SEM 

measurement. 

 

The SEM measures spurious signal levels in up to five pairs of offset or region frequencies and relates 

them to the carrier power. 

 

Setting measure setup 

After configuring test parameters as described in the “Configuring test parameters” on page 202, you 

can continue your measurement. 

 

Procedure 

1. Press the MEASURE SETUP hot key. 

2. To set the nominal channel bandwidth to be measured, complete the following steps: 

a. Press the Bandwidth soft key. 

b. Select the bandwidth option: 1.4 MHz, 3 MHz, 5 MHz, 10 MHz, 15 MHz, or 20 MHz. 

3. To select the mask type, complete the following steps: 

a. Press the Mask Type soft key. 
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b. Select the mask type option, from the following choices: 

–  Wide Area BS Category A 

–  Wide Area BS Category B 

–  Local Area BS 

–  Home BS 

 

Measurement example 

Figure 87 SEM measurement with LTE - FDD signal analyzer 

 

 

 

NOTE 
You can use the LIMIT hot key to analyze your measurements with the user-definable 
limit and Pass/Fail indication. See “Setting limit for RF tests” on page 216 for more 
information. 

 

ACLR 

The Adjacent Channel Leakage power Ratio (ACLR) measures the amount of interference or power in 

an adjacent frequency channel according to the standards. 

 

Setting measure setup 

After configuring test parameters as described in the “Configuring test parameters” on page 202, you 

can continue your measurement. 

 

Procedure 

1. Press the MEASURE SETUP hot key. 

2. Press the Bandwidth soft key. 

3. Select the nominal channel bandwidth to be measured, from the following choices: 

–  1.4 MHz, 3 MHz, 5 MHz, 10 MHz, 15 MHz, and 20 MHz 
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Measurement example 

Figure 88 ACLR measurement with LTE - FDD signal analyzer 

 

 

 

NOTE 
You can use the LIMIT hot key to analyze your measurements with the user-definable 

limit and Pass/Fail indication. See “Setting limit for RF tests” on page 216 for more 
information. 

 

Multi-ACLR 

The Multi-ACLR measurement is used to perform multi-channel ACLR measurements with as many 

channels as possible. It helps you to measure ACLR in multi-channel transmitting Base Station 

environment. 

 

Setting measure setup 

After configuring test parameters as described in the “Configuring test parameters” on page 202, you 

can continue your measurement. 

 

Procedure 

1. Press the MEASURE SETUP hot key. 

2. To set the nominal channel bandwidth to be measured, complete the following steps: 

a. Press the Bandwidth soft key. 

b. Select the bandwidth option: 1.4 MHz, 3 MHz, 5 MHz, 10 MHz, 15 MHz, or 20 MHz. 

3. To set the frequency, do one of the following: 

–  To set the center frequency, complete the following steps: 

a. Toggle the Unit soft key and select Freq. 

b. Press the Lowest Frequency soft key to set the starting center frequency. 

c. Enter a value by using the numeric keys. You can also use the rotary knob. 

d. Select the unit: GHz, MHz, kHz, or Hz. 

e. Press the Highest Frequency soft key to set the stopping center frequency. 
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f. Enter a value by using the numeric keys. You can also use the rotary knob. 

g. Select the unit: GHz, MHz, kHz, or Hz. 

–  To set the channel number, complete the following steps: 

a. Toggle the Unit soft key and select Channel. 

 

 

NOTE 
Selecting Channel sets the standard channel to Band Global automatically so that you 
can set the Channel Number without choosing a standard channel band from the list. 

b. Press the Lowest Channel soft key to set the starting channel. 

c. Enter a value by using the numeric keys. You can also use the rotary knob. 

d. Press the Enter soft key. 

e. Press the Highest Channel soft key to set the stopping channel. 

f. Enter a value by using the numeric keys. You can also use the rotary knob. 

g. Press the Enter soft key. 

 

Measurement example 

Figure 89 Multi-ACLR measurement with LTE - FDD signal analyzer 

 

 

 

NOTE 
You can use the LIMIT hot key to analyze your measurements with the user-definable 
limit and Pass/Fail indication. See “Setting limit for RF tests” on page 216 for more 
information. 

 

Spurious emissions 

Out-of-band emissions are unwanted emissions immediately outside the channel bandwidth resulting 

from the modulation process and non-linearity in the transmitter but excluding spurious emissions. The 

Spurious Emissions measurement is to identify and determine the power level of out-of-band spurious 

emission within the necessary channel bandwidth and modulated signal measured at the RF port of 

the Base Station. 
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Setting measure setup 

After configuring test parameters as described in the “Configuring test parameters” on page 202, you 

can continue your measurement. 

 

Procedure 

1. Press the MEASURE SETUP hot key. 

2. To set up the range table and parameters, press the Range Table soft key and then complete 

the following steps: 

a. Press the Range soft key, and then select the range number between 1 and 20 to add  

as a new or change the existing settings. 

b. Do the following as desired: 

–  Select Start Frequency, and then specify the start frequency for the selected range. 

–  Select Stop Frequency, and then specify the stop frequency for the selected range. 

–  Select Start Limit, and then specify the lower limit for Pass/Fail indication. 

–  Select Stop Limit, and then specify the upper limit for Pass/Fail indication. 

–  Select More (1/2) > Attenuation, and then specify an value in the multiple of five. 

–  Select More (1/2) > RBW, and then specify a RBW value. 

–  Select More (1/2) > VBW, and then specify a VBW value. 

c. Press the PREV hard key. 

d. Toggle the Range soft key and select On to display the selected range in the result table or 

Off to hide it from the table. 

3. Toggle the Measure Type soft key between Examine and Full to select the measurement type. 

 

NOTE 
The Examine mode displays only the selected range while the Full mode lets the 

instrument automatically changes the selected range from one another. 

4. To set the number of measurements to be averaged, complete the following steps: 

a. Press the Average soft key. 

b. Enter a value between 1 and 100. 

c. Press the Enter soft key. 

5. To move the highlighted bar in the result table to other range, complete the following steps: 

a. Press the Range soft key in the Measure Setup menu bar. 

b. Enter a value between 1 and 20. 

c. Press the Enter soft key. 
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Measurement example 

Figure 90 Spurious emissions measurement with LTE - FDD signal analyzer 

 

 

 

NOTE 
You can use the LIMIT hot key to analyze your measurements with the user-definable 
limit and Pass/Fail indication. See “Setting limit for RF tests” on page 216 for more 
information. 

 

Setting limit for RF tests 

By default, test limits specified in the standard are set for you. You can change thresholds if you desire. 

 

Procedure 

1. Press the LIMIT hot key. 

2. Press the RF Test Limits soft key. 

3. Select the test item(s) and set the limit(s) depending on your selected measurement mode: 
 

To set the limit for Select Set 

Channel power Channel Power High Limit 
Low Limit 

Occupied bandwidth Occupied BW High Limit 

Spectrum emission mask Spectrum Emission Mask (On/Off only) 

ACLR ACLR (On/Off only) 

Multi-ACLR Multi-ACLR (On/Off only) 

Spurious emissions Spurious Emissions (On/Off only) 

4. Optional. You can enable alarm sound that goes off if the measurement falls outside of the limit. 
Toggle the Beep soft key between On and Off to enable or disable the beep sound. 

5. Optional. Go to SAVE/LOAD > Save, and then select Save Limit to save the limit settings. 

See “Using save” on page 33 for more information. 
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Conducting power vs. time (frame) measurements 

The Power vs. Time (Frame) measures the modulation envelope in the time domain, showing the 

power of each time slot in an LTE signal. 

 

Setting measure setup 

After configuring test parameters as described in the “Configuring test parameters” on page 202, you 

can continue your measurement. The measurement settings can be saved and recalled as a file. 

 

Procedure 

1. Press the MEASURE SETUP hot key. 

2. To set the nominal channel bandwidth to be measured, complete the following steps: 

a. Press the Bandwidth soft key. 

b. Select the bandwidth option: 1.4 MHz, 3 MHz, 5 MHz, 10 MHz, 15 MHz, or 20 MHz. 

3. To select the subframe number to be measured, complete the following steps: 

a. Press the Subframe No soft key. 

b. Enter a value by using the numeric keys. You can also use the rotary knob. 

c. Press the Enter soft key. 

4. Toggle the Cell ID soft key and select Auto or Manual as desired: 

–  Auto: to let the instrument detect the Cell ID for the LTE signal automatically. 

–  Manual: to set a specific Cell ID for the LTE signal manually in order to speed up the 

synchronization with a BTS. 

5. Optional. Press the Miscellaneous soft key, and then do the following(s) as needed: 

–  To select the number of antenna ports, toggle the MIMO soft key and select 2x2 or 4x4. 

This MIMO (Multiple Input Multiple Output) setting is activated only if the option 030 LTE-
Advanced FDD is installed with a license number. If not, the instrument sets this option to 
2x2 by default. A 2x1 or 4x1 RF combiner is also required to able to test on MIMO 
channels. 

–  To assign a antenna port number automatically or manually, press the Antenna Port soft 
key and select the option: Auto, 0, 1, 2, and 3. If the option 030 LTE-Advanced FDD is not 

installed or if the MIMO is set to 2x2, the antenna ports 2 and 3 are disabled. 

–  To select the cyclic prefix, toggle the Cyclic Prefix soft key and select Normal or 
Extended. See “Appendix E – Cyclic prefix table” on page 592 for OFDM parameter details 

by different bandwidth. 
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Measurement example 

Figure 91 Power vs. time (frame) measurement with LTE – FDD signal analyzer 

 

 

Conducting modulation measurements 

Constellation 

The Constellation is used to observe some aspects of modulation accuracy and can reveal certain 

fault mechanisms such as I/Q amplitude imbalance or quadrature imbalance. It displays constellation 

diagram by modulation types. 

 

Setting measure setup 

After configuring test parameters as described in the “Configuring test parameters” on page 202, you 

can continue your measurement. The measurement settings can be saved and recalled as a file. 

 

Procedure 

1. Press the MEASURE SETUP hot key. 

2. To set the nominal channel bandwidth to be measured, complete the following steps: 

a. Press the Bandwidth soft key. 

b. Select the bandwidth option: 1.4 MHz, 3 MHz, 5 MHz, 10 MHz, 15 MHz, or 20 MHz. 

3. To select the subframe number to be measured, complete the following steps: 

a. Press the Subframe No soft key. 

b. Enter a value by using the numeric keys. You can also use the rotary knob. 
 

 

NOTE 

For MBMS testing, this subframe number must be neither 0 nor 5 as these subframes 0 
and 5 are not available for MBMS and it must be set to the MBMS transmitted channel’s 
subframe number. 

c. Press the Enter soft key. 

4. Optional. Toggle the Cell ID soft key and select Auto or Manual as desired: 
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–  Auto: to let the instrument detect the Cell ID for the LTE signal automatically. 

–  Manual: to set a specific Cell ID for the LTE signal manually in order to speed up the 

synchronization with a BTS. 

5. Optional. Toggle the CFI soft key and select Auto or Manual as desired: 

–  Auto: to let the instrument set the number of OFDM symbols used for transmitting PDCCHs 

in a subframe. 

–  Manual: to set the number of OFDM symbols manually. The set of OFDM symbols that can 
be used for PDCCH in a subframe is given by 0, 2, 3 or 4 in 1.4 MHz bandwidth and 1, 2, or 
3 in other bandwidths. 

6. Optional. Press the PHICH Ng soft key, and then select the option for the number of PHICH 
groups (Ng): 1/6, 1/2, 1, 2, E-1/6, E-1/2, E-1, or E-2. 

7. Optional. Press the Miscellaneous soft key, and then do the following(s) as needed: 

–  To select the number of antenna ports, toggle the MIMO soft key and select 2x2 or 4x4. 

This MIMO (Multiple Input Multiple Output) setting is activated only if the option 030 LTE-
Advanced FDD is installed with a license number. If not, the instrument sets this option to 
2x2 by default. A 2x1 or 4x1 RF combiner is also required to able to test on MIMO 
channels. 

–  To assign a antenna port number automatically or manually, press the Antenna Port soft 
key and select the option: Auto, 0, 1, 2, and 3. If the option 030 LTE-Advanced FDD is not 

installed or if the MIMO is set to 2x2, the antenna ports 2 and 3 are disabled. 

–  To turn the Multimedia Broadcast Multicast Service (MBMS) feature on or off, toggle the 
MBMS soft key and select On or Off. For proper MBMS testing, you need to set the 
Subframe No with the same PMCH subframe number. If this setting is on, either PMCH or 

PDSCH appears on the screen depending on the detected channel. 

–  To set the Multicast Broadcast Single Frequency Network (MBSFN) detection automatically 
or manually for MBMS testing, toggle the MBSFN soft key and select Auto or Manual. An 

automatically detected or manually entered MBSFN ID appears on the screen. 

–  To select the cyclic prefix, toggle the Cyclic Prefix soft key and select Normal or 
Extended. See “Appendix E – Cyclic prefix table” on page 592 for OFDM parameter details 

by different bandwidth. 

–  Press the PDSCH Modulation Type soft key, and then select the modulation type option: 
Auto, QPSK, 16 QAM, 64 QAM, E-TM3.3, E-TM3.2, E-TM3.1, E-TM2, E-TM1.2, and E-
TM1.1. If two or more modulation types are used in a frame, select Auto. If the PDSCH 

uses the same modulation type in a frame or in a subframe, select a specific modulation 
type to get more accurate EVM. 

 

NOTE 
If you have installed a license for the option 032 LTE-FDD 256 QAM Demodulator on 
your CellAdvisor, you will have additional PDSCH modulation types of 256 QAM,  
E-TM3.1a, and E-TM2a. 

–  To set the threshold for PDSCH, complete the following steps: 

a. Press the PDSCH Threshold soft key. 

b. Enter a value by using the numeric keys. 

c. Press the dB soft key. 

–  Toggle the PDSCH Precoding soft key between On and Off to enable or disable the 

PDSCH precoding. 
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Measurement example 

Figure 92 Constellation measurement with LTE - FDD signal analyzer 

 

 

Figure 93 Constellation measurement with LTE - FDD signal analyzer (MBMS On) 

 

 

 

NOTE 
You can use the LIMIT hot key to analyze your measurements with the user-definable 

limit and Pass/Fail indication. See “Setting limit for modulation tests” on page 237 for 
more information. 

 

Data channel 

The Data Channel measures the constellation for the specified resource block as well as the 

modulation accuracy of each PDSCH at the specified subframe. 

 

Setting measure setup 

After configuring test parameters as described in the “Configuring test parameters” on page 202, you 
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can continue your measurement. The measurement settings can be saved and recalled as a file. 

 

Procedure 

1. Press the MEASURE SETUP hot key. 

2. To set the nominal channel bandwidth to be measured, complete the following steps: 

a. Press the Bandwidth soft key. 

b. Select the bandwidth option: 1.4 MHz, 3 MHz, 5 MHz, 10 MHz, 15 MHz, or 20 MHz. 

3. To select the subframe number to be measured, complete the following steps: 

a. Press the Subframe No soft key. 

b. Enter a value by using the numeric keys. You can also use the rotary knob. 
 

 

NOTE 

For MBMS testing, this subframe number must be neither 0 nor 5 as these subframes 0 
and 5 are not available for MBMS and it must be set to the MBMS transmitted channel’s 
subframe number. 

c. Press the Enter soft key. 

4. Optional. Toggle the Cell ID soft key and select Auto or Manual as desired: 

–  Auto: to let the instrument detect the Cell ID for the LTE signal automatically. 

–  Manual: to set a specific Cell ID for the LTE signal manually in order to speed up the 

synchronization with a BTS. 

5. Optional. Toggle the CFI soft key and select Auto or Manual as desired: 

–  Auto: to let the instrument set the number of OFDM symbols used for transmitting PDCCHs 

in a subframe. 

–  Manual: to set the number of OFDM symbols manually. The set of OFDM symbols that can 
be used for PDCCH in a subframe is given by 0, 2, 3 or 4 in 1.4 MHz bandwidth and 1, 2, or 
3 in other bandwidths. 

6. Optional. Press the PHICH Ng soft key, and then select the option for the number of PHICH 
groups (Ng): 1/6, 1/2, 1, 2, E-1/6, E-1/2, E-1, or E-2. 

7. Toggle the Event Hold soft key between On and Off to enable or disable the event hold feature. 

When enabled, the display line for the PDSCH threshold appears. 
When an event occurs, the measurement is put on hold until you press the HOLD hot key. 

8. Optional. Press the Miscellaneous soft key, and then do the following(s) as needed: 

–  To select the number of antenna ports, toggle the MIMO soft key and select 2x2 or 4x4. 

This MIMO (Multiple Input Multiple Output) setting is activated only if the option 030 LTE-
Advanced FDD is installed with a license number. If not, the instrument sets this option to 
2x2 by default. A 2x1 or 4x1 RF combiner is also required to able to test on MIMO 
channels. 

–  To assign a antenna port number automatically or manually, press the Antenna Port soft 
key and select the option: Auto, 0, 1, 2, and 3. If the option 030 LTE-Advanced FDD is not 

installed or if the MIMO is set to 2x2, the antenna ports 2 and 3 are disabled. 

–  To turn the Multimedia Broadcast Multicast Service (MBMS) feature on or off, toggle the 
MBMS soft key and select On or Off. For proper MBMS testing, you need to set the 
Subframe No with the same PMCH subframe number. If this setting is on, either PMCH or 

PDSCH appears on the screen depending on the detected channel. 

–  To set the Multicast Broadcast Single Frequency Network (MBSFN) detection automatically 
or manually for MBMS testing, toggle the MBSFN soft key and select Auto or Manual. An 

automatically detected or manually entered MBSFN ID appears on the screen. 

–  To select the cyclic prefix, toggle the Cyclic Prefix soft key and select Normal or 
Extended. See “Appendix E – Cyclic prefix table” on page 592 for OFDM parameter details 

by different bandwidth. 
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–  Press the PDSCH Modulation Type soft key, and then select the modulation type option: 
Auto, QPSK, 16 QAM, 64 QAM, E-TM3.3, E-TM3.2, E-TM3.1, E-TM2, E-TM1.2, and E-
TM1.1. If two or more modulation types are used in a frame, select Auto. If the PDSCH 

uses the same modulation type in a frame or in a subframe, select a specific modulation 
type to get more accurate EVM. 

 

NOTE 
If you have installed a license for the option 032 LTE-FDD 256 QAM Demodulator on 
your CellAdvisor, you will have additional PDSCH modulation types of 256 QAM,  
E-TM3.1a, and E-TM2a. 

–  To set the threshold for PDSCH, complete the following steps: 

a. Press the PDSCH Threshold soft key. 

a. Enter a value by using the numeric keys, and then press the dB soft key. 

–  Toggle the PDSCH Precoding soft key between On and Off to enable or disable the 

PDSCH precoding. 

 

Measurement example 

Figure 94 Data channel measurement with LTE - FDD signal analyzer 

 

 



JD780A Series Analyzers 

 Using LTE - FDD Signal Analyzer 223 

Figure 95 Data channel measurement with LTE - FDD signal analyzer (MBMS On) 

 

 

 

NOTE 

You can use the LIMIT hot key to analyze your measurements with the user-definable 
limit and Pass/Fail indication. See “Setting limit for modulation tests” on page 237 for 
more information. 

 

Using marker 

You can use the MARKER hard key to place a marker on a resource block and display the IQ diagram 

for the selected resource block. 

 

Procedure 

1. Press the MARKER hard key. 

2. Press the RB Number soft key to select the resource block to be marked. 

3. Enter the resource block number by using the numeric keys. 

4. Press the Enter soft key. 

The marker appears on the selected resource block. 

5. Toggle the Marker View soft key between On and Off to display or dismiss the result of the 

selected resource block. 

 

Control channel 

The Control Channel measures the constellation for the specified control channel as well as 

modulation accuracy of the control channel at the specified subframe. 

 

Setting measure setup 

After configuring test parameters as described in the “Configuring test parameters” on page 202, you 

can continue your measurement. The measurement settings can be saved and recalled as a file. 

 

Procedure 
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1. Press the MEASURE SETUP hot key. 

2. To set the nominal channel bandwidth to be measured, complete the following steps: 

a. Press the Bandwidth soft key. 

b. Select the bandwidth option: 1.4 MHz, 3 MHz, 5 MHz, 10 MHz, 15 MHz, or 20 MHz. 

3. To select the subframe number to be measured, complete the following steps: 

a. Press the Subframe No soft key. 

b. Enter a value by using the numeric keys. You can also use the rotary knob. 
 

 

NOTE 

For MBMS testing, this subframe number must be neither 0 nor 5 as these subframes 0 
and 5 are not available for MBMS and it must be set to the MBMS transmitted channel’s 
subframe number. 

c. Press the Enter soft key. 

4. Optional. Toggle the Cell ID soft key and select Auto or Manual as desired: 

–  Auto: to let the instrument detect the Cell ID for the LTE signal automatically. 

–  Manual: to set a specific Cell ID for the LTE signal manually in order to speed up the 

synchronization with a BTS. 

5. Optional. Toggle the CFI soft key and select Auto or Manual as desired: 

–  Auto: to let the instrument set the number of OFDM symbols used for transmitting PDCCHs 

in a subframe. 

–  Manual: to set the number of OFDM symbols manually. The set of OFDM symbols that can 
be used for PDCCH in a subframe is given by 0, 2, 3 or 4 in 1.4 MHz bandwidth and 1, 2, or 
3 in other bandwidths. 

6. Optional. Press the PHICH Ng soft key, and then select the option for the number of PHICH 
groups (Ng): 1/6, 1/2, 1, 2, E-1/6, E-1/2, E-1, or E-2. 

7. Toggle the EVM Detection Mode soft key and select Single or Combine as desired: 

–  Single: Testing on one single antenna connected to your JD780A series with a cable. 

–  Combine: Testing on multiple antennas connected to your JD780A series with a 2x1 or 4x1 

combiner or an antenna. 

8. Optional. Press the Miscellaneous soft key, and then do the following(s) as needed: 

–  To select the number of antenna ports, toggle the MIMO soft key and select 2x2 or 4x4. 

This MIMO (Multiple Input Multiple Output) setting is activated only if the option 030 LTE-
Advanced FDD is installed with a license number. If not, the instrument sets this option to 
2x2 by default. A 2x1 or 4x1 RF combiner is also required to able to test on MIMO 
channels. 

–  To assign a antenna port number automatically or manually, press the Antenna Port soft 
key and select the option: Auto, 0, 1, 2, and 3. If the option 030 LTE-Advanced FDD is not 

installed or if the MIMO is set to 2x2, the antenna ports 2 and 3 are disabled. 

–  To turn the Multimedia Broadcast Multicast Service (MBMS) feature on or off, toggle the 
MBMS soft key and select On or Off. For proper MBMS testing, you need to set the 
Subframe No with the same PMCH subframe number. If this setting is on, the 

measurement item “MBSFN RS” appears in the result table. 

–  To set the Multicast Broadcast Single Frequency Network (MBSFN) detection automatically 
or manually for MBMS testing, toggle the MBSFN soft key and select Auto or Manual. An 

automatically detected or manually entered MBSFN ID appears on the screen. 

–  To select the cyclic prefix, toggle the Cyclic Prefix soft key and select Normal or 
Extended. See “Appendix E – Cyclic prefix table” on page 592 for OFDM parameter details 

by different bandwidth. 

–  To set the threshold for PDCCH, complete the following steps: 
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a. Press the PDCCH Threshold soft key. 

b. Enter a value by using the numeric keys. 

c. Press the dB soft key. 

–  Toggle the PDCCH Mode soft key and select REG to calculate EVM based on Resource 
Element Group or Avg to calculate EVM after adding up all the PDCCH signals from one 

subframe. 

 

Measurement example 

Figure 96 Control channel measurement with LTE - FDD signal analyzer 

 

 

Figure 97 Control channel measurement with LTE - FDD signal analyzer (MBMS On) 

 

 

 

NOTE 

You can use the LIMIT hot key to analyze your measurements with the user-definable 
limit and Pass/Fail indication. See “Setting limit for modulation tests” on page 237 for 
more information. 
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Using marker 

You can use the MARKER hard key to place a marker on a control channel and display the IQ 

diagram for the selected channel. 
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Procedure 

1. Press the MARKER hard key. 

2. Press the Channel soft key to select the channel to be displayed in the IQ diagram. 

The channel P-SS is selected by default. 

3. Turn the rotary knob to move the highlight from one to another in the channel summary table. 

4. Toggle the Marker View soft key between On and Off to display or dismiss the result of the 

selected channel. 

 

Subframe 

The Subframe measures the modulation accuracy of all the data and control channels at the specified 

subframe (1 ms). 

 

Setting measure setup 

After configuring test parameters as described in the “Configuring test parameters” on page 202, you 

can continue your measurement. The measurement settings can be saved and recalled as a file. 

 

Procedure 

1. Press the MEASURE SETUP hot key. 

2. To set the nominal channel bandwidth to be measured, complete the following steps: 

a. Press the Bandwidth soft key. 

b. Select the bandwidth option: 1.4 MHz, 3 MHz, 5 MHz, 10 MHz, 15 MHz, or 20 MHz. 

3. To select the subframe number to be measured, complete the following steps: 

a. Press the Subframe No soft key. 

b. Enter a value by using the numeric keys. You can also use the rotary knob. 
 

 

NOTE 

For MBMS testing, this subframe number must be neither 0 nor 5 as these subframes 0 
and 5 are not available for MBMS and it must be set to the MBMS transmitted channel’s 
subframe number. 

c. Press the Enter soft key. 

4. Optional. Toggle the Cell ID soft key and select Auto or Manual as desired: 

–  Auto: to let the instrument detect the Cell ID for the LTE signal automatically. 

–  Manual: to set a specific Cell ID for the LTE signal manually in order to speed up the 

synchronization with a BTS. 

5. Optional. Toggle the CFI soft key and select Auto or Manual as desired: 

–  Auto: to let the instrument set the number of OFDM symbols used for transmitting PDCCHs 

in a subframe. 

–  Manual: to set the number of OFDM symbols manually. The set of OFDM symbols that can 
be used for PDCCH in a subframe is given by 0, 2, 3 or 4 in 1.4 MHz bandwidth and 1, 2, or 
3 in other bandwidths. 

6. Optional. Press the PHICH Ng soft key, and then select the option for the number of PHICH 
groups (Ng): 1/6, 1/2, 1, 2, E-1/6, E-1/2, E-1, or E-2. 

7. Toggle the EVM Detection Mode soft key and select Single or Combine as desired: 

–  Single: Testing on one single antenna connected to your JD780A series with a cable. 
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–  Combine: Testing on multiple antennas connected to your JD780A series with a 2x1 or 4x1 

combiner or an antenna. 

8. Optional. Press the Miscellaneous soft key, and then do the following(s) as needed: 

–  To select the number of antenna ports, toggle the MIMO soft key and select 2x2 or 4x4. 

This MIMO (Multiple Input Multiple Output) setting is activated only if the option 030 LTE-
Advanced FDD is installed with a license number. If not, the instrument sets this option to 
2x2 by default. A 2x1 or 4x1 RF combiner is also required to able to test on MIMO 
channels. 

–  To assign a antenna port number automatically or manually, press the Antenna Port soft 
key and select the option: Auto, 0, 1, 2, and 3. If the option 030 LTE-Advanced FDD is not 

installed or if the MIMO is set to 2x2, the antenna ports 2 and 3 are disabled. 

–  To turn the Multimedia Broadcast Multicast Service (MBMS) feature on or off, toggle the 
MBMS soft key and select On or Off. For proper MBMS testing, you need to set the 
Subframe No with the same PMCH subframe number. If this setting is on, the 

measurement item “MBSFN RS” appears in the result table and either PMCH or PDSCH 
appears as well depending on the detected channel. 

–  To set the Multicast Broadcast Single Frequency Network (MBSFN) detection automatically 
or manually for MBMS testing, toggle the MBSFN soft key and select Auto or Manual. An 

automatically detected or manually entered MBSFN ID appears on the screen. 

–  To select the cyclic prefix, toggle the Cyclic Prefix soft key and select Normal or 
Extended. See “Appendix E – Cyclic prefix table” on page 592 for OFDM parameter details 

by different bandwidth. 

–  Press the PDSCH Modulation Type soft key, and then select the modulation type option: 
Auto, QPSK, 16 QAM, 64 QAM, E-TM3.3, E-TM3.2, E-TM3.1, E-TM2, E-TM1.2, and E-
TM1.1. If two or more modulation types are used in a frame, select Auto. If the PDSCH 

uses the same modulation type in a frame or in a subframe, select a specific modulation 
type to get more accurate EVM. 

 

NOTE 
If you have installed a license for the option 032 LTE-FDD 256 QAM Demodulator on 
your CellAdvisor, you will have additional PDSCH modulation types of 256 QAM,  
E-TM3.1a, and E-TM2a. 

–  To set the threshold for PDSCH, complete the following steps: 

a. Press the PDSCH Threshold soft key. 

b. Enter a value by using the numeric keys. 

c. Press the dB soft key. 

–  To set the threshold for PDCCH, complete the following steps: 

a. Press the PDCCH Threshold soft key. 

b. Enter a value by using the numeric keys. 

c. Press the dB soft key. 

–  Toggle the PDCCH Mode soft key and select REG to calculate EVM based on Resource 
Element Group or Avg to calculate EVM after adding up all the PDCCH signals from one 

subframe. 

–  Toggle the PDSCH Precoding soft key between On and Off to enable or disable the 

PDSCH precoding. 
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Measurement example 

Figure 98 Subframe measurement with LTE - FDD signal analyzer 

1) Regular view 

 

2) Chart view 
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Figure 99 Subframe measurement with LTE - FDD signal analyzer (MBMS On) 

 

 

 

NOTE 
You can use the LIMIT hot key to analyze your measurements with the user-definable 
limit and Pass/Fail indication. See “Setting limit for modulation tests” on page 237 for 
more information. 

 

Setting display 

You can use the TRACE/DISPLAY hard key to view the RE and RS power at the symbol. 

 

Procedure 

1. Press the TRACE/DISPLAY hard key. 

2. Toggle the Chart soft key between On and Off to display or dismiss the chart.  
If this setting is on, the MARKER hard key is activated. 

 

Using marker 

If you turn the Chart view on, you can use the MARKER hard key to place the marker at a specific 

symbol. 

 

Procedure 

1. Press the MARKER hard key. 

2. Toggle the Marker View soft key between On and Off to display or dismiss the marker on the 

chart. 

3. Press the Symbol soft key to select the symbol number, to which the marker is placed. 

4. Enter a value by using the numeric keys. 

5. Press the Enter soft key. 

 

Frame 

The Frame measures the modulation accuracy of all the data and control channels at the frame (10 

ms). 
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Setting measure setup 

After configuring test parameters as described in the “Configuring test parameters” on page 202, you 

can continue your measurement. The measurement settings can be saved and recalled as a file. 

 

Procedure 

1. Press the MEASURE SETUP hot key. 

2. To set the nominal channel bandwidth to be measured, complete the following steps: 

a. Press the Bandwidth soft key. 

b. Select the bandwidth option: 1.4 MHz, 3 MHz, 5 MHz, 10 MHz, 15 MHz, or 20 MHz. 

3. Optional. Toggle the Cell ID soft key and select Auto or Manual as desired: 

–  Auto: to let the instrument detect the Cell ID for the LTE signal automatically. 

–  Manual: to set a specific Cell ID for the LTE signal manually in order to speed up the 

synchronization with a BTS. 

4. Optional. Toggle the CFI soft key and select Auto or Manual as desired: 

–  Auto: to let the instrument set the number of OFDM symbols used for transmitting PDCCHs 

in a subframe. 

–  Manual: to set the number of OFDM symbols manually. The set of OFDM symbols that can 
be used for PDCCH in a subframe is given by 0, 2, 3 or 4 in 1.4 MHz bandwidth and 1, 2, or 
3 in other bandwidths. 

5. Optional. Press the PHICH Ng soft key, and then select the option for the number of PHICH 
groups (Ng): 1/6, 1/2, 1, 2, E-1/6, E-1/2, E-1, or E-2. 

6. Toggle the EVM Detection Mode soft key and select Single or Combine as desired: 

–  Single: Testing on one single antenna connected to your JD780A series with a cable. 

–  Combine: Testing on multiple antennas connected to your JD780A series with a 2x1 or 4x1 

combiner or an antenna. 

7. Optional. Press the Miscellaneous soft key, and then do the following(s) as needed: 

–  To select the number of antenna ports, toggle the MIMO soft key and select 2x2 or 4x4. 

This MIMO (Multiple Input Multiple Output) setting is activated only if the option 030 LTE-
Advanced FDD is installed with a license number. If not, the instrument sets this option to 
2x2 by default. A 2x1 or 4x1 RF combiner is also required to able to test on MIMO 
channels. 

–  To assign a antenna port number automatically or manually, press the Antenna Port soft 
key and select the option: Auto, 0, 1, 2, and 3. If the option 030 LTE-Advanced FDD is not 

installed or if the MIMO is set to 2x2, the antenna ports 2 and 3 are disabled. 

–  To turn the Multimedia Broadcast Multicast Service (MBMS) feature on or off, toggle the 
MBMS soft key and select On or Off. If this setting is on, the measurement items MBSFN 

RS, PMCH QPSK, PMCH 16 QAM, and PMCH 64 QAM appear in the result table. 

–  To set the Multicast Broadcast Single Frequency Network (MBSFN) detection automatically 
or manually for MBMS testing, toggle the MBSFN soft key and select Auto or Manual. An 

automatically detected or manually entered MBSFN ID appears on the screen. 

–  To select the cyclic prefix, toggle the Cyclic Prefix soft key and select Normal or 
Extended. See “Appendix E – Cyclic prefix table” on page 592 for OFDM parameter details 

by different bandwidth. 

–  Press the PDSCH Modulation Type soft key, and then select the modulation type option: 
Auto, QPSK, 16 QAM, 64 QAM, E-TM3.3, E-TM3.2, E-TM3.1, E-TM2, E-TM1.2, and E-
TM1.1. If two or more modulation types are used in a frame, select Auto. If the PDSCH 

uses the same modulation type in a frame or in a subframe, select a specific modulation 
type to get more accurate EVM. 
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NOTE 
If you have installed a license for the option 032 LTE-FDD 256 QAM Demodulator on 
your CellAdvisor, you will have additional PDSCH modulation types of 256 QAM,  
E-TM3.1a, and E-TM2a. 

–  To set the threshold for PDSCH, complete the following steps: 

a. Press the PDSCH Threshold soft key. 

b. Enter a value by using the numeric keys. 

c. Press the dB soft key. 

–  To set the threshold for PDCCH, complete the following steps: 

a. Press the PDCCH Threshold soft key. 

b. Enter a value by using the numeric keys. 

c. Press the dB soft key. 

–  Toggle the PDCCH Mode soft key and select REG to calculate EVM based on Resource 
Element Group or Avg to calculate EVM after adding up all the PDCCH signals from one 

subframe. 

–  Toggle the PDSCH Precoding soft key between On and Off to enable or disable the 

PDSCH precoding. 

 

Measurement example 

Figure 100 Frame measurement with LTE - FDD signal analyzer 
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Figure 101 Frame measurement with LTE - FDD signal analyzer (MBMS On) 

 

 

 

NOTE 

You can use the LIMIT hot key to analyze your measurements with the user-definable 
limit and Pass/Fail indication. See “Setting limit for modulation tests” on page 237 for 
more information. 

 

Time alignment error 

In eNode B supporting Tx Diversity transmission, signals are transmitted from two or more antennas. 

These signals shall be aligned. The time alignment error in Tx diversity is specified as the delay 

between the signals from two antennas at the antenna ports. 

 

Setting measure setup 

After configuring test parameters as described in the “Configuring test parameters” on page 202, you 

can continue your measurement. The measurement settings can be saved and recalled as a file. 

 

Procedure 

1. Press the MEASURE SETUP hot key. 

2. To set the nominal channel bandwidth to be measured, complete the following steps: 

a. Press the Bandwidth soft key. 

b. Select the bandwidth option: 1.4 MHz, 3 MHz, 5 MHz, 10 MHz, 15 MHz, or 20 MHz. 

3. Optional. Toggle the Cell ID soft key and select Auto or Manual as desired: 

–  Auto: to let the instrument detect the Cell ID for the LTE signal automatically. 

–  Manual: to set a specific Cell ID for the LTE signal manually in order to speed up the 

synchronization with a BTS. 

4. Optional. Press the Miscellaneous soft key, and then do the following(s) as needed: 

–  To select the number of antenna ports, toggle the MIMO soft key and select 2x2 or 4x4. 

This MIMO (Multiple Input Multiple Output) setting is activated only if the option 030 LTE-
Advanced FDD is installed with a license number. If not, the instrument sets this option to 
2x2 by default. A 2x1 or 4x1 RF combiner is also required to able to test on MIMO 
channels. 
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–  To assign a antenna port number automatically or manually, press the Antenna Port soft 
key and select the option: Auto, 0, 1, 2, and 3. If the option 030 LTE-Advanced FDD is not 

installed or if the MIMO is set to 2x2, the antenna ports 2 and 3 are disabled. 

–  To select the cyclic prefix, toggle the Cyclic Prefix soft key and select Normal or 
Extended. See “Appendix E – Cyclic prefix table” on page 592 for OFDM parameter details 

by different bandwidth. 

 

Measurement example 

Figure 102 Time alignment error measurement with LTE - FDD signal analyzer 

 

 

 

NOTE 

You can use the LIMIT hot key to analyze your measurements with the user-definable 
limit and Pass/Fail indication. See “Setting limit for modulation tests” on page 237 for 
more information. 

 

Data allocation map 

The Data Allocation Map function represents data allocation as a frame. 

 

Setting measure setup 

After configuring test parameters as described in the “Configuring test parameters” on page 202, you 

can continue your measurement. The measurement settings can be saved and recalled as a file. You 

can also use JDViewer, PC application software to configure a measure setup, save as a file, and load 

the file on to the instrument. 

 

Procedure 

1. Press the MEASURE SETUP hot key. 

2. To set the nominal channel bandwidth to be measured, complete the following steps: 

a. Press the Bandwidth soft key. 

b. Select the bandwidth option: 1.4 MHz, 3 MHz, 5 MHz, 10 MHz, 15 MHz, or 20 MHz. 

3. To select the subframe number to be measured, complete the following steps: 
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a. Press the Subframe No soft key. 

b. Enter a value by using the numeric keys. You can also use the rotary knob. 
 

 

NOTE 

For MBMS testing, this subframe number must be neither 0 nor 5 as these subframes 0 
and 5 are not available for MBMS and it must be set to the MBMS transmitted channel’s 
subframe number. 

c. Press the Enter soft key. 

4. To set the threshold for PDSCH, complete the following steps: 

a. Press the PDSCH Threshold soft key. 

b. Enter a value by using the numeric keys. 

c. Press the dB soft key. 

5. Optional. Toggle the Cell ID soft key and select Auto or Manual as desired: 

–  Auto: to let the instrument detect the Cell ID for the LTE signal automatically. 

–  Manual: to set a specific Cell ID for the LTE signal manually in order to speed up the 

synchronization with a BTS. 

6. Optional. Press the Miscellaneous soft key, and then do the following(s) as needed: 

–  To select the number of antenna ports, toggle the MIMO soft key and select 2x2 or 4x4. 

This MIMO (Multiple Input Multiple Output) setting is activated only if the option 030 LTE-
Advanced FDD is installed with a license number. If not, the instrument sets this option to 
2x2 by default. A 2x1 or 4x1 RF combiner is also required to able to test on MIMO 
channels. 

–  To assign a antenna port number automatically or manually, press the Antenna Port soft 
key and select the option: Auto, 0, 1, 2, and 3. If the option 030 LTE-Advanced FDD is not 

installed or if the MIMO is set to 2x2, the antenna ports 2 and 3 are disabled. 

–  To turn the Multimedia Broadcast Multicast Service (MBMS) feature on or off, toggle the 
MBMS soft key and select On or Off. For proper MBMS testing, you need to set the 
Subframe No with the same PMCH subframe number. If this setting is on, either PMCH or 

PDSCH appears on the screen depending on the detected channel. 

–  To set the Multicast Broadcast Single Frequency Network (MBSFN) detection automatically 
or manually for MBMS testing, toggle the MBSFN soft key and select Auto or Manual. An 

automatically detected or manually entered MBSFN ID appears on the screen. 

–  To select the cyclic prefix, toggle the Cyclic Prefix soft key and select Normal or 
Extended. See “Appendix E – Cyclic prefix table” on page 592 for OFDM parameter details 

by different bandwidth. 

 

Setting display 

You can use the TRACE/DISPLAY hard key to change the display mode to PDSCH, PMCH, or both. 

 

Procedure 

1. Press the TRACE/DISPLAY hard key. 

2. Press the Display Channel soft key. 

3. Select the display mode from the choice: PDSCH, PMCH, and Both. 
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Measurement example 

Figure 103 Data allocation map measurement with LTE - FDD signal analyzer 

 

 

Figure 104 Data allocation map measurement with LTE - FDD signal analyzer (MBMS On) 

 

 

 

NOTE 

You can use the LIMIT hot key to analyze your measurements with the user-definable 
limit and Pass/Fail indication. See “Setting limit for modulation tests” on page 237 for 
more information. 

 

Using marker 

You can use the MARKER hard key to place the marker at a specific resource block and subframe. 

 

Procedure 

1. Press the MARKER hard key. 
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2. Toggle the Marker View soft key between On and Off to display or dismiss the marker on the 

chart. 

3. To select the resource block number, complete the following steps: 

a. Press the RB Number soft key. 

b. Enter the resource block number to select by using the numeric keys. You can also use the 
rotary knob to move the marker side by side. 

c. Press the Enter soft key. 

4. To select the subframe block number, complete the following steps: 

a. Press the Subframe No soft key. 

b. Enter the subframe number to select by using the numeric keys. You can also use the 
rotary knob to move the marker up and down. 

c. Press the Enter soft key. 

 

Setting limit for modulation tests 

Procedure 

1. Press the LIMIT hot key. 

2. Press the Modulation Test Limits soft key to set the limits. 

3. Select the test item(s) and set the limit(s) depending on your selected measurement mode: 
 

To set the limit for Select Set 

Frequency error Frequency Error High Limit 
Low Limit 

PDSCH error vector 
magnitude if MBMS is off 

EVM > PDSCH EVM High Limit (QPSK) 
High Limit (16 QAM) 
High Limit (64 QAM) 
High Limit (256 QAM)* 

PMCH error vector magnitude 
if MBMS is on and a PMCH is 
detected 

EVM > PMCH EVM High Limit (QPSK) 
High Limit (16 QAM) 
High Limit (64 QAM) 
High Limit (256 QAM)* 

RMS for data error vector 
magnitude 

EVM > Data EVM RMS High Limit 

Peak for data error vector 
magnitude 

EVM> Data EVM Peak High Limit 

RS error vector magnitude EVM > RS EVM High Limit 

P-SS error vector magnitude EVM > P-SS EVM High Limit 

S-SS error vector magnitude EVM > S-SS EVM High Limit 

Downlink RS power Power > DL RS Power High Limit 
Low Limit 

P-SS power Power > P-SS Power High Limit 
Low Limit 

S-SS power Power > S-SS Power High Limit 
Low Limit 

PBCH power Power > PBCH Power High Limit 
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Low Limit 

Subframe power Power > Subframe Power High Limit 
Low Limit 

OFDM symbol power Power > OFDM Symbol Power High Limit 
Low Limit 

Frame average power Power > Frame Avg Power High Limit 
Low Limit 

Time alignment error for MIMO Time Alignment Error > MIMO High Limit 

Time alignment error for 
aggregation of component 
carriers (intra-band 
contiguous, intra-band non-
contiguous, and inter-band) 

Time Alignment Error > Carrier 
Aggregation 

Intra Cont 
Intra Non-cont 
Inter Band 

Time error Time Error High Limit 
Low Limit 

I-Q origin offset IQ Origin Offset High Limit 

4. Optional. You can enable alarm sound that goes off if the measurement falls outside of the limit. 
Toggle the Beep soft key between On and Off to enable or disable the beep sound. 

5. Optional. Go to SAVE/LOAD > Save, and then select Save Limit to save the limit settings. 

See “Using save” on page 33 for more information. 

 

Performing auto measurements 

Conformance test 

The Conformance Test is to test if eNode-B meets some specified standards that have been 

developed for verification. Its test procedure and test setups have been developed by 3GPP. Test 

results can be saved as a .csv file type. 

 

Setting limit for conformance test 

You can set test limits for test item(s) in the auto measurement. Turning the test limit on for a test item 

makes the test item included in the conformance test. 

 

Procedure 

1. Press the LIMIT hot key. 

2. To set the limit for BTS output power, complete the following steps: 

a. Press the BTS Output Power soft key. 

b. Toggle the Test Limits soft key between On and Off to enable or disable the limit. 

c. Press the High Limit soft key. 

d. Enter a value for the upper limit. 

e. Press the dBm unit soft key. 

f. Press the Low Limit soft key. 

g. Enter a value for the lower limit. 

h. Press the dBm unit soft key. 
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3. To set the limit for total power dynamic, complete the following steps: 

a. Press the Total Power Dynamic soft key. 

b. Toggle the Test Limits soft key between On and Off to enable or disable the limit. 

c. Press the Low Limit soft key. 

d. Enter a value for the lower limit. 

e. Press the dBm unit soft key. 

4. To verify signal quality, press the Signal Quality soft key, and then do the following as needed: 

 

To set the limit for Select Set 

Frequency error Frequency Error > Test Limits 
[E-TM2|E-TM3.1|E-TM3.2|E-
TM3.3] 

High Limit 
Low Limit 

Error vector magnitude EVM > Test Limits [E-TM2|E-
TM3.1|E-TM3.2|E-TM3.3] 

High Limit (QPSK) 
High Limit (16 QAM) 
High Limit (64 QAM) 

Time alignment error Time Alignment Error High Limit 

RS power RS Power High Limit 
Low Limit 

5. To verify unwanted emissions, press the Unwanted Emissions soft key, and then do the 

following as needed: 
 

To set the limit for Select Set 

Occupied bandwidth Occupied BW High Limit 

Adjacent channel power ratio ACLR  

Spectrum emission mask SEM Mask Type 

Spurious emissions Spurious Emissions Range Table 

6. Optional. You can enable alarm sound that goes off if the measurement falls outside of the limit. 
Toggle the Beep soft key between On and Off to enable or disable the beep sound. 

7. Optional. Go to SAVE/LOAD > Save, and then select Save Limit to save the limit settings. 

See “Using save” on page 33 for more information. 

 

Setting measure setup 

After setting frequency as described in the “Configuring test parameters” on page 202, you can 

continue your measurement. 

 

Procedure 

1. Press the MEASURE SETUP hot key. 

2. Press the Bandwidth soft key. 

3. Select the nominal channel bandwidth to be measured, from the following choices: 

–  1.4 MHz, 3 MHz, 5 MHz, 10 MHz, 15 MHz, and 20 MHz 

4. Press the Sector soft key, and then select the sector option: Alpha, Beta, or Gamma. 

5. To set external offset, complete the following steps: 

a. Toggle the External Offset soft key and select On. 
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b. Enter a value by using the numeric keys. 

c. Press the dB soft key. 

6. To save your settings and results, go to SAVE/LOAD > Save and then perform functions as you 

desire. See “Using save” on page 33 for more information. 

7. Press the Run Test soft key to start to run a test. 

The Auto Measure Results window appears at the end of the test. 

8. When prompted on the screen, connect the cable from the Spectrum Analyzer RF In port of the 
instrument either to Antenna Port 0 or Antenna Port 1 of the eNode-B, and then change the TM 

mode on the eNode-B side. 

9. Press the Continue soft key to continue testing. 

10. Repeat the steps 8-9 until completion of the test. 
A conformance test report appears at the end of the test. 

11. Optional. To stop running the test, press the Abort soft key. 

 

Maintenance test 

The Auto Measure function of the JD780A series allows a complete signal profiling covering RF 

characterization and modulation quality parameters of up to 20 different carriers, particularly useful on 

an overlay architecture where base stations are transmitting in different frequencies. 

 

Following settings are required only when you run the Auto Measure Maintenance Test on the 

instrument using “Current” configuration setting. Additional settings are not required when you run Auto 

Measure using a scenario generated in the PC application software, JDViewer. 

 

Setting limit for maintenance test 

You can set test limits for test item(s) in the auto measurement. 

Procedure 

1. Press the LIMIT hot key. 

2. Press the RF Test Limits soft key, and then enable test limits as desired. 

3. Press the Modulation Test Limits soft key, and then enable test limits as desired. 

4. Optional. You can enable alarm sound that goes off if the measurement falls outside of the limit. 
Toggle the Beep soft key between On and Off to enable or disable the beep sound. 

5. Optional. Go to SAVE/LOAD > Save, and then select Save Limit to save the limit settings. 

See “Using save” on page 33 for more information. 

 

 

NOTE 
You can use the Allowed % Change soft key for each test item to compare two 
measurement values displayed in the result table. This requires setting the Display mode 
to Compare in advance. 

 

Setting measure setup 

After configuring test parameters as described in the “Configuring test parameters” on page 202, you 

can continue your measurement. The measurement settings can be saved and recalled as a file. You 

can also use JDViewer, PC application software to configure a measure setup, save as a file, and load 

the file on to the instrument. 
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Procedure 

1. Press the MEASURE SETUP hot key. 

2. Toggle the Configuration soft key and select the configuration option: 

–  Current: to let the instrumnet use current frequency (single carrier) and determine pass or 

fail based on the instrument’s limit settings in Auto Measure. 

–  Scenario: to run a test with a programmed scenario in JDViewer. 

The Scenario menu becomes activated. 

3. To load a scenario, press the Scenario soft key, and then select a scenario file to load. 

4. Toggle the Test Time soft key and select the test time option: 

–  Now: to let the instrument run a test only once. 

–  Schedule: to let the instrument repeat tests as defined in the Set Timing. 

The Set Timing menu becomes activated. 

5. To define a schedule for an auto measurement, complete the following steps: 

a. Press the Set Timing soft key. 

b. Press the Start Time (HH:MM) soft key. 

c. Enter the time in the HH:MM format, and then press the Enter soft key. 

d. Press the Stop Time (HH:MM) soft key. 

e. Enter the time in the HH:MM format, and then press the Enter soft key. 

f. Press the Time Interval soft key. 

g. Enter the amount of time in minutes, and then press the Enter soft key. 

–   

6. Press the Settings soft key, and then set the following as needed: 

a. Press the Bandwidth soft key, and then select the nominal channel bandwidth to be 

measured, from the following choices: 

–  1.4 MHz, 3 MHz, 5 MHz, 10 MHz, 15 MHz, and 20 MHz 

b. Toggle the Cell ID soft key and select Auto or Manual as desired: 

–  Auto: to let the instrument detect the Cell ID for the LTE signal automatically. 

–  Manual: to set a specific Cell ID for the LTE signal manually in order to speed up the 

synchronization with a BTS. 

c. Press the MIMO soft key, and then select the antenna number option: 2x2 or 4x4. 

This MIMO (Multiple Input Multiple Output) setting is activated only if the option 030 LTE-
Advanced FDD is installed with a license number. If not, the instrument sets this option to 
2x2 by default. A 2x1 or 4x1 RF combiner is also required to able to test on MIMO 
channels. 

d. Press the Antenna Port soft key, and then select the option: Auto, 0, 1, 2, or 3. 

If the option 030 LTE-Advanced FDD is not installed or if the MIMO is set to 2x2, the 
antenna ports 2 and 3 are disabled. 

e. Toggle the External Offset soft key and select On. 

f. Enter a value by using the numeric keys, and then press the dB soft key. 

g. To turn the Multimedia Broadcast Multicast Service (MBMS) feature on or off, toggle the 
MBMS soft key and select On or Off. For proper MBMS testing, you need to set the 

Subframe No with the same PMCH subframe number. 

h. To set the Multicast Broadcast Single Frequency Network (MBSFN) detection automatically 
or manually for MBMS testing, toggle the MBSFN soft key and select Auto or Manual. An 

automatically detected or manually entered MBSFN ID appears on the screen. 

7. To save your settings and results, go to SAVE/LOAD > Save and then perform functions as you 

desire. See “Using save” on page 33 for more information. 
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8. Press the Run Test soft key to start to run a test. 

The Auto Measure Results window appears at the end of the test. 

9. To stop running the test, press the Abort soft key. 

10. To change the view on the screen during the test, press the Display and then select the view 

option from the following choices: 

–  Screen: You can view each measurement screen as the test progresses. 

–  Results: You can view a measurement result table as the test progresses. 

–  Settings: You can view a measurement setting table as the test progresses. 

 

Setting display 

After completion of the auto measurement, the screen menu changes to Trace/Display so that you can 

view the results in different forms. 

 

Procedure 

1. Toggle the Display soft key and select the display option: 

–  Result: to view the result table. 

The Display Result menu becomes activated. 

–  Settings: to view the measurement settings for the auto measurement. 

2. Toggle the Display Result soft key and select the display result option: 

–  Full: to view detailed measurement readings with the pass/fail indication. 

–  Quick: to view only the Pass/Fail results. 

–  Compare: to compare two measurement values for each test time with the Allowed % 

Change setting on. You can view results vs. factory-defined or user-defined references. 

3. To view the measurement results for a different carrier, press the View Carrier soft key and then 

select the carrier number to view. 

4. Press the Replace Reference soft key to replace existing reference values for comparison with 

new measurement data. 

5. Press the Load From soft key to select the location from which references file to be loaded. 

 

Signal performance test 

Unlike the other auto measurement tests, the Signal Performance Test runs measurements 

continuously. 

 

Setting limit for signal performance test 

You can set test limits for test item(s) in the auto measurement. 

Procedure 

1. Press the LIMIT hot key. 

2. Press the RF Test Limits > Channel Power soft key, and then set the limits for the channel 

power. Other RF test items are not used in the signal performance test. 

3. Press the Modulation Test Limits soft key, and then enable test limits as desired. 

4. Optional. You can enable alarm sound that goes off if the measurement falls outside of the limit. 
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Toggle the Beep soft key between On and Off to enable or disable the beep sound. 

5. Optional. Go to SAVE/LOAD > Save, and then select Save Limit to save the limit settings. 

See “Using save” on page 33 for more information. 

 

Setting measure setup 

After configuring test parameters as described in the “Configuring test parameters” on page 202, you 

can continue your measurement. The measurement settings can be saved and recalled as a file. You 

can also use JDViewer, PC application software to configure a measure setup, save as a file, and load 

the file on to the instrument. 

 

Procedure 

1. Press the MEASURE SETUP hot key. 

2. Toggle the Cell ID soft key and select Auto or Manual as desired: 

–  Auto: to let the instrument detect the Cell ID for the LTE signal automatically. 

–  Manual: to set a specific Cell ID for the LTE signal manually in order to speed up the 

synchronization with a BTS. 

3. Press the MIMO soft key, and then select the antenna number option: 2x2 or 4x4. 

This MIMO (Multiple Input Multiple Output) setting is activated only if the option 030 LTE-
Advanced FDD is installed with a license number. If not, the instrument sets this option to 2x2 by 
default. A 2x1 or 4x1 RF combiner is also required to able to test on MIMO channels. 

4. Press the Antenna Port soft key, and then select the option: Auto, 0, 1, 2, or 3. 

If the option 030 LTE-Advanced FDD is not installed or if the MIMO is set to 2x2, the antenna 
ports 2 and 3 are disabled. 

5. Press the Bandwidth soft key, and then select the nominal channel bandwidth to be measured, 

from the following choices: 

–  1.4 MHz, 3 MHz, 5 MHz, 10 MHz, 15 MHz, and 20 MHz 

6. Toggle the RF Profile soft key between On and Off to turn on or off the RF profiling such as 

channel power and subframe frequency error. 

7. Toggle the Modulation Profile soft key between On and Off to turn on or off the modulation 

profiling such as P-SS, S-SS, Data - QPSK, Data – 16 QAM, and Data – 64 QAM. 

8. Toggle the MIMO Profile soft key between On and Off to turn on or off the MIMO profiling such 

as TX1 - RS0, TX2 - RS1, and time alignment error. 

9. Toggle the External Offset soft key and select On to set the external offset value. 

10. To save your settings and results, go to SAVE/LOAD > Save and then perform functions as you 

desire. See “Using save” on page 33 for more information. 

 

DAS test 

The Distributed Antenna System (DAS) testing enables you to check the degradation of performance 

in the signal transmission from a radio band to antennas distributed from it. You can save 

measurement values at both the radio band and antennas and then compare results with percentage 

of changes. You can also save test results in the .csv file format for ease of analysis. 

 

Setting measure setup 

Procedure 

1. Press the MEASURE SETUP hot key. 
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2. Press the Settings soft key and then set the following; 

a. Press the Bandwidth soft key and then select the nominal channel bandwidth to be 
measured from the choices: 1.4 MHz, 3 MHz, 5 MHz, 10 MHz, 15 MHz, and 20 MHz: 

b. Press the MIMO soft key, and then select the antenna number option: 2x2 or 4x4. 

This MIMO (Multiple Input Multiple Output) setting is activated only if the option 030 LTE-
Advanced FDD is installed with a license number. If not, the instrument sets this option to 
2x2 by default. A 2x1 or 4x1 RF combiner is also required to able to test on MIMO 
channels. 

c. Toggle the Cell ID soft key and select Auto or Manual as desired: 

–  Auto: to let the instrument detect the Cell ID for the LTE signal automatically. 

–  Manual: to set a specific Cell ID for the LTE signal manually in order to speed up the 

synchronization with a BTS. 

d. Press the Antenna Port soft key, and then select the option: Auto, 0, 1, 2, or 3. 

If the option 030 LTE-Advanced FDD is not installed or if the MIMO is set to 2x2, the 
antenna ports 2 and 3 are disabled. 

e. Toggle the External Offset soft key and select On to set the external offset value. 

f. To turn the Multimedia Broadcast Multicast Service (MBMS) feature on or off, toggle the 
MBMS soft key and select On or Off. 

g. To set the Multicast Broadcast Single Frequency Network (MBSFN) detection automatically 
or manually for MBMS testing, toggle the MBSFN soft key and select Auto or Manual. An 

automatically detected or manually entered MBSFN ID appears on the screen. 

3. To save your settings, go to SAVE/LOAD > Save > Save Setup and then perform functions as 

you desire. See “Using save” on page 33 for more information. 

4. Press the Continue soft key to do the reference test first or press the Skip Reference Test soft 

key if you already saved test results from the radio band under test. 

5. Press the FREQ/DIST hard key and then set the frequency to be measured. See “Setting 

frequency” on page 272 for more information. 

6. Press the PREV hard key. 

7. Press the Limit soft key and then set the limits and allowed percentage change for each test 

item. See “Maintenance test” on page 310 for more information on setting limits. 

8. Keep pressing the PREV hard key until you see the Run Test soft key. 

9. Press the Run Test soft key. 

The instrument runs specified tests to gather reference measurement values. The measurement 
table appears when the reference test is done. 

10. Press the Continue soft key to run the testing on an antenna (Ant 1). 

11. Optional. To change the settings such as External Offset, press the Settings and then change 

the settings as needed. 

12. Press the Continue soft key. 

The instrument runs the testing on Ant 1. The Ant 1 tab appears with the updated result table 
when the test is done. 

13. To run the testing on the next antenna (Ant 2), press the Run Test soft key and then repeat the 
steps 11-12. You can do the testing on up to 10 distributed antennas for one radio band. 

14. To view test results for each antenna, press the Select Antenna soft key and then select the 

antenna tab number to display on the screen. 

15. Optional. Press the Delete Test soft key to delete the selected antenna tab. 

16. Optional. Press the Retest Reference soft key to obtain reference measurement values again. 

17. Optional. To save your measurement results, go to SAVE/LOAD > Save and then perform 

functions as you desire. See “Using save” on page 33 for more information. 
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Measurement Example 

Figure 105 DAS measurement with LTE - FDD signal analyzer 

 

 

Performing power statistics CCDF measurements 

The Power Statistics Complementary Cumulative Distribution Function (CCDF) measurement 

characterizes the power statistics of the input signal. It provides PAR (Peak to Average power Ratio) 

versus different probabilities. 

 

Setting measure setup 

After configuring test parameters as described in the “Configuring test parameters” on page 202, you 

can continue your measurement. The measurement settings can be saved and recalled as a file. You 

can also use JDViewer, PC application software to configure a measure setup, save as a file, and load 

the file on to the instrument. 

 

Procedure 

1. Press the MEASURE SETUP hot key. 

2. Press the CCDF Length soft key to set the length of the CCDF. 

3. Enter a value between 1 and 100 by using the numeric keys. You can also use the rotary knob. 

4. Press the Enter soft key. 
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Measurement example 

Figure 106 CCDF measurement with LTE - FDD signal analyzer 

 

 

Performing carrier aggregation measurements 

Carrier aggregation enables a maximum of five multiple LTE carriers to be used together in order to 

provide high data rate required for LTE-Advanced. Component carriers to be aggregated can be intra-

band contiguous, intra-band non-contiguous, or inter-band. The JD780A series provides carrier 

aggregation measurements supporting for all the different modes with carrier aggregation bands 

added to the channel standard. This functionality is activated if the license for the option 030 LTE-

Advanced FDD is installed. 

 

Setting measure setup 

After configuring test parameters as described in the “Configuring test parameters” on page 202, you 

can continue your measurement. The measurement settings can be saved and recalled as a file. You 

can also use JDViewer, PC application software to configure a measure setup, save as a file, and load 

the file on to the instrument. 

 

Procedure 

1. Press the MEASURE SETUP hot key. 

2. To configure parameters for up to 5 component carriers, complete the following steps: 

a. Press the CA Configuration soft key. 

The component carrier configuration window appears. 

b. Press the CA Range soft key. 

c. Enter the number of the component carrier to be set between 1 and 5. 

d. Press the Enter soft key. 

e. Toggle the Turn On soft key and then select On to set parameters and view the results for 
the selected component carrier on the screen or Off to turn it off. 

f. Set the following parameters as needed: 
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–  Center Frequency, Channel, Bandwidth, Cell ID, CFI, PHICH Ng, Antenna Port, 
MBMS On/Off, Cyclic Prefix, and PDSCH Modulation Type 

g. To set more component carriers, repeat the steps c-f. 

3. Press the MEASURE SETUP hot key again 

4. Toggle the EVM Detection Mode soft key and select Single or Combine as desired: 

–  Single: Testing on one single antenna connected to your JD780A series with a cable. 

–  Combine: Testing on multiple antennas connected to your JD780A series with a 2x1 or 4x1 

combiner or an antenna. 

5. To select the subframe number to be measured, do one of the following: 

–  If the EVM Detection Mode is set to Single, press the Subframe No soft key and then set 

the subframe number. 
 

 

NOTE 

For MBMS testing, this subframe number must be neither 0 nor 5 as these subframes 0 
and 5 are not available for MBMS and it must be set to the MBMS transmitted channel’s 
subframe number. 

–  If the EVM Detection Mode is set to Combine, toggle the Subframe No soft key and then 
select 0 or 5. 

6. To set the threshold for PDSCH, complete the following steps: 

a. Press the PDSCH Threshold soft key. 

b. Enter a value by using the numeric keys. 

c. Press the dB soft key. 

7. Toggle the PDSCH Precoding soft key between On and Off to enable or disable the PDSCH 

precoding. 

8. To select the number of antenna ports, toggle the MIMO soft key and select 2x2 or 4x4. 

This MIMO (Multiple Input Multiple Output) setting is activated only if the option 030 LTE-
Advanced FDD is installed with a license number. If not, the instrument sets this option to 2x2 by 
default. A 2x1 or 4x1 RF combiner is also required to able to test on MIMO channels. 

 

Setting display 

You can use the TRACE/DISPLAY hard key to select modulation analysis or spectrum analysis. 

 

Procedure 

1. Press the TRACE/DISPLAY hard key. 

2. Toggle the Display soft key and select MA for modulation analysis or SA for spectrum analysis. 

The screen changes according to the selected option. 
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Measurement example 

Figure 107 Carrier aggregation measurement with LTE - FDD signal analyzer (MA) 

 

 

Figure 108 Carrier aggregation measurement with LTE - FDD signal analyzer (SA) 

 

 

 

NOTE 
You can use the LIMIT hot key to analyze your measurements with the user-definable 

limit and Pass/Fail indication. See “Setting limit for modulation tests” on page 237 for 
more information. 

 

Using marker 

You can use the MARKER hard key to place the marker at a specific channel. 

 

Procedure 

1. Press the MARKER hard key. 
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2. Toggle the IQ Diagram soft key between On and Off to display or dismiss data on the IQ 

diagram for each component carrier. 

3. Press the Channel soft key to select the channel to be displayed on the IQ diagram. 

4. Use the rotary knob to move and select an item under EVM. 

 

Conducting LTE - FDD OTA measurements 

The FDD LTE Over The Air (OTA) measurement has Channel Scanner, ID Scanner, Multipath Profile, 

Datagram, and Control Channel screens. The ID Scanner displays key parameters such as RSRP, 

RSRQ, RS-SINR, and S-SS RSSI. The Multipath Profile enables you to determine RF environmental 

conditions of testing area. The OTA Control Channel provides summary of all control channels 

including RS power variation over time. 

 

Channel scanner 

The Channel Scanner is a radio receiver that can automatically tune or scan two or more discrete 

frequencies and multi-channels, indicating when it finds a signal on one of them and then continuing 

scanning when that frequency goes silent. 

 

Setting channel/frequency 

Procedure 

To set the channels to be scanned: 

1. Press the FREQ/DIST hard key. 

2. Toggle the Unit soft key and select Channel. 

3. Press the Index soft key, and then enter an index number between one and six by turning the 

rotary knob or using the numeric keys. 

4. To select the standard channel, complete the following steps: 

a. Press the Channel Std soft key. The standard channel window appears. 

See “Appendix C – Band, frequency & channel standard” on page 588 for more information. 

b. Select the band to be measured by using the rotary knob, the arrow keys, or the Page 
Up/Page Down soft keys. 

c. Press the Select soft key or the rotary knob to confirm the selection. 

5. To set the channel number for the selected index, complete the following steps: 

a. Press the Channel Number soft key. 

b. Enter a value by using the numeric keys. You can also use the rotary knob. 

c. Press the Enter soft key. 

The instrument displays a corresponding center frequency for the channel number. 

6. To set the integration bandwidth for the selected index, complete the following steps: 

a. Press the Integration Bandwidth soft key. 

b. Enter a value by using the numeric keys. You can also use the rotary knob. 

c. Select the unit: GHz, MHz, kHz, or Hz. 

7. To add more channels to be scanned, repeat steps 3-6. 

8. Press the ESC hard key to dismiss the channel list window and view the scanning result. 
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To set the frequencies to be scanned: 

1. Press the FREQ/DIST hard key. 

2. Toggle the Unit soft key and select Freq. 

3. Press the Index soft key, and then enter an index number between one and six by turning the 

rotary knob or using the numeric keys. 

4. To set the center frequency for the selected index, complete the following steps: 

a. Press the Center Frequency soft key. 

b. Enter a value by using the numeric keys. You can also use the rotary knob. 

c. Select the unit: GHz, MHz, kHz, or Hz. 

5. To set the integration bandwidth for the selected index, complete the following steps: 

a. Press the Integration Bandwidth soft key. 

b. Enter a value by using the numeric keys. You can also use the rotary knob. 

c. Select the unit: GHz, MHz, kHz, or Hz. 

6. To add more channels to be scanned, repeat steps 3-5. 

7. Press the ESC hard key to dismiss the channel list window and view the scanning result. 

 

Setting number of antenna ports 

Procedure 

1. Press the MEASURE SETUP hot key. 

2. Toggle the MIMO soft key and select 2x2 or 4x4. 

This MIMO (Multiple Input Multiple Output) setting is activated only if the option 030 LTE-
Advanced FDD is installed with a license number. If not, the instrument sets this option to 2x2 by 
default. A 2x1 or 4x1 RF combiner is also required to able to test on MIMO channels. 

 

Measurement example 

Figure 109 Channel scanner measurement with LTE - FDD OTA signal analyzer 
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ID scanner 

The LTE mobile receives signals from multiple base stations that all of these signals share the same 

spectrum and are present at the same time. Each base station has unique scrambling code assigned 

to the particular base station and it differentiates its signal from other base stations in the area. 

 

The ID Scanner shows key parameters such as RSRP (Reference Signal Received Power) and RSRQ 

(Reference Signal Received Quality) that predict the downlink coverage quickly. 

 RSRPs from entire cells help to rank between the different cells as input for handover and cell 

reselection decisions. 

 RSRQ provides additional information when RSRP is not sufficient to make a reliable 

handover or cell reselection decision. 

 

All of the parameters for OTA ID scanner can be plotted on map data such as Google Maps and 

Google Earth by using JDViewer. 

 

Setting measure setup 

After configuring test parameters as described in the “Configuring test parameters” on page 202, you 

can continue your measurement. 

 

Procedure 

1. Press the MEASURE SETUP hot key. 

2. To set the nominal channel bandwidth to be measured, complete the following steps: 

a. Press the Bandwidth soft key. 

b. Select the bandwidth option: 1.4 MHz, 3 MHz, 5 MHz, 10 MHz, 15 MHz, or 20 MHz. 

3. Optional. Press the Miscellaneous soft key, and then do the following(s) as needed: 

–  To select the number of antenna ports, toggle the MIMO soft key and select 2x2 or 4x4. 

This MIMO (Multiple Input Multiple Output) setting is activated only if the option 030 LTE-
Advanced FDD is installed with a license number. If not, the instrument sets this option to 
2x2 by default. A 2x1 or 4x1 RF combiner is also required to able to test on MIMO 
channels. 

–  To select the cyclic prefix, toggle the Cyclic Prefix soft key and select Normal or 
Extended. See “Appendix E – Cyclic prefix table” on page 592 for OFDM parameter details 

by different bandwidth. 

4. Optional. Go to SAVE/LOAD > Save, and then select the save option from the choices available 

for your measurement mode. See “Using save” on page 33 for more information. 
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Measurement example 

Figure 110 ID scanner measurement with LTE - FDD OTA signal analyzer 

 

 

Multipath profile 

The Multipath Profile enables you to determine RF environmental conditions of testing area. It 

indicates the amount of power of the dominant pilot signal that is dispersed outside the main 

correlation peak due to multipath echoes that are expressed in dB. This value should be very small 

ideally. 

 

The multipath profile is the result of portions of the original broadcast signal arriving at the receiving 

antenna out of phase. This can be caused by the signal being reflected off objects such as buildings, 

or being refracted through the atmosphere differently from the main signal. 

 

Setting measure setup 

After configuring test parameters as described in the “Configuring test parameters” on page 202, you 

can continue your measurement. 

 

Procedure 

1. Press the MEASURE SETUP hot key. 

2. To set the nominal channel bandwidth to be measured, complete the following steps: 

a. Press the Bandwidth soft key. 

b. Select the bandwidth option: 1.4 MHz, 3 MHz, 5 MHz, 10 MHz, 15 MHz, or 20 MHz. 

3. Toggle the Display soft key and select RS or Sync. 

The RS Window soft key becomes activated if RS is selected. 

4. Press the RS Window soft key, if RS is selected, and then select the RS window option: 2 µs,  
4 µs, or 8 µs. 

5. Optional. Press the Miscellaneous soft key, and then do the following(s) as needed: 

–  To select the number of antenna ports, toggle the MIMO soft key and select 2x2 or 4x4. 

This MIMO (Multiple Input Multiple Output) setting is activated only if the option 030 LTE-
Advanced FDD is installed with a license number. If not, the instrument sets this option to 
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2x2 by default. A 2x1 or 4x1 RF combiner is also required to able to test on MIMO 
channels. 

–  To select the cyclic prefix, toggle the Cyclic Prefix soft key and select Normal or 
Extended. See “Appendix E – Cyclic prefix table” on page 592 for OFDM parameter details 

by different bandwidth. 

6. Optional. Go to SAVE/LOAD > Save, and then select the save option from the choices available 

for your measurement mode. See “Using save” on page 33 for more information. 

 

Measurement example 

Figure 111 Multipath profile measurement with LTE - FDD OTA signal analyzer 

 

 

Control channel 

DL RS power is the resource element power of Downlink Reference Symbol. The absolute DL RS 

power is indicated on the BCH. The absolute accuracy is defined as the maximum deviation between 

the DL RS power indicated on the BCH and the DL RS power at the BS antenna connector. 

 

The OTA Control Channel provides summary of all control channels including RS power trend over 

time. GPS coordinates (latitude and longitude) will be displayed on the screen if a GPS antenna is 

connected and locked to the GPS satellites. 

 

Setting measure setup 

After configuring test parameters as described in the “Configuring test parameters” on page 202, you 

can continue your measurement. The measurement settings can be saved and recalled as a file. You 

can also use JDViewer, PC application software to configure a measure setup, save as a file, and load 

the file on to the instrument. 

 

Procedure 

1. Press the MEASURE SETUP hot key. 

2. To set the nominal channel bandwidth to be measured, complete the following steps: 

a. Press the Bandwidth soft key. 
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b. Select the bandwidth option: 1.4 MHz, 3 MHz, 5 MHz, 10 MHz, 15 MHz, or 20 MHz. 

3. To select the subframe number to be measured, complete the following steps: 

a. Press the Subframe No soft key. 

b. Enter a value by using the numeric keys. You can also use the rotary knob. 
 

 

NOTE 

For MBMS testing, this subframe number must be neither 0 nor 5 as these subframes 0 
and 5 are not available for MBMS and it must be set to the MBMS transmitted channel’s 
subframe number. 

c. Press the Enter soft key. 

4. Optional. Toggle the Cell ID soft key and select Auto or Manual as desired: 

–  Auto: to let the instrument detect the Cell ID for the LTE signal automatically. 

–  Manual: to set a specific Cell ID for the LTE signal manually in order to speed up the 

synchronization with a BTS. 

5. Optional. Press the Miscellaneous soft key, and then do the following(s) as needed: 

–  To select the number of antenna ports, toggle the MIMO soft key and select 2x2 or 4x4. 

This MIMO (Multiple Input Multiple Output) setting is activated only if the option 030 LTE-
Advanced FDD is installed with a license number. If not, the instrument sets this option to 
2x2 by default. A 2x1 or 4x1 RF combiner is also required to able to test on MIMO 
channels. 

–  To assign a antenna port number automatically or manually, press the Antenna Port soft 
key and select the option: Auto, 0, 1, 2, and 3. If the option 030 LTE-Advanced FDD is not 

installed or if the MIMO is set to 2x2, the antenna ports 2 and 3 are disabled. 

–  To select the cyclic prefix, toggle the Cyclic Prefix soft key and select Normal or 
Extended. See “Appendix E – Cyclic prefix table” on page 592 for OFDM parameter details 

by different bandwidth. 

–  To turn the Multimedia Broadcast Multicast Service (MBMS) feature on or off, toggle the 
MBMS soft key and select On or Off. For proper MBMS testing, you need to set the 
Subframe No with the same PMCH subframe number. If this setting is on, the 

measurement item “MBSFN RS” appears in the result table. 

–  To set the Multicast Broadcast Single Frequency Network (MBSFN) detection automatically 
or manually for MBMS testing, toggle the MBSFN soft key and select Auto or Manual. An 

automatically detected or manually entered MBSFN ID appears on the screen. 

6. Optional. Go to SAVE/LOAD > Save, and then select the save option from the choices available 

for your measurement mode. See “Using save” on page 33 for more information. 

 

Setting limit for OTA control channel 

Procedure 

1. Press the LIMIT hot key. 

2. Select the test item(s) and set the limit(s) as needed: 
 

To set the limit for Select Set 

P-SS error vector magnitude P-SS EVM High Limit 

S-SS error vector magnitude S-SS EVM High Limit 

RS error vector magnitude RS EVM > RS0 EVM 
RS EVM > RS1 EVM 
RS EVM > RS2 EVM 
RS EVM > RS3 EVM 

High Limit 



JD780A Series Analyzers 

 Using LTE - FDD Signal Analyzer 255 

Frequency error Frequency Error High Limit 
Low Limit 

Time error Time Error High Limit 
Low Limit 

Time alignment error Time Alignment Error High Limit 

3. Optional. Go to SAVE/LOAD > Save, and then select Save Limit to save the limit settings. 

See “Using save” on page 33 for more information. 

 

Setting display 

You can use the TRACE/DISPLAY hard key to select the display option. 

 

Procedure 

1. Press the TRACE/DISPLAY hard key. 

2. Toggle the Display soft key and select Power or EVM. 

The screen changes according to the selected option. 

 

Measurement example 

Figure 112 Control channel measurement with LTE - FDD OTA signal analyzer 

 

 

Datagram 

The OTA Datagram is a time-varying spectral representation that shows how the power of a signal 

varies with time. The power allocated to the specific resource block will be represented with an 

amplitude axis (in dBm) and the waterfall diagram will show the trend of past resource block power 

over certain period. Using a marker function facilitates analysis of accumulated resource block power 

for data utilization. 

 

Setting measure setup 

After configuring test parameters as described in the “Configuring test parameters” on page 202, you 
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can continue your measurement. The measurement settings can be saved and recalled as a file. You 

can also use JDViewer, PC application software to configure a measure setup, save as a file, and load 

the file on to the instrument. 

 

Procedure 

1. Press the MEASURE SETUP hot key. 

2. To set the nominal channel bandwidth to be measured, complete the following steps: 

a. Press the Bandwidth soft key. 

b. Select the bandwidth option: 1.4 MHz, 3 MHz, 5 MHz, 10 MHz, 15 MHz, or 20 MHz. 

3. To select the subframe number to be measured, complete the following steps: 

a. Press the Subframe No soft key. 

b. Enter a value by using the numeric keys. You can also use the rotary knob. 

c. Press the Enter soft key. 

4. Optional. Toggle the Cell ID soft key and select Auto or Manual as desired: 

–  Auto: to let the instrument detect the Cell ID for the LTE signal automatically. 

–  Manual: to set a specific Cell ID for the LTE signal manually in order to speed up the 

synchronization with a BTS. 

5. Optional. To set the threshold for PDSCH, complete the following steps: 

a. Press the PDSCH Threshold soft key. 

b. Enter a value by using the numeric keys. 

c. Press the dB soft key. 

6. To set the time cursor at a specific position, complete the following steps: 

a. Toggle the Time Cursor soft key and select On. 

b. Turn the rotary knob to move the time cursor. You can also enter a value and then press the 
Enter soft key. 

 

 

NOTE 

Enabling the time cursor puts the measurement on hold and you can make post-
processing analysis for each measurement over time using the time cursor. 

7. To start a new measurement, press the Reset/Restart soft key. 

8. Optional. Press the Miscellaneous soft key, and then do the following(s) as needed: 

–  To select the number of antenna ports, toggle the MIMO soft key and select 2x2 or 4x4. 

This MIMO (Multiple Input Multiple Output) setting is activated only if the option 030 LTE-
Advanced FDD is installed with a license number. If not, the instrument sets this option to 
2x2 by default. A 2x1 or 4x1 RF combiner is also required to able to test on MIMO 
channels. 

–  To select the cyclic prefix, toggle the Cyclic Prefix soft key and select Normal or 
Extended. See “Appendix E – Cyclic prefix table” on page 592 for OFDM parameter details 

by different bandwidth. 

9. Optional. Go to SAVE/LOAD > Save, and then select the save option from the choices available 

for your measurement mode. See “Using save” on page 33 for more information. 
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Measurement example 

Figure 113 Datagram measurement with LTE - FDD signal analyzer 

 

 

Route map 

The JD780A Series provides the Route Map function that allows you to collect data of points in an 

indoor or outdoor environment and track the received signals and coverage of RF transmitters by 

plotting data real time directly on top of a loaded floor plan or a map.  

 

If you have obtained user experience data through Viavi’s ariesoGEO and generated raster data files 

from the application, you can load them onto your base map to help you troubleshoot problems easily 

and quickly. 

 

Setting measure setup 

Procedure 

1. If required, connect a GPS receiver to your JD780A series for outdoor mapping. 
Indoor mapping does not necessarily need a GPS antenna. 

2. Configure test parameters as described in the “Configuring test parameters” on page 202. 

3. To load your map file, complete the following steps: 

a. Plug in your USB drive that has a floor map or .mcf file type created in JDMapCreator. If 

the JDMapCreator application on your computer is connected to the instrument via USB or 
LAN, you can send a map file with a single layer to the instrument directly by using the 
Send to EQP menu in JDMapCreator. 

 

 

NOTE 

The JDMapCreator converts and resizes any scanned floor plan or layout to fit onto your 
instrument’s display. JDMapCreator 1.2.0 or later can save a multiple-layered map, 
providing x1, x2, and x4 views, as a sizable map file so that you can zoom in and out 

after loading it. 

b. Press SAVE/LOAD hot key, and then select Load > Load Map. 

See “Using load” on page 36 for more information. 

4. Press the MEASURE SETUP hot key. 
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5. Press the Plot Point soft key, and then select the plot point option from the following choices: 

–  To collect data/plot points automatically as you move around in a vehicle or outside, press 
the GPS soft key and then toggle the Screen Mode soft key between Map and Full. 

 

 

NOTE 
With the Map setting, you can view only the collected points that can be seen within the 

boundary of the loaded map. If a point is off the map, the instrument displays an arrow to 
indicate the direction of the current location on the map and the distance from the center 
to the location at the top of the screen. 
 
With the Full setting, you can view all the collected points of the route without the loaded 

map. 

–  To collect data/plot points manually without a GPS antenna in an indoor environment, press 
the Position soft key. 

6. Press the Plot Item soft key, and then select the measurement option: RSRP, RSRQ, RS-SINR, 
S-SS RSSI, P-SS Power, S-SS Power, or S-SS Ec/Io. 

 

 

NOTE 

The instrument collects the strongest Cell ID’s data to plot points. 

7. Press the Bandwidth soft key to set the nominal channel bandwidth to be measured, and then 
select the bandwidth option: 1.4 MHz, 3 MHz, 5 MHz, 10 MHz, 15 MHz, or 20 MHz. 

8. Toggle the Plot soft key and select Start to start plotting. 

9. Touch directly on the screen or press the ENTER hard key to collect data and plot points on the 
loaded map for the Position setting. 

 

 

NOTE 
For the Position setting, you can change the direction of the route with the arrow keys 

and the distance with the rotary knob. 

10. Toggle the Plot soft key and select Stop to stop plotting. 

11. Press the SAVE/LOAD hot key to save the result. 
See “Using save” on page 33 for more information. 

 

 

NOTE 

The instrument does not automatically save the collected data. It is recommended that 
you save the result. Otherwise, you will lose all the collected data. 

 

 

Setting limit for route map 

You can set the thresholds for each test item. 

 

Procedure 

1. Press the LIMIT hot key. 

2. Select the plot items and set the limits as needed: 
 

To set the limit for Select Set 

RSRP RSRP Excellent, Very Good, Good, Fair, Poor (dBm) 

RSRQ RSRQ Good, Fair, Poor (dB) 

RS-SINR RS-SINR Good, Fair, Poor (dB) 

S-SS RSSI S-SS RSSI Excellent, Very Good, Good, Fair, Poor (dBm) 

P-SS Power P-SS Power Excellent, Very Good, Good, Fair, Poor (dBm) 
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S-SS Power S-SS Power Excellent, Very Good, Good, Fair, Poor (dBm) 

S-SS Ec/Io S-SS Ec/Io Good, Fair, Poor (dB) 

3. Optional. Go to SAVE/LOAD > Save, and then select Save Limit to save the limit settings. 

See “Using save” on page 33 for more information. 

 

Measurement example 

Figure 114 Route map measurement with LTE - FDD OTA signal analyzer 

1) RSRP 

 

2) RSRQ 
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3) RS-SINR 

 

4) S-SS RSSI 

 

5) P-SS Power 
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6) S-SS Power 

 

7) S-SS Ec/Io 

 

 

Controlling a map 

If you have loaded a sizable map that was created in JDMapCreator 1.2.0 or later, you can use the 

Map Control feature that enables you to zoom into the map and view a specific area of interest in detail. 

 

Procedure 

1. Press the TRACE/DISPLAY hard key. 

2. Press the Map Control soft key. This key is active only when you have loaded a sizable map. 

3. Do one of the following: 

–  To zoom into an area of interest directly, complete the following steps: 

a. Toggle the Zoom to soft key and select Area. 

The black rectangle appears on the map. 

b. Press the Zoom In and Zoom Out soft keys, as you need, to decrease and increase 

the selected area. 

c. Move the rectangle by using the four arrow keys, as you need, to place it in a specific 
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area of interest. 

d. Press the center of the rotary knob to zoom into the selected area. You can also press 
the Zoom to soft key again to zoom into the selected area. 

–  To zoom into the center or zoom out from the center, complete the following steps: 

a. Toggle the Zoom to soft key and select Center. 

b. Press the Zoom In and Zoom Out soft keys, as you need, to zoom in and zoom out. 

c. Move the zoomed-in area by using the four arrow keys, as you need. 

 

Loading and displaying raster data 

If you have a set of raster data files generated through the ariesoGEO application, you can load and 

overlay the data on your base map to help you check the signal quality and the strength of 

interferences while driving toward the area of interest. 

 

Procedure 

1. Copy a set of raster data files into your USB memory drive, including the following: 

–  ASCII: .tab, .asc, and .clr files 

–  BIL: .tab,.hdr, .bil, and .clr files 

 

NOTE 

The .tab file type is a geospatial vector data format used in many geographic 

information systems. The color file (.clr) is an optional file, but the image will be 

displayed as a grayscale image without it. The size of the raster map must be  
1024 x 1024 or smaller. 

2. Plug in the USB memory drive to your instrument. 

3. Press the TRACE/DISPLAY hard key. 

4. Press the Load Raster Map soft key. 

The file explorer window appears. 

5. Navigate to the raster file (.tab) you want to open, and then press the Load soft key. 

The raster image appears on top of your base map as shown in Figure 115. 

 

NOTE 

If the area of the loaded raster data is not within the boundary of the base map, you will 
not see the raster image on the screen. 

6. To select the display option, complete the following steps: 

a. Press the Display Options soft key. 

b. Select the option you desire from the choices: On, Off, and Blink. 

7. To adjust the transparency level of the image, complete the following steps: 

a. Press the Transparency soft key. 

b. Enter a value between 0 for opaque and 100 for clear. 

c. Press the Enter soft key. 

 



JD780A Series Analyzers 

 Using LTE - FDD Signal Analyzer 263 

Figure 115 Raster image overlaid on the route map in LTE-FDD OTA signal analyzer 

  

 

Performing RAN performance testing 

The JD780A series provides the optional feature that lets you conduct correlated uplink and downlink 

testing with your instrument connected to your mobile device via Bluetooth. The RANAdvisor TrueSite 

application installed on your smartphone collects data and transfers uplink data based on your 

parameter settings and then your instrument consolidates the data into the measurement results and 

displays them as performance indicators. It helps you troubleshoot a problem and identify the cause of 

the problem fast. 

 

To perform this testing, you need both of these installed: the license for the option 014 LTE-FDD RAN 

Performance Indicator on your instrument and the RANAdvisor TrueSite app with the license on your 

smartphone. 

 

Preparing your smartphone for remote control via Bluetooth 

To set up a Bluetooth connection and enable data collection with remote control properly, you need to 

pair your instrument with your smartphone and set the app’s local Bluetooth control option to Slave 

once at the beginning. 

 

Procedure 

1. Connect a Bluetooth adapter to the USB Host port and an Omni antenna to the RF In port of your 
CellAdvisor instrument. 
The instrument detects the adapter and turns on its Bluetooth automatically. 

2. Make your smartphone visible to your instrument by doing the following steps: 

a. On your smartphone, turn on Bluetooth. 

b. Check the checkbox for Visible to all nearby Bluetooth devices to enable this option. 

3. Pair with your smartphone by doing the following steps: 

a. On your instrument, press the MEASURE SETUP hot key. 

b. Press the Bluetooth Connect soft key. 

c. Press the Scan soft key. 

The instrument lists detected Bluetooth devices with their MAC address and status. 



JD780A Series Analyzers 

264 Using LTE - FDD Signal Analyzer 

d. Highlight your mobile device from the list by touching on the screen. 

e. Press the Pair soft key. 

The pairing dialog box appears on your smartphone. 

f. On your smartphone, enter 0000 and then tap the OK button. 
If pairing is successful, the status of your device on the list changes to “Paired”. 

4. Make sure to set your smartphone as a slave by completing the following steps: 

a. On your smartphone, open the RANAdvisor TrueSite icon. 

b. Go to Settings > General. 

c. Tap the Automation Control Mode menu under Automation Control Options. 

d. Select the Local Bluetooth Control option. 

e. Tap Slave. 

The application restart dialog box appears. 

f. Tap Continue. 

The application closes itself. 

 

NOTE 
It is very important for you to set the local Bluetooth control option to Slave on the 

RANAdvisor TrueSite app in order to give your instrument a control to collect necessary 
data from the app over Bluetooth successfully. 

 

 

Setting parameters on RANAdvisor TrueSiteTM 

To specify uplink measurement data that will be transferred to your instrument, you need to set map 

display parameters of your choice on the RANAdvisor TrueSite application. 

 

Procedure 

1. After you have paired and set your smartphone as a slave, open the RANAdvisor TrueSite icon 

on your device again. 

2. Tap the (+) button at the bottom of the Home screen. 

The Main Screen appears. 

3. Tap the Customization menu. 

The Choose Operation menu box appears. 

4. Select Map Display Parameters > LTE Serving and Neighbor Parameters. 

5. Make sure to check the checkbox for the following two mandatory parameters: 

–  Serving E-ARFCN 

–  Serving Physical Cell-ID 

 

NOTE 

It is very important for you to select these two parameters to identify the Uplink Channel 
Number, Cell ID, Group ID, and Sector ID. 

6. Select other parameters up to six from the list of parameters supported by the CellAdvisor 
instrument. See “Appendix L – Supported map display parameters” on page 609 for more 
information. 

 

NOTE 

As the RANAdvisor TrueSite app can transfer data of up to eight parameters at a time, it 
limits you to select eight parameters in total: two compulsories and six electives. After you 
have selected all eight parameters, the app blocks any further selection. In this case, you 
need to uncheck any selected optional parameters in order to enable other optional 
parameters. 

7. Tap the OK button and then the Back key to return to the Home Screen. 

 

Performing RAN performance testing 

After you have set the local Bluetooth control option and selected desired parameters on the app, you 

need to connect your instrument to your smartphone via Bluetooth to enable data collection from 
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RANAdvisor TrueSite so that you can view consolidated measurement results on your instrument and 

save results as a file. 

 

Procedure 

1. Make sure to have the RANAdvisor TrueSite app opened on your device. 

2. Press the MEASURE SETUP hot key on your instrument. 

3. Press the Bluetooth Connect soft key. 

4. Highlight your paired smartphone to connect from the list. 

5. Press the Connect soft key. 

The connected device information appears above the RAN Performance Indicator chart to 
indicate a successful connection. 

6. The instrument automatically sets the correlated downlink channel number for the received uplink 
channel number and displays measurement results as like Figure 116. Observe the consolidated 

measurement results on the screen for your troubleshooting. 

 

NOTE 

If the Cell ID of the uplink channel is not identical to the one of the downlink channel, the 
instrument displays “---“ for the parameters to indicate invalid measurement results. 

7. If you want to see measurement results for other parameters, select new parameters on the 
RANAdvisor TrueSite app. See “Setting parameters on RANAdvisor TrueSite

TM
” on page 264. 

8. Optional. To save your settings and results, go to SAVE/LOAD > Save and then perform 

functions as you desire. See “Using save” on page 33 for more information. 

 

Measurement example 

Figure 116 RAN performance indicator in LTE-FDD signal analyzer 

 

 

Setting performance score level 

To analyze your measurement data easily with color codes, you can use the limit feature and set a 

performance score level for each measurement parameter. 

Procedure 

1. Press the LIMIT hot key. 

2. To analyze the quality of user experience, do the following as needed: 



JD780A Series Analyzers 

266 Using LTE - FDD Signal Analyzer 

 

To set the level for Select Set 

Data throughput Data Throughput Good, Bad (kbps) 

Channel quality indicator CQI Good, Bad 

Modulation type Modulation Type (On/Off only) 

 

3. To check the performance of eNodeB, do the following as needed: 
 

To set the level for Select Set 

Reference signal received power RSRP Good, Bad (dBm) 

Reference signal received 
quality 

RSRQ Good, Bad (dB) 

Signal to interference and noise 
ratio 

SINR Good, Bad (dB) 

Error vector magnitude More (1/2) > EVM Good, Bad (%) 

Time alignment error More (1/2) > Time Alignment Error Good, Bad (ns) 

Frequency error More (1/2) > Frequency Error Good, Bad (ppm) 
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Using LTE - TDD Signal Analyzer 

This chapter provides instructions for using the LTE - TDD Signal Analyzer (option 029) and LTE-

Advanced TDD Analyzer (option 031) with the LTE - TDD OTA Analyzer (option 049), LTE-TDD 256 

QAM Demodulator (option 033), and the LTE-TDD RAN Performance Indicator (option 015). Topics 

discussed in this chapter are as follows: 

 

 Introduction .............................................................................................................................. 268 

 Display overview ...................................................................................................................... 269 

 Connecting a cable .................................................................................................................. 269 

 Selecting measurement mode ................................................................................................. 271 

 Configuring test parameters .................................................................................................... 271 

 Conducting spectrum measurements ...................................................................................... 276 

 Conducting RF measurements ................................................................................................ 278 

 Conducting power vs. time measurements ............................................................................. 286 

 Conducting modulation measurements ................................................................................... 290 

 Performing auto measurements .............................................................................................. 308 

 Performing power statistics CCDF measurements ................................................................. 315 

 Performing carrier aggregation measurements ....................................................................... 316 

 Conducting LTE - TDD OTA measurements ............................................................................ 319 

 Performing RAN performance testing ..................................................................................... 333 
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Introduction 

The LTE (Long-Term Evolution) Signal Analyzer of the JD780A series performs power and spectrum 

measurements as well as modulation analysis to test the proper transmitter performance of TDD LTE 

systems. It performs conformance testing according to the following standards providing a simple 

Pass/Fail indication on each test. 

 

 3GPP TS 36.104. Evolved Universal Terrestrial Radio Access (E-UTRA); Base Station (BS) 

Radio Transmission and Reception 

 3GPP TS 36.141. Evolved Universal Terrestrial Radio Access (E-UTRA); Base Station (BS) 

Conformance Testing 

 3GPP TS 36.211. Evolved Universal Terrestrial Radio Access (E-UTRA); Physical Channels 

and Modulation 

 3GPP TS 36.212. Evolved Universal Terrestrial Radio Access (E-UTRA); Multiplexing and 

Channel Coding 

 3GPP TS 36.213 V8.2.0. Evolved Universal Terrestrial Radio Access (E-UTRA); Physical 

Layer Procedures 

 

This instrument provides the following measurement tools for TDD LTE system: 

 

 Spectrum Analysis 

 RF Analysis 

- Channel Power 

- Occupied Bandwidth 

- Spectrum Emission Mask 

- Adjacent Channel Leakage power Ratio (ACLR) 

- Multi-ACLR 

- Spurious Emissions 

 Power vs. Time: Slot and Frame 

 Modulation Analysis 

- Constellation 

- Data Channel 

- Control Channel 

- Subframe 

- Time Alignment Error 

- Data Allocation Map 

 Auto Measure 

- Conformance Test 

- Maintenance Test 

- Signal Performance Test 

- DAS Test 

 Power Statistics CCDF 

 Carrier Aggregation 
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 Over The Air (OTA) 

- Channel Scanner 

- ID Scanner 

- Multipath Profile 

- Control Channel 

- Datagram 

- Route Map 

 RAN Performance Indicator 

 

Display overview 

Figure 117 provides descriptions for each segment of the measurement screen. 

 

Figure 117 LTE - TDD signal analyzer measurement screen 

 

 

Connecting a cable 

Direct connection 

Procedure 

1. Connect the Spectrum Analyzer RF In port of the JD780A series and the Power amplifier output 

port of BTS. 
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Figure 118 Direct connection 

 
JD785A/JD786A 

 
JD788A 

 

Indirect connection 

Procedure 

1. Connect the Spectrum Analyzer RF In port of the JD780A series and the monitor (test) port of 

BTS. 

 

Figure 119 Indirect connection 

 
JD785A/JD786A 

 
JD788A 

 

 

CAUTION 
The maximum power for the Spectrum Analyzer RF In port is +25 dBm (0.316 W). If the 
input signal level to be measured is greater than +25 dBm, use a High Power 
Attenuator to prevent damage when you directly connect the signal to the instrument or 
connect the signal from the coupling port of a directional coupler. 

 

Over the air (OTA) 

Procedure 

1. Connect an Omni/directional RF antenna to the Spectrum Analyzer RF In port of the JD780A 

series. 

2. Connect a GPS antenna to the GPS port of the JD780A series. 
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Figure 120 OTA connection 

 
JD785A/JD786A 

 
JD788A 

 

 

CAUTION 

If the input signal level to be measured is less than 0 dBm, set 0 dB attenuation or turn on 
the preamp to have better dynamic range for the OTA testing. 

 

Selecting measurement mode 

Procedure 

1. Press the MODE hard key. 

2. Press the Signal Analyzer soft key. 

3. Press the LTE - TDD soft key. The Spectrum mode is set by default. 

4. Press the MEASURE hot key, and then select the measurement mode option from the following 
choices: 

–  Spectrum 

–  RF Analysis > Channel Power, Occupied BW, Spectrum Emission Mask, ACLR,  
Multi-ACLR, or Spurious Emissions 

–  Power vs Time > Power vs Time (Slot) or Power vs Time (Frame) 

–  Modulation Analysis > Constellation, Data Channel, Control Channel, Subframe,  
Time Alignement Error, or Data Allocation Map 

–  Auto Measure > Conformance Test, Maintenance Test, Signal Perfomance, or DAS Test 

–  Power Statistics CCDF 

–  More (1/2) > Carrier Aggregation 

–  More (1/2) > OTA > Channel Scanner, ID Scanner, Multipath Profile, Control Channel, 
Datagram, or Route Map 

–  More (1/2) > RAN Performance Indicator 

 

 

NOTE 
The Carrier Aggregation soft key is activated if the license for the option 031 LTE-
Advanced TDD is installed and so does the RAN Performance Indicator for the option 

015 LTE-TDD RAN Performance Indicator. 
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Configuring test parameters 

Setting frequency 

You can set the frequency with either frequency or channel number. If a frequency to be set matches 

to the frequency corresponding to the selected channel standard, the instrument calculates its channel 

number and updates the screen with it automatically. 

 

Procedure 

To set the center frequency: 

1. Press the FREQ/DIST hard key. 

2. Toggle the Unit soft key and select Freq. 

3. Press the Center Frequency soft key. 

4. Enter a value by using the numeric keys. You can also use the rotary knob. 

5. Select the unit: GHz, MHz, kHz, or Hz. 

6. Optional. To define the amount of frequency increment for the rotary knob, complete the following 
steps: 

a. Press the Frequency Step soft key. 

b. Enter a value by using the numeric keys. You can also use the rotary knob. 

c. Press the unit: GHz, MHz, kHz, or Hz. 
 
To set the channel number: 

1. Press the FREQ/DIST hard key. 

2. Toggle the Unit soft key and select Channel. 

 

 

NOTE 
Selecting Channel sets the standard channel to Band Global automatically so that you 
can set the Channel Number without choosing a standard channel band from the list. 

3. Press the Channel Number soft key. 

4. Enter a value by using the numeric keys. You can also use the rotary knob. 

5. Press the Enter soft key. 

The instrument automatically displays the corresponding center frequency value for the selected 
channel number. 

6. Optional. To define the amount of channel increment for the rotary knob, complete the following 
steps: 

a. Press the Channel Step soft key. 

b. Enter a value by using the numeric keys. You can also use the rotary knob. 

c. Press the Enter soft key. 

 

 

NOTE 

This frequency setting is not used in the Multi-ACLR and Spurious Emissions modes. 

 

Setting amplitude 

Reference level and attenuation 

You can set the reference and attenuation levels automatically or manually to optimize the display of 

the traces measured, as you desire. 

 



JD780A Series Analyzers 

 Using LTE – TDD Signal Analyzer 273 

Procedure 

To automatically set the reference and attenuation level: 

1. Press the AMP/SCALE hard key. 

2. Press the Auto Scale soft key. 

Each time you press this key, both of the Y-axis scale and input attenuation level change to be 
optimized with some margin. 

 
To set the reference or attenuation level manually: 

1. Press the AMP/SCALE hard key. 

2. To set the maximum reference value on the Y-axis manually, complete the following steps: 

a. Press the Reference Level soft key. 

b. Enter a value by using the numeric keys or the rotary knob with 10 dB increments. 

c. Press the unit soft key or the ENTER hard key. 

 

 

NOTE 
In the measurements such as Control Channel and Subframe, you can select the 
reference option between Relative and Absolute instead. 

3. To set the attenuation option, select one from the following choices: 

–  To set the input attenuator’s level automatically, select Attenuation > Auto. 

 

 

NOTE 
It is recommended that you set the Attenuation to Auto in most situations so that the 

level of the input attenuator can be set automatically according to your input signal level. 

–  To set the input attenuation manually up to 55 dB to optimize S/N, complete the following 
steps: 

a. Select Attenuation > Manual. 

b. Press the Attenuation Value soft key to set the level. 

c. Enter a value between 0 and 55 in fives by using the numeric keys. 

d. Press the dB soft key or the ENTER hard key. 

–  To couple the input attenuator’s level with your reference level setting, select Attenuation > 
Couple. 

As you increase the reference setting, the attenuation level also increases acoordingly. 
 
Optional. To change the scale unit: 

1. Select More (1/2) > Units. 

2. Select the unit of the display scale: dBm, dBV, dBmV, dBµV, V, or W. 

The scale unit on the screen changes accordingly. 

 

 

NOTE 

This Units menu is available in the Spectrum and RF Analysis modes. 
 

 

Scale per division 

You can use the Scale/Div feature available for the spectrum and RF analysis. It represents the value 

of one division on the horizontal scale. The default setting is 10 dB per division and the maximum 

value can be set up to 20 dB. 
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Procedure 

To set the scale per division: 

1. Press the AMP/SCALE hard key. 

2. Select More (1/2) > Scale/Div. 

3. Enter a value between 1 and 20 by using the numeric keys. 

4. Press the dB soft key to complete the entry. 

 

Pre-amplifier 

You can turn the internal pre-amplifier on to correct and compensate for the gain of the preamp so that 

amplitude readings show the value at the input connector. 

 

Procedure 

1. Press the AMP/SCALE hard key. 

2. Toggle the Preamp soft key and select On or Off as needed. 

 

 

NOTE 

You can turn the Preamp on when the input attenuation range is from 0 dB to 10 dB. If 
the attenuation value is manually set to greater than 10 dB, the instrument will 
automatically turn off the pre-amplifier to display low-level signal properly on the chart. 

 

External offset 

You can turn the External Offset on and manually set the external offset value. An offset consists of a 

cable loss and a user offset and the measurement result shows the value reflecting both offset values. 

When the external offset value is set at 40 dB in the Spectrum mode, the measurement result 

compensates 40 dB at both the Spectrum Analyzer and Signal Analyzer modes 

 

Procedure 

To set the external offset: 

1. Press the AMP/SCALE hard key. 

2. Toggle the External Offset soft key and select On. 

3. Enter a value by using the numeric keys. 

4. Press the dB soft key to complete the entry. 

 
To turn the external offset off: 

1. Press the AMP/SCALE hard key. 

2. Toggle the External Offset soft key and select Off. 

 

Setting average 

You can set the number of measurements to be averaged for the trace presentation. A maximum of 

100 times of averaging can be set. When the averaging reaches to your setting, a new measurement 

value replaces the measurement value in sequence from the earliest. 
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Procedure 

1. Press the BW/AVG hard key. 

2. Press the Average soft key. 

3. Enter a value between 1 and 100 as needed by using the numeric keys. 

4. Press the Enter soft key. 

 

Setting sweep mode 

The default setting is Continue to sweep continuously for most on-going measurements. If you want to 

hold the measurement or get a single sweep, you can change the sweep mode. 

 

Procedure 

To select the single sweep mode: 

1. Press the SWEEP hot key. 

2. Toggle the Sweep Mode soft key and select Single. You can also use the HOLD hot key. 

The letter HOLD in red appears and the sweeping is paused. 

3. Optional. Press the Sweep Once soft key to get a new measurement. 
 
To return to the continuous sweep mode: 

1. Toggle the Sweep Mode soft key and select Continue. You can also use the HOLD hot key. 

The letter HOLD in red disappears and the sweeping resumes. 

 

Setting trigger source 

You can set the trigger source option for your measurements. 

Procedure 

1. Press the TRIGGER hot key. 

2. Select the trigger source option from the following choices: Internal, External, or GPS. 

 

Setting external clock 

To enhance the reliability of modulation analysis measurements the JD780A series must be 

synchronized with a base station. When an external clock is not supplied, the instrument works with its 

built-in internal high-accuracy time base and some measurement results may exhibit inaccurate values. 

Therefore, it is highly recommended that you use the same reference clock as the signal source. You 

can use the TRIGGER hot key to set the external clock. 
 

Figure 121 Connection ports for external reference clock 
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Procedure 

1. Connect an external reference or a GPS antenna to the JD780A series. 

2. Press the SYSTEM hot key. 

3. Press the Freq Reference soft key, and then select the reference option: Internal, External 10 
MHz, External 13 MHz, External 15 MHz, or GPS. 

 

Table 14 External reference indicators 

Type Indicator Description 

Internal  (green) The green INT icon indicates that the instrument uses the built-in 

internal time base. 

External  (green) The green EXT icon indicates that an external reference is connected 

and locked and that the instrument uses the same reference clock as 
the signal source. 

External  (red) The red EXT icon indicates that an external reference is connect but not 

locked. 

GPS (green) The green GPS antenna icon indicates that a GPS antenna is 
connected and locked. 

GPS (yellow) The yellow GPS antenna icon indicates that a GPS antenna is 
connected and locking is in progress. 

GPS (grey) The grey GPS antenna icon indicates that a GPS antenna is not 
connected, failed, or unable to be locked. 

 

Conducting spectrum measurements 

Setting measure setup 

After configuring test parameters as described in the “Configuring test parameters” on page 271, you 

can continue your measurement. 

 

Procedure 

1. Press the MEASURE SETUP hot key. 

2. To set the nominal channel bandwidth to be measured, complete the following steps: 

a. Press the Bandwidth soft key. 

b. Select the bandwidth option: 1.4 MHz, 3 MHz, 5 MHz, 10 MHz, 15 MHz, or 20 MHz. 

3. To select the subframe number to be measured, complete the following steps: 

a. Press the Subframe No soft key. 

b. Enter a value by using the numeric keys. You can also use the rotary knob. 

c. Press the Enter soft key. 

4. If you enable the gated sweep for the guard period, you can easily identify the existence of the 
interference in uplink call activities. 

a. To turn it on, toggle the Guard Period soft key and select Enable. 

The Subframe No menu deactivates. 

b. To turn it off, toggle the Guard Period soft key and select Disable. 
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NOTE 

In LTE-TDD, the guard period is a special subframe, normally Subframe #1 and optionally 
Subframe #6, where there happens the switching from DL to UL. You should not see any 
data transmission in the guard period spectrum. 

5. Toggle the Cell ID soft key and select Auto or Manual as desired: 

–  Auto: to let the instrument detect the Cell ID for the LTE signal automatically. 

–  Manual: to set a specific Cell ID for the LTE signal manually in order to speed up the 

synchronization with a BTS. 

 

Your measurement result is displayed on the screen as like the following example, Figure 122. 

 

Figure 122 Spectrum measurement screen with LTE - TDD signal analyzer 

 

 

Setting trace 

You can display up to six traces on the measurement chart simultaneously. 

 

Procedure 

1. Press the TRACE/DISPLAY hard key. 

2. Press the Select Trace soft key, and then select the trace number: T1, T2, T3, T4, T5, or T6. 

The legend shape of the selected trace changes from square to round to indicate that the trace is 
the active one now. 

3. Do one of the following: 
 

To Select Trace Legend 

Clear current data and display with new 
measurements 

Clear Write W 

Display the input signal’s maximum response only 
(unlimited or for a certain amount of time) 

Max Hold M 

Display the input signal’s minimum response only 
(unlimited or for a certain amount of time) 

Min Hold m 
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Capture the selected trace and compare traces Capture C 

Load a saved trace More (1/2) > Load L 

Hide the selected trace Trace View > Off F 

Remove all the traces and initialize the trace settings More (1/2) > 
Trace Clear All 

 

 

 

NOTE 
For the Max Hold and Min Hold, your instrument compares newly acquired data with the 

active trace and displays larger maximum values or smaller minimum values on the 
screen. You can set it to Unlimited to hold and view maximum or minimum data or 

specify a certain amount of time up to 60 seconds by using numeric keys or the rotary 
knob. 

4. Optional. Press the More (1/2) > Trace Info soft key, and then select the trace number to view 
the trace’s parameter setting information stored at the time of the measurement or None to hide 

the information display. 

5. Optional. If you have the two traces T1 and T2, you can perform trace math. To view the power 
difference between the traces, press the T1 – T2 -> T5 or T2 – T1 -> T6 soft key. 

The result is overlaid on the screen along with the second Y-axis. 

 

Conducting RF measurements 

Channel power 

The Channel Power measurement is a common test used in the wireless industry to measure the total 

transmitted power of a radio within a defined frequency channel. It acquires a number of points 

representing the input signal in the time domain, transforms this information into the frequency domain 

using Fast Fourier Transform (FFT), and then calculates the channel power. The effective resolution 

bandwidth of the frequency domain trace is proportional to the number of points acquired for the FFT. 

 

The channel power measurement identifies the total RF power and power spectral density (PSD) of 

the signal in the LTE channel bandwidth. 

 

Setting measure setup 

After configuring test parameters as described in the “Configuring test parameters” on page 271, you 

can continue your measurement. 

 

Procedure 

1. Press the MEASURE SETUP hot key. 

2. To set the nominal channel bandwidth to be measured, complete the following steps: 

a. Press the Bandwidth soft key. 

b. Select the bandwidth option: 1.4 MHz, 3 MHz, 5 MHz, 10 MHz, 15 MHz, or 20 MHz. 

3. To select the subframe number to be measured, complete the following steps: 

a. Press the Subframe No soft key. 

b. Enter a value by using the numeric keys. You can also use the rotary knob. 

c. Press the Enter soft key. 

4. Toggle the Cell ID soft key and select Auto or Manual as desired: 
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–  Auto: to let the instrument detect the Cell ID for the LTE signal automatically. 

–  Manual: to set a specific Cell ID for the LTE signal manually in order to speed up the 

synchronization with a BTS. 

 

Measurement example 

Figure 123 Channel power measurement with LTE - TDD signal analyzer 

 

 

 

NOTE 
You can use the LIMIT hot key to analyze your measurements with the user-definable 

limit and Pass/Fail indication. See “Setting limit for RF tests” on page 285 for more 
information. 

 

Occupied bandwidth 

The Occupied Bandwidth measures the spectrum shape of the carrier. It is defined as the bandwidth, 

which includes 99% of the transmitted power among total transmitted power. 

 

Setting measure setup 

After configuring test parameters as described in the “Configuring test parameters” on page 271, you 

can continue your measurement. 

 

Procedure 

1. Press the MEASURE SETUP hot key. 

2. To set the nominal channel bandwidth to be measured, complete the following steps: 

a. Press the Bandwidth soft key. 

b. Select the bandwidth option: 1.4 MHz, 3 MHz, 5 MHz, 10 MHz, 15 MHz, or 20 MHz. 

3. To select the subframe number to be measured, complete the following steps: 

a. Press the Subframe No soft key. 

b. Enter a value by using the numeric keys. You can also use the rotary knob. 
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c. Press the Enter soft key. 

4. Toggle the Cell ID soft key and select Auto or Manual as desired: 

–  Auto: to let the instrument detect the Cell ID for the LTE signal automatically. 

–  Manual: to set a specific Cell ID for the LTE signal manually in order to speed up the 

synchronization with a BTS. 

 

Measurement example 

Figure 124 Occupied bandwidth measurement with LTE - TDD signal analyzer 

 

 

 

NOTE 
You can use the LIMIT hot key to analyze your measurements with the user-definable 
limit and Pass/Fail indication. See “Setting limit for RF tests” on page 285 for more 
information. 

 

Spectrum emission mask (SEM) 

The Spectrum Emission Mask (SEM) measurement required by 3GPP specifications encompasses 

different power limits and different measurement bandwidths (resolution bandwidths) at various 

frequency offsets. It may be expressed as a ratio of power spectral densities between the carrier and 

the specified offset frequency band. It provides useful figures-of-merit for the spectral re-growth and 

emissions produced by components and circuit blocks, without the rigor of performing a full SEM 

measurement. 

 

The SEM measures spurious signal levels in up to five pairs of offset or region frequencies and relates 

them to the carrier power. 

 

Setting measure setup 

After configuring test parameters as described in the “Configuring test parameters” on page 271, you 

can continue your measurement. 
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Procedure 

1. Press the MEASURE SETUP hot key. 

2. To set the nominal channel bandwidth to be measured, complete the following steps: 

a. Press the Bandwidth soft key. 

b. Select the bandwidth option: 1.4 MHz, 3 MHz, 5 MHz, 10 MHz, 15 MHz, or 20 MHz. 

3. To select the mask type, complete the following steps: 

a. Press the Mask Type soft key. 

b. Select the mask type option, from the following choices: 

–  Wide Area BS Category A 

–  Wide Area BS Category B 

–  Local Area BS 

–  Home BS 

4. To select the subframe number to be measured, complete the following steps: 

a. Press the Subframe No soft key. 

b. Enter a value by using the numeric keys. You can also use the rotary knob. 

c. Press the Enter soft key. 

5. Toggle the Cell ID soft key and select Auto or Manual as desired: 

–  Auto: to let the instrument detect the Cell ID for the LTE signal automatically. 

–  Manual: to set a specific Cell ID for the LTE signal manually in order to speed up the 

synchronization with a BTS. 

 

Measurement example 

Figure 125 SEM measurement with LTE - TDD signal analyzer 

 

 

 

NOTE 
You can use the LIMIT hot key to analyze your measurements with the user-definable 
limit and Pass/Fail indication. See “Setting limit for RF tests” on page 285 for more 
information. 
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ACLR 

The Adjacent Channel Leakage power Ratio (ACLR) measures the amount of interference or power in 

an adjacent frequency channel according to the standards. 

 

Setting measure setup 

After configuring test parameters as described in the “Configuring test parameters” on page 271, you 

can continue your measurement. 

 

Procedure 

1. Press the MEASURE SETUP hot key. 

2. To set the nominal channel bandwidth to be measured, complete the following steps: 

a. Press the Bandwidth soft key. 

b. Select the bandwidth option: 1.4 MHz, 3 MHz, 5 MHz, 10 MHz, 15 MHz, or 20 MHz. 

3. To select the subframe number to be measured, complete the following steps: 

a. Press the Subframe No soft key. 

b. Enter a value by using the numeric keys. You can also use the rotary knob. 

c. Press the Enter soft key. 

4. Toggle the Cell ID soft key and select Auto or Manual as desired: 

–  Auto: to let the instrument detect the Cell ID for the LTE signal automatically. 

–  Manual: to set a specific Cell ID for the LTE signal manually in order to speed up the 

synchronization with a BTS. 

 

Measurement example 

Figure 126 ACLR measurement with LTE - TDD signal analyzer 

 

 

 

NOTE 
You can use the LIMIT hot key to analyze your measurements with the user-definable 

limit and Pass/Fail indication. See “Setting limit for RF tests” on page 285 for more 
information. 
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Multi-ACLR 

The Multi-ACLR measurement is used to perform multi-channel ACLR measurements with as many 

channels as possible. It helps you to measure ACLR in multi-channel transmitting Base Station 

environment. 

 

Setting measure setup 

After configuring test parameters as described in the “Configuring test parameters” on page 271, you 

can continue your measurement. 

 

Procedure 

1. Press the MEASURE SETUP hot key. 

2. To set the nominal channel bandwidth to be measured, complete the following steps: 

a. Press the Bandwidth soft key. 

b. Select the bandwidth option: 1.4 MHz, 3 MHz, 5 MHz, 10 MHz, 15 MHz, or 20 MHz. 

3. To set the frequency, do one of the following: 

–  To set the center frequency, complete the following steps: 

a. Toggle the Unit soft key and select Freq. 

b. Press the Lowest Frequency soft key to set the starting center frequency. 

c. Enter a value by using the numeric keys. You can also use the rotary knob. 

d. Select the unit: GHz, MHz, kHz, or Hz. 

e. Press the Highest Frequency soft key to set the stopping center frequency. 

f. Enter a value by using the numeric keys. You can also use the rotary knob. 

g. Select the unit: GHz, MHz, kHz, or Hz. 

–  To set the channel number, complete the following steps: 

a. Toggle the Unit soft key and select Channel. 

 

 

NOTE 
Selecting Channel sets the standard channel to Band Global automatically so that you 
can set the Channel Number without choosing a standard channel band from the list. 

b. Press the Lowest Channel soft key to set the starting channel. 

c. Enter a value by using the numeric keys. You can also use the rotary knob. 

d. Press the Enter soft key. 

e. Press the Highest Channel soft key to set the stopping channel. 

f. Enter a value by using the numeric keys. You can also use the rotary knob. 

g. Press the Enter soft key. 
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Measurement example 

Figure 127 Multi-ACLR measurement with LTE - TDD signal analyzer 

 

 

 

NOTE 

You can use the LIMIT hot key to analyze your measurements with the user-definable 
limit and Pass/Fail indication. See “Setting limit for RF tests” on page 285 for more 
information. 

 

Spurious emissions 

Out-of-band emissions are unwanted emissions immediately outside the channel bandwidth resulting 

from the modulation process and non-linearity in the transmitter but excluding spurious emissions. The 

Spurious Emissions measurement is to identify and determine the power level of out-of-band spurious 

emission within the necessary channel bandwidth and modulated signal measured at the RF port of 

the Base Station. 

 

Setting measure setup 

After configuring test parameters as described in the “Configuring test parameters” on page 271, you 

can continue your measurement. 

 

Procedure 

1. Press the MEASURE SETUP hot key. 

2. To set up the range table and parameters, press the Range Table soft key and then complete 

the following steps: 

a. Press the Range soft key, and then select the range number between 1 and 20 to add  

as a new or change the existing settings. 

b. Do the following as desired: 

–  Select Start Frequency, and then specify the start frequency for the selected range. 

–  Select Stop Frequency, and then specify the stop frequency for the selected range. 

–  Select Start Limit, and then specify the lower limit for Pass/Fail indication. 

–  Select Stop Limit, and then specify the upper limit for Pass/Fail indication. 
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–  Select More (1/2) > Attenuation, and then specify an value in the multiple of five. 

–  Select More (1/2) > RBW, and then specify a RBW value. 

–  Select More (1/2) > VBW, and then specify a VBW value. 

c. Press the PREV hard key. 

d. Toggle the Range soft key and select On to display the selected range in the result table or 

Off to hide it from the table. 

3. Toggle the Measure Type soft key between Examine and Full to select the measurement type. 

 

NOTE 
The Examine mode displays only the selected range while the Full mode lets the 

instrument automatically changes the selected range from one another. 

4. To set the number of measurements to be averaged, complete the following steps: 

a. Press the Average soft key. 

b. Enter a value between 1 and 100. 

c. Press the Enter soft key. 

5. To move the highlighted bar in the result table to other range, complete the following steps: 

a. Press the Range soft key in the Measure Setup menu bar. 

b. Enter a value between 1 and 20. 

c. Press the Enter soft key. 

 

Measurement example 

Figure 128 Spurious emissions measurement with LTE - TDD signal analyzer 

 

 

 

NOTE 
You can use the LIMIT hot key to analyze your measurements with the user-definable 
limit and Pass/Fail indication. See “Setting limit for RF tests” on page 285 for more 
information. 

 

Setting limit for RF tests 

By default, test limits specified in the standard are set for you. You can change thresholds if you desire. 
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Procedure 

1. Press the LIMIT hot key. 

2. Press the RF Test Limits soft key. 

3. Select the test item(s) and set the limit(s) depending on your selected measurement mode: 
 

To set the limit for Select Set 

Channel power Channel Power High Limit 
Low Limit 

Occupied bandwidth Occupied BW High Limit 

Spectrum emission mask Spectrum Emission Mask (On/Off only) 

ACLR ACLR (On/Off only) 

Multi-ACLR Multi-ACLR (On/Off only) 

Spurious emissions Spurious Emissions (On/Off only) 

4. Optional. You can enable alarm sound that goes off if the measurement falls outside of the limit. 
Toggle the Beep soft key between On and Off to enable or disable the beep sound. 

5. Optional. Go to SAVE/LOAD > Save, and then select Save Limit to save the limit settings. 

See “Using save” on page 33 for more information. 

 

Conducting power vs. time measurements 

The Power vs. Time measurement measures the modulation envelope in the time domain, showing the 

signal rise and fall shape of LTE signal and the power of each time slot in an LTE signal. 

 

Power vs. time (slot) 

The Power vs. Time (Slot) in LTE - TDD Signal Analyzer measures the modulation envelope in the 

time domain, showing the signal rise and fall shapes of LTE signal. 

 

 

NOTE 

In this measurement, desirable level of the input power is lower than -10 dBm. If the input 
power to be measured is -10 dBm or higher, it is highly recommended that you use an 
external attenuator. 

 

Setting measure setup 

After configuring test parameters as described in the “Configuring test parameters” on page 271, you 

can continue your measurement. The measurement settings can be saved and recalled as a file. 

 

Procedure 

1. Press the MEASURE SETUP hot key. 

2. To set the nominal channel bandwidth to be measured, complete the following steps: 

a. Press the Bandwidth soft key. 

b. Select the bandwidth option: 1.4 MHz, 3 MHz, 5 MHz, 10 MHz, 15 MHz, or 20 MHz. 

3. To select the slot number to be measured, complete the following steps: 
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a. Press the Slot No soft key. 

b. Enter a value by using the numeric keys. You can also use the rotary knob. 

c. Press the Enter soft key. 

4. Toggle the Cell ID soft key and select Auto or Manual as desired: 

–  Auto: to let the instrument detect the Cell ID for the LTE signal automatically. 

–  Manual: to set a specific Cell ID for the LTE signal manually in order to speed up the 

synchronization with a BTS. 

5. Optional. Press the Miscellaneous soft key, and then do the following(s) as needed: 

–  To select the number of antenna ports, toggle the MIMO soft key and select 2x2 or 4x4. 

This MIMO (Multiple Input Multiple Output) setting is activated only if the option 031 LTE-
Advanced TDD is installed with a license number. If not, the instrument sets this option to 
2x2 by default. A 2x1 or 4x1 RF combiner is also required to able to test on MIMO 
channels. 

–  To assign a antenna port number automatically or manually, press the Antenna Port soft 
key and select the option: Auto, 0, 1, 2, and 3. If the option 031 LTE-Advanced TDD is not 

installed or if the MIMO is set to 2x2, the antenna ports 2 and 3 are disabled. 

–  To select the cyclic prefix, toggle the Cyclic Prefix soft key and select Normal or 
Extended. See “Appendix E – Cyclic prefix table” on page 592 for OFDM parameter details 

by different bandwidth. 

–  To set the delay, complete the following steps: 

a. Press the Delay soft key to set the amount of delay in µs. 

b. Enter a value by using the numeric keys. You can also use the rotary knob. 

c. Press the µs soft key. 

 

 

NOTE 

The Delay setting is used only when there is a time offset in the signals to be measured. 

 

Setting limit for power vs. time tests 

Procedure 

1. Press the LIMIT hot key. 

2. Press the PvsT Test Limits soft key. 

3. Select the test item(s) and set the limit(s): 
 

To set the limit for Select Set 

Slot average power Slot Avg Power High Limit,  
Low Limit 

Off power Off Power High Limit 

Transition period Transition Period High Limit 

4. Optional. You can enable alarm sound that goes off if the measurement falls outside of the limit. 
Toggle the Beep soft key between On and Off to enable or disable the beep sound. 

5. Optional. Go to SAVE/LOAD > Save, and then select Save Limit to save the limit settings. 

See “Using save” on page 33 for more information. 
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Measurement example 

Figure 129 Power vs. time (slot) measurement with LTE – TDD signal analyzer 

1) Off to on 

 

2) On to off 

 

 

Power vs. time (frame) 

The Power vs. Time (Frame) measures the modulation envelope in the time domain, showing the 

power of each time slot in an LTE signal. 

 

Setting measure setup 

After configuring test parameters as described in the “Configuring test parameters” on page 271, you 

can continue your measurement. The measurement settings can be saved and recalled as a file. 

 

Procedure 

1. Press the MEASURE SETUP hot key. 
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2. To set the nominal channel bandwidth to be measured, complete the following steps: 

a. Press the Bandwidth soft key. 

b. Select the bandwidth option: 1.4 MHz, 3 MHz, 5 MHz, 10 MHz, 15 MHz, or 20 MHz. 

3. To select the subframe number to be measured, complete the following steps: 

a. Press the Subframe No soft key. 

b. Enter a value by using the numeric keys. You can also use the rotary knob. 

c. Press the Enter soft key. 

4. Toggle the Cell ID soft key and select Auto or Manual as desired: 

–  Auto: to let the instrument detect the Cell ID for the LTE signal automatically. 

–  Manual: to set a specific Cell ID for the LTE signal manually in order to speed up the 

synchronization with a BTS. 

5. Optional. Press the Miscellaneous soft key, and then do the following(s) as needed: 

–  To select the number of antenna ports, toggle the MIMO soft key and select 2x2 or 4x4. 

This MIMO (Multiple Input Multiple Output) setting is activated only if the option 031 LTE-
Advanced TDD is installed with a license number. If not, the instrument sets this option to 
2x2 by default. A 2x1 or 4x1 RF combiner is also required to able to test on MIMO 
channels. 

–  To assign a antenna port number automatically or manually, press the Antenna Port soft 
key and select the option: Auto, 0, 1, 2, and 3. If the option 031 LTE-Advanced TDD is not 

installed or if the MIMO is set to 2x2, the antenna ports 2 and 3 are disabled. 

–  To select the cyclic prefix, toggle the Cyclic Prefix soft key and select Normal or 
Extended. See “Appendix E – Cyclic prefix table” on page 592 for OFDM parameter details 

by different bandwidth. 

–  To set the delay, complete the following steps: 

a. Press the Delay soft key to set the amount of delay in µs. 

b. Enter a value by using the numeric keys. You can also use the rotary knob. 

c. Press the µs soft key. 

 

 

NOTE 

The Delay setting is used only when there is a time offset in the signals to be measured. 
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Measurement example 

Figure 130 Power vs. time (frame) measurement with LTE – TDD signal analyzer 

 

 

Conducting modulation measurements 

Constellation 

The Constellation is used to observe some aspects of modulation accuracy and can reveal certain 

fault mechanisms such as I/Q amplitude imbalance or quadrature imbalance. It displays constellation 

diagram by modulation types. 

 

Setting measure setup 

After configuring test parameters as described in the “Configuring test parameters” on page 271, you 

can continue your measurement. The measurement settings can be saved and recalled as a file. You 

can also use JDViewer, PC application software to configure a measure setup, save as a file, and load 

the file on to the instrument. 

 

Procedure 

1. Press the MEASURE SETUP hot key. 

2. To set the nominal channel bandwidth to be measured, complete the following steps: 

a. Press the Bandwidth soft key. 

b. Select the bandwidth option: 1.4 MHz, 3 MHz, 5 MHz, 10 MHz, 15 MHz, or 20 MHz. 

3. To select the subframe number to be measured, complete the following steps: 

a. Press the Subframe No soft key. 

b. Enter a value by using the numeric keys. You can also use the rotary knob. 
 

 

NOTE 

For MBMS testing, this subframe number must be neither 0 nor 5 as these subframes 0 
and 5 are not available for MBMS and it must be set to the MBMS transmitted channel’s 
subframe number. 

c. Press the Enter soft key. 
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4. Optional. Toggle the Cell ID soft key and select Auto or Manual as desired: 

–  Auto: to let the instrument detect the Cell ID for the LTE signal automatically. 

–  Manual: to set a specific Cell ID for the LTE signal manually in order to speed up the 

synchronization with a BTS. 

5. Optional. Toggle the CFI soft key and select Auto or Manual as desired: 

–  Auto: to let the instrument set the number of OFDM symbols used for transmitting PDCCHs 

in a subframe. 

–  Manual: to set the number of OFDM symbols manually. The set of OFDM symbols that can 
be used for PDCCH in a subframe is given by 0, 2, 3 or 4 in 1.4 MHz bandwidth and 1, 2, or 
3 in other bandwidths. 

6. Optional. Press the PHICH Ng soft key, and then select the option for the number of PHICH 
groups (Ng): 1/6, 1/2, 1, 2, E-1/6, E-1/2, E-1, or E-2. 

7. Press the Uplink-Downlink Configuration soft key, and then select the number of 

uplink/downlink between one and six. 

8. Optional. Press the Miscellaneous soft key, and then do the following(s) as needed: 

–  To select the number of antenna ports, toggle the MIMO soft key and select 2x2 or 4x4. 

This MIMO (Multiple Input Multiple Output) setting is activated only if the option 031 LTE-
Advanced TDD is installed with a license number. If not, the instrument sets this option to 
2x2 by default. A 2x1 or 4x1 RF combiner is also required to able to test on MIMO 
channels. 

–  To assign a antenna port number automatically or manually, press the Antenna Port soft 
key and select the option: Auto, 0, 1, 2, and 3. If the option 031 LTE-Advanced TDD is not 

installed or if the MIMO is set to 2x2, the antenna ports 2 and 3 are disabled. 

–  To turn the Multimedia Broadcast Multicast Service (MBMS) feature on or off, toggle the 
MBMS soft key and select On or Off. For proper MBMS testing, you need to set the 
Subframe No with the same PMCH subframe number. If this setting is on, either PMCH or 

PDSCH appears on the screen depending on the detected channel. 

–  To set the Multicast Broadcast Single Frequency Network (MBSFN) detection automatically 
or manually for MBMS testing, toggle the MBSFN soft key and select Auto or Manual. An 

automatically detected or manually entered MBSFN ID appears on the screen. 

–  To set the delay, complete the following steps: 

a. Press the Delay soft key to set the amount of delay in µs. 

b. Enter a value by using the numeric keys. You can also use the rotary knob. 

c. Press the µs soft key. 
 

 

NOTE 

The Delay setting is used only when there is a time offset in the signals to be measured. 

–  To select the cyclic prefix, toggle the Cyclic Prefix soft key and select Normal or 
Extended. See “Appendix E – Cyclic prefix table” on page 592 for OFDM parameter details 

by different bandwidth. 

–  Press the PDSCH Modulation Type soft key, and then select the modulation type option: 
Auto, QPSK, 16 QAM, 64 QAM, E-TM3.3, E-TM3.2, E-TM3.1, E-TM2, E-TM1.2, and E-
TM1.1. If two or more modulation types are used in a frame, select Auto. If the PDSCH 

uses the same modulation type in a frame or in a subframe, select a specific modulation 
type to get more accurate EVM. 

 

NOTE 
If you have installed a license for the option 033 LTE-TDD 256 QAM Demodulator on 
your CellAdvisor, you will have additional PDSCH modulation types of 256 QAM,  
E-TM3.1a, and E-TM2a. 

–  To set the threshold for PDSCH, complete the following steps: 

a. Press the PDSCH Threshold soft key. 

b. Enter a value by using the numeric keys. 
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c. Press the dB soft key. 

–  Toggle the PDSCH Precoding soft key between On and Off to enable or disable the 

PDSCH precoding. 

 

Measurement example 

Figure 131 Constellation measurement with LTE - TDD signal analyzer 

 

 

Figure 132 Constellation measurement with LTE - TDD signal analyzer (MBMS On) 

 

 

 

NOTE 
You can use the LIMIT hot key to analyze your measurements with the user-definable 

limit and Pass/Fail indication. See “Setting limit for modulation tests” on page 307 for 
more information. 
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Data channel 

The Data Channel measures the constellation for the specified resource block as well as the 

modulation accuracy of each PDSCH at the specified subframe. 

 

Setting measure setup 

After configuring test parameters as described in the “Configuring test parameters” on page 271, you 

can continue your measurement. The measurement settings can be saved and recalled as a file. You 

can also use JDViewer, PC application software to configure a measure setup, save as a file, and load 

the file on to the instrument. 

 

Procedure 

1. Press the MEASURE SETUP hot key. 

2. To set the nominal channel bandwidth to be measured, complete the following steps: 

a. Press the Bandwidth soft key. 

b. Select the bandwidth option: 1.4 MHz, 3 MHz, 5 MHz, 10 MHz, 15 MHz, or 20 MHz. 

3. To select the subframe number to be measured, complete the following steps: 

a. Press the Subframe No soft key. 

b. Enter a value by using the numeric keys. You can also use the rotary knob. 
 

 

NOTE 

For MBMS testing, this subframe number must be neither 0 nor 5 as these subframes 0 
and 5 are not available for MBMS and it must be set to the MBMS transmitted channel’s 
subframe number. 

c. Press the Enter soft key. 

4. Optional. Toggle the Cell ID soft key and select Auto or Manual as desired: 

–  Auto: to let the instrument detect the Cell ID for the LTE signal automatically. 

–  Manual: to set a specific Cell ID for the LTE signal manually in order to speed up the 

synchronization with a BTS. 

5. Optional. Toggle the CFI soft key and select Auto or Manual as desired: 

–  Auto: to let the instrument set the number of OFDM symbols used for transmitting PDCCHs 

in a subframe. 

–  Manual: to set the number of OFDM symbols manually. The set of OFDM symbols that can 
be used for PDCCH in a subframe is given by 0, 2, 3 or 4 in 1.4 MHz bandwidth and 1, 2, or 
3 in other bandwidths. 

6. Optional. Press the PHICH Ng soft key, and then select the option for the number of PHICH 
groups (Ng): 1/6, 1/2, 1, 2, E-1/6, E-1/2, E-1, or E-2. 

7. Toggle the Event Hold soft key between On and Off to enable or disable the event hold feature. 

When enabled, the display line for the PDSCH threshold appears. 
When an event occurs, the measurement is put on hold until you press the HOLD hot key. 

 

 

NOTE 

You can view detailed current resource block on the I-Q diagram, particularly in a 
dynamic field environment. 

8. Press the More (1/2) > Uplink-Downlink Configuration soft key, and then select the number of 

uplink/downlink between one and six. 

9. Optional. Press the More (1/2) > Miscellaneous soft key, and then do the following(s) as 

needed: 

–  To select the number of antenna ports, toggle the MIMO soft key and select 2x2 or 4x4. 
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This MIMO (Multiple Input Multiple Output) setting is activated only if the option 031 LTE-
Advanced TDD is installed with a license number. If not, the instrument sets this option to 
2x2 by default. A 2x1 or 4x1 RF combiner is also required to able to test on MIMO 
channels. 

–  To assign a antenna port number automatically or manually, press the Antenna Port soft 
key and select the option: Auto, 0, 1, 2, and 3. If the option 031 LTE-Advanced TDD is not 

installed or if the MIMO is set to 2x2, the antenna ports 2 and 3 are disabled. 

–  To turn the Multimedia Broadcast Multicast Service (MBMS) feature on or off, toggle the 
MBMS soft key and select On or Off. For proper MBMS testing, you need to set the 
Subframe No with the same PMCH subframe number. If this setting is on, either PMCH or 

PDSCH appears on the screen depending on the detected channel. 

–  To set the Multicast Broadcast Single Frequency Network (MBSFN) detection automatically 
or manually for MBMS testing, toggle the MBSFN soft key and select Auto or Manual. An 

automatically detected or manually entered MBSFN ID appears on the screen. 

–  To set the delay, complete the following steps: 

a. Press the Delay soft key to set the amount of delay in µs. 

b. Enter a value by using the numeric keys. You can also use the rotary knob. 

c. Press the µs soft key. 
 

 

NOTE 

The Delay setting is used only when there is a time offset in the signals to be measured. 

–  To select the cyclic prefix, toggle the Cyclic Prefix soft key and select Normal or 
Extended. See “Appendix E – Cyclic prefix table” on page 592 for OFDM parameter details 

by different bandwidth. 

–  Press the PDSCH Modulation Type soft key, and then select the modulation type option: 
Auto, QPSK, 16 QAM, 64 QAM, E-TM3.3, E-TM3.2, E-TM3.1, E-TM2, E-TM1.2, and E-
TM1.1. If two or more modulation types are used in a frame, select Auto. If the PDSCH 

uses the same modulation type in a frame or in a subframe, select a specific modulation 
type to get more accurate EVM. 

 

NOTE 
If you have installed a license for the option 033 LTE-TDD 256 QAM Demodulator on 
your CellAdvisor, you will have additional PDSCH modulation types of 256 QAM,  
E-TM3.1a, and E-TM2a. 

–  To set the threshold for PDSCH, complete the following steps: 

a. Press the PDSCH Threshold soft key. 

b. Enter a value by using the numeric keys. 

c. Press the dB soft key. 

–  Toggle the PDSCH Precoding soft key between On and Off to enable or disable the 

PDSCH precoding. 

 



JD780A Series Analyzers 

 Using LTE – TDD Signal Analyzer 295 

Measurement example 

Figure 133 Data channel measurement with LTE - TDD signal analyzer 

 

 

Figure 134 Data channel measurement with LTE - TDD signal analyzer (MBMS On) 

 

 

 

NOTE 
You can use the LIMIT hot key to analyze your measurements with the user-definable 
limit and Pass/Fail indication. See “Setting limit for modulation tests” on page 307 for 
more information. 

 

Using marker 

You can use the MARKER hard key to place a marker on a resource block and display the IQ diagram 

for the selected resource block. 

 

Procedure 
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1. Press the MARKER hard key. 

2. Press the RB Number soft key to select the resource block to be marked. 

3. Enter the resource block number by using the numeric keys. 

4. Press the Enter soft key. 

The marker appears on the selected resource block. 

5. Toggle the Marker View soft key between On and Off to display or dismiss the result of the 

selected resource block. 

 

Control channel 

The Control Channel measures the constellation for the specified control channel as well as 

modulation accuracy of the control channel at the specified subframe. 

 

Setting measure setup 

After configuring test parameters as described in the “Configuring test parameters” on page 271, you 

can continue your measurement. The measurement settings can be saved and recalled as a file. You 

can also use JDViewer, PC application software to configure a measure setup, save as a file, and load 

the file on to the instrument. 

 

Procedure 

1. Press the MEASURE SETUP hot key. 

2. To set the nominal channel bandwidth to be measured, complete the following steps: 

a. Press the Bandwidth soft key. 

b. Select the bandwidth option: 1.4 MHz, 3 MHz, 5 MHz, 10 MHz, 15 MHz, or 20 MHz. 

3. To select the subframe number to be measured, complete the following steps: 

a. Press the Subframe No soft key. 

b. Enter a value by using the numeric keys. You can also use the rotary knob. 
 

 

NOTE 

For MBMS testing, this subframe number must be neither 0 nor 5 as these subframes 0 
and 5 are not available for MBMS and it must be set to the MBMS transmitted channel’s 
subframe number. 

c. Press the Enter soft key. 

4. Optional. Toggle the Cell ID soft key and select Auto or Manual as desired: 

–  Auto: to let the instrument detect the Cell ID for the LTE signal automatically. 

–  Manual: to set a specific Cell ID for the LTE signal manually in order to speed up the 

synchronization with a BTS. 

5. Optional. Toggle the CFI soft key and select Auto or Manual as desired: 

–  Auto: to let the instrument set the number of OFDM symbols used for transmitting PDCCHs 

in a subframe. 

–  Manual: to set the number of OFDM symbols manually. The set of OFDM symbols that can 
be used for PDCCH in a subframe is given by 0, 2, 3 or 4 in 1.4 MHz bandwidth and 1, 2, or 
3 in other bandwidths. 

6. Optional. Press the PHICH Ng soft key, and then select the option for the number of PHICH 
groups (Ng): 1/6, 1/2, 1, 2, E-1/6, E-1/2, E-1, or E-2. 

7. Toggle the EVM Detection Mode soft key and select Single or Combine as desired: 
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–  Single: Testing on one single antenna connected to your JD780A series with a cable. 

–  Combine: Testing on multiple antennas connected to your JD780A series with a 2x1 or 4x1 

combiner or an antenna. 

8. Press the Uplink-Downlink Configuration soft key, and then select the number of 

uplink/downlink between one and six. 

9. Optional. Press the Miscellaneous soft key, and then do the following(s) as needed: 

–  To select the number of antenna ports, toggle the MIMO soft key and select 2x2 or 4x4. 

This MIMO (Multiple Input Multiple Output) setting is activated only if the option 031 LTE-
Advanced TDD is installed with a license number. If not, the instrument sets this option to 
2x2 by default. A 2x1 or 4x1 RF combiner is also required to able to test on MIMO 
channels. 

–  To assign a antenna port number automatically or manually, press the Antenna Port soft 
key and select the option: Auto, 0, 1, 2, and 3. If the option 031 LTE-Advanced TDD is not 

installed or if the MIMO is set to 2x2, the antenna ports 2 and 3 are disabled. 

–  To turn the Multimedia Broadcast Multicast Service (MBMS) feature on or off, toggle the 
MBMS soft key and select On or Off. For proper MBMS testing, you need to set the 
Subframe No with the same PMCH subframe number. If this setting is on, the 

measurement item “MBSFN RS” appears in the result table. 

–  To set the Multicast Broadcast Single Frequency Network (MBSFN) detection automatically 
or manually for MBMS testing, toggle the MBSFN soft key and select Auto or Manual. An 

automatically detected or manually entered MBSFN ID appears on the screen. 

–  To set the delay, complete the following steps: 

a. Press the Delay soft key to set the amount of delay in µs. 

b. Enter a value by using the numeric keys. You can also use the rotary knob. 

c. Press the µs soft key. 

 

 

NOTE 

The Delay setting is used only when there is a time offset in the signals to be measured. 

–  To select the cyclic prefix, toggle the Cyclic Prefix soft key and select Normal or 
Extended. See “Appendix E – Cyclic prefix table” on page 592 for OFDM parameter details 

by different bandwidth. 

–  To set the threshold for PDCCH, complete the following steps: 

a. Press the PDCCH Threshold soft key. 

b. Enter a value by using the numeric keys. 

c. Press the dB soft key. 

–  Toggle the PDCCH Mode soft key and select REG to calculate EVM based on Resource 
Element Group or Avg to calculate EVM after adding up all the PDCCH signals from one 

subframe. 
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Measurement example 

Figure 135 Control channel measurement with LTE - TDD signal analyzer 

 

 

Figure 136 Control channel measurement with LTE - TDD signal analyzer (MBMS On) 

 

 

 

NOTE 
You can use the LIMIT hot key to analyze your measurements with the user-definable 

limit and Pass/Fail indication. See “Setting limit for modulation tests” on page 307 for 
more information. 

 

Using marker 

You can use the MARKER hard key to place a marker on a resource block and display the IQ diagram 

for the selected resource block. 

 

Procedure 

1. Press the MARKER hard key. 
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2. Press the Channel soft key to select the channel to be displayed in the IQ diagram. 

The channel P-SS is selected by default. 

3. Turn the rotary knob to move the highlight from one to another in the channel summary table. 

4. Toggle the Marker View soft key between On and Off to display or dismiss the result of the 

selected channel. 

 

Subframe 

The Subframe measures the modulation accuracy of all the data and control channels at the specified 

subframe (1 ms). 

 

Setting measure setup 

After configuring test parameters as described in the “Configuring test parameters” on page 271, you 

can continue your measurement. The measurement settings can be saved and recalled as a file. You 

can also use JDViewer, PC application software to configure a measure setup, save as a file, and load 

the file on to the instrument. 

 

Procedure 

1. Press the MEASURE SETUP hot key. 

2. To set the nominal channel bandwidth to be measured, complete the following steps: 

a. Press the Bandwidth soft key. 

b. Select the bandwidth option: 1.4 MHz, 3 MHz, 5 MHz, 10 MHz, 15 MHz, or 20 MHz. 

3. To select the subframe number to be measured, complete the following steps: 

a. Press the Subframe No soft key. 

b. Enter a value by using the numeric keys. You can also use the rotary knob. 
 

 

NOTE 

For MBMS testing, this subframe number must be neither 0 nor 5 as these subframes 0 
and 5 are not available for MBMS and it must be set to the MBMS transmitted channel’s 
subframe number. 

c. Press the Enter soft key. 

4. Optional. Toggle the Cell ID soft key and select Auto or Manual as desired: 

–  Auto: to let the instrument detect the Cell ID for the LTE signal automatically. 

–  Manual: to set a specific Cell ID for the LTE signal manually in order to speed up the 

synchronization with a BTS. 

5. Optional. Toggle the CFI soft key and select Auto or Manual as desired: 

–  Auto: to let the instrument set the number of OFDM symbols used for transmitting PDCCHs 

in a subframe. 

–  Manual: to set the number of OFDM symbols manually. The set of OFDM symbols that can 
be used for PDCCH in a subframe is given by 0, 2, 3 or 4 in 1.4 MHz bandwidth and 1, 2, or 
3 in other bandwidths. 

6. Optional. Press the PHICH Ng soft key, and then select the option for the number of PHICH 
groups (Ng): 1/6, 1/2, 1, 2, E-1/6, E-1/2, E-1, or E-2. 

7. Toggle the EVM Detection Mode soft key and select Single or Combine as desired: 

–  Single: Testing on one single antenna connected to your JD780A series with a cable. 

–  Combine: Testing on multiple antennas connected to your JD780A series with a 2x1 or 4x1 
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combiner or an antenna. 

8. Press the Uplink-Downlink Configuration soft key, and then select the number of 

uplink/downlink between one and six. 

9. Optional. Press the Miscellaneous soft key, and then do the following(s) as needed: 

–  To select the number of antenna ports, toggle the MIMO soft key and select 2x2 or 4x4. 

This MIMO (Multiple Input Multiple Output) setting is activated only if the option 031 LTE-
Advanced TDD is installed with a license number. If not, the instrument sets this option to 
2x2 by default. A 2x1 or 4x1 RF combiner is also required to able to test on MIMO 
channels. 

–  To assign a antenna port number automatically or manually, press the Antenna Port soft 
key and select the option: Auto, 0, 1, 2, and 3. If the option 031 LTE-Advanced TDD is not 

installed or if the MIMO is set to 2x2, the antenna ports 2 and 3 are disabled. 

–  To turn the Multimedia Broadcast Multicast Service (MBMS) feature on or off, toggle the 
MBMS soft key and select On or Off. For proper MBMS testing, you need to set the 
Subframe No with the same PMCH subframe number. If this setting is on, the 

measurement item “MBSFN RS” appears in the result table and either PMCH or PDSCH 
appears as well depending on the detected channel. 

–  To set the Multicast Broadcast Single Frequency Network (MBSFN) detection automatically 
or manually for MBMS testing, toggle the MBSFN soft key and select Auto or Manual. An 

automatically detected or manually entered MBSFN ID appears on the screen. 

–  To set the delay, complete the following steps: 

a. Press the Delay soft key to set the amount of delay in µs. 

b. Enter a value by using the numeric keys. You can also use the rotary knob. 

c. Press the µs soft key. 

 

 

NOTE 

The Delay setting is used only when there is a time offset in the signals to be measured. 

–  To select the cyclic prefix, toggle the Cyclic Prefix soft key and select Normal or 
Extended. See “Appendix E – Cyclic prefix table” on page 592 for OFDM parameter details 

by different bandwidth. 

–  Press the PDSCH Modulation Type soft key, and then select the modulation type option: 
Auto, QPSK, 16 QAM, 64 QAM, E-TM3.3, E-TM3.2, E-TM3.1, E-TM2, E-TM1.2, and E-
TM1.1. If two or more modulation types are used in a frame, select Auto. If the PDSCH 

uses the same modulation type in a frame or in a subframe, select a specific modulation 
type to get more accurate EVM. 

 

NOTE 
If you have installed a license for the option 033 LTE-TDD 256 QAM Demodulator on 
your CellAdvisor, you will have additional PDSCH modulation types of 256 QAM,  
E-TM3.1a, and E-TM2a. 

–  To set the threshold for PDSCH, complete the following steps: 

a. Press the PDSCH Threshold soft key. 

b. Enter a value by using the numeric keys. 

c. Press the dB soft key. 

–  To set the threshold for PDCCH, complete the following steps: 

a. Press the PDCCH Threshold soft key. 

b. Enter a value by using the numeric keys. 

c. Press the dB soft key. 

–  Toggle the PDCCH Mode soft key and select REG to calculate EVM based on Resource 
Element Group or Avg to calculate EVM after adding up all the PDCCH signals from one 

subframe. 

–  Toggle the PDSCH Precoding soft key between On and Off to enable or disable the 
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PDSCH precoding. 

 

Measurement example 

Figure 137 Subframe measurement with LTE - TDD signal analyzer 

1) Regular view 
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2) Chart view 

 

 

Figure 138 Subframe measurement with LTE - TDD signal analyzer (MBMS On) 

 

 

 

NOTE 
You can use the LIMIT hot key to analyze your measurements with the user-definable 
limit and Pass/Fail indication. See “Setting limit for modulation tests” on page 307 for 
more information. 

 

Setting display 

You can use the TRACE/DISPLAY hard key to view your measurement result with the chart. 

 

Procedure 

1. Press the TRACE/DISPLAY hard key. 

2. Toggle the Chart soft key between On and Off to display or dismiss the chart. If this setting is on, 
the MARKER hard key is activated. 
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Using marker 

If you turn the Chart view on, you can use the MARKER hard key to place the marker at a specific 

symbol. 

 

Procedure 

1. Press the MARKER hard key. 

2. Toggle the Marker View soft key between On and Off to display or dismiss the marker on the 

chart. 

3. Press the Symbol soft key to select the symbol number, to which the marker is placed. 

4. Enter a value by using the numeric keys. 

5. Press the Enter soft key. 

 

Time alignment error 

In eNode B supporting Tx Diversity transmission, signals are transmitted from two or more antennas. 

These signals shall be aligned. The time alignment error in Tx diversity is specified as the delay 

between the signals from two antennas at the antenna ports. 

 

Setting measure setup 

After configuring test parameters as described in the “Configuring test parameters” on page 271, you 

can continue your measurement. The measurement settings can be saved and recalled as a file. You 

can also use JDViewer, PC application software to configure a measure setup, save as a file, and load 

the file on to the instrument. 

 

Procedure 

1. Press the MEASURE SETUP hot key. 

2. To set the nominal channel bandwidth to be measured, complete the following steps: 

a. Press the Bandwidth soft key. 

b. Select the bandwidth option: 1.4 MHz, 3 MHz, 5 MHz, 10 MHz, 15 MHz, or 20 MHz. 

3. Optional. Toggle the Cell ID soft key and select Auto or Manual as desired: 

–  Auto: to let the instrument detect the Cell ID for the LTE signal automatically. 

–  Manual: to set a specific Cell ID for the LTE signal manually in order to speed up the 

synchronization with a BTS. 

4. Optional. Press the Miscellaneous soft key, and then do the following(s) as needed: 

–  To select the number of antenna ports, toggle the MIMO soft key and select 2x2 or 4x4. 

This MIMO (Multiple Input Multiple Output) setting is activated only if the option 031 LTE-
Advanced TDD is installed with a license number. If not, the instrument sets this option to 
2x2 by default. A 2x1 or 4x1 RF combiner is also required to able to test on MIMO 
channels. 

–  To assign a antenna port number automatically or manually, press the Antenna Port soft 
key and select the option: Auto, 0, 1, 2, and 3. If the option 031 LTE-Advanced TDD is not 

installed or if the MIMO is set to 2x2, the antenna ports 2 and 3 are disabled. 

–  To set the delay, complete the following steps: 

a. Press the Delay soft key to set the amount of delay in µs. 

b. Enter a value by using the numeric keys. You can also use the rotary knob. 
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c. Press the µs soft key. 

 

 

NOTE 

The Delay setting is used only when there is a time offset in the signals to be measured. 

–  To select the cyclic prefix, toggle the Cyclic Prefix soft key and select Normal or 
Extended. See “Appendix E – Cyclic prefix table” on page 592 for OFDM parameter details 

by different bandwidth. 

 

Measurement example 

Figure 139 Time alignment error measurement with LTE - TDD signal analyzer 

 

 

 

NOTE 
You can use the LIMIT hot key to analyze your measurements with the user-definable 

limit and Pass/Fail indication. See “Setting limit for modulation tests” on page 307 for 
more information. 

 

Data allocation map 

The Data Allocation Map function represents data allocation as a mapping. 

 

Setting measure setup 

After configuring test parameters as described in the “Configuring test parameters” on page 271, you 

can continue your measurement. The measurement settings can be saved and recalled as a file. You 

can also use JDViewer, PC application software to configure a measure setup, save as a file, and load 

the file on to the instrument. 

 

Procedure 

1. Press the MEASURE SETUP hot key. 

2. To set the nominal channel bandwidth to be measured, complete the following steps: 

a. Press the Bandwidth soft key. 

b. Select the bandwidth option: 1.4 MHz, 3 MHz, 5 MHz, 10 MHz, 15 MHz, or 20 MHz. 
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3. To select the subframe number to be measured, complete the following steps: 

a. Press the Subframe No soft key. 

b. Enter a value by using the numeric keys. You can also use the rotary knob. 
 

 

NOTE 

For MBMS testing, this subframe number must be neither 0 nor 5 as these subframes 0 
and 5 are not available for MBMS and it must be set to the MBMS transmitted channel’s 
subframe number. 

c. Press the Enter soft key. 

4. To set the threshold for PDSCH, complete the following steps: 

a. Press the PDSCH Threshold soft key. 

b. Enter a value by using the numeric keys. 

c. Press the dB soft key. 

5. Optional. Toggle the Cell ID soft key and select Auto or Manual as desired: 

–  Auto: to let the instrument detect the Cell ID for the LTE signal automatically. 

–  Manual: to set a specific Cell ID for the LTE signal manually in order to speed up the 

synchronization with a BTS. 

6. Optional. Press the Miscellaneous soft key, and then do the following(s) as needed: 

–  To select the number of antenna ports, toggle the MIMO soft key and select 2x2 or 4x4. 

This MIMO (Multiple Input Multiple Output) setting is activated only if the option 031 LTE-
Advanced TDD is installed with a license number. If not, the instrument sets this option to 
2x2 by default. A 2x1 or 4x1 RF combiner is also required to able to test on MIMO 
channels. 

–  To assign a antenna port number automatically or manually, press the Antenna Port soft 
key and select the option: Auto, 0, 1, 2, and 3. If the option 031 LTE-Advanced TDD is not 

installed or if the MIMO is set to 2x2, the antenna ports 2 and 3 are disabled. 

–  To turn the Multimedia Broadcast Multicast Service (MBMS) feature on or off, toggle the 
MBMS soft key and select On or Off. For proper MBMS testing, you need to set the 
Subframe No with the same PMCH subframe number. If this setting is on, either PMCH or 

PDSCH appears on the screen depending on the detected channel. 

–  To set the Multicast Broadcast Single Frequency Network (MBSFN) detection automatically 
or manually for MBMS testing, toggle the MBSFN soft key and select Auto or Manual. An 

automatically detected or manually entered MBSFN ID appears on the screen. 

–  To select the cyclic prefix, toggle the Cyclic Prefix soft key and select Normal or 
Extended. See “Appendix E – Cyclic prefix table” on page 592 for OFDM parameter details 

by different bandwidth. 
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Measurement example 

Figure 140 Data allocation map measurement with LTE - TDD signal analyzer 

 

 

Figure 141 Data allocation map measurement with LTE - TDD signal analyzer (MBMS On) 

 

 

 

NOTE 

You can use the LIMIT hot key to analyze your measurements with the user-definable 
limit and Pass/Fail indication. See “Setting limit for modulation tests” on page 307 for 
more information. 

 

Setting display 

You can use the TRACE/DISPLAY hard key to change the display mode to PDSCH, PMCH, or both. 

 

Procedure 

1. Press the TRACE/DISPLAY hard key. 
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2. Press the Display Channel soft key. 

3. Select the display mode from the choice: PDSCH, PMCH, and Both. 

 

Using marker 

You can use the MARKER hard key to place the marker at a specific resource block and subframe. 

 

Procedure 

1. Press the MARKER hard key. 

2. Toggle the Marker View soft key between On and Off to display or dismiss the marker on the 

chart. 

3. To select the resource block number, complete the following steps: 

a. Press the RB Number soft key. 

b. Enter the resource block number to select by using the numeric keys. You can also use the 
rotary knob to move the marker side by side. 

c. Press the Enter soft key. 

4. To select the subframe block number, complete the following steps: 

a. Press the Subframe No soft key. 

b. Enter the subframe number to select by using the numeric keys. You can also use the 
rotary knob to move the marker up and down. 

c. Press the Enter soft key. 

 

Setting limit for modulation tests 

Procedure 

1. Press the LIMIT hot key. 

2. Press the Modulation Test Limits soft key to set the limits. 

3. Select the test item(s) and set the limit(s) depending on your selected measurement mode: 
 

To set the limit for Select Set 

Frequency error Frequency Error High Limit 
Low Limit 

PDSCH error vector 
magnitude if MBMS is off 

EVM > PDSCH EVM High Limit (QPSK) 
High Limit (16 QAM) 
High Limit (64 QAM) 
High Limit (256 QAM)* 

PMCH error vector magnitude 
if MBMS is on and a PMCH is 
detected 

EVM > PMCH EVM High Limit (QPSK) 
High Limit (16 QAM) 
High Limit (64 QAM) 
High Limit (256 QAM)* 

RMS for data error vector 
magnitude 

EVM > Data EVM RMS High Limit 

Peak for data error vector 
magnitude 

EVM> Data EVM Peak High Limit 

RS error vector magnitude EVM > RS EVM High Limit 



JD780A Series Analyzers 

308 Using LTE – TDD Signal Analyzer 

P-SS error vector magnitude EVM > P-SS EVM High Limit 

S-SS error vector magnitude EVM > S-SS EVM High Limit 

Downlink RS power Power > DL RS Power High Limit 
Low Limit 

P-SS power Power > P-SS Power High Limit 
Low Limit 

S-SS power Power > S-SS Power High Limit 
Low Limit 

PBCH power Power > PBCH Power High Limit 
Low Limit 

Subframe power Power > Subframe Power High Limit 
Low Limit 

OFDM symbol power Power > OFDM Symbol Power High Limit 
Low Limit 

Time alignment error for 
MIMO 

Time Alignment Error > MIMO High Limit 

Time alignment error for 
aggregation of component 
carriers (intra-band 
contiguous, intra-band non-
contiguous, and inter-band) 

Time Alignment Error > Carrier 
Aggregation 

Intra Cont 
Intra Non-cont 
Inter Band 

Time error Time Error High Limit 
Low Limit 

I-Q origin offset IQ Origin Offset High Limit 

4. Optional. You can enable alarm sound that goes off if the measurement falls outside of the limit. 
Toggle the Beep soft key between On and Off to enable or disable the beep sound. 

5. Optional. Go to SAVE/LOAD > Save, and then select Save Limit to save the limit settings. 

See “Using save” on page 33 for more information. 

 

Performing auto measurements 

Conformance test 

The Conformance Test is to test if eNode-B meets some specified standards that have been 

developed for verification. Its test procedure and test setups have been developed by 3GPP. Test 

results can be saved as a .csv file type. 

 

Setting limit for conformance test 

You can set test limits for test item(s) in the auto measurement. Turning the test limit on for a test item 

makes the test item included in the conformance test. 

 

Procedure 

1. Press the LIMIT hot key. 

2. To set the limit for BTS output power, complete the following steps: 

a. Press the BTS Output Power soft key. 
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b. Toggle the Test Limits soft key between On and Off to enable or disable the limit. 

c. Press the High Limit soft key. 

d. Enter a value for the upper limit. 

e. Press the dBm unit soft key. 

f. Press the Low Limit soft key. 

g. Enter a value for the lower limit. 

h. Press the dBm unit soft key. 

3. To set the limit for total power dynamic, complete the following steps: 

a. Press the Total Power Dynamic soft key. 

b. Toggle the Test Limits soft key between On and Off to enable or disable the limit. 

c. Press the Low Limit soft key. 

d. Enter a value for the lower limit. 

e. Press the dBm unit soft key. 

4. To set the limit for on/off power, press the On/Off Power soft key, and then do the following as 

needed: 
 

To set the limit for Select Set 

Off power Off Power High Limit 

Transition period Transition Period High Limit 

5. To verify signal quality, press the Signal Quality soft key, and then do the following as needed: 

 

To set the limit for Select Set 

Frequency error Frequency Error High Limit 
Low Limit 

Error vector magnitude EVM High Limit (QPSK) 
High Limit (16 QAM) 
High Limit (64 QAM) 

Time alignment error Time Alignment Error High Limit 

RS power RS Power High Limit 
Low Limit 

6. To verify unwanted emissions, press the Unwanted Emissions soft key, and then do the 

following as needed: 
 

To set the limit for Select Set 

Occupied bandwidth Occupied BW High Limit 

Adjacent channel power ratio ACLR  

Spectrum emission mask SEM Mask Type 

Spurious emissions Spurious Emissions Range Table 

7. Optional. You can enable alarm sound that goes off if the measurement falls outside of the limit. 
Toggle the Beep soft key between On and Off to enable or disable the beep sound. 

8. Optional. Go to SAVE/LOAD > Save, and then select Save Limit to save the limit settings. 

See “Using save” on page 33 for more information. 
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Setting measure setup 

After setting frequency as described in the “Configuring test parameters” on page 271, you can 

continue your measurement. 

 

Procedure 

1. Press the MEASURE SETUP hot key. 

2. Press the Bandwidth soft key. 

3. Select the nominal channel bandwidth to be measured, from the following choices: 

–  1.4 MHz, 3 MHz, 5 MHz, 10 MHz, 15 MHz, and 20 MHz 

4. Press the Sector soft key, and then select the sector option: Alpha, Beta, or Gamma. 

5. To set external offset, complete the following steps: 

a. Toggle the External Offset soft key and select On. 

b. Enter a value by using the numeric keys. 

c. Press the dB soft key. 

6. To save your settings and results, go to SAVE/LOAD > Save and then perform functions as you 

desire. See “Using save” on page 33 for more information. 

7. Press the Run Test soft key to start to run a test. 

The Auto Measure Results window appears at the end of the test. 

8. When prompted on the screen, connect the cable from the Spectrum Analyzer RF In port of the 
instrument either to Antenna Port 0 or Antenna Port 1 of the eNode-B, and then change the TM 

mode on the eNode-B side. 

9. Press the Continue soft key to continue testing. 

10. Repeat the steps 8-9 until completion of the test. 
A conformance test report appears at the end of the test. 

11. Optional. To stop running the test, press the Abort soft key. 

 

Maintenance test 

The Auto Measure function of the JD780A series allows a complete signal profiling covering RF 

characterization and modulation quality parameters of up to 20 different carriers, particularly useful on 

an overlay architecture where base stations are transmitting in different frequencies. 

 

Following settings are required only when you run the Auto Measure Maintenance Test on the 

instrument using “Current” configuration setting. Additional settings are not required when you run Auto 

Measure using a scenario generated in the PC application software, JDViewer. 

 

Setting limit for maintenance test 

You can set test limits for test item(s) in the auto measurement. 

Procedure 

1. Press the LIMIT hot key. 

2. Press the RF Test Limits soft key, and then enable test limits as desired. 

3. Press the PvsT Test Limits soft key, and then enable test limits as desired. 

4. Press the Modulation Test Limits soft key, and then enable test limits as desired. 



JD780A Series Analyzers 

 Using LTE – TDD Signal Analyzer 311 

5. Optional. You can enable alarm sound that goes off if the measurement falls outside of the limit. 
Toggle the Beep soft key between On and Off to enable or disable the beep sound. 

6. Optional. Go to SAVE/LOAD > Save, and then select Save Limit to save the limit settings. 

See “Using save” on page 33 for more information. 

 

 

NOTE 
You can use the Allowed % Change soft key for each test item to compare two 
measurement values displayed in the result table. This requires setting the Display mode 
to Compare in advance. 

 

Setting measure setup 

After configuring test parameters as described in the “Configuring test parameters” on page 271, you 

can continue your measurement. The measurement settings can be saved and recalled as a file. You 

can also use JDViewer, PC application software to configure a measure setup, save as a file, and load 

the file on to the instrument. 

 

Procedure 

1. Press the MEASURE SETUP hot key. 

2. Toggle the Configuration soft key and select the configuration option: 

–  Current: to let the instrumnet use current frequency (single carrier) and determine pass or 

fail based on the instrument’s limit settings in Auto Measure. 

–  Scenario: to run a test with a programmed scenario in JDViewer. 

The Scenario menu becomes activated. 

3. To load a scenario, press the Scenario soft key, and then select a scenario file to load. 

4. Toggle the Test Time soft key and select the test time option: 

–  Now: to let the instrument run a test only once. 

–  Schedule: to let the instrument repeat tests as defined in the Set Timing. 

The Set Timing menu becomes activated. 

5. To define a schedule for an auto measurement, complete the following steps: 

a. Press the Set Timing soft key. 

b. Press the Start Time (HH:MM) soft key. 

c. Enter the time in the HH:MM format, and then press the Enter soft key. 

d. Press the Stop Time (HH:MM) soft key. 

e. Enter the time in the HH:MM format, and then press the Enter soft key. 

f. Press the Time Interval soft key. 

g. Enter the amount of time in minutes, and then press the Enter soft key. 

7. Press the Settings soft key, and then set the following: 

a. Press the Bandwidth soft key, and then select the nominal channel bandwidth to be 

measured, from the following choices: 

–  1.4 MHz, 3 MHz, 5 MHz, 10 MHz, 15 MHz, and 20 MHz 

b. Toggle the Cell ID soft key and select Auto or Manual as desired: 

–  Auto: to let the instrument detect the Cell ID for the LTE signal automatically. 

–  Manual: to set a specific Cell ID for the LTE signal manually in order to speed up the 

synchronization with a BTS. 

c. Press the MIMO soft key, and then select the antenna number option: 2x2 or 4x4. 
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This MIMO (Multiple Input Multiple Output) setting is activated only if the option 031 LTE-
Advanced TDD is installed with a license number. If not, the instrument sets this option to 
2x2 by default. A 2x1 or 4x1 RF combiner is also required to able to test on MIMO 
channels. 

d. Press the Antenna Port soft key, and then select the option: Auto, 0, 1, 2, or 3. 

If the option 031 LTE-Advanced TDD is not installed or if the MIMO is set to 2x2, the 
antenna ports 2 and 3 are disabled. 

e. Toggle the External Offset soft key and select On. 

f. Enter a value by using the numeric keys, and then press the dB soft key. 

g. To turn the Multimedia Broadcast Multicast Service (MBMS) feature on or off, toggle the 
MBMS soft key and select On or Off. For proper MBMS testing, you need to set the 

Subframe No with the same PMCH subframe number. 

h. To set the Multicast Broadcast Single Frequency Network (MBSFN) detection automatically 
or manually for MBMS testing, toggle the MBSFN soft key and select Auto or Manual. An 

automatically detected or manually entered MBSFN ID appears on the screen. 

8. To save your settings and results, go to SAVE/LOAD > Save and then perform functions as you 

desire. See “Using save” on page 33 for more information. 

9. Press the Run Test soft key to start to run a test. 

The Auto Measure Results window appears at the end of the test. 

10. To stop running the test, press the Abort soft key. 

11. To change the view on the screen during the test, press the Display and then select the view 

option from the following choices: 

–  Screen: You can view each measurement screen as the test progresses. 

–  Results: You can view a measurement result table as the test progresses. 

–  Settings: You can view a measurement setting table as the test progresses. 

 

Setting display 

After completion of the auto measurement, the screen menu changes to Trace/Display so that you can 

view the results in different forms. 

 

Procedure 

1. Toggle the Display soft key and select the display option: 

–  Result: to view the result table. The Display Result menu becomes activated. 

–  Settings: to view the measurement settings for the auto measurement. 

2. Toggle the Display Result soft key and select the display result option: 

–  Full: to view detailed measurement readings with the pass/fail indication. 

–  Quick: to view only the Pass/Fail results. 

–  Compare: to compare two measurement values for each test time with the Allowed % 

Change setting on. You can view results vs. factory-defined or user-defined references. 

3. To view the measurement results for a different carrier, press the View Carrier soft key and then 

select the carrier number to view. 

4. Press the Replace Reference soft key to replace existing reference values for comparison with 

new measurement data. 

5. Press the Load From soft key to select the location from which references file to be loaded. 
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Signal performance test 

Unlike the other auto measurement tests, the Signal Performance Test runs measurements 

continuously. 

 

Setting limit for signal performance test 

You can set test limits for test item(s) in the auto measurement. 

Procedure 

1. Press the LIMIT hot key. 

2. Press the RF Test Limits > Channel Power soft key, and then set the limits for the channel 

power. Other RF test items are not used in the signal performance test. 

3. Press the Modulation Test Limits soft key, and then enable test limits as desired. 

4. Optional. You can enable alarm sound that goes off if the measurement falls outside of the limit. 
Toggle the Beep soft key between On and Off to enable or disable the beep sound. 

5. Optional. Go to SAVE/LOAD > Save, and then select Save Limit to save the limit settings. 

See “Using save” on page 33 for more information. 

 

Setting measure setup 

After configuring test parameters as described in the “Configuring test parameters” on page 271, you 

can continue your measurement. The measurement settings can be saved and recalled as a file. You 

can also use JDViewer, PC application software to configure a measure setup, save as a file, and load 

the file on to the instrument. 

 

Procedure 

1. Press the MEASURE SETUP hot key. 

2. Toggle the Cell ID soft key and select Auto or Manual as desired: 

–  Auto: to let the instrument detect the Cell ID for the LTE signal automatically. 

–  Manual: to set a specific Cell ID for the LTE signal manually in order to speed up the 

synchronization with a BTS. 

3. Press the MIMO soft key, and then select the antenna number option: 2x2 or 4x4. 

This MIMO (Multiple Input Multiple Output) setting is activated only if the option 031 LTE-
Advanced TDD is installed with a license number. If not, the instrument sets this option to 2x2 by 
default. A 2x1 or 4x1 RF combiner is also required to able to test on MIMO channels. 

4. Press the Antenna Port soft key, and then select the option: Auto, 0, 1, 2, or 3. 

If the option 031 LTE-Advanced TDD is not installed or if the MIMO is set to 2x2, the antenna 
ports 2 and 3 are disabled. 

5. Press the Bandwidth soft key, and then select the nominal channel bandwidth to be measured, 

from the following choices: 

–  1.4 MHz, 3 MHz, 5 MHz, 10 MHz, 15 MHz, and 20 MHz 

6. Toggle the RF Profile soft key between On and Off to turn on or off the RF profiling such as 

channel power and subframe frequency error. 

7. Toggle the Modulation Profile soft key between On and Off to turn on or off the modulation 

profiling such as P-SS, S-SS, Data - QPSK, Data – 16 QAM, and Data – 64 QAM. 

8. Toggle the MIMO Profile soft key between On and Off to turn on or off the MIMO profiling such 

as TX1 - RS0, TX2 - RS1, and time alignment error. 

9. Toggle the External Offset soft key and select On to set the external offset value. 
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10. To save your settings and results, go to SAVE/LOAD > Save and then perform functions as you 

desire. See “Using save” on page 33 for more information. 

 

DAS test 

The Distributed Antenna System (DAS) testing enables you to check the degradation of performance 

in the signal transmission from a radio band to antennas distributed from it. You can save 

measurement values at both the radio band and antennas and then compare results with percentage 

of changes. You can also save test results in the .csv file format for ease of analysis. 

 

Setting measure setup 

Procedure 

1. Press the MEASURE SETUP hot key. 

2. Press the Settings soft key and then set the following; 

a. Press the Bandwidth soft key and then select the nominal channel bandwidth to be 
measured from the choices: 1.4 MHz, 3 MHz, 5 MHz, 10 MHz, 15 MHz, and 20 MHz: 

b. Press the MIMO soft key, and then select the antenna number option: 2x2 or 4x4. 

This MIMO (Multiple Input Multiple Output) setting is activated only if the option 031 LTE-
Advanced TDD is installed with a license number. If not, the instrument sets this option to 
2x2 by default. A 2x1 or 4x1 RF combiner is also required to able to test on MIMO 
channels. 

c. Toggle the Cell ID soft key and select Auto or Manual as desired: 

–  Auto: to let the instrument detect the Cell ID for the LTE signal automatically. 

–  Manual: to set a specific Cell ID for the LTE signal manually in order to speed up the 

synchronization with a BTS. 

d. Press the Antenna Port soft key, and then select the option: Auto, 0, 1, 2, or 3. 

If the option 031 LTE-Advanced TDD is not installed or if the MIMO is set to 2x2, the 
antenna ports 2 and 3 are disabled. 

e. Toggle the External Offset soft key and select On to set the external offset value. 

f. To turn the Multimedia Broadcast Multicast Service (MBMS) feature on or off, toggle the 
MBMS soft key and select On or Off. 

g. To set the Multicast Broadcast Single Frequency Network (MBSFN) detection automatically 
or manually for MBMS testing, toggle the MBSFN soft key and select Auto or Manual. An 

automatically detected or manually entered MBSFN ID appears on the screen. 

3. To save your settings, go to SAVE/LOAD > Save > Save Setup and then perform functions as 

you desire. See “Using save” on page 33 for more information. 

4. Press the Continue soft key to do the reference test first or press the Skip Reference Test soft 

key if you already saved test results from the radio band under test. 

5. Press the FREQ/DIST hard key and then set the frequency to be measured. See “Setting 

frequency” on page 272 for more information. 

6. Press the PREV hard key. 

7. Press the Limit soft key and then set the limits and allowed percentage change for each test 

item. See “Maintenance test” on page 310 for more information on setting limits. 

8. Keep pressing the PREV hard key until you see the Run Test soft key. 

9. Press the Run Test soft key. 

The instrument runs specified tests to gather reference measurement values. The measurement 
table appears when the reference test is done. 

10. Press the Continue soft key to run the testing on an antenna (Ant 1). 
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11. Optional. To change the settings such as External Offset, press the Settings and then change 

the settings as needed. 

12. Press the Continue soft key. 

The instrument runs the testing on Ant 1. The Ant 1 tab appears with the updated result table 
when the test is done. 

13. To run the testing on the next antenna (Ant 2), press the Run Test soft key and then repeat the 
steps 11-12. You can do the testing on up to 10 distributed antennas for one radio band. 

14. To view test results for each antenna, press the Select Antenna soft key and then select the 

antenna tab number to display on the screen. 

15. Optional. Press the Delete Test soft key to delete the selected antenna tab. 

16. Optional. Press the Retest Reference soft key to obtain reference measurement values again. 

17. Optional. To save your measurement results, go to SAVE/LOAD > Save and then perform 

functions as you desire. See “Using save” on page 33 for more information. 

 

Measurement example 

Figure 142 DAS measurement with LTE - TDD signal analyzer 

 

 

Performing power statistics CCDF measurements 

The Power Statistics Complementary Cumulative Distribution Function (CCDF) measurement 

characterizes the power statistics of the input signal. It provides PAR (Peak to Average power Ratio) 

versus different probabilities. 

 

Setting measure setup 

After configuring test parameters as described in the “Configuring test parameters” on page 271, you 

can continue your measurement. The measurement settings can be saved and recalled as a file. You 

can also use JDViewer, PC application software to configure a measure setup, save as a file, and load 

the file on to the instrument. 
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Procedure 

1. Press the MEASURE SETUP hot key. 

2. Press the CCDF Length soft key to set the length of the CCDF. 

3. Enter a value between 1 and 100 by using the numeric keys. You can also use the rotary knob. 

4. Press the Enter soft key. 

 

Measurement example 

Figure 143 CCDF measurement with LTE - TDD signal analyzer 

 

 

Performing carrier aggregation measurements 

Carrier aggregation enables a maximum of five multiple LTE carriers to be used together in order to 

provide high data rate required for LTE-Advanced. Component carriers to be aggregated can be intra-

band contiguous, intra-band non-contiguous, or inter-band. The JD780A series provides carrier 

aggregation measurements supporting for all the different modes with carrier aggregation bands 

added to the channel standard. This functionality is activated if the license for the option 031 LTE-

Advanced TDD is installed. 

 

Setting measure setup 

After configuring test parameters as described in the “Configuring test parameters” on page 271, you 

can continue your measurement. The measurement settings can be saved and recalled as a file. You 

can also use JDViewer, PC application software to configure a measure setup, save as a file, and load 

the file on to the instrument. 

 

Procedure 

1. Press the MEASURE SETUP hot key. 

2. To configure parameters for up to 5 component carriers, complete the following steps: 

a. Press the CA Configuration soft key. 
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The component carrier configuration window appears. 

b. Press the CA Range soft key. 

c. Enter the number of the component carrier to be set between 1 and 5. 

d. Press the Enter soft key. 

e. Toggle the Turn On soft key and then select On to set parameters and view the results for 
the selected component carrier on the screen or Off to turn it off. 

f. Set the following parameters as needed: 

–  Center Frequency, Channel, Bandwidth, Cell ID, CFI, PHICH Ng, Antenna Port, 
MBMS On/Off, Cyclic Prefix, and PDSCH Modulation Type 

g. To set more component carriers, repeat the steps c-f. 

3. Press the MEASURE SETUP hot key again. 

4. Toggle the EVM Detection Mode soft key and select Single or Combine as desired: 

–  Single: Testing on one single antenna connected to your JD780A series with a cable. 

–  Combine: Testing on multiple antennas connected to your JD780A series with a 2x1 or 4x1 

combiner or an antenna. 

5. To select the subframe number to be measured, do one of the following: 

–  If the EVM Detection Mode is set to Single, press the Subframe No soft key and then set 

the subframe number. 
 

 

NOTE 

For MBMS testing, this subframe number must be neither 0 nor 5 as these subframes 0 
and 5 are not available for MBMS and it must be set to the MBMS transmitted channel’s 
subframe number. 

–  If the EVM Detection Mode is set to Combine, toggle the Subframe No soft key and then 
select 0 or 5. 

6. To set the threshold for PDSCH, complete the following steps: 

a. Press the PDSCH Threshold soft key. 

b. Enter a value by using the numeric keys. 

c. Press the dB soft key. 

7. Toggle the PDSCH Precoding soft key between On and Off to enable or disable the PDSCH 

precoding. 

8. To select the number of antenna ports, toggle the MIMO soft key and select 2x2 or 4x4. 

This MIMO (Multiple Input Multiple Output) setting is activated only if the option 031 LTE-
Advanced TDD is installed with a license number. If not, the instrument sets this option to 2x2 by 
default. A 2x1 or 4x1 RF combiner is also required to able to test on MIMO channels. 

 

Setting display 

You can use the TRACE/DISPLAY hard key to select modulation analysis or spectrum analysis. 

 

Procedure 

1. Press the TRACE/DISPLAY hard key. 

2. Toggle the Display soft key and select MA for modulation analysis or SA for spectrum analysis. 

The screen changes according to the selected option. 
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Measurement example 

Figure 144 Carrier aggregation measurement with LTE - TDD signal analyzer (MA) 

 

 

Figure 145 Carrier aggregation measurement with LTE - TDD signal analyzer (SA) 

 

 

 

NOTE 
You can use the LIMIT hot key to analyze your measurements with the user-definable 

limit and Pass/Fail indication. See “Setting limit for modulation tests” on page 307 for 
more information. 

 

Using marker 

You can use the MARKER hard key to place the marker at a specific channel. 

 

Procedure 

1. Press the MARKER hard key. 
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2. Toggle the Marker View soft key between On and Off to display or dismiss the marker. 

3. Press the Channel soft key to select the channel to be displayed on the IQ diagram. 

4. Use the rotary knob to move and select an item under EVM. 

 

Conducting LTE - TDD OTA measurements 

The TDD LTE Over The Air (OTA) measurement has Channel Scanner, ID Scanner, Multipath Profile, 

Datagram, and Control Channel screens. The ID Scanner displays key parameters such as RSRP, 

RSRQ, RS-SINR, and S-SS RSSI. The Multipath Profile enables you to determine RF environmental 

conditions of testing area. The OTA Control Channel provides summary of all control channels 

including RS power variation over time. 

 

Channel scanner 

The Channel Scanner is a radio receiver that can automatically tune or scan two or more discrete 

frequencies and multi-channels, indicating when it finds a signal on one of them and then continuing 

scanning when that frequency goes silent. 

 

Setting channel/frequency 

Procedure 

To set the channels to be scanned: 

1. Press the FREQ/DIST hard key. 

2. Toggle the Unit soft key and select Channel. 

3. Press the Index soft key, and then enter an index number between one and six by turning the 

rotary knob or using the numeric keys. 

4. To select the standard channel, complete the following steps: 

a. Press the Channel Std soft key. The standard channel window appears. 

See “Appendix C – Band, frequency & channel standard” on page 588 for more information. 

b. Select the band to be measured by using the rotary knob, the arrow keys, or the Page 
Up/Page Down soft keys. 

c. Press the Select soft key or the rotary knob to confirm the selection. 

5. To set the channel number for the selected index, complete the following steps: 

a. Press the Channel Number soft key. 

b. Enter a value by using the numeric keys. You can also use the rotary knob. 

c. Press the Enter soft key. 

The instrument displays a corresponding center frequency for the channel number. 

6. To set the integration bandwidth for the selected index, complete the following steps: 

a. Press the Integration Bandwidth soft key. 

b. Enter a value by using the numeric keys. You can also use the rotary knob. 

c. Select the unit: GHz, MHz, kHz, or Hz. 

7. To add more channels to be scanned, repeat steps 3-6. 

8. Press the ESC hard key to dismiss the channel list window and view the scanning result. 
 
To set the frequencies to be scanned: 
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1. Press the FREQ/DIST hard key. 

2. Toggle the Unit soft key and select Freq. 

3. Press the Index soft key, and then enter an index number between one and six by turning the 

rotary knob or using the numeric keys. 

4. To set the center frequency for the selected index, complete the following steps: 

a. Press the Center Frequency soft key. 

b. Enter a value by using the numeric keys. You can also use the rotary knob. 

c. Select the unit: GHz, MHz, kHz, or Hz. 

5. To set the integration bandwidth for the selected index, complete the following steps: 

a. Press the Integration Bandwidth soft key. 

b. Enter a value by using the numeric keys. You can also use the rotary knob. 

c. Select the unit: GHz, MHz, kHz, or Hz. 

6. To add more channels to be scanned, repeat steps 3-5. 

7. Press the ESC hard key to dismiss the channel list window and view the scanning result. 

 

Setting number of antenna ports 

Procedure 

1. Press the MEASURE SETUP hot key. 

2. Toggle the MIMO soft key and select 2x2 or 4x4. 

This MIMO (Multiple Input Multiple Output) setting is activated only if the option 031 LTE-
Advanced TDD is installed with a license number. If not, the instrument sets this option to 2x2 by 
default. A 2x1 or 4x1 RF combiner is also required to able to test on MIMO channels. 

 

Measurement example 

Figure 146 Channel scanner measurement with LTE - TDD OTA signal analyzer 
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ID scanner 

The LTE mobile receives signals from multiple base stations that all of these signals share the same 

spectrum and are present at the same time. Each base station has unique scrambling code assigned 

to the particular base station and it differentiates its signal from other base stations in the area. 

 

The ID Scanner shows key parameters such as RSRP (Reference Signal Received Power) and RSRQ 

(Reference Signal Received Quality) that predict the downlink coverage quickly. 

 RSRPs from entire cells help to rank between the different cells as input for handover and cell 

reselection decisions. 

 RSRQ provides additional information when RSRP is not sufficient to make a reliable 

handover or cell reselection decision. 

 

All of the parameters for OTA ID scanner can be plotted on map data such as Google Maps and 

Google Earth by using JDViewer. 

 

Setting measure setup 

After configuring test parameters as described in the “Configuring test parameters” on page 271, you 

can continue your measurement. 

 

Procedure 

1. Press the MEASURE SETUP hot key. 

2. To set the nominal channel bandwidth to be measured, complete the following steps: 

a. Press the Bandwidth soft key. 

b. Select the bandwidth option: 1.4 MHz, 3 MHz, 5 MHz, 10 MHz, 15 MHz, or 20 MHz. 

3. Optional. Press the Miscellaneous soft key, and then do the following(s) as needed: 

–  To select the number of antenna ports, toggle the MIMO soft key and select 2x2 or 4x4. 

This MIMO (Multiple Input Multiple Output) setting is activated only if the option 031 LTE-
Advanced TDD is installed with a license number. If not, the instrument sets this option to 
2x2 by default. A 2x1 or 4x1 RF combiner is also required to able to test on MIMO 
channels. 

–  To select the cyclic prefix, toggle the Cyclic Prefix soft key and select Normal or 
Extended. See “Appendix E – Cyclic prefix table” on page 592 for OFDM parameter details 

by different bandwidth. 

4. Optional. Go to SAVE/LOAD > Save, and then select the save option from the choices available 

for your measurement mode. See “Using save” on page 33 for more information. 
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Measurement example 

Figure 147 ID scanner measurement with LTE - TDD OTA signal analyzer 

 

 

Multipath profile 

The Multipath Profile enables you to determine RF environmental conditions of testing area. It 

indicates the amount of power of the dominant pilot signal that is dispersed outside the main 

correlation peak due to multipath echoes that are expressed in dB. This value should be very small 

ideally. 

 

The multipath profile is the result of portions of the original broadcast signal arriving at the receiving 

antenna out of phase. This can be caused by the signal being reflected off objects such as buildings, 

or being refracted through the atmosphere differently from the main signal. 

 

Setting measure setup 

After configuring test parameters as described in the “Configuring test parameters” on page 271, you 

can continue your measurement. 

 

Procedure 

1. Press the MEASURE SETUP hot key. 

2. To set the nominal channel bandwidth to be measured, complete the following steps: 

a. Press the Bandwidth soft key. 

b. Select the bandwidth option: 1.4 MHz, 3 MHz, 5 MHz, 10 MHz, 15 MHz, or 20 MHz. 

3. Toggle the Display soft key and select RS or Sync. 

The RS Window soft key becomes activated if RS is selected. 

4. Press the RS Window soft key, if RS is selected, and then select the RS window option: 2 µs,  
4 µs, or 8 µs. 

5. Optional. Press the Miscellaneous soft key, and then do the following(s) as needed: 

–  To select the number of antenna ports, toggle the MIMO soft key and select 2x2 or 4x4. 

This MIMO (Multiple Input Multiple Output) setting is activated only if the option 031 LTE-
Advanced TDD is installed with a license number. If not, the instrument sets this option to 
2x2 by default. A 2x1 or 4x1 RF combiner is also required to able to test on MIMO 
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channels. 

–  To select the cyclic prefix, toggle the Cyclic Prefix soft key and select Normal or 
Extended. See “Appendix E – Cyclic prefix table” on page 592 for OFDM parameter details 

by different bandwidth. 

6. Optional. Go to SAVE/LOAD > Save, and then select the save option from the choices available 

for your measurement mode. See “Using save” on page 33 for more information. 

 

Measurement example 

Figure 148 Multipath profile measurement with LTE - TDD OTA signal analyzer 

 

 

Control channel 

DL RS power is the resource element power of Downlink Reference Symbol. The absolute DL RS 

power is indicated on the BCH. The absolute accuracy is defined as the maximum deviation between 

the DL RS power indicated on the BCH and the DL RS power at the BS antenna connector. 

 

The OTA Control Channel provides summary of all control channels including RS power trend over 

time. GPS coordinates (latitude and longitude) will be displayed on the screen if a GPS antenna is 

connected and locked to the GPS satellites. 

 

Setting measure setup 

After configuring test parameters as described in the “Configuring test parameters” on page 271, you 

can continue your measurement. The measurement settings can be saved and recalled as a file. You 

can also use JDViewer, PC application software to configure a measure setup, save as a file, and load 

the file on to the instrument. 

 

Procedure 

1. Press the MEASURE SETUP hot key. 

2. To set the nominal channel bandwidth to be measured, complete the following steps: 

a. Press the Bandwidth soft key. 

b. Select the bandwidth option: 1.4 MHz, 3 MHz, 5 MHz, 10 MHz, 15 MHz, or 20 MHz. 
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3. To select the subframe number to be measured, complete the following steps: 

a. Press the Subframe No soft key. 

b. Enter a value by using the numeric keys. You can also use the rotary knob. 
 

 

NOTE 

For MBMS testing, this subframe number must be neither 0 nor 5 as these subframes 0 
and 5 are not available for MBMS and it must be set to the MBMS transmitted channel’s 
subframe number. 

c. Press the Enter soft key. 

4. Toggle the Cell ID soft key and select Auto or Manual as desired: 

–  Auto: to let the instrument detect the Cell ID for the LTE signal automatically. 

–  Manual: to set a specific Cell ID for the LTE signal manually in order to speed up the 

synchronization with a BTS. 

5. Optional. Press the Miscellaneous soft key, and then do the following(s) as needed: 

–  To select the number of antenna ports, toggle the MIMO soft key and select 2x2 or 4x4. 

This MIMO (Multiple Input Multiple Output) setting is activated only if the option 031 LTE-
Advanced TDD is installed with a license number. If not, the instrument sets this option to 
2x2 by default. A 2x1 or 4x1 RF combiner is also required to test on MIMO channels. 

–  To assign a antenna port number automatically or manually, press the Antenna Port soft 
key and select the option: Auto, 0, 1, 2, and 3. If the option 031 LTE-Advanced TDD is not 

installed or if the MIMO is set to 2x2, the antenna ports 2 and 3 are disabled. 

–  To select the cyclic prefix, toggle the Cyclic Prefix soft key and select Normal or 
Extended. See “Appendix E – Cyclic prefix table” on page 592 for OFDM parameter details 

by different bandwidth. 

–  To turn the Multimedia Broadcast Multicast Service (MBMS) feature on or off, toggle the 
MBMS soft key and select On or Off. For proper MBMS testing, you need to set the 
Subframe No with the same PMCH subframe number. If this setting is on, the 

measurement item “MBSFN RS” appears in the result table. 

–  To set the Multicast Broadcast Single Frequency Network (MBSFN) detection automatically 
or manually for MBMS testing, toggle the MBSFN soft key and select Auto or Manual. An 

automatically detected or manually entered MBSFN ID appears on the screen. 

6. Go to SAVE/LOAD > Save, and then select the save option from the choices available for your 

measurement mode. See “Using save” on page 33 for more information. 

 

Setting limit for OTA control channel 

Procedure 

1. Press the LIMIT hot key. 

2. Select the test item(s) and set the limit(s) as needed: 
 

To set the limit for Select Set 

P-SS error vector magnitude P-SS EVM High Limit 

S-SS error vector magnitude S-SS EVM High Limit 

RS error vector magnitude RS EVM > RS0 EVM 
RS EVM > RS1 EVM 
RS EVM > RS2 EVM 
RS EVM > RS3 EVM 

High Limit 

Frequency error Frequency Error High Limit 
Low Limit 
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Time error Time Error High Limit 
Low Limit 

Time alignment error Time Alignment Error High Limit 

3. Optional. Go to SAVE/LOAD > Save, and then select Save Limit to save the limit settings. 

See “Using save” on page 33 for more information. 

 

Setting display 

You can use the TRACE/DISPLAY hard key to select the display option. 

 

Procedure 

1. Press the TRACE/DISPLAY hard key. 

2. Toggle the Display soft key and select Power or EVM. 

The screen changes according to the selected option. 

 

Measurement example 

Figure 149 Control channel measurement with LTE - TDD OTA signal analyzer 

 

 

Datagram 

The OTA Datagram is a time-varying spectral representation that shows how the power of a signal 

varies with time. The power allocated to the specific resource block will be represented with an 

amplitude axis (in dBm) and the waterfall diagram will show the trend of past resource block power 

over certain period. Using a marker function facilitates analysis of accumulated resource block power 

for data utilization. 

 

Setting measure setup 

After configuring test parameters as described in the “Configuring test parameters” on page 271, you 

can continue your measurement. The measurement settings can be saved and recalled as a file. You 

can also use JDViewer, PC application software to configure a measure setup, save as a file, and load 



JD780A Series Analyzers 

326 Using LTE – TDD Signal Analyzer 

the file on to the instrument. 

 

Procedure 

1. Press the MEASURE SETUP hot key. 

2. To set the nominal channel bandwidth to be measured, complete the following steps: 

a. Press the Bandwidth soft key. 

b. Select the bandwidth option: 1.4 MHz, 3 MHz, 5 MHz, 10 MHz, 15 MHz, or 20 MHz. 

3. To select the subframe number to be measured, complete the following steps: 

a. Press the Subframe No soft key. 

b. Enter a value by using the numeric keys. You can also use the rotary knob. 

c. Press the Enter soft key. 

4. Optional. Toggle the Cell ID soft key and select Auto or Manual as desired: 

–  Auto: to let the instrument detect the Cell ID for the LTE signal automatically. 

–  Manual: to set a specific Cell ID for the LTE signal manually in order to speed up the 

synchronization with a BTS. 

5. Optional. To set the threshold for PDSCH, complete the following steps: 

a. Press the PDSCH Threshold soft key. 

b. Enter a value by using the numeric keys. 

c. Press the dB soft key. 

6. To set the time cursor at a specific position, complete the following steps: 

a. Toggle the Time Cursor soft key and select On. 

b. Turn the rotary knob to move the time cursor. You can also enter a value and then press the 
Enter soft key. 

 

 

NOTE 

Enabling the time cursor puts the measurement on hold and you can make post-
processing analysis for each measurement over time using the time cursor. 

7. To start a new measurement, press the Reset/Restart soft key. 

8. Optional. Press the Miscellaneous soft key, and then do the following(s) as needed: 

–  To select the number of antenna ports, toggle the MIMO soft key and select 2x2 or 4x4. 

This MIMO (Multiple Input Multiple Output) setting is activated only if the option 031 LTE-
Advanced TDD is installed with a license number. If not, the instrument sets this option to 
2x2 by default. A 2x1 or 4x1 RF combiner is also required to able to test on MIMO 
channels. 

–  To select the cyclic prefix, toggle the Cyclic Prefix soft key and select Normal or 
Extended. See “Appendix E – Cyclic prefix table” on page 592 for OFDM parameter details 

by different bandwidth. 

9. Optional. Go to SAVE/LOAD > Save, and then select the save option from the choices available 

for your measurement mode. See “Using save” on page 33 for more information. 
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Measurement example 

Figure 150 Datagram measurement with LTE - TDD signal analyzer 

 

 

Route map 

The JD780A Series provides the Route Map function that allows you to collect data of points in an 

indoor or outdoor environment and track the received signals and coverage of RF transmitters by 

plotting data real time directly on top of a loaded floor plan or a map. 

 

If you have obtained user experience data through Viavi’s ariesoGEO and generated raster data files 

from the application, you can load them onto your base map to help you troubleshoot problems easily 

and quickly. 
 

Setting measure setup 

Procedure 

1. If required, connect a GPS receiver to your JD780A series for outdoor mapping. 
Indoor mapping does not necessarily need a GPS antenna. 

2. Configure test parameters as described in the “Configuring test parameters” on page 271. 

3. To load your map file, complete the following steps: 

a. Plug in your USB drive that has a floor map or .mcf file type created in JDMapCreator. If 

the JDMapCreator application on your computer is connected to the instrument via USB or 
LAN, you can send a map file with a single layer to the instrument directly by using the 
Send to EQP menu in JDMapCreator. 

 

 

NOTE 

The JDMapCreator converts and resizes any scanned floor plan or layout to fit onto your 
instrument’s display. JDMapCreator 1.2.0 or later can save a multiple-layered map, 
providing x1, x2, and x4 views, as a sizable map file so that you can zoom in and out 

after loading it. 

b. Press SAVE/LOAD hot key, and then select Load > Load Map. 

See “Using load” on page 36 for more information. 

4. Press the MEASURE SETUP hot key. 

5. Press the Plot Point soft key, and then select the plot point option from the following choices: 
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–  To collect data/plot points automatically as you move around in a vehicle or outside, press 
the GPS soft key and then toggle the Screen Mode soft key between Map and Full. 

 

 

NOTE 
With the Map setting, you can view only the collected points that can be seen within the 

boundary of the loaded map. If a point is off the map, the instrument displays an arrow to 
indicate the direction of the current location on the map and the distance from the center 
to the location at the top of the screen. 
 
With the Full setting, you can view all the collected points of the route without the loaded 

map. 

–  To collect data/plot points manually without a GPS antenna in an indoor environment, press 
the Position soft key. 

6. Press the Plot Item soft key, and then select the measurement option: RSRP, RSRQ, RS-SINR, 
S-SS RSSI, P-SS Power, S-SS Power, or S-SS Ec/Io. 

 

 

NOTE 

The instrument collects the strongest Cell ID’s data to plot points. 

7. Press the Bandwidth soft key to set the nominal channel bandwidth to be measured, and then 
select the bandwidth option: 1.4 MHz, 3 MHz, 5 MHz, 10 MHz, 15 MHz, or 20 MHz. 

8. Toggle the Plot soft key and select Start to start plotting. 

9. Touch directly on the screen or press the ENTER hard key to collect data and plot points on the 
loaded map for the Position setting. 

 

 

NOTE 
For the Position setting, you can change the direction of the route with the arrow keys 

and the distance with the rotary knob. 

10. Toggle the Plot soft key and select Stop to stop plotting. 

11. Press the SAVE/LOAD hot key to save the result. 
See “Using save” on page 33 for more information. 

 

 

NOTE 

The instrument does not automatically save the collected data. It is recommended that 
you save the result. Otherwise, you will lose all the collected data. 

 

 

Setting limit for route map 

You can set the thresholds for each test item. 

 

Procedure 

1. Press the LIMIT hot key. 

2. Select the plot items and set the limits as needed: 
 

To set the limit for Select Set 

RSRP RSRP Excellent, Very Good, Good, Fair, Poor (dBm) 

RSRQ RSRQ Good, Fair, Poor (dB) 

RS-SINR RS-SINR Good, Fair, Poor (dB) 

S-SS RSSI S-SS RSSI Excellent, Very Good, Good, Fair, Poor (dBm) 

P-SS Power P-SS Power Excellent, Very Good, Good, Fair, Poor (dBm) 

S-SS Power S-SS Power Excellent, Very Good, Good, Fair, Poor (dBm) 
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S-SS Ec/Io S-SS Ec/Io Good, Fair, Poor (dB) 

3. Optional. Go to SAVE/LOAD > Save, and then select Save Limit to save the limit settings. 

See “Using save” on page 33 for more information. 

 

Measurement example 

Figure 151 Route map measurement with LTE - TDD OTA signal analyzer 

1) RSRP 

 

2) RSRQ 
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3) RS-SINR 

 

4) S-SS RSSI 

 

5) P-SS Power 
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6) S-SS Power 

 

7) S-SS Ec/Io 

 

 

Controlling a map 

If you have loaded a sizable map that was created in JDMapCreator 1.2.0 or later, you can use the 

Map Control feature that enables you to zoom into the map and view a specific area of interest in detail. 

 

Procedure 

1. Press the TRACE/DISPLAY hard key. 

2. Press the Map Control soft key. This key is active only when you have loaded a sizable map. 

3. Do one of the following: 

–  To zoom into an area of interest directly, complete the following steps: 

a. Toggle the Zoom to soft key and select Area. 

The black rectangle appears on the map. 

b. Press the Zoom In and Zoom Out soft keys, as you need, to decrease and increase 

the selected area. 

c. Move the rectangle by using the four arrow keys, as you need, to place it in a specific 
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area of interest. 

d. Press the center of the rotary knob to zoom into the selected area. You can also press 
the Zoom to soft key again to zoom into the selected area. 

–  To zoom into the center or zoom out from the center, complete the following steps: 

a. Toggle the Zoom to soft key and select Center. 

b. Press the Zoom In and Zoom Out soft keys, as you need, to zoom in and zoom out. 

c. Move the zoomed-in area by using the four arrow keys, as you need. 

 

Loading and displaying raster data 

If you have a set of raster data files generated through the ariesoGEO application, you can load and 

overlay the data on your base map to help you check the signal quality and the strength of 

interferences while driving toward the area of interest. 

 

Procedure 

1. Copy a set of raster data files into your USB memory drive, including the following: 

–  ASCII: .tab, .asc, and .clr files 

–  BIL: .tab,.hdr, .bil, and .clr files 

 

NOTE 

The .tab file type is a geospatial vector data format used in many geographic 

information systems. The color file (.clr) is an optional file, but the image will be 

displayed as a grayscale image without it. The size of the raster map must be  
1024 x 1024 or smaller. 

2. Plug in the USB memory drive to your instrument. 

3. Press the TRACE/DISPLAY hard key. 

4. Press the Load Raster Map soft key. 

The file explorer window appears. 

5. Navigate to the raster file (.tab) you want to open, and then press the Load soft key. 

The raster image appears on top of your base map as shown in Figure 152. 

 

NOTE 

If the area of the loaded raster data is not within the boundary of the base map, you will 
not see the raster image on the screen. 

6. To select the display option, complete the following steps: 

a. Press the Display Options soft key. 

b. Select the option you desire from the choices: On, Off, and Blink. 

7. To adjust the transparency level of the image, complete the following steps: 

a. Press the Transparency soft key. 

b. Enter a value between 0 for opaque and 100 for clear. 

c. Press the Enter soft key. 
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Figure 152 Raster image overlaid on the route map in LTE-TDD OTA signal analyzer 

  

 

Performing RAN performance testing 

The JD780A series provides the optional feature that lets you conduct correlated uplink and downlink 

testing with your instrument connected to your mobile device via Bluetooth. The RANAdvisor TrueSite 

application installed on your smartphone collects data and transfers uplink data based on your 

parameter settings and then your instrument consolidates the data into the measurement results and 

displays them as performance indicators. It helps you troubleshoot a problem and identify the cause of 

the problem fast. 

 

To perform this testing, you need both of these installed: the license for the option 015 LTE-TDD RAN 

Performance Indicator on your instrument and the RANAdvisor TrueSite app with the license on your 

smartphone. 

 

Preparing your smartphone for remote control via Bluetooth 

To set up a Bluetooth connection and enable data collection with remote control properly, you need to 

pair your instrument with your smartphone and set the app’s local Bluetooth control option to Slave 

once at the beginning. 

 

Procedure 

1. Connect a Bluetooth adapter to the USB Host port and an Omni antenna to the RF In port of your 
CellAdvisor instrument. 
The instrument detects the adapter and turns on its Bluetooth automatically. 

2. Make your smartphone visible to your instrument by doing the following steps: 

a. On your smartphone, turn on Bluetooth. 

b. Check the checkbox for Visible to all nearby Bluetooth devices to enable this option. 

3. Pair with your smartphone by doing the following steps: 

a. On your instrument, press the MEASURE SETUP hot key. 

b. Press the Bluetooth Connect soft key. 

c. Press the Scan soft key. 

The instrument lists detected Bluetooth devices with their MAC address and status. 
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d. Highlight your mobile device from the list by touching on the screen. 

e. Press the Pair soft key. 

The pairing dialog box appears on your smartphone. 

f. On your smartphone, enter 0000 and then tap the OK button. 
If pairing is successful, the status of your device on the list changes to “Paired”. 

4. Make sure to set your smartphone as a slave by completing the following steps: 

a. On your smartphone, open the RANAdvisor TrueSite icon. 

b. Go to Settings > General. 

c. Tap the Automation Control Mode menu under Automation Control Options. 

d. Select the Local Bluetooth Control option. 

e. Tap Slave. 

The application restart dialog box appears. 

f. Tap Continue. 

The application closes itself. 

 

NOTE 
It is very important for you to set the local Bluetooth control option to Slave on the 

RANAdvisor TrueSite app in order to give your instrument a control to collect necessary 
data from the app over Bluetooth successfully. 

 

 

Setting parameters on RANAdvisor TrueSiteTM 

To specify uplink measurement data that will be transferred to your instrument, you need to set map 

display parameters of your choice on the RANAdvisor TrueSite application. 

 

Procedure 

1. After you have paired and set your smartphone as a slave, open the RANAdvisor TrueSite icon 

on your device again. 

2. Tap the (+) button at the bottom of the Home screen. 

The Main Screen appears. 

3. Tap the Customization menu. 

The Choose Operation menu box appears. 

4. Select Map Display Parameters > LTE Serving and Neighbor Parameters. 

5. Make sure to check the checkbox for the following two mandatory parameters: 

–  Serving E-ARFCN 

–  Serving Physical Cell-ID 

 

NOTE 

It is very important for you to select these two parameters to identify the Uplink Channel 
Number, Cell ID, Group ID, and Sector ID. 

6. Select other parameters up to six from the list of parameters supported by the CellAdvisor 
instrument. See “Appendix L – Supported map display parameters” on page 609 for more 
information. 

 

NOTE 

As the RANAdvisor TrueSite app can transfer data of up to eight parameters at a time, it 
limits you to select eight parameters in total: two compulsories and six electives. After you 
have selected all eight parameters, the app blocks any further selection. In this case, you 
need to uncheck any selected optional parameters in order to enable other optional 
parameters. 

7. Tap the OK button and then the Back key to return to the Home Screen. 

 

Performing RAN performance testing 

After you have set the local Bluetooth control option and selected desired parameters on the app, you 

need to connect your instrument to your smartphone via Bluetooth to enable data collection from 
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RANAdvisor TrueSite so that you can view consolidated measurement results on your instrument and 

save results as a file. 

 

Procedure 

1. Make sure to have the RANAdvisor TrueSite app opened on your device. 

2. Press the MEASURE SETUP hot key on your instrument. 

3. Press the Bluetooth Connect soft key. 

4. Highlight your paired smartphone to connect from the list. 

5. Press the Connect soft key. 

The connected device information appears above the RAN Performance Indicator chart to 
indicate a successful connection. 

6. The instrument automatically sets the correlated downlink channel number for the received uplink 
channel number and displays measurement results as like Figure 153. Observe the consolidated 

measurement results on the screen for your troubleshooting. 

 

NOTE 

If the Cell ID of the uplink channel is not identical to the one of the downlink channel, the 
instrument displays “---“ for the parameters to indicate invalid measurement results. 

7. If you want to see measurement results for other parameters, select new parameters on the 
RANAdvisor TrueSite app. See “Setting parameters on RANAdvisor TrueSite

TM
” on page 264. 

8. Optional. To save your settings and results, go to SAVE/LOAD > Save and then perform 

functions as you desire. See “Using save” on page 33 for more information. 

 

Measurement example 

Figure 153 RAN performance indicator in LTE-TDD signal analyzer 

 

 

Setting performance score level 

To analyze your measurement data easily with color codes, you can use the limit feature and set a 

performance score level for each measurement parameter. 

 

Procedure 

1. Press the LIMIT hot key. 



JD780A Series Analyzers 

336 Using LTE – TDD Signal Analyzer 

2. To analyze the quality of user experience, do the following as needed: 
 

To set the level for Select Set 

Data throughput Data Throughput Good, Bad (kbps) 

Channel quality indicator CQI Good, Bad 

Modulation type Modulation Type (On/Off only) 

 

3. To check the performance of eNodeB, do the following as needed: 
 

To set the level for Select Set 

Reference signal received power RSRP Good, Bad (dBm) 

Reference signal received 
quality 

RSRQ Good, Bad (dB) 

Signal to interference and noise 
ratio 

SINR Good, Bad (dB) 

Error vector magnitude More (1/2) > EVM Good, Bad (%) 

Time alignment error More (1/2) > Time Alignment Error Good, Bad (ns) 

Frequency error More (1/2) > Frequency Error Good, Bad (ppm) 
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Using CDMA Signal Analyzer 

This chapter provides instructions for using the CDMA Signal Analyzer function (option 020) with the 

CDMA OTA Analyzer function (option 040). Topics discussed in this chapter are as follows: 

 

 Introduction .............................................................................................................................. 338 

 Display overview ...................................................................................................................... 339 

 Connecting a cable .................................................................................................................. 339 

 Selecting measurement mode ................................................................................................. 341 

 Configuring test parameters .................................................................................................... 341 

 Conducting spectrum measurements ...................................................................................... 346 

 Conducting RF measurements ................................................................................................ 348 

 Conducting modulation measurements ................................................................................... 355 

 Performing auto measurements .............................................................................................. 363 

 Performing power statistics CCDF measurements ................................................................. 365 

 Conducting CDMA OTA measurements .................................................................................. 366 
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Introduction 

This CDMA Signal Analyzer can be used to test a CDMA transmitter including cdmaOne and 

cdma2000 signals to check the base station’s compliance with following standards documentation. 

 

 3GPP2 C.S0002 Physical Layer Standard for cdma2000 Spread Spectrum Systems 

 3GPP2 C.S0010 Recommended Minimum Performance Standards for cdma2000 Spread 

Spectrum Base Station 

 

This instrument automatically makes standard defined measurements using the measurement 

methods and limits as defined in the standards. Detailed measurement results allow you to analyze 

cdmaOne and cdma2000 system performance. 

 

 cdmaOne uses dual BPSK (Binary Phase-Shifting Key) for the forward link and OQPSK 

(Offset Quadrature Phase Shift Keying) for the reverse link. 

 cdma2000 uses QPSK (Quadrature Phase Shift Keying) modulation for the forward link and 

QPSK modulation with HPSK spreading for the reverse link. Both forward and reverse links 

may have several channels, and individual characteristics for each channel. The chip rate 

depends on the mode selected. 

 

You may alter the measurement parameters for specialized analysis. Pass/Fail testing with standard 

defined or user defined upper and lower limits and the Pass/Fail indictor help you to determine base 

station performance easily. 

 

This instrument provides the following measurement tools for CDMA system: 

 

 Spectrum Analysis 

 RF Analysis 

- Channel Power 

- Occupied Bandwidth 

- Spectrum Emission Mask (SEM) 

- Adjacent Channel Power Ratio (ACPR) 

- Multi-ACPR 

- Spurious Emissions 

 Modulation Analysis 

- Constellation 

- Code Domain Power 

- Codogram 

- Received Code Strength Indicator (RCSI) 

- CDP Table 

 Auto Measure 

 Power Statistics CCDF 

 Over The Air (OTA) 

- Channel Scanner 

- PN Scanner 

- Multipath Profile 

- Code Domain Power 

- Route Map 
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Display overview 

Figure 154 provides descriptions for each segment of the measurement screen. 

 

Figure 154 CDMA signal analyzer measurement screen 

 

 

Connecting a cable 

Direct connection 

Procedure 

1. Connect the Spectrum Analyzer RF In port of the JD780A series and the Power amplifier output 

port of BTS. 

 

Figure 155 Direct connection 

 
JD785A/JD786A 

 
JD788A 

 

  



JD780A Series Analyzers 

340 Using CDMA Signal Analyzer 

Indirect connection 

Procedure 

1. Connect the Spectrum Analyzer RF In port of the JD780A series and the monitor (test) port of 

BTS. 

 

Figure 156 Indirect connection 

 
JD785A/JD786A 

 
JD788A 

 

 

CAUTION 
The maximum power for the Spectrum Analyzer RF In port is +25 dBm (0.316 W). If the 
input signal level to be measured is greater than +25 dBm, use a High Power 
Attenuator to prevent damage when you directly connect the signal to the instrument or 
connect the signal from the coupling port of a directional coupler. 

 

 

NOTE 

For accurate PN Offset and Time Offset measurements with the CDMA Signal Analyzer 
function, a PP2S should be connected to the External Trigger. Without a GPS connection, 
measurement results could be invalid numbers. 

 

Over the air (OTA) 

Procedure 

1. Connect an Omni/directional RF antenna to the Spectrum Analyzer RF In port of the JD780A 

series. 

2. Connect a GPS antenna to the GPS port of the JD780A series. 

 

 

CAUTION 

If the input signal level to be measured is less than 0 dBm, set 0 dB attenuation or turn on 
the preamp to have better dynamic range for the OTA testing. 
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Figure 157 OTA connection 

 
JD785A/JD786A 

 
JD788A 

 

Selecting measurement mode 

Procedure 

1. Press the MODE hard key. 

2. Press the Signal Analyzer soft key. 

3. Press the CDMA soft key. The Spectrum mode is set by default. 

4. Press the MEASURE hot key, and then select the measurement mode option from the following 
choices: 

–  Spectrum 

–  RF Analysis > Channel Power, Occupied BW, Spectrum Emission Mask, ACPR,  
Multi-ACPR, or Spurious Emissions 

–  Modulation > Constellation, Code Domain Power, Codogram, RCSI, or CDP Table 

–  Auto Measure 

–  Power Statistics CCDF 

–  OTA > Channel Scanner, PN Scanner, Multipath Profile, Code Domain Power, 
or Route Map 

 

Configuring test parameters 

Setting frequency 

You can set the frequency with either frequency or channel number. If a frequency to be set matches 

to the frequency corresponding to the selected channel standard, the instrument calculates its channel 

number and updates the screen with it automatically. 

 

Procedure 

To set the center frequency: 

1. Press the FREQ/DIST hard key. 

2. Toggle the Unit soft key and select Freq. 
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3. Press the Center Frequency soft key. 

4. Enter a value by using the numeric keys. You can also use the rotary knob. 

5. Select the unit: GHz, MHz, kHz, or Hz. 

6. Optional. To define the amount of frequency increment for the rotary knob, complete the following 
steps: 

a. Press the Frequency Step soft key. 

b. Enter a value by using the numeric keys. You can also use the rotary knob. 

c. Press the unit: GHz, MHz, kHz, or Hz. 
 
To set the channel number: 

1. Press the FREQ/DIST hard key. 

2. Toggle the Unit soft key and select Channel. 

3. To select the standard channel, complete the following steps: 

a. Press the Channel Std soft key. The standard channel window appears. 

See “Appendix C – Band, frequency & channel standard”” on page 588 for more 
information. 

b. Select the band to be measured by using the rotary knob, the arrow keys, or the Page 
Up/Page Down soft keys. 

c. Press the Select soft key or the rotary knob to confirm the selection. 

4. Press the Channel Number soft key. 

5. Enter a value by using the numeric keys. You can also use the rotary knob. 

6. Press the Enter soft key. 

The instrument automatically displays the corresponding center frequency value for the selected 
channel number. 

7. Optional. To define the amount of channel increment for the rotary knob, complete the following 
steps: 

a. Press the Channel Step soft key. 

b. Enter a value by using the numeric keys. You can also use the rotary knob. 

c. Press the Enter soft key. 

 

 

NOTE 

This frequency setting is not used in the Multi-ACLR and Spurious Emissions modes. 

 

Setting amplitude 

Reference level and attenuation 

You can set the reference and attenuation levels automatically or manually to optimize the display of 

the traces measured, as you desire. 

 

Procedure 

To automatically set the reference and attenuation level: 

1. Press the AMP/SCALE hard key. 

2. Press the Auto Scale soft key. 

Each time you press this key, both of the Y-axis scale and input attenuation level change to be 
optimized with some margin. 

 
To set the reference or attenuation level manually: 



JD780A Series Analyzers 

 Using CDMA Signal Analyzer 343 

1. Press the AMP/SCALE hard key. 

2. To set the maximum reference value on the Y-axis manually, complete the following steps: 

a. Press the Reference Level soft key. 

b. Enter a value by using the numeric keys or the rotary knob with 10 dB increments. 

c. Press the unit soft key or the ENTER hard key. 

 

 

NOTE 
In the measurements such as Code Domain Power, Codogram, and RCSI, you may 
need to select the reference option between Relative and Absolute before setting the 

reference level. 

3. To set the attenuation option, select one from the following choices: 

–  To set the input attenuator’s level automatically, select Attenuation > Auto. 

 

 

NOTE 
It is recommended that you set the Attenuation to Auto in most situations so that the 

level of the input attenuator can be set automatically according to your input signal level. 

 

–  To set the input attenuation manually up to 55 dB to optimize S/N, complete the following 
steps: 

a. Select Attenuation > Manual. 

b. Press the Attenuation Value soft key to set the level. 

c. Enter a value between 0 and 55 in fives by using the numeric keys. 

d. Press the dB soft key or the ENTER hard key. 

–  To couple the input attenuator’s level with your reference level setting, select Attenuation > 
Couple. 

As you increase the reference setting, the attenuation level also increases acoordingly. 
 
Optional. To change the scale unit: 

1. Select More (1/2) > Units. 

2. Select the unit of the display scale: dBm, dBV, dBmV, dBµV, V, or W. 

The scale unit on the screen changes accordingly. 

 

 

NOTE 

This Units menu is available in the Spectrum and RF Analysis modes. 
 

 

Scale per division 

You can use the Scale/Div feature available for the spectrum and RF analysis. It represents the value 

of one division on the horizontal scale. The default setting is 10 dB per division and the maximum 

value can be set up to 20 dB. 

 

Procedure 

To set the scale per division: 

1. Press the AMP/SCALE hard key. 

2. Select More (1/2) > Scale/Div. 

3. Enter a value between 1 and 20 by using the numeric keys. 

4. Press the dB soft key to complete the entry. 
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Pre-amplifier 

You can turn the internal pre-amplifier on to correct and compensate for the gain of the preamp so that 

amplitude readings show the value at the input connector. 

 

Procedure 

1. Press the AMP/SCALE hard key. 

2. Toggle the Preamp soft key and select On or Off as needed. 

 

 

NOTE 

You can turn the Preamp on when the input attenuation range is from 0 dB to 10 dB. If 
the attenuation value is manually set to greater than 10 dB, the instrument will 
automatically turn off the pre-amplifier to display low-level signal properly on the chart. 

 

External offset 

You can turn the External Offset on and manually set the external offset value. An offset consists of a 

cable loss and a user offset and the measurement result shows the value reflecting both offset values. 

When the external offset value is set at 40 dB in the Spectrum mode, the measurement result 

compensates 40 dB at both the Spectrum Analyzer and Signal Analyzer modes 

 

Procedure 

To set the external offset: 

1. Press the AMP/SCALE hard key. 

2. Toggle the External Offset soft key and select On. 

3. Enter a value by using the numeric keys. 

4. Press the dB soft key to complete the entry. 

 
To turn the external offset off: 

1. Press the AMP/SCALE hard key. 

2. Toggle the External Offset soft key and select Off. 

 

Setting average 

You can set the number of measurements to be averaged for the trace presentation. A maximum of 

100 times of averaging can be set. When the averaging reaches to your setting, a new measurement 

value replaces the measurement value in sequence from the earliest. 

 

Procedure 

1. Press the BW/AVG hard key. 

2. Press the Average soft key. 

3. Enter a value between 1 and 100 as needed by using the numeric keys. 

4. Press the Enter soft key. 

 

Setting sweep mode 

The default setting is Continue to sweep continuously for most on-going measurements. If you want to 
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hold the measurement or get a single sweep, you can change the sweep mode. 

 

Procedure 

To select the single sweep mode: 

1. Press the SWEEP hot key. 

2. Toggle the Sweep Mode soft key and select Single. You can also use the HOLD hot key. 

The letter HOLD in red appears and the sweeping is paused. 

3. Optional. Press the Sweep Once soft key to get a new measurement. 
 
To return to the continuous sweep mode: 

1. Toggle the Sweep Mode soft key and select Continue. You can also use the HOLD hot key. 

The letter HOLD in red disappears and the sweeping resumes. 

 

Setting trigger source 

You can set the trigger source option for your measurements. Connecting an external trigger is 

necessary for accurate modulation measurements on CDMA systems. 

Procedure 

1. Press the TRIGGER hot key. 

2. Select the trigger source option from the following choices: Internal, External, or GPS. 

 

Setting external clock 

To enhance the reliability of modulation analysis measurements the JD780A series must be 

synchronized with a base station. When an external clock is not supplied, the instrument works with its 

built-in internal high-accuracy time base and some measurement results may exhibit inaccurate values. 

Therefore, it is highly recommended that you use the same reference clock as the signal source. You 

can use the TRIGGER hot key to set the external clock. 

 

Table 15 Standards of external clock operation 

Clock Type Reference Port Switching Standard 

External Reference Internal Internal 10 MHz  Default 

 External External Ref Clock Ext Ref (SMA) Manual switching 
(Input signal level >-3 dBm) 

 GPS GPS Clock GPS (SMA) Automatic switching 
(GPS signal received) 

Trigger Internal Internal Trigger  Default 

 External External Trigger Trigger (SMA) Manual switching 

 GPS GPS GPS (SMA) Manual switching 
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Figure 158 Connection ports for external reference clock 

 

 

Procedure 

1. Connect an external reference or a GPS antenna to the JD780A series. 

2. Press the SYSTEM hot key. 

3. Press the Freq Reference soft key, and then select the reference option: Internal, External 10 
MHz, External 13 MHz, External 15 MHz, or GPS. 

 

 

NOTE 

When a GPS antenna is connected and locked, GPS coordinates (longitude and latitude) 
are displayed on the screen and frequency reference is automatically set to GPS in the 
System > Freq Reference. 

 

Table 16 External reference indicators 

Type Indicator Description 

Internal  (green) The green INT icon indicates that the instrument uses the built-in 

internal time base. 

External  (green) The green EXT icon indicates that an external reference is connected 

and locked and that the instrument uses the same reference clock as 
the signal source. 

External  (red) The red EXT icon indicates that an external reference is connect but not 

locked. 

GPS (green) The green GPS antenna icon indicates that a GPS antenna is 
connected and locked. 

GPS (yellow) The yellow GPS antenna icon indicates that a GPS antenna is 
connected and locking is in progress. 

GPS (grey) The grey GPS antenna icon indicates that a GPS antenna is not 
connected, failed, or unable to be locked. 

 

Conducting spectrum measurements 

If you have configured test parameters as described in the “Configuring test parameters” on page 341, 

your measurement result is displayed on the screen as like the following example, Figure 159. 
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Figure 159 Spectrum measurement screen with CDMA signal analyzer 

 

 

Setting trace 

You can display up to six traces on the measurement chart simultaneously. 

 

Procedure 

1. Press the TRACE/DISPLAY hard key. 

2. Press the Select Trace soft key, and then select the trace number: T1, T2, T3, T4, T5, or T6. 

The legend shape of the selected trace changes from square to round to indicate that the trace is 
the active one now. 

3. Do one of the following: 
 

To Select Trace Legend 

Clear current data and display with new 
measurements 

Clear Write W 

Display the input signal’s maximum response only 
(unlimited or for a certain amount of time) 

Max Hold M 

Display the input signal’s minimum response only 
(unlimited or for a certain amount of time) 

Min Hold m 

Capture the selected trace and compare traces Capture C 

Load a saved trace More (1/2) > Load L 

Hide the selected trace Trace View > Off F 

Remove all the traces and initialize the trace 
settings 

More (1/2) > Trace 
Clear All 

 

 

 

NOTE 
For the Max Hold and Min Hold, your instrument compares newly acquired data with the 

active trace and displays larger maximum values or smaller minimum values on the 
screen. You can set it to Unlimited to hold and view maximum or minimum data or 

specify a certain amount of time up to 60 seconds by using numeric keys or the rotary 
knob. 
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4. To select the detection option, press the More (1/2) > Detectors, and then do one of the 

following: 
 

To display Select 

Random noise better than the peak without missing signals Normal 

The highest value in each data point Peak 

The root mean squared average power across the spectrum RMS 

The lowest value in each data point Negative Peak 

The center value in each data point Sample 

5. Optional. Press the More (1/2) > Trace Info soft key, and then select the trace number to view 
the trace’s parameter setting information stored at the time of the measurement or None to hide 

the information display. 

6. Optional. If you have the two traces T1 and T2, you can perform trace math. To view the power 
difference between the traces, press the T1 – T2 -> T5 or T2 – T1 -> T6 soft key. 

The result is overlaid on the screen along with the second Y-axis. 

 

Conducting RF measurements 

Channel power 

The Channel Power measurement is a common test used in the wireless industry to measure the total 

transmitted power of a radio within a defined frequency channel. It acquires a number of points 

representing the input signal in the time domain, transforms this information into the frequency domain 

using Fast Fourier Transform (FFT), and then calculates the channel power. The effective resolution 

bandwidth of the frequency domain trace is proportional to the number of points acquired for the FFT. 

 

The channel power measurement identifies the total RF power, power spectral density (PSD) and peak 

to average ratio (PAR) of the signal within the channel bandwidth (1.23 MHz for cdmaOne). 

 

After configuring test parameters as described in the “Configuring test parameters” on page 341, your 

measurement result is displayed on the screen as like the following example, Figure 160. 
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Figure 160 Channel power measurement with CDMA signal analyzer 

 

 

 

NOTE 
You can use the LIMIT hot key to analyze your measurements with the user-definable 
limit and Pass/Fail indication. See “Setting limit for RF tests” on page 354 for more 
information. 

 

Occupied bandwidth 

The Occupied Bandwidth measures the spectrum shape of the carrier. It is defined as the bandwidth, 

which includes 99% of the transmitted power among total transmitted power. 

 

After configuring test parameters as described in the “Configuring test parameters” on page 341, your 

measurement result is displayed on the screen as like the following example, Figure 161. 

 

Figure 161 Occupied bandwidth measurement with CDMA signal analyzer 
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NOTE 
You can use the LIMIT hot key to analyze your measurements with the user-definable 
limit and Pass/Fail indication. See “Setting limit for RF tests” on page 354 for more 
information. 

 

Spectrum emission mask (SEM) 

The Spectrum Emission Mask (SEM) measurement required by 3GPP2 specifications encompasses 

different power limits and different measurement bandwidths (resolution bandwidths) at various 

frequency offsets. It may be expressed as a ratio of power spectral densities between the carrier and 

the specified offset frequency band. It provides useful figures-of-merit for the spectral re-growth and 

emissions produced by components and circuit blocks, without the rigor of performing a full SEM 

measurement. 

 

The SEM measures spurious signal levels in up to five pairs of offset or region frequencies and relates 

them to the carrier power. 

 

Setting measure setup 

After configuring test parameters as described in the “Configuring test parameters” on page 341, your 

measurement result is displayed on the screen as like the following example, Figure 162. 

 

Figure 162 SEM measurement with CDMA signal analyzer 

 

 

 

NOTE 
You can use the LIMIT hot key to analyze your measurements with the user-definable 
limit and Pass/Fail indication. See “Setting limit for RF tests” on page 354 for more 
information. 

 

ACPR 

The Adjacent Channel Power Ratio (ACPR) is defined as the ratio of the average power in the 

adjacent frequency channel (or offset) to the average power in the transmitted frequency channel. It 

may be expressed as the ratio of the integrated signal power in the adjacent channel to the integrated 

signal power in the main channel. 
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After configuring test parameters as described in the “Configuring test parameters” on page 341, your 

measurement result is displayed on the screen as like the following example, Figure 163. 

 

Figure 163 ACPR measurement with CDMA signal analyzer 

 

 

 

NOTE 

You can use the LIMIT hot key to analyze your measurements with the user-definable 
limit and Pass/Fail indication. See “Setting limit for RF tests” on page 354 for more 
information. 

 

Multi-ACPR 

The Multi-ACPR measurement is used to perform multi-channel ACPR measurements with as many 

channels as possible. It helps you to measure ACPR in multi-channel transmitting base station 

environment. 

 

Setting frequency for Multi-ACPR 

You can set the frequency with either frequency or channel number. 

Procedure 

1. Press the MEASURE SETUP hot key. 

2. To set the frequency, do one of the following: 

–  To set the center frequency, complete the following steps: 

a. Toggle the Unit soft key and select Freq. 

b. Press the Lowest Frequency soft key to set the starting center frequency. 

c. Enter a value by using the numeric keys. You can also use the rotary knob. 

d. Select the unit: GHz, MHz, kHz, or Hz. 

e. Press the Highest Frequency soft key to set the stopping center frequency. 

f. Enter a value by using the numeric keys. You can also use the rotary knob. 

g. Select the unit: GHz, MHz, kHz, or Hz. 

–  To set the channel number, complete the following steps: 
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a. Toggle the Unit soft key and select Channel. 

b. To select the standard channel, press the Channel Std soft key and then select the 

band to be measured. 

c. Press the Lowest Channel soft key to set the starting channel. 

d. Enter a value by using the numeric keys. You can also use the rotary knob. 

e. Press the Enter soft key. 

f. Press the Highest Channel soft key to set the stopping channel. 

g. Enter a value by using the numeric keys. You can also use the rotary knob. 

h. Press the Enter soft key. 

 

After configuring test parameters, your measurement result is displayed on the screen as like the 

following example, Figure 164. 

 

Figure 164 Multi-ACPR measurement with CDMA signal analyzer 

 
 

 

NOTE 
You can use the LIMIT hot key to analyze your measurements with the user-definable 
limit and Pass/Fail indication. See “Setting limit for RF tests” on page 354 for more 
information. 

 

Spurious emissions 

Out-of-band emissions are unwanted emissions immediately outside the channel bandwidth resulting 

from the modulation process and non-linearity in the transmitter but excluding spurious emissions. The 

Spurious Emissions measurement is to identify and determine the power level of out-of-band spurious 

emission within the necessary channel bandwidth and modulated signal measured at the RF port of 

the Base Station. 
 

Setting measure setup 

Procedure 

1. Press the MEASURE SETUP hot key. 
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2. To set up the range table and parameters, press the Range Table soft key and then complete 

the following steps: 

a. Press the Range soft key, and then select the range number between 1 and 20 to add  

as a new or change the existing settings. 

b. Do the following as desired: 

–  Select Start Frequency, and then specify the start frequency for the selected range. 

–  Select Stop Frequency, and then specify the stop frequency for the selected range. 

–  Select Start Limit, and then specify the lower limit for Pass/Fail indication. 

–  Select Stop Limit, and then specify the upper limit for Pass/Fail indication. 

–  Select More (1/2) > Attenuation, and then specify an value in the multiple of five. 

–  Select More (1/2) > RBW, and then specify a RBW value. 

–  Select More (1/2) > VBW, and then specify a VBW value. 

c. Press the PREV hard key. 

d. Toggle the Range soft key and select On to display the selected range in the result table or 

Off to hide it from the table. 

3. Toggle the Measure Type soft key between Examine and Full to select the measurement type. 

 

NOTE 
The Examine mode displays only the selected range while the Full mode lets the 

instrument automatically changes the selected range from one another. 

4. To set the number of measurements to be averaged, complete the following steps: 

a. Press the Average soft key. 

b. Enter a value between 1 and 100, and then press the Enter soft key. 

5. To move the highlighted bar in the result table to other range, complete the following steps: 

a. Press the Range soft key in the Measure Setup menu bar. 

b. Enter a value between 1 and 20, and then press the Enter soft key. 

 

After configuring test parameters as described in the “Configuring test parameters” on page 341, your 

measurement result is displayed on the screen as like the following example, Figure 165. 
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Figure 165 Spurious emissions measurement with CDMA signal analyzer 

 

 

 

NOTE 

You can use the LIMIT hot key to analyze your measurements with the user-definable 
limit and Pass/Fail indication. See “Setting limit for RF tests” on page 354 for more 
information. 

 

Setting limit for RF tests 

By default, test limits specified in the standard are set for you. You can change thresholds if you desire. 

 

Procedure 

1. Press the LIMIT hot key. 

2. Press the RF Test Limits soft key. 

3. Select the test item(s) and set the limit(s) depending on your selected measurement mode: 
 

To set the limit for Select Set 

Channel power Channel Power High Limit 
Low Limit 

Occupied bandwidth Occupied BW High Limit 

Spectrum emission mask Spectrum Emission Mask (On/Off only) 

ACPR ACPR (On/Off only) 

Multi-ACPR Multi-ACPR (On/Off only) 

Spurious emissions Spurious Emissions (On/Off only) 

4. Optional. You can enable alarm sound that goes off if the measurement falls outside of the limit. 
Toggle the Beep soft key between On and Off to enable or disable the beep sound. 

5. Optional. Go to SAVE/LOAD > Save, and then select Save Limit to save the limit settings. 

See “Using save” on page 33 for more information. 
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Conducting modulation measurements 

In order to make accurate measurements of time offset and PN, you must connect an external trigger 

before making a modulation measurement. 

 

Constellation 

The Constellation is used to observe some aspects of modulation accuracy and can reveal certain 

fault mechanisms such as I/Q amplitude imbalance or quadrature imbalance. It displays constellation 

diagram by modulation types. 

 

Setting measure setup 

After configuring test parameters as described in the “Configuring test parameters” on page 341, you 

can continue your measurement. The measurement settings can be saved and recalled as a file. You 

can also use JDViewer, PC application software to configure a measure setup, save as a file, and load 

the file on to the instrument. 

 

Procedure 

1. Press the MEASURE SETUP hot key. 

2. To set the Pseudo-Noise (PN) offset, complete the following steps: 

a. Toggle the PN Offset soft key between Auto and Manual. 

b. Enter a value by using the numeric keys to set manually. 

c. Press the Enter soft key. 

3. To set the incremental step for the PN offset, complete the following steps: 

a. Press the PN Increment soft key. 

b. Enter a value by using the numeric keys. 

c. Press the Enter soft key. 

4. Optional. Go to SAVE/LOAD > Save, and then select the save option from the choices available 

for your measurement mode. See “Using save” on page 33 for more information. 
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Measurement example 

Figure 166 Constellation measurement with CDMA signal analyzer 

 

 

 

NOTE 

You can use the LIMIT hot key to analyze your measurements with the user-definable 
limit and Pass/Fail indication. See “Setting limit for modulation tests” on page 362 for 
more information. 

 

Code domain power 

The Code Domain Power (CDP) measures the distribution of power across the set of code channels, 

normalized to the total power. It helps to verify that each code channel is operating at its proper level 

and to identify problems throughout the transmitter design from coding to the RF section. System 

imperfections such as amplifier non-linearity will present themselves as an undesired distribution of 

power in the code domain. 

 

Setting measure setup 

After configuring test parameters as described in the “Configuring test parameters” on page 341, you 

can continue your measurement. The measurement settings can be saved and recalled as a file. You 

can also use JDViewer, PC application software to configure a measure setup, save as a file, and load 

the file on to the instrument. 

 

Procedure 

1. Press the MEASURE SETUP hot key. 

2. To set the Pseudo-Noise (PN) offset, complete the following steps: 

a. Toggle the PN Offset soft key between Auto and Manual. 

b. Enter a value by using the numeric keys to set manually. 

c. Press the Enter soft key. 

3. To set the incremental step for the PN offset, complete the following steps: 

a. Press the PN Increment soft key. 

b. Enter a value by using the numeric keys. 



JD780A Series Analyzers 

 Using CDMA Signal Analyzer 357 

c. Press the Enter soft key. 

4. To set the threshold between Auto and Manual, complete the following steps: 

a. Press the Threshold soft key. Its default setting is -27 dB. 

b. Enter a value between -50 and zero by using the numeric keys to change the value in the 
Manual mode. 

c. Press the Enter soft key. 

5. Toggle the Q-Paging soft key between On and Off to enable or disable the quick page channel 

that indicates the power of Quick Page Walsh code 80. 

6. Optional. Go to SAVE/LOAD > Save, and then select the save option from the choices available 

for your measurement mode. See “Using save” on page 33 for more information. 

 

Measurement example 

Figure 167 Code domain power measurement with CDMA signal analyzer 

 

 

 

NOTE 

You can use the LIMIT hot key to analyze your measurements with the user-definable 
limit and Pass/Fail indication. See “Setting limit for modulation tests” on page 362 for 
more information. 

 

Setting display 

You can view .your measurement results in a different view option. 

 

Procedure 

1. Press the TRACE/DISPLAY hard key. 

2. Press the Code Order soft key, and then select the code order option from the following choices: 

–  Hadamard: To assign the number based on Walsh code order and display the measured 

code power according to the assigned number in sequence. 

–  Bit Reverse: Code number in binary bit is reversed relative to the Hadamard method. 

3. Toggle the Base Code Length soft key and select the base Walsh code number: 64 or 128. 
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Codogram 

The Codogram displays how the code level is changing over time and makes it easier for you to view 

traffic channels as they initiate and terminate and to track traffic channels call levels over time. The 

Codogram measurements can be saved into an external USB memory so that a post-analysis can be 

done with the application software JDViewer. 

 

Setting measure setup 

After configuring test parameters as described in the “Configuring test parameters” on page 341, you 

can continue your measurement. The measurement settings can be saved and recalled as a file. You 

can also use JDViewer, PC application software to configure a measure setup, save as a file, and load 

the file on to the instrument. 

 

Procedure 

1. Press the MEASURE SETUP hot key. 

2. To set the Pseudo-Noise (PN) offset, complete the following steps: 

a. Toggle the PN Offset soft key between Auto and Manual. 

b. Enter a value by using the numeric keys to set manually. 

c. Press the Enter soft key. 

3. To set the incremental step for the PN offset, complete the following steps: 

a. Press the PN Increment soft key. 

b. Enter a value by using the numeric keys. 

c. Press the Enter soft key. 

4. To set the threshold between Auto and Manual, complete the following steps: 

a. Press the More (1/2) > Threshold soft key. Its default setting is -27 dB. 

b. Enter a value between -50 and zero by using the numeric keys to change the value in the 
Manual mode. 

c. Press the Enter soft key. 

5. Toggle the More (1/2) > Q-Paging soft key between On and Off to enable or disable the quick 

page channel that indicates the power of Quick Page Walsh code 80. 

6. To set the time interval, complete the following steps: 

a. Press the Time Interval soft key. 

b. Enter a value by using the numeric keys. 

c. Press the Enter soft key. 

7. To place the time cursor to analyze your measurements, complete the following steps: 

a. Toggle the Time Cursor soft key between On and Off to enable or disable the time cursor. 

b. Enter a value by using the numeric keys. 

c. Press the Enter soft key. 

 

 

NOTE 

When the time cursor is enabled, the measurement is put on hold and information about 
the time cursor is displayed. 

8. Optional. Go to SAVE/LOAD > Save, and then select the save option from the choices available 

for your measurement mode. See “Using save” on page 33 for more information. 
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Measurement example 

Figure 168 Codogram in full view with CDMA signal analyzer 

 

 

Setting display 

You can view .your measurement results in a different view option. 

 

Procedure 

1. Press the TRACE/DISPLAY hard key. 

2. Press the Code Order soft key, and then select the code order option from the following choices: 

–  Hadamard: To assign the number based on Walsh code order and display the measured 

code power according to the assigned number in sequence. 

–  Bit Reverse: Code number in binary bit is reversed relative to the Hadamard method. 

3. Toggle the Base Code Length soft key and select the base Walsh code number: 64 or 128. 

 

RCSI 

The Received Code Strength Indicator (RCSI) is used to track the power variation of cdmaOne or 

cdma2000 control channels such as Pilot, Paging, Sync, and Q-Paging over time. The RCSI 

measurements can be saved into an external USB memory so that a post-analysis can be done with 

the application software JDViewer. 

 

Setting measure setup 

After configuring test parameters as described in the “Configuring test parameters” on page 341, you 

can continue your measurement. The measurement settings can be saved and recalled as a file. You 

can also use JDViewer, PC application software to configure a measure setup, save as a file, and load 

the file on to the instrument. 

 

Procedure 

1. Press the MEASURE SETUP hot key. 
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2. To set the Pseudo-Noise (PN) offset, complete the following steps: 

a. Toggle the PN Offset soft key between Auto and Manual. 

b. Enter a value by using the numeric keys to set manually. 

c. Press the Enter soft key. 

3. To set the incremental step for the PN offset, complete the following steps: 

a. Press the PN Increment soft key. 

b. Enter a value by using the numeric keys. 

c. Press the Enter soft key. 

4. To set the threshold between Auto and Manual, complete the following steps: 

a. Press the Threshold soft key. Its default setting is -27 dB. 

b. Enter a value between -50 and zero by using the numeric keys to change the value in the 
Manual mode. 

c. Press the Enter soft key. 

5. Toggle the Q-Paging soft key between On and Off to enable or disable the quick page channel 

that indicates the power of Quick Page Walsh code 80. 

6. Press the Alarm Code soft key, and then select the alarm code option: None, Pilot, Page, Sync, 
or Quick Page. 

7. To set the alarm mask, complete the following steps: 

a. Press the Set Mask soft key. 

b. Enter a value by using the numeric keys. 

c. Press the [dB|dBm] soft key. 

8. Optional. Go to SAVE/LOAD > Save, and then select the save option from the choices available 

for your measurement mode. See “Using save” on page 33 for more information. 

 

Measurement example 

Figure 169 RCSI measurement with CDMA signal analyzer 

 

 

Setting display 

You can view .your measurement results in a different view option. 
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Procedure 

1. Press the TRACE/DISPLAY hard key. 

2. Press the Code Order soft key, and then select the code order option from the following choices: 

–  Hadamard: To assign the number based on Walsh code order and display the measured 

code power according to the assigned number in sequence. 

–  Bit Reverse: Code number in binary bit is reversed relative to the Hadamard method. 

3. Toggle the Base Code Length soft key and select the base Walsh code number: 64 or 128. 

 

CDP Table 

The CDP Table is used to look at a numeric and textual description of all the active code channels in 

the signal. 

 

Setting measure setup 

After configuring test parameters as described in the “Configuring test parameters” on page 341, you 

can continue your measurement. The measurement settings can be saved and recalled as a file. You 

can also use JDViewer, PC application software to configure a measure setup, save as a file, and load 

the file on to the instrument. 

 

Procedure 

1. Press the MEASURE SETUP hot key. 

2. To set the Pseudo-Noise (PN) offset, complete the following steps: 

a. Toggle the PN Offset soft key between Auto and Manual. 

b. Enter a value by using the numeric keys to set manually. 

c. Press the Enter soft key. 

3. To set the incremental step for the PN offset, complete the following steps: 

a. Press the PN Increment soft key. 

b. Enter a value by using the numeric keys. 

c. Press the Enter soft key. 

4. To set the threshold between Auto and Manual, complete the following steps: 

a. Press the Threshold soft key. Its default setting is -27 dB. 

b. Enter a value between -50 and zero by using the numeric keys to change the value in the 
Manual mode. 

c. Press the Enter soft key. 

5. Toggle the Q-Paging soft key between On and Off to enable or disable the quick page channel 

that indicates the power of Quick Page Walsh code 80. 
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Measurement example 

Figure 170 CDP Table measurement with CDMA signal analyzer 

 

 

Setting display 

If the CDP table spans over to the next page(s), you can change pages up and down to view .your 

measurement results. 

 

Procedure 

1. Press the TRACE/DISPLAY hard key. 

2. Press the Code Order soft key, and then select the code order option from the following choices: 

–  Hadamard: To assign the number based on Walsh code order and display the measured 

code power according to the assigned number in sequence. 

–  Bit Reverse: Code number in binary bit is reversed relative to the Hadamard method. 

3. Toggle the Base Code Length soft key and select the base Walsh code number: 64 or 128. 

4. Select Page Up or Page Down as needed to scroll the screen up and down. 

 

Setting limit for modulation tests 

Procedure 

1. Press the LIMIT hot key. 

2. Press the Modulation Test Limits soft key. 

3. Select the test item(s) and set the limit(s) depending on your selected measurement mode: 
 

To set the limit for Select Set 

Frequency error Frequency Error High Limit 
Low Limit 

Time offset Time Offset High Limit 
Low Limit 
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Waveform quality (Rho) Rho Low Limit 

Carrier feed through Carrier Feed Through High Limit 

Pilot power Pilot Power High Limit [Abs|Rel] 
Low Limit [Abs|Rel] 

Highest level among inactive channels Max Inactive High Limit 

4. Optional. You can enable alarm sound that goes off if the measurement falls outside of the limit. 
Toggle the Beep soft key between On and Off to enable or disable the beep sound. 

5. Optional. Go to SAVE/LOAD > Save, and then select Save Limit to save the limit settings. 

See “Using save” on page 33 for more information. 

 

 

NOTE 

The Time Offset compares the PN offset timing with the overall system time and the 
instrument checks the start of PN offset in comparison to either the GPS signal or the 
even second clock signal. 

 

 

NOTE 

The Rho measures the modulation quality for a CDMA transmitter along with EVM and 
Walsh Channel Power. It includes all errors occurred along the transmitter chain such as 
base band filtering, abnormality of I/Q modulator and distortion in power amplifier. A 
perfect Rho value is 1.0 indicating that all of the power is being transmitted correctly. 

 

 

NOTE 

The Carrier Feed Through is a result of the RF carrier signal feeding through the I/Q 
modulator and riding on the output circuitry without being modulated. 

 

Performing auto measurements 

The Auto Measure function of the JD780A series allows a complete signal profiling covering RF 

characterization and modulation quality parameters of up to 10 different carriers, particularly useful on 

an overlay architecture where base stations are transmitting in different frequencies. 

 

The Auto Measure can be easily executed either by selecting a menu in the instrument or by running a 

programmed scenario in the PC-based application so that the instrument automatically configure and 

perform tests on every aspect of all the carriers. 

 

Setting limit for auto measure 

You can set test limits for test item(s) in the auto measurement. 

Procedure 

1. Press the LIMIT hot key. 

2. Press the RF Test Limits soft key, and then enable test limits as desired. 

3. Press the Modulation Test Limits soft key, and then enable test limits as desired. 

4. Optional. You can enable alarm sound that goes off if the measurement falls outside of the limit. 
Toggle the Beep soft key between On and Off to enable or disable the beep sound. 

5. Optional. Go to SAVE/LOAD > Save, and then select Save Limit to save the limit settings. 

See “Using save” on page 33 for more information. 
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Setting measure setup 

After configuring test parameters as described in the “Configuring test parameters” on page 341, you 

can continue your measurement. The measurement settings can be saved and recalled as a file. You 

can also use JDViewer, PC application software to configure a measure setup, save as a file, and load 

the file on to the instrument. 

 

Procedure 

1. Press the MEASURE SETUP hot key. 

2. Toggle the Configuration soft key and select the configuration option: 

–  Current: to let the instrumnet use current frequency (single carrier) and determine pass or 

fail based on the instrument’s limit settings in Auto Measure. 

–  Scenario: to run a test with a programmed scenario in JDViewer. 

The Scenario menu becomes activated. 

3. To load a scenario, press the Scenario soft key, and then select a scenario file to load. 

4. Toggle the Test Time soft key and select the test time option: 

–  Now: to let the instrument run a test only once. 

–  Schedule: to let the instrument repeat tests as defined in the Set Timing. 

The Set Timing menu becomes activated. 

5. To define a schedule for an auto measurement, complete the following steps: 

a. Press the Set Timing soft key. 

b. Press the Start Time (HH:MM) soft key. 

c. Enter the time in the HH:MM format, and then press the Enter soft key. 

d. Press the Stop Time (HH:MM) soft key. 

e. Enter the time in the HH:MM format, and then press the Enter soft key. 

f. Press the Time Interval soft key. 

g. Enter the amount of time in minutes, and then press the Enter soft key. 

6. To set external offset, complete the following steps: 

a. Toggle the External Offset soft key and select On. 

b. Enter a value by using the numeric keys, and then press the dB soft key. 

6. To save your settings and results, go to SAVE/LOAD > Save and then perform functions as you 

desire. See “Using save” on page 33 for more information. 

7. Press the Run Test soft key to start to run a test. 

The Auto Measure Results window appears at the end of the test. 

8. To stop running the test, press the Abort soft key. 

9. To change the view on the screen during the test, press the Display and then select the view 

option from the following choices: 

–  Screen: You can view each measurement screen as the test progresses. 

–  Results: You can view a measurement result table as the test progresses. 

–  Settings: You can view a measurement setting table as the test progresses. 

 

Setting display 

After completion of the auto measurement, the screen menu changes to Trace/Display so that you can 

view the results in different forms. 
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Procedure 

1. Toggle the Display soft key and select the display option: 

–  Result: to view the result table. 

The Display Result menu becomes activated. 

–  Settings: to view the measurement settings for the auto measurement. 

2. Toggle the Display Result soft key and select the display result option: 

–  Full: to view detailed measurement readings with the pass/fail indication. 

–  Quick: to view only the Pass/Fail results. 

3. To view the measurement results for a different carrier, press the View Carrier soft key and then 

select the carrier number to view. 

 

Performing power statistics CCDF measurements 

The Power Statistics Complementary Cumulative Distribution Function (CCDF) measurement 

characterizes the power statistics of the input signal. It provides PAR (Peak to Average power Ratio) 

versus different probabilities. 

 

Setting measure setup 

After configuring test parameters as described in the “Configuring test parameters” on page 341, you 

can continue your measurement. The measurement settings can be saved and recalled as a file. You 

can also use JDViewer, PC application software to configure a measure setup, save as a file, and load 

the file on to the instrument. 

 

Procedure 

1. Press the MEASURE SETUP hot key. 

2. Press the CCDF Length soft key to set the length of the CCDF. 

3. Enter a value between 1 and 100 by using the numeric keys. You can also use the rotary knob. 

4. Press the Enter soft key. 
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Measurement example 

Figure 171 CCDF measurement with CDMA signal analyzer 

 

 

Conducting CDMA OTA measurements 

This Over The Air (OTA) measurement has channel scanner, PN scanner, multipath profile, and Code 

Domain power screens. It is used to verify CDMA transmitter performance at any location providing 

reflective measurements and identifying signals providing from different sites. The Code Domain 

power shows not only modulation performance metric but also amplifier capacity and code utilization 

metric. The Amplifier capacity (code utilization) measurement is an estimate of the amount of power 

amplifier capacity (code utilization) that is being used expressed in percent of maximum. 

 

Channel scanner 

Setting channel/frequency 

Procedure 

To set the channels to be scanned: 

1. Press the FREQ/DIST hard key. 

2. Toggle the Unit soft key and select Channel. 

3. Press the Index soft key, and then enter an index number between one and six by turning the 

rotary knob or using the numeric keys. 

4. To select the standard channel, complete the following steps: 

a. Press the Channel Std soft key. The standard channel window appears. 

See “Appendix C – Band, frequency & channel standard” on page 588 for more information. 

b. Select the band to be measured by using the rotary knob, the arrow keys, or the Page 
Up/Page Down soft keys. 

c. Press the Select soft key or the rotary knob to confirm the selection. 

5. To set the channel number for the selected index, complete the following steps: 

a. Press the Channel Number soft key. 

b. Enter a value by using the numeric keys. You can also use the rotary knob. 
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c. Press the Enter soft key. 

The instrument displays a corresponding center frequency for the channel number. 

6. To set the integration bandwidth for the selected index, complete the following steps: 

a. Press the Integration Bandwidth soft key. 

b. Enter a value by using the numeric keys. You can also use the rotary knob. 

c. Select the unit: GHz, MHz, kHz, or Hz. 

7. To add more channels to be scanned, repeat steps 3-6. 

8. Press the ESC hard key to dismiss the channel list window and view the scanning result. 
 
To set the frequencies to be scanned: 

1. Press the FREQ/DIST hard key. 

2. Toggle the Unit soft key and select Freq. 

3. Press the Index soft key, and then enter an index number between one and six by turning the 

rotary knob or using the numeric keys. 

4. To set the center frequency for the selected index, complete the following steps: 

a. Press the Center Frequency soft key. 

b. Enter a value by using the numeric keys. You can also use the rotary knob. 

c. Select the unit: GHz, MHz, kHz, or Hz. 

5. To set the integration bandwidth for the selected index, complete the following steps: 

a. Press the Integration Bandwidth soft key. 

b. Enter a value by using the numeric keys. You can also use the rotary knob. 

c. Select the unit: GHz, MHz, kHz, or Hz. 

6. To add more channels to be scanned, repeat steps 3-5. 

7. Press the ESC hard key to dismiss the channel list window and view the scanning result. 

 

Setting measure setup 

After configuring other test parameters as described in the “Configuring test parameters” on page 341, 

you can continue your measurement. The measurement settings can be saved and recalled as a file. 

You can also use JDViewer, PC application software to configure a measure setup, save as a file, and 

load the file on to the instrument. 

 

Procedure 

1. Press the MEASURE SETUP hot key. 

2. To set the incremental step for the PN offset, complete the following steps: 

a. Press the PN Increment soft key. 

b. Enter a value by using the numeric keys. 

c. Press the Enter soft key. 

3. Optional. Go to SAVE/LOAD > Save, and then select the save option from the choices available 

for your measurement mode. See “Using save” on page 33 for more information. 
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Setting limit for OTA channel scanner 

Procedure 

1. Press the LIMIT hot key. 

2. Press the Limit Line soft key to set a threshold for the limit line and Pass/Fail indication. 

3. Enter a value, and then press the dBm unit soft key. 

4. Toggle the Limit Line soft key between On and Off to display or dismiss the limit line. 

5. Optional. You can enable alarm sound that goes off if the measurement falls outside of the limit. 
Toggle the Beep soft key between On and Off to enable or disable the beep sound. 

6. Optional. Go to SAVE/LOAD > Save, and then select Save Limit to save the limit settings. 

See “Using save” on page 33 for more information. 

 

Measurement example 

Figure 172 Channel scanner measurement with CDMA OTA signal analyzer 

 

 

PN scanner 

Each access network sector has a unique PN offset. The PN Scanner is used to identify all the active 

PNs in an area. 

 

Setting measure setup 

After configuring test parameters as described in the “Configuring test parameters” on page 341, you 

can continue your measurement. The measurement settings can be saved and recalled as a file. You 

can also use JDViewer, PC application software to configure a measure setup, save as a file, and load 

the file on to the instrument. 

 

Procedure 

1. Press the MEASURE SETUP hot key. 

2. To set the incremental step for the PN offset, complete the following steps: 
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a. Press the PN Increment soft key. 

b. Enter a value by using the numeric keys. 

c. Press the Enter soft key. 

3. Optional. Go to SAVE/LOAD > Save, and then select the save option from the choices available 

for your measurement mode. See “Using save” on page 33 for more information. 

 

Measurement example 

Figure 173 PN scanner measurement with CDMA OTA signal analyzer 

 

 

Multipath profile 

The Multipath Profile enables you to determine RF environmental conditions of testing area. It 

indicates the amount of power of the dominant pilot signal that is dispersed outside the main 

correlation peak due to multipath echoes that are expressed in dB. This value should be very small 

ideally. 

 

The multipath profile is the result of portions of the original broadcast signal arriving at the receiving 

antenna out of phase. This can be caused by the signal being reflected off objects such as buildings, 

or being refracted through the atmosphere differently from the main signal. 

 

Setting measure setup 

After configuring test parameters as described in the “Configuring test parameters” on page 341, you 

can continue your measurement. The measurement settings can be saved and recalled as a file. You 

can also use JDViewer, PC application software to configure a measure setup, save as a file, and load 

the file on to the instrument. 

 

Procedure 

1. Press the MEASURE SETUP hot key. 

2. To set the incremental step for the PN offset, complete the following steps: 

a. Press the PN Increment soft key. 
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b. Enter a value by using the numeric keys. 

c. Press the Enter soft key. 

3. Optional. Go to SAVE/LOAD > Save, and then select the save option from the choices available 

for your measurement mode. See “Using save” on page 33 for more information. 

 

Measurement example 

Figure 174 Multipath profile measurement with CDMA OTA signal analyzer 

 

 

Code domain power 

Channels with high correlation factors are determined to be active channels and are indicated as such 

on the display. Once the channels are decoded, the analyzer determines the power of each channel 

relative to the total signal power. 

 

This measurement helps to verify that each code channel is operating at its proper level and helps to 

identify problems throughout the transmitter design from the coding to the RF section. System 

imperfections, such as the non-linearity of amplifiers, will present themselves as an undesired 

distribution of power in the code domain. 

 

Setting measure setup 

After configuring test parameters as described in “Configuring test parameters” on page 341, you can 

continue your measurement. The measurement settings can be saved and recalled as a file. You can 

also use JDViewer, PC application software to configure a measure setup, save as a file, and load the 

file on to the instrument. 

 

Procedure 

1. Press the MEASURE SETUP hot key. 

2. To set the Pseudo-Noise (PN) offset, complete the following steps: 

a. Toggle the PN Offset soft key between Auto and Manual. 

b. Enter a value by using the numeric keys to set manually. 
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c. Press the Enter soft key. 

3. To set the incremental step for the PN offset, complete the following steps: 

a. Press the PN Increment soft key. 

b. Enter a value by using the numeric keys. 

c. Press the Enter soft key. 

4. To set the threshold between Auto and Manual, complete the following steps: 

a. Press the Threshold soft key. Its default setting is -27 dB. 

b. Enter a value between -50 and zero by using the numeric keys to change the value in the 
Manual mode. 

c. Press the Enter soft key. 

5. Toggle the Q-Paging soft key between On and Off to enable or disable the quick page channel 

that indicates the power of Quick Page Walsh code 80. 

6. To set the maximum amplifier power, complete the following steps: 

a. Press the Max Amplifier Power soft key. 

b. Enter a value by using the numeric keys. 

c. Press the dBm soft key. 

7. To set the pilot power, complete the following steps: 

a. Press the Pilot Power soft key. 

b. Enter a value by using the numeric keys. 

c. Press the dBm soft key. 

8. To set the threshold for pilot dominance, complete the following steps: 

a. Press the More (1/2) > Pilot Dominance > soft key. 

b. Enter a value by using the numeric keys. 

c. Press the Enter soft key. 

 

 

NOTE 

Recommended value is 10. Color of the Pilot Dominance indicator on the screen bases 
on this setting. 

9. To set the threshold for multipath power, complete the following steps: 

a. Press the More (1/2) > Multipath Power < soft key. 

b. Enter a value by using the numeric keys. 

c. Press the Enter soft key. 

 

 

NOTE 

Recommended value is one. Color of the multipath power indicator on the screen bases 
on this setting. 

10. Optional. Go to SAVE/LOAD > Save, and then select the save option from the choices available 

for your measurement mode. See “Using save” on page 33 for more information. 
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Measurement example 

Figure 175 Code domain power measurement with CDMA OTA signal analyzer 

 

 

 

NOTE 
You can use the LIMIT hot key to analyze your measurements with the user-definable 

limit and Pass/Fail indication. 

 

Setting display 

You can view .your measurement results in a different view option. 

 

Procedure 

1. Press the TRACE/DISPLAY hard key. 

2. Press the Code Order soft key, and then select the code order option from the following choices: 

–  Hadamard: To assign the number based on Walsh code order and display the measured 

code power according to the assigned number in sequence. 

–  Bit Reverse: Code number in binary bit is reversed relative to the Hadamard method. 

3. Toggle the Base Code Length soft key and select the base Walsh code number: 64 or 128. 

 

Route map 

The JD780A Series provides the Route Map function that allows you to collect data of points in an 

indoor or outdoor environment and track the received signals and coverage of RF transmitters by 

plotting data real time directly on top of a loaded floor plan or a map. 

 

Setting measure setup 

Procedure 

1. If required, connect a GPS receiver to your JD780A series for outdoor mapping. 
Indoor mapping does not necessarily need a GPS antenna. 

2. Configure test parameters as described in the “Configuring test parameters” on page 341. 
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3. To load your map file, complete the following steps: 

a. Plug in your USB drive that has a floor map or .mcf file type created in JDMapCreator. . If 

the JDMapCreator application on your computer is connected to the instrument via USB or 
LAN, you can send a map file with a single layer to the instrument directly by using the 
Send to EQP menu in JDMapCreator. 

 

NOTE 

The JDMapCreator converts and resizes any scanned floor plan or layout to fit onto your 
instrument’s display. JDMapCreator 1.2.0 or later can save a multiple-layered map, 
providing x1, x2, and x4 views, as a sizable map file so that you can zoom in and out 

after loading it. 

b. Press SAVE/LOAD hot key, and then select Load > Load Map. 

See “Using load” on page 36 for more information. 

4. Press the MEASURE SETUP hot key. 

5. Press the Plot Point soft key, and then select the plot point option from the following choices: 

–  To collect data/plot points automatically as you move around in a vehicle or outside, press 
the GPS soft key and then toggle the Screen Mode soft key between Map and Full. 

 

NOTE 
With the Map setting, you can view only the collected points that can be seen within the 

boundary of the loaded map. If a point is off the map, the instrument displays an arrow to 
indicate the direction of the current location on the map and the distance from the center 
to the location at the top of the screen. With the Full setting, you can view all the 

collected points of the route without the loaded map. 

–  To collect data/plot points manually without a GPS antenna in an indoor environment, press 
the Position soft key. 

6. Press the Plot Item soft key, and then select the measurement option: Pilot Power or Ec/Io. 

7. To set the incremental step for the PN offset, complete the following steps: 

a. Press the PN Increment soft key. 

b. Enter a value by using the numeric keys. 

c. Press the Enter soft key. 

8. Toggle the Plot soft key and select Start. 

9. Touch directly on the screen or press the ENTER hard key to collect data and plot points on the 
loaded map for the Position setting. 

 

NOTE 
For the Position setting, you can change the direction of the route with the arrow keys 

and the distance with the rotary knob. 

10. Toggle the Plot soft key and select Stop to stop plotting. 

11. Press the SAVE/LOAD hot key to save the result. 

See “Using save” on page 33 for more information. 

 

NOTE 

The instrument does not automatically save the collected data. It is recommended that 
you save the result. Otherwise, you will lose all the collected data. 

 

 

Setting limit 

You can set the thresholds for the four different color indicators for Pilot power or Ec/Io. 

 

Procedure 

1. Press the LIMIT hot key. 

2. To set the limits for pilot power if you have selected Pilot for the plot item, complete the following 
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steps: 

a. Press the Pilot Power soft key. 

b. Press the Excellent soft key to set its threshold. 

c. Enter a value, and then press the dBm soft key. You can also use the rotary knob. 

d. Press the Very Good soft key to set its threshold. 

e. Enter a value, and then press the dBm soft key. You can also use the rotary knob. 

f. Press the Good soft key to set its threshold. 

g. Enter a value, and then press the dBm soft key. You can also use the rotary knob. 

h. Press the Fair soft key to set its threshold. 

i. Enter a value, and then press the dBm soft key. You can also use the rotary knob. 

j. Press the Poor soft key to set its threshold. 

k. Enter a value, and then press the dBm soft key. You can also use the rotary knob. 

3. To set the limits for Ec/Io if you have selected as for the plot item , complete the following steps: 

a. Press the Ec/Io soft key. 

b. Press the Good soft key to set its threshold. 

c. Enter a value, and then press the Enter soft key. You can also use the rotary knob. 

d. Press the Fair soft key to set its threshold. 

e. Enter a value, and then press the Enter soft key. You can also use the rotary knob. 

f. Press the Poor soft key to set its threshold. 

g. Enter a value, and then press the Enter soft key. You can also use the rotary knob. 

4. Optional. Go to SAVE/LOAD > Save, and then select Save Limit to save the limit settings. 

See “Using save” on page 33 for more information. 

 

Measurement example 

Figure 176 Route map measurement with CDMA OTA signal analyzer 

1) Pilot Power 
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2) Pilot Ec/Io 

 

 

Controlling a map 

If you have loaded a sizable map that was created in JDMapCreator 1.2.0 or later, you can use the 

Map Control feature that enables you to zoom into the map and view a specific area of interest in detail. 

 

Procedure 

1. Press the TRACE/DISPLAY hard key. 

2. Press the Map Control soft key. This key is active only when you have loaded a sizable map. 

3. Do one of the following: 

–  To zoom into an area of interest directly, complete the following steps: 

a. Toggle the Zoom to soft key and select Area. 

The black rectangle appears on the map. 

b. Press the Zoom In and Zoom Out soft keys, as you need, to decrease and increase 

the selected area. 

c. Move the rectangle by using the four arrow keys, as you need, to place it in a specific 
area of interest. 

d. Press the center of the rotary knob to zoom into the selected area. You can also press 
the Zoom to soft key again to zoom into the selected area. 

–  To zoom into the center or zoom out from the center, complete the following steps: 

a. Toggle the Zoom to soft key and select Center. 

b. Press the Zoom In and Zoom Out soft keys, as you need, to zoom in and zoom out. 

c. Move the zoomed-in area by using the four arrow keys, as you need. 
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Using EV-DO Signal Analyzer 

This chapter provides instructions for using the EV-DO Signal Analyzer function (option 021) with the 

EV-DO OTA Analyzer function (option 041). Topics discussed in this chapter are as follows: 

 

 Introduction .............................................................................................................................. 377 

 Display overview ...................................................................................................................... 377 

 Connecting a cable .................................................................................................................. 378 

 Selecting measurement mode ................................................................................................. 380 

 Configuring test parameters .................................................................................................... 380 

 Conducting spectrum measurements ...................................................................................... 385 

 Conducting RF measurements ................................................................................................ 386 

 Conducting power vs. time measurements ............................................................................. 393 

 Conducting modulation measurements ................................................................................... 395 

 Performing auto measurements .............................................................................................. 405 

 Performing power statistics CCDF measurements ................................................................. 407 

 Conducting EV-DO OTA measurements ................................................................................. 408 
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Introduction 

The EV-DO Signal Analyzer of the JD780A series performs power and spectrum measurements as 

well as modulation analysis to test the proper transmitter performance of EV-DO systems. It performs 

conformance testing according to the following standards providing a simple Pass/Fail indication on 

each test. 

 

 3GPP2 C.S0024-B. cdma2000 High Rate Packet Data Air Interface Specification 

 3GPP2 C.S0032-B. Recommended Minimum Performance Standards for cdma2000 High 

Rate Packet Data Access Network 

 

You may alter the measurement parameters for specialized analysis. Pass/Fail testing with standard 

defined or user defined upper and lower limits and the Pass/Fail indictor help you to determine base 

station performance easily. 

 

This instrument provides the following measurement tools for EV-DO system: 

 

 Spectrum Analysis 

 RF Analysis 

- Channel Power 

- Occupied Bandwidth 

- Spectrum Emission Mask (SEM) 

- Adjacent Channel Power Ratio (ACLR) 

- Multi-ACPR 

- Spurious Emissions 

 Power vs. Time: Idle Slot and Active Slot 

 Modulation Analysis 

- Constellation 

- Code Domain Power 

- MAC Codogram 

- Received Code Strength Indicator (RCSI) 

- MAC CDP Table 

 Auto Measure 

 Power Statistics CCDF 

 Over The Air (OTA) 

- Channel Scanner 

- PN Scanner 

- Multipath Profile 

- Code Domain Power 

- Route Map 

Display overview 

Figure 177 provides descriptions for each segment of the measurement screen. 
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Figure 177 EV-DO signal analyzer measurement screen 

 

 

Connecting a cable 

Direct connection 

Procedure 

1. Connect the Spectrum Analyzer RF In port of the JD780A series and the Power amplifier output 

port of BTS. 

 

Figure 178 Direct connection 

 
JD785A/JD786A 

 
JD788A 

 

Indirect connection 

Procedure 

1. Connect the Spectrum Analyzer RF In port of the JD780A series and the monitor (test) port of 

BTS. 
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Figure 179 Indirect connection 

 
JD785A/JD786A 

 
JD788A 

 

 

CAUTION 
The maximum power for the Spectrum Analyzer RF In port is +25 dBm (0.316 W). If the 
input signal level to be measured is greater than +25 dBm, use a High Power 
Attenuator to prevent damage when you directly connect the signal to the instrument or 
connect the signal from the coupling port of a directional coupler. 

 

Over the air (OTA) 

Procedure 

1. Connect an Omni/directional RF antenna to the Spectrum Analyzer RF In port of the JD780A 

series. 

2. Connect a GPS antenna to the GPS port of the JD780A series. 

 

Figure 180 OTA connection 

 
JD785A/JD786A 

 
JD788A 

 

 

CAUTION 

If the input signal level to be measured is less than 0 dBm, set 0 dB attenuation or turn on 
the preamp to have better dynamic range for the OTA testing. 
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Selecting measurement mode 

Procedure 

1. Press the MODE hard key. 

2. Press the Signal Analyzer soft key. 

3. Press the EV-DO soft key. The Spectrum mode is set by default. 

4. Press the MEASURE hot key, and then select the measurement mode option from the following 
choices: 

–  Spectrum 

–  RF Analysis > Channel Power, Occupied BW, Spectrum Emission Mask, ACPR,  
Multi-ACPR, or Spurious Emissions 

–  Power vs Time > Power vs Time (Idle Slot) or Power vs Time (Active Slot) 

–  Modulation Analysis > Constellation > Composite 64, Composite 128, Pilot, MAC 64, MAC 
128, or Data 

–  Modulation Analysis > Code Domain Power > Pilot, MAC 64, MAC 128, or Data 

–  Modulation Analysis > MAC Codogram, RCSI, or MAC CDP Table 

–  Auto Measure 

–  Power Statistics CCDF 

–  OTA > Channel Scanner, PN Scanner, Multipath Profile, Code Domain Power, or 
Route Map 

 

Configuring test parameters 

Setting frequency 

You can set the frequency with either frequency or channel number. If a frequency to be set matches 

to the frequency corresponding to the selected channel standard, the instrument calculates its channel 

number and updates the screen with it automatically. 

 

Procedure 

To set the center frequency: 

1. Press the FREQ/DIST hard key. 

2. Toggle the Unit soft key and select Freq. 

3. Press the Center Frequency soft key. 

4. Enter a value by using the numeric keys. You can also use the rotary knob. 

5. Select the unit: GHz, MHz, kHz, or Hz. 

6. Optional. To define the amount of frequency increment for the rotary knob, complete the following 

steps: 

a. Press the Frequency Step soft key. 

b. Enter a value by using the numeric keys. You can also use the rotary knob. 

c. Press the unit: GHz, MHz, kHz, or Hz. 
 
To set the channel number: 

1. Press the FREQ/DIST hard key. 
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2. Toggle the Unit soft key and select Channel. 

3. To select the standard channel, complete the following steps: 

a. Press the Channel Std soft key. The standard channel window appears. 

See “Appendix C – Band, frequency & channel standard” on page 588 for more information. 

b. Select the band to be measured by using the rotary knob, the arrow keys, or the Page 
Up/Page Down soft keys. 

c. Press the Select soft key or the rotary knob to confirm the selection. 

4. Press the Channel Number soft key. 

5. Enter a value by using the numeric keys. You can also use the rotary knob. 

6. Press the Enter soft key. 

The instrument automatically displays the corresponding center frequency value for the selected 
channel number. 

7. Optional. To define the amount of channel increment for the rotary knob, complete the following 
steps: 

a. Press the Channel Step soft key. 

b. Enter a value by using the numeric keys. You can also use the rotary knob. 

c. Press the Enter soft key. 

 

 

NOTE 

This frequency setting is not used in the Multi-ACLR and Spurious Emissions modes. 

 

Setting amplitude 

Reference level and attenuation 

You can set the reference and attenuation levels automatically or manually to optimize the display of 

the traces measured, as you desire. 

 

Procedure 

To automatically set the reference and attenuation level: 

1. Press the AMP/SCALE hard key. 

2. Press the Auto Scale soft key. 

Each time you press this key, both of the Y-axis scale and input attenuation level change to be 
optimized with some margin. 

 
To set the reference or attenuation level manually: 

1. Press the AMP/SCALE hard key. 

2. To set the maximum reference value on the Y-axis manually, complete the following steps: 

a. Press the Reference Level soft key. 

b. Enter a value by using the numeric keys or the rotary knob with 10 dB increments. 

c. Press the unit soft key or the ENTER hard key. 

 

 

NOTE 
In the measurements such as Code Domain Power and MAC Codogram, you may 
need to select the reference option between Relative and Absolute before setting the 

reference level. 

3. To set the attenuation option, select one from the following choices: 

–  To set the input attenuator’s level automatically, select Attenuation > Auto. 
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NOTE 
It is recommended that you set the Attenuation to Auto in most situations so that the 

level of the input attenuator can be set automatically according to your input signal level. 

 

–  To set the input attenuation manually up to 55 dB to optimize S/N, complete the following 
steps: 

a. Select Attenuation > Manual. 

b. Press the Attenuation Value soft key to set the level. 

c. Enter a value between 0 and 55 in fives by using the numeric keys. 

d. Press the dB soft key or the ENTER hard key. 

–  To couple the input attenuator’s level with your reference level setting, select Attenuation > 
Couple. 

As you increase the reference setting, the attenuation level also increases acoordingly. 
 
Optional. To change the scale unit: 

1. Select More (1/2) > Units. 

2. Select the unit of the display scale: dBm, dBV, dBmV, dBµV, V, or W. 

The scale unit on the screen changes accordingly. 

 

 

NOTE 

This Units menu is available in the Spectrum and RF Analysis modes. 
 

 

Scale per division 

You can use the Scale/Div feature available for the spectrum and RF analysis. It represents the value 

of one division on the horizontal scale. The default setting is 10 dB per division and the maximum 

value can be set up to 20 dB. 

 

Procedure 

To set the scale per division: 

1. Press the AMP/SCALE hard key. 

2. Select More (1/2) > Scale/Div. 

3. Enter a value between 1 and 20 by using the numeric keys. 

4. Press the dB soft key to complete the entry. 

 

Pre-amplifier 

You can turn the internal pre-amplifier on to correct and compensate for the gain of the preamp so that 

amplitude readings show the value at the input connector. 

 

Procedure 

1. Press the AMP/SCALE hard key. 

2. Toggle the Preamp soft key and select On or Off as needed. 

 

 

NOTE 

You can turn the Preamp on when the input attenuation range is from 0 dB to 10 dB. If 
the attenuation value is manually set to greater than 10 dB, the instrument will 
automatically turn off the pre-amplifier to display low-level signal properly on the chart. 
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External offset 

You can turn the External Offset on and manually set the external offset value. An offset consists of a 

cable loss and a user offset and the measurement result shows the value reflecting both offset values. 

When the external offset value is set at 40 dB in the Spectrum mode, the measurement result 

compensates 40 dB at both the Spectrum Analyzer and Signal Analyzer modes 

 

Procedure 

To set the external offset: 

1. Press the AMP/SCALE hard key. 

2. Toggle the External Offset soft key and select On. 

3. Enter a value by using the numeric keys. 

4. Press the dB soft key to complete the entry. 

 
To turn the external offset off: 

1. Press the AMP/SCALE hard key. 

2. Toggle the External Offset soft key and select Off. 

 

Setting average 

You can set the number of measurements to be averaged for the trace presentation. A maximum of 

100 times of averaging can be set. When the averaging reaches to your setting, a new measurement 

value replaces the measurement value in sequence from the earliest. 

 

Procedure 

1. Press the BW/AVG hard key. 

2. Press the Average soft key. 

3. Enter a value between 1 and 100 as needed by using the numeric keys. 

4. Press the Enter soft key. 

 

Setting sweep mode 

The default setting is Continue to sweep continuously for most on-going measurements. If you want to 

hold the measurement or get a single sweep, you can change the sweep mode. 

 

Procedure 

To select the single sweep mode: 

1. Press the SWEEP hot key. 

2. Toggle the Sweep Mode soft key and select Single. You can also use the HOLD hot key. 

The letter HOLD in red appears and the sweeping is paused. 

3. Optional. Press the Sweep Once soft key to get a new measurement. 
 
To return to the continuous sweep mode: 

1. Toggle the Sweep Mode soft key and select Continue. You can also use the HOLD hot key. 

The letter HOLD in red disappears and the sweeping resumes. 
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Setting trigger source 

You can set the trigger source option for your measurements. Connecting an external trigger is 

necessary for accurate modulation measurements on EV-DO systems. 

Procedure 

1. Press the TRIGGER hot key. 

2. Select the trigger source option from the following choices: Internal, External, or GPS. 

 

Setting external clock 

To enhance the reliability of modulation analysis measurements the JD780A series must be 

synchronized with a base station. When an external clock is not supplied, the instrument works with its 

built-in internal high-accuracy time base and some measurement results may exhibit inaccurate values. 

Therefore, it is highly recommended that you use the same reference clock as the signal source. You 

can use the TRIGGER hot key to set the external clock. 

 

Table 17 Standards of external clock operation 

Clock Type Reference Port Switching Standard 

External Reference Internal Internal 10 MHz  Default 

 External External Ref Clock Ext Ref (SMA) Manual switching 
(Input signal level >-3 dBm) 

 GPS GPS Clock GPS (SMA) Automatic switching 
(GPS signal received) 

Trigger Internal Internal Trigger  Default 

 External External Trigger Trigger (SMA) Manual switching 

 GPS GPS GPS (SMA) Manual switching 

 

Figure 181 Connection ports for external reference clock 

 

 

Procedure 

1. Connect an external reference or a GPS antenna to the JD780A series. 

2. Press the SYSTEM hot key. 

3. Press the Freq Reference soft key, and then select the reference option: Internal, External 10 
MHz, External 13 MHz, External 15 MHz, or GPS. 
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NOTE 

When a GPS antenna is connected and locked, GPS coordinates (longitude and latitude) 
are displayed on the screen and frequency reference is automatically set to GPS in the 
System > Freq Reference. 

 

Table 18 External reference indicators 

Type Indicator Description 

Internal  (green) The green INT icon indicates that the instrument uses the built-in 

internal time base. 

External  (green) The green EXT icon indicates that an external reference is connected 

and locked and that the instrument uses the same reference clock as 
the signal source. 

External  (red) The red EXT icon indicates that an external reference is connect but not 

locked. 

GPS (green) The green GPS antenna icon indicates that a GPS antenna is 
connected and locked. 

GPS (yellow) The yellow GPS antenna icon indicates that a GPS antenna is 
connected and locking is in progress. 

GPS (grey) The grey GPS antenna icon indicates that a GPS antenna is not 
connected, failed, or unable to be locked. 

 

Conducting spectrum measurements 

If you have configured test parameters as described in the “Configuring test parameters” on page 380, 

your measurement result is displayed on the screen as like the following example, Figure 182. 

 

Figure 182 Spectrum measurement screen with EV-DO signal analyzer 

 

 

Setting trace 

You can display up to six traces on the measurement chart simultaneously. 
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Procedure 

1. Press the TRACE/DISPLAY hard key. 

2. Press the Select Trace soft key, and then select the trace number: T1, T2, T3, T4, T5, or T6. 

The legend shape of the selected trace changes from square to round to indicate that the trace is 
the active one now. 

3. Do one of the following: 
 

To Select Trace Legend 

Clear current data and display with new 
measurements 

Clear Write W 

Display the input signal’s maximum response only 
(unlimited or for a certain amount of time) 

Max Hold M 

Display the input signal’s minimum response only 
(unlimited or for a certain amount of time) 

Min Hold m 

Capture the selected trace and compare traces Capture C 

Load a saved trace More (1/2) > Load L 

Hide the selected trace Trace View > Off F 

Remove all the traces and initialize the trace 
settings 

More (1/2) > Trace 
Clear All 

 

 

 

NOTE 
For the Max Hold and Min Hold, your instrument compares newly acquired data with the 

active trace and displays larger maximum values or smaller minimum values on the 
screen. You can set it to Unlimited to hold and view maximum or minimum data or 

specify a certain amount of time up to 60 seconds by using numeric keys or the rotary 
knob. 

4. Optional. Press the More (1/2) > Trace Info soft key, and then select the trace number to view 
the trace’s parameter setting information stored at the time of the measurement or None to hide 

the information display. 

5. Optional. If you have the two traces T1 and T2, you can perform trace math. To view the power 
difference between the traces, press the T1 – T2 -> T5 or T2 – T1 -> T6 soft key. 

The result is overlaid on the screen along with the second Y-axis. 

 

Conducting RF measurements 

Channel power 

The Channel Power measurement is a common test used in the wireless industry to measure the total 

transmitted power of a radio within a defined frequency channel. It acquires a number of points 

representing the input signal in the time domain, transforms this information into the frequency domain 

using Fast Fourier Transform (FFT), and then calculates the channel power. The effective resolution 

bandwidth of the frequency domain trace is proportional to the number of points acquired for the FFT. 

 

The channel power measurement identifies the total RF power, power spectral density (PSD) and peak 

to average ratio (PAR) of the signal in the EV-DO channel bandwidth (1.23 MHz). 

 

After configuring test parameters as described in the “Configuring test parameters” on page 380, your 

measurement result is displayed on the screen as like the following example, Figure 183. 
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Figure 183 Channel power measurement with EV-DO signal analyzer 

 

 

 

NOTE 

You can use the LIMIT hot key to analyze your measurements with the user-definable 
limit and Pass/Fail indication. See “Setting limit for RF tests” on page 392 for more 
information. 

 

Occupied bandwidth 

The Occupied Bandwidth measures the spectrum shape of the carrier. It is defined as the bandwidth, 

which includes 99% of the transmitted power among total transmitted power. 

 

After configuring test parameters as described in the “Configuring test parameters” on page 380, your 

measurement result is displayed on the screen as like the following example, Figure 184. 

 

Figure 184 Occupied bandwidth measurement with EV-DO signal analyzer 
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NOTE 
You can use the LIMIT hot key to analyze your measurements with the user-definable 
limit and Pass/Fail indication. See “Setting limit for RF tests” on page 392 for more 
information. 

 

Spectrum emission mask (SEM) 

The Spectrum Emission Mask (SEM) measurement required by 3GPP2 specifications encompasses 

different power limits and different measurement bandwidths (resolution bandwidths) at various 

frequency offsets. It may be expressed as a ratio of power spectral densities between the carrier and 

the specified offset frequency band. It provides useful figures-of-merit for the spectral re-growth and 

emissions produced by components and circuit blocks, without the rigor of performing a full SEM 

measurement. 

 

The SEM measures spurious signal levels in up to five pairs of offset or region frequencies and relates 

them to the carrier power. 

 

Setting measure setup 

After configuring test parameters as described in the “Configuring test parameters” on page 380, your 

measurement result is displayed on the screen as like the following example, Figure 185. 

 

Figure 185 SEM measurement with EV-DO signal analyzer 

 

 

 

NOTE 
You can use the LIMIT hot key to analyze your measurements with the user-definable 
limit and Pass/Fail indication. See “Setting limit for RF tests” on page 392 for more 
information. 

 

ACPR 

The Adjacent Channel Power Ratio (ACPR) is defined as the ratio of the average power in the 

adjacent frequency channel (or offset) to the average power in the transmitted frequency channel. It 

may be expressed as the ratio of the integrated signal power in the adjacent channel to the integrated 

signal power in the main channel. 
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After configuring test parameters as described in the “Configuring test parameters” on page 380, your 

measurement result is displayed on the screen as like the following example, Figure 186. 

 

Figure 186 ACPR measurement with EV-DO signal analyzer 

 

 

 

NOTE 

You can use the LIMIT hot key to analyze your measurements with the user-definable 
limit and Pass/Fail indication. See “Setting limit for RF tests” on page 392 for more 
information. 

 

Multi-ACPR 

The Multi-ACPR measurement is used to perform multi-channel ACPR measurements with as many 

channels as possible. It helps you to measure ACPR in multi-channel transmitting Base Station 

environment. 

 

Setting frequency for Multi-ACPR 

You can set the frequency with either frequency or channel number. 

 

Procedure 

1. Press the MEASURE SETUP hot key. 

2. To set the frequency, do one of the following: 

–  To set the center frequency, complete the following steps: 

a. Toggle the Unit soft key and select Freq. 

b. Press the Lowest Frequency soft key to set the starting center frequency. 

c. Enter a value by using the numeric keys. You can also use the rotary knob. 

d. Select the unit: GHz, MHz, kHz, or Hz. 

e. Press the Highest Frequency soft key to set the stopping center frequency. 

f. Enter a value by using the numeric keys. You can also use the rotary knob. 

g. Select the unit: GHz, MHz, kHz, or Hz. 

–  To set the channel number, complete the following steps: 
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a. Toggle the Unit soft key and select Channel. 

b. To select the standard channel, press the Channel Std soft key and then select the 

band to be measured. 

c. Press the Lowest Channel soft key to set the starting channel. 

d. Enter a value by using the numeric keys. You can also use the rotary knob. 

e. Press the Enter soft key. 

f. Press the Highest Channel soft key to set the stopping channel. 

g. Enter a value by using the numeric keys. You can also use the rotary knob. 

h. Press the Enter soft key. 

 

After configuring the test parameters, your measurement result is displayed on the screen as like the 

following example, Figure 187. 

 

Figure 187 Multi-ACPR measurement with EV-DO signal analyzer 

 

 

 

NOTE 

You can use the LIMIT hot key to analyze your measurements with the user-definable 
limit and Pass/Fail indication. See “Setting limit for RF tests” on page 392 for more 
information. 

 

Spurious emissions 

Out-of-band emissions are unwanted emissions immediately outside the channel bandwidth resulting 

from the modulation process and non-linearity in the transmitter but excluding spurious emissions. The 

Spurious Emissions measurement is to identify and determine the power level of out-of-band spurious 

emission within the necessary channel bandwidth and modulated signal measured at the RF port of 

the Base Station. 

 

Setting measure setup 

Procedure 

1. Press the MEASURE SETUP hot key. 



JD780A Series Analyzers 

 Using EV-DO Signal Analyzer 391 

2. To set up the range table and parameters, press the Range Table soft key and then complete 

the following steps: 

a. Press the Range soft key, and then select the range number between 1 and 20 to add  

as a new or change the existing settings. 

b. Do the following as desired: 

–  Select Start Frequency, and then specify the start frequency for the selected range. 

–  Select Stop Frequency, and then specify the stop frequency for the selected range. 

–  Select Start Limit, and then specify the lower limit for Pass/Fail indication. 

–  Select Stop Limit, and then specify the upper limit for Pass/Fail indication. 

–  Select More (1/2) > Attenuation, and then specify an value in the multiple of five. 

–  Select More (1/2) > RBW, and then specify a RBW value. 

–  Select More (1/2) > VBW, and then specify a VBW value. 

c. Press the PREV hard key. 

d. Toggle the Range soft key and select On to display the selected range in the result table or 

Off to hide it from the table. 

3. Toggle the Measure Type soft key between Examine and Full to select the measurement type. 

 

NOTE 
The Examine mode displays only the selected range while the Full mode lets the 

instrument automatically changes the selected range from one another. 

4. To set the number of measurements to be averaged, complete the following steps: 

a. Press the Average soft key. 

b. Enter a value between 1 and 100. 

c. Press the Enter soft key. 

5. To move the highlighted bar in the result table to other range, complete the following steps: 

a. Press the Range soft key in the Measure Setup menu bar. 

b. Enter a value between 1 and 20. 

c. Press the Enter soft key. 

 

After configuring test parameters as described in the “Configuring test parameters” on page 380, your 

measurement result is displayed on the screen as like the following example, Figure 188. 
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Figure 188 Spurious emissions measurement with EV-DO signal analyzer 

 

 

 

NOTE 
You can use the LIMIT hot key to analyze your measurements with the user-definable 

limit and Pass/Fail indication. See “Setting limit for RF tests” on page 392 for more 
information. 

 

Setting limit for RF tests 

By default, test limits specified in the standard are set for you. You can change thresholds if you desire. 

 

Procedure 

1. Press the LIMIT hot key. 

2. Press the RF Test Limits soft key. 

3. Select the test item(s) and set the limit(s) depending on your selected measurement mode: 
 

To set the limit for Select Set 

Channel power Channel Power High Limit 
Low Limit 

Occupied bandwidth Occupied BW High Limit 

Spectrum emission mask Spectrum Emission Mask (On/Off only) 

ACPR ACPR (On/Off only) 

Multi-ACPR Multi-ACPR (On/Off only) 

Spurious emissions Spurious Emissions (On/Off only) 

4. Optional. You can enable alarm sound that goes off if the measurement falls outside of the limit. 
Toggle the Beep soft key between On and Off to enable or disable the beep sound. 

5. Optional. Go to SAVE/LOAD > Save, and then select Save Limit to save the limit settings. 

See “Using save” on page 33 for more information. 
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Conducting power vs. time measurements 

The Power vs. Time (Idle Slot and Active Slot) in EV-DO Signal Analyzer verifies that the transmitter 

output power has correct amplitude, shape, and timing for the EV-DO format. 

 

 Idle Slot: Slot with no data in traffic channel. 

 Active Slot: Slot with the loaded data in traffic channel. 

 

Forward link of 1xEV-DO is a frame structure and each frame consists of 16 slots. The frame period for 

1xEV-DO is 26.667 ms, which is also the period of one pilot channel. Each frame is divided into 16 

slots of 1.666 ms. 1xEV-DO uses CDMA modulation scheme, but unlike its previous systems the Pilot, 

MAC (Media Access Control), and Data (Traffic) Channel are not transmitted simultaneously; instead 

they are transmitted in TDM (Time Division Multiplex). 

 

Power vs. time (idle slot) 

The Power vs. Time (Idle Slot) measurement provides the idle slot that includes the Pilot and MAC 

channels with the masks in all regions. 

 

After configuring test parameters as described in the “Configuring test parameters” on page 380, your 

measurement result is displayed on the screen as like the following example, Figure 189. 

 

Figure 189 Power vs. time (idle slot) measurement with EV-DO signal analyzer 

 

 

 

NOTE 
You can use the LIMIT hot key to analyze your measurements with the user-definable 
limit and Pass/Fail indication. See “Setting limit for power vs. time tests” on page 394 for 
more information. 

 

Power vs. time (active slot) 

The Power vs. Time (Active Slot) measurement includes the Pilot, MAC, and Data channels with the 

upper and lower masks. 

 

After configuring test parameters as described in the “Configuring test parameters” on page 380, your 
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measurement result is displayed on the screen as like the following example, Figure 190. 

 

Figure 190 Power vs. time (active slot) measurement with EV-DO signal analyzer 

 

 

 

NOTE 
You can use the LIMIT hot key to analyze your measurements with the user-definable 
limit and Pass/Fail indication. See “Setting limit for power vs. time tests” on page 394 for 
more information. 

 

Setting limit for power vs. time tests 

Procedure 

1. Press the LIMIT hot key. 

2. Press the PvsT Test Limits soft key. 

3. Select the test item(s) and set the limit(s): 
 

To set the limit for Select Set 

Pilot power Pilot Power High Limit 
Low Limit 

Medium access control power MAC Power High Limit 
Low Limit 

Data power during the data period Data Power High Limit 
Low Limit 

On/off power ratio of the pilot and MAC 
powers to the data power 

On/Off Ratio Low Limit 

4. Optional. You can enable alarm sound that goes off if the measurement falls outside of the limit. 
Toggle the Beep soft key between On and Off to enable or disable the beep sound. 

5. Optional. Go to SAVE/LOAD > Save, and then select Save Limit to save the limit settings. 

See “Using save” on page 33 for more information. 
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Conducting modulation measurements 

In order to make accurate measurements of time offset and PN, you must connect an external trigger 

before making a modulation measurement. 

 

Constellation 

The Constellation is used to observe some aspects of modulation accuracy and can reveal certain 

fault mechanisms such as I/Q amplitude imbalance or quadrature imbalance. It displays constellation 

diagram by modulation types. 

 

Setting measure setup 

After configuring test parameters as described in the “Configuring test parameters” on page 380, you 

can continue your measurement. The measurement settings can be saved and recalled as a file. You 

can also use JDViewer, PC application software to configure a measure setup, save as a file, and load 

the file on to the instrument. 

 

Procedure 

1. Press the MEASURE SETUP hot key. 

2. To set the Pseudo-Noise (PN) offset, complete the following steps: 

a. Toggle the PN Offset soft key between Auto and Manual. 

b. Enter a value by using the numeric keys to set manually. 

c. Press the Enter soft key. 

3. To set the incremental step for the PN offset, complete the following steps: 

a. Press the PN Increment soft key. 

b. Enter a value by using the numeric keys. 

c. Press the Enter soft key. 

4. Press the Detect Mode soft key, and then select the detection mode option: Auto, QPSK, 8PSK, 
16 QAM, or 64 QAM. 

5. Optional. Go to SAVE/LOAD > Save, and then select the save option from the choices available 

for your measurement mode. See “Using save” on page 33 for more information. 

 

 

NOTE 
You can use the LIMIT hot key to analyze your measurements with the user-definable 
limit and Pass/Fail indication. See “Setting limit for modulation tests” on page 404 for 
more information. The Max Inactive is not used in the Constellation mode. 
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Measurement example 

Figure 191 Constellation measurement with EV-DO signal analyzer 

1) Composite 64 

 

2) Composite 128 
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3) Pilot 

 

4) MAC 64 

 

5) MAC 128 
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6) Data 

 

 

Code domain power 

The Code Domain Power (CDP) measures the distribution of power across the set of code channels, 

normalized to the total EV-DO power. It helps to verify that each code channel is operating at its proper 

level and to identify problems throughout the transmitter design from coding to the RF section. System 

imperfections such as amplifier non-linearity will present themselves as an undesired distribution of 

power in the code domain. 

 

Setting measure setup 

After configuring test parameters as described in the “Configuring test parameters” on page 380, you 

can continue your measurement. The measurement settings can be saved and recalled as a file. You 

can also use JDViewer, PC application software to configure a measure setup, save as a file, and load 

the file on to the instrument. 

 

Procedure 

1. Press the MEASURE SETUP hot key. 

2. To set the Pseudo-Noise (PN) offset, complete the following steps: 

a. Toggle the PN Offset soft key between Auto and Manual. 

b. Enter a value by using the numeric keys to set manually. 

c. Press the Enter soft key. 

3. To set the incremental step for the PN offset, complete the following steps: 

a. Press the PN Increment soft key. 

b. Enter a value by using the numeric keys. 

c. Press the Enter soft key. 

4. To set the threshold between Auto and Manual, complete the following steps: 

a. Press the Threshold soft key. Its default setting is -27 dB. 

b. Enter a value between -50 and zero by using the numeric keys to change the value in the 
Manual mode. 

c. Press the Enter soft key. 
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5. Press the Detect Mode soft key, and then select the detection mode option: Auto, QPSK, 8PSK, 
16 QAM, or 64 QAM. 

6. Optional. Go to SAVE/LOAD > Save, and then select the save option from the choices available 

for your measurement mode. See “Using save” on page 33 for more information. 

 

 

NOTE 

You can use the LIMIT hot key to analyze your measurements with the user-definable 
limit and Pass/Fail indication for the Max Inactive. See “Setting limit for modulation tests” 
on page 404 for more information. 

 

Measurement example 

Figure 192 Code domain power measurement with EV-DO signal analyzer 

1) Pilot 

 

2) MAC 64 
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3) MAC 128 

 

4) Data 

 

 

MAC Codogram 

The MAC Codogram displays the power variation for every code over time, presenting a clear view of 

the traffic load per channels at any given time. The MAC Codogram measurements can be saved into 

an external USB memory so that a post-analysis can be done with the application software JDViewer. 

 

Setting measure setup 

After configuring test parameters as described in the “Configuring test parameters” on page 380, you 

can continue your measurement. The measurement settings can be saved and recalled as a file. You 

can also use JDViewer, PC application software to configure a measure setup, save as a file, and load 

the file on to the instrument. 
 

Procedure 

1. Press the MEASURE SETUP hot key. 

2. To set the Pseudo-Noise (PN) offset, complete the following steps: 
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a. Toggle the PN Offset soft key between Auto and Manual. 

b. Enter a value by using the numeric keys to set manually. 

c. Press the Enter soft key. 

3. To set the incremental step for the PN offset, complete the following steps: 

a. Press the PN Increment soft key. 

b. Enter a value by using the numeric keys. 

c. Press the Enter soft key. 

4. To set the threshold between Auto and Manual, complete the following steps: 

a. Press the Threshold soft key. Its default setting is -27 dB. 

b. Enter a value between -50 and zero by using the numeric keys to change the value in the 
Manual mode. 

c. Press the Enter soft key. 

5. Toggle the MAC soft key and select the MAC Walsh code option: 64 or 128. 

6. To set the time interval, complete the following steps: 

a. Press the Time Interval soft key. 

b. Enter a value by using the numeric keys. 

c. Press the Enter soft key. 

7. To place the time cursor to analyze your measurements, complete the following steps: 

a. Toggle the Time Cursor soft key between On and Off to enable or disable the time cursor. 

b. Enter a value by using the numeric keys. 

c. Press the Enter soft key. 
 

 

NOTE 

When the time cursor is enabled, the measurement is put on hold and information about 
the time cursor is displayed. 

8. Optional. Go to SAVE/LOAD > Save, and then select the save option from the choices available 

for your measurement mode. See “Using save” on page 33 for more information. 

 

Measurement example 

Figure 193 MAC Codogram in full view with EV-DO signal analyzer 
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RCSI 

The Received Code Strength Indicator (RCSI) is used to track the power variation over time of EV-DO 

channels: Pilot, MAC, Data, and Slot. The RCSI measurements can be saved into an external USB 

memory so that a post-analysis can be done with the application software JDViewer. 

 

Setting measure setup 

After configuring test parameters as described in the “Configuring test parameters” on page 380, you 

can continue your measurement. The measurement settings can be saved and recalled as a file. You 

can also use JDViewer, PC application software to configure a measure setup, save as a file, and load 

the file on to the instrument. 

 

Procedure 

1. Press the MEASURE SETUP hot key. 

2. To set the Pseudo-Noise (PN) offset, complete the following steps: 

a. Toggle the PN Offset soft key between Auto and Manual. 

b. Enter a value by using the numeric keys to set manually. 

c. Press the Enter soft key. 

3. To set the incremental step for the PN offset, complete the following steps: 

a. Press the PN Increment soft key. 

b. Enter a value by using the numeric keys. 

c. Press the Enter soft key. 

4. To set the threshold between Auto and Manual, complete the following steps: 

a. Press the Threshold soft key. Its default setting is -27 dB. 

b. Enter a value between -50 and zero by using the numeric keys to change the value in the 
Manual mode. 

c. Press the Enter soft key. 

5. Toggle the MAC soft key and select the MAC Walsh code option: 64 or 128. 

6. Press the Alarm Code soft key, and then select the alarm code option: None, Pilot, MAC, Data, 
or Slot. 

7. To set the alarm mask, complete the following steps: 

a. Press the Set Mask soft key. 

b. Enter a value by using the numeric keys. 

c. Press the [dB|dBm] soft key. 

8. Optional. Go to SAVE/LOAD > Save, and then select the save option from the choices available 

for your measurement mode. See “Using save” on page 33 for more information. 
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Measurement example 

Figure 194 RCSI measurement with EV-DO signal analyzer 

 

 

MAC CDP Table 

The MAC CDP Table is used for the user to look at a numeric and textual description of all the active 

control channels in the signal. 

 

Setting measure setup 

After configuring test parameters as described in the “Configuring test parameters” on page 380, you 

can continue your measurement. The measurement settings can be saved and recalled as a file. You 

can also use JDViewer, PC application software to configure a measure setup, save as a file, and load 

the file on to the instrument. 

 

Procedure 

1. Press the MEASURE SETUP hot key. 

2. To set the Pseudo-Noise (PN) offset, complete the following steps: 

a. Toggle the PN Offset soft key between Auto and Manual. 

b. Enter a value by using the numeric keys to set manually. 

c. Press the Enter soft key. 

3. To set the incremental step for the PN offset, complete the following steps: 

a. Press the PN Increment soft key. 

b. Enter a value by using the numeric keys. 

c. Press the Enter soft key. 

4. To set the threshold between Auto and Manual, complete the following steps: 

a. Press the Threshold soft key. Its default setting is -27 dB. 

b. Enter a value between -50 and zero by using the numeric keys to change the value in the 
Manual mode. 

c. Press the Enter soft key. 

5. Toggle the MAC soft key and select the MAC Walsh code option: 64 or 128. 
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Measurement example 

Figure 195 MAC CDP Table measurement with EV-DO signal analyzer 

 

 

Setting display 

If the MAC CDP table spans over to the next page(s), you can change pages up and down to 

view .your measurement results. 

 

Procedure 

1. Press the TRACE/DISPLAY hard key. 

2. Select Page Up or Page Down as needed to scroll the screen up and down. 

 

Setting limit for modulation tests 

Procedure 

1. Press the LIMIT hot key. 

2. Press the Modulation Test Limits soft key. 

3. Select the test item(s) and set the limit(s) depending on your selected measurement mode: 
 

To set the limit for Select Set 

Frequency error Frequency Error High Limit 
Low Limit 

Time offset Time Offset High Limit 
Low Limit 

Carrier feed through Carrier Feed Through High Limit 

Highest level among inactive channels Max Inactive High Limit 

Waveform quality (Rho) for pilot Pilot Rho Low Limit 

Waveform quality (Rho) for MAC MAC Rho Low Limit 

Waveform quality (Rho) for data Data Rho Low Limit 
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4. Optional. You can enable alarm sound that goes off if the measurement falls outside of the limit. 
Toggle the Beep soft key between On and Off to enable or disable the beep sound. 

5. Optional. Go to SAVE/LOAD > Save, and then select Save Limit to save the limit settings. 

See “Using save” on page 33 for more information. 

 

 

NOTE 

The Time Offset compares the PN offset timing with the overall system time and the 
instrument checks the start of PN offset in comparison to either the GPS signal or the 
even second clock signal. 

 

 

NOTE 

The Carrier Feed Through is a result of the RF carrier signal feeding through the I/Q 
modulator and riding on the output circuitry without being modulated. 

 

Performing auto measurements 

The Auto Measure function of the JD780A series allows a complete signal profiling covering RF 

characterization and modulation quality parameters of up to 10 different carriers, particularly useful on 

an overlay architecture where base stations are transmitting in different frequencies. 

 

The Auto Measure can be easily executed either by selecting a menu in the instrument or by running a 

programmed scenario in the PC-based application so that the instrument automatically configure and 

perform tests on every aspect of all the carriers. 

 

Setting limit for auto measure 

You can set test limits for test item(s) in the auto measurement. 

Procedure 

1. Press the LIMIT hot key. 

2. Press the RF Test Limits soft key, and then enable test limits as desired. 

3. Press the PvsT Test Limits soft key, and then enable test limits as desired. 

4. Press the Modulation Test Limits soft key, and then enable test limits as desired. 

5. Optional. You can enable alarm sound that goes off if the measurement falls outside of the limit. 
Toggle the Beep soft key between On and Off to enable or disable the beep sound. 

6. Optional. Go to SAVE/LOAD > Save, and then select Save Limit to save the limit settings. 

See “Using save” on page 33 for more information. 

 

Setting measure setup 

After configuring test parameters as described in the “Configuring test parameters” on page 380, you 

can continue your measurement. The measurement settings can be saved and recalled as a file. You 

can also use JDViewer, PC application software to configure a measure setup, save as a file, and load 

the file on to the instrument. 

 

Procedure 

1. Press the MEASURE SETUP hot key. 

2. Toggle the Configuration soft key and select the configuration option: 
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–  Current: to let the instrumnet use current frequency (single carrier) and determine pass or 

fail based on the instrument’s limit settings in Auto Measure. 

–  Scenario: to run a test with a programmed scenario in JDViewer. 

The Scenario menu becomes activated. 

3. To load a scenario, press the Scenario soft key, and then select a scenario file to load. 

4. Toggle the Test Time soft key and select the test time option: 

–  Now: to let the instrument run a test only once. 

–  Schedule: to let the instrument repeat tests as defined in the Set Timing. 

The Set Timing menu becomes activated. 

5. To define a schedule for an auto measurement, complete the following steps: 

a. Press the Set Timing soft key. 

b. Press the Start Time (HH:MM) soft key. 

c. Enter the time in the HH:MM format, and then press the Enter soft key. 

d. Press the Stop Time (HH:MM) soft key. 

e. Enter the time in the HH:MM format, and then press the Enter soft key. 

f. Press the Time Interval soft key. 

g. Enter the amount of time in minutes, and then press the Enter soft key. 

6. Press the Settings soft key, and then set the following: 

a. Toggle the MAC soft key and select the MAC Walsh code option: 64 or 128. 

b. Toggle the PvsT soft key and select the slot option: Idle or Active. 

c. Toggle the External Offset soft key and select On. 

d. Enter a value by using the numeric keys, and then press the dB soft key. 

7. To save your settings and results, go to SAVE/LOAD > Save and then perform functions as you 

desire. See “Using save” on page 33 for more information. 

8. Press the Run Test soft key to start to run a test. 

The Auto Measure Results window appears at the end of the test. 

9. To stop running the test, press the Abort soft key. 

10. To change the view on the screen during the test, press the Display and then select the view 

option from the following choices: 

–  Screen: You can view each measurement screen as the test progresses. 

–  Results: You can view a measurement result table as the test progresses. 

–  Settings: You can view a measurement setting table as the test progresses. 

 

Setting display 

After completion of the auto measurement, the screen menu changes to Trace/Display so that you can 

view the results in different forms. 

 

Procedure 

1. Toggle the Display soft key and select the display option: 

–  Result: to view the result table. 

The Display Result menu becomes activated. 

–  Settings: to view the measurement settings for the auto measurement. 
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2. Toggle the Display Result soft key and select the display result option: 

–  Full: to view detailed measurement readings with the pass/fail indication. 

–  Quick: to view only the Pass/Fail results. 

3. To view the measurement results for a different carrier, press the View Carrier soft key and then 

select the carrier number to view. 

 

Performing power statistics CCDF measurements 

The Power Statistics Complementary Cumulative Distribution Function (CCDF) measurement 

characterizes the power statistics of the input signal. It provides PAR (Peak to Average power Ratio) 

versus different probabilities. 

 

Setting measure setup 

After configuring test parameters as described in the “Configuring test parameters” on page 380, you 

can continue your measurement. The measurement settings can be saved and recalled as a file. You 

can also use JDViewer, PC application software to configure a measure setup, save as a file, and load 

the file on to the instrument. 

 

Procedure 

1. Press the MEASURE SETUP hot key. 

2. Press the CCDF Length soft key to set the length of the CCDF. 

3. Enter a value between 1 and 100 by using the numeric keys. You can also use the rotary knob. 

4. Press the Enter soft key. 

 

Measurement example 

Figure 196 CCDF measurement with EV-DO signal analyzer 
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Conducting EV-DO OTA measurements 

This Over The Air (OTA) measurement has channel scanner, PN scanner, multipath profile, and Code 

Domain power screens. It is used to verify EV-DO transmitter performance at any location providing 

reflective measurements and identifying signals providing from different sites. The Code Domain 

power shows not only modulation performance metric but also amplifier capacity and code utilization 

metric. The Amplifier capacity (code utilization) measurement is an estimate of the amount of power 

amplifier capacity (code utilization) that is being used expressed in percent of maximum. 

 

Channel scanner 

Setting channel/frequency 

Procedure 

To set the channels to be scanned: 

1. Press the FREQ/DIST hard key. 

2. Toggle the Unit soft key and select Channel. 

3. Press the Index soft key, and then enter an index number between one and six by turning the 

rotary knob or using the numeric keys. 

4. To select the standard channel, complete the following steps: 

a. Press the Channel Std soft key. The standard channel window appears. 

See “Appendix C – Band, frequency & channel standard” on page 588 for more information. 

b. Select the band to be measured by using the rotary knob, the arrow keys, or the Page 
Up/Page Down soft keys. 

c. Press the Select soft key or the rotary knob to confirm the selection. 

5. To set the channel number for the selected index, complete the following steps: 

a. Press the Channel Number soft key. 

b. Enter a value by using the numeric keys. You can also use the rotary knob. 

c. Press the Enter soft key. 

The instrument displays a corresponding center frequency for the channel number. 

6. To set the integration bandwidth for the selected index, complete the following steps: 

a. Press the Integration Bandwidth soft key. 

b. Enter a value by using the numeric keys. You can also use the rotary knob. 

c. Select the unit: GHz, MHz, kHz, or Hz. 

7. To add more channels to be scanned, repeat steps 3-6. 

8. Press the ESC hard key to dismiss the channel list window and view the scanning result. 
 
To set the frequencies to be scanned: 

1. Press the FREQ/DIST hard key. 

2. Toggle the Unit soft key and select Freq. 

3. Press the Index soft key, and then enter an index number between one and six by turning the 

rotary knob or using the numeric keys. 

4. To set the center frequency for the selected index, complete the following steps: 

a. Press the Center Frequency soft key. 

b. Enter a value by using the numeric keys. You can also use the rotary knob. 

c. Select the unit: GHz, MHz, kHz, or Hz. 
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5. To set the integration bandwidth for the selected index, complete the following steps: 

a. Press the Integration Bandwidth soft key. 

b. Enter a value by using the numeric keys. You can also use the rotary knob. 

c. Select the unit: GHz, MHz, kHz, or Hz. 

6. To add more channels to be scanned, repeat steps 3-5. 

7. Press the ESC hard key to dismiss the channel list window and view the scanning result. 

 

Setting measure setup 

After configuring other test parameters as described in the “Configuring test parameters” on page 380, 

you can continue your measurement. The measurement settings can be saved and recalled as a file. 

You can also use JDViewer, PC application software to configure a measure setup, save as a file, and 

load the file on to the instrument. 

 

Procedure 

1. Press the MEASURE SETUP hot key. 

2. To set the incremental step for the PN offset, complete the following steps: 

a. Press the PN Increment soft key. 

b. Enter a value by using the numeric keys. 

c. Press the Enter soft key. 

3. Optional. Go to SAVE/LOAD > Save, and then select the save option from the choices available 

for your measurement mode. See “Using save” on page 33 for more information. 

 

Setting limit for OTA channel scanner 

Procedure 

1. Press the LIMIT hot key. 

2. Press the Limit Line soft key to set a threshold for the limit line and Pass/Fail indication. 

3. Enter a value, and then press the dBm unit soft key. 

4. Toggle the Limit Line soft key between On and Off to display or dismiss the limit line. 

5. Optional. You can enable alarm sound that goes off if the measurement falls outside of the limit. 
Toggle the Beep soft key between On and Off to enable or disable the beep sound. 

6. Optional. Go to SAVE/LOAD > Save, and then select Save Limit to save the limit settings. 

See “Using save” on page 33 for more information. 
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Measurement example 

Figure 197 Channel scanner measurement with EV-DO OTA signal analyzer 

 

 

PN scanner 

Each access network sector has a unique PN offset. The PN Scanner is used to identify all the active 

PNs in an area. 

 

Setting measure setup 

After configuring test parameters as described in the “Configuring test parameters” on page 380, you 

can continue your measurement. The measurement settings can be saved and recalled as a file. You 

can also use JDViewer, PC application software to configure a measure setup, save as a file, and load 

the file on to the instrument. 

 

Procedure 

1. Press the MEASURE SETUP hot key. 

2. To set the incremental step for the PN offset, complete the following steps: 

a. Press the PN Increment soft key. 

b. Enter a value by using the numeric keys. 

c. Press the Enter soft key. 

3. Optional. Go to SAVE/LOAD > Save, and then select the save option from the choices available 

for your measurement mode. See “Using save” on page 33 for more information. 
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Measurement example 

Figure 198 PN scanner measurement with EV-DO OTA signal analyzer 

 

 

Multipath profile 

The Multipath Profile enables you to determine RF environmental conditions of testing area. It 

indicates the amount of power of the dominant pilot signal that is dispersed outside the main 

correlation peak due to multipath echoes that are expressed in dB. This value should be very small 

ideally. 

 

The multipath profile is the result of portions of the original broadcast signal arriving at the receiving 

antenna out of phase. This can be caused by the signal being reflected off objects such as buildings, 

or being refracted through the atmosphere differently from the main signal. 

 

Setting measure setup 

After configuring test parameters as described in the “Configuring test parameters” on page 380, you 

can continue your measurement. The measurement settings can be saved and recalled as a file. You 

can also use JDViewer, PC application software to configure a measure setup, save as a file, and load 

the file on to the instrument. 

 

Procedure 

1. Press the MEASURE SETUP hot key. 

2. To set the incremental step for the PN offset, complete the following steps: 

a. Press the PN Increment soft key. 

b. Enter a value by using the numeric keys. 

c. Press the Enter soft key. 

3. Optional. Go to SAVE/LOAD > Save, and then select the save option from the choices available 

for your measurement mode. See “Using save” on page 33 for more information. 
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Measurement example 

Figure 199 Multipath profile measurement with EV-DO OTA signal analyzer 

 

 

Code domain power 

Channels with high correlation factors are determined to be active channels and are indicated as such 

on the display. Once the channels are decoded, the analyzer determines the power of each channel 

relative to the total signal power. 

 

This measurement helps to verify that each code channel is operating at its proper level and helps to 

identify problems throughout the transmitter design from the coding to the RF section. System 

imperfections, such as the non-linearity of amplifiers, will present themselves as an undesired 

distribution of power in the code domain. 

 

Setting measure setup 

After configuring test parameters as described in “Configuring test parameters” on page 380, you can 

continue your measurement. The measurement settings can be saved and recalled as a file. You can 

also use JDViewer, PC application software to configure a measure setup, save as a file, and load the 

file on to the instrument. 

 

Procedure 

1. Press the MEASURE SETUP hot key. 

2. To set the Pseudo-Noise (PN) offset, complete the following steps: 

a. Toggle the PN Offset soft key between Auto and Manual. 

b. Enter a value by using the numeric keys to set manually. 

c. Press the Enter soft key. 

3. To set the incremental step for the PN offset, complete the following steps: 

a. Press the PN Increment soft key. 

b. Enter a value by using the numeric keys. 

c. Press the Enter soft key. 
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4. To set the threshold between Auto and Manual, complete the following steps: 

a. Press the Threshold soft key. Its default setting is -27 dB. 

b. Enter a value between -50 and zero by using the numeric keys to change the value in the 
Manual mode. 

c. Press the Enter soft key. 

5. Toggle the MAC soft key and select the MAC Walsh code option: 64 or 128. 

6. Press the Detect Mode soft key, and then select the detection mode option: Auto, QPSK, 8PSK, 
16 QAM, or 64 QAM. 

7. To set the threshold for pilot dominance, complete the following steps: 

a. Press the Pilot Dominance > soft key. 

b. Enter a value by using the numeric keys. 

c. Press the Enter soft key. 
 

 

NOTE 

Recommended value is 10. Color of the Pilot Dominance indicator on the screen bases 
on this setting. 

8. To set the threshold for multipath power, complete the following steps: 

a. Press the Multipath Power < soft key. 

b. Enter a value by using the numeric keys. 

c. Press the Enter soft key. 
 

 

NOTE 

Recommended value is one. Color of the multipath power indicator on the screen bases 
on this setting. 

9. Optional. Go to SAVE/LOAD > Save, and then select the save option from the choices available 

for your measurement mode. See “Using save” on page 33 for more information. 

 

Measurement example 

Figure 200 Code domain power measurement with EV-DO OTA signal analyzer 
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NOTE 
You can use the LIMIT hot key to analyze your measurements with the user-definable 
limit and Pass/Fail indication. 

 

Route map 

The JD780A Series provides the Route Map function that allows you to collect data of points in an 

indoor or outdoor environment and track the received signals and coverage of RF transmitters by 

plotting data real time directly on top of a loaded floor plan or a map. 

 

Setting measure setup 

Procedure 

1. If required, connect a GPS receiver to your JD780A series for outdoor mapping. 
Indoor mapping does not necessarily need a GPS antenna. 

2. Configure test parameters as described in the “Configuring test parameters” on page 380. 

3. To load your map file, complete the following steps: 

a. Plug in your USB drive that has a floor map or .mcf file type created in JDMapCreator. If 

the JDMapCreator application on your computer is connected to the instrument via USB or 
LAN, you can send a map file with a single layer to the instrument directly by using the 
Send to EQP menu in JDMapCreator. 

 

 

NOTE 

The JDMapCreator converts and resizes any scanned floor plan or layout to fit onto your 
instrument’s display. JDMapCreator 1.2.0 or later can save a multiple-layered map, 
providing x1, x2, and x4 views, as a sizable map file so that you can zoom in and out 

after loading it. 

b. Press SAVE/LOAD hot key, and then select Load > Load Map. 

See “Using load” on page 36 for more information. 

4. Press the MEASURE SETUP hot key. 

5. Press the Plot Point soft key, and then select the plot point option from the following choices: 

–  To collect data/plot points automatically as you move around in a vehicle or outside, press 
the GPS soft key and then toggle the Screen Mode soft key between Map and Full. 

 

 

NOTE 
With the Map setting, you can view only the collected points that can be seen within the 

boundary of the loaded map. If a point is off the map, the instrument displays an arrow to 
indicate the direction of the current location on the map and the distance from the center 
to the location at the top of the screen. 
 
With the Full setting, you can view all the collected points of the route without the loaded 

map. 

–  To collect data/plot points manually without a GPS antenna in an indoor environment, press 
the Position soft key. 

6. Press the Plot Item soft key, and then select the measurement option: Pilot Power or Ec/Io. 

7. To set the incremental step for the PN offset, complete the following steps: 

a. Press the PN Increment soft key. 

b. Enter a value by using the numeric keys. 

c. Press the Enter soft key. 

8. Toggle the Plot soft key and select Start. 

9. Touch directly on the screen or press the ENTER hard key to collect data and plot points on the 
loaded map for the Position setting. 
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NOTE 
For the Position setting, you can change the direction of the route with the arrow keys 

and the distance with the rotary knob. 

10. Toggle the Plot soft key and select Stop to stop plotting. 

11. Press the SAVE/LOAD hot key to save the result. 
See “Using save” on page 33 for more information. 

 

 

NOTE 

The instrument does not automatically save the collected data. It is recommended that 
you save the result. Otherwise, you will lose all the collected data. 

 

 

Setting limit 

You can set the thresholds for the four different color indicators for Pilot power or Ec/Io. 

 

Procedure 

1. Press the LIMIT hot key. 

2. To set the limits for pilot power if you have selected Pilot for the plot item, complete the following 
steps: 

a. Press the Pilot Power soft key. 

b. Press the Excellent soft key to set its threshold. 

c. Enter a value, and then press the dBm soft key. You can also use the rotary knob. 

d. Press the Very Good soft key to set its threshold. 

e. Enter a value, and then press the dBm soft key. You can also use the rotary knob. 

f. Press the Good soft key to set its threshold. 

g. Enter a value, and then press the dBm soft key. You can also use the rotary knob. 

h. Press the Fair soft key to set its threshold. 

i. Enter a value, and then press the dBm soft key. You can also use the rotary knob. 

j. Press the Poor soft key to set its threshold. 

k. Enter a value, and then press the dBm soft key. You can also use the rotary knob. 

3. To set the limits for Ec/Io if you have selected as for the plot item , complete the following steps: 

a. Press the Ec/Io soft key. 

b. Press the Good soft key to set its threshold. 

c. Enter a value, and then press the Enter soft key. You can also use the rotary knob. 

d. Press the Fair soft key to set its threshold. 

e. Enter a value, and then press the Enter soft key. You can also use the rotary knob. 

f. Press the Poor soft key to set its threshold. 

g. Enter a value, and then press the Enter soft key. You can also use the rotary knob. 

4. Optional. Go to SAVE/LOAD > Save, and then select Save Limit to save the limit settings. 

See “Using save” on page 33 for more information. 
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Measurement example 

Figure 201 Route map measurement with EV-DO OTA signal analyzer 

1) Pilot Power 

 

2) Pilot Ec/Io 

 

 

Controlling a map 

If you have loaded a sizable map that was created in JDMapCreator 1.2.0 or later, you can use the 

Map Control feature that enables you to zoom into the map and view a specific area of interest in detail. 

 

Procedure 

1. Press the TRACE/DISPLAY hard key. 

2. Press the Map Control soft key. This key is active only when you have loaded a sizable map. 

3. Do one of the following: 

–  To zoom into an area of interest directly, complete the following steps: 

a. Toggle the Zoom to soft key and select Area. 

The black rectangle appears on the map. 
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b. Press the Zoom In and Zoom Out soft keys, as you need, to decrease and increase 

the selected area. 

c. Move the rectangle by using the four arrow keys, as you need, to place it in a specific 
area of interest. 

d. Press the center of the rotary knob to zoom into the selected area. You can also press 
the Zoom to soft key again to zoom into the selected area. 

–  To zoom into the center or zoom out from the center, complete the following steps: 

a. Toggle the Zoom to soft key and select Center. 

b. Press the Zoom In and Zoom Out soft keys, as you need, to zoom in and zoom out. 

c. Move the zoomed-in area by using the four arrow keys, as you need. 

 

 



 

 

   13 

 

Using TD-SCDMA Signal Analyzer 

This chapter provides instructions for using the TD-SCDMA Signal Analyzer function (option 025) with 

the TD-SCDMA OTA Analyzer function (option 045). Topics discussed in this chapter are as follows: 

 

 Introduction .............................................................................................................................. 419 

 Display overview ...................................................................................................................... 420 

 Connecting a cable .................................................................................................................. 420 

 Selecting measurement mode ................................................................................................. 422 

 Configuring test parameters .................................................................................................... 422 

 Conducting spectrum measurements ...................................................................................... 427 

 Conducting RF measurements ................................................................................................ 428 

 Conducting power vs. time measurements ............................................................................. 436 

 Conducting modulation measurements ................................................................................... 442 

 Performing auto measurements .............................................................................................. 449 

 Conducting TD-SCDMA OTA measurements .......................................................................... 451 
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Introduction 

The Time Division-Synchronous Code Division Multiple Access, also known as TD-SCDMA, is a 3G 

mobile telecommunications standard that is pursued by the Chinese Academy of Telecommunications 

Technology (CATT) in the People's Republic of China. The TD-SCDMA uses the TDD scheme while 

the WCDMA uses the FDD. 

 

This TD-SCDMA Signal Analyzer can be used for testing of TD-SCDMA systems, made according to 

the following standard documentation. 

 

 3GPP TS 25.105 Base Station radio transmission and reception (TDD) 

 3GPP TS 25.142 Base Station conformance testing (TDD) 

 3GPP TS 25.222 Multiplexing and channel coding (TDD) 

 3GPP TS 25.223 Spreading and modulation (TDD) 

 

The instrument automatically makes standard defined measurements using the measurement 

methods and limits as defined in the standard. The detailed results allow you to analyze TD-

SCDMA/HSDPA system performance. You may alter the measurement parameters for specialized 

analysis. Pass/Fail testing with standard defined or user defined upper and lower limits and the 

Pass/Fail indictor help you to determine base station performance easily. 

 

This instrument provides the following measurement tools for TD-SCDMA system: 

 

 Spectrum Analysis 

 RF Analysis 

- Channel Power 

- Occupied Bandwidth 

- Spectrum Emission Mask 

- Adjacent Channel Leakage power Ratio (ACLR) 

- Multi-ACLR 

- Spurious Emissions 

 Power vs. Time: 

- Power vs. Time (Slot) 

- Power vs. Time (Frame) 

- Power vs. Time (Mask) 

- Timogram 

 Modulation Analysis 

- Constellation 

- Midamble Power 

- Code Power 

- Code Error 

 Auto Measure 

 Over The Air (OTA) 

- Sync-DL ID Scanner 

- Sync-DL ID vs. Tau 

- Sync-DL ID Multipath 

- Sync-DL ID Analyzer 

- Route Map 
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Display overview 

Figure 202 provides descriptions for each segment of the measurement screen. 

 

Figure 202 TD-SCDMA signal analyzer measurement screen 

 

 

Connecting a cable 

Direct connection 

Procedure 

1. Connect the Spectrum Analyzer RF In port of the JD780A series and the Power amplifier output 

port of BTS. 

 

Figure 203 Direct connection 

 
JD785A/JD786A 

 
JD788A 
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Indirect connection 

Procedure 

1. Connect the Spectrum Analyzer RF In port of the JD780A series and the monitor (test) port of 

BTS. 

 

Figure 204 Indirect connection 

 
JD785A/JD786A 

 
JD788A 

 

 

CAUTION 
The maximum power for the Spectrum Analyzer RF In port is +25 dBm (0.316 W). If the 
input signal level to be measured is greater than +25 dBm, use a High Power 
Attenuator to prevent damage when you directly connect the signal to the instrument or 
connect the signal from the coupling port of a directional coupler. 

 

Over the air (OTA) 

Procedure 

1. Connect an Omni/directional RF antenna to the Spectrum Analyzer RF In port of the JD780A 

series. 

2. Connect a GPS antenna to the GPS port of the JD780A series. 

 

Figure 205 OTA connection 

 
JD785A/JD786A 

 
JD788A 
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CAUTION 

If the input signal level to be measured is less than 0 dBm, set 0 dB attenuation or turn on 
the preamp to have better dynamic range for the OTA testing. 

 

Selecting measurement mode 

Procedure 

1. Press the MODE hard key. 

2. Press the Signal Analyzer soft key. 

3. Press the More (1/2) > TD-SCDMA soft key. The Spectrum mode is set by default. 

4. Press the MEASURE hot key, and then select the measurement mode option from the following 

choices: 

–  Spectrum 

–  RF Analysis > Channel Power, Occupied BW, Spectrum Emission Mask, ACLR,  
Multi-ACLR, or Spurious Emissions 

–  Power vs Time > Power vs Time (Slot), Power vs Time (Frame), 
Power vs Time (Frame), or Timogram 

–  Modulation Analysis > Constellation, Midamble Power, Code Power, or Code Error 

–  Auto Measure 

–  OTA > Sync-DL ID Scanner, Sync-DL ID vs Tau, Sync-DL ID Multipath,  
Sync-DL ID Analyzer, or Route Map 

 

Configuring test parameters 

Setting frequency 

You can set the frequency with either frequency or channel number. If a frequency to be set matches 

to the frequency corresponding to the selected channel standard, the instrument calculates its channel 

number and updates the screen with it automatically. 

 

Procedure 

To set the center frequency: 

1. Press the FREQ/DIST hard key. 

2. Toggle the Unit soft key and select Freq. 

3. Press the Center Frequency soft key. 

4. Enter a value by using the numeric keys. You can also use the rotary knob. 

5. Select the unit: GHz, MHz, kHz, or Hz. 

6. Optional. To define the amount of frequency increment for the rotary knob, complete the following 
steps: 

a. Press the Frequency Step soft key. 

b. Enter a value by using the numeric keys. You can also use the rotary knob. 

c. Press the unit: GHz, MHz, kHz, or Hz. 
 
To set the channel number: 



JD780A Series Analyzers 

 Using TD-SCDMA Signal Analyzer 423 

1. Press the FREQ/DIST hard key. 

2. Toggle the Unit soft key and select Channel. 

3. To select the standard channel, complete the following steps: 

a. Press the Channel Std soft key. The standard channel window appears. 

See “Appendix C – Band, frequency & channel standard” on page 588 for more information. 

b. Select the band to be measured by using the rotary knob, the arrow keys, or the Page 
Up/Page Down soft keys. 

c. Press the Select soft key or the rotary knob to confirm the selection. 

4. Press the Channel Number soft key. 

5. Enter a value by using the numeric keys. You can also use the rotary knob. 

6. Press the Enter soft key. 

The instrument automatically displays the corresponding center frequency value for the selected 
channel number. 

7. Optional. To define the amount of channel increment for the rotary knob, complete the following 
steps: 

a. Press the Channel Step soft key. 

b. Enter a value by using the numeric keys. You can also use the rotary knob. 

c. Press the Enter soft key. 

 

 

NOTE 

This frequency setting is not used in the Multi-ACLR and Spurious Emissions modes. 

 

Setting amplitude 

Reference level and attenuation 

You can set the reference and attenuation levels automatically or manually to optimize the display of 

the traces measured, as you desire. 

 

Procedure 

To automatically set the reference and attenuation level: 

1. Press the AMP/SCALE hard key. 

2. Press the Auto Scale soft key. 

Each time you press this key, both of the Y-axis scale and input attenuation level change to be 
optimized with some margin. 

 
To set the reference or attenuation level manually: 

1. Press the AMP/SCALE hard key. 

2. To set the maximum reference value on the Y-axis manually, complete the following steps: 

a. Press the Reference Level soft key. 

b. Enter a value by using the numeric keys or the rotary knob with 10 dB increments. 

c. Press the unit soft key or the ENTER hard key. 

 

 

NOTE 
In the measurements such as Midamble Power, Code Power, and Code Error, you 
may need to select the reference option between Relative and Absolute before setting 

the reference level. 

3. To set the attenuation option, select one from the following choices: 
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–  To set the input attenuator’s level automatically, select Attenuation > Auto. 

 

 

NOTE 
It is recommended that you set the Attenuation to Auto in most situations so that the 

level of the input attenuator can be set automatically according to your input signal level. 

 

–  To set the input attenuation manually up to 55 dB to optimize S/N, complete the following 
steps: 

a. Select Attenuation > Manual. 

b. Press the Attenuation Value soft key to set the level. 

c. Enter a value between 0 and 55 in fives by using the numeric keys. 

d. Press the dB soft key or the ENTER hard key. 

–  To couple the input attenuator’s level with your reference level setting, select Attenuation > 
Couple. 

As you increase the reference setting, the attenuation level also increases acoordingly. 
 
Optional. To change the scale unit: 

1. Select More (1/2) > Units. 

2. Select the unit of the display scale: dBm, dBV, dBmV, dBµV, V, or W. 

The scale unit on the screen changes accordingly. 

 

 

NOTE 

This Units menu is available in the Spectrum and RF Analysis modes. 
 

 

Scale per division 

You can use the Scale/Div feature available for the spectrum and RF analysis. It represents the value 

of one division on the horizontal scale. The default setting is 10 dB per division and the maximum 

value can be set up to 20 dB. 

 

Procedure 

To set the scale per division: 

1. Press the AMP/SCALE hard key. 

2. Select More (1/2) > Scale/Div. 

3. Enter a value between 1 and 20 by using the numeric keys. 

4. Press the dB soft key to complete the entry. 

 

Pre-amplifier 

You can turn the internal pre-amplifier on to correct and compensate for the gain of the preamp so that 

amplitude readings show the value at the input connector. 

 

Procedure 

1. Press the AMP/SCALE hard key. 

2. Toggle the Preamp soft key and select On or Off as needed. 

 



JD780A Series Analyzers 

 Using TD-SCDMA Signal Analyzer 425 

 

NOTE 

You can turn the Preamp on when the input attenuation range is from 0 dB to 10 dB. If 
the attenuation value is manually set to greater than 10 dB, the instrument will 
automatically turn off the pre-amplifier to display low-level signal properly on the chart. 

 

External offset 

You can turn the External Offset on and manually set the external offset value. An offset consists of a 

cable loss and a user offset and the measurement result shows the value reflecting both offset values. 

When the external offset value is set at 40 dB in the Spectrum mode, the measurement result 

compensates 40 dB at both the Spectrum Analyzer and Signal Analyzer modes 

 

Procedure 

To set the external offset: 

1. Press the AMP/SCALE hard key. 

2. Toggle the External Offset soft key and select On. 

3. Enter a value by using the numeric keys. 

4. Press the dB soft key to complete the entry. 

 
To turn the external offset off: 

1. Press the AMP/SCALE hard key. 

2. Toggle the External Offset soft key and select Off. 

 

Setting average 

You can set the number of measurements to be averaged for the trace presentation in the spectrum 

and RF analysis. A maximum of 100 times of averaging can be set. When the averaging reaches to 

your setting, a new measurement value replaces the measurement value in sequence from the earliest. 

 

Procedure 

1. Press the BW/AVG hard key. 

2. Press the Average soft key. 

3. Enter a value between 1 and 100 as needed by using the numeric keys. 

4. Press the Enter soft key. 

 

Setting sweep mode 

The default setting is Continue to sweep continuously for most on-going measurements. If you want to 

hold the measurement or get a single sweep, you can change the sweep mode. 

 

Procedure 

To select the single sweep mode: 

1. Press the SWEEP hot key. 

2. Toggle the Sweep Mode soft key and select Single. You can also use the HOLD hot key. 

The letter HOLD in red appears and the sweeping is paused. 

3. Optional. Press the Sweep Once soft key to get a new measurement. 
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To return to the continuous sweep mode: 

1. Toggle the Sweep Mode soft key and select Continue. You can also use the HOLD hot key. 

The letter HOLD in red disappears and the sweeping resumes. 

 

Setting trigger source 

You can set the trigger source option for your measurements. 

Procedure 

1. Press the TRIGGER hot key. 

2. Select the trigger source option from the following choices: Internal, External, or GPS. 

 

Setting external clock 

To enhance the reliability of modulation analysis measurements the JD780A series must be 

synchronized with a base station. When an external clock is not supplied, the instrument works with its 

built-in internal high-accuracy time base and some measurement results may exhibit inaccurate values. 

Therefore, it is highly recommended that you use the same reference clock as the signal source. You 

can use the TRIGGER hot key to set the external clock. 

 

Figure 206 Connection ports for external reference clock 

 

 

Procedure 

1. Connect an external reference or a GPS antenna to the JD780A series. 

2. Press the SYSTEM hot key. 

3. Press the Freq Reference soft key, and then select the reference option: Internal, External 10 
MHz, External 13 MHz, External 15 MHz, or GPS. 

 

Table 19 External reference indicators 

Type Indicator Description 

Internal  (green) The green INT icon indicates that the instrument uses the built-in 

internal time base. 

External  (green) The green EXT icon indicates that an external reference is connected 

and locked and that the instrument uses the same reference clock as 
the signal source. 

External  (red) The red EXT icon indicates that an external reference is connect but not 

locked. 

GPS (green) The green GPS antenna icon indicates that a GPS antenna is 
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connected and locked. 

GPS (yellow) The yellow GPS antenna icon indicates that a GPS antenna is 
connected and locking is in progress. 

GPS (grey) The grey GPS antenna icon indicates that a GPS antenna is not 
connected, failed, or unable to be locked. 

 

Conducting spectrum measurements 

Setting measure setup 

After configuring test parameters as described in the “Configuring test parameters” on page 422, you 

can continue your measurement. 

 

Procedure 

1. Press the MEASURE SETUP hot key. 

2. Press the Slot Number soft key, and then select the time slot number to be displayed: TS0, TS1, 
TS2, TS3, TS4, TS5, or TS6. 

3. Optional. To set the delay, complete the following steps: 

a. Press the Delay soft key to set the amount of delay in µs. 

b. Enter a value by using the numeric keys. You can also use the rotary knob. 

c. Press the µs soft key. 

 

 

NOTE 

The Delay setting is used only when there is a time offset in the signals to be measured. 
 

 

Your measurement result is displayed on the screen as like the following example, Figure 207. 

 

Figure 207 Spectrum measurement screen with TD-SCDMA signal analyzer 
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Setting trace 

You can display up to six traces on the measurement chart simultaneously. 

 

Procedure 

1. Press the TRACE/DISPLAY hard key. 

2. Press the Select Trace soft key, and then select the trace number: T1, T2, T3, T4, T5, or T6. 

The legend shape of the selected trace changes from square to round to indicate that the trace is 
the active one now. 

3. Do one of the following: 
 

To Select Trace Legend 

Clear current data and display with new 
measurements 

Clear Write W 

Display the input signal’s maximum response only 
(unlimited or for a certain amount of time) 

Max Hold M 

Display the input signal’s minimum response only 
(unlimited or for a certain amount of time) 

Min Hold m 

Capture the selected trace and compare traces Capture C 

Load a saved trace More (1/2) > Load L 

Hide the selected trace Trace View > Off F 

Remove all the traces and initialize the trace 
settings 

More (1/2) > Trace 
Clear All 

 

 

 

NOTE 
For the Max Hold and Min Hold, your instrument compares newly acquired data with the 

active trace and displays larger maximum values or smaller minimum values on the 
screen. You can set it to Unlimited to hold and view maximum or minimum data or 

specify a certain amount of time up to 60 seconds by using numeric keys or the rotary 
knob. 

4. Optional. Press the More (1/2) > Trace Info soft key, and then select the trace number to view 
the trace’s parameter setting information stored at the time of the measurement or None to hide 

the information display. 

5. Optional. If you have the two traces T1 and T2, you can perform trace math. To view the power 
difference between the traces, press the T1 – T2 -> T5 or T2 – T1 -> T6 soft key. 

The result is overlaid on the screen along with the second Y-axis. 

 

Conducting RF measurements 

Channel power 

The Channel Power measurement determines the average power of an RF signal burst at or above a 

specified threshold value. 

 

The purpose of the Channel Power measurement is to determine the power delivered to the antenna 

system on the RF channel under test. The instrument acquires a TD-SCDMA signal in the time domain. 

The average power level above the threshold is then computed and displayed. 
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Setting measure setup 

After configuring test parameters as described in the “Configuring test parameters” on page 422, you 

can continue your measurement. 

 

Procedure 

1. Press the MEASURE SETUP hot key. 

2. Press the Slot Number soft key, and then select the time slot number to be displayed: TS0, TS1, 
TS2, TS3, TS4, TS5, or TS6. 

3. Optional. To set the delay, complete the following steps: 

a. Press the Delay soft key to set the amount of delay in µs. 

b. Enter a value by using the numeric keys. You can also use the rotary knob. 

c. Press the µs soft key. 

 

 

NOTE 

The Delay setting is used only when there is a time offset in the signals to be measured. 
 

 

Measurement example 

Figure 208 Channel power measurement with TD-SCDMA signal analyzer 

 

 

 

NOTE 
You can use the LIMIT hot key to analyze your measurements with the user-definable 
limit and Pass/Fail indication. See “Setting limit for RF tests” on page 435 for more 
information. 

 

Occupied bandwidth 

The Occupied Bandwidth measures the spectrum shape of the carrier. It is defined as the bandwidth, 

which includes 99% of the transmitted power among total transmitted power. 

 

Setting measure setup 

After configuring test parameters as described in the “Configuring test parameters” on page 422, you 
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can continue your measurement. 

 

Procedure 

1. Press the MEASURE SETUP hot key. 

2. Press the Slot Number soft key, and then select the time slot number to be displayed: TS0, TS1, 
TS2, TS3, TS4, TS5, or TS6. 

3. Optional. To set the delay, complete the following steps: 

a. Press the Delay soft key to set the amount of delay in µs. 

b. Enter a value by using the numeric keys. You can also use the rotary knob. 

c. Press the µs soft key. 

 

 

NOTE 

The Delay setting is used only when there is a time offset in the signals to be measured. 
 

 

Measurement example 

Figure 209 Occupied bandwidth measurement with TD-SCDMA signal analyzer 

 

 

 

NOTE 

You can use the LIMIT hot key to analyze your measurements with the user-definable 
limit and Pass/Fail indication. See “Setting limit for RF tests” on page 435 for more 
information. 

 

Spectrum emission mask (SEM) 

The Spectrum Emission Mask (SEM) measurement required by 3GPP specifications encompasses 

different power limits and different measurement bandwidths (resolution bandwidths) at various 

frequency offsets. It may be expressed as a ratio of power spectral densities between the carrier and 

the specified offset frequency band. It provides useful figures-of-merit for the spectral re-growth and 

emissions produced by components and circuit blocks, without the rigor of performing a full SEM 

measurement. 

 

The SEM measures spurious signal levels in up to five pairs of offset or region frequencies and relates 
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them to the carrier power. 

 

Setting measure setup 

After configuring test parameters as described in the “Configuring test parameters” on page 422, you 

can continue your measurement. 

 

Procedure 

1. Press the MEASURE SETUP hot key. 

2. Press the Slot Number soft key, and then select the time slot number to be displayed: TS0, TS1, 
TS2, TS3, TS4, TS5, or TS6. 

3. To select the mask type according to the output power of the base station, complete the following 
steps: 

a. Press the Mask Type soft key. 

b. Select the mask type option: - 26 dBm, 26 – 34 dBm, or 34 dBm –. 

4. Optional. To set the delay, complete the following steps: 

a. Press the Delay soft key to set the amount of delay in µs. 

b. Enter a value by using the numeric keys. You can also use the rotary knob. 

c. Press the µs soft key. 

 

 

NOTE 

The Delay setting is used only when there is a time offset in the signals to be measured. 
 

 

Measurement example 

Figure 210 SEM measurement with TD-SCDMA signal analyzer 

 

 

 

NOTE 
You can use the LIMIT hot key to analyze your measurements with the user-definable 
limit and Pass/Fail indication. See “Setting limit for RF tests” on page 435 for more 
information. 
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ACLR 

The Adjacent Channel Leakage power Ratio (ACLR) measures the amount of interference or power in 

an adjacent frequency channel according to the standards. 

 

Setting measure setup 

After configuring test parameters as described in the “Configuring test parameters” on page 422, you 

can continue your measurement. 

 

Procedure 

1. Press the MEASURE SETUP hot key. 

2. Press the Slot Number soft key, and then select the time slot number to be displayed: TS0, TS1, 
TS2, TS3, TS4, TS5, or TS6. 

3. Optional. To set the delay, complete the following steps: 

a. Press the Delay soft key to set the amount of delay in µs. 

b. Enter a value by using the numeric keys. You can also use the rotary knob. 

c. Press the µs soft key. 

 

 

NOTE 

The Delay setting is used only when there is a time offset in the signals to be measured. 
 

 

Measurement example 

Figure 211 ACLR measurement with TD-SCDMA signal analyzer 

 

 

 

NOTE 
You can use the LIMIT hot key to analyze your measurements with the user-definable 
limit and Pass/Fail indication. See “Setting limit for RF tests” on page 435 for more 
information. 

 

Multi-ACLR 

The Multi-ACLR measurement is used to perform multi-channel ACLR measurements with as many 
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channels as possible. It helps you to measure ACLR in multi-channel transmitting Base Station 

environment. 

 

Setting measure setup 

After configuring test parameters as described in the “Configuring test parameters” on page 422, you 

can continue your measurement. 

 

Procedure 

1. Press the MEASURE SETUP hot key. 

2. To set the frequency, do one of the following: 

–  To set the center frequency, complete the following steps: 

a. Toggle the Unit soft key and select Freq. 

b. Press the Lowest Frequency soft key to set the starting center frequency. 

c. Enter a value by using the numeric keys. You can also use the rotary knob. 

d. Select the unit: GHz, MHz, kHz, or Hz. 

e. Press the Highest Frequency soft key to set the stopping center frequency. 

f. Enter a value by using the numeric keys. You can also use the rotary knob. 

g. Select the unit: GHz, MHz, kHz, or Hz. 

–  To set the channel number, complete the following steps: 

a. Toggle the Unit soft key and select Channel. 

b. To select the standard channel, press the Channel Std soft key and then select the 

band to be measured. 

c. Press the Lowest Channel soft key to set the starting channel. 

d. Enter a value by using the numeric keys. You can also use the rotary knob. 

e. Press the Enter soft key. 

f. Press the Highest Channel soft key to set the stopping channel. 

g. Enter a value by using the numeric keys. You can also use the rotary knob. 

h. Press the Enter soft key. 
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Measurement example 

Figure 212 Multi-ACLR measurement with TD-SCDMA signal analyzer 

 

 

 

NOTE 
You can use the LIMIT hot key to analyze your measurements with the user-definable 
limit and Pass/Fail indication. See “Setting limit for RF tests” on page 435 for more 
information. 

 

Spurious emissions 

Out-of-band emissions are unwanted emissions immediately outside the channel bandwidth resulting 

from the modulation process and non-linearity in the transmitter but excluding spurious emissions. The 

Spurious Emissions measurement is to identify and determine the power level of out-of-band spurious 

emission within the necessary channel bandwidth and modulated signal measured at the RF port of 

the Base Station. 

 

Setting measure setup 

After configuring test parameters as described in the “Configuring test parameters” on page 422, you 

can continue your measurement. 

 

Procedure 

1. Press the MEASURE SETUP hot key. 

2. To set up the range table and parameters, press the Range Table soft key and then complete 

the following steps: 

a. Press the Range soft key, and then select the range number between 1 and 20 to add  

as a new or change the existing settings. 

b. Do the following as desired: 

–  Select Start Frequency, and then specify the start frequency for the selected range. 

–  Select Stop Frequency, and then specify the stop frequency for the selected range. 

–  Select Start Limit, and then specify the lower limit for Pass/Fail indication. 

–  Select Stop Limit, and then specify the upper limit for Pass/Fail indication. 
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–  Select More (1/2) > Attenuation, and then specify an value in the multiple of five. 

–  Select More (1/2) > RBW, and then specify a RBW value. 

–  Select More (1/2) > VBW, and then specify a VBW value. 

c. Press the PREV hard key. 

d. Toggle the Range soft key and select On to display the selected range in the result table or 

Off to hide it from the table. 

3. Toggle the Measure Type soft key between Examine and Full to select the measurement type. 

 

NOTE 
The Examine mode displays only the selected range while the Full mode lets the 

instrument automatically changes the selected range from one another. 

4. To set the number of measurements to be averaged, complete the following steps: 

a. Press the Average soft key. 

b. Enter a value between 1 and 100. 

c. Press the Enter soft key. 

5. To move the highlighted bar in the result table to other range, complete the following steps: 

a. Press the Range soft key in the Measure Setup menu bar. 

b. Enter a value between 1 and 20. 

c. Press the Enter soft key. 

 

Measurement example 

Figure 213 Spurious emissions measurement with TD-SCDMA signal analyzer 

 

 

 

NOTE 
You can use the LIMIT hot key to analyze your measurements with the user-definable 

limit and Pass/Fail indication. See “Setting limit for RF tests” on page 435 for more 
information. 

 

Setting limit for RF tests 

By default, test limits specified in the standard are set for you. You can change thresholds if you desire. 
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Procedure 

1. Press the LIMIT hot key. 

2. Press the RF Test Limits soft key. 

3. Select the test item(s) and set the limit(s) depending on your selected measurement mode: 
 

To set the limit for Select Set 

Channel power Channel Power High Limit 
Low Limit 

Occupied bandwidth Occupied BW High Limit 

Spectrum emission mask Spectrum Emission Mask (On/Off only) 

ACLR ACLR (On/Off only) 

Multi-ACLR Multi-ACLR (On/Off only) 

Spurious emissions Spurious Emissions (On/Off only) 

4. Optional. You can enable alarm sound that goes off if the measurement falls outside of the limit. 
Toggle the Beep soft key between On and Off to enable or disable the beep sound. 

5. Optional. Go to SAVE/LOAD > Save, and then select Save Limit to save the limit settings. 

See “Using save” on page 33 for more information. 

 

Conducting power vs. time measurements 

The Power vs. Time (P vs T) measurement analyzes the amplitude profile and timing of the burst 

signal and provides a time mask for the signal. It measures the mean transmit power during the “useful 

part” of TD-SCDMA bursts and verifies that the power ramp fits within the defined mask. TD-SCDMA is 

a Time Division Multiple Access (TDMA) scheme with seven time slots, or bursts, per RF channel and 

by using the “Multi-Slot” function, up to seven slots in a frame can be viewed at one time. 

 

Power vs. time (slot) 

The Power vs. Time (Slot) in TD-SCDMA Signal Analyzer measures the modulation envelope in the 

time domain, showing the signal rise and fall shape of TD-SCDMA signal. 

 

Setting measure setup 

After configuring test parameters as described in the “Configuring test parameters” on page 422, you 

can continue your measurement. The measurement settings can be saved and recalled as a file. 

 

Procedure 

1. Press the MEASURE SETUP hot key. 

2. Press the Slot Number soft key, and then select the time slot number to be displayed: TS0, TS1, 
TS2, TS3, TS4, TS5, or TS6. 

3. Press the Spread Factor soft key, and then select the spread factor option: DL Auto for auto 
detection of downlink, UL Auto for auto detection of uplink, SF1, SF2, SF4, SF8, or SF16 

4. To set the number of maximum users, complete the following steps: 

a. Press the Max Users soft key. 
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b. Enter a value up to 16 by using the numeric keys. 

c. Press the Enter soft key. 

5. Optional. To set the delay, complete the following steps: 

a. Press the Delay soft key to set the amount of delay in µs. 

b. Enter a value by using the numeric keys. You can also use the rotary knob. 

c. Press the µs soft key. 

 

 

NOTE 

The Delay setting is used only when there is a time offset in the signals to be measured. 

6. Optional. Press the Miscellaneous soft key, and then do the following(s) as needed: 

–  To select how to determine scrambling estimation, toggle the Scramble soft key and select 
Spec or Full. 

 

 

NOTE 

The Spec searches “Sync Sequence Number” from 0 to 31 based on the TD-SCDMA 
specification and determines “Scrambling Code Number” by using the sync sequence 
number, while the Full does from 0 to 127 fully. 

–  To select how to determine the Midamble spread factor estimation either in full or maximum 
power search, toggle the Mid SF Map soft key and select Max or Spec. 

 

 

NOTE 

The Max determines the spread factor of the Midamble by using the maximum power of 
the received Midamble, while the Spec searches “Default Midamble Allocation” based on 
the TD-SCDMA specification. 

–  To select the detect mode, press the Detect Mode soft key and then select the option: 
Auto, QPSK/8PSK, QPSK, 8PSK, 16 QAM, or 64 QAM. 

 

Measurement example 

Figure 214 Power vs. time (slot) measurement with TD-SCDMA signal analyzer 

 

 

 

NOTE 
You can use the LIMIT hot key to analyze your measurements with the user-definable 

limit and Pass/Fail indication. See “Setting limit for power vs. time tests” on page 442 for 
more information. 
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Power vs. time (frame) 

The Power vs. Time (Frame) measures the modulation envelope in the time domain, showing the 

power of each time slot of the TD-SCDMA signal. 

 

Setting measure setup 

After configuring test parameters as described in the “Configuring test parameters” on page 422, you 

can continue your measurement. The measurement settings can be saved and recalled as a file. 

 

Procedure 

1. Press the MEASURE SETUP hot key. 

2. Press the Slot Number soft key, and then select the time slot number to be displayed: TS0, TS1, 
TS2, TS3, TS4, TS5, or TS6. 

3. Press the Spread Factor soft key, and then select the spread factor option: DL Auto for auto 
detection of downlink, UL Auto for auto detection of uplink, SF1, SF2, SF4, SF8, or SF16 

4. To set the number of maximum users, complete the following steps: 

a. Press the Max Users soft key. 

b. Enter a value up to 16 by using the numeric keys. 

c. Press the Enter soft key. 

5. Optional. To set the delay, complete the following steps: 

a. Press the Delay soft key to set the amount of delay in µs. 

b. Enter a value by using the numeric keys. You can also use the rotary knob. 

c. Press the µs soft key. 

 

 

NOTE 

The Delay setting is used only when there is a time offset in the signals to be measured. 

6. Optional. Press the Miscellaneous soft key, and then do the following(s) as needed: 

–  To select how to determine scrambling estimation, toggle the Scramble soft key and select 
Spec or Full. 

 

 

NOTE 

The Spec searches “Sync Sequence Number” from 0 to 31 based on the TD-SCDMA 
specification and determines “Scrambling Code Number” by using the sync sequence 
number, while the Full does from 0 to 127 fully. 

–  To select how to determine the Midamble spread factor estimation either in full or maximum 
power search, toggle the Mid SF Map soft key and select Max or Spec. 

 

 

NOTE 

The Max determines the spread factor of the Midamble by using the maximum power of 
the received Midamble, while the Spec searches “Default Midamble Allocation” based on 
the TD-SCDMA specification. 

–  To select the detect mode, press the Detect Mode soft key and then select the option: 
Auto, QPSK/8PSK, QPSK, 8PSK, 16 QAM, or 64 QAM. 
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Measurement example 

Figure 215 Power vs. time (frame) measurement with TD-SCDMA signal analyzer 

 

 

 

NOTE 
You can use the LIMIT hot key to analyze your measurements with the user-definable 

limit and Pass/Fail indication. See “Setting limit for power vs. time tests” on page 442 for 
more information. The On/Off Ratio is not used in the power vs. time (frame) tests. 

 

Power vs. time (mask) 

Setting measure setup 

After configuring test parameters as described in the “Configuring test parameters” on page 422, you 

can continue your measurement. The measurement settings can be saved and recalled as a file. 

 

Procedure 

1. Press the MEASURE SETUP hot key. 

2. Press the Slot Number soft key, and then select the time slot number to be displayed: TS0, TS1, 
TS2, TS3, TS4, TS5, or TS6. 

3. Press the Spread Factor soft key, and then select the spread factor option: DL Auto for auto 
detection of downlink, UL Auto for auto detection of uplink, SF1, SF2, SF4, SF8, or SF16 

4. To set the number of maximum users, complete the following steps: 

a. Press the Max Users soft key. 

b. Enter a value up to 16 by using the numeric keys. 

c. Press the Enter soft key. 

5. Optional. To set the delay, complete the following steps: 

a. Press the Delay soft key to set the amount of delay in µs. 

b. Enter a value by using the numeric keys. You can also use the rotary knob. 

c. Press the µs soft key. 

 

 

NOTE 

The Delay setting is used only when there is a time offset in the signals to be measured. 
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6. Optional. Press the Miscellaneous soft key, and then do the following(s) as needed: 

–  To select how to determine scrambling estimation, toggle the Scramble soft key and select 
Spec or Full. 

 

 

NOTE 

The Spec searches “Sync Sequence Number” from 0 to 31 based on the TD-SCDMA 
specification and determines “Scrambling Code Number” by using the sync sequence 
number, while the Full does from 0 to 127 fully. 

–  To select how to determine the Midamble spread factor estimation either in full or maximum 
power search, toggle the Mid SF Map soft key and select Max or Spec. 

 

 

NOTE 

The Max determines the spread factor of the Midamble by using the maximum power of 
the received Midamble, while the Spec searches “Default Midamble Allocation” based on 
the TD-SCDMA specification. 

–  To select the detect mode, press the Detect Mode soft key and then select the option: 
Auto, QPSK/8PSK, QPSK, 8PSK, 16 QAM, or 64 QAM. 

 

Measurement example 

Figure 216 Power vs. time (mask) measurement with TD-SCDMA signal analyzer 

 

 

 

NOTE 
You can use the LIMIT hot key to analyze your measurements with the user-definable 

limit and Pass/Fail indication. See “Setting limit for power vs. time tests” on page 442 for 
more information. The DwPTS Power and UpPTS Power are not used in the power vs. 
time (mask) tests. 

 

Timogram 

Setting measure setup 

After configuring test parameters as described in the “Configuring test parameters” on page 422, you 

can continue your measurement. The measurement settings can be saved and recalled as a file. 
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Procedure 

1. Press the MEASURE SETUP hot key. 

2. Press the Spread Factor soft key, and then select the spread factor option: DL Auto for auto 
detection of downlink, UL Auto for auto detection of uplink, SF1, SF2, SF4, SF8, or SF16 

3. To set the number of maximum users, complete the following steps: 

a. Press the Max Users soft key. 

b. Enter a value up to 16 by using the numeric keys. 

c. Press the Enter soft key. 

4. To set the time interval, complete the following steps: 

a. Press the Time Interval soft key. 

b. Enter a value by using the numeric keys. 

c. Press the Enter soft key. 

5. To place the time cursor to analyze your measurements, complete the following steps: 

a. Toggle the Time Cursor soft key between On and Off to enable or disable the time cursor. 

b. Enter a value by using the numeric keys. 

c. Press the Enter soft key. 

 

 

NOTE 

When the time cursor is enabled, the measurement is put on hold and information about 
the time cursor is displayed. 

6. Optional. Press the Miscellaneous soft key, and then do the following(s) as needed: 

–  To set the delay, complete the following steps: 

a. Press the Delay soft key to set the amount of delay in µs. 

b. Enter a value by using the numeric keys. You can also use the rotary knob. 

c. Press the µs soft key. 

 

 

NOTE 

The Delay setting is used only when there is a time offset in the signals to be measured. 

–  To select how to determine scrambling estimation, toggle the Scramble soft key and select 
Spec or Full. 

 

 

NOTE 

The Spec searches “Sync Sequence Number” from 0 to 31 based on the TD-SCDMA 
specification and determines “Scrambling Code Number” by using the sync sequence 
number, while the Full does from 0 to 127 fully. 

–  To select how to determine the Midamble spread factor estimation either in full or maximum 
power search, toggle the Mid SF Map soft key and select Max or Spec. 

 

 

NOTE 

The Max determines the spread factor of the Midamble by using the maximum power of 
the received Midamble, while the Spec searches “Default Midamble Allocation” based on 
the TD-SCDMA specification. 

–  To select the detect mode, press the Detect Mode soft key and then select the option: 
Auto, QPSK/8PSK, QPSK, 8PSK, 16 QAM, or 64 QAM. 
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Measurement example 

Figure 217 Timogram with TD-SCDMA signal analyzer 

 

 

Setting limit for power vs. time tests 

Procedure 

1. Press the LIMIT hot key. 

2. Press the PvsT Test Limits soft key. 

3. Select the test item(s) and set the limit(s) depending on your selected measurement mode: 
 

To set the limit for Select Set 

Slot power Slot Power High Limit, Low Limit 

Downlink pilot signal power DwPTS Power High Limit, Low Limit 

Uplink pilot signal power UpPTS Power High Limit, Low Limit 

Power between on and off 
portions of the downlink slots 

On/Off Ratio High Limit, Low Limit 

4. Optional. You can enable alarm sound that goes off if the measurement falls outside of the limit. 
Toggle the Beep soft key between On and Off to enable or disable the beep sound. 

5. Optional. Go to SAVE/LOAD > Save, and then select Save Limit to save the limit settings. 

See “Using save” on page 33 for more information. 

 

Conducting modulation measurements 

TD-SCDMA receivers rely on the frequency or phase quality of the QPSK or 8PSK signal in order to 

achieve the expected carrier to noise performance. A transmitter with high frequency or phase error is 

often still able to support phone calls during a functional test. It displays the frequency errors 

numerically and graphically, showing the binary representation of the demodulated data bits of the 

received signal using Constellation, Midamble Power, Code Power, and Code Error screens. 
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Constellation 

The Constellation is used to observe some aspects of modulation accuracy and can reveal certain 

fault mechanisms such as I/Q amplitude imbalance or quadrature imbalance. It displays constellation 

diagram by modulation types. 

 

Setting measure setup 

After configuring test parameters as described in the “Configuring test parameters” on page 422, you 

can continue your measurement. The measurement settings can be saved and recalled as a file. You 

can also use JDViewer, PC application software to configure a measure setup, save as a file, and load 

the file on to the instrument. 

 

Procedure 

1. Press the MEASURE SETUP hot key. 

2. Toggle the Scramble soft key and select Auto or Manual to set the scramble code automatically 

or manually. 

3. Press the Slot Number soft key, and then select the time slot number to be displayed: TS0, TS1, 
TS2, TS3, TS4, TS5, or TS6. 

4. Press the Spread Factor soft key, and then select the spread factor option: DL Auto for auto 
detection of downlink, UL Auto for auto detection of uplink, SF1, SF2, SF4, SF8, or SF16 

5. To set the number of maximum users, complete the following steps: 

a. Press the Max Users soft key. 

b. Enter a value up to 16 by using the numeric keys, and then press the Enter soft key. 

6. Optional. Press the Miscellaneous soft key, and then do the following(s) as needed: 

–  To set the delay, complete the following steps: 

a. Press the Delay soft key to set the amount of delay in µs. 

b. Enter a value by using the numeric keys. You can also use the rotary knob. 

c. Press the µs soft key. 
 

 

NOTE 

The Delay setting is used only when there is a time offset in the signals to be measured. 

–  To select how to determine scrambling estimation, toggle the Scramble soft key and select 
Spec or Full. 

 

 

NOTE 

The Spec searches “Sync Sequence Number” from 0 to 31 based on the TD-SCDMA 
specification and determines “Scrambling Code Number” by using the sync sequence 
number, while the Full does from 0 to 127 fully. 

–  To select how to determine the Midamble spread factor estimation either in full or maximum 
power search, toggle the Mid SF Map soft key and select Max or Spec. 

 

 

NOTE 

The Max determines the spread factor of the Midamble by using the maximum power of 
the received Midamble, while the Spec searches “Default Midamble Allocation” based on 
the TD-SCDMA specification. 

–  To select the detect mode, press the Detect Mode soft key and then select the option: 
Auto, QPSK/8PSK, QPSK, 8PSK, 16 QAM, or 64 QAM. 

–  To set the relative threshold, complete the following steps: 

a. Press the Threshold soft key. Its default setting is -27 dB. 

b. Enter a value between -50 and zero by using the numeric keys. 
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c. Press the Enter soft key. 

 

Measurement example 

Figure 218 Constellation measurement with TD-SCDMA signal analyzer 

 

 

 

NOTE 
You can use the LIMIT hot key to analyze your measurements with the user-definable 

limit and Pass/Fail indication. See “Setting limit for modulation tests” on page 449 for 
more information. The Max Inactive is not used in the Constellation mode. 

 

Midamble power 

Setting measure setup 

After configuring test parameters as described in the “Configuring test parameters” on page 422, you 

can continue your measurement. The measurement settings can be saved and recalled as a file. You 

can also use JDViewer, PC application software to configure a measure setup, save as a file, and load 

the file on to the instrument. 

 

Procedure 

1. Press the MEASURE SETUP hot key. 

2. Toggle the Scramble soft key and select Auto or Manual to set the scramble code automatically 

or manually. 

3. Press the Slot Number soft key, and then select the time slot number to be displayed: TS0, TS1, 
TS2, TS3, TS4, TS5, or TS6. 

4. Press the Spread Factor soft key, and then select the spread factor option: DL Auto for auto 
detection of downlink, UL Auto for auto detection of uplink, SF1, SF2, SF4, SF8, or SF16 

5. To set the number of maximum users, complete the following steps: 

a. Press the Max Users soft key. 

b. Enter a value up to 16 by using the numeric keys. 

c. Press the Enter soft key. 

6. Optional. Press the Miscellaneous soft key, and then do the following(s) as needed: 

–  To set the delay, complete the following steps: 
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a. Press the Delay soft key to set the amount of delay in µs. 

b. Enter a value by using the numeric keys. You can also use the rotary knob. 

c. Press the µs soft key. 
 

 

NOTE 

The Delay setting is used only when there is a time offset in the signals to be measured. 

–  To select how to determine scrambling estimation, toggle the Scramble soft key and select 
Spec or Full. 

 

 

NOTE 

The Spec searches “Sync Sequence Number” from 0 to 31 based on the TD-SCDMA 
specification and determines “Scrambling Code Number” by using the sync sequence 
number, while the Full does from 0 to 127 fully. 

–  To select how to determine the Midamble spread factor estimation either in full or maximum 
power search, toggle the Mid SF Map soft key and select Max or Spec. 

 

 

NOTE 

The Max determines the spread factor of the Midamble by using the maximum power of 
the received Midamble, while the Spec searches “Default Midamble Allocation” based on 
the TD-SCDMA specification. 

–  To select the detect mode, press the Detect Mode soft key and then select the option: 
Auto, QPSK/8PSK, QPSK, 8PSK, 16 QAM, or 64 QAM. 

–  To set the relative threshold, complete the following steps: 

a. Press the Threshold soft key. Its default setting is -27 dB. 

b. Enter a value between -50 and zero by using the numeric keys. 

c. Press the Enter soft key. 

 

Measurement example 

Figure 219 Midamble measurement with TD-SCDMA signal analyzer 

 

 

Code power 

Setting measure setup 

After configuring test parameters as described in the “Configuring test parameters” on page 422, you 
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can continue your measurement. The measurement settings can be saved and recalled as a file. You 

can also use JDViewer, PC application software to configure a measure setup, save as a file, and load 

the file on to the instrument. 

 

Procedure 

1. Press the MEASURE SETUP hot key. 

2. Toggle the Scramble soft key and select Auto or Manual to set the scramble code automatically 

or manually. 

3. Press the Slot Number soft key, and then select the time slot number to be displayed: TS0, TS1, 
TS2, TS3, TS4, TS5, or TS6. 

4. Press the Spread Factor soft key, and then select the spread factor option: DL Auto for auto 
detection of downlink, UL Auto for auto detection of uplink, SF1, SF2, SF4, SF8, or SF16 

5. To set the number of maximum users, complete the following steps: 

a. Press the Max Users soft key. 

b. Enter a value up to 16 by using the numeric keys. 

c. Press the Enter soft key. 

6. Optional. Press the Miscellaneous soft key, and then do the following(s) as needed: 

–  To set the delay, complete the following steps: 

a. Press the Delay soft key to set the amount of delay in µs. 

b. Enter a value by using the numeric keys. You can also use the rotary knob. 

c. Press the µs soft key. 

 

 

NOTE 

The Delay setting is used only when there is a time offset in the signals to be measured. 

–  To select how to determine scrambling estimation, toggle the Scramble soft key and select 
Spec or Full. 

 

 

NOTE 

The Spec searches “Sync Sequence Number” from 0 to 31 based on the TD-SCDMA 
specification and determines “Scrambling Code Number” by using the sync sequence 
number, while the Full does from 0 to 127 fully. 

–  To select how to determine the Midamble spread factor estimation either in full or maximum 
power search, toggle the Mid SF Map soft key and select Max or Spec. 

 

 

NOTE 

The Max determines the spread factor of the Midamble by using the maximum power of 
the received Midamble, while the Spec searches “Default Midamble Allocation” based on 
the TD-SCDMA specification. 

–  To select the detect mode, press the Detect Mode soft key and then select the option: 
Auto, QPSK/8PSK, QPSK, 8PSK, 16 QAM, or 64 QAM. 

–  To set the relative threshold, complete the following steps: 

a. Press the Threshold soft key. Its default setting is -27 dB. 

b. Enter a value between -50 and zero by using the numeric keys. 

c. Press the Enter soft key. 
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Measurement example 

Figure 220 Code power measurement with TD-SCDMA signal analyzer 

 

 

 

NOTE 
You can use the LIMIT hot key to analyze your measurements with the user-definable 
limit and Pass/Fail indication for the Max Inactive. See “Setting limit for modulation tests” 
on page 449 for more information. 

Code error 

Setting measure setup 

After configuring test parameters as described in the “Configuring test parameters” on page 422, you 

can continue your measurement. The measurement settings can be saved and recalled as a file. You 

can also use JDViewer, PC application software to configure a measure setup, save as a file, and load 

the file on to the instrument. 

 

Procedure 

1. Press the MEASURE SETUP hot key. 

2. Toggle the Scramble soft key and select Auto or Manual to set the scramble code automatically 

or manually. 

3. Press the Slot Number soft key, and then select the time slot number to be displayed: TS0, TS1, 
TS2, TS3, TS4, TS5, or TS6. 

4. Press the Spread Factor soft key, and then select the spread factor option: DL Auto for auto 
detection of downlink, UL Auto for auto detection of uplink, SF1, SF2, SF4, SF8, or SF16 

5. To set the number of maximum users, complete the following steps: 

a. Press the Max Users soft key. 

b. Enter a value up to 16 by using the numeric keys. 

c. Press the Enter soft key. 

6. Optional. Press the Miscellaneous soft key, and then do the following(s) as needed: 

–  To set the delay, complete the following steps: 

a. Press the Delay soft key to set the amount of delay in µs. 

b. Enter a value by using the numeric keys. You can also use the rotary knob. 
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c. Press the µs soft key. 

 

 

NOTE 

The Delay setting is used only when there is a time offset in the signals to be measured. 

–  To select how to determine scrambling estimation, toggle the Scramble soft key and select 
Spec or Full. 

 

 

NOTE 

The Spec searches “Sync Sequence Number” from 0 to 31 based on the TD-SCDMA 
specification and determines “Scrambling Code Number” by using the sync sequence 
number, while the Full does from 0 to 127 fully. 

–  To select how to determine the Midamble spread factor estimation either in full or maximum 
power search, toggle the Mid SF Map soft key and select Max or Spec. 

 

 

NOTE 

The Max determines the spread factor of the Midamble by using the maximum power of 
the received Midamble, while the Spec searches “Default Midamble Allocation” based on 
the TD-SCDMA specification. 

–  To select the detect mode, press the Detect Mode soft key and then select the option: 
Auto, QPSK/8PSK, QPSK, 8PSK, 16 QAM, or 64 QAM. 

–  To set the relative threshold, complete the following steps: 

a. Press the Threshold soft key. Its default setting is -27 dB. 

b. Enter a value between -50 and zero by using the numeric keys. 

c. Press the Enter soft key. 

 

Measurement example 

Figure 221 Code error measurement with TD-SCDMA signal analyzer 

 

 

 

NOTE 
You can use the LIMIT hot key to analyze your measurements with the user-definable 
limit and Pass/Fail indication for the Max Inactive. See “Setting limit for modulation tests” 
on page 449 for more information. 
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Setting limit for modulation tests 

Procedure 

1. Press the LIMIT hot key. 

2. Press the Modulation Test Limits soft key. 

3. Select the test item(s) and set the limit(s) depending on your selected measurement mode: 
 

To set the limit for Select Set 

Frequency error Frequency Error High Limit 
Low Limit 

Error vector magnitude rms EVM RMS High Limit 

Peak code domain error PCDE High Limit 

Highest level among inactive channels Max Inactive High Limit 

4. Optional. You can enable alarm sound that goes off if the measurement falls outside of the limit. 
Toggle the Beep soft key between On and Off to enable or disable the beep sound. 

5. Optional. Go to SAVE/LOAD > Save, and then select Save Limit to save the limit settings. 

See “Using save” on page 33 for more information. 

 

Performing auto measurements 

The Auto Measure function of the JD780A series allows a complete signal profiling covering RF 

characterization and modulation quality parameters of up to 10 different carriers, particularly useful on 

an overlay architecture where base stations are transmitting in different frequencies. 

 

The Auto Measure can be easily executed either by selecting a menu in the instrument or by running a 

programmed scenario in the PC-based application so that the instrument automatically configure and 

perform tests on every aspect of all the carriers. 

 

Setting limit 

You can set test limits for test item(s) in the auto measurement. 

Procedure 

1. Press the LIMIT hot key. 

2. Press the RF Test Limits soft key, and then enable test limits as desired. 

3. Press the PvsT Test Limits soft key, and then enable test limits as desired. 

4. Press the Modulation Test Limits soft key, and then enable test limits as desired. 

5. Optional. You can enable alarm sound that goes off if the measurement falls outside of the limit. 
Toggle the Beep soft key between On and Off to enable or disable the beep sound. 

6. Optional. Go to SAVE/LOAD > Save, and then select Save Limit to save the limit settings. 

See “Using save” on page 33 for more information. 

 

Setting measure setup 

After configuring test parameters as described in the “Configuring test parameters” on page 422, you 

can continue your measurement. The measurement settings can be saved and recalled as a file. You 
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can also use JDViewer, PC application software to configure a measure setup, save as a file, and load 

the file on to the instrument. 

 

Procedure 

1. Press the MEASURE SETUP hot key. 

2. Toggle the Configuration soft key and select the configuration option: 

–  Current: to let the instrumnet use current frequency (single carrier) and determine pass or 

fail based on the instrument’s limit settings in Auto Measure. 

–  Scenario: to run a test with a programmed scenario in JDViewer. 

The Scenario menu becomes activated. 

3. To load a scenario, press the Scenario soft key, and then select a scenario file to load. 

4. Toggle the Test Time soft key and select the test time option: 

–  Now: to let the instrument run a test only once. 

–  Schedule: to let the instrument repeat tests as defined in the Set Timing. 

The Set Timing menu becomes activated. 

5. To define a schedule for an auto measurement, complete the following steps: 

a. Press the Set Timing soft key. 

b. Press the Start Time (HH:MM) soft key. 

c. Enter the time in the HH:MM format, and then press the Enter soft key. 

d. Press the Stop Time (HH:MM) soft key. 

e. Enter the time in the HH:MM format, and then press the Enter soft key. 

f. Press the Time Interval soft key. 

g. Enter the amount of time in minutes, and then press the Enter soft key. 

7. Press the Settings soft key, and then set the following: 

a. Press the Slot Number soft key, and then select the time slot number to be displayed: TS0, 
TS1, TS2, TS3, TS4, TS5, or TS6. 

b. Toggle the External Offset soft key and select On. 

c. Enter a value by using the numeric keys, and then press the dB soft key. 

8. To save your settings and results, go to SAVE/LOAD > Save and then perform functions as you 

desire. See “Using save” on page 33 for more information. 

9. Press the Run Test soft key to start to run a test. 

The Auto Measure Results window appears at the end of the test. 

10. To stop running the test, press the Abort soft key. 

11. To change the view on the screen during the test, press the Display and then select the view 

option from the following choices: 

–  Screen: You can view each measurement screen as the test progresses. 

–  Results: You can view a measurement result table as the test progresses. 

–  Settings: You can view a measurement setting table as the test progresses. 

 

Setting display 

After completion of the auto measurement, the screen menu changes to Trace/Display so that you can 

view the results in different forms. 
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Procedure 

1. Toggle the Display soft key and select the display option: 

–  Result: to view the result table. 

The Display Result menu becomes activated. 

–  Settings: to view the measurement settings for the auto measurement. 

2. Toggle the Display Result soft key and select the display result option: 

–  Full: to view detailed measurement readings with the pass/fail indication. 

–  Quick: to view only the Pass/Fail results. 

3. To view the measurement results for a different carrier, press the View Carrier soft key and then 

select the carrier number to view. 

 

Conducting TD-SCDMA OTA measurements 

Sync-DL ID scanner 

Setting measure setup 

After configuring test parameters as described in the “Configuring test parameters” on page 422, you 

can continue your measurement. 

 

Procedure 

1. Press the MEASURE SETUP hot key. 

2. Toggle the Sync-DL ID soft key and select Auto or Manual to set the Sync Downlink ID 

automatically or manually. 

3. Optional. To select the delay, complete the following steps: 

a. Press the Miscellaneous soft key. 

b. Press the Delay soft key to set the amount of delay in µs. 

c. Enter a value by using the numeric keys. You can also use the rotary knob. 

d. Press the µs soft key. 

 

 

NOTE 

The Delay setting is used only when there is a time offset in the signals to be measured. 

4. Optional. Go to SAVE/LOAD > Save, and then select the save option from the choices available 

for your measurement mode. See “Using save” on page 33 for more information. 
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Measurement example 

Figure 222 Sync-DL ID scanner measurement with TD-SCDMA OTA signal analyzer 

 

 

Sync-DL ID vs. Tau 

Setting measure setup 

After configuring test parameters as described in the “Configuring test parameters” on page 422, you 

can continue your measurement. 

 

Procedure 

1. Press the MEASURE SETUP hot key. 

2. Toggle the Sync-DL ID soft key and select Auto or Manual to set the Sync Downlink ID 

automatically or manually. 

3. Optional. To select the delay, complete the following steps: 

a. Press the Miscellaneous soft key. 

b. Press the Delay soft key to set the amount of delay in µs. 

c. Enter a value by using the numeric keys. You can also use the rotary knob. 

d. Press the µs soft key. 

 

 

NOTE 

The Delay setting is used only when there is a time offset in the signals to be measured. 

4. Optional. Go to SAVE/LOAD > Save, and then select the save option from the choices available 

for your measurement mode. See “Using save” on page 33 for more information. 
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Measurement example 

Figure 223 Sync-DL ID vs. Tau measurement with TD-SCDMA OTA signal analyzer 

 

 

Sync-DL ID multipath 

Setting measure setup 

After configuring test parameters as described in the “Configuring test parameters” on page 422, you 

can continue your measurement. 

 

Procedure 

1. Press the MEASURE SETUP hot key. 

2. Toggle the Sync-DL ID soft key and select Auto or Manual to set the Sync Downlink ID 

automatically or manually. 

3. Optional. To select the delay, complete the following steps: 

a. Press the Miscellaneous soft key. 

b. Press the Delay soft key to set the amount of delay in µs. 

c. Enter a value by using the numeric keys. You can also use the rotary knob. 

d. Press the µs soft key. 

 

 

NOTE 

The Delay setting is used only when there is a time offset in the signals to be measured. 

4. Optional. Go to SAVE/LOAD > Save, and then select the save option from the choices available 

for your measurement mode. See “Using save” on page 33 for more information. 
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Measurement example 

Figure 224 Sync-DL ID multipath measurement with TD-SCDMA OTA signal analyzer 

 

 

Sync-DL ID analyzer 

Setting measure setup 

After configuring test parameters as described in the “Configuring test parameters” on page 422, you 

can continue your measurement. 

 

Procedure 

1. Press the MEASURE SETUP hot key. 

2. Toggle the Sync-DL ID soft key and select Auto or Manual to set the Sync Downlink ID 

automatically or manually. 

3. Optional. To select the delay, complete the following steps: 

a. Press the Miscellaneous soft key. 

b. Press the Delay soft key to set the amount of delay in µs. 

c. Enter a value by using the numeric keys. You can also use the rotary knob. 

d. Press the µs soft key. 

 

 

NOTE 

The Delay setting is used only when there is a time offset in the signals to be measured. 

4. Optional. Go to SAVE/LOAD > Save, and then select the save option from the choices available 

for your measurement mode. See “Using save” on page 33 for more information. 

 

Setting limit for Sync-DL ID analyzer 

Procedure 

1. Press the LIMIT hot key. 

2. To set the limit for rms of the error vector magnitude, complete the following steps: 
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a. Press the EVM RMS soft key. 

b. Toggle the Test Limits soft key between On and Off to enable or disable the limit. 

c. Press the High Limit soft key, and then enter a value for the upper threshold. 

d. Press the Enter soft key. 

3. To set the limit for frequency error, complete the following steps: 

a. Press the Frequency Error soft key. 

b. Toggle the Test Limits soft key between On and Off to enable or disable the limit. 

c. Press the High Limit soft key, and then enter a value for the upper threshold. 

d. Press the ppm soft key. 

e. Press the Low Limit soft key, and then enter a value for the lower threshold. 

f. Press the ppm soft key. 

4. Optional. You can enable alarm sound that goes off if the measurement falls outside of the limit. 
Toggle the Beep soft key between On and Off to enable or disable the beep sound. 

5. Optional. Go to SAVE/LOAD > Save, and then select Save Limit to save the limit settings. 

See “Using save” on page 33 for more information. 

 

Measurement example 

Figure 225 Sync-DL ID analyzer measurement with TD-SCDMA OTA signal analyzer 

 

 

Route map 

The JD780A Series provides the Route Map function that allows you to collect data of points in an 

indoor or outdoor environment and track the received signals and coverage of RF transmitters by 

plotting data real time directly on top of a loaded floor plan or a map. 

 

Setting measure setup 

Procedure 

1. If required, connect a GPS receiver to your JD780A series for outdoor mapping. 
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Indoor mapping does not necessarily need a GPS antenna. 

2. Configure test parameters as described in the “Configuring test parameters” on page 422. 

3. To load your map file, complete the following steps: 

a. Plug in your USB drive that has a floor map or .mcf file type created in JDMapCreator. . If 

the JDMapCreator application on your computer is connected to the instrument via USB or 
LAN, you can send a map file with a single layer to the instrument directly by using the 
Send to EQP menu in JDMapCreator. 

 

 

NOTE 

The JDMapCreator converts and resizes any scanned floor plan or layout to fit onto your 
instrument’s display. JDMapCreator 1.2.0 or later can save a multiple-layered map, 
providing x1, x2, and x4 views, as a sizable map file so that you can zoom in and out 

after loading it. 

b. Press SAVE/LOAD hot key, and then select Load > Load Map. 

See “Using load” on page 36 for more information. 

4. Press the MEASURE SETUP hot key. 

5. Press the Plot Point soft key, and then select the plot point option from the following choices: 

–  To collect data/plot points automatically as you move around in a vehicle or outside, press 
the GPS soft key and then toggle the Screen Mode soft key between Map and Full. 

 

 

NOTE 
With the Map setting, you can view only the collected points that can be seen within the 

boundary of the loaded map. If a point is off the map, the instrument displays an arrow to 
indicate the direction of the current location on the map and the distance from the center 
to the location at the top of the screen. 
 
With the Full setting, you can view all the collected points of the route without the loaded 

map. 

–  To collect data/plot points manually without a GPS antenna in an indoor environment, press 
the Position soft key. 

6. Toggle the Plot soft key and select Start to start plotting. 

7. Touch directly on the screen or press the ENTER hard key to collect data and plot points on the 
loaded map for the Position setting. 

 

 

NOTE 
For the Position setting, you can change the direction of the route with the arrow keys 

and the distance with the rotary knob. 

8. Toggle the Plot soft key and select Stop to stop plotting. 

9. Press the SAVE/LOAD hot key to save the result. 
See “Using save” on page 33 for more information. 

 

 

NOTE 

The instrument does not automatically save the collected data. It is recommended that 
you save the result. Otherwise, you will lose all the collected data. 

 

 

Setting limit for route map 

You can set the thresholds for each test item. 

 

Procedure 

1. Press the LIMIT hot key. 

2. Press the Excellent soft key to set its threshold. 

3. Enter a value, and then press the Enter soft key. You can also use the rotary knob. 
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4. Press the Very Good soft key to set its threshold. 

5. Enter a value, and then press the Enter soft key. You can also use the rotary knob. 

6. Press the Good soft key to set its threshold. 

7. Enter a value, and then press the Enter soft key. You can also use the rotary knob. 

8. Press the Fair soft key to set its threshold. 

9. Enter a value, and then press the Enter soft key. You can also use the rotary knob. 

10. Press the Poor soft key to set its threshold. 

11. Enter a value, and then press the Enter soft key. You can also use the rotary knob. 

12. Optional. Go to SAVE/LOAD > Save, and then select Save Limit to save the limit settings. 

See “Using save” on page 33 for more information. 

 

Measurement example 

Figure 226 Route map measurement with TD-SCDMA OTA signal analyzer 

1) Map view 
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2) Full view 

 

 

Controlling a map 

If you have loaded a sizable map that was created in JDMapCreator 1.2.0 or later, you can use the 

Map Control feature that enables you to zoom into the map and view a specific area of interest in detail. 

 

Procedure 

1. Press the TRACE/DISPLAY hard key. 

2. Press the Map Control soft key. This key is active only when you have loaded a sizable map. 

3. Do one of the following: 

–  To zoom into an area of interest directly, complete the following steps: 

a. Toggle the Zoom to soft key and select Area. 

The black rectangle appears on the map. 

b. Press the Zoom In and Zoom Out soft keys, as you need, to decrease and increase 

the selected area. 

c. Move the rectangle by using the four arrow keys, as you need, to place it in a specific 
area of interest. 

d. Press the center of the rotary knob to zoom into the selected area. You can also press 
the Zoom to soft key again to zoom into the selected area. 

–  To zoom into the center or zoom out from the center, complete the following steps: 

a. Toggle the Zoom to soft key and select Center. 

b. Press the Zoom In and Zoom Out soft keys, as you need, to zoom in and zoom out. 

c. Move the zoomed-in area by using the four arrow keys, as you need. 
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Using Mobile WiMAX Signal Analyzer 

This chapter provides instructions for using the Mobile WiMAX Signal Analyzer function (option 026) 

with the Mobile WiMAX OTA Analyzer function (option 046). Topics discussed in this chapter are as 

follows: 

 

 Introduction .............................................................................................................................. 460 

 Display overview ...................................................................................................................... 460 

 Connecting a cable .................................................................................................................. 461 

 Selecting measurement mode ................................................................................................. 463 

 Configuring test parameters .................................................................................................... 463 

 Conducting spectrum measurements ...................................................................................... 468 

 Conducting RF measurements ................................................................................................ 470 

 Conducting power vs. time (frame) measurements ................................................................. 477 

 Conducting modulation measurements ................................................................................... 479 

 Performing auto measurements .............................................................................................. 487 

 Performing power statistics CCDF measurements ................................................................. 488 

 Conducting Mobile WiMAX OTA measurements ..................................................................... 489 
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Introduction 

The Mobile WiMAX Signal Analyzer performs power and spectrum measurements as well as 

modulation analysis to test the proper transmitter performance of Mobile WiMAX systems. It performs 

conformance testing according to the following standards providing a simple Pass/Fail indication on 

each test. 

 

 IEEE 802.16e-2005 

 WiBro (Korean Mobile WiMAX OFDMA Service) 

 

This instrument provides the following measurement tools for Mobile WiMAX system: 

 

 Spectrum Analysis 

 RF Analysis 

- Channel Power 

- Occupied Bandwidth 

- Spectrum Emission Mask 

- Spurious Emissions 

 Power vs. Time (Frame) 

 Modulation Analysis 

- Constellation 

- Spectral Flatness 

- EVM vs. Subcarrier 

- EVM vs. Symbol 

 Auto Measure 

 Power Statistics CCDF 

 Over The Air (OTA) 

- Preamble Scanner 

- Multipath Profile 

- Preamble Power Trend 

- Route Map 

 

Display overview 

Figure 227 provides descriptions for each segment of the measurement screen. 
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Figure 227 Mobile WiMAX signal analyzer measurement screen 

 

 

Connecting a cable 

Direct connection 

Procedure 

1. Connect the Spectrum Analyzer RF In port of the JD780A series and the Power amplifier output 

port of BTS. 

 

Figure 228 Direct connection 

 
JD785A/JD786A 

 
JD788A 

 

Indirect connection 

Procedure 

1. Connect the Spectrum Analyzer RF In port of the JD780A series and the monitor (test) port of 

BTS. 
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Figure 229 Indirect connection 

 
JD785A/JD786A 

 
JD788A 

 

 

CAUTION 
The maximum power for the Spectrum Analyzer RF In port is +25 dBm (0.316 W). If the 
input signal level to be measured is greater than +25 dBm, use a High Power 
Attenuator to prevent damage when you directly connect the signal to the instrument or 
connect the signal from the coupling port of a directional coupler. 

 

Over the air (OTA) 

Procedure 

1. Connect an Omni/directional RF antenna to the Spectrum Analyzer RF In port of the JD780A 

series. 

2. Connect a GPS antenna to the GPS port of the JD780A series. 

 

Figure 230 OTA connection 

 
JD785A/JD786A 

 
JD788A 

 

 

CAUTION 

If the input signal level to be measured is less than 0 dBm, set 0 dB attenuation or turn on 
the preamp to have better dynamic range for the OTA testing. 
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Selecting measurement mode 

Procedure 

1. Press the MODE hard key. 

2. Press the Signal Analyzer soft key. 

3. Press the More (1/2) > Mobile WiMAX soft key. The Spectrum mode is set by default. 

4. Press the MEASURE hot key, and then select the measurement mode option from the following 
choices: 

–  Spectrum 

–  RF Analysis > Channel Power, Occupied BW, Spectrum Emission Mask, or  
Spurious Emissions 

–  Power vs Time (Frame) 

–  Modulation Analysis > Constellation, Spectral Flatness, EVM vs Subcarrier, or  
EVM vs. Symbol 

–  Auto Measure 

–  Power Statistics CCDF 

–  OTA > Preamble Scanner, Multipath Profile, Preamble Power Trend, or Route Map 

 

Configuring test parameters 

Setting frequency 

You can set the frequency with either frequency or channel number. If a frequency to be set matches 

to the frequency corresponding to the selected channel standard, the instrument calculates its channel 

number and updates the screen with it automatically. 

 

Procedure 

To set the center frequency: 

1. Press the FREQ/DIST hard key. 

2. Toggle the Unit soft key and select Freq. 

3. Press the Center Frequency soft key. 

4. Enter a value by using the numeric keys. You can also use the rotary knob. 

5. Select the unit: GHz, MHz, kHz, or Hz. 

6. Optional. To define the amount of frequency increment for the rotary knob, complete the following 
steps: 

a. Press the Frequency Step soft key. 

b. Enter a value by using the numeric keys. You can also use the rotary knob. 

c. Press the unit: GHz, MHz, kHz, or Hz. 
 
To set the channel number: 

1. Press the FREQ/DIST hard key. 

2. Toggle the Unit soft key and select Channel. 

3. To select the standard channel, complete the following steps: 

a. Press the Channel Std soft key. The standard channel window appears. 
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See “Appendix C – Band, frequency & channel standard” on page 588 for more information. 

b. Select the band to be measured by using the rotary knob, the arrow keys, or the Page 
Up/Page Down soft keys. 

c. Press the Select soft key or the rotary knob to confirm the selection. 

4. Press the Channel Number soft key. 

5. Enter a value by using the numeric keys. You can also use the rotary knob. 

6. Press the Enter soft key. 

The instrument automatically displays the corresponding center frequency value for the selected 
channel number. 

7. Optional. To define the amount of channel increment for the rotary knob, complete the following 
steps: 

a. Press the Channel Step soft key. 

b. Enter a value by using the numeric keys. You can also use the rotary knob. 

c. Press the Enter soft key. 

 

 

NOTE 

This frequency setting is not used in the Spurious Emissions mode. 

 

Setting amplitude 

Reference level and attenuation 

You can set the reference and attenuation levels automatically or manually to optimize the display of 

the traces measured, as you desire. 

 

Procedure 

To automatically set the reference and attenuation level: 

1. Press the AMP/SCALE hard key. 

2. Press the Auto Scale soft key. 

Each time you press this key, both of the Y-axis scale and input attenuation level change to be 
optimized with some margin. 

 
To set the reference or attenuation level manually: 

1. Press the AMP/SCALE hard key. 

2. To set the maximum reference value on the Y-axis manually, complete the following steps: 

a. Press the Reference Level soft key. 

b. Enter a value by using the numeric keys or the rotary knob with 10 dB increments. 

c. Press the unit soft key or the ENTER hard key. 

 

 

NOTE 
In the measurements such as Midamble Power, Code Power, and Code Error, you 
may need to select the reference option between Relative and Absolute before setting 

the reference level. 

3. To set the attenuation option, select one from the following choices: 

–  To set the input attenuator’s level automatically, select Attenuation > Auto. 

 

 

NOTE 
It is recommended that you set the Attenuation to Auto in most situations so that the 

level of the input attenuator can be set automatically according to your input signal level. 
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–  To set the input attenuation manually up to 55 dB to optimize S/N, complete the following 
steps: 

a. Select Attenuation > Manual. 

b. Press the Attenuation Value soft key to set the level. 

c. Enter a value between 0 and 55 in fives by using the numeric keys. 

d. Press the dB soft key or the ENTER hard key. 

–  To couple the input attenuator’s level with your reference level setting, select Attenuation > 
Couple. 

As you increase the reference setting, the attenuation level also increases acoordingly. 
 
Optional. To change the scale unit: 

1. Select More (1/2) > Units. 

2. Select the unit of the display scale: dBm, dBV, dBmV, dBµV, V, or W. 

The scale unit on the screen changes accordingly. 

 

 

NOTE 

This Units menu is available in the Spectrum and RF Analysis modes. 
 

 

Scale per division 

You can use the Scale/Div feature available for the spectrum and RF analysis. It represents the value 

of one division on the horizontal scale. The default setting is 10 dB per division and the maximum 

value can be set up to 20 dB. 

 

Procedure 

To set the scale per division: 

1. Press the AMP/SCALE hard key. 

2. Select More (1/2) > Scale/Div. 

3. Enter a value between 1 and 20 by using the numeric keys. 

4. Press the dB soft key to complete the entry. 

 

Pre-amplifier 

You can turn the internal pre-amplifier on to correct and compensate for the gain of the preamp so that 

amplitude readings show the value at the input connector. 

 

Procedure 

1. Press the AMP/SCALE hard key. 

2. Toggle the Preamp soft key and select On or Off as needed. 

 

 

NOTE 

You can turn the Preamp on when the input attenuation range is from 0 dB to 10 dB. If 
the attenuation value is manually set to greater than 10 dB, the instrument will 
automatically turn off the pre-amplifier to display low-level signal properly on the chart. 

 



JD780A Series Analyzers 

466 Using Mobile WiMAX Signal Analyzer 

External offset 

You can turn the External Offset on and manually set the external offset value. An offset consists of a 

cable loss and a user offset and the measurement result shows the value reflecting both offset values. 

When the external offset value is set at 40 dB in the Spectrum mode, the measurement result 

compensates 40 dB at both the Spectrum Analyzer and Signal Analyzer modes 

 

Procedure 

To set the external offset: 

1. Press the AMP/SCALE hard key. 

2. Toggle the External Offset soft key and select On. 

3. Enter a value by using the numeric keys. 

4. Press the dB soft key to complete the entry. 

 
To turn the external offset off: 

1. Press the AMP/SCALE hard key. 

2. Toggle the External Offset soft key and select Off. 

 

Setting average 

You can set the number of measurements to be averaged for the trace presentation. A maximum of 

100 times of averaging can be set. When the averaging reaches to your setting, a new measurement 

value replaces the measurement value in sequence from the earliest. 

 

Procedure 

1. Press the BW/AVG hard key. 

2. Press the Average soft key. 

3. Enter a value between 1 and 100 as needed by using the numeric keys. 

4. Press the Enter soft key. 

 

Setting sweep mode 

The default setting is Continue to sweep continuously for most on-going measurements. If you want to 

hold the measurement or get a single sweep, you can change the sweep mode. 

 

Procedure 

To select the single sweep mode: 

1. Press the SWEEP hot key. 

2. Toggle the Sweep Mode soft key and select Single. You can also use the HOLD hot key. 

The letter HOLD in red appears and the sweeping is paused. 

3. Optional. Press the Sweep Once soft key to get a new measurement. 
 
To return to the continuous sweep mode: 

1. Toggle the Sweep Mode soft key and select Continue. You can also use the HOLD hot key. 

The letter HOLD in red disappears and the sweeping resumes. 
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Setting trigger source 

You can set the trigger source option for your measurements. 

Procedure 

1. Press the TRIGGER hot key. 

2. Select the trigger source option from the following choices: Internal, External, or GPS. 

 

Setting external clock 

To enhance the reliability of modulation analysis measurements the JD780A series must be 

synchronized with a base station. When an external clock is not supplied, the instrument works with its 

built-in internal high-accuracy time base and some measurement results may exhibit inaccurate values. 

Therefore, it is highly recommended that you use the same reference clock as the signal source. You 

can use the TRIGGER hot key to set the external clock. 

 

Figure 231 Connection ports for external reference clock 

 

 

Procedure 

1. Connect an external reference or a GPS antenna to the JD780A series. 

2. Press the SYSTEM hot key. 

3. Press the Freq Reference soft key, and then select the reference option: Internal, External 10 
MHz, External 13 MHz, External 15 MHz, or GPS. 

 

Table 20 External reference indicators 

Type Indicator Description 

Internal  (green) The green INT icon indicates that the instrument uses the built-in 

internal time base. 

External  (green) The green EXT icon indicates that an external reference is connected 

and locked and that the instrument uses the same reference clock as 
the signal source. 

External  (red) The red EXT icon indicates that an external reference is connect but not 

locked. 

GPS (green) The green GPS antenna icon indicates that a GPS antenna is 
connected and locked. 

GPS (yellow) The yellow GPS antenna icon indicates that a GPS antenna is 
connected and locking is in progress. 

GPS (grey) The grey GPS antenna icon indicates that a GPS antenna is not 
connected, failed, or unable to be locked. 
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Conducting spectrum measurements 

Setting measure setup 

After configuring test parameters as described in the “Configuring test parameters” on page 463, you 

can continue your measurement. 

 

Procedure 

1. Press the MEASURE SETUP hot key. 

2. Press the System Config soft key, and then do the following: 

a. Press the Bandwidth soft key, and then select the nominal channel bandwidth to be 

measured from the following choices: 

–  7 MHz (8/7): Sets the channel bandwidth to 7 MHz with sampling factor 8/7. In 

conjunction with nominal channel bandwidth 

–  8.75 MHz (8/7): Sets the channel bandwidth to 8.75 MHz with sampling factor 8/7 

–  10 MHz (28/25): Sets the channel bandwidth to 10 MHz with sampling factor 28/25 

b. Toggle the Frame Length soft key and select 5 ms or 10 ms. 

c. Press the TTG (RTG) soft key to set the transmit/receive transition gap between the last 

sample of the downlink burst and the first sample of the subsequent uplink burst. 

d. Enter a value by using the numeric keys, and then press the Enter soft key. 

e. Press the CP Ratio soft key, and then select the cyclic prefix ratio option: 1/4, 1/8, 1/16, or 
1/32. 

f. Press the DL Symbols soft key to set the number of downlink symbols. 

g. Enter a value by using the numeric keys, and then press the Enter soft key. 

h. Press the UL Symbols soft key to set the number of uplink symbols. 

i. Enter a value by using the numeric keys, and then press the Enter soft key. 

3. Optional. To set the delay, complete the following steps: 

a. Press the Delay soft key to set the amount of delay in µs. 

b. Enter a value by using the numeric keys. You can also use the rotary knob. 

c. Press the µs soft key. 

 

 

NOTE 

The Delay setting is used only when there is a time offset in the signals to be measured. 
 

 

Your measurement result is displayed on the screen as like the following example, Figure 232. 
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Figure 232 Spectrum measurement screen with Mobile WiMAX signal analyzer 

 

 

Setting trace 

You can display up to six traces on the measurement chart simultaneously. 

 

Procedure 

1. Press the TRACE/DISPLAY hard key. 

2. Press the Select Trace soft key, and then select the trace number: T1, T2, T3, T4, T5, or T6. 

The legend shape of the selected trace changes from square to round to indicate that the trace is 
the active one now. 

3. Do one of the following: 
 

To Select Trace Legend 

Clear current data and display with new 
measurements 

Clear Write W 

Display the input signal’s maximum response only 
(unlimited or for a certain amount of time) 

Max Hold M 

Display the input signal’s minimum response only 
(unlimited or for a certain amount of time) 

Min Hold m 

Capture the selected trace and compare traces Capture C 

Load a saved trace More (1/2) > Load L 

Hide the selected trace Trace View > Off F 

Remove all the traces and initialize the trace 
settings 

More (1/2) > Trace 
Clear All 

 

 

 

NOTE 
For the Max Hold and Min Hold, your instrument compares newly acquired data with the 

active trace and displays larger maximum values or smaller minimum values on the 
screen. You can set it to Unlimited to hold and view maximum or minimum data or 

specify a certain amount of time up to 60 seconds by using numeric keys or the rotary 
knob. 
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4. Optional. Press the More (1/2) > Trace Info soft key, and then select the trace number to view 
the trace’s parameter setting information stored at the time of the measurement or None to hide 

the information display. 

5. Optional. If you have the two traces T1 and T2, you can perform trace math. To view the power 
difference between the traces, press the T1 – T2 -> T5 or T2 – T1 -> T6 soft key. 

The result is overlaid on the screen along with the second Y-axis. 

 

Conducting RF measurements 

Channel power 

The Channel Power measurement is a common test used in the wireless industry to measure the total 

transmitted power of a radio within a defined frequency channel. It acquires a number of points 

representing the input signal in the time domain, transforms this information into the frequency domain 

using Fast Fourier Transform (FFT), and then calculates the channel power. The effective resolution 

bandwidth of the frequency domain trace is proportional to the number of points acquired for the FFT. 

 

The channel power measurement identifies the total RF power, power spectral density (PSD) and peak 

to average ratio (PAR) of the signal in the Mobile WiMAX channel bandwidth. 

 

Setting measure setup 

After configuring test parameters as described in the “Configuring test parameters” on page 463, you 

can continue your measurement. 

 

Procedure 

1. Press the MEASURE SETUP hot key. 

2. Press the System Config soft key, and then do the following: 

a. Press the Bandwidth soft key, and then select the nominal channel bandwidth to be 

measured from the following choices: 

–  7 MHz (8/7): Sets the channel bandwidth to 7 MHz with sampling factor 8/7. In 

conjunction with nominal channel bandwidth 

–  8.75 MHz (8/7): Sets the channel bandwidth to 8.75 MHz with sampling factor 8/7 

–  10 MHz (28/25): Sets the channel bandwidth to 10 MHz with sampling factor 28/25 

b. Toggle the Frame Length soft key and select 5 ms or 10 ms. 

c. Press the TTG (RTG) soft key to set the transmit/receive transition gap between the last 

sample of the downlink burst and the first sample of the subsequent uplink burst. 

d. Enter a value by using the numeric keys, and then press the Enter soft key. 

e. Press the CP Ratio soft key, and then select the cyclic prefix ratio option: 1/4, 1/8, 1/16, or 
1/32. 

f. Press the DL Symbols soft key to set the number of downlink symbols. 

g. Enter a value by using the numeric keys, and then press the Enter soft key. 

h. Press the UL Symbols soft key to set the number of uplink symbols. 

i. Enter a value by using the numeric keys, and then press the Enter soft key. 

3. Optional. To set the delay, complete the following steps: 

a. Press the Delay soft key to set the amount of delay in µs. 

b. Enter a value by using the numeric keys. You can also use the rotary knob. 
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c. Press the µs soft key. 

 

 

NOTE 

The Delay setting is used only when there is a time offset in the signals to be measured. 

4. To set the start/stop symbols, complete the following steps: 

a. Press the Start Symbol soft key. 

b. Enter a value by using the numeric keys, and then press the Enter soft key. 

c. Press the Stop Symbol soft key. 

d. Enter a value by using the numeric keys, and then press the Enter soft key. 

 

Measurement example 

Figure 233 Channel power measurement with Mobile WiMAX signal analyzer 

 

 

 

NOTE 
You can use the LIMIT hot key to analyze your measurements with the user-definable 
limit and Pass/Fail indication. See “Setting limit for RF tests” on page 476 for more 
information. 

 

Occupied bandwidth 

The Occupied Bandwidth measures the spectrum shape of the carrier. It is defined as the bandwidth, 

which includes 99% of the transmitted power among total transmitted power. 

 

Setting measure setup 

After configuring test parameters as described in the “Configuring test parameters” on page 463, you 

can continue your measurement. 

 

Procedure 

1. Press the MEASURE SETUP hot key. 

2. Press the System Config soft key, and then do the following: 
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a. Press the Bandwidth soft key, and then select the nominal channel bandwidth to be 

measured from the following choices: 

–  7 MHz (8/7): Sets the channel bandwidth to 7 MHz with sampling factor 8/7. In 

conjunction with nominal channel bandwidth 

–  8.75 MHz (8/7): Sets the channel bandwidth to 8.75 MHz with sampling factor 8/7 

–  10 MHz (28/25): Sets the channel bandwidth to 10 MHz with sampling factor 28/25 

b. Toggle the Frame Length soft key and select 5 ms or 10 ms. 

c. Press the TTG (RTG) soft key to set the transmit/receive transition gap between the last 

sample of the downlink burst and the first sample of the subsequent uplink burst. 

d. Enter a value by using the numeric keys, and then press the Enter soft key. 

e. Press the CP Ratio soft key, and then select the cyclic prefix ratio option: 1/4, 1/8, 1/16, or 
1/32. 

f. Press the DL Symbols soft key to set the number of downlink symbols. 

g. Enter a value by using the numeric keys, and then press the Enter soft key. 

h. Press the UL Symbols soft key to set the number of uplink symbols. 

i. Enter a value by using the numeric keys, and then press the Enter soft key. 

3. Optional. To set the delay, complete the following steps: 

a. Press the Delay soft key to set the amount of delay in µs. 

b. Enter a value by using the numeric keys. You can also use the rotary knob. 

c. Press the µs soft key. 

 

 

NOTE 

The Delay setting is used only when there is a time offset in the signals to be measured. 

4. To set the start/stop symbols, complete the following steps: 

a. Press the Start Symbol soft key. 

b. Enter a value by using the numeric keys, and then press the Enter soft key. 

c. Press the Stop Symbol soft key. 

d. Enter a value by using the numeric keys, and then press the Enter soft key. 
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Measurement example 

Figure 234 Occupied bandwidth measurement with Mobile WiMAX signal analyzer 

 

 

 

NOTE 
You can use the LIMIT hot key to analyze your measurements with the user-definable 
limit and Pass/Fail indication. See “Setting limit for RF tests” on page 476 for more 
information. 

 

Spectrum emission mask (SEM) 

The Spectrum Emission Mask (SEM) measurement compares the total power level within the defined 

carrier bandwidth and the given offset channels according to the standards. 

 

Setting measure setup 

After configuring test parameters as described in the “Configuring test parameters” on page 463, you 

can continue your measurement. 

 

Procedure 

1. Press the MEASURE SETUP hot key. 

2. Press the System Config soft key, and then do the following: 

a. Press the Bandwidth soft key, and then select the nominal channel bandwidth to be 

measured from the following choices: 

–  7 MHz (8/7): Sets the channel bandwidth to 7 MHz with sampling factor 8/7. In 

conjunction with nominal channel bandwidth 

–  8.75 MHz (8/7): Sets the channel bandwidth to 8.75 MHz with sampling factor 8/7 

–  10 MHz (28/25): Sets the channel bandwidth to 10 MHz with sampling factor 28/25 

b. Toggle the Frame Length soft key and select 5 ms or 10 ms. 

c. Press the TTG (RTG) soft key to set the transmit/receive transition gap between the last 

sample of the downlink burst and the first sample of the subsequent uplink burst. 

d. Enter a value by using the numeric keys, and then press the Enter soft key. 

e. Press the CP Ratio soft key, and then select the cyclic prefix ratio option: 1/4, 1/8, 1/16, or 
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1/32. 

f. Press the DL Symbols soft key to set the number of downlink symbols. 

g. Enter a value by using the numeric keys, and then press the Enter soft key. 

h. Press the UL Symbols soft key to set the number of uplink symbols. 

i. Enter a value by using the numeric keys, and then press the Enter soft key. 

3. Optional. To set the delay, complete the following steps: 

a. Press the Delay soft key to set the amount of delay in µs. 

b. Enter a value by using the numeric keys. You can also use the rotary knob. 

c. Press the µs soft key. 

 

 

NOTE 

The Delay setting is used only when there is a time offset in the signals to be measured. 

4. To set the start/stop symbols, complete the following steps: 

a. Press the Start Symbol soft key. 

b. Enter a value by using the numeric keys, and then press the Enter soft key. 

c. Press the Stop Symbol soft key. 

d. Enter a value by using the numeric keys, and then press the Enter soft key. 

 

Measurement example 

Figure 235 SEM measurement with Mobile WiMAX signal analyzer 

 

 

 

NOTE 

You can use the LIMIT hot key to analyze your measurements with the user-definable 
limit and Pass/Fail indication. See “Setting limit for RF tests” on page 476 for more 
information. 

 

Spurious emissions 

Out-of-band emissions are unwanted emissions immediately outside the channel bandwidth resulting 

from the modulation process and non-linearity in the transmitter but excluding spurious emissions. The 

Spurious Emissions measurement is to identify and determine the power level of out-of-band spurious 
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emission within the necessary channel bandwidth and modulated signal measured at the RF port of 

the Base Station. 

 

Setting measure setup 

After configuring test parameters as described in the “Configuring test parameters” on page 463, you 

can continue your measurement. 

 

Procedure 

1. Press the MEASURE SETUP hot key. 

2. To set up the range table and parameters, press the Range Table soft key and then complete 

the following steps: 

a. Press the Range soft key, and then select the range number between 1 and 20 to add  

as a new or change the existing settings. 

b. Do the following as desired: 

–  Select Start Frequency, and then specify the start frequency for the selected range. 

–  Select Stop Frequency, and then specify the stop frequency for the selected range. 

–  Select Start Limit, and then specify the lower limit for Pass/Fail indication. 

–  Select Stop Limit, and then specify the upper limit for Pass/Fail indication. 

–  Select More (1/2) > Attenuation, and then specify an value in the multiple of five. 

–  Select More (1/2) > RBW, and then specify a RBW value. 

–  Select More (1/2) > VBW, and then specify a VBW value. 

c. Press the PREV hard key. 

d. Toggle the Range soft key and select On to display the selected range in the result table or 

Off to hide it from the table. 

3. Toggle the Measure Type soft key between Examine and Full to select the measurement type. 

 

NOTE 
The Examine mode displays only the selected range while the Full mode lets the 

instrument automatically changes the selected range from one another. 

4. To set the number of measurements to be averaged, complete the following steps: 

a. Press the Average soft key. 

b. Enter a value between 1 and 100. 

c. Press the Enter soft key. 

5. To move the highlighted bar in the result table to other range, complete the following steps: 

a. Press the Range soft key in the Measure Setup menu bar. 

b. Enter a value between 1 and 20. 

c. Press the Enter soft key. 
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Measurement example 

Figure 236 Spurious emissions measurement with Mobile WiMAX signal analyzer 

 

 

 

NOTE 
You can use the LIMIT hot key to analyze your measurements with the user-definable 
limit and Pass/Fail indication. See “Setting limit for RF tests” on page 476 for more 
information. 

 

Setting limit for RF tests 

By default, test limits specified in the standard are set for you. You can change thresholds if you desire. 

 

Procedure 

1. Press the LIMIT hot key. 

2. Press the RF Test Limits soft key. 

3. Select the test item(s) and set the limit(s) depending on your selected measurement mode: 
 

To set the limit for Select Set 

Channel power Channel Power High Limit 
Low Limit 

Occupied bandwidth Occupied BW High Limit 

Spectrum emission mask Spectrum Emission Mask (On/Off only) 

Spurious emissions Spurious Emissions (On/Off only) 

4. Optional. You can enable alarm sound that goes off if the measurement falls outside of the limit. 
Toggle the Beep soft key between On and Off to enable or disable the beep sound. 

5. Optional. Go to SAVE/LOAD > Save, and then select Save Limit to save the limit settings. 

See “Using save” on page 33 for more information. 
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Conducting power vs. time (frame) measurements 

The Power vs. Time (Frame) measures the modulation envelope in the time domain, showing the 

power of each time slot in a Mobile WiMAX signal. 

 

Setting measure setup 

After configuring test parameters as described in the “Configuring test parameters” on page 463, you 

can continue your measurement. The measurement settings can be saved and recalled as a file. 

 

Procedure 

1. Press the MEASURE SETUP hot key. 

2. Press the System Config soft key, and then do the following: 

a. Press the Bandwidth soft key, and then select the nominal channel bandwidth to be 

measured from the following choices: 

–  7 MHz (8/7): Sets the channel bandwidth to 7 MHz with sampling factor 8/7. In 

conjunction with nominal channel bandwidth 

–  8.75 MHz (8/7): Sets the channel bandwidth to 8.75 MHz with sampling factor 8/7 

–  10 MHz (28/25): Sets the channel bandwidth to 10 MHz with sampling factor 28/25 

b. Toggle the Frame Length soft key and select 5 ms or 10 ms. 

c. Press the TTG (RTG) soft key to set the transmit/receive transition gap between the last 

sample of the downlink burst and the first sample of the subsequent uplink burst. 

d. Enter a value by using the numeric keys, and then press the Enter soft key. 

e. Press the CP Ratio soft key, and then select the cyclic prefix ratio option: 1/4, 1/8, 1/16, or 
1/32. 

f. Press the DL Symbols soft key to set the number of downlink symbols. 

g. Enter a value by using the numeric keys, and then press the Enter soft key. 

h. Press the UL Symbols soft key to set the number of uplink symbols. 

i. Enter a value by using the numeric keys, and then press the Enter soft key. 

3. To set the start/stop symbols, complete the following steps: 

a. Press the Start Symbol soft key. 

b. Enter a value by using the numeric keys, and then press the Enter soft key. 

c. Press the Stop Symbol soft key. 

d. Enter a value by using the numeric keys, and then press the Enter soft key. 

4. Toggle the Preamble Index soft key and select the preamble search method: Auto or Manual. 

5. Toggle the Search Type soft key and select Full or Window. 

6. Toggle the Video Filter soft key and select On or Off to enable or disable the video filter. 

7. Optional. Press the Miscellaneous soft key, and then do the following as needed: 

–  To set the delay, complete the following steps: 

a. Press the Delay soft key to set the amount of delay in µs. 

b. Enter a value by using the numeric keys. You can also use the rotary knob. 

c. Press the µs soft key. 

 

 

NOTE 

The Delay setting is used only when there is a time offset in the signals to be measured. 



JD780A Series Analyzers 

478 Using Mobile WiMAX Signal Analyzer 

–  To select the detect mode, press the Detect Mode soft key and then select the option: 
Auto, QPSK, 16 QAM, or 64 QAM. 

 

Setting limit for power vs. time tests 

Procedure 

1. Press the LIMIT hot key. 

2. Press the PvsT Test Limits soft key. 

3. Select the test item(s) and set the limit(s): 
 

To set the limit for Select Set 

Preamble power Preamble Power High Limit, Low Limit 

Downlink burst power DL Burst Power High Limit, Low Limit 

Uplink burst power UL Burst Power High Limit, Low Limit 

Frame average power Frame Average Power High Limit, Low Limit 

Time offset Time Offset High Limit, Low Limit 

I/Q origin offset IQ Origin Offset High Limit 

4. Optional. You can enable alarm sound that goes off if the measurement falls outside of the limit. 
Toggle the Beep soft key between On and Off to enable or disable the beep sound. 

5. Optional. Go to SAVE/LOAD > Save, and then select Save Limit to save the limit settings. 

See “Using save” on page 33 for more information. 

 

Measurement example 

Figure 237 Power vs. time (frame) measurement with Mobile WiMAX signal analyzer 
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Conducting modulation measurements 

Constellation 

The Constellation is used to observe some aspects of modulation accuracy and can reveal certain 

fault mechanisms such as I/Q amplitude imbalance or quadrature imbalance. It displays constellation 

diagram by modulation types. 

 

Setting measure setup 

After configuring test parameters as described in the “Configuring test parameters” on page 463, you 

can continue your measurement. The measurement settings can be saved and recalled as a file. You 

can also use JDViewer, PC application software to configure a measure setup, save as a file, and load 

the file on to the instrument. 

 

Procedure 

1. Press the MEASURE SETUP hot key. 

2. Press the System Config soft key, and then do the following: 

a. Press the Bandwidth soft key, and then select the nominal channel bandwidth to be 

measured from the following choices: 

–  7 MHz (8/7): Sets the channel bandwidth to 7 MHz with sampling factor 8/7. In 

conjunction with nominal channel bandwidth 

–  8.75 MHz (8/7): Sets the channel bandwidth to 8.75 MHz with sampling factor 8/7 

–  10 MHz (28/25): Sets the channel bandwidth to 10 MHz with sampling factor 28/25 

b. Toggle the Frame Length soft key and select 5 ms or 10 ms. 

c. Press the TTG (RTG) soft key to set the transmit/receive transition gap between the last 

sample of the downlink burst and the first sample of the subsequent uplink burst. 

d. Enter a value by using the numeric keys, and then press the Enter soft key. 

e. Press the CP Ratio soft key, and then select the cyclic prefix ratio option: 1/4, 1/8, 1/16, or 
1/32. 

f. Press the DL Symbols soft key to set the number of downlink symbols. 

g. Enter a value by using the numeric keys, and then press the Enter soft key. 

h. Press the UL Symbols soft key to set the number of uplink symbols. 

i. Enter a value by using the numeric keys, and then press the Enter soft key. 

3. To set the start/stop symbols, complete the following steps: 

a. Press the Start/Stop Symbol soft key. 

b. Enter a value by using the numeric keys, and then press the Enter soft key. 

4. Toggle the Preamble Index soft key and select the preamble search method: Auto or Manual. 

5. Toggle the Search Type soft key and select Full or Window. 

6. Optional. Press the Miscellaneous soft key, and then do the following as needed: 

–  To select the detect mode, press the Detect Mode soft key and then select the option: 
Auto, QPSK, 16 QAM, or 64 QAM. 

–  To select the downlink zone, press the DL Zone soft key and then select the permutation 
zone option: Auto, PUSC for partial usage of subcarrier channels, FUSC for full usage of 
subcarrier channels, or AMC2X3 for adaptive modulation and coding. 

 

 

NOTE 

The permutation zone that is a number of contiguous OFDMA symbols in downlink that 
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use the same permutation. The DL subframe may contain more than one permutation 
zone. The maximum number of DL zone is 8 in one DL subframe. 

–  To set the delay, complete the following steps: 

a. Press the Delay soft key to set the amount of delay in µs. 

b. Enter a value by using the numeric keys. You can also use the rotary knob. 

c. Press the µs soft key. 

 

 

NOTE 

The Delay setting is used only when there is a time offset in the signals to be measured. 
 

 

Measurement example 

Figure 238 Constellation measurement with Mobile WiMAX signal analyzer 

 

 

 

NOTE 

You can use the LIMIT hot key to analyze your measurements with the user-definable 
limit and Pass/Fail indication. See “Setting limit for modulation tests” on page 486 for 
more information. The Spectral Flatness is not used in the Constellation mode. 

 

Spectral flatness 

The Spectral Flatness is used to measure the flatness energy of the constellation according to the 

WiMAX specification IEEE 802.16e. 

 

Setting measure setup 

After configuring test parameters as described in the “Configuring test parameters” on page 463, you 

can continue your measurement. The measurement settings can be saved and recalled as a file. You 

can also use JDViewer, PC application software to configure a measure setup, save as a file, and load 

the file on to the instrument. 

  



JD780A Series Analyzers 

 Using Mobile WiMAX Signal Analyzer 481 

Procedure 

1. Press the MEASURE SETUP hot key. 

2. Press the System Config soft key, and then do the following: 

a. Press the Bandwidth soft key, and then select the nominal channel bandwidth to be 

measured from the following choices: 

–  7 MHz (8/7): Sets the channel bandwidth to 7 MHz with sampling factor 8/7. In 

conjunction with nominal channel bandwidth 

–  8.75 MHz (8/7): Sets the channel bandwidth to 8.75 MHz with sampling factor 8/7 

–  10 MHz (28/25): Sets the channel bandwidth to 10 MHz with sampling factor 28/25 

b. Toggle the Frame Length soft key and select 5 ms or 10 ms. 

c. Press the TTG (RTG) soft key to set the transmit/receive transition gap between the last 

sample of the downlink burst and the first sample of the subsequent uplink burst. 

d. Enter a value by using the numeric keys, and then press the Enter soft key. 

e. Press the CP Ratio soft key, and then select the cyclic prefix ratio option: 1/4, 1/8, 1/16, or 
1/32. 

f. Press the DL Symbols soft key to set the number of downlink symbols. 

g. Enter a value by using the numeric keys, and then press the Enter soft key. 

h. Press the UL Symbols soft key to set the number of uplink symbols. 

i. Enter a value by using the numeric keys, and then press the Enter soft key. 

3. To set the start/stop symbols, complete the following steps: 

a. Press the Start Symbol soft key. 

b. Enter a value by using the numeric keys, and then press the Enter soft key. 

c. Press the Stop Symbol soft key. 

d. Enter a value by using the numeric keys, and then press the Enter soft key. 

4. Toggle the Preamble Index soft key and select the preamble search method: Auto or Manual. 

5. Toggle the Search Type soft key and select Full or Window. 

6. Optional. Press the Miscellaneous soft key, and then do the following as needed: 

–  To select the detect mode, press the Detect Mode soft key and then select the option: 
Auto, QPSK, 16 QAM, or 64 QAM. 

–  To select the downlink zone, press the DL Zone soft key and then select the permutation 
zone option: Auto, PUSC for partial usage of subcarrier channels, FUSC for full usage of 
subcarrier channels, or AMC2X3 for adaptive modulation and coding. 

 

 

NOTE 

The permutation zone, which is a number of contiguous OFDMA, symbols in downlink 
that use the same permutation. The DL subframe may contain more than one 
permutation zone. The maximum number of DL zone is 8 in one DL subframe. 

–  To set the delay, complete the following steps: 

a. Press the Delay soft key to set the amount of delay in µs. 

b. Enter a value by using the numeric keys. You can also use the rotary knob. 

c. Press the µs soft key. 

 

 

NOTE 

The Delay setting is used only when there is a time offset in the signals to be measured. 
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Measurement example 

Figure 239 Spectral flatness measurement with Mobile WiMAX signal analyzer 

 

 

 

NOTE 
You can use the LIMIT hot key to analyze your measurements with the user-definable 
limit and Pass/Fail indication for the Spectral Flatness. See “Setting limit for modulation 
tests” on page 486 for more information. 

 

EVM vs. subcarrier 

The EVM vs Subcarrier shows the error vector magnitude representing the average constellation error 

of WIMAX OFDMA subcarriers. 

 

Setting measure setup 

After configuring test parameters as described in the “Configuring test parameters” on page 463, you 

can continue your measurement. The measurement settings can be saved and recalled as a file. You 

can also use JDViewer, PC application software to configure a measure setup, save as a file, and load 

the file on to the instrument. 

 

Procedure 

1. Press the MEASURE SETUP hot key. 

2. Press the System Config soft key, and then do the following: 

a. Press the Bandwidth soft key, and then select the nominal channel bandwidth to be 

measured from the following choices: 

–  7 MHz (8/7): Sets the channel bandwidth to 7 MHz with sampling factor 8/7. In 

conjunction with nominal channel bandwidth 

–  8.75 MHz (8/7): Sets the channel bandwidth to 8.75 MHz with sampling factor 8/7 

–  10 MHz (28/25): Sets the channel bandwidth to 10 MHz with sampling factor 28/25 

b. Toggle the Frame Length soft key and select 5 ms or 10 ms. 

c. Press the TTG (RTG) soft key to set the transmit/receive transition gap between the last 

sample of the downlink burst and the first sample of the subsequent uplink burst. 
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d. Enter a value by using the numeric keys, and then press the Enter soft key. 

e. Press the CP Ratio soft key, and then select the cyclic prefix ratio option: 1/4, 1/8, 1/16, or 
1/32. 

f. Press the DL Symbols soft key to set the number of downlink symbols. 

g. Enter a value by using the numeric keys, and then press the Enter soft key. 

h. Press the UL Symbols soft key to set the number of uplink symbols. 

i. Enter a value by using the numeric keys, and then press the Enter soft key. 

3. To set the start/stop symbols, complete the following steps: 

a. Press the Start/Stop Symbol soft key. 

b. Enter a value by using the numeric keys, and then press the Enter soft key. 

4. Toggle the Preamble Index soft key and select the preamble search method: Auto or Manual. 

5. Toggle the Search Type soft key and select Full or Window. 

6. Optional. Press the Miscellaneous soft key, and then do the following as needed: 

–  To select the detect mode, press the Detect Mode soft key and then select the option: 
Auto, QPSK, 16 QAM, or 64 QAM. 

–  To select the downlink zone, press the DL Zone soft key and then select the permutation 
zone option: Auto, PUSC for partial usage of subcarrier channels, FUSC for full usage of 
subcarrier channels, or AMC2X3 for adaptive modulation and coding. 

 

 

NOTE 

The permutation zone, which is a number of contiguous OFDMA, symbols in downlink 
that use the same permutation. The DL subframe may contain more than one 
permutation zone. The maximum number of DL zone is 8 in one DL subframe. 

–  To set the delay, complete the following steps: 

a. Press the Delay soft key to set the amount of delay in µs. 

b. Enter a value by using the numeric keys. You can also use the rotary knob. 

c. Press the µs soft key. 

 

 

NOTE 

The Delay setting is used only when there is a time offset in the signals to be measured. 
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Measurement example 

Figure 240 EVM vs. subcarrier measurement with Mobile WiMAX signal analyzer 

 

 

 

NOTE 

You can use the LIMIT hot key to analyze your measurements with the user-definable 
limit and Pass/Fail indication. See “Setting limit for modulation tests” on page 486 for 
more information. The Spectral Flatness and Frequency Error are not used in the EVM 
vs. Subcarrier mode. 

 

EVM vs. symbol 

The EVM vs Symbol is used to show the error vector magnitude representing the average 

constellation error of WiMAX OFDMA symbols. 

 

Setting measure setup 

After configuring test parameters as described in the “Configuring test parameters” on page 463, you 

can continue your measurement. The measurement settings can be saved and recalled as a file. You 

can also use JDViewer, PC application software to configure a measure setup, save as a file, and load 

the file on to the instrument. 

 

Procedure 

1. Press the MEASURE SETUP hot key. 

2. Press the System Config soft key, and then do the following: 

a. Press the Bandwidth soft key, and then select the nominal channel bandwidth to be 

measured from the following choices: 

–  7 MHz (8/7): Sets the channel bandwidth to 7 MHz with sampling factor 8/7. In 

conjunction with nominal channel bandwidth 

–  8.75 MHz (8/7): Sets the channel bandwidth to 8.75 MHz with sampling factor 8/7 

–  10 MHz (28/25): Sets the channel bandwidth to 10 MHz with sampling factor 28/25 

b. Toggle the Frame Length soft key and select 5 ms or 10 ms. 

c. Press the TTG (RTG) soft key to set the transmit/receive transition gap between the last 

sample of the downlink burst and the first sample of the subsequent uplink burst. 
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d. Enter a value by using the numeric keys, and then press the Enter soft key. 

e. Press the CP Ratio soft key, and then select the cyclic prefix ratio option: 1/4, 1/8, 1/16, or 
1/32. 

f. Press the DL Symbols soft key to set the number of downlink symbols. 

g. Enter a value by using the numeric keys, and then press the Enter soft key. 

h. Press the UL Symbols soft key to set the number of uplink symbols. 

i. Enter a value by using the numeric keys, and then press the Enter soft key. 

3. To set the start/stop symbols, complete the following steps: 

a. Press the Start/Stop Symbol soft key. 

b. Enter a value by using the numeric keys, and then press the Enter soft key. 

4. Toggle the Preamble Index soft key and select the preamble search method: Auto or Manual. 

5. Toggle the Search Type soft key and select Full or Window. 

6. Optional. Press the Miscellaneous soft key, and then do the following as needed: 

–  To select the detect mode, press the Detect Mode soft key and then select the option: 
Auto, QPSK, 16 QAM, or 64 QAM. 

–  To select the downlink zone, press the DL Zone soft key and then select the permutation 
zone option: Auto, PUSC for partial usage of subcarrier channels, FUSC for full usage of 
subcarrier channels, or AMC2X3 for adaptive modulation and coding. 

 

 

NOTE 

The permutation zone, which is a number of contiguous OFDMA, symbols in downlink 
that use the same permutation. The DL subframe may contain more than one 
permutation zone. The maximum number of DL zone is 8 in one DL subframe. 

–  To set the delay, complete the following steps: 

a. Press the Delay soft key to set the amount of delay in µs. 

b. Enter a value by using the numeric keys. You can also use the rotary knob. 

c. Press the µs soft key. 

 

 

NOTE 

The Delay setting is used only when there is a time offset in the signals to be measured. 
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Measurement example 

Figure 241 EVM vs. symbol measurement with Mobile WiMAX signal analyzer 

 

 

 

NOTE 
You can use the LIMIT hot key to analyze your measurements with the user-definable 

limit and Pass/Fail indication. See “Setting limit for modulation tests” on page 486 for 
more information. The Spectral Flatness and Frequency Error are not used in the EVM 
vs. Subcarrier mode. 

 

Setting limit for modulation tests 

Procedure 

1. Press the LIMIT hot key. 

2. Press the Modulation Test Limits soft key to set the limits. 

3. Select the test item(s) and set the limit(s) depending on your selected measurement mode: 
 

To set the limit for Select Set 

Spectral flatness Spectral Flatness On/Off 

Frequency error Frequency Error High Limit 
Low Limit 

RMS for RCE RCE RMS High Limit 

Peak for RCE RCE Peak High Limit 

RMS for error vector magnitude EVM RMS High Limit 

Peak for error vector magnitude EVM Peak High Limit 

4. Optional. You can enable alarm sound that goes off if the measurement falls outside of the limit. 
Toggle the Beep soft key between On and Off to enable or disable the beep sound. 

5. Optional. Go to SAVE/LOAD > Save, and then select Save Limit to save the limit settings. 

See “Using save” on page 33 for more information. 
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Performing auto measurements 

The Auto Measure function of the JD780A series allows a complete signal profiling covering RF 

characterization and modulation quality parameters of up to 10 different carriers, particularly useful on 

an overlay architecture where base stations are transmitting in different frequencies. 

 

The Auto Measure can be easily executed either by selecting a menu in the instrument or by running a 

programmed scenario in the PC-based application so that the instrument automatically configure and 

perform tests on every aspect of all the carriers. 

 

Setting limit 

You can set test limits for test item(s) in the auto measurement. 

Procedure 

1. Press the LIMIT hot key. 

2. Press the RF Test Limits soft key, and then enable test limits as desired. 

3. Press the PvsT Test Limits soft key, and then enable test limits as desired. 

4. Press the Modulation Test Limits soft key, and then enable test limits as desired. 

5. Optional. You can enable alarm sound that goes off if the measurement falls outside of the limit. 
Toggle the Beep soft key between On and Off to enable or disable the beep sound. 

6. Optional. Go to SAVE/LOAD > Save, and then select Save Limit to save the limit settings. 

See “Using save” on page 33 for more information. 

 

Setting measure setup 

After configuring test parameters as described in the “Configuring test parameters” on page 463, you 

can continue your measurement. The measurement settings can be saved and recalled as a file. You 

can also use JDViewer, PC application software to configure a measure setup, save as a file, and load 

the file on to the instrument. 

 

Procedure 

1. Press the MEASURE SETUP hot key. 

2. Toggle the Configuration soft key and select the configuration option: 

–  Current: to let the instrumnet use current frequency (single carrier) and determine pass or 

fail based on the instrument’s limit settings in Auto Measure. 

–  Scenario: to run a test with a programmed scenario in JDViewer. 

The Scenario menu becomes activated. 

3. To load a scenario, press the Scenario soft key, and then select a scenario file to load. 

4. Toggle the Test Time soft key and select the test time option: 

–  Now: to let the instrument run a test only once. 

–  Schedule: to let the instrument repeat tests as defined in the Set Timing. 

The Set Timing menu becomes activated. 

5. To define a schedule for an auto measurement, complete the following steps: 

a. Press the Set Timing soft key. 

b. Press the Start Time (HH:MM) soft key. 
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c. Enter the time in the HH:MM format, and then press the Enter soft key. 

d. Press the Stop Time (HH:MM) soft key. 

e. Enter the time in the HH:MM format, and then press the Enter soft key. 

f. Press the Time Interval soft key. 

g. Enter the amount of time in minutes, and then press the Enter soft key. 

7. Press the Settings soft key, and then set the following: 

a. Press the Start Symbol soft key. 

b. Enter a value by using the numeric keys, and then press the Enter soft key. 

c. Press the Stop Symbol soft key. 

d. Enter a value by using the numeric keys, and then press the Enter soft key. 

e. Toggle the External Offset soft key and select On or Off. 

f. Enter a value by using the numeric keys, and then press the dB soft key. 

8. To save your settings and results, go to SAVE/LOAD > Save and then perform functions as you 

desire. See “Using save” on page 33 for more information. 

9. Press the Run Test soft key to start to run a test. 

The Auto Measure Results window appears at the end of the test. 

10. To stop running the test, press the Abort soft key. 

11. To change the view on the screen during the test, press the Display and then select the view 

option from the following choices: 

–  Screen: You can view each measurement screen as the test progresses. 

–  Results: You can view a measurement result table as the test progresses. 

–  Settings: You can view a measurement setting table as the test progresses. 

 

Setting display 

After completion of the auto measurement, the screen menu changes to Trace/Display so that you can 

view the results in different forms. 

 

Procedure 

1. Toggle the Display soft key and select the display option: 

–  Result: to view the result table. 

The Display Result menu becomes activated. 

–  Settings: to view the measurement settings for the auto measurement. 

2. Toggle the Display Result soft key and select the display result option: 

–  Full: to view detailed measurement readings with the pass/fail indication. 

–  Quick: to view only the Pass/Fail results. 

3. To view the measurement results for a different carrier, press the View Carrier soft key and then 

select the carrier number to view. 

 

Performing power statistics CCDF measurements 

The Power Statistics Complementary Cumulative Distribution Function (CCDF) measurement 

characterizes the power statistics of the input signal. It provides PAR (Peak to Average power Ratio) 

versus different probabilities. 
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Setting measure setup 

After configuring test parameters as described in the “Configuring test parameters” on page 463, you 

can continue your measurement. The measurement settings can be saved and recalled as a file. You 

can also use JDViewer, PC application software to configure a measure setup, save as a file, and load 

the file on to the instrument. 

 

Procedure 

1. Press the MEASURE SETUP hot key. 

2. Press the CCDF Length soft key to set the length of the CCDF. 

3. Enter a value between 1 and 100 by using the numeric keys. You can also use the rotary knob. 

4. Press the Enter soft key. 

 

Measurement example 

Figure 242 CCDF measurement with Mobile WiMAX signal analyzer 

 

 

Conducting Mobile WiMAX OTA measurements 

This Over The Air (OTA) measurement has preamble scanner, multipath profile, and preamble power 

trend screens. Preamble scanner displays six preambles and relative powers to inform neighbor cells 

existence. The multipath profile graph helps the user to determine testing area's RF environmental 

condition. The preamble power trend shows power variations of selected preamble over time along 

with relative power trend for strongest preamble. 

 

Preamble scanner 

The OTA Preamble Scanner displays the six strongest preambles to inform neighbor cells existence of 

testing area. Preamble Index, Relative Power, Cell ID, and Sector ID are listed in for each preamble 

signal with Time Offset in us. Positioning information, latitude, and longitude will be displayed if a GPS 

antenna is supplied and locked to the GPS satellites on the bottom of the screen. 
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Setting measure setup 

After configuring test parameters as described in the “Configuring test parameters” on page 463, you 

can continue your measurement. 

 

Procedure 

1. Press the MEASURE SETUP hot key. 

2. Press the System Config soft key, and then do the following: 

a. Press the Bandwidth soft key, and then select the nominal channel bandwidth to be 

measured from the following choices: 

–  7 MHz (8/7): Sets the channel bandwidth to 7 MHz with sampling factor 8/7. In 

conjunction with nominal channel bandwidth 

–  8.75 MHz (8/7): Sets the channel bandwidth to 8.75 MHz with sampling factor 8/7 

–  10 MHz (28/25): Sets the channel bandwidth to 10 MHz with sampling factor 28/25 

b. Toggle the Frame Length soft key and select 5 ms or 10 ms. 

c. Press the TTG (RTG) soft key to set the transmit/receive transition gap between the last 

sample of the downlink burst and the first sample of the subsequent uplink burst. 

d. Enter a value by using the numeric keys, and then press the Enter soft key. 

e. Press the CP Ratio soft key, and then select the cyclic prefix ratio option: 1/4, 1/8, 1/16, or 
1/32. 

f. Press the DL Symbols soft key to set the number of downlink symbols. 

g. Enter a value by using the numeric keys, and then press the Enter soft key. 

h. Press the UL Symbols soft key to set the number of uplink symbols. 

i. Enter a value by using the numeric keys, and then press the Enter soft key. 

3. Optional. Press the Miscellaneous soft key, and then do the following as needed: 

–  To set the delay, complete the following steps: 

a. Press the Delay soft key to set the amount of delay in µs. 

b. Enter a value by using the numeric keys. You can also use the rotary knob. 

c. Press the µs soft key. 

 

 

NOTE 

The Delay setting is used only when there is a time offset in the signals to be measured. 

4. Optional. Go to SAVE/LOAD > Save, and then select the save option from the choices available 

for your measurement mode. See “Using save” on page 33 for more information. 
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Measurement example 

Figure 243 Preamble scanner measurement with Mobile WiMAX OTA signal analyzer 

 

 

Multipath profile 

The Multipath Profile enables the user to determine RF environmental conditions of testing area. It 

indicates the multipath power with time delay in us up to six. 

 

The multipath profile is the result of portions of the original broadcast signal arriving at the receiving 

antenna out of phase. This can be caused by the signal being reflected off objects such as buildings, 

or being refracted through the atmosphere differently from the main signal. 

 

Setting measure setup 

After configuring test parameters as described in the “Configuring test parameters” on page 463, you 

can continue your measurement. 

 

Procedure 

1. Press the MEASURE SETUP hot key. 

2. Press the System Config soft key, and then do the following: 

a. Press the Bandwidth soft key, and then select the nominal channel bandwidth to be 

measured from the following choices: 

–  7 MHz (8/7): Sets the channel bandwidth to 7 MHz with sampling factor 8/7. In 

conjunction with nominal channel bandwidth 

–  8.75 MHz (8/7): Sets the channel bandwidth to 8.75 MHz with sampling factor 8/7 

–  10 MHz (28/25): Sets the channel bandwidth to 10 MHz with sampling factor 28/25 

b. Toggle the Frame Length soft key and select 5 ms or 10 ms. 

c. Press the TTG (RTG) soft key to set the transmit/receive transition gap between the last 

sample of the downlink burst and the first sample of the subsequent uplink burst. 

d. Enter a value by using the numeric keys, and then press the Enter soft key. 

e. Press the CP Ratio soft key, and then select the cyclic prefix ratio option: 1/4, 1/8, 1/16, or 
1/32. 
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f. Press the DL Symbols soft key to set the number of downlink symbols. 

g. Enter a value by using the numeric keys, and then press the Enter soft key. 

h. Press the UL Symbols soft key to set the number of uplink symbols. 

i. Enter a value by using the numeric keys, and then press the Enter soft key. 

3. Optional. Press the Miscellaneous soft key, and then do the following as needed: 

–  To set the delay, complete the following steps: 

a. Press the Delay soft key to set the amount of delay in µs. 

b. Enter a value by using the numeric keys. You can also use the rotary knob. 

c. Press the µs soft key. 

 

 

NOTE 

The Delay setting is used only when there is a time offset in the signals to be measured. 

4. Optional. Go to SAVE/LOAD > Save, and then select the save option from the choices available 

for your measurement mode. See “Using save” on page 33 for more information. 

 

Measurement example 

Figure 244 Multipath profile measurement with Mobile WiMAX OTA signal analyzer 

 

 

Preamble power trend 

The Preamble Power Trend shows power variations of a strongest preamble signal over time along 

with the relative power trend compare to total preamble power. Searching preamble index can be set 

auto to detect strongest or manual to search specific preamble. Positioning information, latitude, and 

longitude will be displayed if a GPS antenna is supplied and locked to the GPS satellites on the bottom 

of the screen. 

 

Setting measure setup 

After configuring test parameters as described in the “Configuring test parameters” on page 463, you 

can continue your measurement. 
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Procedure 

1. Press the MEASURE SETUP hot key. 

2. Press the System Config soft key, and then do the following: 

a. Press the Bandwidth soft key, and then select the nominal channel bandwidth to be 

measured from the following choices: 

–  7 MHz (8/7): Sets the channel bandwidth to 7 MHz with sampling factor 8/7. In 

conjunction with nominal channel bandwidth 

–  8.75 MHz (8/7): Sets the channel bandwidth to 8.75 MHz with sampling factor 8/7 

–  10 MHz (28/25): Sets the channel bandwidth to 10 MHz with sampling factor 28/25 

b. Toggle the Frame Length soft key and select 5 ms or 10 ms. 

c. Press the TTG (RTG) soft key to set the transmit/receive transition gap between the last 

sample of the downlink burst and the first sample of the subsequent uplink burst. 

d. Enter a value by using the numeric keys, and then press the Enter soft key. 

e. Press the CP Ratio soft key, and then select the cyclic prefix ratio option: 1/4, 1/8, 1/16, or 
1/32. 

f. Press the DL Symbols soft key to set the number of downlink symbols. 

g. Enter a value by using the numeric keys, and then press the Enter soft key. 

h. Press the UL Symbols soft key to set the number of uplink symbols. 

i. Enter a value by using the numeric keys, and then press the Enter soft key. 

3. Toggle the Preamble Index soft key and select the preamble search method: Auto or Manual. 

4. Optional. Press the Miscellaneous soft key, and then do the following as needed: 

–  To set the delay, complete the following steps: 

a. Press the Delay soft key to set the amount of delay in µs. 

b. Enter a value by using the numeric keys. You can also use the rotary knob. 

c. Press the µs soft key. 

 

 

NOTE 

The Delay setting is used only when there is a time offset in the signals to be measured. 

5. Optional. Go to SAVE/LOAD > Save, and then select the save option from the choices available 

for your measurement mode. See “Using save” on page 33 for more information. 
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Measurement example 

Figure 245 Preamble power trend with Mobile WiMAX OTA signal analyzer 

 

 

Route map 

The JD780A Series provides the Route Map function that allows you to collect data of points in an 

indoor or outdoor environment and track the received signals and coverage of RF transmitters by 

plotting data real time directly on top of a loaded floor plan or a map. 

 

Setting measure setup 

Procedure 

1. If required, connect a GPS receiver to your JD780A series for outdoor mapping. 
Indoor mapping does not necessarily need a GPS antenna. 

2. Configure test parameters as described in the “Configuring test parameters” on page 463. 

3. To load your map file, complete the following steps: 

a. Plug in your USB drive that has a floor map or .mcf file type created in JDMapCreator. . If 

the JDMapCreator application on your computer is connected to the instrument via USB or 
LAN, you can send a map file with a single layer to the instrument directly by using the 
Send to EQP menu in JDMapCreator. 

 

 

NOTE 

The JDMapCreator converts and resizes any scanned floor plan or layout to fit onto your 
instrument’s display. JDMapCreator 1.2.0 or later can save a multiple-layered map, 
providing x1, x2, and x4 views, as a sizable map file so that you can zoom in and out 

after loading it. 

b. Press SAVE/LOAD hot key, and then select Load > Load Map. 

See “Using load” on page 36 for more information. 

4. Press the MEASURE SETUP hot key. 

5. Press the Plot Point soft key, and then select the plot point option from the following choices: 

–  To collect data/plot points automatically as you move around in a vehicle or outside, press 
the GPS soft key and then toggle the Screen Mode soft key between Map and Full. 
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NOTE 
With the Map setting, you can view only the collected points that can be seen within the 

boundary of the loaded map. If a point is off the map, the instrument displays an arrow to 
indicate the direction of the current location on the map and the distance from the center 
to the location at the top of the screen. 
 
With the Full setting, you can view all the collected points of the route without the loaded 

map. 

–  To collect data/plot points manually without a GPS antenna in an indoor environment, press 
the Position soft key. 

6. Toggle the Plot soft key and select Start to start plotting. 

7. Touch directly on the screen or press the ENTER hard key to collect data and plot points on the 
loaded map for the Position setting. 

 

 

NOTE 
For the Position setting, you can change the direction of the route with the arrow keys 

and the distance with the rotary knob. 

8. Toggle the Plot soft key and select Stop to stop plotting. 

9. Press the SAVE/LOAD hot key to save the result. 
See “Using save” on page 33 for more information. 

 

 

NOTE 

The instrument does not automatically save the collected data. It is recommended that 
you save the result. Otherwise, you will lose all the collected data. 

 

 

Setting limit for route map 

You can set the thresholds for each test item. 

 

Procedure 

1. Press the LIMIT hot key. 

2. Press the Excellent soft key to set its threshold. 

3. Enter a value, and then press the Enter soft key. You can also use the rotary knob. 

4. Press the Very Good soft key to set its threshold. 

5. Enter a value, and then press the Enter soft key. You can also use the rotary knob. 

6. Press the Good soft key to set its threshold. 

7. Enter a value, and then press the Enter soft key. You can also use the rotary knob. 

8. Press the Fair soft key to set its threshold. 

9. Enter a value, and then press the Enter soft key. You can also use the rotary knob. 

10. Press the Poor soft key to set its threshold. 

11. Enter a value, and then press the Enter soft key. You can also use the rotary knob. 

12. Optional. Go to SAVE/LOAD > Save, and then select Save Limit to save the limit settings. 

See “Using save” on page 33 for more information. 
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Measurement example 

Figure 246 Route map measurement with Mobile WiMAX OTA signal analyzer 

 

 

Controlling a map 

If you have loaded a sizable map that was created in JDMapCreator 1.2.0 or later, you can use the 

Map Control feature that enables you to zoom into the map and view a specific area of interest in detail. 

 

Procedure 

1. Press the TRACE/DISPLAY hard key. 

2. Press the Map Control soft key. This key is active only when you have loaded a sizable map. 

3. Do one of the following: 

–  To zoom into an area of interest directly, complete the following steps: 

a. Toggle the Zoom to soft key and select Area. 

The black rectangle appears on the map. 

b. Press the Zoom In and Zoom Out soft keys, as you need, to decrease and increase 

the selected area. 

c. Move the rectangle by using the four arrow keys, as you need, to place it in a specific 
area of interest. 

d. Press the center of the rotary knob to zoom into the selected area. You can also press 
the Zoom to soft key again to zoom into the selected area. 

–  To zoom into the center or zoom out from the center, complete the following steps: 

a. Toggle the Zoom to soft key and select Center. 

b. Press the Zoom In and Zoom Out soft keys, as you need, to zoom in and zoom out. 

c. Move the zoomed-in area by using the four arrow keys, as you need. 
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Using Cable and Antenna Analyzer 

This chapter provides instructions for using the Cable and Antenna Analyzer function, which is 

available for the JD785A Base Station Analyzer and the JD786A RF Analyzer. Topics discussed in this 

chapter are as follows: 

 

 Introduction .............................................................................................................................. 498 

 Display overview ...................................................................................................................... 498 

 Selecting measurement mode ................................................................................................. 499 

 Configuring test parameters .................................................................................................... 499 

 Performing calibration .............................................................................................................. 501 

 Connecting a cable .................................................................................................................. 507 

 Performing reflection measurements....................................................................................... 509 

 Performing DTF measurements .............................................................................................. 510 

 Performing reflection-DTF measurements .............................................................................. 513 

 Performing cable loss (1 port) measurements ........................................................................ 514 

 Performing 1-port phase measurements ................................................................................. 516 

 Performing Smith chart measurements ................................................................................... 518 

 Performing 2-port vector measurements ................................................................................. 519 

 Performing 2-port scalar measurements ................................................................................. 520 

 Analyzing measurements ........................................................................................................ 521 
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Introduction 

The Cable and Antenna Analyzer is a diagnostic tool needed to accurately detect operational problems 

by performing cable and antenna measurements to verify the base station’s infrastructure, including 

feed lines, connectors, antennas, cables, jumpers, amplifiers, and filters. The JD785A Base Station 

Analyzer and the JD786A RF Analyzer have all of the measurement functions necessary to verify 

cable and antenna systems from Voltage Standing Wave Ratio (VSWR) to power measurements. In 

addition, the JD785A and the JD786A make distance-to-fault measurements to pinpoint a faulty 

location accurately. 

 

To get maximum power into a load it is required that the load impedance match the generator 

impedance. Any difference in impedance or mismatching would not produce maximum power transfer. 

An impedance mismatch at the antenna system produces a reflective ‘traveling wave’, which goes in 

the opposite direction from the incident wave. As the two traveling waves cross each other in opposite 

direction, it is produce an interference pattern called a "standing wave". VSWR is the ratio between the 

power sent forward to the cable and/or antenna and the amount of power that is reflected back to the 

transmitter. 

 

Some of the consequences of having a high VSWR condition in cellular services include dropped calls, 

poor reception, and an overall unacceptable performance in the cell (or section of cell) covered by the 

base station antenna. Therefore, the VSWR of the antenna system including the feed line is one of the 

most critical factors in the service and maintenance of the RF transmitter systems. 

 

This Cable and Antenna Analyzer function performs following measurements: 

 

 Reflection: VSWR and Return Loss 

 Distance to Fault (DTF): VSWR and Return Loss 

 Reflection-DTF (dual measurement) 

 2 Port Measurements: Vector and Scalar (Optional) 

 Cable Loss (1 Port) 

 1 Port Phase 

 Smith Chart 

 

Display overview 

Figure 247 provides descriptions for each segment of the measurement screen. 
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Figure 247 Reflection measurement screen 

 

 

Selecting measurement mode 

Procedure 

1. Press the MODE hard key. 

2. Press the Cable & Antenna Analyzer soft key. The Reflection (VSWR) mode is selected by 

default. 

3. To change the mode, press the MEASURE hot key and then select the measurement mode: 

–  Reflection (Return Loss) 

–  DTF (VSWR) 

–  DTF (Return Loss) 

–  Reflection-DTF 

–  Cable Loss (1 Port) 

–  1 Port Phase, Smith Chart 

–  2 Port Measurement (Vector/Scalar) 

 

Configuring test parameters 

Setting frequency  

You can set frequencies manually using the Start Frequency/Stop Frequency or Center 

Frequency/Span. You can also select from the band list stored in the instrument. It is recommended to 

set the frequency to a value that covers the normal range of the measurement with enough margins. 
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Procedure 

To set the start and stop frequencies: 

1. Press the FREQ/DIST hard key. 

2. Press the Start Frequency soft key. 

3. Enter a value by using the numeric keys. You can also use the rotary knob or the arrow keys. 

4. Select the unit: GHz, MHz, kHz, or Hz. 

5. Press the Stop Frequency soft key. 

6. Enter a value by using the numeric keys. You can also use the rotary knob or the arrow keys. 

7. Select the unit: GHz, MHz, kHz, or Hz. 
 
To set the center frequency and span: 

1. Press the FREQ/DIST hard key. 

2. Press the Center Frequency soft key. 

3. Enter a value by using the numeric keys. You can also use the rotary knob or the arrow keys. 

4. Select the unit: GHz, MHz, kHz, or Hz. 

5. Press the Span soft key. 

6. Enter a value by using the numeric keys. You can also use the rotary knob or the arrow keys. 

7. Select the unit: GHz, MHz, kHz, or Hz. 
 
To select the band from the band list: 

1. Press the FREQ/DIST hard key. 

2. Press the Band List soft key, and then select Standard Band or Custom Band. 

The band list window appears. 

3. Select a frequency band from the list, and then press the Select soft key. 

The start and stop frequency information on the screen changes according to your choice. 

 

Setting distance 

In the DTF measurement mode, you need to set the start and stop distances. The maximum 

measurable distance is displayed on the left side of the screen depending on the frequency setting. 

You can set any distance within the maximum measurable distance. Optimum resolution is achieved 

when the user setting distance is the same as the maximum measurable distance 

 

Procedure 

1. Press the FREQ/DIST hard key. 

2. Press the Start Distance soft key. 

3. Enter a value by using the numeric keys. You can also use the rotary knob or the arrow keys. 

4. Select the Enter soft key. 

5. Press the Stop Frequency soft key. 

6. Enter a value by using the numeric keys. You can also use the rotary knob or the arrow keys. 

7. Select the Enter soft key. 
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Adjusting scale 

You can adjust the Y-axis scale to optimize the display of measurement trace(s). Adjusting scale does 

not affect the calibration state. 

Procedure 

1. Press the AMP/SCALE hard key. 

2. Do one of the following choices: 

–  Press the Auto Scale to optimize the display of the measured trace by letting the 

instrument set the minimum and maximum values for the Y-axis automatically. 
Each time this key is pressed, the top and bottom scales are set to the minimum and 
maximum values with margin on the Y-axis of the chart. 

–  Press the Full Scale to restore the insturment’s default amplitude range for the Y-scale 

automatically. 

–  To set the minimum and maximum values for the Y-axis manually, complete the following 
steps: 

a. Press the Maximum (Top) soft key. 

b. Enter a value by using the numeric keys. 

c. Press the Enter soft key. 

d. Press the Minimum (Top) soft key. 

e. Enter a value by using the numeric keys. 

f. Press the Enter soft key. 

 

 

NOTE 

This setting is not used in the Smith Chart measurement mode. 

 

Setting sweep mode 

The default setting is Continue to sweep continuously for most on-going measurements. If you want to 

hold the measurement or get a single sweep, you can change the sweep mode. 

 

Procedure 

To select the single sweep mode: 

1. Press the SWEEP hot key. 

2. Toggle the Sweep Mode soft key and select Single. You can also use the HOLD hot key. 

The letter HOLD in red appears and the sweeping is paused. 

3. Optional. Press the Sweep Once soft key to get a new measurement. 
 
To return to the continuous sweep mode: 

1. Toggle the Sweep Mode soft key and select Continue. You can also use the HOLD hot key. 

The letter HOLD in red disappears and the sweeping resumes. 

 

Performing calibration 

To get reliable and accurate measurement results, you must perform a calibration on your instrument 

after setting frequencies and prior to making a measurement. To perform the calibration, you need to 

have the following ready: 
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 Calibration accessories (optional). 

 Mechanical Y-Cal kit or electronic EZ-Cal kit 

 Phase-stabilized test cable 

 

1-port calibration 

Measurement modes that need the 1-port calibration are Reflection, DTF, Cable Loss, 1 Port Phase, 

and Smith Chart. 

 

It is recommended that you perform an O-S-L calibration right at the Reflection/RF Out port of the 

instrument without using an extension cable in order to minimize a measurement error. If using an 

extension cable is inevitable, you need to use a phase stable cable and perform the O-S-L calibration 

at the open end of the extension cable. 

 

 

NOTE 

If the O-S-L calibration is done at the end of the port extension cable for DTF 
measurement, the length of the port extension cable is compensated automatically and is 
not included in the distance to the point of discontinuity. 
 
Bending or moving the extension cable while making a measurement may cause errors in 
the measurement. 

 

O-S-L calibration using mechanical Y-Cal kit 

Figure 248 illustrates the connection when a port extension cable is used for calibration. 

 

Figure 248 1-port calibration connection with mechanical Y-Cal kit 

 

 

Procedure 

1. Press the MEASURE SETUP hot key. 

2. Press the Calibrate soft key. 

The on-screen instruction for the calibration appears. 

3. Connect the OPEN connector of the CAL Kit directly to the Cable and Antenna Analyzer 
Reflection/RF Out port or at the end of the connected extension cable. 

4. Press the Continue soft key to start calibration.  

The calibration progress bar appears. 

5. Connect the SHORT connector of the CAL Kit directly to the Cable and Antenna Analyzer 
Reflection/RF Out port or at the end of the connected extension cable. 

6. Press the Continue soft key to continue calibration.  
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The calibration progress bar appears. 

7. Connect the LOAD connector of the CAL Kit directly to the Cable and Antenna Analyzer 
Reflection/RF Out port or at the end of the connected extension cable. 

8. Press the Continue soft key to continue calibration.  

The calibration progress bar appears. 
After completion, the calibration status on the screen changes to ON. 

 

O-S-L calibration using electronic EZ-Cal kit 

The e-Calibration is an Open-Short-Load calibration using the electronic EZ-Cal kit, which lets you 

perform the O-S-L calibration easy and fast with only one connection of the kit to the instrument. 

 

The O-S-L calibration must be performed after setting the frequencies and connecting an extension 

cable as like any mechanical calibration. Figure 249 illustrates the connection when a port extension 

cable is used for calibration. 

 

Figure 249 1-port calibration connection with electronic EZ-Cal kit 

 

 

Procedure 

1. Connect an extension cable, if necessary, to the Reflection/RF Out port of the instrument. 

2. Connect your EZ-Cal to the other open end of the extension cable or to your instrument's 
Reflection/RF Out port directly. 

3. Connect the USB cable to the side of the EZ-Cal and then to the USB Host port to power the 

e-calibration kit. 
The instrument detects the EZ-Cal automatically and displays the EZ-Cal icon. 

4. Press the MEASURE SETUP hot key. 

5. Press the Calibrate soft key. 

The on-screen instruction appears. to guide you through the e-calibration. 

6. Press the Continue soft key to continue calibration. 

The calibration progress bar appears. 
After completion, the calibration status on the screen changes to ON (E). 

7. Make sure to disconnect the EZ-Cal kit including its USB connection. 

 

Quick calibration in DTF 

The Quick calibration that is available only in the DTF measurement mode is useful when you want to 

measure the cable length only, without having to perform a full O-S-L calibration with a mechanical  

Y-Cal kit. 
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Procedure 

1. Press the MEASURE SETUP hot key. 

2. Press the Calibrate soft key. 

3. Connect the OPEN connector of your mechanical Y-Cal kit directly to the Reflection/RF Out port 

or at the end of the connected extension cable. 

4. Press the Quick Cal. soft key to start the quick calibration. 

The calibration status on the screen appears. 
After completion, the calibration status on the screen changes to ON (Q). 

 

2-port calibration 

Measurement modes that need the 2-port calibration are 2 Port Vector and Scalar measurements and 

2 Port Phase. You must perform 2-port calibration before making a measurement. 

 

O-S-L-Thru calibration using mechanical Y-Cal kit for vector measurements 

Figure 250 illustrates the connection using the Y-Cal kit for calibration in Vector measurements. 

Figure 250 2-port calibration connection with Y-Cal in vector measurements 

1) 

 

2) 

 

 

Procedure 

1. Press the MEASURE SETUP hot key. 

2. Press the Calibrate soft key. 

The on-screen instruction for the calibration appears. 

3. Connect the OPEN connector of the CAL Kit directly to the Cable and Antenna Analyzer 
Reflection/RF Out port or at the end of the connected test cable as illustrated in Figure 250-1. 

4. Press the Continue soft key to start calibration.  

The calibration progress bar appears. 

5. Connect the SHORT connector of the CAL Kit directly to the Cable and Antenna Analyzer 
Reflection/RF Out port or at the end of the connected test cable. 

6. Press the Continue soft key to continue calibration.  

The calibration progress bar appears. 

7. Connect the LOAD connector of the CAL Kit directly to the Cable and Antenna Analyzer 
Reflection/RF Out port or at the end of the connected test cable. 

8. Press the Continue soft key to continue calibration. 

The calibration progress bar appears. 

9. Connect the Reflection/RF Out port and the RF In port for the Cable and Antenna Analyzer with 
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the test cable and the proper adapter as illustrated in Figure 250-2. 

10. Press the Continue soft key to continue calibration.  

The calibration progress bar appears. 
After completion, the calibration status on the screen changes to ON. 

 

O-S-L-Thru calibration using electronic EZ-Cal kit for vector measurements 

Figure 251 illustrates the connection using the EZ-Cal kit for calibration in Vector measurements. 

Figure 251 2-port calibration connection with EZ-Cal in vector measurements 

1) 

 

2) 

 

 

Procedure 

1. Connect an extension cable, if necessary, to the Reflection/RF Out port of the instrument. 

2. Connect your EZ-Cal to the other open end of the extension cable or to your instrument's 
Reflection/RF Out port directly. 

3. Connect the USB cable to the side of the EZ-Cal and then to the USB Host port to power the 
e-calibration kit as illustrated in Figure 251-1. 

The instrument detects the EZ-Cal automatically and displays the EZ-Cal icon. 

4. Press the MEASURE SETUP hot key. 

5. Press the Calibrate soft key. 

The on-screen instruction appears to guide you through the e-calibration. 

6. When the O-S-L calibration is done, make sure to disconnect the EZ-Cal kit including its USB 
connection. 

7. Connect the Reflection/RF Out port and the RF In port for the Cable and Antenna Analyzer with 
the test cable and the proper adapter as illustrated in Figure 251-2. 

8. Press the Continue soft key to continue calibration. 

The calibration progress bar appears. 
After completion, the calibration status on the screen changes to ON. 

 

Scalar measurement 

Figure 252 illustrates the connection for calibration in Scalar measurements. 
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Figure 252 2-port calibration connection in Scalar measurements 

 

 

Procedure 

1. Press the MEASURE SETUP hot key. 

2. Press the Calibrate soft key. 

The on-screen instruction for the calibration appears. 

3. Connect the Reflection/RF Out port for the Cable and Antenna Analyzer and the RF In port for 
the Spectrum Analyzer with a test cable as illustrated in Figure 252. 

4. Press the Continue soft key to continue calibration.  

The calibration progress bar appears. 
After completion, the calibration status on the screen changes to ON. 

 

Calibration status indicators 

The instrument displays calibration status that is an important indicator to get reliable and accurate 

measurement results from CAA testing. The calibration status includes ON, ON (E), ON (I), ON (Q), 

OFF (T), and OFF. 

 

Table 21 Calibration status indicators 

Indicator(s) Description 

ON Indicates that a mechanical O-S-L calibration is performed using a Y-Cal kit and the 
instrument is ready to make a measurement. 

ON (E) Indicates that an electronic O-S-L calibration or e-calibration is performed using Viavi’s 
EZ-Cal kit and the instrument is ready to make a measurement. 

ON (I) 

 
Indicates that the frequency setting is changed within the frequency range registered 
for the O-S-L calibration and so the calibration is still valid. When the calibration status 
changes from ON to ON (I), re-calibration is not necessarily required. 

ON (Q) Indicates that quick calibration (Quick Cal) is performed. It is useful only if cable length 
measurement is needed. 

OFF (T) Indicates that the temperature registered during the calibration is changed by 
+/-10°C or greater. It is recommended that you perform a new O-S-L 
calibration to obtain accurate measurement results. When the temperature 
comes back within the registered range, the status may be changed to ON. 

OFF Indicates that the frequency setting is changed off the frequency range registered for 
the calibration. The calibration is no longer valid. 
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Connecting a cable 

Connecting a cable for reflection, DTF, 1-port phase, and Smith Chart 

measurements 

Procedure 

1. Connect the one end of the port extension cable to the Cable and Antenna Analyzer 
Reflection/RF Out port of the instrument. 

2. Connect the other end of the port extension cable to an antenna or feed line as illustrated in 
Figure 253. 

Measurement result is displayed on the screen. 

 

Figure 253 Connection for reflection measurement 

 

 

 

NOTE 

After calibration, do not change the connection of the port extension cable or the 
frequency setting. It may cause a measurement error. 
 
Changing any frequency settings will automatically turn the calibration status to OFF on 
the display screen, which requires re-calibration to proceed next measurement. 

 

 

CAUTION 
The maximum input power for the Cable and Antenna Analyzer Reflection/RF Out port 

is +25 dBm. Do not connect this port directly to the output port of the system to prevent 
degraded performance or malfunctioning. 

 

 

WARNING 

Do not attempt to connect the instrument to the antenna when there is a risk of lightning. 
Electric shock may cause malfunction of or damage to the instrument. 

 

Connecting a cable for cable loss (1 port) measurements 

Procedure 

1. Connect the one end of the cable under test to the Cable and Antenna Analyzer Reflection/RF 
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Out port of the instrument. 

2. Connect the SHORT standard of the Cal Kit to the other end of the cable under test as illustrated 

in Figure 254. 

Measurement result is displayed on the screen. 

 

Figure 254 Connection for cable loss (1 port) measurement 

 

 

Connecting a cable for 2-port vector measurements 

Procedure 

1. Connect the one end of the Thru test cable to the Cable and Antenna Analyzer Reflection/RF Out 
port of the instrument and the other end of the cable to DUT. 

2. Connect the DUT to the Cable and Antenna Analyzer RF In port of the instrument as illustrated 

in Figure 255. 

Measurement result is displayed on the screen. 

 

Figure 255 Connection for 2-port vector measurement 

 

 

 

CAUTION 
The maximum input power for the Cable and Antenna Analyzer RF In port is +25 dBm. 
However, a proper level of input to the Cable and Antenna Analyzer RF In port is 0 

dBm. When the input power is expected to be greater than 0 dBm, you must adjust the 
output power for the RF Out. 

 

Connecting a cable for 2-port scalar measurements 

Procedure 
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1. Connect the one end of the Thru test cable to the Cable and Antenna Analyzer Reflection/RF Out 
port of the instrument and the other end of the cable to DUT. 

2. Connect the DUT to the Spectrum Analyzer RF In port of the instrument as illustrated in Figure 

256. Measurement result is displayed on the screen. 

 

Figure 256 Connection for 2-port scalar measurement 

 

 

 

CAUTION 
The maximum input power for the Spectrum Analyzer RF In port is +20 dBm. 

 

Performing reflection measurements 

The Reflection measurement can be used to characterize cable and antenna system to ensure 

transmission line impedance performance and signal reflection characteristics of cell-site across a 

specific frequency range in voltage standing-wave ration (VSWR) or return loss. 

 

Making a measurement 

Procedure 

1. Make a proper cable connection as described in “Connecting a cable for reflection, DTF, 1-port 
phase, and Smith Chart measurements” on page 507. 

2. Press the MEASURE SETUP hot key. 

3. Press the Data Points soft key to change the resolution of your measurement, and then select 
the data point option: 126, 251, 501, 1001, and 2001. Changing the data point does not affect 

current calibration. 

 

 

NOTE 

The larger number you choose, the higher resolution you get and the longer the 
instrument takes to sweep and display results. Selecting the data point larger than what 
you need for a measurement will result in unnecessarily long sweep time. It is 
recommended that you select high resolution data points only for an instance of 
measuring wide frequency bands or requiring precise measurement data. 

4. Optional. To turn the bias tee on, complete the following steps: 

a. Toggle the Bias Tee soft key and select On. 

b. Enter a value between 12 and 32 with 0.1 V step. 
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c. Enter the V soft key. 

 

 

NOTE 

The instrument’s built-in bias tee function (option 002) supplies 12-32 VDC bias to active 
devices through the RF In port, eliminating the need of an external power supply. 

5. Optional. To select the output power, toggle the Output Power soft key between 0 dBm and -30 
dBm. 

 

 

NOTE 

When an amplifier’s reflection is measured, it is recommended that you change this 
output power level to -30 dBm and then re-calibrate. Changing to -30 dBm may result in 
reduced measurement dynamic range. 

6. Optional. To turn the interference rejection on, toggle the Interference Rej soft key between On 
and Off to enable or disable the feature. 

 

 

NOTE 

It is recommended that you use this feature only when you suspect interfering signals in 
the area as turning this on slows down the measurement. 

 

 

Measurement example 

Figure 257 Reflection measurement in return loss scale 

 

 

 

NOTE 
You can use the LIMIT hot key to analyze your measurements with the user-definable 

limit and Pass/Fail indication. See “Setting limit for cable and antenna analyzer” on page 
523 for more information. 

 

 

NOTE 
You can go to MEASURE SETUP > Zoom to view your measurements in detail with the 

user-definable zoom zones. See “Setting zoom zones” on page 522 for more information. 

 

Performing DTF measurements 

The Distance-To-Fault (DTF) measurement can be used to accurately identify fault locations in the 
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cell-site transmission (cable and feed line) system, indicating signal discontinuities in VSWR or return 

loss over distance in meter or foot. This measurement precisely pinpoints the location of such things 

as damaged or degraded antennas, connectors, amplifiers, filters, and duplexers. 

 

Making a measurement 

Procedure 

1. Make a proper cable connection as described in “Connecting a cable for reflection, DTF, 1-port 
phase, and Smith Chart measurements” on page 507. 

2. Press the MEASURE SETUP hot key. 

3. Press the Data Points soft key to change the resolution of your measurement, and then select 
the data point option: 126, 251, 501, 1001, and 2001. Changing the data point does not affect 

current calibration. 

 

 

NOTE 

The larger number you choose, the higher resolution you get and the longer the 
instrument takes to sweep and display results. Selecting the data point larger than what 
you need for a measurement will result in unnecessarily long sweep time. It is 
recommended that you select high resolution data points only for an instance of 
measuring wide frequency bands or requiring precise measurement data. 

4. Press the DTF Settings soft key, and then do the following: 

–  To select a cable from the list, complete the following steps: 

a. Press the Cable List soft key, and then select Standard Cable or Custom Cable. 

The cable list window appears. 

b. Select a cable by using the rotary knob or the Page Up/Page Down soft keys. 

c. Press the Select soft key. 

d. Optional. In the standard cable list window, press the Add to Custom soft key to add 

the selected cable to the custom list. 

–  To define a new cable, complete the following steps: 

a. Press the Prop Velocity soft key to define the cable’s relative propagation delay. 

b. Enter a value by using the numeric keys. You can also use the rotary knob. 

c. Press the Enter soft key. 

d. Press the Cable Loss soft key to define the cable’s cable loss. 

e. Enter a value by using the numeric keys. You can also use the rotary knob. 

f. Press the Enter soft key. 

 

 

NOTE 

The propagation velocity affects the calucation of the distance and the cable loss does 
the peak level of the discontinuity in a DTF measurement. 

 

–  Toggle the Metrics soft key and select the unit option for the X-axis: Meter or Foot. 

–  Press the Windowing soft key, and then select the video filtering option: Rectangular, 
Blackman, Nominal Side Lobe, Low Side Lobe, or Minimum Side Lobe. 

5. Optional. To turn the bias tee on, complete the following steps: 

a. Toggle the Bias Tee soft key and select On. 

b. Enter a value between 12 and 32 with 0.1 V step. 

c. Enter the V soft key. 
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NOTE 

The instrument’s built-in bias tee function (option 002) supplies 12-32 VDC bias to active 
devices through the RF In port, eliminating the need of an external power supply. 

6. Optional. To select the output power, toggle the Output Power soft key between 0 dBm and  
-30 dBm. 

 

 

NOTE 

When an amplifier’s reflection is measured, it is recommended that you change this 
output power level to -30 dBm and then re-calibrate. Changing to -30 dBm may result in 
reduced measurement dynamic range. 

7. Optional. To turn the interference rejection on, toggle the Interference Rej soft key between  
On and Off to enable or disable the feature. 

 

 

NOTE 

It is recommended that you use this feature only when you suspect interfering signals in 
the area as turning this on slows down the measurement. 

 

 

Measurement example 

Figure 258 DTF measurement 

 

 

 

NOTE 
You can use the LIMIT hot key to analyze your measurements with the user-definable 
limit and Pass/Fail indication. See “Setting limit for cable and antenna analyzer” on page 
523 for more information. 
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Figure 259 DTF measurement with the alternate DTF band on 

 

 

 

NOTE 
You can go to MEASURE SETUP > Alternate DTF Band Settings to scale down a 

specific sub-band. See “Setting alternate DTF band” on page 522 for more information. 

 

Performing reflection-DTF measurements 

You can view two measurement results simultaneously on the screen as you configure each 

measurement setting. 

 

Making a measurement 

Procedure 

1. Make a proper cable connection as described in “Connecting a cable for reflection, DTF, 1-port 
phase, and Smith Chart measurements” on page 507. 

2. Press the MEASURE SETUP hot key. 

3. Toggle the Active Window soft key between Top and Bottom and select the window to be 

active for setting. 

4. Press the Dual Config soft key, and then select the dual configuration option: 

–  To select the measurement mode for the top window, press the Top soft key, and then 
select Reflection (VSWR) or Reflection (Return Loss). 

–  To select the measurement mode for the bottom window, press the Bottom soft key, and 
then select DTF (VSWR) or DTF (Return Loss). 

–  To configure DTF settings for the bottom window, select Bottom > DTF Settings. 

See “Performing DTF measurements” on page 510 for more information. 

–  To set the alternate DTF band settings for the bottom window, select Bottom > Alt DTF 
Band Settings. See “Setting alternate DTF band” on page 522 for more information. 

 

 

NOTE 

See “Performing reflection measurements” and “Performing DTF measurements” for 
more information on how to set other measurement setup parameters for the Reflection-
DTF measurement. 
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Measurement example 

Figure 260 Reflection-DTF dual measurement 

1) Alt DTF band off: 

 

 

2) Alt DTF band on: 

 

 

 

NOTE 

You can use the LIMIT hot key to analyze your measurements with the user-definable 
limit and Pass/Fail indication. See “Setting limit for cable and antenna analyzer” on page 
523 for more information. 

 

Performing cable loss (1 port) measurements 

The Cable Loss (1 Port) measurement quantifies signal loss through a cable or other device over a 

defined frequency range by range by connecting one end of the cable to the instrument measurement 

port and terminating the other end of the cable with a short, or leaving it open altogether. This 
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measurement can be particularly useful in measuring the loss of feed line connected to the antenna. 

 

Making a measurement 

Procedure 

1. Make a proper cable connection as described in “Connecting a cable for cable loss (1 port) 
measurements” on page 507. 

2. Press the MEASURE SETUP hot key. 

3. Press the Data Points soft key to change the resolution of your measurement, and then select 
the data point option: 126, 251, 501, 1001, and 2001. Changing the data point does not affect 

current calibration. 
 

 

NOTE 

The larger number you choose, the higher resolution you get and the longer the 
instrument takes to sweep and display results. Selecting the data point larger than what 
you need for a measurement will result in unnecessarily long sweep time. It is 
recommended that you select high resolution data points only for an instance of 
measuring wide frequency bands or requiring precise measurement data. 

4. Optional. To turn the bias tee on, complete the following steps: 

a. Toggle the Bias Tee soft key and select On. 

b. Enter a value between 12 and 32 with 0.1 V step. 

c. Enter the V soft key. 
 

 

NOTE 

The instrument’s built-in bias tee function (option 002) supplies 12-32 VDC bias to active 
devices through the RF In port, eliminating the need of an external power supply. 

 

 

 

NOTE 

See “Performing reflection measurements” for more information on how to set other 
measurement setup parameters for the Cable Loss (1 Port) measurement. 

 

Measurement example 

Figure 261 Cable loss (1 port) measurement 
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NOTE 
You can use the LIMIT hot key to analyze your measurements with the user-definable 
limit and Pass/Fail indication. See “Setting limit for cable and antenna analyzer” on page 
523 for more information. 

 

Figure 262 Cable loss (1 port) measurement with the zone enabled 

 

 

 

NOTE 
You can go to MEASURE SETUP > Zoom to view your measurements in detail with the 

user-definable zoom zones. See “Setting zoom zones” on page 522 for more information. 

 

Performing 1-port phase measurements 

The 1-port Phase measurement is used to measure S11 phase to tune antennas and to phase-match 

cables. 

 

Making a measurement 

Procedure 

1. Make a proper cable connection as described in “Connecting a cable for reflection, DTF, 1-port 
phase, and Smith Chart measurements” on page 507. 

2. Press the MEASURE SETUP hot key. 

3. Press the Data Points soft key to change the resolution of your measurement, and then select 
the data point option: 126, 251, 501, 1001, and 2001. Changing the data point does not affect 

current calibration. 
 

 

NOTE 

The larger number you choose, the higher resolution you get and the longer the 
instrument takes to sweep and display results. Selecting the data point larger than what 
you need for a measurement will result in unnecessarily long sweep time. It is 
recommended that you select high resolution data points only for an instance of 
measuring wide frequency bands or requiring precise measurement data. 

4. Optional. To turn the bias tee on, complete the following steps: 

a. Toggle the Bias Tee soft key and select On. 

b. Enter a value between 12 and 32 with 0.1 V step. 
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c. Enter the V soft key. 
 

 

NOTE 

The instrument’s built-in bias tee function (option 002) supplies 12-32 VDC bias to active 
devices through the RF In port, eliminating the need of an external power supply. 

 

 

 

NOTE 

See “Performing reflection measurements” on page 509 for more information on how to 
set other measurement setup parameters for the Cable Loss (1 Port) measurement. 

 

Measurement example 

Figure 263 Cable loss (1 port) measurement 

 

 

Figure 264 Cable loss (1 port) measurement with zoom 
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NOTE 
You can use the LIMIT hot key to analyze your measurements with the user-definable 
limit and Pass/Fail indication. See “Setting limit for cable and antenna analyzer” on page 
523 for more information. 

 

 

NOTE 
You can go to MEASURE SETUP > Zone to view your measurements in detail with the 

user-definable zoom zones. See “Setting zoom zones” on page 522 for more information. 

 

Performing Smith chart measurements 

The Smith Chart measurement is used to measure DUTs’ impedance and phase to properly tune RF 

devices. Smith chart also displays impedance-matching characteristics in cable and antenna systems 

or filter and duplexer devices. 

 

Making a measurement 

Procedure 

1. Make a proper cable connection as described in “Connecting a cable for reflection, DTF, 1-port 
phase, and Smith Chart measurements” on page 507. 

2. Press the MEASURE SETUP hot key. 

3. Press the Data Points soft key to change the resolution of your measurement, and then select 
the data point option: 126, 251, 501, 1001, and 2001. Changing the data point does not affect 

current calibration. 

 

 

NOTE 

The larger number you choose, the higher resolution you get and the longer the 
instrument takes to sweep and display results. Selecting the data point larger than what 
you need for a measurement will result in unnecessarily long sweep time. It is 
recommended that you select high resolution data points only for an instance of 
measuring wide frequency bands or requiring precise measurement data. 

4. Optional. To turn the bias tee on, complete the following steps: 

a. Toggle the Bias Tee soft key and select On. 

b. Enter a value between 12 and 32 with 0.1 V step. 

c. Enter the V soft key. 

 

 

NOTE 

The instrument’s built-in bias tee function (option 002) supplies 12-32 VDC bias to active 
devices through the RF In port, eliminating the need of an external power supply. 

 

 

 

NOTE 

See “Performing reflection measurements” on page 509 for more information on how to 
set other measurement setup parameters for the Smith Chart measurement. 
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Measurement example 

Figure 265 Smith chart measurement 

 

 

Performing 2-port vector measurements 

The Vector measurement is used to perform faster and more accurate measurement with around 80 

dB dynamic range. It also provides antenna isolation measurement. You can determine DUT’s S21 

phase characteristic by selecting the measurement display type as Phase. 

 

Making a measurement 

Procedure 

1. Make a proper cable connection as described in “Connecting a cable for 2-port vector 
measurements” on page 508. 

2. Press the MEASURE SETUP hot key. 

3. Press the Data Points soft key to change the resolution of your measurement, and then select 
the data point option: 126, 251, 501, 1001, and 2001. Changing the data point does not affect 

current calibration. 

 

 

NOTE 

The larger number you choose, the higher resolution you get and the longer the 
instrument takes to sweep and display results. Selecting the data point larger than what 
you need for a measurement will result in unnecessarily long sweep time. It is 
recommended that you select high resolution data points only for an instance of 
measuring wide frequency bands or requiring precise measurement data. 

4. Toggle the Display soft key and select Magnitude to view measurements in dB or Phase in 

degree. 

5. Optional. To turn the bias tee on, complete the following steps: 

a. Toggle the Bias Tee soft key and select On. 

b. Enter a value between 12 and 32 with 0.1 V step. 

c. Enter the V soft key. 
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NOTE 

The instrument’s built-in bias tee function (option 002) supplies 12-32 VDC bias to active 
devices through the RF In port, eliminating the need of an external power supply. 

6. Optional. To select the output power, toggle the Output Power soft key between 0 dBm and -30 
dBm. 

 

 

NOTE 

When an amplifier’s reflection is measured, it is recommended that you change this 
output power level to -30 dBm and then re-calibrate. Changing to -30 dBm may result in 
reduced measurement dynamic range. 

7. Optional. To set the number of measurements to be averaged, press the Average soft key and 
then adjust the number between one and five by using the rotary knob. 

8. Optional. To turn the interference rejection on, toggle the Interference Rej soft key between On 
and Off to enable or disable the feature. 

 

 

NOTE 

It is recommended that you use this feature only when you suspect interfering signals in 
the area as turning this on slows down the measurement. 

 

 

Measurement example 

Figure 266 2-port vector measurement 

 

 

Performing 2-port scalar measurements 

The Scalar measurement enables full characterization of DUT with dynamics over 100 dB. 

 

Making a measurement 

Procedure 

1. Make a proper cable connection as described in “Connecting a cable for 2-port scalar 
measurements” on page 508. 

2. Press the MEASURE SETUP hot key. 
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3. Press the Data Points soft key to change the resolution of your measurement, and then select 
the data point option: 126, 251, 501, 1001, and 2001. Changing the data point does not affect 

current calibration. 

 

 

NOTE 

The larger number you choose, the higher resolution you get and the longer the 
instrument takes to sweep and display results. Selecting the data point larger than what 
you need for a measurement will result in unnecessarily long sweep time. It is 
recommended that you select high resolution data points only for an instance of 
measuring wide frequency bands or requiring precise measurement data. 

4. Optional. To select the output power, toggle the Output Power soft key between 0 dBm and -30 
dBm. 

 

 

NOTE 

When an amplifier’s reflection is measured, it is recommended that you change this 
output power level to -30 dBm and then re-calibrate. Changing to -30 dBm may result in 
reduced measurement dynamic range. 

 

 

Measurement example 

Figure 267 2-port scalar measurement 

 

 

Analyzing measurements 

Setting trace and display 

You can display up to six traces on the measurement chart simultaneously. 

 

Procedure 

1. Press the TRACE/DISPLAY hard key. 

2. Press the Select Trace soft key, and then select the trace number: T1, T2, T3, T4, T5, or T6. 

The legend shape of the selected trace changes from square to round to indicate that the trace is 
the active one now. 

3. Toggle the Trace View soft key and select On to display the selected trace. 
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4. To clear, write or capture, or hide the trace(s), do one of the following: 
 

To Select Trace Legend 

Clear current data and display with new 
measurements 

Clear Write W 

Capture the selected trace and compare traces Capture C 

Load a saved trace Load L 

Hide the selected trace Trace View > Off F 

Remove all the traces and initialize the trace 
settings 

Trace Clear All  

5. Optional. If you have at least two traces (T1 and T2), you can perform trace math: 

a. Press the Trace Math soft key. 

b. Press the T1 – T2 -> T5 or T2 – T1 -> T6 soft key. 

 

 

NOTE 

The trace to be loaded must be in the same measurement mode and has the same 
frequency setting as the current measurement. 

 

Setting zoom zones 

You can define up to three zoom-in zones so that you can view uplink and downlink frequencies in 

detail on a single measurement window for compliance verification. 

Procedure 

1. Press the MEASURE SETUP hot key. 

2. Press the Zoom soft key. 

3. To view a zoom zone in a separate chart, complete the following steps: 

a. Press the Zoom soft key, and then select the zone number to zoom in: Zone 1, Zone 2,  
or Zone 3. 

b. Toggle the Zoom soft key and select On. 

The zoom-in chart for the selected zone appears under the measurement result. 

4. To define a zone range, complete the following steps: 

a. Press the Zone [1|2|3] soft key to select an active zone. 

b. Toggle the Zone [1|2|3] soft key between On and Off to view or dismiss the active zone. 

c. Press the Start Frequency soft key. 

d. Enter a value by using the numeric keys. You can also use the rotary knob. 

e. Select the unit: GHz, MHz, kHz, or Hz. 

f. Press the Stop Frequency soft key. 

g. Enter a value by using the numeric keys. You can also use the rotary knob. 

h. Select the unit: GHz, MHz, kHz, or Hz. 

5. To clear all the zones, press the Clear All soft key. 

 

Setting alternate DTF band 

You can use the Alt DTF Band in DTF measurements to scale down a specific sub-band without a 



JD780A Series Analyzers 

 Using Cable and Antenna Analyzer 523 

need of an additional calibration. 

Procedure 

1. Press the MEASURE SETUP hot key. 

2. Press the Alt DTF Band Settings soft key. 

3. Toggle the Alt DTF Band soft key and select On or Off to enable or disable the alternate band 

feature. 

4. To set the start and stop distances for the alternate band, complete the following steps: 

a. Press the Start Distance soft key. 

b. Enter a value by using the numeric keys. You can also use the rotary knob or the arrow 
keys. 

c. Select the Enter soft key. 

d. Press the Stop Frequency soft key. 

e. Enter a value by using the numeric keys. You can also use the rotary knob or the arrow 
keys. 

f. Select the Enter soft key. 

5. To set the start and stop frequencies for the alternate band, complete the following steps: 

a. Press the Alternate Start Frequency soft key. 

b. Enter a value by using the numeric keys. You can also use the rotary knob or the arrow 
keys. 

c. Select the unit: GHz, MHz, kHz, or Hz. 

d. Press the Alternate Stop Frequency soft key. 

e. Enter a value by using the numeric keys. You can also use the rotary knob or the arrow 
keys. 

f. Select the unit: GHz, MHz, kHz, or Hz. 

6. To set the center and span frequencies for the alternate band, complete the following steps: 

a. Press the Alternate Center Frequency soft key. 

b. Enter a value by using the numeric keys. You can also use the rotary knob or the arrow 
keys. 

c. Select the unit: GHz, MHz, kHz, or Hz. 

d. Press the Alternate Span Frequency soft key. 

e. Enter a value by using the numeric keys. You can also use the rotary knob or the arrow 
keys. 

f. Select the unit: GHz, MHz, kHz, or Hz. 

 

Setting limit for cable and antenna analyzer 

Procedure 

1. Press the LIMIT hot key. 

2. Press the Multi Segment Line soft key for Pass/Fail indication. 

3. Toggle the Limit soft key between Upper and Lower to select the one to be displayed. 

4. Set the number of segments for the selected upper or lower limit line. You can set up to 50 
segments. 

a. Press the # of Line soft key. 

b. Enter a value between 1 and 50 by using the numeric keys. 
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c. Press the Enter soft key. 

5. Press the Autoset soft key to let the instrument set the limit for each segment and display the 

line. 

6. Optional. To move the limit line, complete the following steps: 

a. Select Limit Up/Down or Limit Left/Right. 

b. Turn the rotary knob to move the line as desired. You can also manually enter a value. 

7. Optional. To edit the segment properties, complete the following steps: 

a. Press the Edit Limit soft key. 

b. Press the Move soft key and then turn the rotary knob to select the segment to edit. 

c. Select the menu option, from the following choices: 

–  To hide the line for the selected segment, toggle the Line soft key and select Off. 

–  To add a new point, press the Add Point soft key. 

–  To delete the selected point, press the Delete Point soft key. 

–  To change the position, press the Frequency or Amplitude soft key, and then turn the 

rotary knob to change the value as desired. 

8. Optional. Go to SAVE/LOAD > Save, and then select Save Limit to save the limit settings. 

See “Using save” on page 33 for more information. 
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Using E1 Analyzer 

This chapter provides instructions for using the E1 Analyzer function (option 004). Topics discussed in 

this chapter are as follows: 

 

 Introduction .............................................................................................................................. 526 

 Display overview ...................................................................................................................... 526 

 Connecting a cable .................................................................................................................. 527 

 Monitoring transmission ........................................................................................................... 528 

 Performing BERT testing ......................................................................................................... 529 
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Introduction 

The European Conference of Postal and Telecommunications Administrations (CEPT) originally 

standardized the E-carrier system, which revised and improved the earlier American T-carrier 

technology, and this has now been adopted by the International Telecommunication Union 

Telecommunication Standardization Sector (ITU-T). 

 

E1 is transmitted physically as 32 timeslots, but one is used for framing and typically one allocated for 

signaling call setup and tear down. Unlike Internet data services, E-carrier systems permanently 

allocate capacity for a voice call for its entire duration. This ensures high call quality because the 

transmission arrives with the same short delay (Latency) and capacity at all times. 

 

This portable test instrument can be a useful tool to check the overall health of the transmission 

system and assist in locating the source of problems or defects. 

 

The E1 Analyzer function provides following measurements: 

 

 Monitoring 

 BERT Testing (PCM31 only) 

 

Display overview 

Figure 268 provides descriptions for each segment of the measurement screen. 

 

Figure 268 E1 analyzer screen 
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Connecting a cable 

Out-of-service testing 

Figure 269 Point-to-point connection 

 

 

Figure 270 Loop-back connection 

 

 

Figure 271 Error injection and measurement connection 

 

 

In-service monitoring 

Figure 272 In-service connection 
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Monitoring transmission 

Making a test 

Procedure 

To select the measurement mode: 

1. Press the MODE hard key. 

2. Press the E1/T1 Analyzer soft key. 

3. Select E1 Analyzer > Monitoring. 
 
To configure measurement parameters: 

1. Press the MEASURE SETUP hot key. 

2. Press the RX Mode soft key, and then select the receiver input option from the following choices: 

–  Terminate: Provides 120-ohm nominal input impedance, according to the framing and line 

code settings. 

–  Bridge: Provides input impedance greater than one kilohm for in-service monitoring, 

bridging the receiver input across lines that are terminated elsewhere in the network. 

–  Monitor: Provides 120-ohm nominal input impedance for the in-service monitoring of E1 

lines. 

3. Toggle the Framing soft key between PCM30 and PCM31 and select the framing type for your 

receiver setting: 

–  PCM30: Timeslots from 1 to 15 correspond to channels from 1 to 15 and timeslots from 17 

to 31 to channels from 16 to 30. Timeslot 16 is for the multi-frame alignment and Channel 
Associated Signaling (CAS). 

–  PCM31: Timeslots from 1 to 31 correspond to channels from 1 to 31. 

 

 

NOTE 

If the framing type does not match with your receiver setting, a framing alarm occurs. 

4. Toggle the Line Code soft key between AMI and HDB3 and select the line code type to send an 

E1 signal: 

–  AMI: It stands for Alternate Mark Inversion. A line code uses one three level signal to 

convey binary digits in which successive binary ones (“marks” or pulses) are of alternating 
polarity, either positive or negative, equal in amplitude. A binary zero (“space”) is 
transmitted as no pulse or zero amplitude. 

–  HDB3: It stands for High Density Bipolar order 3 encoding. It is a bipolar signaling 

technique (using both positive and negative pulses) based on the AMI. It extends AMI by 
inserting violation codes whenever there is a run of four or more zeros. 

 
To start or stop monitoring: 

1. Press the MEASURE hot key. 

2. Press the Monitoring soft key, and then select the monitoring option as needed: Start, Stop, or 
Clear. 

 
Optional. You can save event records automatically by using the Save Logging Data soft key. See 

“Using save” on page 33 for more information. 
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Measurement example 

Figure 273 E1 transmission monitoring for framing PCM30 

 

 

 

NOTE 

Bit Error is not supported for the framing type PCM30. 

 

Performing BERT testing 

There are three RX modes available for the BERT testing. 

 

 Terminate Mode: The Terminate mode is used when you wish to send and receive an E1 

signal. The instrument terminates the received signal with a low impedance termination, and 

requires that the circuit be disrupted for testing. 

 Bridge Mode: The Bridge mode is similar to the monitor mode. However, in the Bridge mode, 

the instrument applies high impedance isolation resistors to the circuit under test. This 

isolation circuitry will protect the signal from any possible disruption. There is no need to plug 

into the TX jack of the test set while in the Bridge mode, and there is no need to specify a test 

pattern to be transmitted. However, the transmitter in the test set is sending the selected test 

pattern, framing, coding, and CRC. 

 Monitor Mode: The Monitor (protected monitoring point) mode is used when a monitor access 

is to be made. The network element has isolated the MON signal from the live signal with high 

impedance resistors. It is useful that it protects the live signal from any possible disruptions 

caused by the testing process. 

 

Making a test 

Procedure 

To select the measurement mode: 

1. Press the MODE hard key. 

2. Press the E1/T1 Analyzer soft key. 

3. Select E1 Analyzer > BERT. 
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To configure measurement parameters: 

1. Press the MEASURE SETUP hot key. 

2. Press the RX Mode soft key, and then select the receiver input option from the following choices: 

–  Terminate: Provides 120-ohm nominal input impedance, according to the framing and line 

code settings. 

–  Bridge: Provides input impedance greater than one kilohm for in-service monitoring, 

bridging the receiver input across lines that are terminated elsewhere in the network. 

–  Monitor: Provides 120-ohm nominal input impedance for the in-service monitoring of E1 

lines. 

3. Toggle the Framing soft key between PCM30 and PCM31 and select the framing type for your 

receiver setting: 

–  PCM30: Timeslots from 1 to 15 correspond to channels from 1 to 15 and timeslots from 17 

to 31 to channels from 16 to 30. Timeslot 16 is for the multi-frame alignment and Channel 
Associated Signaling (CAS). 

–  PCM31: Timeslots from 1 to 31 correspond to channels from 1 to 31. 

 

 

NOTE 

If the framing type does not match with your receiver setting, a framing alarm occurs. 

4. Toggle the Line Code soft key between AMI and HDB3 and select the line code type to send an 

E1 signal: 

–  AMI: It stands for Alternate Mark Inversion. A line code uses one three level signal to 

convey binary digits in which successive binary ones (“marks” or pulses) are of alternating 
polarity, either positive or negative, equal in amplitude. A binary zero (“space”) is 
transmitted as no pulse or zero amplitude. 

–  HDB3: It stands for High Density Bipolar order 3 encoding. It is a bipolar signaling 

technique (using both positive and negative pulses) based on the AMI. It extends AMI by 
inserting violation codes whenever there is a run of four or more zeros. 

5. Press the Pattern soft key, and then select the stress pattern option from the following choices: 

–  1-4: A four-bit pattern that contains a single one, being used to test clock recovery. 

–  1-8: An eight-bit pattern that contains a single one, being used to test clock recovery. 

–  All 1’S: A pattern that causes line drivers to consume the maximum power. 

–  All 0’S: A pattern that is often selected to verify HDB3 provisioning. Circuit will drop if 

optioned for AMI. 

–  Alternate: A pattern that alternates between ones and zeroes. 

6. Toggle the TX Clock soft key between Internal and RX and select the timing source option to 

measure frequency and timing: 

–  Internal: Internal clock uses an internal oscillator in case of external reference is not 

available and the instrument does not transmit signal to synchronized equipment. The 
instrument provides the clock to the unit under test and most cases in Loopback test mode. 

–  RX: Transmit clock uses the frequency recovered from the received signal (Network Loop), 

if accurate frequency measurement is required. 

7. Toggle the TX LBO soft key between 0 dB and -6 dB and select the level for TX Line Build Out. 

8. Toggle the CRC-4 soft key between On and Off to activate or deactivate the CRC-4. 

 

 

NOTE 

CRC-4 is used to detect errors in blocks of data transmitted across communication links. 
The detection is determined by a formula applied at both ends of transmit and receive. E1 
uses a four-bit CRC (CRC-4) for error checking. 

 
To start or stop testing: 
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1. Press the MEASURE hot key. 

2. Press the BERT soft key, and then select the testing option as needed: Start, Stop, or Clear. 
 
To select the error injection type: 

1. Press the Error Injection soft key, and then select the error injection type: None, 1E-3, 1E-4, 
1E-5, or Single. 

 
Optional. You can save event records automatically by using the Save Logging Data soft key. See 

“Using save” on page 33 for more information. 

 

Measurement example 

Figure 274 E1 BERT testing for framing PCM30 

 

 

 

NOTE 

Bit Error is not supported for the framing type PCM30. 
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Using T1 Analyzer 

This chapter provides instructions for using the T1 Analyzer function (option 005). Topics discussed in 

this chapter are as follows: 

 

 Introduction .............................................................................................................................. 533 

 Display overview ...................................................................................................................... 533 

 Connecting a cable .................................................................................................................. 534 

 Monitoring transmission ........................................................................................................... 535 

 Performing BERT testing ......................................................................................................... 536 

 Performing RX signal testing ................................................................................................... 538 

 Performing loop testing ............................................................................................................ 540 
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Introduction 

The T1 is what telephone companies have traditionally used to transport digitized telephone 

conversations between central offices. As early as the 1960’s, a single T1 circuit made it possible for a 

telephone company to deliver 24 high quality voice conversations. T1 is a fully digitalized service with 

no possibility of crosstalk, which is common in analog carrier networks where copper pairs pickup 

emissions from neighboring pairs. Significant increases in noise immunity were also achieved by 

adopting this new digital transmission standard. 

 

Since the early 1980’s, T1 service has been available to private industry throughout the country. This 

document will discuss the various types of T1 measurement items, how to measure them, and 

understand the general guidelines of T1 analysis using the JD785A Base Station Analyzer. 

 

This portable test instrument can be a useful tool to check the overall health of the transmission 

system and assist in locating the source of problems or defects. The T1 Analyzer function provides 

following measurements: 

 

 Monitoring 

 RX Signal Level 

 BERT Testing 

 Loop Testing 

 

Display overview 

Figure 275 provides descriptions for each segment of the measurement screen. 

 

Figure 275 T1 analyzer screen 
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Connecting a cable 

Out-of-service testing 

Figure 276 Point-to-point connection 

 

 

Figure 277 Loop-back connection 

 

 

Figure 278 Error injection and measurement connection 

 

 

In-service monitoring 

Figure 279 In-service connection 
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Monitoring transmission 

Making a test 

Procedure 

To select the measurement mode: 

1. Press the MODE hard key. 

2. Press the E1/T1 Analyzer soft key. 

3. Select T1 Analyzer > Monitoring. 
 
To configure measurement parameters: 

1. Press the MEASURE SETUP hot key. 

2. Press the RX Mode soft key, and then select the receiver input option from the following choices: 

–  Terminate: Provides 100-ohm nominal input impedance, according to the framing, line 

code, and BER pattern settings. 

–  Bridge: Provides input impedance greater than one kilohm for in-service monitoring, 

bridging the receiver input across lines that are terminated elsewhere in the network. 

–  Monitor: Provides 100-ohm nominal input impedance for the in-service monitoring of T1 

lines. 

3. Toggle the Framing soft key between SF-D4 and ESF and select the framing type for your 

receiver setting: 

–  SF-D4 (Super Frame-D4): Group of 12 frames, used to align equipment for framing. 

–  ESF (Extended Super Frame): Group of 24 frames, used to align equipment for framing. 

4K for a maintenance channel (Facilities Data Link), 2K for CRC-6 checksum, and 2K for 
framing/synchronization. 

 

 

NOTE 

If the framing type does not match with your receiver setting, a framing alarm occurs. 

4. Toggle the Line Code soft key between AMI and B8ZS and select the line code type to send an 

T1 signal: 

–  AMI: It stands for Alternate Mark Inversion. A line code uses one three level signal to 

convey binary digits in which successive binary ones (“marks” or pulses) are of alternating 
polarity, either positive or negative, equal in amplitude. A binary zero (“space”) is 
transmitted as no pulse or zero amplitude. 

–  B8ZS: It stands for Bipolar with 8-Zero Substitution. A coding scheme in which the 

transmitter "substitutes" a fixed pattern of ones, zeros, and BPVs in place of 8 consecutive 
zeros. 

 
To start or stop monitoring: 

1. Press the MEASURE hot key. 

2. Press the Monitoring soft key, and then select the monitoring option as needed: Start, Stop, or 
Clear. 

 
Optional. You can save event records automatically by using the Save Logging Data soft key. See 

“Using save” on page 33 for more information. 
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Measurement example 

Figure 280 T1 transmission monitoring 

 

 

Performing BERT testing 

Making a test 

Procedure 

To select the measurement mode: 

1. Press the MODE hard key. 

2. Press the E1/T1 Analyzer soft key. 

3. Select T1 Analyzer > BERT. 
 
To configure measurement parameters: 

1. Press the MEASURE SETUP hot key. 

2. Press the RX Mode soft key, and then select the receiver input option from the following choices: 

–  Terminate: Provides 100-ohm nominal input impedance, according to the framing, line 

code, and BER pattern settings. 

–  Bridge: Provides input impedance greater than one kilohm for in-service monitoring, 

bridging the receiver input across lines that are terminated elsewhere in the network. 

–  Monitor: Provides 100-ohm nominal input impedance for the in-service monitoring of T1 

lines. 

3. Toggle the Framing soft key between SF-D4 and ESF and select the framing type for your 

receiver setting: 

–  SF-D4 (Super Frame-D4): Group of 12 frames, used to align equipment for framing. 

–  ESF (Extended Super Frame): Group of 24 frames, used to align equipment for framing. 

4K for a maintenance channel (Facilities Data Link), 2K for CRC-6 checksum, and 2K for 
framing/synchronization. 

 

 

NOTE 

If the framing type does not match with your receiver setting, a framing alarm occurs. 
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4. Toggle the Line Code soft key between AMI and B8ZS and select the line code type to send an 

T1 signal: 

–  AMI: It stands for Alternate Mark Inversion. A line code uses one three level signal to 

convey binary digits in which successive binary ones (“marks” or pulses) are of alternating 
polarity, either positive or negative, equal in amplitude. A binary zero (“space”) is 
transmitted as no pulse or zero amplitude. 

–  B8ZS: It stands for Bipolar with 8-Zero Substitution. A coding scheme in which the 

transmitter "substitutes" a fixed pattern of ones, zeros, and BPVs in place of 8 consecutive 
zeros. 

5. Press the Pattern soft key, and then select the stress pattern option from the following choices: 

–  1-8: An eight-bit pattern that contains a single one, being used to test clock recovery. 

–  1-16: A sixteen-bit pattern that contains a single one, being used to test clock recovery. 

–  All 1’S: A pattern that causes line drivers to consume the maximum power. 

–  All 0’S: A pattern that is often selected to verify HDB3 provisioning. Circuit will drop if 

optioned for AMI. 

–  Alternate: A pattern that alternates between ones and zeroes. 

–  3-24: A twenty-four bit-pattern containing 3 ones with the longest length of consecutive 

zeroes constrained to fifteen. It has ones density of 12.5% and is used to check clock 
recovery. 

–  QRSS: A pseudorandom pattern that is a common test pattern and simulates live traffic on 

a circuit. 

–  2e23: A pseudorandom pattern based on a 23 bit shift register. 

–  2e15: A pseudorandom pattern based on a 15 bit shift register. 

–  2e23 INV: Bit inversed pseudorandom pattern based on a 23 bit shift register. 

–  2e15 INV: Bit inversed pseudorandom pattern based on a 15 bit shift register. 

6. Toggle the TX Clock soft key between Internal and RX and select the timing source option to 

measure frequency and timing: 

–  Internal: Internal clock uses an internal oscillator in case of external reference is not 

available and the instrument does not transmit signal to synchronized equipment. The 
instrument provides the clock to the unit under test and most cases in Loopback test mode. 

–  RX: Transmit clock uses the frequency recovered from the received signal (Network Loop), 

if accurate frequency measurement is required. 

7. Press the TX LBO soft key, and then select the level for TX Line Build Out option from the 

following choices: 

–  0 dB: Is used in most cases including that the test set is connected to the DSX front panel, 

to CSU, to NIU or Channel Bank or that the cabling is less than about 130 feet in-between 
test set and DSX. 

–  -7.5 dB: Is used in cases that attenuation is needed where the T1 line is series connected 

to 7.5 dB attenuator. 

–  -15 dB: Is used in cases that attenuation is needed where the T1 line is series connected to 

15 dB attenuator. 
 
To start or stop testing: 

1. Press the MEASURE hot key. 

2. Press the BERT soft key, and then select the testing option as needed: Start, Stop, or Clear. 
 
To select the error injection type: 

1. Press the Error Injection soft key, and then select the error injection type: None, 1E-3, 1E-4, 
1E-5, or Single. 
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To set the error injection optios: 

1. Press the Alarm Injection soft key. 

2. Toggle the AIS Alarm soft key between On and Off to enable or disable the Alarm Indication 

Signal. 

3. Toggle the RAI Alarm soft key between On and Off to enable or disable the Remote Alarm 

Indication. 

 
Optional. You can save event records automatically by using the Save Logging Data soft key. See 

“Using save” on page 33 for more information. 

 

Measurement example 

Figure 281 T1 BERT testing 

 

 

Performing RX signal testing 

Making a test 

Procedure 

To select the measurement mode: 

1. Press the MODE hard key. 

2. Press the E1/T1 Analyzer soft key. 

3. Select T1 Analyzer > RX Signal. 
 
To configure measurement parameters: 

1. Press the MEASURE SETUP hot key. 

2. Press the RX Mode soft key, and then select the receiver input option from the following choices: 

–  Terminate: Provides 100-ohm nominal input impedance, according to the framing, line 

code, and BER pattern settings. 

–  Bridge: Provides input impedance greater than one kilohm for in-service monitoring, 

bridging the receiver input across lines that are terminated elsewhere in the network. 



JD780A Series Analyzers 

 Using T1 Analyzer 539 

–  Monitor: Provides 100-ohm nominal input impedance for the in-service monitoring of T1 

lines. 

3. Toggle the Framing soft key between SF-D4 and ESF and select the framing type for your 

receiver setting: 

–  SF-D4 (Super Frame-D4): Group of 12 frames, used to align equipment for framing. 

–  ESF (Extended Super Frame): Group of 24 frames, used to align equipment for framing. 

4K for a maintenance channel (Facilities Data Link), 2K for CRC-6 checksum, and 2K for 
framing/synchronization. 

 

 

NOTE 

If the framing type does not match with your receiver setting, a framing alarm occurs. 

4. Toggle the Line Code soft key between AMI and B8ZS and select the line code type to send an 

T1 signal: 

–  AMI: It stands for Alternate Mark Inversion. A line code uses one three level signal to 

convey binary digits in which successive binary ones (“marks” or pulses) are of alternating 
polarity, either positive or negative, equal in amplitude. A binary zero (“space”) is 
transmitted as no pulse or zero amplitude. 

–  B8ZS: It stands for Bipolar with 8-Zero Substitution. A coding scheme in which the 

transmitter "substitutes" a fixed pattern of ones, zeros, and BPVs in place of 8 consecutive 
zeros. 

 
To start or stop testing: 

1. Press the MEASURE hot key. 

2. Press the RX Signal soft key, and then select the testing option as needed: Start, Stop, or 
Clear. 

 
Optional. You can save event records automatically by using the Save Logging Data soft key. See 

“Using save” on page 33 for more information. 

 

Measurement example 

Figure 282 T1 RX signal testing 
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Performing loop testing 

Making a test 

Procedure 

To select the measurement mode: 

1. Press the MODE hard key. 

2. Press the E1/T1 Analyzer soft key. 

3. Select T1 Analyzer > Loop Test. 
 
To configure measurement parameters: 

1. Press the MEASURE SETUP hot key. 

2. Press the RX Mode soft key, and then select the receiver input option from the following choices: 

–  Terminate: Provides 100-ohm nominal input impedance, according to the framing, line 

code, and BER pattern settings. 

–  Bridge: Provides input impedance greater than one kilohm for in-service monitoring, 

bridging the receiver input across lines that are terminated elsewhere in the network. 

–  Monitor: Provides 100-ohm nominal input impedance for the in-service monitoring of T1 

lines. 

3. Toggle the Framing soft key between SF-D4 and ESF and select the framing type for your 

receiver setting: 

–  SF-D4 (Super Frame-D4): Group of 12 frames, used to align equipment for framing. 

–  ESF (Extended Super Frame): Group of 24 frames, used to align equipment for framing. 

4K for a maintenance channel (Facilities Data Link), 2K for CRC-6 checksum, and 2K for 
framing/synchronization. 

 

 

NOTE 

If the framing type does not match with your receiver setting, a framing alarm occurs. 

4. Toggle the Line Code soft key between AMI and B8ZS and select the line code type to send an 

T1 signal: 

–  AMI: It stands for Alternate Mark Inversion. A line code uses one three level signal to 

convey binary digits in which successive binary ones (“marks” or pulses) are of alternating 
polarity, either positive or negative, equal in amplitude. A binary zero (“space”) is 
transmitted as no pulse or zero amplitude. 

–  B8ZS: It stands for Bipolar with 8-Zero Substitution. A coding scheme in which the 

transmitter "substitutes" a fixed pattern of ones, zeros, and BPVs in place of 8 consecutive 
zeros. 

5. Press the Pattern soft key, and then select the stress pattern option from the following choices: 

–  1-8: An eight-bit pattern that contains a single one, being used to test clock recovery. 

–  1-16: A sixteen-bit pattern that contains a single one, being used to test clock recovery. 

–  All 1’S: A pattern that causes line drivers to consume the maximum power. 

–  All 0’S: A pattern that is often selected to verify HDB3 provisioning. Circuit will drop if 

optioned for AMI. 

–  Alternate: A pattern that alternates between ones and zeroes. 

–  3-24: A twenty-four bit-pattern containing 3 ones with the longest length of consecutive 

zeroes constrained to fifteen. It has ones density of 12.5% and is used to check clock 
recovery. 

–  QRSS: A pseudorandom pattern that is a common test pattern and simulates live traffic on 

a circuit. 
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–  2e23: A pseudorandom pattern based on a 23 bit shift register. 

–  2e15: A pseudorandom pattern based on a 15 bit shift register. 

–  2e23 INV: Bit inversed pseudorandom pattern based on a 23 bit shift register. 

–  2e15 INV: Bit inversed pseudorandom pattern based on a 15 bit shift register. 

6. Toggle the TX Clock soft key between Internal and RX and select the timing source option to 

measure frequency and timing: 

–  Internal: Internal clock uses an internal oscillator in case of external reference is not 

available and the instrument does not transmit signal to synchronized equipment. The 
instrument provides the clock to the unit under test and most cases in Loopback test mode. 

–  RX: Transmit clock uses the frequency recovered from the received signal (Network Loop), 

if accurate frequency measurement is required. 

7. Press the TX LBO soft key, and then select the level for TX Line Build Out option from the 

following choices: 

–  0 dB: Is used in most cases including that the test set is connected to the DSX front panel, 

to CSU, to NIU or Channel Bank or that the cabling is less than about 130 feet in-between 
test set and DSX. 

–  -7.5 dB: Is used in cases that attenuation is needed where the T1 line is series connected 

to 7.5 dB attenuator. 

–  -15 dB: Is used in cases that attenuation is needed where the T1 line is series connected to 

15 dB attenuator. 

8. Press the Loop Codes soft key, and then do one of the following option: 

–  To select the link option, toggle press the Link soft key between Inband and Datalink. 

Datalink is used when the framing is set to ESF. 

–  To select the Channel Service Unit, press the CSU soft key. 

–  To select the Network Interface Unit, press the NIU soft key. 
 
To start or stop testing: 

1. Press the MEASURE hot key. 

2. Press the Loop Test soft key, and then select the testing option as needed: Start, Stop, or 
Clear. 

 
To activate or deactiave the external loop back: 

1. Press the Remote Loop Up to activate the external loop back so that the instrument sends the 

system a request of the loop back mode. 

2. Press the Remote Loop Dn to deactivate the external loop back so that the instrument sends 

the system a request to clean the loop back mode. 
 
To activate or deactiave the internal loop back: 

1. Press the Self Loop Up to activate the internal loop back. 

2. Press the Self Loop Dn to deactivate the internal loop back, reverting the instrument to a 

through mode. 
 
To select the error injection type: 

1. Press the Error Injection soft key, and then select the error injection type: None, 1E-3, 1E-4, 
1E-5, or Single. 

 
To set the error injection optios: 

1. Press the Alarm Injection soft key. 

2. Toggle the AIS Alarm soft key between On and Off to enable or disable the Alarm Indication 

Signal. 
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3. Toggle the RAI Alarm soft key between On and Off to enable or disable the Remote Alarm 

Indication. 

 
Optional. You can save event records automatically by using the Save Logging Data soft key. See 

“Using save” on page 33 for more information. 

 

Measurement example 

Figure 283 T1 loop testing 
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Using Channel Scanner 

This chapter provides instructions for using the Channel Scanner function (option 012). Topics 

discussed in this chapter are as follows: 

 

 Introduction .............................................................................................................................. 544 

 Display overview ...................................................................................................................... 544 

 Connecting a cable .................................................................................................................. 544 

 Selecting measurement mode ................................................................................................. 546 

 Configuring test parameters .................................................................................................... 546 

 Making channel scanner measurements ................................................................................. 549 

 Making frequency scanner measurements ............................................................................. 550 

 Making custom scanner measurements .................................................................................. 551 

 Analyzing measurements ........................................................................................................ 553 
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Introduction 

A Channel Scanner is a radio receiver that can automatically tune or scan two or more discrete 

frequencies and multi-channels, indicating when it finds a signal on one of them and then continuing 

scanning when that frequency goes silent. 

 

You can measure up to 20 channels with this channel scanner. Using existing format-based or custom 

parameters, you will be able to easily verify improper multi-channel power levels. 

 

 Channel Scanner 

 Frequency Scanner 

 Custom Scanner (Channel or Frequency) 

 

Display overview 

Figure 284 provides descriptions for each segment of the measurement screen. 

 

Figure 284 Channel scanner screen 

 

 

Connecting a cable 

Direct connection 

Procedure 

1. Connect the Spectrum Analyzer RF In port of the JD780A series and the Power amplifier output 

port of BTS. 
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Figure 285 Direct connection 

 
JD785A/JD786A 

 
JD788A 

 

Indirect connection 

Procedure 

1. Connect the Spectrum Analyzer RF In port of the JD780A series and the monitor (test) port of 

BTS. 

 

Figure 286 Indirect connection 

 
JD785A/JD786A 

 
JD788A 

 

 

CAUTION 
The maximum power for the Spectrum Analyzer RF In port is +25 dBm (0.316 W). If the 
input signal level to be measured is greater than +25 dBm, use a High Power 
Attenuator to prevent damage when you directly connect the signal to the instrument or 
connect the signal from the coupling port of a directional coupler. 

 

Over the air (OTA) 

Procedure 

1. Connect an Omni/directional RF antenna to the Spectrum Analyzer RF In port of the JD780A 

series. 

2. Connect a GPS antenna to the GPS port of the JD780A series. 
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Figure 287 OTA connection 

 
JD785A/JD786A 

 
JD788A 

 

 

CAUTION 

If the input signal level to be measured is less than 0 dBm, set 0 dB attenuation or turn on 
the preamp to have better dynamic range for the OTA testing. 

 

Selecting measurement mode 

Procedure 

1. Press the MODE hard key. 

2. Press the Channel Scanner soft key. The Channel Scanner mode is selected by default. 

3. To change the measurement mode, press the MEASURE hot key and then select the 
measurement mode: 

–  Channel Scanner 

–  Frequency Scanner 

–  Custom Scanner 

 

Configuring test parameters 

Setting frequency 

You need to set the channel or frequency to be scanned depending on the scanner mode: channel 

scanner, frequency scanner, and custom scanner. Refer to each scanner mode for how to set the 

channel or frequency. 

 

Setting amplitude 

Reference level and attenuation 

You can set the reference and attenuation levels automatically or manually to optimize the display of 

the traces measured, as you desire. 
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Procedure 

To automatically set the reference and attenuation level: 

1. Press the AMP/SCALE hard key. 

2. Press the Auto Scale soft key. 

Each time you press this key, both of the Y-axis scale and input attenuation level change to be 
optimized with some margin. 

 
To set the reference or attenuation level manually: 

1. Press the AMP/SCALE hard key. 

2. To set the maximum reference value on the Y-axis manually, complete the following steps: 

a. Press the Reference Level soft key. 

b. Enter a value by using the numeric keys or the rotary knob with 10 dB increments. 

c. Press the unit soft key or the ENTER hard key. 

3. To set the attenuation option, select one from the following choices: 

–  To set the input attenuator’s level automatically, select Attenuation > Auto. 

 

 

NOTE 
It is recommended that you set the Attenuation to Auto in most situations so that the 

level of the input attenuator can be set automatically according to your input signal level. 

 

–  To set the input attenuation manually up to 55 dB to optimize S/N, complete the following 
steps: 

a. Select Attenuation > Manual. 

b. Press the Attenuation Value soft key to set the level. 

c. Enter a value between 0 and 55 in fives by using the numeric keys. 

d. Press the dB soft key or the ENTER hard key. 

–  To couple the input attenuator’s level with your reference level setting, select Attenuation > 
Couple. 

As you increase the reference setting, the attenuation level also increases acoordingly. 
 
Optional. To change the scale unit: 

1. Select More (1/2) > Units. 

2. Select the unit of the display scale: dBm, dBV, dBmV, dBµV, V, or W. 

The scale unit on the screen changes accordingly. 

 

Pre-amplifier 

You can turn the internal pre-amplifier on to correct and compensate for the gain of the preamp so that 

amplitude readings show the value at the input connector. 

 

Procedure 

1. Press the AMP/SCALE hard key. 

2. Toggle the Preamp soft key and select On or Off as needed. 

 

 

NOTE 

You can turn the Preamp on when the input attenuation range is from 0 dB to 10 dB. If 
the attenuation value is manually set to greater than 10 dB, the instrument will 
automatically turn off the pre-amplifier to display low-level signal properly on the chart. 
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External offset 

You can turn the External Offset on and manually set the external offset value. An offset consists of a 

cable loss and a user offset and the measurement result shows the value reflecting both offset values. 

When the external offset value is set at 40 dB in the Spectrum mode, the measurement result 

compensates 40 dB at both the Spectrum Analyzer and Signal Analyzer modes 

 

Procedure 

To set the external offset: 

1. Press the AMP/SCALE hard key. 

2. Toggle the External Offset soft key and select On. 

3. Enter a value by using the numeric keys. 

4. Press the dB soft key to complete the entry. 

 
To turn the external offset off: 

1. Press the AMP/SCALE hard key. 

2. Toggle the External Offset soft key and select Off. 

 

Setting average 

You can set the number of measurements to be averaged for the trace presentation. A maximum of 

100 times of averaging can be set. When the averaging reaches to your setting, a new measurement 

value replaces the measurement value in sequence from the earliest. 

 

Procedure 

1. Press the BW/AVG hard key. 

2. Press the Average soft key. 

3. Enter a value between 1 and 100 as needed by using the numeric keys. 

4. Press the Enter soft key. 

 

Setting sweep mode 

The default setting is Continue to sweep continuously for most on-going measurements. If you want to 

hold the measurement or get a single sweep, you can change the sweep mode. 

 

Procedure 

To select the single sweep mode: 

1. Press the SWEEP hot key. 

2. Toggle the Sweep Mode soft key and select Single. You can also use the HOLD hot key. 

The letter HOLD in red appears and the sweeping is paused. 

3. Optional. Press the Sweep Once soft key to get a new measurement. 
 
To return to the continuous sweep mode: 

1. Toggle the Sweep Mode soft key and select Continue. You can also use the HOLD hot key. 

The letter HOLD in red disappears and the sweeping resumes. 
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NOTE 
Selecting Sweep Mode > Fast may reduce the measurement accuracy, but you can use 

this fast sweep mode to identify the existence of interfering signals. 

 

Making channel scanner measurements 

Setting channel 

You need to set the channel to be scanned. 

 

Procedure 

1. Press the FREQ/DIST hard key. 

2. To select the standard channel, complete the following steps: 

a. Press the Channel Std soft key. The standard channel window appears. 

See “Appendix C – Band, frequency & channel standard” on page 588 for more information. 

b. Select the band to be measured by using the rotary knob, the arrow keys, or the Page 
Up/Page Down soft keys. 

c. Press the Select soft key or the rotary knob to confirm the selection. 

3. Toggle the Link soft key to select the scanning direction and select Fwd for forward or Rev for 

reverse. 

4. To set the starting channel, complete the following steps: 

a. Press the Start Channel soft key. 

b. Enter a value by using the numeric keys. You can also use the rotary knob. 

c. Press the Enter soft key. 

5. To set the amount of channel increment in scanning channels, complete the following steps: 

a. Press the Channel Step soft key. 

b. Enter a value by suing the numeric keys. You can also use the rotary knob. 

c. Press the Enter soft key. 

6. To set the integration bandwidth, complete the following steps: 

a. Press the Integration Bandwidth soft key. 

b. Enter a value by using the numeric keys. You can also use the rotary knob. 

c. Select the unit: GHz, MHz, kHz, or Hz. 

7. To set the number of channels to be displayed in the measurement table, complete the following 
steps: 

a. Press the # of Channels soft key. 

b. Enter a value by using the numeric keys. You can also use the rotary knob. 

c. Press the Enter soft key. 

 

Measurement example 

Test results can be saved as a *.csv file format so that you can work on it in any spreadsheet 

software. 



JD780A Series Analyzers 

 

550 Using Channel Scanner 

Figure 288 Channel scanner measurement 

 
 

 

NOTE 
You can use the LIMIT hot key to analyze your measurements with the display line and 
channel limit. See “Setting limit for channel scanner” on page 553 for more information. 

 

Making frequency scanner measurements 

Setting frequency 

You need to set the frequency to be scanned. 
 

Procedure 

1. Press the FREQ/DIST hard key. 

2. To set the starting center frequency, complete the following steps: 

a. Press the Start Frequency soft key. 

b. Enter a value by using the numeric keys. You can also use the rotary knob. 

c. Select the unit: GHz, MHz, kHz, or Hz. 

3. To set the amount of frequency increment in scanning channels, complete the following steps: 

a. Press the Frequency Step soft key. 

b. Enter a value by suing the numeric keys. You can also use the rotary knob. 

c. Select the unit: GHz, MHz, kHz, or Hz. 

4. To set the integration bandwidth, complete the following steps: 

a. Press the Integration Bandwidth soft key. 

b. Enter a value by using the numeric keys. You can also use the rotary knob. 

c. Select the unit: GHz, MHz, kHz, or Hz. 

5. To set the number of frequencies to be displayed in the measurement table, complete the 
following steps: 

a. Press the # of Frequency soft key. 

b. Enter a value by using the numeric keys. You can also use the rotary knob. 

c. Press the Enter soft key. 
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Measurement example 

Figure 289 Frequency scanner measurement 

 

 

 

NOTE 
You can use the LIMIT hot key to analyze your measurements with the display line and 

channel limit. See “Setting limit for channel scanner” on page 553 for more information. 

 

Making custom scanner measurements 

Setting channel/frequency 

You can customize channels or frequencies to be scanned as you desire. 

 

Procedure 

To set the channels to be scanned: 

1. Press the FREQ/DIST hard key. 

2. Toggle the Unit soft key and select Channel. 

3. To select the standard channel, complete the following steps: 

a. Press the Channel Std soft key. The standard channel window appears. 

See “Appendix C – Band, frequency & channel standard” on page 588 for more information. 

b. Select the band to be measured by using the rotary knob, the arrow keys, or the Page 
Up/Page Down soft keys. 

c. Press the Select soft key or the rotary knob to confirm the selection. 

4. Toggle the Link soft key to select the scanning direction and select Fwd for forward or Rev for 

reverse. 

5. Press the Index soft key, and then enter an index number by turning the rotary knob or using the 

numeric keys. 

6. To set the channel number for the selected index, complete the following steps: 

a. Press the Channel Number soft key. 

b. Enter a value by using the numeric keys. You can also use the rotary knob. 

c. Press the Enter soft key. 
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The instrument displays a corresponding center frequency for the channel number. 

7. To set the integration bandwidth for the selected index, complete the following steps: 

a. Press the Integration Bandwidth soft key. 

b. Enter a value by using the numeric keys. You can also use the rotary knob. 

c. Select the unit: GHz, MHz, kHz, or Hz. 

8. To add more channels to be scanned, repeat steps 5-7. 

9. Press the ESC hard key to dismiss the channel list window and view the scanning result. 
 
To set the frequencies to be scanned: 

1. Press the FREQ/DIST hard key. 

2. Toggle the Unit soft key and select Freq. 

3. Press the Index soft key, and then enter an index number by turning the rotary knob or using the 

numeric keys. 

4. To set the center frequency for the selected index, complete the following steps: 

a. Press the Center Frequency soft key. 

b. Enter a value by using the numeric keys. You can also use the rotary knob. 

c. Select the unit: GHz, MHz, kHz, or Hz. 

5. To set the integration bandwidth for the selected index, complete the following steps: 

a. Press the Integration Bandwidth soft key. 

b. Enter a value by using the numeric keys. You can also use the rotary knob. 

c. Select the unit: GHz, MHz, kHz, or Hz. 

6. To add more channels to be scanned, repeat steps 3-5. 

7. Press the ESC hard key to dismiss the channel list window and view the scanning result. 

 

Measurement example 

Figure 290 Custom scanner measurement 
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NOTE 
You can use the LIMIT hot key to analyze your measurements with the display line and 
channel limit. See “Setting limit for channel scanner” on page 553 for more information. 

 

Analyzing measurements 

Setting limit for channel scanner 

Procedure 

To use the display line: 

1. Press the LIMIT hot key. 

2. Press the Display Line soft key to set a threshold for the limit line and Pass/Fail indication. 

3. Enter a value, and then press the dBm unit soft key. 

4. Toggle the Display Line soft key between On and Off to display or dismiss the limit line. 
 
To use the channel limit: 

1. Press the LIMIT hot key. 

2. Press the Channel Limit soft key to set the limits for each channel index. 

3. Press the Index soft key, and then select the channel/frequency index number by turning the 

rotary knob or using the numeric keys. 

4. Toggle the Limit soft key between On and Off to enable or disable the Pass/Fail indication. 

5. Set the upper threshold: 

a. Press the High Limit soft key. 

b. Enter a value for the upper limit. 

c. Press the dBm unit soft key. 

6. Set the lower threshold: 

a. Press the Low Limit soft key. 

b. Enter a value for the lower limit. 

c. Press the dBm unit soft key. 

7. Optional. Go to SAVE/LOAD > Save, and then select the save option from the choices available 

for your measurement mode. See “Using save” on page 33 for more information. 
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Using Power Meter 

This chapter provides instructions for using the RF Power Meter function and the Optical Power Meter 

function. Topics discussed in this chapter are as follows: 

 

 Introduction .............................................................................................................................. 555 

 Display overview ...................................................................................................................... 555 

 Performing internal RF power measurements ......................................................................... 555 

 Performing external RF power measurements ........................................................................ 560 

 Performing optical power measurements ................................................................................ 563 
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Introduction 

The Power Meter of the JD780A series uses power measurement based on spectrum measurement 

results to provide an accurate power measurement result unlike a general spectrum analyzer, of which 

power accuracy may be degraded if the span is set too wide. 

 

The power meter also provides Pass/Fail indication with user-defined lower and upper limits. 

 

The Power Meter function provides following measurements: 

 Internal RF Power Measurement 

 External RF Power Measurement 

 Optical Power Measurement 

 

Display overview 

Figure 291 provides descriptions for each segment of the measurement screen. 

 

Figure 291 Power measurement screen 

 

 

Performing internal RF power measurements 

The internal power measurement of the JD780A series collects powers from the raw data of spectrum 

analyzer in the optimal span and integrates the powers up to the specified user span, which results in 

an accurate power measurement, independent of the span setting. 
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Connecting a cable 

Direct connection 

Procedure 

1. Connect the Spectrum Analyzer RF In port of the JD780A series and the Power amplifier output 

port of BTS as shown in Figure 292. 

 

Figure 292 Direct connection 

 
JD785A/JD786A 

 
JD788A 

 

Indirect connection 

Procedure 

1. Connect the Spectrum Analyzer RF In port of the JD780A series and the monitor (test) port of 

BTS as shown in Figure 293. 

 

Figure 293 Indirect connection 

 
JD785A/JD786A 

 
JD788A 

 

 

CAUTION 
The maximum power for the Spectrum Analyzer RF In port is +25 dBm (0.316 W). If the 
input signal level to be measured is greater than +25 dBm, use a High Power 
Attenuator to prevent damage when you directly connect the signal to the instrument or 

connect the signal from the coupling port of a directional coupler. 
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Selecting measurement mode 

Procedure 

1. Press the MODE hard key. 

2. Select More (1/2) > Power Meter > Internal RF Power Meter. 

 

Setting frequency  

You need to set the frequency range to be measured either with the center frequency and span or with 

the start and stop frequencies. You can also set the frequency with the channel number and span. 

 

Procedure 

To set the center frequency and span: 

1. Press the FREQ/DIST hard key. 

2. Toggle the Unit soft key and select Freq. 

3. Press the Center Frequency soft key. 

4. Enter a value by using the numeric keys. You can also use the rotary knob or the arrow keys. 

5. Select the unit: GHz, MHz, kHz, or Hz. 

6. Press the Span soft key, and then do one of the following: 

–  To set the span manually, select Span, enter a value, and then select the unit. 

–  To set the span automatically, select Full Span, Zero Span, or Last Span as needed. 

 

 

NOTE 
The Zero Span option is available only in the Spectrum mode. If you have selected Zero 
Span, select TRIGGER > Free Run, External, GPS, Video, or Display Position. 

 
To set the start and stop frequencies: 

1. Press the FREQ/DIST hard key. 

2. Toggle the Unit soft key and select Freq. 

3. Press the Start Frequency soft key. 

4. Enter a value by using the numeric keys. You can also use the rotary knob or the arrow keys. 

5. Select the unit: GHz, MHz, kHz, or Hz. 

6. Press the Stop Frequency soft key. 

7. Enter a value by using the numeric keys. You can also use the rotary knob or the arrow keys. 

8. Select the unit: GHz, MHz, kHz, or Hz. 
 
To set the channel number and span: 

1. Press the FREQ/DIST hard key. 

2. Toggle the Unit soft key and select Channel. 

3. To select the standard channel, complete the following steps: 

a. Press the Channel Std soft key. The standard channel window appears. 

See “Appendix C – Band, frequency & channel standard” on page 588 for more information. 

b. Select the band to be measured by using the rotary knob, the arrow keys, or the Page 
Up/Page Down soft keys. 

c. Press the Select soft key or the rotary knob to confirm the selection. 
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4. Toggle the Link soft key to select the sweep direction and select Fwd for forward or Rev for 

reverse. 

5. To set the channel number, complete the following steps: 

a. Press the Channel Number soft key. 

b. Enter a value by using the numeric keys. 

c. Press the Enter soft key or ENTER hard key to complete the entry. 

The instrument automatically displays the corresponding center frequency value for the 
selected channel number. 

6. To set the span, complete the following steps: 

a. Press the Span soft key. 

b. Select the span option, from the following choices: 

–  To set the span manually, select Span, enter a value, and then select the unit. 

–  To set the span automatically, select Full Span, Zero Span, or Last Span as needed. 

 

 

NOTE 
The Zero Span option is available only in the Spectrum mode. If you have selected Zero 
Span, select TRIGGER > Free Run, External, GPS, Video, or Display Position. 

 
Optional. To define the amount of frequency increment for the rotary knob: 

1. Press the Frequency Step soft key, if the Freq is selected. 

2. Enter a value by using the numeric keys. 

3. Press the unit: GHz, MHz, kHz, or Hz. 
 
Optional. To define the amount of channel increment for the rotary knob: 

1. Press the Channel Step soft key, if the Channel is selected. 

2. Enter a value by using the numeric keys. 

3. Press the Enter soft key. 

 

Setting amplitude 

Procedure 

1. Press the AMP/SCALE hard key. 

2. Toggle the Display soft key and select the display method: Relative or Absolute. 

3. If the Relative is selected, press the Set Reference soft key to set the current value as the 

reference. 

4. To specify the display range, complete the following steps: 

a. Press the Display Maximum soft key to set the maximum value for the power meter. 

b. Enter a value by using the numeric keys. You can also use the rotary knob. 

c. Press the dBm soft key. 

d. Press the Display Minimum soft key to set the minimum value for the power meter. 

e. Enter a value by using the numeric keys. You can also use the rotary knob. 

f. Press the dBm soft key. 

5. Optional. To enable the external offset, complete the following steps: 

a. Toggle the External Offset soft key and select On. 

b. Enter a value between 0 and 60 by using the numeric keys. 
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c. Press the dB soft key. 

 

Setting sweep mode 

The default setting of the sweep mode is Continue. If you want to hold the measurement, you can 

change the sweep mode. 

 

Procedure 

To select the single sweep mode: 

1. Press the SWEEP hot key. 

2. To select the single sweep mode, toggle the Sweep Mode soft key and select Single. You can 
also use the HOLD hot key. 

The letter HOLD in red appears and the sweeping is paused. 

3. To return to the continuous sweep mode, toggle the Sweep Mode soft key and select Continue. 
You can also use the HOLD hot key. 
The letter HOLD in red disappears and the sweeping resumes. 

 

Making a measurement 

Procedure 

1. Press the MEASURE SETUP hot key. 

2. Press the Resolution soft key, and then select the resolution option from the following choices: 

–  0 to display the reading with no decimal place 

–  1 to display the reading with one decimal place 

–  2 to display the reading with two decimal places 

3. To set the resolution bandwidth, complete the following steps: 

a. Press the RBW soft key. 

b. Enter a value by using the numeric keys. 

c. Press the unit: MHz, kHz, or Hz. 

4. Press the Accuracy Mode soft key, and then select the accuracy mode option: Low, Middle, 
and High. 

5. To specify the number of measurements to be averaged, complete the following steps: 

a. Press the Average soft key. 

b. Enter a value between 1 and 100 by using the numeric keys. 

c. Press the Enter soft key. 

6. To set a threshold and view the results with Pass/Fail indication, complete the following steps: 

a. Press the LIMIT hot key. 

b. Toggle the Limit soft key between On and Off to enable or disable the Pass/Fail indication. 

c. Press the High Limit soft key, and then enter a threshold value. 

d. Press the dBm unit soft key. 

e. Press the Low Limit soft key, and then enter a threshold value. 

f. Press the dBm unit soft key. 

7. Optional. Go to SAVE/LOAD > Save, and then select the save option from the choices available 

for your measurement mode. See “Using save” on page 33 for more information. 
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Measurement example 

Figure 294 Internal power measurement 

 

 

Performing external RF power measurements 

This instrument performs radio output power measurement with the use of optional external power 

sensors including JD730 series power sensors. It serves as the highly accurate RF power meter and 

gives wider range of power measurement. 

 

Connecting a cable 

There are two types of power sensors. Directional power sensors are used in in-service power 

measurement. Terminating power sensors are used in out-of-service power measurement. 

 

Table 22 External power sensor type 

Part No. Description Frequency Range Power Range 

JD731B Directional Power Sensor 300-3800 MHz Average: +21.76 to +51.76 dBm 
(0.15 to 150 W) 
Peak: +36.02 to +56.02 dBm 
(4 to 400 W) 

JD732B Terminating Power Sensor 20-3800 MHz Average: -30 to +20 dBm 

JD733A Directional Power Sensor 150-3500 MHz Average/Peak: +20 to +47 dBm 
(0.1 to 50 W) 

JD734B Terminating Power Sensor 20-3800 MHz Peak: -30 to +20 dBm 

JD736B Terminating Power Sensor 20-3800 MHz Average/Peak: -30 to +20 dBm 

 

Terminating power sensor connection 

Procedure 

1. Connect an external power sensor to the USB Host port of the JD780A series and to the RF 
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output port of BTS. 
The JD780A series automatically detects and initializes the power sensor connected to the 
instrument. Connecting an external power sensor is mandatory 

 

Table 23 Terminating power sensor connection 

 
JD785A/JD786A 

 
JD788A 

 

Directional power sensor connection 

Procedure 

1. Connect an external power sensor to the USB Host port of the JD780A series and to the RF 

output port of BTS as shown in Figure 295. 
The JD780A series automatically detects and initializes the power sensor connected to the 
instrument. Connecting an external power sensor is mandatory. 

 

Figure 295 Directional power sensor connection 

 
JD785A/JD786A 

 
JD788A 

 

Selecting measurement mode 

Procedure 

1. Press the MODE hard key. 

2. Select More (1/2) > Power Meter > External RF Power Meter. 

 

Setting frequency  

You need to set the frequency to be measured depending on your connected external power sensor. 
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Procedure 

1. Press the FREQ/DIST hard key. 

2. Press the Frequency soft key. 

3. Enter a value by using the numeric keys. You can also use the rotary knob. 

4. Select the unit: GHz, MHz, kHz, or Hz. 

 

Setting amplitude 

Procedure 

1. Press the AMP/SCALE hard key. 

2. Toggle the Display soft key and select the display method: Relative or Absolute. 

3. If the Relative is selected, press the Set Reference soft key to set the current value as the 

reference. 

4. To specify the display range, complete the following steps: 

a. Press the Display Maximum soft key to set the maximum value for the power meter. 

b. Enter a value by using the numeric keys. You can also use the rotary knob. 

c. Press the dBm soft key. 

d. Press the Display Minimum soft key to set the minimum value for the power meter. 

e. Enter a value by using the numeric keys. You can also use the rotary knob. 

f. Press the dBm soft key. 

5. Optional. To enable the external offset, complete the following steps: 

a. Toggle the External Offset soft key and select On. 

b. Enter a value between 0 and 60 by using the numeric keys. 

c. Press the dB soft key. 

 

Making a measurement 

Procedure 

1. Press the MEASURE hot key. 

2. Depending your connected power sensor, do one of the following: 

–  For JD736B, select the power range option: Average Power, Peak Power, or Pulse Power. 

–  For JD734B, select Peak Power. 

–  For JD732B, select Average Power. 

–  For JD731B, select the power range option: Forward Avg Power, Reverse Avg Power, 
Forward Peak Power, Pulse Power, or VSWR. 

–  For JD733A, select the power range option: Forward Avg Power, Reverse Avg Power, 
Forward Peak Power, or VSWR. 

3. Press the MEASURE SETUP hot key. 

4. Press the Resolution soft key, and then select the resolution option from the following choices: 

–  0 to display the reading with no zero decimal place 

–  1 to display the reading with one decimal place 
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–  2 to display the reading with two decimal places 

5. To set a threshold and view the results with Pass/Fail indication, complete the following steps: 

a. Press the LIMIT hot key. 

b. Toggle the Limit soft key between On and Off to enable or disable the Pass/Fail indication. 

c. Press the High Limit soft key, and then enter a threshold value. 

d. Press the dBm unit soft key. 

e. Press the Low Limit soft key, and then enter a threshold value. 

f. Press the dBm unit soft key. 

6. Optional. Go to SAVE/LOAD > Save, and then select the save option from the choices available 

for your measurement mode. See “Using save” on page 33 for more information. 

 

Measurement example 

You can measure and understand a trend of a system output in operation where output power 

constantly varies depending on the amount of calls being processed by the BTS or Repeater. In 

addition, the Log graph benefits you to easily examine the discontinuance of output power caused by 

the transmission problems or defective connection. 

 

Figure 296 External power measurement of pulse power 

 

 

Performing optical power measurements 

The optical power measurement is available in conjunction with MP-series power sensor, which 

measures optical power via a USB connection. 

 

Connecting a power meter 

Connecting an external optical power meter is mandatory for power measurements in the Optical 

Power Meter mode. There are two optical power meters (sensors) those can be connected to the 

instrument via USB. See “JD780A Series Common Options” on page 602 for the optional power 

meters. 
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Procedure 

1. Connect a MP-series optical power sensor to the USB Host port of the JD780A series as shown 

in Figure 297. 
The OPS indicator appears in the system status bar. 

2. Connect the optical cable from the output port of BTS to the power meter. 

 

Figure 297 Optical power sensor connection 

 
JD785A/JD786A 

 
JD788A 

 

Selecting measurement mode 

Procedure 

1. Press the MODE hard key. 

2. Select More (1/2) > Power Meter > Optical Power Meter. 

The Optical Power Meter screen appears. 

 

Setting measurement parameters 

Procedure 

1. Press the MEASURE SETUP hot key. 

2. To select your desired wavelength for testing, do one of the following: 

–  To let your instrument detect the wavelength automatically, toggle the Wavelength soft key 

and select Auto. 

–  To select a wavelength from the wavelength list, complete the following steps: 

a. Toggle the Wavelength soft key and select Manual. 

b. Press the Stdwave soft key. 

The wavelength list box appears. 

c. Select the wavelength you want from the list, and then tap the Apply button. 

3. Optional. To edit the wavelength list, complete the following steps: 

a. Press the Stored Wavelength soft key. 

The Stored Wavelength dialog box appears. 

b. Do the following: 

–  To add a new wavelength, enter a value between 780 and 1650 in the input box,  

and then tap the Add button. 

–  To edit an existing wavelength, highlight a wavelength in the list, enter a new value 

between 780 and 1650 in the input box, and then tap the Edit button. 

–  To delete an existing wavelength from the list, highlight a wavelength in the list, and 

then tap the Delete button. 

c. Tap the Apply button to save your changes. 
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Making a power measurement 

Procedure 

1. After setting the parameters, read the absolute measurement value in dBm on the screen. 
Figure 298 is an example of the measurement screen. To view a relative power, see “Reading a 

relative power” on page 565.  

2. To view the result in mW, complete the following steps: 

a. Press the AMP/SCALE hard key. 

b. Press the Units soft key, and then select mW. 

3. To set a threshold and view the result with Pass/Fail indication, complete the following steps: 

a. Press the LIMIT hot key. 

b. Toggle the Threshold soft key between On and Off to enable or disable the Pass/Fail 

indication. 

c. Press the Threshold soft key, and then enter a value. 

d. Press the dBm unit soft key. 

e. Toggle the Alarm soft key between On and Off to enable or disable alarming. 

4. Optional. Go to SAVE/LOAD > Save, and then select the save option from the choices available 

for your measurement mode. See “Using save” on page 33 for more information. 

 

Figure 298 optical power measurement 

 

 

 

NOTE 

If the Wavelength is set to Auto, it displays “Auto” for the modulation frequency. It it is set 
to Manual, the instrument displays a detected modulation frequency. 

 

Reading a relative power 

To view a relative power in dB, you can set a reference value automatically or manually. 
 

Procedure 

1. Press the AMP/SCALE hard key. 

2. Toggle the Display soft key and select Relative. 
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3. Do one of the following: 

–  To let the instrument set the last measurement as a reference, complete the following steps: 

a. Toggle the Relative Reference soft key and select Last. 

b. Press the Reference Last soft key. 

 

NOTE 

To set or release reference, you can also press and hold the physical round button on the 
connected MP-series power meter for a few seconds until you hear a beep. 

–  To set the reference manually, complete the following steps: 

a. Toggle the Relative Reference soft key and select Manual. 

b. Press the Reference Manual soft key. 
c. Enter a value manually as you desire, and then press the Enter soft key. 

 

Holding a measurement 

Procedure 

1. To hold the measurement, press the HOLD hard key. 
Measurement is paused and the text “Hold” appears. 

2. To resume the measurement, press the HOLD hard key again. 
Measurement is resumed and the text “Hold” disappears. 
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Performing Fiber Inspection 

This chapter provides instructions for using the fiber testing function with a P5000i fiberscope. Topics 

discussed in this chapter are as follows: 

 

 Introduction .............................................................................................................................. 568 

 Display overview ..................................................................................................................... 568 

 Connecting a fiber microscope ................................................................................................ 568 

 Selecting measurement mode ................................................................................................ 569 

 Configuring test parameters .................................................................................................... 569 

 Performing fiber inspection...................................................................................................... 570 
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Introduction 

Inspection of fiber optic connections is essential for the optimal performance and longevity of fiber optic 

connectivity. Throughout their lives, fiber connectors must be inspected, analyzed, and cleaned to maintain 

an acceptable level of functionality. The JD780A series makes it fast and easy to troubleshoot and certify 

that every connection at a cell site is optimized for a lifetime of performance. 

 

The JD780A series supports the handheld fiber microscope P5000i that can capture video images from the 

sensor and analyzes the images for fiber end face defects and contamination with reliable PASS/FAIL 

results to guarantee the performance of your optical connections. 

 

Display overview 

Figure 291 provides descriptions for each segment of the measurement screen. 

 

Figure 299 Fiber inspection screen 

 

 

Connecting a fiber microscope 

Connecting an optional fiber microscope P5000i is mandatory for fiber inspection and analysis. See “JD780A 

Series Common Options” on page 602 for available options. 

 

Procedure 

1. Connect your fiber microscope P5000i to the USB Host port of the JD780A series. 

The instrument detects the connected microscope automatically and displays the icon. 
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Selecting measurement mode 

Procedure 

1. Press the MODE hard key. 

2. Select More (1/2) > Fiber Inspection. 

 

Configuring test parameters 

Selecting profile and tip 

You can select analysis profiles and inspection tips from the list. 

 

Procedure 

1. Press the MEASURE SETUP hot key. 

2. Press the Profile & Tip soft key. 

The profile and tip pane appears. 

3. To select one of the pre-configured analysis profiles that match the PASS/FAIL criteria in the IEC 
visual inspection standard, complete the following steps: 

a. Tap the drop-down list button for the Profile. 

b. Select the profile that you want to use, from the following choices: 

–  MM (IEC-61300-3-35) 

–  Ribbon, MM (IEC-61300-3-35) 

–  Ribbon, SM APC (IEC-61300-3-35) 

–  SM APC (IEC-61300-3-35) 

–  SM PC (IEC-61300-3-35) 

–  SM UPC (IEC-61300-3-35) 

 NOTE 

All of the profiles are factory set and cannot be edited or removed. 

4. To select the inspection tip (optical settings) that you want to use, complete the following steps: 

a. Tap the drop-down list button for the Tip. 

b. Select one of the tips available to your selected profile, from the following choices: 

–  Standard Tips (with BAP1) and Simplex Long Reach (-L) Tips 

–  Ribbon Tips and Ribbon Tips – Long Reach 

 NOTE 

This setting allows you to select the best optical settings for the type of inspection tip 
that is attached to your microscope probe. 

5. Tap the Apply button or press the Apply soft key to save and return to the previous state. 

 

Setting preferences 

You can set your preferences of auto center and QuickCapture button function. The QuickCapture button is 

the small grey round button on the side of the microscope. 

 

Procedure 

1. To set the function of the QuickCapture button on the side of the P5000i, toggle the Test Button 

soft key and select the option from the following choices: 

–  Test: Sets the capture button to function as Test. Pressing the Quickcapture button 
analyzes fiber image as like the Test soft key on your JD780A series. 
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–  Freeze: Sets the capture button to function as Freeze. Pressing the Quickcapture button 
captures fiber image as like the Freeze soft key on your JD780A series. 

2. To turn the auto center feature on or off, toggle the Auto Center soft key between On and Off 
and select the option you want to set. Default setting is On. It automatically displays the center of 

the fiber when viewing at high magnification. 

 

Performing fiber inspection 

Capturing fiber image 

Procedure 

1. Connect the fiber to be inspected to the tip of your microscope P5000i. 
The live image of the fiber is displayed on the screen. 
See the user manual of your fiber microscope for details on using the P5000i. 

2. Focus the image by rotating the Focus Control on the P5000i until the image is in focus. 

3. Toggle the Magnification soft key between Low and High and select the option you want to use. 
You can also press the Magnification Control button on either side of the P5000i. 

4. Press the Freeze soft key to capture the properly focused image. 

The text “Capturing…” appears. 

5. Optional. To save the captured image as a file (.png), complete the following steps: 

a. Tap the Save PNG soft key. 

The Save window appears with the on-screen key. 

b. Type a file name in the File Name field. 

c. Select a folder where you want to save the file, if desired. 

d. Press the Save soft key. 

6. Press the Live soft key to return to the live image screen or press the Quit soft key to exit. 

 

Measurement example 

Figure 300 Captured fiber image 
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Testing a fiber 

Procedure 

1. Connect the fiber to be inspected to the tip of your microscope P5000i. 
The live image of the fiber is displayed on the screen. 
See the user manual of your fiber microscope for details on using the P5000i. 

2. Focus the image by rotating the Focus Control on the P5000i until the image is in focus. 

3. Toggle the Magnification soft key between Low and High and select the option you want to use. 
You can also press the Magnification Control button on either side of the P5000i. 

4. Press the Test soft key to start fiber analysis. 

The text “Analyzing…” appears. 

5. Once the test is completed, check the result displayed on the screen with the following 
information: 

–  Image overlay of the zone locations, defects, and scratches 

–  PASS or FAIL result 

–  Specific test result for each zone 

6. To show or hide image overlays, press the Overlay soft key. 

Each time this key is pressed, the selection changes. 

7. Optional. To save the fiber inspection result with specific details as a report (.pdf), complete the 

following steps: 

a. Tap the Save PDF soft key. 

The Save window appears with the on-screen key. 

b. Type a file name in the File Name field. 

c. Select a folder where you want to save the file, if desired. 

d. Press the Save soft key. 

The information input window appears. 

e. Type in information as required. 

f. Tap the Apply button or press the Apply soft key to save and return to the previous state. 

8. Press the Live soft key to return to the live image screen or press the Quit soft key to exit the 

fiber inspection. 
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Measurement example 

Figure 301 Analyzed fiber image and fiber inspection result 

 

 

Figure 302 Fiber inspection report 

 

 

 



 

 

   21 

 

Using EMF Analyzer 

This chapter provides instructions for using the EMF Analyzer function (option 050). Topics discussed 

in this chapter are as follows: 

 

 Introduction .............................................................................................................................. 574 

 Display overview ...................................................................................................................... 574 

 Connecting an isotropic antenna ............................................................................................. 574 

 Selecting measurement mode ................................................................................................. 575 

 Configuring test parameters .................................................................................................... 575 

 Conducting EMF spectrum measurements ............................................................................. 579 

 Recording and replaying EMF logging data ............................................................................ 581 
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Introduction 

Base stations emit electro-magnetic fields (EMF) of high frequency, which varies between wireless 

technologies and countries. As personal exposure to high frequency fields from base stations can 

provoke health effect, the International Commission on Non-Ionizing Radiation Protection (ICNIRP) 

has provided general guidelines on limitations regarding high frequency exposure. Using the EMF 

Analyzer in JD780A series with an isotropic antenna connected, you can now measure the level of 

EMF onsite in the field in order to verify if the level of emission from of your base station is compliant 

with the guidelines. 

 

The JD780A series is the solution to perform following measurement and analysis: 

 

 EMF Spectrum 

 EMF Replayer 

 

Display overview 

Figure 303 provides overview of each segment of the measurement screen. 

 

Figure 303 EMF Spectrum measurement screen 

 

 

Connecting an isotropic antenna 

In the EMF Analyzer mode, connecting an isotropic antenna is mandatory and the part number is 

G700050380. Using this isotropic antenna, you can make three-dimensional measurements. 

 

Procedure 

1. Connect the RF Type-N connector of the isotropic antenna to the RF In port of the instrument. 
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2. Connect the USB plug of the isotropic antenna to the USB Host port of the JD780A series. 

The device icon appears in the system status bar on the screen. 

 

Figure 304 Connection using an isotropic antenna 

 

 

 

CAUTION 
The maximum power for the Spectrum Analyzer RF In port is +25 dBm (0.316 W). 

 

Selecting measurement mode 

Procedure 

1. Press the MODE hard key. 

2. Press the More (1/2) soft key and then the EMF Analyzer soft key.  

This menu is activated only after you have not installed the license on your CellAdvisor. 

3. Press the MEASURE hot key, and then select the measurement mode from the following 
choices: 

–  EMF Spectrum 

–  EMF Replayer 

 

Configuring test parameters 

Setting frequency 

You need to set the frequency range to be measured with either the center frequency/span or the 

start/stop frequencies. You can also set the frequency with the channel number and span. 
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Procedure 

To set the center frequency and span: 

1. Press the FREQ/DIST hard key. 

2. Toggle the Unit soft key and select Freq. 

3. To set the center frequency, complete the following steps: 

a. Press the Center Frequency soft key. 

b. Enter a value by using the numeric keys. You can also use the rotary knob or the arrow 
keys. 

c. Select the unit from the choices: GHz, MHz, kHz, and Hz. 

4. To set the span frequency, complete the following steps: 

a. Press the Span soft key. 

b. Enter a value by using the numeric keys. You can also use the rotary knob or the arrow 
keys. 

c. Select the unit from the choices: GHz, MHz, kHz, and Hz. 

 
To set the start and stop frequencies: 

1. Press the FREQ/DIST hard key. 

2. Toggle the Unit soft key and select Freq. 

3. To set the start frequency, complete the following steps: 

a. Press the Start Frequency soft key. 

b. Enter a value by using the numeric keys. You can also use the rotary knob or the arrow 
keys. 

c. Select the unit from the choices: GHz, MHz, kHz, and Hz. 

4. To set the stop frequency, complete the following steps: 

a. Press the Stop Frequency soft key. 

b. Enter a value by using the numeric keys. You can also use the rotary knob or the arrow 
keys. 

c. Select the unit from the choices: GHz, MHz, kHz, and Hz. 

5. Optional. To define the amount of frequency increment for the rotary knob: 

a. Press the Frequency Step soft key, if the Freq is selected. 

b. Enter a value by using the numeric keys. 

c. Press the unit: GHz, MHz, kHz, or Hz. 

 
To set the channel number and span: 

1. Press the FREQ/DIST hard key. 

2. Toggle the Unit soft key and select Channel. 

3. To select the standard channel, complete the following steps: 

a. Press the Channel Std soft key. The standard channel window appears. 

See “Appendix C – Band, frequency & channel standard” on page 588 for more information. 

b. Highlight the band to be measured by using the rotary knob, the arrow keys, or the  
Page Up/Page Down soft keys. 

c. Press the Select soft key or the rotary knob to confirm the selection. 

4. Toggle the Link soft key to select the sweep direction and select Fwd (forward) or Rev (reverse) 

as you desire. 

5. To set the channel number, complete the following steps: 

a. Press the Channel Number soft key. 

b. Enter a value by using the numeric keys. 

c. Press the Enter soft key or ENTER hard key to complete the entry. 

The instrument automatically displays the corresponding center frequency value for the 
selected channel number. 

6. To set the span frequency, complete the following steps: 
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a. Press the Span soft key. 

b. Enter a value by using the numeric keys. You can also use the rotary knob or the arrow 
keys. 

c. Select the unit from the choices: GHz, MHz, kHz, and Hz. 

7. Optional. To define the amount of channel increment for the rotary knob: 

a. Press the Channel Step soft key, if the Channel is selected. 

b. Enter a value by using the numeric keys. 

c. Press the Enter soft key. 

 

Setting amplitude 

Reference level and attenuation 

You can set the reference and attenuation levels automatically or manually to optimize the display of 

the traces measured, as you desire. 

 

Procedure 

To automatically set the reference and attenuation level: 

1. Press the AMP/SCALE hard key. 

2. Press the Auto Scale soft key. 

Each time you press this key, both of the Y-axis scale and input attenuation level change to be 
optimized with some margin. 

 
To set the reference or attenuation level manually: 

1. Press the AMP/SCALE hard key. 

2. To set the maximum reference level on the Y-axis manually, complete the following steps: 

a. Press the Reference Level soft key. 

b. Enter a value by using the numeric keys or the rotary knob. 

c. Press your desired unit soft key from the available choices, which vary depending on your 
selection of the unit in the Units setting. 

3. To set the input attenuation level, select one from the following choices: 

–  To set the input attenuator’s level automatically, select Attenuation > Auto. 
 

 

NOTE 
It is recommended that you set the Attenuation to Auto in most situations so that the 

level of the input attenuator can be set automatically according to your input signal level. 

–  To set the input attenuation manually up to 55 dB to optimize S/N, complete the following 

steps: 

a. Select Attenuation > Manual. 

b. Press the Attenuation Value soft key to set the level. 

c. Enter a value in fives by using the numeric keys. 

d. Press the dB soft key or the ENTER hard key. 

 
To change the scale unit: 

1. Select More (1/2) > Units. 

2. Select the unit of the display scale: dBµV/m, dBmV/m, dBV/m, V/m, Watt/m^2, dBm/m^2, 
dBW/m^2, A/m, dBA/m, and Watt/cm^2. 

The scale unit on the screen changes accordingly. 

 

Pre-amplifier 

You can turn on the internal pre-amplifier to correct and compensate for the gain of the preamplifier so 
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that amplitude readings show the values at the input connector. 

 

Procedure 

1. Press the AMP/SCALE hard key. 

2. Toggle the Preamp soft key and select On or Off as needed. 

 

 

NOTE 

You can turn on the Preamp when the input attenuation range is from 0 dB to 10 dB. If 
the attenuation value is manually set to greater than 10 dB, the instrument will 
automatically turn off the pre-amplifier to display low-level signal properly on the chart. 

 

External offset 

You can turn on the External Offset and manually set the external offset value. 

 

Procedure 

To set the external offset: 

1. Press the AMP/SCALE hard key. 

2. Toggle the External Offset soft key and select On. 

3. Enter a value by using the numeric keys. 

4. Press the dB soft key to complete the entry. 

 
To turn the external offset off: 

1. Press the AMP/SCALE hard key. 

2. Toggle the External Offset soft key and select Off. 

 

Scale per division 

You can use the Scale/Div feature available for the spectrum measurement screen. It represents the 

value of one division on the horizontal scale. The default setting is 10 dB per division and the 

maximum value can be set up to 20 dB. 

 

Procedure 

To set the scale per division: 

1. Press the AMP/SCALE hard key. 

2. Select More (1/2) > Scale/Div. 

3. Enter a value between 1 and 20 by using the numeric keys. 

4. Press the dB soft key to complete the entry. 

 

Setting bandwidth 

You can set the Resolution Bandwidth (RBW) and Video Bandwidth (VBW) manually or automatically. 

Selecting Auto changes the value to correspond to your frequency span setting for RBW and VBW. 

 

Procedure 

To automatically set the RBW and VBW: 

1. Press the BW/AVG hard key. 
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2. Toggle the RBW soft key and select Auto. 

3. Toggle the VBW soft key and select Auto. 

The RBW or VBW value on the screen changes accordingly based on the span. 

 
To manually set the RBW or VBW: 

1. Press the BW/AVG hard key. 

2. Press the RBW soft key. 

3. Enter a value in 1-3 sequence by using the numeric keys. 

4. Select the unit from the choices: MHz, kHz, and Hz. 
The RBW setting automatically changes to Manual. 

5. Press the VBW soft key. 

6. Enter a value by using the numeric keys. 

7. Select the unit from the choices: MHz, kHz, and Hz. 
The VBW setting automatically changes to Manual. 

The RBW or VBW value on the screen changes accordingly. 

 

Conducting EMF spectrum measurements 

After you have configured test parameters as described in the “Configuring test parameters” on page 

575, you can start your EMF measurements. If you log your measurement, you can play back using 

the EMF Replayer. For more information on saving logging data, see “Logging EMF spectrum data” on 

page 581. 

 

Procedure 

1. Press the MEASURE SETUP hot key. 

2. To specify the amount of measurement time that you want the instrument to stay for on each 
axis: 

a. Press the Dwell Time soft key. 

b. Enter a value in seconds between one and 60. 

c. Press the unit soft key or the ENTER hard key. 

3. To specify the amount of measurement time that you want the instrument to stay for on all three 
axes in order to display current and accumulated EMF power: 

a. Press the Measurement Time soft key. 

b. Enter a value in minutes or in seconds. You can set this up to 30 minutes. 

c. Select the unit from the choices: Minute and Second. 

 

NOTE 

The Isotropic EMF Power is the current or the latest average power measured with three 
axes for the specified dwell time for the axis while the Accumulated Isotropic EMF Power 
is the average, maximum, and minimum power taken from the number (n) times of 
measurements. 

4. To specify the number of EMF measurements that you want to make: 

a. Press the # of Measurement soft key. 

b. Enter a value. Depending on your settings for Dwell Time and Measurement Time, you can 
set this up to 600.  

c. Press the Enter soft key or the ENTER hard key. 

 

NOTE 

The dwell time, measurement time, and number of measurement are correlated based on 
the equation of “# of Measurement = Measurement Time / (Dwell Time x 3)”. For 

example, if you set the Dwell Time to 60 seconds and the Measurement Time to 30 
minutes, you can enter “10” for the # of Measurement”. 

5. To start the measurement, toggle the Measurement soft key and select On. 



JD780A Series Analyzers 

 

580 Using EMF Analyzer 

The instrument displays measurement results on the screen. Figure 305 is an example. 

6. To hold the display, press the HOLD hot key. 

7. To release the display, press the HOLD hot key again. 

8. To stop the measurement, toggle the Measurement soft key and select Off. 

9. To clear current display and start new measurement, press the Restart soft key. 

 

Figure 305 EMF spectrum measurement with EMF analyzer 

 

 

Setting trace 

You can display up to six traces on the measurement chart simultaneously. 

 

Procedure 

1. Press the TRACE/DISPLAY hard key. 

2. Press the Select Trace soft key, and then select the trace number from the following choices: 

–  T1: Current EMF Trace 

–  T2: EMF Trace of X-axis 

–  T3: Isotropic EMF Trace 

–  T4: EMF Trace of Y-axis 

–  T5: Accumulated Isotropic EMF Trace  

–  T6: EMF Trace of Z-axis 

The legend shape of the selected trace changes from square to round to indicate that the trace 
is the active one now. 

3. Toggle the Trace View soft key between On and Off and select On to show the selected trace on 
the display or Off to hide it from the display. 

 

 

Setting limit 

You can set three different limits to analyze the results, as you desire. 
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Procedure 

To set the display line: 

1. Press the LIMIT hot key. 

2. Toggle the Display Line soft key and select On. 

The straight horizontal line appears to be used as a visual reference only. 

3. Press the Display Line soft key, and then enter a value that you want to set as a reference. 

4. Select your desired unit soft key from the available choices, which vary depending on your 
selection of the unit in the Units setting in Amp/Scale. 

 
To set the multiple segment line: 

1. Press the LIMIT hot key. 

2. Press the Multi Segment Line soft key for Pass/Fail indication. 

3. Toggle the Limit soft key between Upper and Lower to select the one to be displayed. 

4. Set the number of segments for the selected upper or lower limit line, up to 50 segments. 

a. Press the # of Line soft key. 

b. Enter a value between 1 and 50 by using the numeric keys. 

c. Press the Enter soft key. 

5. Press the Autoset soft key to let the instrument set the limit for each segment and display the line. 

6. Optional. To move the limit line, complete the following steps: 

a. Select Limit Up/Down or Limit Left/Right. 

b. Turn the rotary knob to move the line as desired. You can also manually enter a value. 

7. Optional. To edit the segment properties, complete the following steps: 

a. Press the Edit Limit soft key. 

b. Press the Move soft key and then turn the rotary knob to select the segment to edit. 

c. Select the menu option, from the following choices: 

–  To hide the line for the selected segment, toggle the Line soft key and select Off. 

–  To add a new point, press the Add Point soft key. 

–  To delete the selected point, press the Delete Point soft key. 

–  To change the position, press the Frequency or Amplitude soft key, and then turn the 

rotary knob to change the value as desired. 

8. Optional. Go to SAVE/LOAD > Save, and then select Save Limit to save the limit settings. 

See “Using save” on page 33 for more information. 

 
To set the ICNIRP limit: 

1. Press the LIMIT hot key. 

2. Toggle the ICNIRP Limit soft key between On and Off and select On to show a reference line for 
the set span frequency range based on the ICNIRP guidelines or Off to hide the line from the 

display. 

 

Recording and replaying EMF logging data 

Logging EMF spectrum data 

You can record EMF spectrum measurement as a logging file in .grr file type so that you can play it 

back in the spectrogram chart view for data analysis. 

 

Procedure 

1. Press the SAVE/LOAD hot key. 

2. Select the Save soft key. 
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3. Select the Save Logging Data soft key. The on-screen keyboard appears. 

4. Type the name of the file in the File Name field. 
 

 

NOTE 

In is recommended that you use an external USB memory drive to save logging data in 
order to have enough free space. 

5. Press the Save soft key to start logging. 

The “Recording” appears on the screen. 

6. Press the ESC hard key to stop logging data and complete saving. 

 

Replaying EMF spectrum data 

If you have recorded logging data in the EMF Spectrum mode, you can load the saved data in the 

EMF Replayer mode and view them in the spectrogram chart for your analysis. 

 

Loading a saved logging file 

Procedure 

1. In the EMF Analyzer mode, press the MEASURE hot key. 

2. Press the EMF Replayer soft key. The file explorer window appears. 

3. Navigate to the .grr file that you have saved in the EMF Spectrum mode. 

 

NOTE 

In the File Information pane, you can find the properties of the file that you want to open. 
If the selected logging data have been saved in a measurement mode other than EMF 
Spectrum, the instrument will display an error message at the bottom of the window. 

4. Press the Load soft key.  

The EMF Replayer window appears with the upper spectrogram chart and the lower spectrum 
chart. The spectrum chart displays two traces: isotropic trace and isotropic average trace.  

 

Changing play options  

Procedure 

1. Press the MEASURE hot key. 

2. Toggle the Replay Direction soft key between FWD and REV to change play direction to forward 

or reverse. 

3. Press the Replay Speed soft key, and then select the speed option: x1, x2, x3, and x4. 

4. Press the Play soft key to start playing the recorded logging data. 

5. Press the Pause soft key to pause or stop playing the recorded logging data. 

6. To move to a particular failure position directly and play from there, complete the following steps: 

a. Press the Jump to Fail Index soft key. 

b. Enter a value by using the numeric keys. 

c. Press the Enter soft key. 

 

 

NOTE 

If you connected a USB drive, do not remove it while playing. Doing so may freeze the 
USB port, which will require you to restart the instrument to get a USB drive recognized 
again. 
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Changing amplitude settings 

You can change the reference level, scale per division, and units to optimize the display of the 

recorded data while replaying, as you desire. 

 

Procedure 

1. Press the AMP/SCALE hard key. 

2. To set the maximum reference level on the Y-axis, complete the following steps: 

a. Press the Reference Level soft key. 

b. Enter a value by using the numeric keys or the rotary knob with 10 dB increments. 

c. Press your desired unit soft key from the choices, which vary depending on your selection 
of the unit in the Units setting. 

3. To change the scale unit, select Units and then select the unit of the display scale from the 
choices: dBµV/m, dBmV/m, dBV/m, V/m, Watt/m^2, dBm/m^2, dBW/m^2, A/m, dBA/m, and 
Watt/cm^2. 

The scale unit on the screen changes accordingly. 
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Appendix A – Product general information 

 JD785A/JD786A JD788A Supplemental Information 
Inputs and Outputs    

RF In   Spectrum Analyzer 
Connector Type-N female Type-N female  

Impedance 50 Ω 50 Ω Nominal 
Damage Level >+33 dBm, >±50 V DC >+33 dBm, >±50 V DC Nominal 

    
Reflection/RF Out   Cable and Antenna Analyzer 

Connector Type-N female Type-N female  
Impedance 50 Ω 50 Ω Nominal 

Damage Level >+40 dBm, >±50 V DC >+40 dBm, >±50 V DC Nominal 
    

RF In   Cable and Antenna Analyzer 
Connector Type-N female N/A  

Impedance 50 Ω N/A Nominal 
Damage Level >+25 dBm, >±50 V DC N/A Nominal 

    
External Trigger, GPS    

Connector SMA female SMA female  
Impedance 50 Ω 50 Ω Nominal 

    
External Ref    

Connector SMA female SMA female  
Impedance 50 Ω 50 Ω Nominal 

Input Frequency 10, 13, 15 MHz 10, 13, 15 MHz  
Input Range -5 to +5 dBm -5 to +5 dBm  

    
USB    

USB Host Type A, 1 port Type A, 1 port  
USB Client Type B, 1 port Type B, 1 port  

    
LAN RJ45, 10/100 Base-T RJ45, 10/100 Base-T  

    
E1/T1 RJ45 N/A Available in JD785A 

    
GPIO N/A RJ45 Available in JD786A and JD788A 

    
Audio Jack 3.5 mm headphone 

jack 
3.5 mm headphone 
jack 

 

    
External Power 5.5 mm barrel 

connector 
5.5 mm barrel 
connector 

 

    
Speaker Built-in speaker Built-in speaker  

    
Display    

Type 
 

Size 

Resistive touch 
screen 
8” 

Resistive touch 
screen 
8” 

 
 
LCD backlight, transflective LCD 
with anti-glare coating 

Resolution 800 x 600 800 x 600  
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 JD785A/JD786A JD788A Supplemental Information 
Power    

External DC Input 18 V DC 18 V DC  
Power Consumption 37 W 37 W 49 W maximum when charging 

battery 
    

Battery    
 10.8 V, 7800 mA-h 10.8 V, 7800 mA-h Lithium Ion 

Operating Time > 3 hours (Typical) > 3 hours (Typical) In balance mode 
Charge Time 2.5 hours (80 %) 

5 hours (100 %) 
2.5 hours (80 %) 
5 hours (100 %) 

In case of a fully discharged 
battery 

Storage Temperature 0 to 25°C 
(32 to 77°F) 
 

0 to 25°C 
(32 to 77°F) 
 

The battery pack should be 
stored in an environment with 
low humidity. Extended 
exposure to temperature above 
45°C could degrade battery 
performance and life. 

    
Data Storage    

Internal Maximum 100 MB Maximum 100 MB Up to 3800 traces 
External Limited to the size of 

USB flash drive 
Limited to the size of 
USB flash drive 

Supports USB 2.0 compatible 
memory devices 

    
Environmental    
Operating Temperature 

AC Power 
 

Battery 

 
0 to 40°C 
(32 to 104°F) 
0 to 40°C 
(32 to 104°F) 
-10 to 55 °C 
(14 to 131

 
°F) 

 
0 to 40°C 
(32 to 104°F) 
0 to 40°C 
(32 to 104°F) 
-10 to 55 °C 
(14 to 131

 
°F) 

 
With no derating 
 
At charging 
 
At discharging 

Maximum Humidity 95% RH 95% RH Non-condensing 
Shock and Vibration MIL-PRF-28800F Class 

2 
MIL-PRF-28800F Class 
2 

 

Storage Temperature -30 to 71°C 
(-22 to 160°F) 

-30 to 71°C 
(-22 to 160°F) 

With the battery pack removed 

    
EMC    
 IEC/EN 61326-1:2006 IEC/EN 61326-1:2006 Complies with European EMC 
 CISPR11:2009+A1:2010 CISPR11:2009+A1:2010  
ESD    
 IEC/EN 61000-4-2 IEC/EN 61000-4-2  
    
Size and Weight (Standard Configuration) 

Weight <4.3 kg (9.5 lb.) <3.9 kg (8.6 lb.) With battery 
    

Size 295 x 195 x 82 (mm) 295 x 195 x 82 (mm) Approximately (W x H x D) 
 11.6 x 7.7 x 3.2 (Inch) 11.6 x 7.7 x 3.2 (Inch)  

    
Warranty    
 2 years 2 years  
    
Calibration Cycle    
 1 year 1 year  
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Appendix B – Cable list 

 

Cable Type 
Relative Propagation 
Velocity (V¦) 

Nominal Attenuation dB/m 
@ 1000 MHz 

FSJ1-50A   0.84 0.197 

FSJ250   0.83 0.134 

FSJ4-50B   0.81 0.119 

HCC 12-50J   0.915 0.092 

HCC 158-50J   0.95 0.023 

HCC 300-50J   0.96 0.014 

HCC 312-50J   0.96 0.013 

HCC 78-50J   0.915 0.042 

HF 4-1/8” Cu2Y   0.97 0.01 

HF 5” Cu2Y   0.96 0.007 

HF 6-1/8”Cu2Y   0.97 0.006 

HJ4.5-50   0.92 0.054 

HJ4-50   0.914 0.087 

HJ5-50   0.916 0.042 

HJ7-50A   0.921 0.023 

LDF12-50   0.88 0.022 

LDF4-50A   0.88 0.077 

LDF5-50A   0.89 0.043 

LDF6-50   0.89 0.032 

LDFF7-50A   0.88 0.027 

LMR100   0.8 0.792 

LMR1200   0.88 0.044 

LMR1700   0.89 0.033 

LMR200   0.83 0.344 

LMR240   0.84 0.262 

LMR400   0.85 0.135 

LMR500   0.86 0.109 

LMR600   0.87 0.087 

LMR900   0.87 0.056 

RG142   0.69 0.443 

RG17, 17A   0.659 0.18 

RG174   0.66 0.984 

RG178B   0.69 1.509 

RG187, 188   0.69 1.017 

RG213/U   0.66 0.292 

RG214   0.659 0.292 

RG223   0.659 0.165 

RG55, 55A, 55B   0.659 0.541 

RG58, 58B   0.659 1.574 

RG58A, 58C   0.659 0.787 

RG8, 8A, 10, 10A   0.659 0.262 

RG9, 9A   0.659 0.289 

HFSC-12D(1/2") 0.81 0.112 

HFC-12D(1/2") 0.88 0.072 

HFC-22D(7/8") 0.88 0.041 

HFC-33D(1_1/4") 0.88 0.0294 

HFC-42D(1_5/8") 0.87 0.0243 

RFCX-12D(1/2") 0.88 0.088 

RFCX-22D(7/8") 0.88 0.049 

RFCX-33D(1_1/4") 0.88 0.038 

RFCX-42D(1_5/8") 0.87 0.028 

RFCL-22D(7/8") 0.88 0.044 

RFCL-33D(1_1/4") 0.88 0.034 

RFCL-42D(1_5/8") 0.87 0.0315 
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Appendix C – Band, frequency & channel standard 

 

Standard 

Uplink Downlink 

Start Freq 
(MHz) 

Stop Freq 
(MHz) 

Valid Channels 
Start Freq 
(MHz) 

Stop Freq 
(MHz) 

Valid Channels 

GSM 

GSM 450  450.40  457.60  259≤n≤293 460.40  467.60  259≤n≤293 

GSM 480  478.80  486.00  306≤n≤340 488.80  496.00  306≤n≤340 

GSM 850  824.00  849.00  128≤n≤251 869.00  894.00  128≤n≤251 

P-GSM 900  890.00  915.00  1≤n≤124 935.00  960.00  1≤n≤124 

E-GSM 900  880.00 915.00 
0≤n≤124 

925.00 960.00 
0≤n≤124 

975≤n≤1023 975≤n≤1023 

R-GSM 900  876.00 915.00 
0≤n≤124 

921.00 960.00 
0≤n≤124 

955≤n≤1023 955≤n≤1023 

R-GSM 900 (China)  885.00  889.00  999≤n≤1019 930.00  934.00  999≤n≤1019 

DCS 1800 1710.00  1785.00  512≤n≤885 1805.00  1880.00  512≤n≤885 

PCS 1900 1850.00  1910.00  512≤n≤810 1930.00  1990.00  512≤n≤810 

CDMA 

Band 0 (800) 824.00  849.00  
1≤n≤799 

869.00  894.00  
1≤n≤799 

991≤n≤1023 991≤n≤1023 

Band 1 (NA PCS) 1850.00  1910.00  0≤n≤1199 1930.00  1990.00  0≤n≤1199 

Band 2 (TACS) 872.0125  914.9875  
0≤n≤1000 

917.0125  959.9875  
0≤n≤1000 

1329≤n≤2047 1329≤n≤2047 

Band 3 (JTACS) 887.0125  924.9875  

1≤n≤799 

832.0125  869.9875  

1≤n≤799 

801≤n≤1039 801≤n≤1039 

1041≤n≤1199 1041≤n≤1199 

1201≤n≤1600 1201≤n≤1600 

Band 4 (KR PCS) 1750.00  1780.00  0≤n≤599 1840.00  1870.00  0≤n≤599 

Band 5 (450) 411.675  483.480  

1≤n≤300 

421.6750  493.4800  

1≤n≤300 

539≤n≤871 539≤n≤871 

1039≤n≤1473 1039≤n≤1473 

1792≤n≤2016 1792≤n≤2016 

Band 6 (2100) 1920.00  1980.00  0≤n≤1199 2100.00  2170.00  0≤n≤1199 

Band 7 (700) 776.00  794.00  0≤n≤359 746.00  764.00  0≤n≤359 

Band 8 (1800) 1710.00  1784.95  0≤n≤1499 1805.00  1879.95  0≤n≤1499 

Band 9 (900) 880.00  914.95  0≤n≤699 925.00  959.95  0≤n≤699 

Band 10 (2nd 800) 806.000  900.975  
0≤n≤719 

851.000  939.975  
0≤n≤719 

720≤n≤919 720≤n≤919 

WCDMA 
Band Global       

Band 1 (2100-General) 1920.0  1980.0  9612≤n≤9888 2110.0  2170.0  10562≤n≤10838 

Band 2 (1900-General) 
1850.0  1910.0  

9262≤n≤9538 
1930.0  1990.0  

9662≤n≤9938 

Band 2 (1900-Additional) 12≤n≤287 412≤n≤687 

Band 3 (1800-General) 1710.0  1780.0  937≤n≤1288 1805.0  1880.0  1162≤n≤1513 

Band 4 (1700-General) 
1710.0  1775.0  

1312≤n≤1513 
2110.0  2155.0  

1537≤n≤1738 

Band 4 (1700-Additional) 1662≤n≤1862 1887≤n≤2087 

Band 5 (850-General) 
824.0  849.0  

4132≤n≤4233 
869.0  894.0  

4357≤n≤4458 

Band 5 (850-Additional) 782≤n≤862 1007≤n≤1087 

Band 6 (800-General) 
830.0  840.0  

4162≤n≤4188 
875.0  885.0  

4387≤n≤4413 

Band 6 (800-Additional) 812≤n≤837 1037≤n≤1062 

Band 7 (2600-General) 
2500.0  2570.0  

2012≤n≤2338 
2620.0  2690.0  

2237≤n≤2563 

Band 7 (2600-Additional) 2362≤n≤2687 2587≤n≤2912 

Band 8 (900-General) 880.0  915.0  2712≤n≤2863 925.0  960.0  2937≤n≤3088 

Band 9 (1700-General) 1749.9  1784.9  8762≤n≤8912 1844.9  1879.9  9237≤n≤9387 

Band 10 (1700-General) 
1710.0  1770.0  

2887≤n≤3163 
2110.0  2170.0  

3112≤n≤3388 

Band 10 (1700-Additional) 3187≤n≤3462 3412≤n≤3687 

Band 11 (1500-General) 1427.9  1447.9  3487≤n≤3562 1475.9  1495.9  3712≤n≤3787 

Band 12 (700-General) 
699.0  716.0  

3617≤n≤3678 
729.0  746.0  

3842≤n≤3903 

Band 12 (700-Additional) 3707≤n≤3767 3932≤n≤3992 

Band 13 (700-General) 
777.0  787.0  

3792≤n≤3818 
746.0  756.0  

4017≤n≤4043 

Band 13 (700-Additional) 3842≤n≤3867 4067≤n≤4092 

Band 14 (700-General) 
788.0  798.0  

3892≤n≤3918 
758.0  768.0  

4117≤n≤4143 

Band 14 (700-Additional) 3942≤n≤3967 4167≤n≤4192 

Band 19 (800-General) 
830.0  845.0  

312≤n≤363 
875.0  890.0  

712≤n≤763 

Band 19 (800-Additional) 387≤n≤437 787≤n≤837 

Band 20 (800-General) 832.0  862.0  4287≤n≤4413 791.0  821.0  4512≤n≤4638 
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Band 21 (1500-General) 1447.9  1462.9  462≤n≤512 1495.9  1510.9  862≤n≤912 

Band 22 (3500-General) 3410.0  3490.0  4437≤n≤4813 3510.0  3590.0  4662≤n≤5038 

Band 25 (1900-General) 
1850.0  1915.0  

4887≤n≤5188 
1930.0  1995.0  

5112≤n≤5413 

Band 25 (1900-Additional) 5212≤n≤5512 5437≤n≤5737 

Band 26 (800-General) 
814.0  849.0  

5537≤n≤5688 
859.0  894.0  

5762≤n≤5913 

Band 26 (800-Additional) 5712≤n≤5862 5937≤n≤6087 

LTE - FDD 

Band Global       

Band 1 (2100) 1920.0  1980.0  18000≤n≤18599 2110.0  2170.0  0≤n≤599 

Band 2 (1900) 1850.0  1910.0  18600≤n≤19199 1930.0  1990.0  600≤n≤1199 

Band 3 (1800) 1710.0  1785.0  19200≤n≤19949 1805.0  1880.0  1200≤n≤1949 

Band 4 (1700) 1710.0  1755.0  19950≤n≤20399 2110.0  2155.0  1950≤n≤2399 

Band 5 (850) 824.0  849.0  20400≤n≤20649 869.0  894.0  2400≤n≤2649 

Band 7 (2600) 2500.0  2570.0  20750≤n≤21449 2620.0  2690.0  2750≤n≤3449 

Band 8 (900) 880.0  915.0  21450≤n≤21799 925.0  960.0  3450≤n≤3799 

Band 9 (1700) 1749.9  1784.9  21800≤n≤22149 1844.9  1879.9  3800≤n≤4149 

Band 10 (1700) 1710.0  1770.0  22150≤n≤22749 2110.0  2170.0  4150≤n≤4749 

Band 11 (1500) 1427.9  1447.9  22750≤n≤22949 1475.9  1495.9  4750≤n≤4949 

Band 12 (700) 699.0  716.0  23010≤n≤23179 729.0  746.0  5010≤n≤5179 

Band 13 (700) 777.0  787.0  23180≤n≤23279 746.0  756.0  5180≤n≤5279 

Band 14 (700) 788.0  798.0  23280≤n≤23379 758.0  768.0  5280≤n≤5379 

Band 17 (700) 704.0  716.0  23730≤n≤23849 734.0  746.0  5730≤n≤5849 

Band 18 (800) 815.0  830.0  23850≤n≤23999 860.0  875.0  5850≤n≤5999 

Band 19 (800) 830.0  845.0  24000≤n≤24149 875.0  890.0  6000≤n≤6149 

Band 20 (800) 832.0  862.0  24150≤n≤24449 791.0  821.0  6150≤n≤6449 

Band 21 (1500)  1447.9  1462.9  24450≤n≤24599 1495.9  1510.9  6450≤n≤6599 

Band 22 (3500) 3410.0  3490.0  24600≤n≤25399 3510.0  3590.0  6600≤n≤7399 

Band 23 (2100) 2000.0  2020.0  25500≤n≤25699 2180.0  2200.0  7500≤n≤7699 

Band 24 (1500) 1626.5  1660.5  25700≤n≤26039 1525.0  1559.0  7700≤n≤8039 

Band 25 (1900) 1850.0  1915.0  26040≤n≤26689 1930.0  1995.0  8040≤n≤8689 

Band 26 (800) 814.0  849.0  26690≤n≤27039 859.0  894.0  8690≤n≤9039 

LTE - TDD 

Band Global    

 

Band 33 (1900) 1900.0  1920.0  36000≤n≤36199 

Band 34 (2100) 2010.0  2025.0  36200≤n≤36349 

Band 35 (1850) 1850.0  1910.0  36350≤n≤36949 

Band 36 (1930) 1930.0  1990.0  36950≤n≤37549 

Band 37 (1910) 1910.0  1930.0  37550≤n≤37749 

Band 38 (2570) 2570.0  2620.0  37750≤n≤38249 

Band 39 (1880) 1880.0  1920.0  38250≤n≤38649 

Band 40 (2300) 2300.0  2400.0  38650≤n≤39649 

Band 41 (2496) 2496.0  2690.0  39650≤n≤41589 

Band 42 (3400) 3400.0  3600.0  41590≤n≤43589 

Band 43 (3600) 3600.0  3800.0  43590≤n≤45589 

TD-SCDMA 

FBN 0 1785.0  1805.0  0≤n≤92 

 

FBN 1 1900.0  1920.0  0≤n≤92 

FBN 2 1920.0  1980.0  0≤n≤255 

FBN 3 1920.0  1980.0  0≤n≤36 

FBN 4 1980.0  2010.0  0≤n≤142 

FBN 5 2010.0  2025.0  0≤n≤67 

FBN 6 2100.0  2170.0  0≤n≤255 

FBN 7 2100.0  2170.0  0≤n≤36 

FBN 8 2170.0  2220.0  0≤n≤242 

WiMAX 

ProfR1 (1.25 2150) 2150.625  2159.375  0≤n≤7  

ProfR2 (1.25 2305) 2305.625  2320.625  0≤n≤12 

ProfR3 (1.25 2361) 2361.875  2375.625  13≤n≤24 

ProfR4 (1.25 2500) 2500.625  2688.125  0≤n≤150 

ProfR5 (1.25 3400) 3400.625  3700.625  0≤n≤240 

ProfR6 (3.5 2598) 2524.750  2591.250  0≤n≤38 2598.750  2665.250  0≤n≤38 

ProfR7 (3.5 3461) 3411.750  3443.250  0≤n≤18 3461.750  3493.250  0≤n≤18 

ProfR8 (3.5 3551) 3501.750  3598.000  0≤n≤55 3551.750  3648.000  0≤n≤55 

ProfR9 (3.5 3651) 3601.750  3698.000  0≤n≤55 3651.750  3748.000  0≤n≤55 

ProfR10 (3.5 3751) 3701.750  3798.000  0≤n≤55 3751.750  3848.000  0≤n≤55 

ProfR11 (7 2600) 2526.500  2589.500  0≤n≤36 2600.50  2663.50  0≤n≤36 

ProfR12 (7 3463) 2413.500  3441.500  0≤n≤16 3463.50  3491.50  0≤n≤16 

ProfR13 (7 3553) 3503.500  3596.250  0≤n≤53 3553.50  3646.25  0≤n≤53 
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ProfR14 (7 3653) 3603.500  3696.250  0≤n≤53 3653.50  3746.25  0≤n≤53 

ProfR15 (7 3753) 3703.500  3796.250  0≤n≤53 3753.50  3846.25  0≤n≤53 

ProfR26 (10 5275) 5275.000  5335.000  55≤n≤67  

ProfR27 (10 5740) 5740.000  5830.000  148≤n≤166 

ProfR28 (10 5735) 5735.000  5845.000  147≤n≤169 

ProfR29 (8.75 2304) 2304.375  2395.625  0≤n≤730 
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Appendix D – VSWR-Return loss conversion table 

This information is for the Cable and Antenna Analyzer mode of the JD785A Base Station Analyzer 

and the JD786A RF Analyzer. 

 

 Return Loss=20log10(VSWR+1/VSWR-1) (dB) 

 VSWR=(10
R.L./20

+1/10
R.L./20

-1) 

 

VSWR Return 
Loss 
(dB) 

Trans. 
Loss 
(dB) 

Volt. 
Refl 
Coeff 

Power 
Trans 
(%) 

Power 
Refl 
(%) 

 VSWR Return 
Loss 
(dB) 

Trans. 
Loss 
(dB) 

Volt. 
Refl 
Coeff 

Power 
Trans 
(%) 

Power 
Refl 
(%) 

1.00 -- 0.000 0.00 100.0 0.0  1.64 12.3 0.263 0.24 94.1 5.9 

1.01 46.1 0.000 0.00 100.0 0.0  1.66 12.1 0.276 0.25 93.8 6.2 

1.02 40.1 0.000 0.01 100.0 0.0  1.68 11.9 0.289 0.25 93.6 6.4 

1.03 36.6 0.001 0.01 100.0 0.0  1.70 11.7 0.302 0.26 93.3 6.7 

1.04 34.2 0.002 0.02 100.0 0.0  1.72 11.5 0.315 0.26 93.0 7.0 

1.05 32.3 0.003 0.02 99.9 0.1  1.74 11.4 0.329 0.27 92.7 7.3 

1.06 30.7 0.004 0.03 99.9 0.1  1.76 11.2 0.342 0.28 92.4 7.6 

1.07 29.4 0.005 0.03 99.9 0.1  1.78 11.0 0.356 0.28 92.1 7.9 

1.08 28.3 0.006 0.04 99.9 0.1  1.80 10.9 0.370 0.29 91.8 8.2 

1.09 27.3 0.008 0.04 99.8 0.2  1.82 10.7 0.384 0.29 91.5 8.5 

1.10 26.4 0.010 0.05 99.8 0.2  1.84 10.6 0.398 0.30 91.3 8.7 

1.11 25.7 0.012 0.05 99.7 0.3  1.86 10.4 0.412 0.30 91.0 9.0 

1.12 24.9 0.014 0.06 99.7 0.3  1.88 10.3 0.426 0.31 90.7 9.3 

1.13 24.3 0.016 0.06 99.6 0.4  1.90 10.2 0.440 0.31 90.4 9.6 

1.14 23.7 0.019 0.07 99.6 0.4  1.92 10.0 0.454 0.32 90.1 9.9 

1.15 23.1 0.021 0.07 99.5 0.5  1.94 9.9 0.468 0.32 89.8 10.2 

1.16 22.6 0.024 0.07 99.5 0.5  1.96 9.8 0.483 0.32 89.5 10.5 

1.17 22.1 0.027 0.08 99.4 0.6  1.98 9.7 0.497 0.33 89.2 10.8 

1.18 21.7 0.030 0.08 99.3 0.7  2.00 9.5 0.512 0.33 88.9 11.1 

1.19 21.2 0.033 0.09 99.2 0.8  2.50 7.4 0.881 0.43 81.6 18.4 

1.20 20.8 0.036 0.09 99.2 0.8  3.00 6.0 1.249 0.50 75.0 25.0 

1.21 20.4 0.039 0.10 99.1 0.9  3.50 5.1 1.603 0.56 69.1 30.9 

1.22 20.1 0.043 0.10 99.0 1.0  4.00 4.4 1.938 0.60 64.0 36.0 

1.23 19.7 0.046 0.10 98.9 1.1  4.50 3.9 2.255 0.64 59.5 40.5 

1.24 19.4 0.050 0.11 98.9 1.1  5.00 3.5 2.553 0.67 55.6 44.4 

1.25 19.1 0.054 0.11 98.8 1.2  5.50 3.2 2.834 0.69 52.1 47.9 

1.26 18.8 0.058 0.12 98.7 1.3  6.00 2.9 3.100 0.71 49.0 51.0 

1.27 18.5 0.062 0.12 98.6 1.4  6.50 2.7 3.351 0.73 46.2 53.8 

1.28 18.2 0.066 0.12 98.5 1.5  7.00 2.5 3.590 0.75 43.7 56.3 

1.29 17.9 0.070 0.13 98.4 1.6  7.50 2.3 3.817 0.76 41.5 58.5 

1.30 17.7 0.075 0.13 98.3 1.7  8.00 2.2 4.033 0.78 39.5 60.5 

1.32 17.2 0.083 0.14 98.1 1.9  8.50 2.1 4.240 0.79 37.7 62.3 

1.34 16.8 0.093 0.15 97.9 2.1  9.00 1.9 4.437 0.80 36.0 64.0 

1.36 16.3 0.102 0.15 97.7 2.3  9.50 1.8 4.626 0.81 34.5 65.5 

1.38 15.9 0.112 0.16 97.5 2.5  10.00 1.7 4.807 0.82 33.1 66.9 

1.40 15.8 0.122 0.17 97.2 2.8  11.00 1.6 5.149 0.83 30.6 69.4 

1.42 15.2 0.133 0.17 97.0 3.0  12.00 1.5 5.466 0.85 28.4 71.6 

1.44 14.9 0.144 0.18 96.7 3.3  13.00 1.3 5.762 0.86 26.5 73.5 

1.46 14.6 0.155 0.19 96.5 3.5  14.00 1.2 6.040 0.87 24.9 75.1 

1.48 14.3 0.166 0.19 96.3 3.7  15.00 1.2 6.301 0.88 23.4 76.6 

1.50 14.0 0.177 0.20 96.0 4.0  16.00 1.1 6.547 0.88 22.1 77.9 

1.52 13.7 0.189 0.21 95.7 4.3  17.00 1.0 6.780 0.89 21.0 79.0 

1.54 13.4 0.201 0.21 95.5 4.5  18.00 1.0 7.002 0.89 19.9 80.1 

1.56 13.2 0.213 0.22 95.2 4.8  19.00 0.9 7.212 0.90 19.0 81.0 

1.58 13.0 0.225 0.22 94.9 5.1  20.00 0.9 7.413 0.90 18.1 81.9 

1.60 12.7 0.238 0.23 94.7 5.3  25.00 0.7 8.299 0.92 14.8 85.2 

1.62 12.5 0.250 0.24 94.4 5.6  30.00 0.6 9.035 0.94 12.5 87.5 
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Appendix E – Cyclic prefix table 

This information is for the LTE – FDD Signal Analyzer mode and the LTE – TDD Signal Analyzer mode 

of the JD785A Base Station Analyzer and the JD788A Signal Analyzer. Following table shows OFDM 

parameter details by different bandwidth. 

 

 

Bandwidth Configuration (Downlink) 
Cyclic Prefix Length 

TS µs 

20 MHz 

Normal CP ∆f=15 kHz 
160 for l =0 

144 for l =1,2,..,6 

5.208 

4.6875 

Extended CP 
∆f=15 kHz 512 for l =0,1,…,5 16.667 

∆f=7.5 kHz 1024 for l =0,1,2 33.333 

15 MHz 

Normal CP ∆f=15 kHz 
120 for l =0 

108 for l =1,2,..,6 

5.208 

4.6875 

Extended CP 
∆f=15 kHz 384 for l =0,1,…,5 16.667 

∆f=7.5 kHz 768 for l =0,1,2 33.333 

10 MHz 

Normal CP ∆f=15 kHz 
80 for l =0 

72 for l =1,2,..,6 

5.208 

4.6875 

Extended CP 
∆f=15 kHz 256 for l =0,1,…,5 16.667 

∆f=7.5 kHz 512 for l =0,1,2 33.333 

5 MHz 

Normal CP ∆f=15 kHz 
40 for l =0 

36 for l =1,2,..,6 

5.208 

4.6875 

Extended CP 
∆f=15 kHz 128 for l =0,1,…,5 16.667 

∆f=7.5 kHz 248 for l =0,1,2 33.333 

3 MHz 

Normal CP ∆f=15 kHz 
20 for l =0 

18 for l =1,2,..,6 

5.208 

4.6875 

Extended CP 
∆f=15 kHz 64 for l =0,1,…,5 16.667 

∆f=7.5 kHz 128 for l =0,1,2 33.333 

1.4 MHz 

Normal CP ∆f=15 kHz 
10 for l =0 

9 for l =1,2,..,6 

5.208 

4.6875 

Extended CP 
∆f=15 kHz 32 for l =0,1,…,5 16.667 

∆f=7.5 kHz 64 for l =0,1,2 33.333 
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Appendix F – Motorola CDMA/EV-DO LMF 

Motorola’s CDMA/EV-DO base stations (BTS) are optimized with the assistance of Local Maintenance 

Facility (LMF), a Motorola’s software tool that interfaces with the cell site and the instrument. The 

optimization process identifies the accumulated loss (or gain) for all receiving and transmitting paths at 

the cell site and stores that value in the system’s database. 

 

Using JD780A series LMF interface 

An emulation interface to LMF has been implemented in Viavi’s base station analyzer (JD785A) in 

order to perform BTS optimization procedures. The scope of this emulation is to do maintenance tests 

of TX Calibration and TX Audit required in routine maintenance practices with or without the use of an 

external power sensor. Using the external power sensor, you can get highly accurate measurement 

results. 

 

Setting up for a LMF test 

Procedure 

1. To connect your instrument both with BTS and PC, do one of the following: 

–  Internal power sensor: Connect the Motorola CDMA/EV-DO BTS with the Spectrum 
Analyzer RF In 50 Ω port of JD785A and connect the WinLMF running PC with JD785A via 
a hub as illustrated in the Figure 306. 

–  External power sensor: Connect an external power sensor to the USB Host port of JD785A 
and to the BTS and connect the WinLMF running PC with JD785A via a hub as illustrated in 
the Figure 307. 

 

Figure 306 Using internal power sensor 
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Figure 307 Using external power sensor 

 

 

Performing a LMF test 

Procedure 

1. Press the SYSTEM hot key. 

2. To set the IP address, complete the following steps: 

a. Select System Configuration > Ethernet Config > IPv4. 

b. Toggle the Mode soft key and select Static. 

c. Press the Field > IP Address soft key. 

d. Set the IP address as “192.167.10.1”. 

3. Select Remote Interface > LAN > LMF. 

4. To set up the LMF settings, complete the following steps: 

a. Press the LMF Settings soft key. 

b. Select the power measurement and BTS option from the following choices: 

–  External PM 800 MHz Band for external measurement on cellular basestation 

–  External PM 1900 MHz Band for external meausrement on PCS basestation 

–  Internal PM 800 MHz Band for internal measurement on celluar basestation 

–  Internal PM 1900 MHz Band for internal measurement on PCS basestation 

5. To select the measurement mode, complete the following steps: 

a. Press the MODE hard key. 

b. Press the Power Meter soft key. 

c. Select Internal RF Power Meter or External RF Power Meter depending on your LMF 

settings. The measurement result is displayed on the screen. 
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Appendix G – Bluetooth connection 

JD780A series’ Bluetooth mode is used for communication between the instrument and your computer 

with JDRemote or a storage device in order to use the following services if needed. 

 

 Bluetooth Personal Area Network (PAN) profile service for JDRemote. 

 Bluetooth File Transfer Profile (FTP) or Object Push Profile (OPP) service for file transfer from 

the instrument to a Bluetooth storage device. 

 

The Bluetooth Connectivity option includes a pair of Bluetooth USB Parani-UD100 Adapters and 5 dBi 

Dipole Antennas as well as the BlueSoleil application software. 

 

Installing and setting up Bluetooth software 

The BlueSoleil application must be installed in your computer prior to making a Bluetooth connection. 

After installing the software, you must disable DHCP Server option in order to use the PAN service 

properly. 

 

Procedure 

1. Insert the provided CD-ROM into your computer and install the software as instructed. 
The BlueSoleil Space shortcut icon appears on the desktop. 

 

 

NOTE 

For more information on installation, refer to the Quick Start Guide or the User Guide 
provided with the adapter. 

2. Double-click the BlueSoleil Space shortcut icon on your computer desktop to launch the 

application. 
The BlueSoleil program window appears. 

3. Right-click the My Device icon (the orange ball) in the center of the window, and then click 
Properties > Services tab. 

The My Device Properties window appears. 

4. Select the Bluetooth Personal Area Network from the list, and then click the Properties button. 

The Bluetooth Personal Area Network Properties window appears. 

5. Click the Options tab, and then uncheck the Enable DHCP Server option. 

 

 

NOTE 

As the Enable DHCP Server option is checked by default, you must disable this option. 

6. Click the OK button. 

The Bluetooth Personal Area Network Properties window dismisses. 

7. Click the OK button. 

The My Device Properties window dismisses. 

 

Making Bluetooth connection 

The JD780A series detects a connected Parani-UD100 USB Bluetooth Adapter automatically. 

 

Procedure 

1. Connect the 5 dBi Dipole Antenna to the Parani-UD100 Bluetooth USB Adapter: one for the 
computer and the other for JD780A series. 
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2. Plug in the Bluetooth adapters to the USB port of the computer and the instrument. 
The instrument detects the connected adapter and turns the Bluetooth mode on automatically. 
The Bluetooth icon appears in the status bar at the top of the instrument screen. 

3. Double-click the BlueSoleil Space icon on the computer desktop to launch the application if not 

opened already. 
The BlueSoleil program window appears. 

4. Double-click the My Device icon (orange ball) in the center of the application window to search 

the JD780A series. 
You can view an added icon around the orange ball labeled with the detected JD780A series’ BD 
address or model and serial numbers. 

5. Right-click the device icon for the JD780A series, and then click the Pair. 

The Bluetooth Passkey window appears. 

6. Enter 0000 in the Passkey box, and then click the OK button. 

The word “Paired” appears on the window. The instrument also turns the Bluetooth Mode on 
automatically and displays the paired device and service information on the screen. 

7. Double-click the device icon for the JD780A series to search services. 

8. Right-click the icon for the JD780A series, and then select either the Connect Bluetooth 
Personal Area Network or the Connect Bluetooth File Transfer. 

 

 

NOTE 

Select one of these services as needed. If the Connect Bluetooth Personal Area Network 
is selected, a fixed IP address (192.168.10.10) is assigned for JD780A series and this 
address must be typed into the TCP/IP setting on JDViewer or JDRemote. See “Setting 
up communication in application” on page 596 for more information. 

 

 

Setting up communication in application 

If the Connect Bluetooth Personal Area Network service is selected on BlueSoleil, you need to 

configure communication setting on the application JDViewer or JDRemote by entering the fixed IP 

address for the instrument. 

 

JDViewer setup 

Procedure 

1. Launch the JDViewer application. 

2. Go to Settings > Communication. 

The Settings dialog box appears. 

3. Click the drop-down list in the Instrument pane, and then select the instrument series to be 
communicated. 

4. In the Connection Method pane, select the TCP/IP, and then enter 192.168.10.10 without dots. 

5. Click OK to finish the communication setup. 

6. Go to Load > Connect to make a connection between the instrument and JDViewer. 

JD780A series and JDViewer become ready for communication. 

 

JDRemote setup 

Procedure 

1. Launch the JDRemote application. 
The Select Model dialog box appears. 
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2. Select the 740A/B, 780A/B Series, and then click the OK button. 

3. Right-click on the JDRemote window, and then click the Communication. 

The Communication dialog box appears. 

4. Select the TCP/IP, and then enter 192.168.10.10 without dots. 

5. Click OK to finish the communication setup. 

6. Right-click on the JDRemote window, and then click the Connect. 

This enables communication between the instrument and JDRemote. 

7. Right-click on the JDRemote window, and then click the Start. 

JD780A series and JDRemote become ready for communication. 

8. Optional. To adjust the image quality, complete the following steps: 

a. Right-click on the JDRemote. 

b. Click the Quality. 

c. Select the image quality option among High, Medium, or Low. 

You can improve refresh rate, if experiencing low-quality signal, by adjusting the image 
quality in JDRemote. 

 

Turning Bluetooth mode on/off manually 

JD780A series turns the Bluetooth Mode on automatically if connected. You can also turn it on and off 

manually. 

 

Procedure 

1. Press the SYSTEM hot key. 

2. Press the System Configuration > Remote Interface > Bluetooth soft key. 

The Bluetooth screen appears with the device information. 

3. Toggle the Bluetooth soft key between On and Off to turn it on and off. 

Connecting or disconnecting the adapter also turns the mode on or off automatically. 
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Appendix H – Device driver installation 

JD780A series can be controlled from the application software JDViewer or JDRemote installed on 

your computer. You must install driver software for the instrument on to the computer if USB Client 

connection is used for communication. 

 

Procedure 

1. Go to Control Panel > System > Device Manager. 

The Device Manager window appears. 

2. Right-click the Unknown Device under the Other Devices, and then click the Update Driver 
Software. 
The Update Driver Software – Unknown Device window appears as shown in the Figure 308 

below. 

3. Select the Browse my computer for driver software, and then click the Browse button to 

search for the location where the driver software is. 
The Browse For Folder window appears. 

4. Search for the JDRemote folder, and then select the driver folder for the installed OS. 

For example, OSDisk (C:) > Program Files (x86) > JDRemote > Driver > Win7 > 64bit. 

5. Click the OK button. 

The Browse For Folder window dismisses. 

6. Click the Next button to start installation. 
If the Windows Security window appears, select the Install this driver software anyway. 

Installing driver software starts. 

7. Click the Close button at the end of the installation. 

 

Figure 308 Device manager screen 
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Appendix I – Ordering information 

The Warranty Period for Viavi Solutions Accessories shall apply to the all standard and optional 

accessories listed below. The warranty period varies by product and is generally one (1) year unless 

otherwise specified. 

JD785A Base Station Analyzer 

JD785A   
9 kHz to 8 GHz Spectrum Analyzer  
5 MHz to 6 GHz Cable and Antenna Analyzer

1
  

10 MHz to 8 GHz RF Power Meter Internal mode 
   
Options   
NOTE: Upgrade options for the JD785A use the designation JD785AU before the respective last three-digit 
option number. 
   
JD785A001 2-Port Transmission Measurements

2
  

JD785A002 Bias Tee (Requires option 01) 
JD785A003 CW Signal Generator  
JD785A004 E1 Analyzer

3
  

JD785A005 T1 Analyzer
3
  

JD785A006 Bluetooth Connectivity  
JD785A007 High Power CW Signal Generator  
JD785A010 GPS Receiver and Antenna  
JD785A011 Interference Analyzer

4, 5
  

JD785A012 Channel Scanner  
JD785A014 LTE-FDD RAN Performance Indicator  
JD785A015 LTE-TDD RAN Performance Indicator  
JD785A016 Wi-Fi Connectivity  
JD785A020 cdmaOne/cdma2000 Signal Analyzer  
JD785A021 EV-DO Signal Analyzer (Requires option 20) 
JD785A022 GSM/GPRS/EDGE Signal Analyzer  
JD785A023 WCDMA/HSPA+ Signal Analyzer  
JD785A025 TD-SCDMA Signal Analyzer  
JD785A026 Mobile WiMAX Signal Analyzer  
JD785A028 LTE-FDD Signal Analyzer  
JD785A029 LTE-TDD Signal Analyzer  
JD785A030 LTE Advanced-FDD Signal Analyzer (Requires option 28) 
JD785A031 LTE Advanced-TDD Signal Analyzer (Requires option 29) 
JD785A032 LTE-FDD 256 QAM Demodulator (Requires option 28) 
JD785A033 LTE-TDD 256 QAM Demodulator (Requires option 29) 
JD785A040 cdmaOne/cdma2000 OTA Analyzer

5
 (Requires option 10) 

JD785A041 EV-DO OTA Analyzer
5
 (Requires option 10) 

JD785A042 GSM/GPRS/EDGE OTA Analyzer
5
 (Requires option 10) 

JD785A043 WCDMA/HSPA+ OTA Analyzer
5
 (Requires option 10) 

JD785A045 TD-SCDMA OTA Analyzer
5
 (Requires option 10) 

JD785A046 Mobile WiMAX OTA Analyzer
5
 (Requires option 10) 

JD785A048 LTE-FDD OTA Analyzer
5
 (Requires option 10) 

JD785A049 LTE-TDD OTA Analyzer
5
 (Requires option 10) 

JD785A050 EMF Analyzer 
7
  

 
 

  

Standard Accessories 
G710550326 AC/DC Power Adapter

6
 

G710550335 Cross LAN Cable (1.5 m)
6
 

GC73050515 USB A to B Cable (1.8 m)
6
 

GC72450518 > 1 G Byte USB Memory
6
 



JD780A Series Analyzers 

 

600 Appendix 

G710550325 Rechargeable Lithium Ion Battery
6
 

G710550323 Automotive Cigarette Lighter 12 V DC Adapter
6
 

G710550316 Stylus Pen
6
 

JD780A361 JD780A Series User’s Manual and Application Software – CD 
  

1
Requires Calibration Kit 

2
Requires Dual Port Calibration Kit 

3
Requires Test Cable 

4
Highly recommended adding JD785A010 

5
Highly recommended adding G70005035x and/or G70005036x 

6
Standard accessories can be purchased separately. 

7
Requires G700050380 

 

JD786A RF Analyzer 

JD786A   
9 kHz to 8 GHz Spectrum Analyzer  
5 MHz to 6 GHz Cable and Antenna Analyzer

1
  

10 MHz to 8 GHz RF Power Meter Internal mode 
   
Options   
NOTE: Upgrade options for the JD786A use the designation JD786AU before the respective last three-digit 
option number. 
   
JD786A001 2-Port Transmission Measurements

2
  

JD786A002 Bias Tee (Requires option 01) 
JD786A003 CW Signal Generator  
JD785A006 Bluetooth Connectivity  
JD786A007 High Power CW Signal Generator  
JD786A010 GPS Receiver and Antenna  
JD786A011 Interference Analyzer

3,4
  

JD786A012 Channel Scanner  
JD786A016 Wi-Fi Connectivity  
JD786A050 EMF Analyzer6  

 
Standard Accessories 
G710550326 AC/DC Power Adapter

5
 

G710550335 Cross LAN Cable (1.5 m)
5
 

GC73050515 USB A to B Cable (1.8 m)
5
 

GC72450518 > 1 G Byte USB Memory
5
 

G710550325 Rechargeable Lithium Ion Battery
5
 

G710550323 Automotive Cigarette Lighter 12 V DC Adapter
5
 

G710550316 Stylus Pen
5
 

JD780A361 JD780A Series User’s Manual and Application Software – CD 
  

1
Requires Calibration Kit 

2
Requires Dual port Calibration Kit 

3
Highly recommended adding JD786A010 

4
Highly recommended adding G70005035x and/or G70005036x 

5
Standard accessories can be purchased separately. 

6
Requires G700050380 

 

 

 

JD788A Signal Analyzer 

JD788A   
9 kHz to 8 GHz Spectrum Analyzer  
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10 MHz to 8 GHz RF Power Meter Internal mode 
   
Options   
NOTE: Upgrade options for the JD788A use the designation JD788AU before the respective last three-digit 
option number. 
   
JD785A001 2-Port Transmission Measurements

1
  

JD785A003 CW Signal Generator  
JD788A006 Bluetooth Connectivity  
JD788A007 High Power CW Signal Generator  
JD788A009 20 MHz Demodulation Hardware  
JD788A010 GPS Receiver and Antenna  
JD788A011 Interference Analyzer

2,3
  

JD788A012 Channel Scanner  
JD788A014 LTE-FDD RAN Performance Indicator  
JD788A015 LTE-TDD RAN Performance Indicator  
JD788A016 Wi-Fi Connectivity  
JD788A020 cdmaOne/cdma2000 Signal Analyzer (Requires option 9) 
JD788A021 EV-DO Signal Analyzer (Requires option 9 and 20) 
JD788A022 GSM/GPRS/EDGE Signal Analyzer (Requires option 9) 
JD788A023 WCDMA/HSPA+ Signal Analyzer (Requires option 9) 
JD788A025 TD-SCDMA Signal Analyzer (Requires option9) 
JD788A026 Mobile WiMAX Signal Analyzer (Requires option 9) 
JD788A028 LTE-FDD Signal Analyzer (Requires option 9) 
JD788A029 LTE-TDD Signal Analyzer (Requires option 9) 
JD788A030 LTE Advanced-FDD Signal Analyzer (Requires options 9 and 28) 
JD788A031 LTE Advanced-TDD Signal Analyzer (Requires options 9 and 29) 
JD788A032 LTE-FDD 256 QAM Demodulator (Requires options 9 and 28) 
JD788A033 LTE-TDD 256 QAM Demodulator (Requires options 9 and 29) 
JD788A040 cdmaOne/cdma2000 OTA Analyzer

3
 (Requires options 9 and 10) 

JD788A041 EV-DO OTA Analyzer
3
 (Requires options 9 and 10) 

JD788A042 GSM/GPRS/EDGE OTA Analyzer
3
 (Requires options 9 and 10) 

JD788A043 WCDMA/HSPA+ OTA Analyzer
3
 (Requires options 9 and 10) 

JD788A045 TD-SCDMA OTA Analyzer
3
 (Requires options 9 and 10) 

JD788A046 Mobile WiMAX OTA Analyzer
3
 (Requires options 9 and 10) 

JD788A048 LTE-FDD OTA Analyzer
3
 (Requires options 9 and 10) 

JD788A049 LTE-TDD OTA Analyzer
3
 (Requires options 9 and 10) 

JD788A050 EMF Analyzer5  
   
Standard Accessories 
G710550326 AC/DC Power Adapter

4
 

G710550335 Cross LAN Cable (1.5 m)
4
 

GC73050515 USB A to B Cable (1.8 m)
4
 

GC72450518 > 1 G Byte USB Memory
4
 

G710550325 Rechargeable Lithium Ion Battery
4
 

G710550323 Automotive Cigarette Lighter 12 V DC Adapter
4
 

G710550316 Stylus Pen
4
 

JD780A361 JD780A Series User’s Manual and Application Software – CD 
  

1
Requires Dual Port Calibration Kit 

2
Highly recommended adding JD788A010 

3
Highly recommended adding G70005035x and/or G70005036x 

4
Standard accessories can be purchased separately. 

5
Requires G700050380 
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JD780A Series Common Options 

Optional RF Power Sensors 
JD731B Directional Power Sensor. Peak and Average power 300 to 3800 MHz 
JD733A Directional Power Sensor. Peak and Average power 150 to 3500 MHz 
JD732B Terminating Power Sensor. Average Power 20 to 3800 MHz 
JD734B Terminating power sensor, Peak Power 20 to 3800 MHz 
JD736B Terminating power sensor, Dual (Average/Peak) power 20 to 3800 MHz 

 
 

Optional Optical Power Sensors 
MP-60A USB Optical Power Meter, with software, 2.5 mm and 1.25 mm interfaces,  

30" USB extender, carrying pouch 
MP-80A USB Optical Power Meter-High Power, with software, 2.5 mm and 1.25 mm interfaces, 

30" USB extender, carrying pouch 
  

 
Optional Calibration Kits 
JD78050509 Y- Calibration Kit Type-N(m), DC to 6 GHz, 50 Ω 
JD78050507 Dual Port Type-N 6 GHz Calibration Kit 
JD70050509 EZ-CAL Kit Type-N(m), DC to 6 GHz, 50  Ω 

 
 

Optional Fiber Microscope Kits 
FBP-SD101 FBP-P5000i Digital Probe, FiberChekPRO SW, Case, and 4 Tips  
FBP-MTS-101 FBP-P5000i Digital Probe, FiberChekPRO SW, Case, and 7 Tips 
FIT-SD103 FBP-P5000i Digital Probe, MP-60A USB Power Meter, FiberChekPRO SW, Case, Tips 

and Adapters  
FIT-SD103-C FBP-P5000i Digital Probe, MP-60A USB Power Meter, FiberChekPRO SW, Case, Tips 

and Adapters 
FIT-SD113 FBP-P5000i Digital Probe, MP-80A USB Power Meter, FiberChekPRO SW, Case, Tips 

and Adapters  
 

Optional RF Cables 
G710050530 1.0 m (3.28 ft) RF Cable, DC to 18 GHz, Type-N(m) to Type-N(m), 50  
G710050531 1.5 m (4.92 ft) RF Cable, DC to 18 GHz, Type-N(m) to Type-N(f), 50  
G710050532 3.0 m (9.84 ft) RF Cable, DC to 18 GHz, Type-N(m) to Type-N(f), 50  
G710050533 1.5 m (4.92 ft) RF Cable, DC to 18 GHz, Type-N(m) to SMA(m), 50  
G710050534 1.5 m (4.92 ft) RF Cable, DC to 18 GHz, Type-N(m) to QMA(m), 50  
G710050535 1.5 m (4.92 ft) RF Cable, DC to 18 GHz, Type-N(m) to SMB(m), 50  
G710050536 RF Cable DC to 6 GHz Type-N(m) to DIN(f), 1.5 m 
G710050537 RF Cable DC to 4 GHz Type-N(m) to 1.0/2.3 (m), 1.5 m 
G700050540 Phase-Stable RF Cable w Grip DC to 6 GHz Type-N(m) to Type-N(f), 1.5 m 
G700050541 Phase-Stable RF Cable w Grip DC to 6 GHz Type-N(m) to DIN(f), 1.5 m 

 

  
Optional Antennas 
G700050353 RF Omni Antenna  Type-N(m), 806 MHz to 896 MHz 
G700050354 RF Omni Antenna  Type-N(m), 870 MHz to 960 MHz 
G700050355 RF Omni Antenna  Type-N(m), 1.71 GHz to 2.17 GHz 
G700050356 RF Omni Antenna  Type-N(m), 720 MHz to 800 MHz 
G700050357 RF Omni Antenna  Type-N(m), 2.3 GHz to 2.7 GHz 
G700050364 RF Yagi Antenna  Type-N(f), 806 MHz to 896 MHz, 10.2 dBd 
G700050365 RF Yagi Antenna  Type-N(f), 866 MHz to 960 MHz, 10.2 dBd 
G700050363 RF Yagi Antenna  Type-N(f), 1.75 GHz to 2.39 GHz, 9.8 dBd 
G700050366 RF Log-Periodic Antenna  SMA(f), 700 MHz to 4 GHz, 1.85 dBd 
G700050367 RF Log-periodic Antenna  SMA(f), 700 MHz to 6 GHz, 2.85 dBd 
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G700050380 Isotropic Antenna  Type-N(m), 70 MHz to 3 GHz 
 
 

Optional RF Adapters 
G700050571 Adapter Type-N(m) to DIN(f), DC to 7.5 GHz, 50 W 
G700050572 Adapter DIN(m) to DIN(m), DC to 7.5 GHz, 50 W 
G700050573 Adapter Type-N(m) to SMA(f) DC to 18 GHz, 50 W 
G700050574 Adapter Type-N(m) to BNC(f), DC to 4 GHz, 50 W 
G700050575 Adapter Type-N(f) to Type-N(f), DC to 18 GHz 50 W 
G700050576 Adapter Type-N(m) to DIN(m), DC to 7.5 GHz, 50 W 
G700050577 Adapter Type-N(f) to DIN(f), DC to 7.5 GHz, 50 W 
G700050578 Adapter Type-N(f) to DIN(m), DC to 7.5 GHz, 50 W 
G700050579 Adapter DIN(f) to DIN(f), DC to 7.5 GHz, 50 W 
G700050580 Adapter Type-N(m) to Type-N(m), DC to 11 GHz 50 W 
G700050581 Adapter N(m) to QMA(f), DC to 6.0 GHz, 50 W 
G700050582 Adapter N(m) to QMA(m), DC to 6.0 GHz, 50 W 
G700050583 Adapter N(m) to 4.1/9.5 MINI DIN (f), DC to 6.0 GHz, 50 Ω 
G700050584 Adapter N(m) to 4.1/9.5 MINI DIN (m), DC to 6.0 GHz, 50 Ω 
G700050585 Adapter N(m) to 4.3-10 (f), DC to 6.0 GHz, 50 ohm 
G700050586 Adapter N(m) to 4.3-10 (m), DC to 6.0 GHz, 50 ohm 
 
 

 
 

Optional E1/T1 Test Cables 
G710050317 RJ45 to Y Bantam Cable 
G710050318 RJ45 to Y BNC Cable 
G710050319 RJ45 to 4 Alligator Clips 

 

 
StrataSync Subscription 
SS-CA-BSA-AM-01 StrataSync for CellAdvisor BSA - Asset Management-1 Yr. 
SS-CA-BSA-TDM-01 StrataSync for CellAdvisor BSA - Test Data Management-1 Yr. 
SS-CA-RFA-AM-01 StrataSync for CellAdvisor RFA - Asset Management-1 Yr. 
SS-CA-RFA-TDM-01 StrataSync for CellAdvisor RFA - Test Data Management-1 Yr. 
SS-CA-SA-AM-01 StrataSync for CellAdvisor SA - Asset Management-1 Yr. 
SS-CA-SA-TDM-01 StrataSync for CellAdvisor SA - Test Data Management-1 Yr. 

 
 

Optional Miscellaneous 
G710050581 Attenuator 40 dB, 100 W, DC to 4 GHz (Unidirectional) 
JD74050341 Soft Carrying Case 
JD71050342 Hard Carrying Case 
JD70050342 Hard Carrying Case with wheels 
JD70050343 CellAdvisor Backpack Carrying Case 
JD70050006 USB Bluetooth Dongle and 5 dBi Dipole Antenna 
G710050585 RF Directional Coupler, 700 MHz to 4 GHz, 30 dB, Input/Output; 

Type-N(m) to Type-N(f), Tap Off; Type-N(f)
1
 

G710050586 RF Combiner, 700 MHz to 4 GHz, Type-N(f) to Type-N(m)
1
 

G710050587 4x1 RF Combiner, 700 MHz to 4 GHz, Type-N(f) to Type-N(m)
2
 

G700050601 Bandpass filter 696 MHz to 716 MHz, N(m) to N(f), 50 ohm 
G700050602 Bandpass filter 776 MHz to 788 MHz, N(m) to N(f), 50 ohm 
G700050603 Bandpass filter 806 MHz to 849 MHz, N(m) to N(f), 50 ohm 
G700050604 Bandpass filter 1710 MHz to 1755 MHz, N(m) to N(f), 50 ohm 
G700050605 Bandpass filter 1850 MHz to 1910 MHz, N(m) to N(f), 50 ohm 
JD70050007 AntennaAdvisor Handle

3
 

JD71050351 GPS Antenna for JD740 and JD780 Series 
G710550324 External Battery Charger 
JD780A362 JD780A Series User’s Manual – Printed Version 
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1
Highly recommended for LTE Testing 

2
Highly recommended for LTE Advanced Testing 

3 
Requires G700050366 or G700050367 RF Log-Periodic Antenna  
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Appendix J – RoHS information 

This appendix describes the RoHS (Restriction of Hazardous Substances) information, which is a mandatory 

requirement from China. The RoHS directive consists in the restriction on the use of certain hazardous 

substances in electrical or electronic equipment sold or used in the European Union, after July 1, 2006. These 

substances are: lead, mercury, cadmium, hexavalent chromium, polybrominated biphenyls, and polybrominated 

diphenyl ethers. 
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Appendix K – On-screen keyboard 

You can use the on-screen keyboard to type in texts, file names, and folder names. 

 

Adding or deleting letters 

Procedure 

1. Tap keys on the on-screen keyboard. As you type, each letter is displayed in the name field. If 
you want to change the letter case between uppercase and lowercase, tap the Caps key. 

2. To delete a letter, tap the Back key on the keyboard or press the backspace key on the keypad. 

3. To move the cursor along the name field, tap the < or > key, turn the rotary knob, or touch in 

between letters in the name field. 

4. To delete all the letters displayed in the name field, tap the Clear key on the on-screen keyboard. 

 

Figure 309 On-screen keyboard 

 

 

Editing or adding a custom keyword 

You can edit and delete a keyword or add a new one, as you desire. 

Procedure 

1. Tap the Edit Keywords bar on the on-screen keyboard. 

The edit keywords keyboard appears. 

2. To edit a keyword, select the keyword box and then change the letters. 

3. To delete a keyword, select the keyword box and then tap the Clear key. 

4. To add a keyword, select a blank keyword box and then type in a keyword. 

5. Tap the Save key on the keyboard to save and continue saving. 

 

  



JD780A Series Analyzers 

 Appendix 607 

Figure 310 Edit keywords keyboard 

 

 

Appending a keyword 

You can append a factory-stored or custom-defined keyword, as you want. 

 

Procedure 

1. Tap the Append Keywords bar on the on-screen keyboard. 

The append keywords window appears. 

2. To append a keyword, complete the following steps: 

a. Select the keyword tag button to view available keywords for the tag. 

b. Select one keyword, from the following choices for each keyword tag: 
 

Keyword tag Keyword (tag value) 

Site-ID* SiteA, SiteB, and SiteC 

Sector* Alpha, Beta, and Gamma 

Technology* GSM900, WCDMA850, and LTE180 

Test Type* RL, VSWR, DTF-RL, DTF-VSWR, and CL 

Termination* Open, Load, and Antenna 

Custom Any keywords you have added 

c. To delete the keyword you have added to the keyword field, tap the Delete button. 

d. To clear the keyword field, tap the Clear button. 

3. Optional. You can edit any of the custom keyword tags or tag values by tapping the Edit Tags 
Values or Edit Tags button, but not the factory keyword tags marked with the asterisk (*). 

 

NOTE 

You must keep the keywords marked with the asterisk (*) intact as the StrataSync 
server uses them when transferring data. 

4. Select the Separator option from the choices: hyphen [-], underscore [_], or None. 

5. Select the As a filename option between On and Off. If you select Off, the keyword will not be 

placed in a file name, but in the trace/PNG file information. 

6. Tap the Save and Exit button to save and exit or the Keyboard button to return to the keyboard. 
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Figure 311 Append keywords window 
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Appendix L – Supported map display parameters 

Your CellAdvisor instrument provides the RAN Performance Indicator feature in the LTE signal 

analyzer mode. Setting map display parameters that your instrument supports is important to have test 

results as you desire as the instrument supports RANAdvisor’s map display parameters with 

limitations. Following table will help you select parameters properly by showing what are supported. 

 

Parameter 
Category 

Parameter Name Support 
? 

 Parameter 
Category 

Parameter Name Support 
? 

LTE Cell 
Info 
Parameters 

Cell Name   LTE 
Serving 
and 
Neighbor 
Parameters 
(continued) 

N1 RSRP Rx(1) (dBm)  

Cell Identity   N1 RSRP (dBm)  

Physical Cell ID   N1 RSRQ (dB)  

Tracking Area Code   N2 PCI  

MCC   N2 RSRP Rx(0) (dBm)  

MNC   N2 RSRP Rx(1) (dBm)  

DL E-ARFCN   N2 RSRP (dBm)  

UL E-ARFCN   N2 RSRQ (dB)  

DL Bandwidth   N3 PCI  

UL Bandwidth   N3 RSRP Rx(0) (dBm)  

Band Indicator   N3 RSRP Rx(1) (dBm)  

Allowed Access   N3 RSRP (dBm)  

RLC Tx Throughput YES  N3 RSRQ (dB)  

RLC Rx Throughput YES  N4 PCI  

MAC Tx Throughput YES  N4 RSRP Rx(0) (dBm)  

MAX Rx Throughput YES  N4 RSRP Rx(1) (dBm)  

LTE Mode   N4 RSRP (dBm)  

LTE TDD SF Assignment   N4 RSRQ (dB)  

LTE TDD Special SF 
Patterns 

  N5 PCI  

CQI CW0 YES  N5 RSRP Rx(0) (dBm)  

CQI CW1 YES  N5 RSRP Rx(1) (dBm)  

LTE ML1 
Serving Cell 
Measurement 

RSSI RX (0) (dBm) YES  N5 RSRP (dBm)  

RSSI RX (1) (dBm) YES  N5 RSRQ (dB)  

RSSI (dBm) YES  N6 PCI  

RSRP Rx(0) (dBm) YES  N6 RSRP Rx(0) (dBm)  

RSRP Rx(0) (dBm) YES  N6 RSRP Rx(1) (dBm)  

RSRP (dBm) YES  N6 RSRP (dBm)  

RSRQ Rx(0) (dBm) YES  LTE Demod 
Config 
Parameters 

PDSCH RNTI ID  

RSRQ RX(1) (dBm) YES  PDSCH RNTI Type  

RSRQ (dB) YES  eNodeB Tx Antennas  

SINR Rx(0) (dB) YES  eNodeB Rx Antennas  

SINR Rx(1) (dB) YES  Transmission Mode  

PUSCH Tx (dBm) YES  Spatial Rank  

PUCCH Tx (dBm) YES  RB Alloc for Slot 0 (%)  

SRS Tx (dBm) YES  RB Alloc for Slot 1 (%)  

LTE 
Serving and 
Neighbor 
Parameters 

Serving E-ARFCN YES  Freq Selective PMI  

Serving Physical Cell-ID YES  PMI Index  

Serving RSRP (dBm) YES  Stream 0 TBS (bits)  

Serving RSRQ (dB) YES  Stream 0 Modulation YES 

Detected Cells PCI   Traffic to Pilot Block Ratio  

Neighbor Cell Count   Stream 1 TBS (bits)  

N1 PCI   Stream 1 Modulation  

N1 RSRP Rx(0) (dBm)   PB  
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